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Preface to AcqKnowledge Software Guide 
Welcome 

Welcome to the AcqKnowledge Software Guide. The MP System (MP150 or MP36R) is a complete data 
acquisition system that includes both hardware and software for the acquisition and analysis of life 
science data. The MP System is used for data acquisition, analysis, storage, and retrieval. 
In addition to the MP Systems, AcqKnowledge also supports BIOPAC’s licensed BioHarness, B-Alert, 
Mobita and Stellar Systems. For more information on these wireless hardware solutions, see the Licensed 
Funtionality Chapters at the end of the guide. 
AcqKnowledge software not only makes data collection easier, but also performs analyses more quickly 
and easily than a chart recorder. Easily edit data, cut and paste sections of data, perform mathematical and 
statistical transformations, and copy data to other applications (such as a drawing program or spreadsheet) 
for reports and publication. 
All BIOPAC data acquisition hardware with AcqKnowledge 4.4.2 is compatible with Windows 10/8/7 or 
Mac OS X 10.7-10.11 
AcqKnowledge uses the familiar point-and-click interface common to all Windows and Macintosh 
applications. Complex tasks such as digital filtering or fast Fourier transformations are as easy as 
choosing a menu item or clicking your mouse. 
This manual covers use of AcqKnowledge software with MP150/MP36/BioHarness/B-
Alert/Mobita/Stellar hardware and details BIOPAC equipment available for a variety of applications. If a 
desired application is not addressed, just visit the BIOPAC web site at www.biopac.com to download one 
of our many Application Notes, or call to request a hard copy or talk to an Applications Specialist. 

See also: 
• BIOPAC Installation Guide—packed with the software CD. 
• BIOPAC Hardware Guide.pdf—available under the Help menu and installed to the User Support folder. 

Provides details on Hardware System modules, transducers, electrodes, etc., and setup and calibration. 
• BIOPAC Catalogs 

   
MP Research Catalog  MRI catalog  VR & Stimulus Catalog  

Supported Platforms  
AcqKnowledge 4.4.2 is supported on the following:  
 Operating Systems Hardware 
   Windows 10, 8, 7 MP150 UDP 
  MP36R  
  BioHarness BT (Windows only) 
 Mac OS X 10.9-10.11 B-Alert (Windows only) 
  Mobita (Windows only) 
  Stellar (Windows only)  

http://www.biopac.com/�
http://www.biopac.com/Manuals/research_catalog.pdf�
http://www.biopac.com/ProductImages/corporate%20images/biopac_mri_catalog_web.pdf�
http://www.biopac.com/Manuals/VR_catalog.pdf�
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What’s new for AcqKnowledge 4.4.2 
BONUS! AcqKnowledge includes a courtesy copy of our new Analysis package.  

See the Analysis chapter for details. 
The following features have been added since AcqKnowledge 4.4.1 was released.  

• OS X 10.11 support 
• FaceReader Integration – Licensed feature supporting integration of facial emotional state recognition 

data with AcqKnowledge physiological data.  
• B-Alert – Improved baseline recording in shorter durations 
• MP36R Arbitrary Wave Stimulation – new output control panel that allows the MP36R to be used to 

generate arbitrary waveform output. The arbitrary waveform output is similar to the MP150, allowing 
for generation of square, sine and ramp signals or arbitrary signals from another open graph window. 

• Stellar v2 Hardware Support – new hardware support for the next generation of Stellar transmitters. 
 This supports extended memory, transmitters that have customized signal types, real-time data 
previews to assist in implantation, accelerometers, mini-mouse units, and other functionality. 

• Enhanced Discrete Wavelet Transformation Analysis – now includes a Stationary Waveform 
Transformation option and multi-channel output of transformed data 

• Sweep Display Mode - This mode is similar to an oscilloscope sweep display. Data is plotted left to 
right but when new data is incoming, earlier data remains visible on the screen.  

• Module Setup improvements 
• Find Cycle improvements 
• Bug fixes 

The following features have been added since AcqKnowledge 4.4 was released.  
• Windows 10 support 
• Support for new BioNomadix Data Logger 
• Enhanced support for B-Alert Wireless EEG System 
• Enhanced support for Stellar Telemetry System 
• New Stellar Specialized Analysis options 
• RSA Time-series option added to HRV & RSA Specialized Analysis 
• Dropbox support – save/retrieve AcqKnowledge files to/from a Dropbox account 
• Collapsible channels – quickly hide and unhide single or multiple channels with one click 
• Updated installer 
• Bug fixes 

The following features have been added since AcqKnowledge 4.3.1 was released.  
Automated Analysis Enhancements 

• EEG Seizure Analysis – new routine for locating seizures in long-term small animal EEG recordings 
• Estimated Cardiac Output from Blood Pressure – new Hemodynamics specialized analysis option 
• HRV and RSA automation enhancements – Statistical analysis: Multi-epoch HRV; Spectral Analysis: 

Multi-epoch HRV and RSA; Single-epoch HRV; R-R Poincare Plot; RSA Time-series 
New Licensed Feature Options 

• Baroreflex Analysis 
• Actigraphy Analysis – correlates wireless accelerometer data for sleep studies 

New Hardware Integration 
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• Mobita 32-channel wireless data support  
• Stellar Telemetry System support for wireless ECG and blood pressure 

- GPS Integration – import GPS data to synchronize physiological data with physical location 
- FIR Filter Calculation Channel – apply high quality FIR filters in real time 
- Slew Rate Limiter – precise real-time or offline tool for denoising and removing motion artifact 
- Event-based Rate Measurements – extract the mean, median and standard deviation of online and offline Rate 

outputs 
- Elapsed timers – stopwatch, elapsed timers and alarm to time experiment protocols 
- Embedded PDF Integration – embed PDFs of procedures, analysis, etc. into graph files and journals 
- Sequential File Merge – merge separate graphs into appended segments within the same graph  
- Dataquest file format import 
- Simplified User Interface and UI updates 
- Simplified installation with new Product Care Center 
- New sample data files 
- Bug fixes 

 For a detailed look at what’s new in AcqKnowledge 4.4, watch the Tutorial video. 
The following features have been added since AcqKnowledge 4.3 was released: 

- Horizontal split view – allows viewing of two independent horizontal axis areas in same graph 
- Journal hyperlinks and page setup tool 
- High frame rate camera support 
- MP150 communication improvements 
- Labels for append events may be edited 
- Preferences may be cleared by holding Shift key down while launching application 
- File-specific output control presets for MP36R 
- Files may be opened for Playback from the Startup Wizard 
- New scripting commands for: changing output control preset, get acquisition sampling rate, change active output 

control, callback for window activation, toggling output control, calibrate a channel of the graph 
- Epoch Analysis option to start first interval at beginning of each focus area 
- Support for MPMS200 and OXY300-MRI hardware 
- New measurement validation sample data files with accompanying spreadsheets for verifying measurements 

The following features have been added since AcqKnowledge 4.2 was released.  
- Windows 8 supported 
- OS X 10.8 supported in Mac version 
- Linked acquisitions supporting multiple hardware 

types 
- Increased channel count support – up to 15,000 

channels 
- Consolidated and multiple hardware support 
- Improved compatibility for standard user account 

presets/specialized analysis settings 
- Bluetooth integration for BioHarness 
- Scaled ECG boundary selection 

- ICG Analysis improvements 
- Pressure Volume Loop Analysis tools 
- Find Cycle enhancements 
- Rate Detector enhancements 
- Graph Textual Value Display and Toolbar 
- Original data restored after canceling 

transfomations 
- Focus Area feature 
- Tabbed graph interface 
- Noldus import/export 
- SMI BeGaze data import 

http://www.biopac.com/video/?video_category=acqknowledge-new-features&v=acqknowledge-4-4-gui-overview�
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- Improved software controls for B-Alert wireless 
EEG system 

- Higher resolution cameras supported in Media 
Capture/Playback 

- Media Capture/Playback now supports linking to 
earlier-format AcqKnowledge 3.9/BSL 3.7 files 

- Selection palette toolbar icon  
- Linked selection option from the I-beam tool  
- Measurement column selection  

- Rate/Expression Presets  
- Automated analysis changes to EEG - analyze 

multiple channels in one go 
- Additions to the ICG analysis  
- Journal docking options 
- New preference to “pin” dialog windows on top of 

application 
- New MP150 Modules for Heel/Toe Strike, Dyno 

Clench Bulb and Goniometer setups 

Using this Manual 
The AcqKnowledge Software Guide is divided into four parts: 
Part A Getting Started 
 Please review Getting Started whether new to computer-based data acquisition systems or an old hand at 

physiological monitoring. Use this section to become acquainted with how the system works and the most 
frequently used features. 

Part B Acquisition Functions 
 Explains data acquisition features and gives a detailed summary of different acquisition parameters. Provides 

an in-depth description of the commands used to determine acquisition rate, acquisition duration, and 
specialized functions such as triggering, averaging, and online calculation of different values. 

Part C Analysis Functions 
 Details information on analysis features; covers the range of post-acquisition analysis functions and 

transformations available with the Hardware System. Describes how to edit data, take measurements and 
perform basic file management options (save, print, etc). 

Part D Appendices 
 Answers frequently asked questions, offers hints for working with files, includes information on upgrading 

from previous versions, provides technical information about the Hardware Systems and other information 
about the AcqKnowledge software. 

 
See also: 

BIOPAC Installation Guide 
This guide was included with the software CD. It contains full instructions for hardware and software 
installation, and how to be up and running with the Hardware System in just a few minutes. 
 
Hardware Guide 
BIOPAC Hardware Guide.pdf is available under the Help menu. It gives practical examples of how the data 
acquisition unit is used with different components for common types of data acquisition, and includes sample 
results and applications for widely used test procedures. This guide provides instructions for connecting 
external devices to the data acquisition hardware, electrodes, transducers, amplifiers, etc. 
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User Support System 
 
User Support System files can be found in the following hard drive location; BIOPAC Systems, Inc/AcqKnowledge 
3.x/User Support Systems in the Program Files or Applications folder. 
 
 AcqKnowledge Software Guide.pdf is the software support document 
 
 BIOPAC MP Hardware Guide.pdf is the hardware guide (with specifications) 
  
The User Support files can also be opened directly from the CD. 
 
The files are in PDF format, and can be read by Adobe Acrobat Reader. 

• Adobe Acrobat Reader can be downloaded for free at www.adobe.com under the Adobe Acrobat Reader site. 
 

The Samples folder in the BIOPAC program folder contains sample files and graph template Quick Start files for a 
variety of applications. Quick Start templates establish the channel setup and acquisition parameters required for a 
variety of applications. 
 

• To open sample files, choose File > Open then Browse to the BIOPAC Samples folder. 
• In addition to the standard sample files, measurement sample data files are provided. These files are 

configured for specific measurement types and include spreadsheets providing external data necessary for 
measurement verification. Each spreadsheet contains procedures and examples for the associated 
measurement data file. These sample data files consist of Event Measurements.acq, Traditional.acq (standard 
mathematical measurements included in AcqKnowledge), Expression Sum_Calculate.acq and Correl 
Coef.acq (Correlation Coefficient). 

• To open a graph template Quick Start file, choose File > Open then Browse to the BIOPAC Samples folder 
(be sure to select/enable the desired file type). 

  

http://www.adobe.com/�
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Where do I find help? 
The Introductory sections are intended to provide enough information to get up and running with the MP System, 
and become familiarized with some basic AcqKnowledge functions. There are far more features than described in the 
first few pages, so here is a guide for how to continue using this manual. 
 Help menu 

The online Help menu includes basic information about standard AcqKnowledge functions and links to the 
tutorial, software guide and hardware guide for online searchable Help while running AcqKnowledge, plus 
links to the BIOPAC web site. 
You may also visit BIOPAC’s Tutorial Video page for instructional screencasts of many analysis routines 
and software features. 

 Application Notes 
The BIOPAC web site at http://www.biopac.com has more than 50 available Application Notes. Download 
the desired Application Note or call to request a hard copy. 

 Acquiring data 
For more specific information on different types of acquisitions, see Part B—Acquisition Functions. It covers 
basic acquisition parameters in detail, and describes some acquisition features (such as peak detection 
techniques and online Calculation channels) not covered in the Getting Started section. 

 AcqKnowledge 
Information about how to edit, display and transform data can be found in Part C—Analysis Functions. It 
explains how to import and export data, how to save files, and other file management commands. This 
section also explains how to use all of the post-acquisition features of the AcqKnowledge software. 

 Connecting input devices 
To find out how specific modules connect to the data acquisition hardware, turn to the BIOPAC Hardware 
Guide PDF file. This section describes how to connect signal-conditioning modules to the data acquisition 
unit and how to connect electrodes and transducers to the modules. 

 Working with large files 
Many users need to perform high speed (i.e., fast sampling rates) or long duration acquisitions. These types 
of acquisitions tend to generate large (several megabytes) data files that can be difficult to load, store, and 
view. The Hardware System can handle such acquisitions—see the Appendices for information on how to 
optimize setup for these types of acquisitions. 

 Troubleshooting 
Includes a list of the most frequently asked questions regarding the Hardware System. Check this section 
(Appendix A) for commonly encountered problems and solutions. 
 

http://www.biopac.com/video/?video_category=acqknowledge-new-features&v=whats-new-in-acqknowledge-4-4�
http://www.biopac.com/�
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IMPORTANT SAFETY NOTICE 
BIOPAC Systems, Inc. instrumentation is designed for educational and research-oriented life science 
investigations. BIOPAC Systems, Inc. does not condone the use of its instruments for clinical medical applications. 
Instruments, components, and accessories provided by BIOPAC Systems, Inc. are not intended for the diagnosis, 
mitigation, treatment, cure, or prevention of disease. 
The MP data acquisition unit is an electrically isolated data acquisition system, designed for biophysical 
measurements. 
Exercise extreme caution when applying electrodes and taking bioelectric measurements while using the hardware 
with other external equipment that also uses electrodes or transducers that may make electrical contact with the 
Subject. Always assume that currents can flow between any electrodes or electrical contact points. 
Extreme caution is also required when performing general stimulation (electrical or otherwise) on a subject. 
Stimulation currents should not be allowed to pass through the heart. Keep stimulation electrodes far from the heart 
and located close together on the same side of the subject’s body. 
It is very important (in case of equipment failure) that significant currents are not allowed to pass through the heart. 
If electrocautery or defibrillation equipment is used, it is recommended that all BIOPAC Systems, Inc. 
instrumentation be disconnected from the Subject. 
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Human Anatomy & Physiology Society Position Statement on Animal Use 

(Adopted July 28, 1995, Modified January 2001, Approved April 29, 2012) 
It is the position of the Human Anatomy and Physiology Society (HAPS) that dissection and the manipulation of 
animal tissues and organs are important elements in scientific investigation that introduce students to the excitement 
and challenge of their future careers. HAPS supports the use of biological specimens as part of a program of study, 
provided their use is in strict compliance with federal legislation and the guidelines of the National Institutes of 
Health and the United States Department of Agriculture, and that such use fulfills clearly defined educational 
objectives. 

The mission of the Human Anatomy and Physiology Society (HAPS) is to promote excellence in the teaching of 
anatomy and physiology.  A fundamental tenet of science is the ordered process of inquiry requiring careful and 
thoughtful observation by the investigator. As subdivisions of biology, both anatomy and physiology share a long 
history of careful and detailed examination, exploration and critical inquiry into the structure and function of the 
human and animal body.  

Consistent with the origins and nature of scientific inquiry, HAPS endorses the use of animals as part of the 
laboratory experiences in both human anatomy and human physiology. 

Historically, an important tool of investigation in human and animal anatomy has been dissection. A complete 
anatomy learning experience that includes dissection goes beyond naming structures and leads the student to 
conclusions and insights about the nature and relatedness of living organisms that are not otherwise possible. To 
succeed in their future careers, students must become thoroughly familiar with anatomical structures, their design 
features and their relationships to one another. Dissection is based on observational and kinesthetic learning that 
instills a recognition and appreciation for the three-dimensional structure of the animal body, the interconnections 
between organs and organ systems, and the uniqueness of biological material. Dissection conveys the inherent 
variability of living organisms not otherwise observable in simulations and models. Physiology experiments 
involving humans and live animals provide an excellent opportunity to learn the basic elements specific to scientific 
investigation and experimentation. It is here that students pose questions, propose hypotheses, develop technical 
skills, collect data, analyze results and develop and improve critical thinking and problem solving skills 

Since effective teaching requires a diversity of strategies and approaches, HAPS endorses the use of computer atlases 
and simulations, modeling, and video programs to meet educational objectives and the needs of students. Science 
educators choosing not to use animals or biological specimens should choose alternatives that are able to convey 
equivalent anatomical and physiological intricacies to meet their educational objectives. 

Science educators have in common a respect and reverence for the natural world and therefore have a responsibility 
to share this with their students. They must communicate the importance of a serious approach to the study of 
anatomy and physiology. HAPS also encourages educators to be responsive to student concerns regarding use of 
animals and to provide students who object to animal use with alternative learning materials. 

HAPS contends that science educators should retain responsibility for making decisions regarding the educational 
uses of animals and other strategies and techniques for the betterment of their student’s  learning. Furthermore, it 
opposes any legislation or administrative policy that would erode the educator’s role in decision making or restrict 
dissection and animal experimentation in biology. 

Used with permission of:  
The Human Anatomy & Physiology Society (HAPS)  
251 S. L. White Blvd., P. O. Box 2945, LaGrange, GA 30241-2945 
800-448-HAPS (4277)    Fax: (706) 883-8215    www.hapsweb.org 
  

http://www.hapsweb.org/�
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Part A — Getting Started 
Chapter 1  MP Systems Overview 

Part A - Getting Started covers the basics of data acquisition and analysis with the MP System (MP150 or MP36R), 
since this is the most commonly-used BIOPAC hardware system. All of the material in this section is covered in 
more detail in subsequent sections (see Using this Manual, page 18 ). 

 
BioHarness™ users should also see the BioHarness User Guide available under 
the Help menu and installed to the User Support folder in the program folder.  
Other BIOPAC hardware types, such as B-Alert, Mobita, and Stellar  
are covered in the Licensed Functionality chapters at the end of the guide. 

Overview 
The MP System (MP150 or MP36R) is a computer-based data acquisition system that performs many of the same 
functions as a chart recorder or other data viewing device, but is superior to such devices in that it transcends the 
physical limits commonly encountered (such as paper width or speed). Data collection generally involves taking 
incoming signals (usually analog) and sending them to the computer, where they are (a) displayed on the screen and 
(b) stored in the computer’s memory (or on the hard disk). These signals can then be stored for future examination, 
much as a word processor program stores a document or a statistics program saves a data file. Graphical and 
numerical representations of the data can also be produced for use with other programs. 

Function  MP150  
Aggregate Sample Rate 

Internal MP150 Buffer: 400 kHz 
To Cpt. Memory or Disk: 300 kHz 

Internal Buffer Size: 6 Mbytes 
A/D Converter Signal/Noise Ratio: 86 dB typical 
D/A Resolution: 16 bits 
D/A Output rate: Independent of A/D rate 
Communication to Computer: Ethernet (10 base T, UDP and DLC Type II) 

The MP System utilizes the same hardware, excepting the computer interface. The software has the same “look and 
feel” on computers running Windows® or Mac® OS X. 

 The system is referred to as “MPWSW” for Windows® or “MPWS” for Mac. 
The MP System consists of several major components, including hardware and software. The AcqKnowledge 
software included with the MP system allows full control over editing data, the way it appears on the screen, and 
performs four general functions: 

(a) Control the data acquisition process; 
(b) Perform real-time calculations (such as digital filtering and rate detection); 
(c) Perform post-acquisition transformations (such as FFT’s and math functions); 
(d) Handle file management commands (saving, printing, and the like). 

The heart of the MP System) is the MP data acquisition unit, which converts incoming physiological data into digital 
signals that can be processed and displayed on a computer interface. The MP150 data acquisition unit connects via 
Ethernet, the MP36R connects via USB. 
The MP150 System also includes a Universal Interface Module (UIM100C) for connecting external devices to the 
MP150 data acquisition unit. Connect chart recorders, pre-amplified signals, and digital signals such as those from 
triggers or event counters/recorders. The UIM100C connects to the front of the MP150 data acquisition unit via two 
cables (Analog and Digital). As a rule, both cables should be connected. The connectors for each of the two cables 
are different, so there is only one way the UIM100C can be connected to the MP150 data acquisition unit. 
A wall transformer is included with the MP System (MP150 or MP36R) to convert AC mains power into DC power 
suitable for system operation and safety. 
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MP36R support 
The MP36R is a four-channel data acquisition unit designed to work with AcqKnowledge 4.1 and above for the 
research market. AcqKnowledge support for the MP36R unit includes:  
 Standard data acquisition and data acquisition features (triggering, multiple channels, variable sampling rate, 

input values)  
 Output control functionality for controlling stimulators, digital channel, and channel redirection to output.  
 Standard analog presets for all SS series transducers 
 Electrode Check support  
 Multiple-MP device support. Similar to multiple MP150 support, each graph may acquire from a maximum 

of one unique MP device.  
 Control channel support for changing digital output lines based on calculation channel analysis  

 
MP36R Notes  The computer sleep mode should be disabled—if the computer goes to sleep while AcqKnowledge 4 

is running, communication with the MP36R may be lost and the application may freeze. To prevent 
this from occurring, modify the computer settings to prevent the computer from going to sleep. 
 If sleep mode is enabled and causes the 

application to freeze, force quit the application 
and ‘power cycle’ the MP unit to re-establish 
communication. 

 During an unresponsive period, the ‘Connect 
Hardware’ dialog may display odd characters 
in place of the MP serial number or the 
computer, upon waking up, may generate a 
“Driver irql not less or equal” error dialog. 

 AcqKnowledge software does not support MP36 
units from the Biopac Student Lab product line (without the “R” designation). 

 Mac OS users: Connect the MP36R directly to the computer, do not connect MP36R via hub or 
keyboard. 

MP System Requirements 
Suggested minimum system requirements are detailed below. Recommendations are included to optimize system 
performance; more memory and a faster system will enhance MP System performance. If planning to acquire data 
for more than a few hours and/or are sampling at more than 1,000 samples per second, see the Disk Space note. 

 For AcqKnowledge 4.4.2 
OS Requires Windows 10/8/7 or Mac OS X 10.9-10.11 

Port 

MP150 Requires Ethernet (UDP), MP36R requires USB. 
 

Note To use an MP150 with UDP communication on a network with a non-Windows DHCP server, 
it is necessary to use firmware rev. 1.1.12 or greater in order for the MP150 unit to properly be 
assigned an IP address. This is also true for any DHCP system with non-Windows operating 
systems, such as Unix, Linux, Mac OS X, and other DHCP-aware devices. 

Hard Disk Requires 1 GB to store the software and online manuals; additional 1 GByte recommended for data 
storage 

RAM 1 GB recommended 

Processor PC: Pentium 4 or higher 
Mac: Intel Core Duo or higher 

 

http://www.biopac.com/#Disk Space�
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Disk Space 
With any program, adequate disk space is necessary for storage of data files. Some users may generate data files 
of several hundreds of megabytes. To acquire data for long periods (more than a few hours) while sampling at 
relatively fast rates (more than 1,000 samples per second), as much disk space as possible should be available. (A 
removable drive may also be used). See the Appendices for hints on working with large files. 
 

Windows XP Compatibility 
AcqKnowledge 4.4 is officially released for Windows 10, 8, 7, and Vista operating systems. AcqKnowledge 4.4 
is not supported on Windows XP. 

Automator Integration and Scripting Support 

Mac OS X 10.4 and greater includes a visual scripting environment called “Automator.” Automator allows for 
drag and drop creation of “Workflows.” Each workflow is a series of steps that is performed in another 
application. Each individual step is called an action. An action encapsulates a simple operation within another 
application, such as opening a text file in TextEdit or applying a filter within Photoshop. 

Over 40 actions have been written to allow AcqKnowledge to be controlled from Automator workflows. Using 
these actions, workflows can be constructed to perform sequences of transformations, automating post-
acquisition analysis, performing experimental protocols, and other repetitive operations. 

Workflows can be constructed using Automator. It is also possible to create, edit, and execute workflows directly 
from within the AcqKnowledge environment using the new “Workflow” menu. The Workflow menu allows the 
creation of workflows specific to an individual user account or to one shared by all AcqKnowledge users. These 
workflows can then be edited in the Automator environment. Each workflow created using Workflow > New 
Workflow will appear at the bottom of the Workflow menu each time AcqKnowledge is launched. By simply 
selecting the name of the workflow from the Workflow menu, AcqKnowledge will execute the workflow.  

Workflows executed from the Workflow menu should begin with either an “Open Graphs” or a “Get Active 
Graphs” action. Workflows intended for use outside of the AcqKnowledge environment (e.g. used as Folder 
Actions) should begin with a “Launch Application” action to start AcqKnowledge followed by an “Open 
Graphs” or a “Get Active Graphs” action.  

For more information about Automator and help constructing workflows, see the Apple website at: 

http://support.apple.com/kb/HT2488 

http://support.apple.com/kb/HT2488�
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 MP System Features 
In conjunction with your computer, the MP System is a complete system for acquiring almost any form of 
continuous data, whether digital or analog. The MP System can perform a range of recording tasks, from high-speed 
acquisitions to long duration acquisitions. Generally speaking, for physiological applications, the MP System is 
limited only by the speed of your computer and the available memory or disk space. Features of the MP System 
include: 

Easy to use The MP System offers the same convenient and easy-to-use features which computer 
users are accustomed to. Since the MP System (MP150 or MP36R) software runs under 
these Windows and Mac OS environments, you can run other applications while you are 
collecting data. In terms of hardware setup the MP System (MP150 or MP36R) uses 
simple plug-in connectors and standard interface cables.  
You don’t need a degree in electronics to Set Up your system! 

Flexible The MP System can be configured for a wide variety of applications, from single channel 
applications to multiple-device measurements (up to 16 analog and 16 digital, or multiple 
MP150s). You control the length of acquisition, the rate at which data is collected, how 
data is stored, and more...all with a few clicks of the mouse button. Whether you’re 
measuring alpha waves or collecting zoological data, the MP System (MP150 or MP36R) 
can meet your needs. 

Menu flexibility You can easily customize menu displays to show only the functions you are using, thereby 
reducing the risk of error or confusion in your lab. This function is extremely powerful for 
laboratories working to GLP guidelines. It is also useful for teaching applications where 
instructors can hide unnecessary menu items. See Appendix D—Customizing Menu 
Functionality. 

High Speed Sampling Sample rates up to 400 KHz aggregate 

Arbitrary Sample 
Rates 

Apply different sample rates between channels or operate the STM100C stimulator at a 
different rate than the acquisition sample rate 

Calculation Channel 
Presets 

Customize your recording for specific measurements. 

Template files AcqKnowledge “Quick Start” templates are available for over 40 applications. Just open 
the template file and start the acquisition—appropriate settings are established for the 
selected application. 

Online Calculation Although the MP System provides an extensive array of measurements and 
transformations you can apply to collected data, sometimes you need to perform 
computations while data is being collected. The online Calculation functions allow you to 
calculate new channels based on incoming signals. This feature allows you to compute 
BPM, for instance, based on raw ECG data. 

Online filtering Many times, it is preferable to filter data as it is being collected, rather than having to wait 
until after the fact, so now you can apply filters to incoming data and view the results in 
real time. That means online monitoring of data filtered to suit your needs. 

Online measurements The MP System can instantly compute over a dozen measurements and computations for 
any given data point(s). These options are available from pull-down menus and include 
mean, peak-to-peak, value, standard deviation, frequency, and BPM. 



Part A — Getting Started 27 

AcqKnowledge 4 Software Guide 

 
Measurement 
Validation 

Validate measurements with the ValidateMeasurements.acq sample file that was 
included with the software. The measurement definitions (page 95) include 
measurement formulas and “Sample data file” explanations. 

Preview your data Similar to chart recorders, the MP System allows you to change both the vertical 
scale and the horizontal scale. You can change the amplitude scale or the time 
scale to any value you wish, or you can have the MP System automatically scale 
them for you. 

Replace (or augment) 
a chart recorder 

Whether you want to replace a chart recorder or simply supplement an existing 
setup, the MP System is fully compatible with most major recording devices. 
What’s more, the MP Systemis compatible with most popular input devices, so 
you can continue using the same transducers, electrodes and sensors. 

Simplified editing It used to be that once your data was collected, the only way to edit it was with 
scissors and adhesive tape. Now you can delete unimportant sections of your data 
with a keystroke. You can “paste” together sections from different waves, or 
simply edit out noise spikes from individual waves. 

Append mode For some applications, data only needs to be recorded during some portions of a 
long experiment. AcqKnowledge has an “Append” mode that lets you pause the 
acquisition for as long as you wish, and resume the acquisition as many times as 
needed. In this mode, you can start and stop a recording as you would with a chart 
recorder. Appending data saves on storage space and processing time for 
transformations. 

Digital filtering All data contains measurement error and noise. Now you can reduce or eliminate 
that error by using the digital filters and smoothing transformations included in 
the MP System. You can smooth data across any number of samples, or filter out 
noise from any frequency or bandwidth you wish. 

Digital Output You can control external devices when an input or calculation channel meets 
trigger conditions you specify. Use the Control channels to output a pulse when 
the signal on an analog channel falls above or below a given threshold. 

X/Y plotting You can view and acquire data in the form of an X/Y plot, with one channel on 
the horizontal axis and another on the vertical axis. This allows you to explore 
relationships between different channels and opens up a whole range of 
applications, from chaos plots to respiration analysis to vectorcardiograms. 

Histogram function You can easily examine the variability and the measures of central tendency of 
any waveform data with the histogram function. Set the plotting options to suit or 
let the software determine the “best fit” for graphing your data. 

Math functions In many cases, simply collecting raw data is not enough. AcqKnowledge has an 
array of built-in mathematical functions ranging from simple absolute value to 
computation of integrals, derivatives, and operations involving multiple 
waveforms (such as subtracting one wave from another). You can even chain 
multiple functions together to form complex equations or expressions. 

Annotation AcqKnowledge has a Journal you can use to append comments concerning your 
input data, either online or after the fact. This is especially useful for noting the 
characteristics of an acquisition (what was involved, what manipulations took 
place, and the like) for future reference. 
See also: Text annotation, page 60. 
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Triggering If you need to measure response times or start data collection only after some 

event has occurred, the MP System allows you to trigger an acquisition in a 
number of different ways. You can trigger on the level of a signal, or with an 
external synchronizing trigger. 

Event marker  Many times, especially during a long acquisition or in a laboratory setting, it is 
useful to make a note of when specific events occurred so that these events (such 
as when a manipulation occurred) can be recorded and any changes in the data 
can be noted. The event function allows you to insert symbols in the record and 
add text for each event. These can be added either while data is being collected or 
after the fact. Event functionality can be automated for sequential application or 
customized for Function keys. 

File compatibility Data can be saved and viewed in a number of different formats. For word 
processor programs like Microsoft Word®, use Copy to Clipboard and then paste 
into the document. Use Save as Excel for Microsoft Excel®. You can output your 
data in either text or graphical form, and AcqKnowledge can even read-in raw 
data from a text file. Open (import) or save as (export) MATLAB™ and Igor Pro 
Experiments, or raw (binary) data for low level exchange. 

Pattern recognition Using an advanced pattern search/recognition algorithm, the MP System can 
automatically find a specific pattern within waveforms. This is useful for finding 
abnormal waveforms (such as irregular ECG waves) within a data file. 

Cycle/Peak detection AcqKnowledge has a built-in algorithm to find cycle data, such as positive or 
negative peaks, from any size data file. You can even search for all the 
cycles/peaks with one command and automatically log statistics like time and area 
to the journal. 

Printing The MP System provides a range of printing options, and allows you to fit your 
data on one page or many. You can print several graphs per page, even if you 
only have one-channel recordings. Since MP System (MP150 or MP36R)s run on 
Windows or Mac OS, no special printer drivers are required. 

Report generation AcqKnowledge has many features to simplify report generation. Use the Journal 
for notes and quickly copy and paste graph data or measurements to the journal or 
to another program. Cascade event markers to prevent print overlap and select the 
range of data to print and which options to display (measurements, event markers, 
etc.). Use the Playback mode to simulate acquisition for presentations. 

User Support Whether you have a question about compatibility with your existing equipment or 
you need to develop a specialized measurement device, BIOPAC’s Applications 
Department can address the problem. 
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Application Features 
Use your MP System with AcqKnowledge software for a wide array of applications, such as:  
 

Active Electrodes 
Allergies 
Amplitude Histogram 
Anaerobic Threshold 
Animal studies 
Auditory Evoked Response 

(AER) 
Automate Acquisition Protocols 
Automated Data Analysis 
Automatic Data Reduction 
Autonomic Nervous System 

Studies 
Biomechanics Measurements 
Blood Flow / Blood Pressure 

/Blood Volume 
Body Composition Analysis 
Breath-By-Breath Respiratory 

Gas Analysis 
Cardiac Output 
Cardiology Research 
Cell Transport 
Cerebral Blood Flow 
Chaos Plots 
Common Interface Connections 
Connect to MP System (MP150 

or MP36R)s 
Control Pumps and Valves 
Cross- and Auto-correlation 
Current Clamping 
Defibrillation & Electrocautery 
Dividing EEG into Specific 

Epochs 
ECG Analysis 
ECG Recordings, 12-Lead 
ECG Recordings, 6-Lead 
EEG Spectral Analysis 
Einthoven’s Triangle 
EMG and Force 
EMG Power Spectrum Analysis 
End-tidal CO2 
Episode Counting 
Ergonomics Evaluation 
Event-related Potentials 
Evoked Response 
Exercise Physiology 
External equipment, controlling 
Extra-cellular Spike Recording 
Facial EMG 
FFT & Histograms 
FFT for Frequency Analysis 
Field Potential Measurements 
Fine Wire EMG 
Forced Expiratory Flow & 

Volume 

Gait Analysis 
Gastric Myoelectric Activity 
Gastric Slow Wave Propagation 
Gastrointestinal Motility 

Analysis 
Hardware Flexibility 
Heart Rate Variability 
Heart Sounds 
Histogram Analysis 
Imaging Equipment, Interfacing 
Indirect Blood Pressure 

Recordings 
Integrated (RMS) EMG 
Interface with Existing 

Equipment 
Interface with Third-party 

transducer 
Invasive Electrode 

Measurements 
Ion-selective Micro-electrode 

Interfacing 
Iontophoresis 
Irritants & Inflammation 
Isolated Inputs & Outputs 
Isolated Lung Studies 
Isometric Contraction 
Isotonic Contraction 
Jewett Sequence 
Langendorff Heart Preparations 
Laser Doppler Flowmetry 
Left Cardiac Work 
Long-term Monitoring 
Lung Volume Measurement 
LVP 
Median & Mean Frequency 

Analysis 
Micro-electrode signal 

amplification 
Migrating Myoelectric Complex 
Motor Unit Action Potential 
Movement Analysis 
MRI Applications 
Multi-Channel Sleep Recording 
Nerve Conduction Studies 
Neurology Research 
Noninvasive Cardiac Output 
Noninvasive Electrode 

Measurements 
Nystagmus Investigation 
Oculomotor Research 
Off-line ECG Averaging 
Online Analysis 
Online ECG Analysis 
Orthostatic Testing 
Peripheral Blood Flow 

Peristaltic (Slow Wave) Propagation 
Planted Tissue 
Pressure Volume Loops 
Psychophysiology 
Pulsatile Tissue Studies 
Pulse Rate Measurement 
Pulse Transit Time 
Range of Motion 
Real-time EEG Filtering 
Real-time EEG Filtering 
Recurrent Patterns 
Regional Blood Flow 
Relative BP Measurement 
Remote Monitoring 
Respiration Monitoring 
Respiratory Exchange Ratio 
Rheumatology 
Saccadic Eye Movements 
Sexual Arousal Studies 
Signal Averaging 
Simultaneous Monitoring 
Single Channel Analysis 
Single-fiber EMG 
Software-controlled Stimulator 
Somatosensory Evoked Response 
Spectral Analysis 
Spike Counting 
SpO2 Analysis 
Stand Alone Amplifiers 
Standard Operating Procedures 
Startle Eye Blink Tests 
Startle Response 
Stimulator, software-controlled 
Systemic Vascular Resistance 
Template Analysis 
Tissue Bath Monitoring 
Tissue Conductance Measurement 
Tissue Magnitude & Phase Modeling 
Tissue Resistance & Reactance 
Ussing Chamber Measurements 
Ventricular Late Potentials 
Vestibular Function 
Visual Attention 
Visual Evoked Response 
VO2 Consumption 
Volume/Flow Loop Relationships 
Working Heart Preparations 

 



 

 

Application Notes 
BIOPAC has prepared a wide variety of application notes as a useful source of information concerning certain 
operations and procedures. The notes are static pages that provide detailed technical information about either 
a product or application. A partial list of Application Notes follows. You can view or print application notes 
directly from the Support section of the BIOPAC website www.biopac.com. 

APP NOTE Application 
#AH101  Transducer Calibration and Signal Re-Scaling 
#AH102  Biopotential Amplifier Testing w/ CBLCAL 
#AH103  Remote Monitoring System (TEL100C) 
#AS105 Auditory Brainstem Response (ABR) Testing 
#AS105b/c ABR Testing for Jewett Sequence 
#AS108 Data Reduction of Large Files 
#AS109 3-, 6-, and 12-Lead ECG 
#AH110  Amplifier Baseline (Offset) Adjustment 
#AS111 Nerve Conduction Velocity 
#AH114  TSD107A* Pneumotach Transducer 
#AH114b  TSD107B* Pneumotach Transducer 
#AS115 Hemodynamic Measurements—Part I 
#AS116 Hemodynamic Measurements—Part II 
#AS117 Pulse Transit Time and Velocity Calculation 
#AS118 EMG Signal Analysis 
#AS119 EMG Power Spectrum Analysis 
#AS120 X/Y Loop Area Analysis 
#AS121 Waveform Data Reduction 
#AS122 Power Spectrum Analysis 
#AH125  Pulse Oximeter Module Operation 
#AH127  Precision Force Transducers 
#AH128  Active Electrode Specifications and Usage 
#AS129 Heart Rate Variability 
#AH130 Blood Pressure Measurement 
#AS131 Averaging Mode 
#AH132 TSD105A Variable Force Transducer 
#AH135 TSD117 Pneumotach Transducer 
#AH136 BAT100 Instructions 
#AH140 Angular Measurements with Goniometers 
#AH141 Tri-Axial Accelerometer Calibration 
#AS142  AcqKnowledge Rate Detector Algorithm 
#AS143 Importing AcqKnowledge Data Into Excel 
#AH144 Hand Dynamometer Calibration 
#AH145 TSD101B Respiratory Effort Transducer  
#AS148 Automated ECG Analysis 
#AH149 O2100C Module 
#AH150 O2100C Module—Sample application 
#AH151 CO2100C Module 
#AH152 CO2100C Module—Sample Application 
#AH153 Physiological Sounds Microphone 
#AH154 HLT100C High Level Transducer 
#AS158 Analysis of Inspired and Expired Lung Volume 
#AH159 TSD116 Series Hand Switch and Foot Switch 
#AH160 Gas Analysis Module Response Time 
#AS161 Automated Tissue Bath Analysis 
#AH162 Stimulation Features 
#AS168 Analysis of Intraventricular Pressure Wave Data (LVP Analysis) 
#AS169 Speech Motor Control 
#AH170 LDF100A Laser Doppler Flow Module 
#AH175 Using the STMISOC Stimulus Isolator 
#AS177 ECG Analysis using the Offline Averaging Mode 
#AS183 VO2 Measurement 
#AH186 Psychological Assessment using the TSD115 
#AH187 Electrodermal Response (EDR) using the GSR100 or TEL100 
#AH190 Using the MCE100C Micro-electrode Amplifier 
#AS191 Cardiac Output Measurement using the EBI100C and AcqKnowledge 
#AH249 Online Averaging Latency Parameters (ISI, ABR) 

http://www.biopac.com/�
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Chapter 2  AcqKnowledge Overview 
Overview 

 
AcqKnowledge software performs two basic functions: acquisition and analysis. The acquisition settings 
determine the basic nature of the data to be collected, such as the amount of time data will be collected for 
and at what rate data will be collected. All of the acquisition parameters can be found under the hardware (or 
MP) menu. The other menu commands pertain to analysis functions such as viewing, editing, and 
transforming data. 
Note:  Minor differences exist between the Windows and Mac OS X screen displays and keystroke/mouse 

functionality. These differences are noted throughout this section. 
Menu Functionality See Page 

File New, Open, Open Recent, Open for Playback, SMI BeGaze Import, Close, Save, 
Save As, Save Selection As, Save Journal Text As, Send Email as Attachment, Page 
Setup, Print, Quit 

248 

Edit Undo, Cut, Copy, Paste, Clear/Clear All, Remove Last Appended Segment, Insert 
Waveform, Duplicate Waveform, Select All, Remove Waveform, Create Data 
Snapshot, Merge Graphs, Clipboard (Copy Measurement, Copy Wave Data, Copy 
Graph, Copy Acquisition Settings, Copy Data Modification History for All Channels, 
Copy Data Modification History for Graph, Copy Focus Area Summary, Copy Event 
Summary), Journal (Paste Measurements, Paste Wave Data, Paste Acquisition 
Settings, Paste Modification History for All Channels, Paste Modification History for 
Selected Channel, Paste Focus Area Summary, Paste Event Summary, Manage 
PDFs, Show Journal) 

272 

Transform operations that primarily modify the data in the graph 
Recently Used, Digital Filters, Fourier Linear Combiners, Math Functions, Template 
Functions, Integral, Derivative, Integrate, Smoothing, Difference, Resample 
Waveform, Resample Graph, Expression, Delay, Rescale, Waveform Math, Slew Rate 
Limiter 

282 

Analysis operations that derive data & measurements from the graph 
Recently Used, Histogram, Autoregressive Modeling, Nonlinear Modeling, Power 
Spectral Density, Autoregressive Time-Frequency Analysis, FFT/IFFT, DWT Discrete 
Wavelets, Principal Component Analysis/Inverse PCA, Independent Component 
Analysis/Inverse, Find Cycle, Find Rate—plus a courtesy copy of the Specialized 
Analysis package with classifiers and automation routines 

313 
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Display Tile Waveforms, Autoscale Single Waveform, Autoscale Waveforms, Optimize 
Ranges, Overlap Waveforms, Compare Waveforms, Autoscale Horizontal, Show All 
Data, Show Default Scales, Zoom, Reset Chart Display, Reset Grid, Adjust Grid 
Spacing, Set Wave Positions, Set Channel Visibility, Wave Color, Horizontal Axis, 
Show, Customize Toolbars, Channel Info, Preferences, Size Window, Cursor Style, 
Split View, Create Data View, Create Focus Area, Organize Data Snapshots, Show All 
Data Snapshots, Load All Data Into Memory 

427 

MP150 
MP36 
B-Alert* 
BioHarness* 
Mobita* 

Set Up Data Acquisition, (Channels, Length/Rate, Event Marking, Segment Labels, 
Stimulator, Trigger, Sound Feedback), Set Up Advanced Averaging, Show Input 
Values, Show Manual Control, Show Gauge, MP150 info, Update Firmware, 
AutoPlotting, Scrolling, Sweep, Warn on Overwrite, Organize Channel Presets, Set Up 
Linked Acquisitions, Exit Playback Mode, Manage Hardware Connections 
*Not all MP hardware menu items listed above will be available with B-Alert, 
BioHarness, Mobita or hardware. 

106 

Playback Replaces the hardware menu when Playback mode is active (use File > Open for 
Playback and Playback > Quit playback to toggle playback and acquisition modes) 

43 

Window Controls the position of windows on the monitor 456 
Help Provides online support files (PDF format and web links). 456 
Media Capture or Playback media files(.avi, .wmv, or mpg) and synchronize with .acq data 458 

 
Launching the AcqKnowledge software 
The first step is to launch the software by double-clicking on the AcqKnowledge icon. If 
hardware is not properly connected, you may receive connection messages resembling the 
following examples. (Examples shown are from the commonly-used MP150 hardware.) 
 

 

 
 

 
If you receive a hardware prompt when you launch AcqKnowledge, there are two possibilities: You have not 
properly connected everything and/or you have not powered up the hardware system. 
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 To use AcqKnowledge without a data acquisition unit (depending on the dialog), choose Cancel, 
Analyze Only, No Hardware, or set Preferences > Hardware > General to “Always work with no 
data acquisition hardware connected.” 

 
 
Assuming everything is properly connected and there are no conflicts, AcqKnowledge will launch the Startup 
Wizard (see next page). Use this wizard to choose whether to create a new experiment, open a saved graph for 
analysis or access the Help and support files.  

 
Standard Startup Wizard under 

‘Create and/or Record a new 
experiment’  

Functionality 

Create empty graph Opens new graph window for acquiring data with hardware. Combo box to the right 
selects hardware, if more than one type is available. 

Open graph template from disk Brings up ‘Open’ window for browsing to location of saved graph templates. 

Use recent graph template Activates list of recently-opened graph templates for easy selection. 

Sample graph template Activates list of sample graph templates stored in AcqKnowledge program folder for 
easy selection. 

Quit/OK Quits application or confirms selected operation. 
Hardware type menu (center right of 

screen) 
If different hardware types have been previously added, they may be selected here 

upon subsequent application launches. (If not, this menu will not appear.) 
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 Open a graph file  Presents similar options for analyzing existing graphs, including a checkbox 
option to launch graphs in Playback mode. Playback mode will “replay” 
previously recorded graph data in real time. 

 BioNomadix Logger Presents options for importing BioNomadix Logger data from the Logger 
device or from disk. Not applicable unless the wireless BioNomadix Data 
Logger is being used. For further information about the Logger, click here. 

 Help  Launch various help and support options, including Web screencast tutorials. 
Upon first application launch, this selection is displayed by default. 

NOTE: The Startup Wizard may be disabled following launch if desired. Choose “Display > 
Preferences > Other > When application is lauched," change the default from “Show Startup Wizard” 
to “Create new empty graph window” and click OK.) 

A “window” is the term used for the area on your computer’s screen where data is displayed and/or 
manipulated. The graph window on the screen is designed to provide you with a powerful yet easy-to-use 
interface for working with data. 
At this point, you can use this window, create a new window, or open an existing window. 
It’s a good idea to create a new graph window for each acquisition. To create a new graph window after the 
original launch, choose “File > New.” 
Setting up channels using Module Setup (MP150 Hardware) 
By default, AcqKnowledge presents the Module Setup dialog when a new graph window is launched via 
“Create/Record a new experiment.” This view enables stepwise configuration of AcqKnowledge modules and 
transducers simply by choosing from the list of supported hardware options, which can greatly simplify setup. 

 
For further details on Module Setup, see page 109.  
Setting up channels manually 
If manual setup of channels independent of hardware is preferred, click “Cancel” in the Module Setup dialog 
and choose the “View by Channels” option at the bottom of the channel setup screen. This will display the 
manually-configured Input Channels Setup dialog. 
NOTE: You may also disable the default factory channel setup by going to “Display > Preferences > 
Hardware” and changing the “When creating new graph windows use:” option from “Minimal channel 
setup” to “User-defined default channel setup.” (For full details on this preference, see page 451.) 
Also note that, when using this setting, the following message will appear upon closing the setup dialog until 
all user-defined default settings are accepted by clicking “Yes.” 

 

http://www.biopac.com/BioNomadix-Logger�
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Basic Analog Channel Information 

  
By default, all channels are deselected on new graph windows. Usually, you will want to check all three boxes 
(Acquire, Plot, and Value) for each channel selected to acquire data. 
Acquire When the Acquire box is checked for a given channel, data will be collected on that channel. 
Plot Determines if data will be plotted in real-time during the acquisition. If the plot box is unchecked, 

data will be recorded, but the associated channel will remain hidden.  
Value Enables a separate Show Input Values window to display the values for each channel in real time, 

numerically and/or graphically.  
Channel This is a dynamic alpha-numeric heading based on the type of channel selected: Analog (or 

continuous), Calculation, or Digital. In the sample above, “A1” indicates Analog channel one. 
Label To the right of each channel number is an editable label for entering channel information. 
Channel The channel sample rate is a function of the acquisition sample rate: all channel sample rate 
Sampling options are equal to or less than the acquisition sample rate (as established via “Hardware 
Rate   > Set Up Acquisition”). The options are a specific power of 2 less than the acquisition 
 sample rate. Use the pull-down menu to set the channel sample rate. See page 113 for details. 
Basic Digital Channel Information 
In contrast to analog data, Digital channels collect binary data that represent when a measuring instrument is 
“on” or “off.” (For example, records whether a switch is open or closed, as in reaction time studies or control 
applications.) Digital channels are acquired, plotted, and have values listed the same fashion as analog 
channels. For more details about Digital channels, see page 122. 
Basic Calculation Channel Information 
Calculation channels are used for online computations and transformations of other channels. These channels 
are configured similarly to analog and digital channels, but also have additional dialogues to specify the types 
of transformations and computations to be performed.  
Calculation channels include Presets as a quick way to get started—choose a preset and the software 
automatically sets the gain, offset, etc. appropriate for the selected application.  
When a new Calculation channel is enabled, a simple setup dialog corresponding to the selected preset is 
presented, which helps facilitate proper setup. Choose from the list of available presets or create a custom 
preset; see page 112 for details. 
For a detailed summary of Calculation channel options, see the Calculation Channel section beginning on 
page 122. 

 For a detailed look at launching and setup of AcqKnowledge software, watch the Tutorial video. 
Selecting Hardware 
When AcqKnowledge is first launched, you may select an available data acquisition device from the “Connect 
to:” dialog. The dialog lists all devices that are powered ON and sitting on the same local area network. When 
using more than one MP150 device or working across a network, it will be necessary to lock/unlock an 
MP150 to acquire data (see Appendix E on page 565 for details). The selected MP150 unit will be listed in 
the upper left of the graph display as “Connect to:” if the Hardware toolbar display is enabled. 

 
If using AcqKnowledge 
with BioHarness™, Analog  
channels can be turned  
on/off but not changed. 

http://www.biopac.com/video/?video_category=acqknowledge-new-features&v=acqknowledge-4-4-gui-overview�
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(To display the Hardware toolbar click the “add toolbar” icon          and check the “Hardware” option.   

 

Setting Up Acquisitions 

 

 
Once the channel parameters have been defined, the next step is to specify the acquisition settings. Choose 
Hardware menu > Set Up Data Acquisition > Length/Rate from the Data Acquisition Settings dialog to 
specify the type of acquisition to be performed. The basic parameters involve:  

a) How data should be collected and stored 
b) The data collection rate 
c) The acquisition duration (total length) 

Storage Record and Append to Memory is the default acquisition option. Under this option, the MP System 
automatically records data into a single continuous file, and stores the data in computer memory 
(RAM) during the acquisition. 
The third popup menu at the top of the dialog (which defaults to Memory) specifies where data should 
be stored during the acquisition. You will probably want to choose Memory or Disk storage. If your 
system uses any virtual memory, AcqKnowledge will use as much as possible. You may also store 
data directly to the MP150 data acquisition unit, which can store 4 MB; you cannot store data directly 
to the MP36R or other BIOPAC hardware types. 

 The advantage of storing to the MP data acquisition unit is that much faster 
sampling rates may be obtained. 

 The disadvantages of saving data to the MP data acquisition unit are that there is 
limited storage space and that data is not displayed on the screen while it is being 
collected. When the acquisition has stopped, however, the data will be automatically 
displayed on the screen. 

The other option under storage is Averaging, which allows you to take repeated trials of the same 
data. For more information on this feature, see the averaging section on page 162.  

Rate Acquisition Sample Rate refers to how many samples the MP System should take each second. The 
higher the sample rate, the more accurate the signal processing. However, as the sampling rate 
increases, so does the demand for system resources (memory, disk space, etc.). There is a “point of 
diminishing return” in terms of sampling rate for almost all types of analog signals, where sampling 
above a given threshold adds relatively little information. 
The MP150 sampling rate has a lower bound of 0.1 samples per second, and an upper bound of 400 
kHz aggregate. The MP150 must use a pre-defined rate; it does not accept custom rates. 
Choose the best acquisition sample rate from the pop-up list. 
Note:  Channel sample rates are variable based on the acquisition sample rate. All channel sample 

rate options are equal to or a specific power of 2 less than the acquisition sample rate. 

Duration The final acquisition parameter is Acquisition Length (Total Length), which controls how long an 
acquisition will last. This can be scaled in seconds, minutes, hours, milliseconds or number of 
samples. You can set this value either by entering a number in the acquisition length  box, or by 
moving the scroll box left or right. 
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Starting an Acquisition 
Once you have specified which channels will contain data and have defined the channel characteristics, the 
next step is to start the acquisition. If a file window is not already open, choose File > New > Graph window. 
Status light 
Next to the Start button, you should see a circular status light. The status light indicates the communication 
link between your computer and the data acquisition hardware unit. 
 If the data acquisition hardware unit is properly connected to the computer and is turned on, the circle will 

be solid and green. 
 If the data acquisition unit is not properly connected or not communicating with the computer, the circle 

will be solid and gray.  
 Start 

To start an acquisition, position the cursor over the  button and click the mouse button, or select 
Ctrl+ Spacebar. If there are electrodes or transducers connected to the data acquisition unit, it will collect a 
small value of random signal “noise” with a mean of about 0.0 Volts. 
 For information on how to connect measurement devices to Hardware Systems, see the BIOPAC 

Hardware Guide.pdf. 
 To start an acquisition using a variety of “triggers,” see page 173. 
 Graphs that open without a Start Button 

o Compressed Graphs 
o Igor Pro Experiment 
o PhysioNet 
o DWT, IDWT 
o PCA, IPCA, 
o ICA, IICA, 
o AR Model separate graph output  
o Nonlinear Modeling separate graph output 
o HRV tachogram output 
o Chaos > Plot Attractor 
o Chaos > Detrended Fluctuation Analysis 
o MatLab Graphs 

o Merge Graphs 
o Original Data Snapshot 
o Raw Data Files 
o Text Files 
o Transform menu operations: Off-Line 

Averaging; Filter Response 
o Analysis menu operations: 

Histogram; FFT (Magnitude and 
Phase); IFFT; Rate (put result in new 
graph option) 
 

 

Once an acquisition has started, the Start button in the acquisition window will change to Stop, and two 
opposing arrows will blink, indicating that data is being collected. Also, the “BUSY” indicator light on the 
front of the data acquisition unit will illuminate, showing that data is being collected. 

Stopping an Acquisition 

To stop an acquisition at any time, click the  button or select Ctrl+ Spacebar. 
An acquisition will stop automatically when it has recorded an amount of data equal to that indicated in the 
Total Length box. To save this data file, choose File > Save. 
The double-arrow icon to the right of the Start/Stop button is the rewind segment button. Use this button to 
remove any unwanted recording segments from the graph. For more details, see page 169. 
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Display Modes 
The display modes are Chart, Scope, X/Y, Stacked Plot, and Playback. You may change the way data appears 
on the screen at any time, even during an acquisition. To change the display mode, click the corresponding 
icon in the toolbar. 

 Chart mode  
Chart mode is the default display mode. 
Chart mode plots data much as it might appear on a 
chart recorder, with time on the horizontal axis. 
Each channel of data is in its own “track” across the 
screen, with borders between channels. The 
waveforms will not cross boundaries into the tracks 
of adjacent channels. 
If a waveform is plotted off the scale of the channel 
track, choose autoscale waveforms and 
AcqKnowledge will select the “best fit” for 
waveforms to their tracks.  

 Scope mode  
Scope mode plots data much as it might appear on an 
oscilloscope, with time on the horizontal axis. 
Scope mode is similar to Chart mode, except that 
there are no borders between different channels. 
 To help emphasize the selected wave in Scope 

mode, select the “Gray non-selected waves” 
Preference (via Display > Preferences). 

Waveforms can overlap. The autoscale waveforms 
command will automatically separate the waveforms 
in the graph window. 
Note: When only one waveform is present, the scope 
and chart modes are identical.  

 X/Y mode  
X/Y mode plots data from two channels against each 
other, with the values from one channel on the 
horizontal axis and the values from another channel 
on the vertical axis. Plotting a channel against itself 
displays a straight line. 
X/Y mode can be useful for chaos investigations and 
respiration studies.  
Note: When viewing data in X/Y mode as it is being 

acquired, plotting only the most recently 
acquired data point can be a useful option. To 
do this, select Display > Show > Dot Plot and 
then Display > Show > Last Dot only. 

Switching to X/Y mode during acquisition can be 
slow. For best performance, switch to X/Y mode 
either before starting the acquisition or after stopping 
the acquisition. 
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 X/Y mode continued 
Plotted channels 

• To change the channel being plotted: Click the Channel label once and hold. 

 
X-axis, click above the waveform; Y-axis, click left of the waveform. 

• To flip the axes: Click the button in the upper left. 

 
• To change the channel label for this plot: Click the Channel label. 

 
Toolbar icons 
The center cluster of toolbar items is specific to X/Y mode. The left two buttons in this group are shortcuts 
for the Autoscale vertical and Autoscale horizontal functions. Adjacent to these buttons are two buttons that 
perform the center vertical and center horizontal functions.  
Tools 

Cursor: In X/Y mode, the I-beam tool in the lower right hand corner of the graph window changes into a 
crosshair. When the crosshair is moved into the graph window, the coordinates of the crosshair are displayed 
in the upper left corner of the graph window. The X value refers to the coordinate of the crosshair in terms of 
the horizontal axis, and the Y value describes the location of the cursor in terms of the vertical scale. By 
pressing the mouse, a crosshair is drawn over the closest data point and the measurement toolbar “snaps” to 
that position to show the amplitudes of the actual pair of data samples plotted on the screen. In 
AcqKnowledge 4.2 and higher, the Channel number and label are also displayed next to the measurement 
values.  

 
X/Y plot with ECG on X-axis and BPM on Y-axis 

Autoscale: In X/Y mode, the Autoscale waveform function changes to read Autoscale vertical, which 
plots the vertical channel so that it takes up two-thirds of the vertical channel space. This 
function controls the “height” of the data being plotted in the graph window. 

 Similarly, the Autoscale horizontal function plots the waveform so that the waveform is 
plotted in the center two-thirds of the window. This function controls the “width” of the data 
being plotted in the graph window.  
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Autoscale commands adjust the center point and the range of data displayed. To manually 
change the scale, click in either the horizontal or vertical scale area. In this case, the scale at 
the bottom edge of the graph windows (which usually reflects time) is the scale for the X 
variable, and the vertical scale controls the scale for the channel plotted on the Y-axis. 

Center: In X/Y mode, since only two channels can be displayed at a time, tile waveforms and 
compare waveform are replaced with Center horizontal and Center vertical. These two Center 
commands change the midpoint of the horizontal and vertical scales (respectively) so that the 
midpoint of the scale is equal to the mean value (average) for that channel. These features are 
useful for centering the display so that it is easier to interpret. 

Ch. # Box:  In X/Y mode, the channel numbering boxes are disabled. 
Meas. Menu: In X/Y mode, the measurement popup menus are disabled. 
Plot Recent Data Only 

 
Use this option in X/Y mode to plot a user-defined amount of recent data. Checking the “Plot recent data 
only” and entering a value will hide plotting for all data not included in the entered time value. 

  
 Plot recent data option not applied  Plot recent data option applied with 6 sec. value 
 

 Stacked Plot mode 
Stacked Plot displays multiple time ranges on top of each other and is enabled for acquisitions set to Append 
(except when in X/Y mode). In this mode, all appended segments are stacked in the display, but only one 
segment “slice” is active (“selected”). To view an individual segment, click the Chart mode icon. 
 Click the Stacked Plot mode icon to display the Stacked Plot controls beneath the toolbar: 

 

To change the active slice, click the  Jump Tool or the … icon. 
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The selected segment is used for all enabled software functions. This means that autoscaling can easily create 
what looks like a mess if the selected segment is not appropriate for scaling the largest segment. In compound 
action potential graphs in Stacked Plot, the last segment slice will most often be the largest, so if you select 
the last segment before autoscaling you will likely get the expected result. The Transform menu is disabled in 
Stacked Plot mode. 
A commonly used data visualization technique for examining the evolution of waveform morphology is the 
2D waterfall plot or “stacked plot.” A stacked plot draws multiple traces for a single waveform on top of each 
other, or “slices.” Each individual slice is a time-shifted plot of the original waveform. The slices toward the 
bottom of the plot occur earlier in time then the slices toward the top. 
Data can be acquired in stacked plot mode, but it is processor intensive. If acquisition setup includes high 
sampling rates or control channels with low latency, acquire in chart or scope mode and switch to stacked plot 
mode after acquisition. 
The slices can be aligned at any type of events in the graph. This allows for alignment at appended segments 
but also at locations found through other means. For example, an ECG waveform can be aligned at the start of 
the T-wave to examine how the T wave evolves in time. 

Active slice In stacked plot mode, there is a single slice that is called the “active slice.” By default 
it is drawn in black; to change the color, select Stacked Plot Options > Drawing 
Settings. The values on the axes in the graph, grid, displayed events and text 
annotations, selections, and any transformations all apply to the active slice. The 
active slice can be changed using the navigation buttons in the graph toolbar. 

Vertical Separation The vertical separation between consecutive slices is expressed as a percentage of the 
entire visible area. This percentage is kept constant through zooming and scrolling 
operations. 

Stacked Plot Options 

 
Display > Show > Stacked Plot Options 

 
Slicing Event… 

 
Drawing Settings… 

Use Stacked Plot Options to activate slices or visually distinguish the active slice from other slices being 
drawn in Stacked Plot mode. 
Automatic baseline  Adjusts the baseline of each inactive slice to overlap the baseline of the active slice 

prior to the application of any vertical separation. This helps compensate for baseline 
drift in a signal. If it is disabled, no baseline compensation will be applied and the 
stacked plot may exhibit visual vertical segment ordering problems resulting from 
baseline drift (but in this mode can be used as a tool to examine basline drift). 

Gray inactive slices Draws the active slice with a solid pen and draws inactive slices with a dashed gray 
pattern pen. The gray pattern alternates pixels between the chosen waveform color 
and the white background and has the effect of lightening the inactive slices, so you 
may need to zoom in to see the effect. 

Bold active slice Draws the active slice with a thicker pen. In step and line plot modes, plotting 
normally occurs with a one pixel wide pen. Inactive slices will remain one pixel wide 
while the active slice will have the thicker pen as indicated in the edit field. When the 
waveform is in dot plot mode, the pixel width will be added to the waveform's default 
dot size to increase the dot size for the active slice. 
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Change active slice… Draws the active slice in a different color than the chosen waveform color. When 
enabled, the same color is used for the active slice of each waveform in the graph. 
The color can be changed by clicking on the colorwell to the right of the checkbox to 
generate a standard color picker to select color. 

 

Automatically jump…  You can use the Jump tool (green arrow) to change the active slice. Each time 
the active slice is changed the left edge of the plot area will be changed to match the 
start of the newly activated slice. When disabled, each time the active slice is 
changed the display will be adjusted in such a way that the time interval between 
slice starting positions and the display origin is kept constant.  

Functionality in Stacked Plot mode 
Autoscaling 

When a graph is displayed in stacked plot mode, all autoscaling and related display operations (tile, 
compare, overlap) will examine the visible data of the active slice only. It will not be possible to perform 
autoscaling operations using the data of any inactive slice. 

Autoscale Horizontal 
In stacked plot mode, autoscale horizontal will make the active slice occupy the entire visible area. The 
slicing event corresponding to the beginning of the slice will be placed at the left edge of the screen and 
the next slicing event (or last sample point of the waveform if the active slice is the last slice) will be 
placed at the right edge of the screen. The vertical offset will remain unaffected. 

Data Views 
Different data views may have independent Stacked Plot settings. All settings are independent including 
drawing preferences, slicing events, vertical separation, and active slice settings. Stacked plot settings are 
stored individually for each data view in the graph file and will be restored when the graph file is opened 
from disk. 
Any graph-wide operation that may affect the active slice will update all data views that are configured to 
use stacked plot mode. This includes operations that affect the data (e.g. transformations) or events (e.g. 
waveform editing). 

Graphs Containing No Slices 
It is possible that graphs may not contain any slices whatsoever if no events match the slicing event 
criteria. If a graph in Stacked Plot mode contains no active slices, it will be drawn as if the graph was in 
regular chart mode with the following differences: 
All data is drawn using any active slice settings given in the stacked plot drawing options. 
The “Active slice” index will read “N/A.” 
The previous/next/choose slice graph toolbar buttons and “Display > Show > Stacked Plot Options” menu 
items will be disabled. 
It will be possible to view all data from t = 0 to the final data sample of the graph using the horizontal 
scrollbar. 
All autoscaling operations will function as if chart mode was active. Autoscale horizontal will make all of 
the data of the selected waveform visible on screen. 



Part A — Getting Started 43 

AcqKnowledge 4 Software Guide 

If the table of available slices was being displayed prior to the removal/editing of the last matching slicing 
event, the table will be emptied and the “OK” button dimmed. The cancel button will remain active for 
the table window to be dismissed. 
The slicing event, vertical separation, and drawing menu items and toolbar controls will remain active. 

 Playback Mode (Replay) 
Playback mode will replay a graph file stored on disk in real time to 
simulate acquisition. Analog, digital and calculation channels are 
replayed as stored in the graph file. AcqKnowledge 4.2 and higher allows 
caluclation channels to be reconfigured, including  adding channels 
without an offline equivalent. Calculation channels from the original 
graph can be modified, added, or removed without affecting the data 
stored on disk in the original graph file. 

1. Select File > Open for Playback. 
2. Locate a graph file and then click Open. 
3. A new graph window will be generated. 
 The “Connected to…: hardware menu will indicate that the 

graph will be “acquiring” data from the specified file and the 
Start button will change to a “Replay.” 

4. Press Replay to begin playback. 
 The replay can be stopped, but not paused. If the acquisition 

mode is changed to Append, no additional segments will be 
displayed. 

5. Select Playback > Exit Playback Mode to return to acquisition 
status.  

 
Use Open for Playback to 
experiment with different 
calculation channels settings on 
the same data or to recreate an 
experiment for demonstration 
purposes. 

Playback mode has millisecond timing accuracy and allows for reconfiguration of most acquisition 
parameters. Exceptions include: 

 Length is limited to the amount of data in the file 
 Acquisition Sample Rate is fixed (use Channel Sample Rate to downsample) 
 Number of analog and digital channels is fixed  
 Save last, MP, and Averaging modes are disabled 
 “Append” will replay the same data. 

Do not record data while playing back a data file. If one data file is open in "Playback" mode and is 
'replaying' and a second data file is open in hardware mode and is acquiring data, clicking back and forth 
between graph windows causes the hardware device menu to flip to the Playback menu (even though 
'Connected to' shows communication with an MP150 unit). 

 Watch the AcqKnowledge Playback Mode video tutorial for a detailed demonstration of this feature. 
 

http://www.biopac.com/video/?video_category=acqknowledge-tutorials&v=acqknowledge-playback-mode�
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Data Views 
A “Data View” window is used to provide an alternate view of the same data. You can present data in two or 
more modes for comparison, such as X/Y plots and chart plots. To compare responses in real time, turn off 
Autoplot in one Data View (e.g., Dose 1) and continue Autoplotting in another (e.g., Dose 2).  
To create a new Data View for the active (selected) graph, choose: 
 File > New  and select type Data View 
 Display > Create Data View 
 Click the Data View toolbar icon  

This will generate a new window displaying the active graph’s data, and will name the new window “Data 
View of ‘Filename’ . 

TIP Use the Jump-to tool (see page 60) to correlate data views. 
Data Views share fundamental data characteristics such as channel labels, events, and sampling rates, but can 
be customized for the following: 
 horizontal scale, precision, and offset 
 vertical scale, precision, and offset 
 measurements, including number of 

rows, precision, visibility, and use of 
interpolation 

 grid settings, including spacing, 
visibility, and locking state 

 selected area 
 autoplotting 
 hidden channels 

 autoscrolling 
 channel button display state 
 wave color 
 event display state 
 channel order 
 plot mode 
 channel drawing mode (step, line, or dot, 

including dot plot size and type) 
 hardware “connected to” display 

The Data View window can be used like any other graph window. The menus and controls can be used to change 
how the data is presented. An acquisition can be started or stopped in any of the Data Views for a graph, and any 
transformations performed on the data in the Data View will be reflected in the graph and all of the other Data 
Views. Printing a graph from a Data View will use the display settings of that Data View for outputting the graph. 
When a file is saved to disk, the display configurations of any open Data Views are saved into the graph file. 
When the graph file is reopened, all of the Data Views and their display settings will be restored. 
 Data Views are saved with the data file only if they are open at the time the original graph is closed and 

saved. 
 Closing a Data View causes this view to be lost; it is not saved with original file. 
 Closing a Data View that was previously saved with a data file will not be saved if the data file is saved 

after closing the Data View. 
 Closing a Data View will not invoke a warning that the Data View will not be saved. 
 Original Data Snapshot is not merged into the newly created data file. 

In AcqKnowledge 4.3 and higher, a selected area can be shared across multiple Data Views by clicking and 
holding the left mouse button over the I-beam toolbar cursor and choosing the “Link Selections Between Data 
Views” option. (See example figure below.) 
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Analysis 
For purposes of illustration, you should open an existing file that contains actual data. Sample files were installed 
with the software. Select File > Open and choose a file from the list in the dialog. 
After opening the file called demo data.acq, the screen should resemble the following sample file display. 

 
Sample File Display 

The sample graph displays six different types of data, and there is a border between the waveforms. 
To the left of each waveform is a vertical strip containing a text string that can be used to help identify each 
waveform. 
The time scale along the bottom denotes when the data was recorded relative to the beginning of the acquisition. 

 Only the last eight seconds of the total data record are visible, although the file contains 
the complete record. 

 The data displayed on the left edge of the graph represent events that occurred about 22 
seconds into the record, and the data displayed at the right edge of the screen represent 
events that occurred about 30 seconds after the acquisition was started. 

The maximum vertical scale range is from +10 to -10 Volts. 
 This reflects the maximum input voltage the hardware unit can accept and is a greater 

range than you will usually encounter. 
 The display scale can be adjusted to virtually any value range, as demonstrated in the 

graph window above. 
As indicated by the horizontal scale, only a few seconds of data are displayed on the screen. If you choose 
Statistics from the Display menu, you can determine the total length of the record. 
To view data that was collected earlier in the record, use the horizontal scroll bar to move to different points in the 
record. The horizontal scroll bar allows you to move around in a data file, just as the scroll bar in a word 
processor allows you to move to different points in a document. 
Alternatively, position the cursor in the horizontal scale area (where the numerical values are listed) and click the 
mouse button. This will generate the following dialog (see page 74 for details). 
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The Time scale box allows you to change the amount of data that appears on the screen at any given time. In the 
sample dialog, this is set to 2 seconds per division. The divisions on the screen are indicated by the four vertical 
lines, thus displaying eight seconds at a time (two seconds per division times four divisions). By entering a larger 
value in this box, more of the record will be displayed on the screen at any given time. Conversely, entering a 
smaller value in this box will cause a shorter segment of data to be displayed on the screen.  (Above screenshot is 
from AcqKnowledge 4.2) 

 To display the entire waveform (in terms of duration), a shortcut is to choose Autoscale horizontal from 
the Display menu. The Autoscale horizontal command fits the entire data file into the window, regardless 
of the total length of the acquisition. 

The Initial time offset 
box lets you “jump” to 
a different point in the 
time display. 
Changing the value in 
this box allows you to 
display data beginning 
at a certain point in the 
record. For instance, if 
you want to see the 
data at the beginning 
of this record, you 
would tell 
AcqKnowledge to 
display data with an 
initial offset of 0 
seconds, which would 
result in the following: 

As you can tell from the time scale, the first data displayed (at the left edge of the screen) was collected at the 
beginning of the acquisition. Also, the scroll box has moved to the left, indicating that the data on the screen 
represents data collected earlier in the record. 
If you click in the horizontal scale area again, the same dialog will appear, and this time the value in the start box 
should have changed to reflect the new section of data being displayed on the screen. 
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AcqKnowledge also allows customization of the vertical scaling, or amplitude, of each waveform. Clicking the 

vertical scale area produces a dialog (see page 75 for details). 
 The vertical scale dialog allows you to change the range of amplitude 
values displayed (scale) and set the value that appears in the center of 
the vertical scale (midpoint).  
You can vary the midpoint and apparent magnitude of each waveform 
by changing the values in each box. By changing the value in the scale 
box, a smaller value has the effect of increasing the apparent amplitude. 
Entering a number about half the current value will cause the amplitude 
of the wave to appear to double. 

• Scale—In the sample dialog, the units are set to 2 Volts per 
division. As with the horizontal scale, there are four divisions 
on the vertical axis, so this setting should show 8 Volts range of 
data. 

• Midpoint—The box below this controls the midpoint of this 
range. In this case, the midpoint is set to 2 Volts, which means 
that this channel will display the range from - 4 Volts to + 8 
Volts. 

As with the time scale, you can have AcqKnowledge automatically come up with the best fit in terms of midpoint 
and units per division. To do this, select the Autoscale waveform command from the Display menu, and the 
amplitude and offset of each wave will be adjusted to fit their sections. 
Any changes you make in terms of rescaling (either horizontal or vertical) will only affect the way data is 
displayed, and will not change the basic characteristics of your data file. 
Selecting a waveform 
Although all four waves are displayed at once, you may want to operate on only one channel at a time. To do this, 
you need to select the channel you wish to work with. Selecting a channel allows you to highlight all or part of 
that waveform, and enables you to perform transformations on a given channel. 
In the upper left corner of the graph window there is a series of boxes that represent each channel of data. The 
numbers in the boxes correspond to the channel used to acquire the data (the specifics of setting up channels are 
discussed on page 34). In the sample waveforms shown previously, ECG channels are represented by channels 1 
and 2, with respiration on channel 4 and blood pressure on channel 5. 
To select one of these channels 

• Position the  cursor over the channel box  that corresponds to the channel you wish to 
select and click the mouse, or  

• Position the  cursor on the waveform of interest and click the mouse. 
Show/Hide Channel 
To “hide” a waveform, press ALT for Windows or OPTION for Mac and click the channel box. 

Or, Alt+click on the channel number at the top of the channel label region.  
To view a hidden waveform, repeat the appropriate key-click combination. 
Alternatively, you can show/hide a channel via Display > Channel Visibility and checking/unchecking the 
channel boxes in the Channel Visibility dialog. (See this Display menu option on page 433.) 
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Collapsing Channels 
In AcqKnowledge versions 4.4.1 and higher, individual or multiple channels may be hidden from view or 
“collapsed” by simply clicking the triangular button appearing in the upper left region of each channel. When a 
channel is collapsed, all data is retained but simply hidden from view. Collapsing a channel allocates more 
vertical space to remaining channels, enhancing the view of the visible data. The examples below illustrate use of 
this tool when applied to Channel 5. 

 
Channel “Collapse” button (highlighted) 

 
Channel 5 collapsed 

To expand (unhide) the collapsed channel simply click the triangle button, or double click the collapsed channel’s 
label.  

NOTES: 

• Collapsing or expanding channels is supported in Chart or Stacked Plot mode only. 

• Pressing the Alt/Option key while clicking any triangle button will collapse or expand all visible 
channels. 

• Collapsed channels are retained when a graph is saved and reopened. 
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Zoom 
Another way to examine data is to use the “zoom” tool. The zoom tool allows you to select any portion of any 
wave and magnify it as much as possible. To use the zoom tool, click the  icon in the lower right portion of the 
screen. As you move the mouse into the graph area, you will see it change from an arrow  to a crosshair (+). 
Start by positioning the cursor in one corner of the box, holding down the left mouse button, and dragging the 
crosshair horizontally, vertically, or diagonally to form a “box” which encompasses the area you need to zoom in 
on. When you release the mouse button, AcqKnowledge will automatically adjust the horizontal and vertical 
scales. To “unzoom,” choose Zoom back from the Display menu. 
 
Select an area 
Once you have selected a channel, you can “edit” parts of that channel by selecting a section of the waveform. 
The options available to you include cutting, copying, and pasting sections of waveforms. You can also transform 
and analyze entire waveforms or specific sections of waveforms. 
For any of these functions, you will need to select (or highlight) an area to be operated on. If you want to select a 
section of a waveform, position the cursor over the  icon in the lower right hand corner of the screen and click 
the mouse button. Now move the cursor to the first point in the area that you wish to select. As you move the 
cursor into the graph area, you will see it change from an arrow cursor to a standard I-beam editing tool. 

To highlight a section of a waveform, position the  cursor at the left edge of the area you wish to select and 
hold down the mouse button. Now move the mouse to the right until you have selected the desired area. 

To select more than one screen of data, position the  cursor at the left edge of the section to be highlighted, 
then click and hold the mouse button. Use the scroll bars to move to a different point in the record, and when you 
reach the desired endpoint (right edge) of the selected area, hold down the Shift key while you position the cursor 
and click the mouse button. Selecting an area this way will also allow you to “fine tune” the selected area to 
include only a specific range of data. 
Once a channel has been selected and a section of that area highlighted, you can operate on and edit that section of 
the waveform. The editing commands behave much the same way as the editing functions in a word processor. 
You can cut, copy, delete or paste sections of data as defined by the selected area. In most cases (depending on 
available memory) you may undo an edit by choosing Undo from the Edit menu, or by using the shortcuts CTRL 
+ Z for Windows or +Z for Mac. 
Selecting a portion of a waveform also allows you to apply transformations to a particular area, rather than the 
entire area or all waveforms. Selecting an area also allows you to take snap measurements for parameters such as 
delta T, mean, standard deviation, frequency, and so forth. The measurement options are discussed in the next 
section. 
The Selection Palette (Display > Show > Selection Palette) can also be used to select an area. 
Keyboard data selection 
Keystroke combinations can similarly used to select or deselect graph data on a sample-by-sample basis. This 
helps add an enhanced level of precision to the selection operation. See data selection keyboard shortcuts on the 
following page. (AcqKnowledge 4.2 and higher) 

Keyboard Shortcut Description 
Windows: Shift + Ctrl + Left Arrow 
Mac: Shift + Command + Left Arrow 

Subtracts one sample interval from the right edge of the selection. If the selection is 
empty, no action is performed.  

Windows: Shift + Ctrl + Right Arrow 
Mac: Shift + Command + Right Arrow 

Subtracts one sample interval from the left edge of the selection. If the selection is 
empty, no action is performed. 

Shift + Left Arrow Adds one sample interval to the left edge of the selection. 
Shift + Right Arrow Add one sample interval to the right edge of the selection. 
Left Arrow Moves the selection one sample to the left, constructs a zero width selection. 
Right Arrow Moves the selection one sample to the right, constructs a zero width selection. 
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 Transform data 
AcqKnowledge includes a library of functions to transform data or perform mathematical 
calculations on waveform data. All of these options can be found under the Transform and 
Analysis menus, and are discussed in detail in the Analysis section beginning on page 
313. 
When performing transformations 

• If a section of a waveform is highlighted, the transformation will apply to that 
section. 

• If no area is selected, AcqKnowledge will always select a single data point. 
• If the transformation can only be performed on a selected area (digital 

filtering, for instance) and a single point is selected, the entire waveform will 
be used (and the transform entire wave option will be disabled; close out of 
the dialog and select an area if desired). 

 

Measurements 
Once you have selected a channel to work 
with, you can quickly and easily take 
measurements on each wave. The 
measurements appear in the row of boxes 
across the top of the graph window. You can 
specify the number of measurement boxes to 
show and the display precision in the 
“Preferences” dialog of the Display menu. 
Each measurement consists of three parts: (a) 
the channel selection, (b) the measurement 
function, and (c) the result or actual 
measurement value.  

 

The pull-down channel selection allows you to calculate a measurement either for the selected channel (SC) or 
from a numbered channel in the record. To switch between the channel options, click in the channel window. The 
pull-down menu shows the channel numbers and labels for all channels in the file. By default, each measurement 
will reflect the contents of the selected channel. 
The pull-down measurement menu allows you to choose between different types of measurements. To choose a 
measurement, click the measurement popup menu and select a measurement from the list. 

• Some measurements (such as Time or Value) look at only a single data point whereas other measurements 
(such as mean and delta T) examine a range of data on the selected channel. 

• Some of the measurements that depend on a selected area (such as delta T) look at differences in the 
horizontal axis measurement whereas other range measurements (such as peak-peak) use the vertical scale 
information in calculating measurements. 

For a complete description of each of the measurement functions, turn to page 91. 
The final component of a measurement window is the measurement result. 

• When an area is selected (or if the selected area is changed) the measurement result automatically updates 
to reflect the change. 

 

In this example, results for the selected channel (SC) are: 
 Time 17.28 sec 
 delta t 0.00000 sec 
 freq 0.10157 Hz 
 bpm 6.09446 BPM. 



Part A — Getting Started 51 

AcqKnowledge 4 Software Guide 

Events (Markers) 

 

In many instances it is useful to have the software mark an occurrence 
or event during an acquisition so it can be referenced later. For 
instance, you may want to note when a treatment began or when an 
external event occurred so you can examine any possible reaction. 
The software uses “Events”, which are marked in the data to record 
events.  

Event markers can be pre-established and automated. Event icons and labels appear at the top of the graph 
window, and can be edited, displayed, or hidden from view. 
You can automatically insert event markers during an acquisition by pressing the Esc key. This will insert a 
event at the exact time the key is pressed and will activate the text line entry so you can immediately enter a 
comment to be associated with the event. 
For a detailed description of events and event functions, including options to pre-establish event labels and set 
function keys for different labels, see Set Up Event Hotkeys (page 215). 

 Watch the AcqKnowledge Events video tutorial for a detailed demonstration of this feature. 
See also: Text Annotation, page 60. 
 
Grids 

  
Grid superimposes a set of horizontal and vertical lines on the graph window. The grid is designed to allow for 
easy measurements, since the grid lines correspond to horizontal and vertical scale divisions. The grid can be 
locked (analysis, printing) or unlocked (visual aid). 

To activate the grid display, choose Display > Show > Grid or click the  toolbar icon. 

 To display minor grid lines, use Ctrl- . 
 To customize grid line and color and optimize the display and print features, choose Display > Show > Grid 

Options. 
For more information about using and printing grids, see page 78 
Note: The Scale dialogs change when grid lines are locked. See page 74 for details on Horizontal Scale and page 

75 for details on Vertical Scale. 
Horizontal Split View 
Horizontal Split View is a tool for “splitting” the data in a single graph into two simultaneously viewable areas 
and displaying them side-by-side for convenient viewing. Split View is available for data plotted in scope, chart 
or stacked plot modes. Both views can contain independent time scales, initial offset and autoscroll settings. This 
can be useful for making side-by-side comparisons of data at different time ranges, or for reviewing the same 
section of data in two separate time scales for more detailed examination. Split View configurations and scalings 
can be saved and restored in the graph. 

Split View can be activated via the following methods: 
 Choosing Display > Split View  
 Clicking the Split View toolbar button  

Either method divides the graph into two equal regions with independent time scales, and the bar in the center can 
be dragged to the desired location. 

 

http://www.biopac.com/video/?video_category=acqknowledge-tutorials&v=event-marks�
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In the above example, the view in the left pane was rescaled independently of the view of the same data on the 
right pane. This enables a closer view of an area of interest while maintaining the original data display. If a Split 
View encompasses any events, annotations or focus areas, these will be visible in both panes.  
 Note that events, annotations, selected areas and focus areas appearing in the Split View are duplicate 

displays of the same items. If any of these items are added, modified or deleted in one view, this change 
will also be applied to the other view. 

 Split View is not supported in XY mode. 
 Printing of Split Views is not currently supported within the BSL application. If printing is desired, save the 

graph in *.jpg format or use standard operating system screen capture utilities. 
To exit Split View, uncheck the Display > Split View option or drag the Split View bar back to its home position 
at the left of the horizontal scale. 
 
Autoscroll Horizontal Axis Controls 
During data acquisition, three plotting modes are offered. These are normally accessed via the Hardware menu, 
but can be more easily dialed in by using the button in the lower right of the horizontal axis region. This 
button toggles between the following modes, and the button display changes to reflect the plotting type selected. 

Status Icon Description 
Manual  Horizontal axis is not modified by application during data acquisition. Only manual 

adjustments affect the data plot. Equivalent to unchecking both Hardware Menu > Autoplotting 
and Hardware > Scrolling. 

Sweep  Data is plotted until it reaches the right edge of the graph. At this point the data is scrolled, 
clearing data display and showing the newly acquired data starting at the left edge. This 
mimics the “sweep” of an oscilloscope. Equivalent to checking Hardware Menu > Autoplotting 
unchecking Hardware Menu > Scrolling, and checking Hardware menu > Sweep. 

Autoscroll  New data is plotted at the right edge of the graph. When new data is acquired, existing data is 
scrolled to the left, creating space to plot new data. Equivalent to checking both Hardware 
Menu > Autoplotting and Hardware Menu > Scrolling. 
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Journals 
The Journal is a general-purpose text editor built into AcqKnowledge that works like an “electronic notepad” for 
recording notes and data and saving text and/or numeric values for later review. The Journal can be used at the 
same time data is being acquired. Every graph file has a graph-specific Journal file permanently linked to it. There 
is also an option to generate independent Journals for data view, use with multiple graphs or protocols.  

 

Graph-specific journal—Journal is saved with graph; 
preferable for retaining notes and analysis within a 
graph file. Display settings are independent. To save 
a graph-specific Journal independent of its graph, 
use File > Save Journal Text As option. 

Independent Journal—Journal is saved into its own 
file, separately from graphs; preferable when 
performing analysis on multiple graphs at the same 
time. Independent journals allow multiple journal 
windows to be open at the same time (each graph 
view can have its own journal associated with it), but 
only one Independent Journal can be used at a time.  

For more information on using Journals, see Journal Details on page 83. 
Saving data 
Once data has been collected, it can be saved as a file and opened later. The data file can be moved, copied, 
duplicated and deleted just like any other computer file. By default, files are saved as AcqKnowledge (.ACQ) 
files, which are a proprietary format designed to store information in a format as compact as possible. Although 
these files can only be opened from within AcqKnowledge, the data in these files can be exported either as a text 
file or as a graphic image. 
Exporting data to a text file allows you to examine the data using other programs, such as a spreadsheet or 
statistical analysis package. Saving data as a graphic (.JPG) enables you to work with the data in graphic format. 
One of the most useful applications of this is the ability to edit and place AcqKnowledge data as it appears on the 
screen. You can use this feature to paste graphs into word processors, drawing programs, and page layout 
programs. To learn more about these options, turn to the Save As section beginning on page 261. 
Format change warnings 
When a file save function requires a format change for compatibility or alters file content, a prompt will be 
generated to require the user to confirm the option to update format or convert and save.  
 

  
Created with a previous version of AcqKnowledge  Windows PC AcqKnowledge format 
 

  
Saving as a “Graph Template” will erase all data Imported from another file format 
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“Data Snapshot” — Embedded Archive 
“Data Snapshots” are essentially embedded archives of the original acquired data that are stored with the graph 
file so you can easily view them together at a later time to compare results to original waveforms or intermediate 
stages of analysis. 

IMPORTANT Archive functions do not create a new file—they are not backup functions.  
Original data is copied and pasted to the end of the original file.  
You cannot use this feature to recover lost or damaged original data. 

There are two ways to create a snapshot: 
1. Automatic after acquisition: Display > Preferences > Other > Create Data Snapshots after acquisitions 

 
When this is enabled, a date-stamped archive of the data in the graph when acquisition stopped is created. 
In Append mode, the entire graph is archived with each Append, old data as well as the newly acquired 
data.  
This is a memory intensive function; 
each archive that is added to a graph file 
will increase its size on disk by 
approximately 40%. When prompted, 
click OK to proceed.  

2. Manual: Edit > Create Data Snapshot 

  
A snapshot is then taken of the data at that point in time and stored with the graph. Manual archives allow 
you to preserve intermediate stages in a complex analysis for future reference. You will be prompted for a 
comment to describe the archive. This description will be used in the header when you display the archive. 

To view the embedded archive(s) associated with a graph file, choose Display > Show All Data Snapshots. 
This will open a new graph window for each archive associated with the graph. The time portion of the Filename 
for each graph is from the computer clock (saved with semi-colons because you cannot save a file with colons in 
the filename). The “Data Snapshot from…” graph will open with no Start button.  

 

Manual Archive: description and time 
Original file 
Automatic Archive: time only 

Snapshots will also retain the following in addition to the data: 
• Events - Text annotations  
• Graph-specific journals 
• AcqKnowledge GLP Modification logs (ACK100W-G and ACK100M-G only)  
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Print 
AcqKnowledge allows high-resolution printing of 
hard-copy graph plots much as they appear on-
screen. 

• To print a file, choose Print from the File menu. 
This will print the contents of the screen on the 
selected printer. 

• To print the entire file, choose Autoscale 
Horizontal from the Display menu first.  

• You must print a journal as a separate command 
from print graph file. 

You may instruct AcqKnowledge to print the 
contents of a file across several pages by entering a 
value in the Fit to box. Entering “4” in this box, for 
instance, will place the length of the page evenly 
across four pages when printing. 
Print options are available after you click OK in the 
initial File > Print dialog; see page 270. 
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Chapter 3  User Interface & Context Menu Features 

 
 Toolbars 
 Keyboard Shortcuts 
 Mouse Controls 
 Custom toolbars for transformations and analysis 
 Toolbar position retention and changes 
 Event tool enhancements 
 Typed event label drawing improvements 
 Choose MP150 Help Button 
 Button Transparency 
 Customizable Chart Track Dividers 
 Plotting Background Colors 

 Vertical axis scaling buttons 
 Long channel labels and units 
 Graph window tooltip improvements 
 Menu item tooltips 
 Channel Info 
 Transformation history 
 Canceling Transformations 
 Transformation Progress Bar 
 Focus Areas 
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 Toolbars 
Many of the most commonly used features in AcqKnowledge can easily be 
executed with a mouse click. The toolbars contain shortcuts for some of the 
most frequently used AcqKnowledge commands. Click an icon to activate it; 
icons are grayed out when they are not applicable. 
By default, a minimal toolbar configuration is presented when AcqKnowledge 
is first launched. The default toobars will appear as follows: 

 
The default toolbars consist of: 

• Start/Stop button 
• Cursor Toolbar (Arrow, I-beam and Zoom tools) 
• Main Toolbar (Grid, Toolbar Display, Preferences and Customize Toolbar buttons) 

The full range of available toolbars can be displayed by enabling the checkbox options in the Toolbar Display 

shortcut button , or via Display > Show and enabling the desired options. Once the toolbar options have 
been selected, this will be the default toolbar display for all new graphs. All toolbars can be deselected and 
hidden with the exception of the Start/Stop button and the Cursor Toolbar (Arrow, I-beam and Zoom tools). 
Saved graphs created with different toolbar configurations will open with those toolbar options displayed.  
Toolbar position—Toolbars can be dragged and repositioned to any border of the graph window, or floated 
on top of a graph. Toolbars retain the last position they were left in after the application is closed and a new 
graph reopened. 
Restoring the default toolbar position – The default toolbar positions can be restored by going to Display > 
Preferences > Other and selecting “Reset toolbar positions.” The application must then be closed and 
relaunched for the reset to take effect. 

TIP: Preferences can also be accessed by clicking the Preferences toolbar shortcut icon . 

 
NOTE: The “Reset toolbar positions” option restores the default toolbar locations only; it does not hide 

toolbars or restore the default minimal toolbar configuration displayed upon first launch. To return 
toolbars to the default minimal configuration, it is best to deselect unwanted toolbars in the toolbar 
display menu.  

 (Use the Toolbar Display shortcut button  or Display > Show.) 
 You may also reset the toolbars to the default minimal configuration by holding down the Shift key 

while launching AcqKnowledge, but this is a “nuclear” option.” Choosing this option will reset ALL 
program defaults to the factory configuration. Do not choose this option if your configuration 
contains custom settings that you’d like to save. 
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Main, Display and Scaling Toolbars 

 
Main Toolbar 

 
Display Mode Toolbar 

 
Scaling Toolbar 

TOOLBAR ICONS FUNCTION 

 
Show/Hide gridlines in the graph window. Click and hold the mouse to display 
various grid preset options.  

 
Opens popup menu for showing/hiding individual toolbar options. 

 
Opens the Preferences dialog. 

 
Opens the customize toolbar menu. 

 
Change display to scope mode. 

 
Change display to chart mode (default). 

 
Change display to X/Y mode. 

 
Toggle Stacked Plot (overlap segment) mode; see page 40. 

 
Horizontal Split View; see page 51. 

 
Create Data View; see page 44. 

 
Autoscale selected waveform only. 

 
Autoscale waveforms along the horizontal axis. 

 
Center waveforms vertically in the active window. 

 
Center waveforms horizontally in the active window (X/Y mode only). 

Hardware Toolbar 

  
The hardware toolbar displays connected to information and includes quick access to add/change hardware.  

Cursor Toolbar 

 
 Cursor tools are used in many of the on-screen functions described below, including editing, measurements, 
and the amount of data displayed. 
NOTE: The four rightmost icons on the Cursor toolbar (Event tool, Zap tool, Jump tool, and Annotation tool) 
do not become visible until data has been acquired, or a graph containing data has been opened. See below for 
full description of all toolbar button functionality.
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Cursor Tools 
The cursor tools are also accessible via the Display menu (Display > Cursor Style) 

 
This is a general-purpose” arrow” cursor tool, used for selecting waveforms, scrolling 
through data, and resizing the chart boundaries between waveforms when in chart mode. All 
other cursors default to this mode when the cursors are moved outside the graph area. Use 
Alt-click to step through the channels; each click makes a new channel “active.” The arrow 
cursor can also be activated by the Ctrl+B keystroke. 
Holding down the left mouse button with the arrow tool positioned over a graph channel will 
activate a single data point, which displays as a solid black vertical line. This is known as 
“spot measurement” mode. Dragging the mouse will then update selected measurement 
values to the new horizontal locations of the arrow’s position in the graph. The mouse button 
should be depressed for approximately 0.5 seconds in order for spot measurement mode to 
become active. Releasing the button restores the arrow cursor to its normal status.  

 
This is a standard “I-beam” editing tool. This tool is used for selecting an area of a waveform 
(or waveforms) to be edited or transformed. However, editing of the selected area is limited 
to the channel currently selected in the graph. Click to I-beam icon to activate it. Now move 
the cursor toward the waveform. Notice that the cursor changes from an arrow to an I-beam 
when it is placed over the graph area.  
When this cursor appears, select an area of data by holding down the mouse button and 
dragging the mouse to either the left or right. Extend the selected area to include data that is 
not on the screen by positioning the cursor at the left edge of the area to be selected and 
clicking the mouse button. Next, use the scroll bars to scroll through the data until the desired 
data appears on the screen. Hold down the shift key while positioning the cursor to select the 
right edge of the area to be selected. Click the mouse button to select the area. To extend the 
selection, hold the Shift key and move the cursor or the arrow keys. The I-beam cursor can 
also be activated by the Ctrl+I keystroke. 
Clicking and holding on the I-beam tool will generate a pop-up menu for displaying the 
Selection Palette or linking selections between Data Views. 

 

 
When “Link Selections Between Data Views” is selected, the standard I-beam cursor icon 
will change to one with a link appearing across it. When enabled, any area selected in a Data 
View or source graph will also be applied to any other associated data view. For more 
details, see Data Views on page 44. 

 
This is a standard “zoom” tool. The zoom tool is used for selecting and magnifying any 
portion of any wave. Click the  icon to use the zoom tool. As you move the mouse into 
the graph area, it will change from an arrow  to a crosshair (+). Start by positioning the 
cursor in one corner of the box, then hold down the (left) mouse button and drag the 
crosshair horizontally, vertically, or diagonally to form a “box” that encompasses the area to 
be zoomed in. Release the mouse button, and AcqKnowledge will automatically adjust the 
horizontal and vertical scales. To “unzoom,” choose Zoom back from the Display menu or 
use the Ctrl+minus keystroke. 
Hold the “Alt” key to change the zoom mode to zoom out (“– “in the magnifier). The zoom 
tool can also be activated by the Ctrl+G keystroke. 

Grid 
Control 

 

Adjust the grid lines horizontal and vertical. Hold the option key for locked grids to drag to 
the end. 

Event 
Definition 

Inserts an event at the mouse click location. See page 223 for Event details. 
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 On a plot, the horizontal location matches the ‘x’ coordinate of the click 
 In Chart mode, the event will be placed on the channel track where the click took 

place. 
 In Scope mode, the event will be defined on the active channel. 

 Within the events bar, clicks define global events. 
When Event Definition is active, the cursor changes to a flag and the cursor includes a 
downward pointing arrow to indicate where the event will be defined. 
The Event Definition tool is disabled in X/Y mode and if events are not visible. 

Event 
Removal 
“Zap” 

 

Deletes event(s) from a graph with the mouse. It allows for quick editing to eliminate 
misclassified events found through visual inspection. 
 If the user clicks on a single event, that event will be removed from the graph.  
 If the user clicks and drags to define a rectangular area (similar to the zoom tool), all 

events between the left and right edges of the area will be removed; the event icon does 
not need to lie vertically within the bounded area in order to be removed. 

When Event Removal is active, the cursor changes to a lightning bolt. 

Jump-to 

 

Data views and advanced analysis output display multiple representations of the same data at 
the same time. Sometimes this association may be abstract or difficult to visualize. The 
Jump-to tool is a green arrow, and is available in all display modes and during acquisitions. 

Use the “Jump-to” tool to correlate data. 

• Click the Jump tool on a data point to “jump” all of the open data views for that 
graph to the same time. 

• Click the Jump tool on a point in an X/Y plot to jump data views in chart or scope 
mode to the point in time corresponding to the point in the X/Y plot. This can be 
useful for correlating PV loops back to other acquired signals. 

• Rate analysis output graphs will jump back to the corresponding point of source data 
at the start of that cycle. 

• Clustering scatterplots will select the appropriate segment of the source graph 
corresponding to the chosen data point. 

• Change the active segment in Stacked Plot mode; once a trace is selected the display 
will adjust to show the new active segment. 

Text 
Annotation 

 

Use Text Annotation to add floating text notes on top of data in a graph; the text notes move 
and scale with the data. During report or figure preparation, it is nice to be able to add 
additional textual information on top of signals to help clarify signals for readers or draw 
their attention to particular areas of visual interest. AcqKnowledge provides a text annotation 
facility to assist in figure preparation. 
Click the A icon and then click in the graph window to generate the Text Annotation 
Contents dialog. Drag the red “handles” from the annotated text to add connector lines to 
connect the text to the data.  
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Text 
Annotation 

 
continued 

 
 

 

 

 

 
Connector handles 

 
Add a range 

 
Resize a range 

 
Move a connector 

  
Text annotations are short pieces of text that float above channel data and can be used to 
draw visual attention to particular areas of interest in a graph. These text annotations can be 
simple outlined text, can have a connector from the outline boundary to a specific sample 
point on the waveform, or have a range indicator of a specific width. Each text annotation is 
tied to a sample of data in a channel; when the data is moved by coping, pasting, or other 
waveform editing operations, text annotations remain fixed to their corresponding sample 
positions, similar to channel events. 
Although text annotations are tied to horizontal locations like events/markers, they are 
displayed in a relative fashion. The relative pixel distance between the text annotation outline 
boundary and the sample of data remains the same under zoom and autoscaling operations. 

• For example, an annotation that is 20 pixels above a T-Wave peak position will 
continue to be drawn 20 pixels above regardless of zoom. This allows for flexible 
data viewing while maintaining text annotation visibility. 

Text annotation controls 
With the tool active, click in the graph to define a new annotation. 
Select Click an annotation once to select it. 
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Reposition Drag a selected annotation to reposition it. 
Add Connector Connectors or range indicators can be added to selected annotations by 

using the editing handles on the edges of the selected annotation. 
Edit Connector If the selected annotation has a connector to a data point of the graph, an 

editing handle will appear on the end of the connector. The connector can 
be moved to a different data sample of the graph by dragging the editing 
handle on the end of the connector to the new position in the channel. To 
remove the connector, grab the editing handle on the end of the connector 
and drag the mouse inside the text annotation. 

 
Range Indicator If the selected annotation has a range indicator, editing handles will 

appear at both ends of the range indicator. To resize the range indicator, 
grab an editing handle and move the mouse. To remove the range 
indicator, grab an editing handle and move the mouse back inside the text 
annotation. 

Autoposition Resizing windows or adding channels may reposition text annotations 
outside of the visible area. Click and hold down the text annotation tool to 
activate the text annotation popup menu. The “Autoposition Hidden 
Annotations” option automatically 
repositions all annotations so they are visible. 

  
Clear all Click and hold down the text annotation tool 

to activate the text annotation popup menu. 
The “Clear annotations” option will clear 
annotations for a selected channel or for all 
annotations. This action cannot be undone so 
you will be prompted to confirm your selection:  

Selection Palette 

 
Many of the tools within the AcqKnowledge environment are based around the selection. The selected range 
of data in the graph is used as the source for measurements, waveform editing, transformations, and other 
operations. The Selection Palette is a floating dialog that can be used to precisely enter the selection. See page 
436 for Selection Palette guidelines. 

Start/Stop Toolbar 

 toggles to  
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Channel Button Toolbar 
Toggles the display of channel number and label region.  

  
Event Toolbar 

 
Select an event to enable the toolbar. (Events and Event bar must first 
be enabled via Display > Show Events and Event bar). Use the arrows 
to move forward or backward through all event marker types. (If 
events are placed in the waveform, the arrow navigation will locate 
events in the selected channel only.) 
Click the event palette icon to generate the event palette.  

Focus Area Toolbar 

 
Use the Focus Area feature to isolate portions of data that are of 
particular interest within a graph. Focus Areas can be defined, added, 
labeled and deleted within any portion of the graph. For more details 
on creating and using Focus Areas, see page 89. 

Measurements Toolbar 

     

Click the down arrow for quick access to measurement preset 
functions, including pre-loaded options for organizing 
measurement rows and columns. Or create and save custom 
measurement display presets by choosing New Preset, entering a 
name for the preset and clicking OK. 
Right-click in the measurement bar for quick access to options for 
copying measurement and using linear interpolation.  

Custom Toolbars for Transformations and Analysis 
AcqKnowledge 4.1 and above allows users to construct new 
toolbars for triggering transformations and analysis. An arbitrary 
number of toolbars may be created and populated with buttons 
that can trigger any menu item in the Transform and Analysis 
menus. The contents of the text-only buttons match the menu 
item title. These toolbars will persist for each user and their 
positions and visibility within the graph window will be retained. 

 Transformation toolbars may be accessed via the 
"Customize Toolbars" button. 
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Toolbar Position Retention and Changes 
Toolbars can be rearranged within the graph 
window or detached and turned into floating 
tool windows. Any modifications made by 
the user to the position of most toolbars 
within the graph window will be stored as an 
application preference and used for new 
graph windows as they are created and graph 
files that are opened from disk. Default 
toolbar positions have changed to move the Start button and cursor tools to the top of the graph window; users 
preferring the ordering in previous versions may manually reposition the toolbars. Toolbar Tooltips may be 
deactivated when toolbars are detached from a graph.  

Axis Controls 

 

If axis controls interfere with scale values,  

  
adjust the opacity slider in Preferences > Graph 

 
to hide the icons until the cursor passes over them 

. 
 

 
A “scaling” button acts as a shortcut for opening the grid and visible range dialog, similar to double-
clicking the axis. If a channel corresponds to an analog channel that has calibration steps, a calibration 
wrench button be displayed and will open the hardware calibration dialogs. This allows visual access 
to commonly used operations for channels. 

 
Module dependent: Generate the scaling or calibration dialogs for the channel input or calculation. 
Analog inputs will open to the scaling dialog and channels that require calibration will initiate a repeat 
calibration routine.  

 

 
Use Display > Channel Info or use the channel’s contextual menu to display the Channel Information. 

 
Toggle the lock icon at the right edge of the window to change the lock state of the grid for horizontal 
axis or the channel. Unlocked is open (latch to right); locked is closed. 

Enable Cursor Tools During Acquisitions 
Enables access to cursor tools while recordings are in progress. (AcqKnowledge 4.2 and higher only, Display 
> Preferences > Graph) 
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Button Transparency 
Scaling, calibration, transformation history, and grid lock buttons may be made semi-transparent to allow 
units, axis values, and other information underneath the buttons to remain visible. The Preferences > Graph 
panel includes an “Axis controls” slider to change drawing from fully transparent to fully opaque.  
When the mouse is within the buttons, they will be drawn fully opaque regardless of transparency setting. The 
transparency is shared by the scaling, calibration, transformation history, and grid lock buttons and is the 
same for all open graphs as this is an application-level preference. 

Customizable Chart Track Dividers 
Users may change the color used to draw the dividers between channels tracks The Preferences > Graph panel 
contains "Chart Track Divider Appearance" options.  

Plotting Background Colors 
Starting with AcqKnowledge 4.2, customizable background colors for individual graph channels are available 
in Preferences > Graph > Plotting Background Colors. 

Spectrum Analyzer Palette 
The Spectrum Analyzer Palette provides a dynamic display of the frequency 
decomposition of data, in real time or post-acquisition.  

See page 441 for details.   

 

 

Keyboard Shortcuts 
Menu Option Windows OS Mac OS X  

Program info Help > About AcqKnowledge Help > About 
AcqKnowledge 

Quit  Ctrl + Q  Q 
Hide AcqKnowledge minimize (corner box) minimize (corner box) 

File menu   
New  Ctrl + N  N 
Open Ctrl + O  O 
Open for Playback   
SMI Begaze Import   
Close Ctrl + W  W 
Save Ctrl + S  S 
Save As   
Save Selection As   
Save Journal Text As   
Send E-Mail Attachment   
Page Setup   
Print Ctrl + P  P 
Quit Ctrl + Q  Q 

Edit menu   
Undo (when applicable) Ctrl + Z  Z 
Cut Ctrl + X  X 
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Menu Option Windows OS Mac OS X  
Copy Ctrl + C  C 
Paste Ctrl + V  V 
Clear (journal) none none 
Clear All   
Remove Last Appended Segment Use the Rewind toolbar icon  
Insert Waveform   
Duplicate Waveform Ctrl + D  D 
Select All Ctrl + A  A 
Remove Waveform   
Create Data Snapshot   
Merge Graphs   
Clipboard 
 > Copy Measurements 
 >  Copy Wave Data 
 > Copy Graph 
 > Copy Acquisition Settings 
 > Copy Data Modification History for 
All Channels 
 > Copy Data Modification History for 
Selected Channels 
> Copy Focus Area Summary 
> Copy Event Summary 

 
Ctrl + K 
Ctrl + L 
 
Ctrl + U 

 
 K 
 L 

 
 U 

Journal 
 > Paste Measurements 
 > Paste Wave Data 
 > Paste Graph 
 > Paste Acquisition Settings 
 > Paste Modification History for All 
Channels 
 > Paste Modification History for 
Selected Channels 
> Paste Focus Area Summary 
> Paste Event Summary 
> Manage PDFs 
 > Show Journal 

 
Ctrl + M 
Ctrl + / 
 
Ctrl + J 

 
 M 
 + / 

 
 J 

Transform Menu   
Recently Used   
Digital Filters   
Fourier Linear Combiners   
Math Functions   
Template Functions   
Integral   
Derivative   
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Menu Option Windows OS Mac OS X  
Integrate   
Smoothing   
Difference   
Resample Waveform   
Resample Graph   
Expression   
Delay   
Rescale   
Waveform Math   
Slew Rate Limiter   

Analysis menu   
Find Cycle Ctrl + F  F 
Find Next Cycle Ctrl + E  E 
Find All Cycles Ctrl + R  R 

Display menu   
  Tile Waveforms   

Autoscale Single Waveform Ctrl + Shift + Y  Shift  Y 
  Autoscale Waveforms Ctrl + Y  Y 
  Overlap Waveforms   
  Autoscale Horizontal Ctrl + H  H 
Show All Data Ctrl + Shift + D Shift  D 

Show Default Scales   
Zoom Back Ctrl + - (minus key)  - 
Zoom Forward Ctrl + = (equal key)  + 
Reset Chart Display   
Reset Grid   
Adjust Grid Spacing   
Set Wave Positions   
Wave Color   
Horizontal Axis   
Show > Selection Palette 
 > Location Palette 

Ctrl + Shift + = 
Ctrl + Shift + L 

 + Shift + = 
 + Shift + L 

Customize Toolbars   
Channel Info   
Preferences   
Size Window   
Cursor Style > Arrow 
             > Selection 
            > Zoom 

Ctrl + B 
Ctrl + I 
Ctrl + G 

 B 
 I 
 G 

Create Data View   
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Menu Option Windows OS Mac OS X  
Create Focus Area 
Organize Data Snapshots   
Show All Data Snapshots   
Load All Data Into Memory   

Script Menu   
Script Step Ctrl + Shift + T  + Shift + T 

Hardware Device Menu   
Set Up Data Acquisition  > 

• Channels 
• Length/Rate 
• Event Marking 
• Segment Labels 
• Stimulator 
• Trigger 
• Sound Feedback 

Set Up Advanced Averaging 
Show Input Values 
Show Manual Control 
Show Gauge 
MP150 Info 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

Autoplotting Ctrl + T  T 

Scrolling   

Warn On Overwrite   
Organize Channel Presets   
Set Up Linked Acquisitions   
Exit All Playback Graphs Ctrl + Exit Playback Mode Option + Exit Playback 

Mode 
Manage Hardware Connections   

  
 

 

Start/Stop Acquisition Ctrl + spacebar Ctrl + spacebar 
Delete recorded data  

Deletes all recorded data segments 
Ctrl + Rewind button Option + Rewind button 

Window menu 
Select Next Tab 
Select Previous Tab 

 
Ctrl + Tab 
Ctrl + Shift + Tab 

 
 Tab 
 Shift + Tab 

Help 
Tutorial Screencasts from the Web 
Open AcqKnowledge Tutorial 
Application Notes from Web 
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Menu Option Windows OS Mac OS X  
Open AcqKnowledge Manual 
Open Hardware Guide 
About AcqKnowledge 

Cursors 
I-beam 
Arrow (pointer) 
Zoom 
Grid 
Event 
Jump to  
Annotation 

 
Ctrl + I 
Ctrl + B 
Ctrl + G 

 
 I 
 B 
 G 

Horizontal Scroll Location 
 
 

In chart, scope, or stacked plot mode (i.e., all but X/Y) 
these keyboard shortcuts can be used to scroll to various 
parts of the graph. 

Home Jumps to t = 0 (i.e., places first sample of data flush with 
left of graph window) 

End Jumps to the end of the currently selected waveform (i.e., 
places last sample of data of the selected waveform flush 
with right of graph window) 

Page Up Scrolls backward in time one full screen (i.e., places 
leftmost sample of previous visible area at the right of the 
new visible area). 

Page Down Scrolls forward in time one full screen (i.e., places 
rightmost sample of previous visible area at the left of the 
new visible area). 

Tooltips 
Tooltips is an online assistance feature to help novice users learn how to use AcqKnowledge. Text is 
generated to describe the software functionality of the item under the mouse. Unavailable items/controls will 
indicate why they are unavailable. Tooltip visibility can be controlled by selecting or deselecting the “Show 
Menu Tooltips” checkbox in “Preferences > Other.” 
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Mouse Controls 
Contextual menu items correspond to the AcqKnowledge main menu state. 
The following options can be accessed with a right-click for Windows or Control-click for Mac.  

 Mac OS X only: If the mouse is over a portion of the graph that has a context menu available, the 
cursor will change to an arrow with a menu. 

Graph window 

 

Journal window 

 
 
 

Horizontal Scroll 

 
Vertical Scroll 

 
Measurements 

 

Events 

 

Mouse Scrollwheel Support 
The scrollwheel operates on whatever window is underneath the mouse; this window does not need to be the 
topmost window. Many third-party mice include scrollwheels, scrolling balls, or trackpads to allow for quick 
access to navigating through a document. Mice may provide two separate controls, one for scrolling vertically 
and one for scrolling horizontally. 
AcqKnowledge supports horizontal and vertical scrolling using the scrollwheels on the mouse. Scrolling is 
supported in graph windows, journal windows, the event list in the event palette, and a number of other 
dialogs and windows that contain scrollable lists. A dynamic zoom operation can easily be performed in an 
AcqKnowledge graph channel by holding down the Ctrl key (PC) or the Option key (Mac). Scroll ‘up’ to 
zoom in and ‘down’ to zoom out. (Zoom operation supported in AcqKnowledge 4.2 and higher) 

• Mac OS X: To increase the scroll speed, hold down the “Option” key while using the scrollwheel. 

Modification History 
Modification history functionality provides the ability to track transformations that are performed on 
channel data. This gives a visual indicator of whether transformations have been applied to a channel and a 
record of the sequence of transformations and the parameters for the transformation. The history for the 
channel is viewed in the "Channel Info..." dialog. This dialog is accessible via the Channel Info option of 
the context menu or the Display > Channel Info menu item. This dialog replaces the "Statistics" dialog used 
in earlier versions.  
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Cancelling Transformations and Transformation Progress Bar 
In AcqKnowledge 4.1 and higher, transformation cancel support has been restored to the software to offer 
Cancel buttons in progress dialogs that indicate the completion status of threaded transformations. 
Progress dialogs have also been enhanced so the textual message includes a graphical progress bar with 
the percentage that is completed. If the progress message does not contain a percentage, an indeterminate 
progress bar will be displayed.  
AcqKnowledge 4.1 and higher extends the analysis package to display dialogs while analysis routines are 
in progress. This progress dialog contains a cancel button which may be used to terminate the analysis 
before it is complete.  
The event tool allows events to be inserted on a graph with the mouse. When performing event editing, 
three new context menu shortcuts have been added to help make the process quicker:  

  
 Assign Current Event Type: Right-click an area with no data to set the type of event that will be 

inserted on the next left-click of the mouse. 

 Event Palette: Toggles event palette displays. 

 Edit event: Right-click a specific event to open the event palette to Selected Event controls for the 
event that was right-clicked. 

Typed Event Label Drawing Improvements 
The Event system has been enhanced to allow different drawing options 
for channel-specific events when they are drawn in the data plotting area. 
These drawing options are applied to event labels, event amplitude 
markings, and event time location text. The following drawing options 
may be customized:  
 
 Font (including family, size, italic/bold, and other options)  

 Rotation angle of text baseline  

 Text alignment (left, center, right)  

Choose MP150 Help Button 
A Help button is available in the "Choose MP150" dialog that appears when the application is attempting 
to locate an MP150, either on initial application installation or on communications errors. The Help 
button opens a "Troubleshooting MP150 Communications.pdf" document from the application's User 
Support System. This troubleshooting guide provides common information from Technical Support for 
decoding the network blink states of the MP150 and other steps to take to troubleshoot why the MP150 
and computer cannot communicate properly. 

Tooltips 

Channel Label, Units Length and Tooltips 
Character length limitations for channel label and units have been expanded: labels may now be up to 1032 
characters and units may be up to 511 characters. Tooltips have been added to display the full channel units 
when the vertical axis is moused over. Tool tips do not wrap, so long labels may extend beyond the visible 
viewing area of the computer monitor. 
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Graph Window Tooltip Improvements 
Several of the toolbar buttons and the Start/Stop button in the graph window are associated with keyboard 
shortcuts that may be used instead of the buttons. Tooltips for these toolbar buttons display the corresponding 
keyboard shortcuts. Toolbar Tooltips may be deactivated when toolbars are detached from a graph. 

 
Menu Item Tooltips 
Menu item tooltips display informational text about how menu items may be used. (Similar text was 
displayed in earlier versions of AcqKnowledge for Windows in the status area and in earlier versions of 
AcqKnowledge for Mac as Balloon Help). Analysis menu tooltips have been expanded to provide more detail 
regarding the types of analysis that are performed by the selected item. 
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Chapter 4  Editing and Analysis Features 
Overview 
This section provides a brief overview of some of the most frequently used AcqKnowledge features and 
functions. For more detailed information about specific features, turn to Chapters 9 through 13.  
If you are not currently running AcqKnowledge, double click the AcqKnowledge icon to start it. Choose Open 
from the File menu and select the file called “demo data.acq.” Your screen should look like this: 

 

Edit menu functionality during acquisition 
The following Edit menu functions may move or alter memory and cannot be performed during acquisition: 
Undo, Cut, Clear, Clear All, Paste, Insert Waveform, Duplicate waveform, and Remove Waveform. 
 
Scroll bars 
As you can see, there are four channels of data in this file (Heart Rate, ECG, EEG, Resp, EMG Raw, EMG, 
Integrated EMG). Although this record is 30 seconds long, only a few seconds are displayed on the screen at 
one time. You can move to different locations in the record by moving the scroll box at the bottom of the 
screen. Dragging the box left moves you to earlier points in time, and moving right displays events closer to 
the end of the record. Clicking on the arrows at either end of the horizontal scroll bar allows you to move to 
different points in time at smaller increments. 
A vertical scroll bar is on the right side of the screen, and. If you click the scroll arrow at the top of the box, 
you’ll see that one waveform appears to move down within its “track” on the screen. Moving this scroll box 
changes the amplitude offset of a selected channel. As with the horizontal scroll bar, you may either move the 
box or click the arrows. 
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Scaling 
Horizontal axis 
Click the horizontal scale (above the scroll bar) to generate a dialog where values can be entered for units 
per division and horizontal scale offset.  

 
Time Scale 

The time interval (units per division) between the on-screen grid marks. There are four vertical divisions 
per screen, and the default is 2.00 seconds per division, so eight seconds of data will be displayed on the 
screen display. Entering a larger value will display more of the record, and entering a smaller value will 
display less. 

Initial offset 

 The time corresponding with the first data point displayed. For example, to display the middle 1/3 of the 
data file (assuming the record is 30 seconds long), set the offset to 10 seconds and the seconds per 
division to 2.5 seconds. 

Precision 

Controls number of decimal places following whole units appearing in the horizontal axis. 

Hold Relative Position for Append acquisitions 

This option is available in AcqKnowledge 4.2 and higher, and active only in Append acquisition mode. 
When checked, the display for appended acquisitions will show the same relative position with respect to 
the start of acquisition. This is convenient when doing short-duration; high-speed acquisitions where you 
want to be able to zoom in on the signal of interest and have the relative position (from the start of 
acquisition) stay the same. If the acquisition is started with the horizontal scale such that it falls between 
acquisition segments, this feature is not implemented. 

When Hold relative position is checked; after zooming in on a section of data that has been selected 
(highlighted) and is completely within one appended segment, the scale of the selected area changes with 
each appended segment such that it remains relative to the start of acquisition for that segment and 
updates the measurements. If the selected data area falls within two or more appended segments, this 
feature is not implemented. 

Global Grid Settings 

Opens dialog for applying master grid settings for all channels. For more details, see Grids on page 78. 

Channel Grid Settings 

Opens dialog for selectively applying grid settings to one or more channels. For more details, see Grids 
on page 78. 
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Vertical (Amplitude) axis 

   
Clicking the mouse in the vertical scale area (where the amplitude of each channel is displayed) generates 
the Set Screen Vertical Axis dialog, where values can be entered for units per division and vertical scale 
offset. 

Scale  
Determines the limits of the viewable vertical axis scale (usually Volts). AcqKnowledge divides each 
channel into four vertical divisions. When data is displayed in chart mode, each “track” is divided 
into four divisions. When data is displayed in scope mode (or if there is only one channel of data) the 
entire screen is divided into four intervals. To increase the apparent amplitude for a given channel, set 
this value to a smaller number; entering a larger number will cause the waveform to appear to have 
less variability. 

Midpoint  
Refers to median displayed value for a particular channel. A checkbox to the left of each of these 
options allows you to apply these scaling options to all channels. By default, the scaling options you 
choose will only apply to the channel indicated in the dialog. If you want to apply these to all 
channels, click all the checkboxes. 

Precision 
Controls number of decimal places following whole units appearing in the vertical axis. Can be 
applied to selected or all channels. 

Apply to all channels 
 Applies settings selected in the various dialog options to all channels. 
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Adaptive Scaling 
Adaptive scaling uses the data to automatically determine the appropriate visible range for the data. 
As the data changes or the baseline shifts, the visible area shifts along with the data to ensure that data 
will always be plotted on the screen. Rather than limiting data visibility to a fixed voltage range, the 
range adjusts for factors such as background noise, electrode movement, EMG interference, 
disconnection, etc. 
Adaptive scaling can be applied to channels individually and can be unique for each Data View. A 
“settings” button is activated when to “Use adaptive scaling” is enabled.  

 
Scaling changes will be applied whenever the domain of the plot area is changed. This includes 
manual changes to the horizontal scale, horizontal scrollbar use, horizontal auto-scrolling when 
dragging out a selected area, auto-scrolling or auto-plotting during acquisition, initial enabling of 
adaptive scaling and auto-scrolling when executing Find Cycle/Peak functions.  

Show Textual Value Display 
This option  enables a real-time display of the most recently acquired values on a channel-by-channel 
basis, providing amplitude information akin to clinical monitoring displays. This can be useful for 
obtaining a quick visual numerical summary of incoming data while a recording in progress. 

 
In post-processing, the value display can be seen by performing a “spot measurement” (clicking the 
arrow cursor on a single data point).  
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Textual value display in spot measurement mode 

Textual value display can be customized for font, color and style, and positioned at the top or bottom 
of any selected channel. These options can be configured independently per channel or applied to all 
channels. 

• In chart and stacked chart modes, the value display will appear for all enabled channels. 
• In scope mode, the value display will appear only if the selected channel has the value display option 

enabled. 
• Textual value display is not supported in XY mode. 
To enable textual value display: 
Click on the vertical axis area to open the setup dialog and enable the “Show textual values display” 
checkbox. Use the Settings button to set the font style, size and color.  

  
Channel Grid Settings 

Opens dialog for selectively applying grid settings to one or more channels. For more information, 
see Grid Details on page 78. 
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Grid Details 
You can customize the grid behind the waveforms displayed in graph windows in a number of ways. 

 
Grid Lock/Unlock 
Each scale has a small padlock in the lower right 
hand corner that displays the current state of the 
grid lock for that axis and channel. Click the 
padlock to change the lock state. 
  Unlocked grid—the number of grid lines 

and their pixel spacing on screen is kept 
constant through zoom and scaling 
operations 

  Locked grid—the grid lines themselves 
are maintained at constant values through 
zoom operations, e.g. a grid line which is 
located at .753 volts when the grid is 
locked will continue to be located at .753 
volts regardless of changes in scale. 

Grids can be locked and unlocked on individual channels.  
 The lock for the horizontal axis is shared by all channels. 
 The vertical scale can be locked and unlocked independently. 

The lock state of the grid can also be changed through the axis dialogs displayed when the mouse is clicked 
on the axis scale values in the graph window. 
  Click the “Lock units/div” checkboxes. 

 
 
NOTE: All grid screenshots are from AcqKnowledge 4.2. 
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Grid Scaling 
When the grid is locked, the scaling factors controlling how much data is visible on the screen (the distance 
between consecutive major lines of the grid and a fixed location for one of the lines of the grid) are specified 
differently. When the grid is unlocked, these scaling factors do not affect the grid. 
 The Grid Spacing option specifies the scaling factors and whether or not to “Show minor divisions” on the 
grid display. Changing these values only affects the grid display, not how the waveform is scaled. 

   
 Vertical grid: the total range of vertical units displayed per track is specified (Major division) along with 

the first value that should be displayed (First grid line). 
 Horizontal grid: the scaling factors are specified in how many seconds of data should be visible on the 

screen (Major division) and the time offset of the left hand side of the display (First grid line).  
 Settings can be applied to a selected channel or all channels. (Controlled by checking or unchecking 
‘Apply to all channels”). 

Adjust Grid Spacing 
To modify the horizontal and/or vertical grid spacing, choose “Display > Adjust grid spacing.” This will 
generate the aforementioned dialog for modifying the locked axes of the selected waveform. (“Lock vertical 
grid” and “Use channel specific horizontal grid” must be enabled in order for the gridline fields to become 
active). Enter the desired values and click OK. 
 Settings can be applied to a selected channel or all channels. (Controlled by checking or unchecking 

‘Apply to all channels”). 

The following Grid items can also be selected by right clicking with a graph channel and using the contextual 
menu. 

 

 

Grid: Toggles Grid display on and off. 
Adjust grid spacing: Use to change Grid spacing 
for one or all channels (divisions between 
gridlines and position). 
Grid Options: Use to change Grid display for one 
or all channels (Color, width, style, dash length, 
dash spacing, and scale adjustment position). 

Grid Preset: Use to select/create /save custom 
Grid presets and organize them in a list. (left) 
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Example of channel specific horizontal grid 

 

 
Note in figure on left, the horizontal time scale division is 
one second per division in the graph channel, but two 
seconds per division in the horizontal axis. (Green bar area) 
 
 
 
 
 
 
 

Horizontal Axis Grid Controls 

 
 Global Grid Settings: Brings up dialog specifying grid settings used in the shared Horizontal Axis of 

the graph. 
 Channel Grid Settings: Brings up the ‘Adjust grid spacing dialog’ referred to on previous page. 

Individual channel-specific grid settings take priority over the Global Grid Settings. If no channel-specific 
grid setting exists, the Global settings are applied. 
Grid Tool 

 
The Grid Tool allows divisions of the grid to be specified with the mouse. This tool has four states: 

  Inactive The cursor changes to a circle with a line running through it. The grid 
cannot be adjusted since both the horizontal and vertical axes are unlocked. 

  Horizontal axis locked The cursor changes to a horizontal line. A mouse click and drag will change 
the location of the horizontal lines of the grid. 

   Vertical axis locked The cursor changes to a vertical line. The tool can be used to adjust the 
vertical spacing of the grid. 

  Both axes locked The cursor changes to a crosshair. The rectangle of a full grid division can 
be drawn over the data. Adjust the spacing of locked grid lines underneath 
the waveform. 

If the “Alt” (PC) or “Option” key (Mac) is held down for the Grid Tool in any of the active 
modes, an ellipsis will appear under the cursor. After a mouse click or drag, a Grid Settings 
dialog will be generated. This dialog is functionally similar to the grid dialogs accessible via the 
axis settings dialogs. 
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 Based on lock status, the dialog will allow you to adjust Horizontal, Vertical or combined settings. 
 The values displayed in the dialog correspond to the grid ranges that were just drawn out on the screen 

with the grid tool if a mouse drag occurred. 
 If the mouse was simply clicked, the current grid settings are displayed. 
 This dialog allows the grid drawn out with the grid tool to be made more precise. 

Grid Reset 
To return to the original grid, choose “Display > Reset grid.”  
This will reconstruct the default, unlocked grid of four divisions per screen with solid light gray grid lines. 
Grid Options 
The major and minor grid lines can be further customized with spacing, number of divisions, and different 
colors and dashing styles. These are modified under the dialog generated via Display > Show > Grid options.  

 
Line color Click the color well to generate a color chooser. 
Line width Adjust the corresponding slider. 
Dash style Select a style (solid or broken) from the pop-up menu. 
Dash length Adjust the corresponding slider (for any dash mode that is not a solid line). 
Spacing Adjust the corresponding slider (for any dash mode that is not a solid line). 
# of Divisions Enter a value in the text field to set the maximum number of minor grid lines 

to be displayed in a single major grid division. 
Apply visual settings to all channels 
 When checked, the visual settings for major and minor grid lines are applied to all 

channels. When unchecked, the settings will be applied to the selected channel only. 
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Scale Adjustment 
 Select whether to use Start/End or Range/Midpoint parameters to determine 

horizontal and vertical scale adjustments. Applied only when grids are locked. 

 
10 sec. Horizontal Scale adjustment set to ‘Start/End’ parameters 

 
10 sec. Horizontal Scale set to ‘Middle Point/Range’ parameters 

To undo your selections and return to the original grid, choose “Display > Reset grid.” This will reconstruct 
the default, unlocked grid of four divisions per screen with solid light gray grid lines. 

 
Friendly Grid Scaling 

Too much precision can create numbers that are difficult to quickly interpret, so “friendly” grid scaling 
adjusts the range to the nearest possible whole numbers. For example, it’s easier to comprehend 
4.1000000 than 4.1427385. Unlocked grids always restrict precision to the minimum needed for a given 
magnitude. This produces a “friendly” scale that makes it easier to determine the range between the 
gridlines when data is formatted for display or printing. 
With unlocked horizontal grids, the horizontal scale values printed on a graph may not match the 
horizontal scale values displayed on the application screen. For example, horizontal scale values 
 Displayed in the application: 0.00000   7.50000   15.00000   22.50000 

  Printed:    0.00000   7.50125   15.00250   22.50375 
The precision will only match when using the “Visible area” print option. With selected area or entire 
graph options, the precision will not match when grids are unlocked because friendly grid scaling is 
applied on screen, but is not used during printing where the range is fixed to fill the entire page. 
Note that the Zoom tool and vertical autoscale may produce different results. To accommodate the grid 
precision, the Zoom result may be slightly more than specified in the zoom box. For precise correlation 
from selected area to result, lock the grids (horizontal and vertical). Precision is not restricted for locked 
grids or display ranges manually entered in the axis setting dialogs. 
 Watch the AcqKnowledge Grids video tutorial for a detailed demonstration of this feature. 

http://www.biopac.com/video/?video_category=acqknowledge-new-features&v=acqknowledge-grid-functionality-tutorial�
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Journal Details 
To create a journal, choose File > New > Graph-Specific Journal or Independent Journal or choose 
Display > Show >Journal or Edit > Journal > Show Journal.  
Once a Journal is open, text and data can be entered. To enter text, just begin typing when the journal is open. 
AcqKnowledge will automatically “wrap” the text to fit the screen width. 
In addition to formatting tools, Time Stamp, Date Stamp and Auto Time functions are 
available in the journal window.   

• Time and Date stamps refer to the computer’s clock to record the time and date, respectively, directly 
into the Journal.  

• Auto Time function records the time at the instant the carriage return is pressed, which is useful for 
tagging commands as data is collected.  

Measurements and data may also be pasted into an open Journal. To paste measurements into an open 
Journal, select an area and choose “Paste measurements” from the Edit > Journal menu. Paste to Journal 
functions only work if a Journal is open and vary for each journal type: 
 Graph-specific journals can only receive measurements and wave data from their associated graph 

view 
 Independent Journals can receive measurements and wave data from any open graph. Results will be 

put into both the graph-specific journal and the independent journal. Use Journal Preferences to auto-
paste to an independent journal if desired. 

Set the Journal Preferences (page 451) to simultaneously record measurement name and units or control Event 
(marker) paste functionality and detail.  
To paste waveform data into a Journal, select an area and choose “Paste Wave Data” from the Edit > 
Journal menu. Allow several seconds for the text file to be written. The result is a text file of your wave data 
pasted into your active journal.  

TIP: When pasting a graph into a Journal: Pressing the Ctrl key (PC) or the Alt key 
(Mac) will launch a dialog allowing the image to be resized prior to pasting. 

A useful feature of the Journal is that it works in connection with the Cycle/Peak Detector and other 
measurement functions to paste in values from waveform data for further analysis. 
In the example above, the peak-to-peak and delta t measurements were pasted from the open graph window to 
the Journal. See the Journal paste section on page 279 for more information on how to paste information to 
Journal files. 
Use Save as/Open Journal Template to retain SOP text, or standardize lab/computer details for record 
keeping. 

Journal Contextual Menu 
The Journal contextual menu allows quick access to common text 
editing functions, as well as a tool for easily re-docking the Journal 
window to any edge of the graph. To activate this menu, right-click 
anywhere within the Journal window. 
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Rich Journals 
The AcqKnowledge 4.2 Journal adds powerful rich text editing tools, offering advanced functionality 
common to most word processing programs. The following toolbar options are available within the Journal 
window: 

• Font family 
• Font style: bold, italic, underline 
• Paragraph alignment: left, right, center, justify 
• Font color 
The following items can be pasted or embedded into the Journal text: 

• Images 
• Numbered lists 
• Bulleted lists 
• Tables 
• Numerical statistics or expressions 

Images must reside within a document in order to be pasted into the Journal. Pasting image files directly from 
a location such as the Desktop is not currently supported. 

Journal Toolbar Buttons 
The Journal toolbar controls all formatting functions within the Journal window. Although the settings 
customized in this toolbar are retained within a saved Journal, global default settings for subsequent Journals 
are not overridden. To change the global defaults, the overall Journal Preference settings must be modified. 
(Edit > Journal > Preferences). For more information, see Journal Preferences on page 451. 

 
Journal Toolbar Icon Function Explanation 

 
Clear  Clears text from Journal window 

 
Replace  Replaces Journal text with contents of external text file 

 
Save  Saves selected or full Journal text to an external text file 

 
Page Setup Opens dialog for modifying Journal text print configuration 

 
Print  Prints the Journal text to the default printer 

 
Time stamp Inserts current time into Journal 

 
Date stamp  Inserts current date into Journal 

 
Time AND Date Inserts current time and date into Journal when Enter/Return key is pressed 

 
Font  Use to select font type and size for Journal session 

 
Text style Use to bold, italicize or underline text 

 
Text alignment Aligns paragraph text to left, center, right or justified position 

 
Font color Selects color of Journal text 

 
Numbering Toggles text numbering on and off 
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Bulleting  Toggles text bulleting on and off 

 
Increase indent Increases indent in a bulleted or numbered list* 

 
Decrease indent  Decreases indent in a bulleted or numbered list 

 
Insert link Adds hyperlink to Journal 

 
Table Inserts a table into the Journal 

 
Table row  Adds a row to the table ** 

 
Table column  Adds a column to the table  

 
Delete table row  Removes selected row from the table 

 
Delete table 
column  Removes selected column from the table 

 
Merge cells  Merges selected cells within the table 

 
Split cells  Splits selected cells within the table 

*Active only when cursor is positioned within a bulleted or numbered list. 

**Additional table tools are active only when a table is present. 

NOTE: If the AcqKnowledge graph or Journal windows are decreased in size, the Journal toolbar will 
become truncated and some buttons may no longer be in view. Buttons no longer visible on the toolbar can be 
found in drop-down menus indicated by arrows. (See below) 

 
Journal Numerical Table Tools 
The Numerical Table Tools function allows easy insertion of measurements and numerical data into a Journal 
table, which can then be computed and evaluated via basic mathematical operations and expressions. This 
eliminates the need to export data to a spreadsheet application in order to validate statistics gathered during 
the course of an experiment.  

Numerical Tools operations permitted within a Journal table: 

 Insert a single measurement value 
 Insert all measurement values 
 Insert all measurement values with header row 
 Sum, Mean and Standard Deviation statistics for table rows and columns 
 Expression evaluation 
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Menu Item Function 
Undo Removes previous operation 

Select All Selects all cell contents 

Insert Single Measurement Value Pastes single selected measurement value into cell 

Insert All Measurement Values Pastes all measurement values into cells 

Row Statistics Performs Sum, Mean or Standard Deviation operations on row data 

Column Statistics Performs Sum, Mean or Standard Deviation operations on column data 

Evaluate Expression Performs mathematical operations and functions on cell contents  

Word Wrap Wraps text within visible Journal area. (Does not apply to table cells) 

 
Example of Sum, Mean or Standard 
Sum, Mean or Standard Deviation operations can be easily performed on table data. Right clicking within a 
cell opens a contextual menu containing available operations under ‘Row’ or ‘Column’ statistics. Choose an 
operation, and the result will appear in the selected cell. (See sum example below) 
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Example of Evaluate Expression 
This feature works very much like Excel®. Simply enter the cell identifiers into an empty cell, then right-click 
and choose ‘Evaluate Expression.” The formula occupying the cell will be computed and be replaced by the 
result. The mathematical operations and functions available for standard Biopac Expression syntaxes may be 
used. (Transform > Expression). Expressions can be created beforehand then copied and pasted into a 
Numerical Tools Table cell. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
If the expression syntax used is incorrect or invalid, a warning dialog will appear. 

 

TIP: To correct a mistake, use the Ctrl+Z (PC) or Command+Z (Mac) 
keystroke to restore the previous cell data. Multiple levels of undo are 
supported. 

Adding a hyperlink to the Journal 

Use the Journal hyperlink  toolbar button to insert a link to a web address into the Journal. This 
operation is very similar to adding regular text. 

1. Click into the Journal at the desired position for the link to appear. 
2. Click on the “Insert link” toolbar button 
3. Add the web address and some text identifying the link into the URL and Text fields.  
NOTE: For the link to be active, the http:// designation must be entered before the web address. 

 
4. Click OK, and the live link will appear in the Journal. 
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• To format the link text, select the link and use the Journal formatting tools. 
• To edit the link text, position the cursor at the end of the link and use the arrow keys to 

navigate to the desired portion. Backspace to remove unwanted text and type in new text. 
• To delete a link, select the text and use the Delete key. 
• Once a link has been created, the URL portion cannot be edited from within the Journal, nor 

can the original “Insert hyperlink” dialog be recalled. If the URL itself needs to be edited, a 
new link must be created using the “Insert Link” button. 

NOTE: Once a hyperlink is inserted into the Journal, entered additional text is also treated as a hyperlink. To 
nest hyperlinks among existing text: 

1. Insert hyperlink(s) at the end of Journal text. 
2. Select the hyperlink text, right-click and choose “Cut” (or Ctrl+X). 
3. Paste the hyperlink into the text at the desired location. (Ctrl+V) Pasting the link 

into existing text does not affect formatting of subsequent text. 
Embedding PDFs in Journals 
Multiple PDF files can be pasted into a Journal as convenient tabbed windows with all formatting and 
graphics intact. To do this, simply choose Edit > Journal > Manage PDFs, browse to the location of the 
desired PDF files and choose “Embed new.”  
TIP: You may also embed PDFs while in the Journal by right-clicking in the Journal window and choosing 
“Manage PDFs” from the contextual menu. 
For more details on managing embedded PDFs, see page 281. 

 Watch the AcqKnowledge Journal video tutorial for a detailed demonstration of this feature. 
Select a waveform / channel 

Although multiple waveforms can be displayed, only 
one waveform at a time is considered “active.” Most 
software functions only apply to the active waveform, 
which is also referred to as the “selected” channel. 
Selecting a channel allows you to highlight all or part 
of that waveform, and enables you to perform 
transformations on a given channel. 
In the upper left corner of the graph window there is a 
series of numbered buttons that represent each channel 
of data. The numbers in the bunttons correspond to the 
channel used to acquire the data (the specifics of setting 
up channels are discussed on page 34). In the sample 
file, ECG channels are represented by channels 1, with 
respiration on channel 2.  
To select a channel, position the  cursor over the channel button that 
corresponds to the desired channel and click the mouse button or position the 

 cursor on the waveform of interest and click the mouse button. 
Note that the selected channel box appears depressed and the channel label to 
the right of the channel boxes changes to correspond to the selected channel. 
Additionally, the channel label in the display (on the left edge of the track) will 
be highlighted for the active channel. 

 

 

Channel Labels 
Each channel has a label on the left and right edge of the graph window.  
The left label is used to identify the contents of each channel (ECG, 
Respiration, etc.). 
The right label is used to denote the units for each channel’s amplitude scale 
(usually scaled in terms of Volts). 

 

 

http://www.biopac.com/video/?video_category=acqknowledge-tutorials&v=journal-features-in-acqknowledge�
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When a channel is active, its label is highlighted and also 
appears by the channel buttons. 
To change the label for a given channel 
 during or before acquisition 

(including Append mode) 
revise the Hardware menu >  Set Up Channels label text 
 post-acquisition / analysis only 

click the left label enter the desired text in the dialog 
 

 
AcqKnowledge 4 Channel label 

 

Show/Hide Channel 

 
You can “hide” a waveform display without changing the data file. To hide a channel: 
Windows: Alt+click in channel box. 
Mac OS X: Option+click in channel box. 

Or, Alt+click on the channel number at the top of the channel label region.  
To view a hidden waveform, repeat the appropriate key-click combination. 
Alternatively, you can show/hide a channel via Display > Channel Visibility and check/uncheck the 
channel boxes in the Channel Visibility dialog. (See this Display menu option on page 433.) 
When a channel is hidden, the channel button will have a slash through it. View a hidden channel by 
holding down the Alt or Option key and clicking in the channel box again. 

Focus Areas 
Focus areas  are comprised of selected time ranges within the graph. The purpose of the “Focus on” tool is to 
easily isolate selected areas within the graph window for discrete analysis. This can be useful for identifying 
areas of interest within a larger data set by highlighting, naming and storing them permanently in the graph. 
When a focus area is assigned, that portion of the graph will appear shaded with borders appearing at the 
edges. The assigned focus area label will be displayed vertically in the shaded area. (See following page for 
example.) Focus areas may be defined via the “Focus on” toolbar above the graph, in the Output tab of the 
Find Cycle Analysis feature, and once defined, can be selected within the setups for most Specialized 
Analysis tools. 

• Focus areas are graph level data, similar to events. Defining a focus area in one data view defines it 
for all data views, etc. 

• Focus areas are drawn only for graph windows in chart, stacked plot, or scope mode. They are 
overlaid on top of data and events but underneath text annotations and selections. 

• Focus areas may overlap.  
• Each focus area is required to have a unique name. 

Creating Focus Areas 
To create a focus area: 
1. Select an area of interest in the graph data using the I-beam tool or selection palette. 

2. Create the focus area using one of the following methods: 

• Click on the “add”  button to the right of the “Focus on” toolbar. 

• Choose “Display > Create Focus Area.” 

• Right-clicking in the graph and choosing “Create Focus Area” from the contextual menu. 

3. Name the focus area by typing into the label field. 
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The new focus area label will appear in the “Focus on” toolbar field. 

 
The new focus area and label will appear in the graph. 

 
Multiple and overlapping focus areas can be created by selecting additional data and using the “add”  
button.  

Navigate quickly to a focus area time selection in the horizontal axis by selecting its label from the 
“Focus on” toolbar field. 

 
To remove a focus area, use the “minus” “Focus on” toolbar button.  

TIP: To remove multiple focus areas at once, hold down the Ctrl key (PC) or Option key (Mac) and click 
the “minus” focus area toolbar button.  (A confirmation dialog will appear before focus areas are 
removed.) 

To rename a focus area, use the “ellipses” toolbar button.   

To highlight the current focus area, click the “highlight” button.  

Most Specialized Analysis tools can be limited to running analysis on a focus area by choosing the “focus 
areas only” option in the setup dialog. 

 
Focus areas can be included or excluded from a printed graph by selecting or deselecting the “Print focus 
areas” option in Print Setup. 
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Focus area preferences can be modified by using Display > Preferences > Focus Areas. For further details 
see pages 448 and 453. 

For Find Cycle focus area options, see the Find Cycle section on page 325. 

To create focus areas in analysis mode based on events or appended segments, see the Specialized 
Analysis > Focus Areas section on page 376. 

 Watch the AcqKnowledge Focus Area video tutorial for a detailed demonstration of 
this feature. 

Measurements 
A convenient feature in AcqKnowledge is the popup measurement windows. A variety of 
different measurements can be taken, and you can display different measurements from the 
same channel and/or similar measurements from different waveforms. AcqKnowledge can 
display measurements for the selected channel or for any other channel. By default, 
AcqKnowledge displays measurements from the selected channel (as denoted by the “SC” in 
the measurement boxes). 
To select a channel for measurement, position the cursor over the part of the measurement 
window that reads “SC.” Click the mouse button and choose a channel number from the pull-
down menu. The channel numbers in the pull-down menu correspond to the numbers in the 
channel boxes in the upper left corner of the graph window. 
To select a measurement, position the cursor on a measurement box and click the mouse 
button. Choose a measurement from the pull-down menu; see page 95 for measurement 
functions and the minimum samples for each (some of the values are single point 
measurements while others require at least two points to be selected). 
The measurements in the upper half of the menu reflect amplitude measurements, or 
measurements which contain information about the vertical (amplitude) scale. Other 
measurements use information taken from the horizontal axis (usually) and are found on the 
section of the pull-down menu below the dividing line. Some of the measurement options 
change (or are disabled) if units are selected for the horizontal scale. 

  
In some cases, the computations involved in the measurement can produce nonsensical 
results (such as dividing by zero, or calculating a BPM from a single point). In those cases, 
you may get a measurement value like INF or ****. This means that the result was undefined 
at this point.  
Measurement menus are tinted to match the color of the corresponding waveform. 
 

http://www.biopac.com/video/?video_category=acqknowledge-new-features&v=focus-areas-acqknowledge-tutorial�
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Measurement Display 

    
The number of measurement rows is set in Preferences > Measurements, as well as precision of units. 
 
Measurement Area 
It is important to remember that AcqKnowledge is always selecting either a single point or an area spanning 
multiple sample points. If an area is defined and a single point measurement (such as Time) is selected, the 
measurement will reflect the last selected point. 
 
 Single-point measurements 

When a single point is selected, the cursor will “blink.” The following graph shows how the I-beam is 
used to select a single point for measurements. 

 
 
 Selected range measurements 

Drag the I-beam cursor to select an area; the selected area will be highlighted. 
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IMPORTANT! 
The first data point is “plotted” at zero (on the left edge of the graph); the first visible data point is sample 
point 2. The selected areas below demonstrate this concept. 
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Measurements and Measurement Presets  
Measurements are commonly used in conjunction with the cycle detector and other analysis protocols to 
perform data reduction. In complex data analysis using the cycle detector, often multiple different sets of 
measurements may be used to perform multiple extraction passes on the data. The measurement presets 
feature allows users to create multiple predefined measurement configurations and apply them to the graph to 
change between different configurations. All aspects of the measurement configuration are stored, including 
measurement functions, any parameters for the measurement, source channel, and number of measurement 
rows. For more details on this function, see MeasurementsToobar section on page 63. 

Measurement Validation 
You can validate measurements with the ValidateMeasurements.acq sample file included with the software. 
Pay attention to the “Sample data file” section of the measurement definitions that begin on page 95, and 
where included, note which sample points to use for validation (i.e., the first four sample points are used to 
validate the Correlate measurement using the ValidateMeasurements.acq file). 
Other sample files configured for specific measurement types include spreadsheets to provide external data 
necessary for measurement verification. Each spreadsheet contains procedures and examples for the 
associated measurement data file. These sample data files consist of Event Measurements.acq, Traditional.acq 
(standard mathematical measurements included in AcqKnowledge), Expression Sum_Calculate.acq and 
Correl Coef.acq (Correlation Coefficient). 

Measurement Info / Parameters 

 Measurements containing parameters have an “i” for 
info button next to the measurement type in the measurement bar. Click the button to generate a dialog to edit 
the parameters. To paste parameters, enable the Journal Preference via Display > Preferences > Journal > 
Measurement paste settings > Include measurement parameters. 
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Measurement Interpolation 
On a down-sampled channel, the cursor can fall on a point between physical samples. In such cases, in the 
Line Plot mode only, some measurements will display interpolated values; the value is obtained by linear 
interpolation with respect to the two adjoining samples. 
 To disable measurement interpolation, uncheck the “Use linear interpolation” option in the Display >  

Preferences dialog. 
 If interpolation is disabled for Line Plot, or any time Step Plot or Dot Plot is selected, measurements 

take on the value of the first physical sample immediately to the left of the cursor or edge of the 
selection. 

 When measurements are pasted to the Journal, there is no indication of interpolated measurements. 
 A Calculation measurement can be an interpolated value. When a measurement uses an interpolated 

value, the result box background changes from gray to light purple. 
 The “Delta S” and “Samples” measurements are never interpolated. 
 Measurements will not be interpolated if all measurements are set to “SC” (selected channel); the 

cursor will snap to the left for the measurements.  
 Measurement tooltips will reflect measurement interpolation. 

Exporting measurements 
One of the most important reasons to take measurements is to save them; AcqKnowledge allows you to store 
and export these measurements in different formats. 
 Copying measurements to the journal:  

To copy measurements (exactly as they appear in the measurement windows) and paste them to the 
Journal, select Edit > Journal > Paste measurement. Under the default settings, only the values 
themselves are copied to the journal; you can change the settings to include the measurement name and 
other options under Display > Preferences > Journal 

 Copying measurements to the clipboard:  
To copy measurements (exactly as they appear in the measurement windows) to the clipboard and paste 
them into a word processor or other application, select Edit > Clipboard > Copy measurements. Under 
the default settings, only the values themselves are copied to the clipboard; you can change the settings 
to include the measurement name and other options via Display > Preferences > Journal. 

Measurement Definitions 
The table below explains the measurement options available and the range required for each. The default 
option is for time to be displayed on the horizontal axis, although it can be set to display frequency or 
arbitrary units (see page 434 for details on how to change the horizontal scaling options). Unless otherwise 
noted, all of the measurements described here relate to those displayed when the horizontal scale reflects time. 
Measurement Area Explanation  
Area Minimum area: 

3 samples 
 
Uses: 
All points of 
selected area 

Area computes the total area among the waveform and the straight line that is 
drawn between the endpoints. 
Area is expressed in terms of (amplitude units multiplied by horizontal units) and 
calculated using the formula: 
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Where: 
n—number of samples; 
i—index (i = 1.n-1); 

1, +ii xx  - values of two neighboring points at horizontal axis ( 1x – the first 

point, nx – the last point); 

( ) ( )1, +ii xfxf  - values of two neighboring points of a curve (vertical axis); 

( ) ( )1, +ii xyxy  - values of two neighboring points of a straight line (vertical axis). 

At the endpoints y( 1x )= f( 1x ) and y( nx )= f( nx ). 
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Measurement Area Explanation  

1−
∆

=∆
n

Xxi - horizontal sample interval; 

The value of a straight line can be found by formula: 

( ) bxmxy ii +∗=  

( ) 11 xmxfb ∗−= - intercept; 

X
Ym

∆
∆

= - slope of the straight line; 

( ) ( )1xfxfY n −=∆  - vertical distance of increase at vertical axis; 

1xxX n −=∆ - horizontal distance of increase at horizontal axis. 
Sample plot: 

 
The area of the shaded portion is the result. 

Note: The Area measurement is similar to the Integral measurement except that a 
straight line is used (instead of zero) as the baseline for integration. 
 
 
 
 
 
 
 
 
 
 

 
Results: This calculation will always return a positive result. 
Units: Volts - sec. 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: 0.4533 Volts - sec. 

BPM 
(Time domain 
only) 

Minimum area: 
2 samples 
 
Uses: 

BPM (beats per minute) computes the time difference between the first and last 
points and extrapolates BPM by computing the reciprocal of this difference, 
getting the absolute value of it and multiplying by 60 (60 sec). 
The formula for calculation of BPM is: 
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Measurement Area Explanation  
Endpoints of 
selected area 601
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Where:  

nxx ,1 - values of the horizontal axis at the endpoints of selected area. 
Note: As mentioned, this measurement provides essentially the same information 
as the Delta T and Freq measurement. 
Results: Only a positive value. 
Units: BPM. 

Calculate Minimum area: 
2 sources 
 
Uses: 
Results of 
measurements 
used in 
calculation 

Calculate can be used to perform a calculation using the other measurement 
results. For example, you can divide the mean pressure by the mean flow. 
When Calculate is selected, the channel selection box disappears. 

 
The result box will read “Off” until a calculation is performed, and then it will 
display the result of the calculation. As you change the selected area, the 
calculation will update automatically. 
To perform a calculation, generate the “Waveform Arithmetic” dialog via 
Ctrl-Click or right mouse click the Calculate measurement type box or click the 
“info” button next to the measurement type box . 

  

 
Use the pull-down menus to select Sources and Operand. 
Measurements are listed by their position in the measurement display grid (i.e., 
the top left measurement is Row A: Col 1). Only active, available channels appear 
in the Source menu. 
 
Calculation measurement Source operands are updated before a Calculation is 
performed, which means that Calculations can be based on measurements that 
are located after them in the measurement row/column ordering. 
Calculation measurements can include other Calculation measurements as their 
operands. 

• If a cyclic dependency is introduced, the result reads “Error.” 
• When interpolation is being used, a Calculation measurement can also be 

an interpolated value. 
• If either of the operands of a Calculation is interpolated, the result will be 

displayed as an interpolated value (with a light purple background). 
The Operand pull-down menu includes: Addition, Subtraction, Multiplication, 
Division, Exponential. 
The Constant entry box is activated when you select “Source: K, constant” and it 
allows you to define the constant value to be used in the calculation. 
To add units to the calculation result, select the Units entry box and define the 
unit’s abbreviation. 
Click OK to see the calculation result in the calculation measurement box. 

Cap_Dim  Capacity Dimension; fractal dimension estimate. 
(Fractals measure the amount of self-similarity in a data set. AcqKnowledge 
offers three alternate estimates for fractal dimension: Cap_Dim, Corr_Dim, and 
Inf_Dim. The estimates will not agree, based on the heuristic and the 
parameters.) 

Corr_Dim   Correlation Dimension; fractal dimension estimate. Always greater than capacity if 
parameters are the same. (See fractals note at Cap_Dim.) 

Correlate Minimum area: 
2 samples 
 
Uses: 
All points of 

Correlate provides the Pearson product moment correlation coefficient, r, over the 
selected area and reflects the extent of a linear relationship between two data 
sets: ix  - values of horizontal axis and ( )ixf  - values of a curve (vertical axis). 
You can use Correlate to determine whether two ranges of data move together. 
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Measurement Area Explanation  
selected area Association  Correlation  

Large values with large values Positive correlation 
Small values with large values Negative correlation 
Unrelated Correlation near zero 

The formula for the correlation coefficient is: 

Correlate = 
( )( ) ( )

( ) ( )( ) ( )



















−∗∗




















−∗









∗








−∗∗

∑∑∑∑

∑ ∑∑

====

= ==

2

11

2
2

11

2

1 11

n

i
i

n

i
i

n

i
i

n

i
i

n

i

n

i
i

n

i
iii

xfxfnxxn

xfxxfxn
 

 
 
Where: 
n—number of samples;  
i—index (i = 1..n); 

ix — values of points at horizontal axis ( 1x – the first point, nx – the last point); 

( )ixf - values of points of a curve ( vertical axis). 
Results: 
Returns a dimensionless index that ranges from -1.0 to 1.0 inclusive. 
Units: None 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: -0.74825(for whole wave) and 0.95917 (for first four 

sample points). 
 

Delta Minimum area: 
2 samples 
 
Uses: 
Endpoints of 
selected area 

Delta returns the difference between the amplitude values at the endpoints of the 
selected area. 

Delta ( ) ( )1xfxf n −=  
Where: 

( )1xf , ( )nxf —values of a curve at the endpoints of selected area. 
 
 
Results: 
If the data value at the starting location is greater than the data value at the 
ending location of the cursor, then a negative delta will result. Otherwise, a 
positive delta will result. 
Units: Volts 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: -2 Volts (for whole wave). This result shows the 

absolute value of change of amplitude (2) and the minus 
sign means a decrease of amplitude. 

Delta S  Minimum area: 
1 sample 
 
Uses: 
Endpoints of 
selected area 

Delta S returns the difference in sample points between the end and beginning of 
the selected area. 
Results: This calculation will always return a positive result. 
Units: Samples 
 

Delta T(time) 
Delta F 
(frequency) 
Delta X (arbitrary 
unit) 

Minimum area: 
2 samples 
 
Uses: 
Endpoints of 
selected area 

The Delta T/F/X measurement shows the relative distance in horizontal units 
between the endpoints of the selected area. Only one of these three units will be 
displayed in the pop-up menu at a given time, as determined by the horizontal 
scale settings. 

Measurement Horizontal Axis 
Delta T Time 
Delta F Frequency (FFT) 
Delta X Arbitrary units (Histogram Bins) 

The formula for Delta T/F/X is: 

Delta T 1xxn −=  
Where: 

nxx ,1 - values of horizontal axis at the endpoints of selected area. 
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Measurement Area Explanation  
Results: 
If the data value at the starting location is greater than the data value at the 
ending location of the cursor, then a negative delta will result. Otherwise, a 
positive delta will result. 

For Delta T measurements with the horizontal axis format set to HH:MM:SS. 

 For values less than 60 seconds, you will get a value in decimal 
seconds. 

 For values greater than 60 seconds, you will see an HH:MM:SS 
format value 

(See page 74 for details on how to change the horizontal scaling). 
Units:  

Delta T: Seconds (sec.)  Delta X: “arbitrary unit” 
Delta F: Hz 

Sample data file: “ValidateMeasurements.ACQ” 
 Result: 0.12 sec. (for whole wave). 
 

Evt_amp  Extracts the value of the measurement channel at the times where events are 
defined. The measurement result is unitless. Specify Type, Location, and Extract; 
see page 228 for details. 
 The amplitude is always taken from the measurement channel, which may be 

different from the channel on which events are defined. 
Evt_amp can be useful for extracting information such as the average T wave 
height within the selected interval.  

Evt_count   Evaluates the number of events within the selected area. The measurement 
result is unitless. Specify Type and Location; see page 229 for details. 
 

Evt_loc   Extracts information about the times of events. The measurement result uses the 
units of the horizontal axis. Specify Type, Location, and Extract; see page 229 for 
details. 

Expression  Generates the Expression transformation dialog (page 141) and offers Source 
“MC” Measurement Channel instead of “SC” Selected Channel to build recursive 
formulas, i.e. result of the expression as it was evaluated x samples ago. Data 
within the selected area is not changed. 
Evaluation rules: 
When a new selection is made, the first step in evaluation searches through the 
measurement expression for any MMT() invocations. Any measurement whose 
value is needed by MMT () is computed at this time prior to the expression 
evaluation. This behavior is similar to calculation channels and successfully 
allows measurements to the right and bottom of the expression measurement to 
be used in the expression.  
The expression is subsequently evaluated from the leftmost sample in the 
selection to the right most sample. It is evaluated at the waveform sampling rate 
of its source channel. Interpolation is not used at the boundaries to maintain a 
consistent sample interval for the expression. After each expression evaluation, 
the result is cached in memory for potential negative MC result references. 
The rightmost value of the final expression becomes the value of the 
measurement. 

Freq (time 
domain only) 
 

It is important 
to note… 

This does not 
compute the 
frequency 
spectra of the 
data. 
To perform a 
spectral 
analysis, use 
the FFT 
function (see 
page 318). 

Minimum area: 
2 samples 
 
Uses: 
Endpoints of 
selected area 

Freq computes the frequency in Hz between the endpoints of the selected area 
by computing the reciprocal of the absolute value of time difference in that area. 
The formula for Freq is: 

Freq 










−
=

1

1
xxn

 

Where:  

nxx ,1 - values of horizontal axis at the endpoints of selected area. 
The information provided by this measurement is directly related to the Delta T 
and BPM measurements, and is related to a lesser extent to Delta S 
measurement. That is, if the Delta T interval between two adjacent peaks is 
calculated, the BPM and Freq measurement can be extrapolated.  
If the sampling rate is known, the Delta S can also be derived. 
In the following example, you can see Delta T, Freq and BPM measurements for 
the particular area. The Delta S can also be derived. 
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Measurement Area Explanation  

 
Selected area with measurements that describe 

the same interval in different terms. 
 
Note: It is important to note that this does not compute the frequency spectra of 
the data. To perform a spectra analysis, use the FFT function (described on page 
318). 
Freq (or frequency) is only available in time domain windows. 
Results: This calculation will always return a positive result. 
Units: Hz 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: 8.33 Hz (for whole wave). 

Inf_Dim   Information Dimension; fractal dimension estimate. (See fractals note at 
Cap_Dim.)  

Integral Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Integral computes the integral value of the data samples between the endpoints 
of the selected area. This is essentially a running summation of the data. 
Integral is expressed in terms of (amplitude units multiplied by horizontal units) 
and calculated using the following formula. 

Integral = ( ) ( )[ ]
2

1

1
1

i
n

i
ii

x
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+  

Where: 
n—number of samples; 
i—index (i = 1.n-1); 

1, +ii xx  - values of two neighboring points at horizontal axis ( 1x – the first 

point, nx – the last point); 

( ) ( )1, +ii xfxf  - values of two neighboring points of a curve (vertical axis); 

1−
∆

=∆
n

Xxi - horizontal sample interval; 

1xxX n −=∆ - horizontal distance of increase at horizontal axis. 
The following plot graphically represents the Integral calculation. 
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Measurement Area Explanation  

 
The area of the shaded portion is the result. 

Results: The Integral calculation can return a negative value if the selected area 
of the waveform extends below zero. 
Units: Volts—sec. 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 0.300 Volts -sec.(for first 6 sample points) and –
0.155 Volts -sec.(for last 6 sample points—the wave below 
zero). 

Kurtosis   Kurtosis indicates the degree of peakedness in a distribution, e.g. the size of the 
“tails” of the distribution. Distributions that have sharp peaks in their center have 
positive kurtosis; flatter distributions have negative kurtosis. A normal distribution 
has a kurtosis of 0. The following formula is used to extract kurtosis 
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Where from a signal (x) containing n points: 
Lin_reg Minimum area: 

2 samples 
 
Uses: 
All points of 
selected area 

Linear regression is a better method to calculate the slope when you have noisy, 
erratic data. 
 For advanced modeling options, see Nonlinear modeling on page 315. 

Lin_reg computes the non-standard regression coefficient, which describes the 
unit change in f (x) (vertical axis values) per unit change in x (horizontal axis). 
For the selected area, Lin_reg computes the linear regression of the line drawn 
as a best fit for all selected data points using the following formula: 

Lin_reg = 
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Where: 
n—number of samples;  
i—index (i = 1.n); 

ix — values of points at horizontal axis ( 1x – the first point, nx – the last point); 

( )ixf - values of points of a curve ( vertical axis). 
Note: For a single point, Lin_reg computes the linear regression of the line drawn 
between the two samples on either side of the cursor. 
Results: 
If the data value at the starting location is greater than the data value at the 
ending location of the cursor, then a negative delta will result. Otherwise, a 
positive delta will result. 
Units: Volts/sec. 
This value is normally expressed in unit change per second (time rather then 
samples points) since high sampling rates can artificially deflate the value of the 
slope. If the horizontal axis is set to display Frequency or Arbitrary units, the slope 
will be expressed as unit change in corresponding vertical axis values (frequency 
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Measurement Area Explanation  
or arbitrary units, respectively). 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 230.00 Volts/sec. (for 1-4 samples) and 
–170.00 Volts/sec. (for samples 4-7). 

Lyapunov   Lyapunov exponent describes the exponential rate of divergence of a system 
when perturbed from its initial conditions. For instance, if the system is started 
from two slightly different locations, this indicates how different their results will be 
with time. Stable experiments have exponents equal to zero. Specify an 
embedding dimension and a time delay; produces a single-valued measure. This 
measure is quite dependent on the amount of data used. 

Max Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Max (maximum) shows the maximum amplitude value of the data samples 
between the endpoints of the selected area. To compare peak heights, select 
each peak—you can easily see the maximum peak values or paste the results to 
the journal. Also, since you can simultaneously obtain measurements for different 
channels, you can easily compare maximum values for different channels. 
Note: For a single point, Max shows the amplitude value in this point. 
Units: Volts 

Max T Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

Max T shows the time of the data point that represents the maximum value of the 
data samples between the endpoints of the selected area. 
Note: For a single point, Max T shows the time value in this point. 
Units: Seconds 

Mean Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Mean computes the mean amplitude value of the data samples between the 
endpoints of the selected area, according to the formula: 

Mean = ( )∑
=

∗
n

i
ixf

n 1

1  

Where:  
n—number of samples; 
i—index (i = 1.n); 

ix — values of points at horizontal axis; ( 1x – the first point, nx – the last point); 

( )ixf - values of points of a curve ( vertical axis). 

Units: Volts 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 1.538462 Volts (for whole wave). 
Median Minimum area: 

2 samples 
 
Uses: 
All points of 
selected area 

Median shows the median value from the selected area. 
Note: The median and calculation is processor-intensive and can take a long 
time, so you should only select this measurement option when you are actually 
ready to calculate. Until then, set the measurement to “none.” 
Units: Volts 

Median T Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Median T shows the time of the data point that represents the median value of the 
selected area. 
Note: The median and calculation is processor-intensive and can take a long 
time, so you should only select this measurement option when you are actually 
ready to calculate. Until then, set the measurement to “none.” 
Units: Seconds. 
 
 
 
 
 

Min Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Min (minimum) shows the minimum amplitude value of the data samples between 
the endpoints of the selected area. 
Note: For a single point, Min shows the amplitude value in this point. 
Units: Volts. 

Min T Minimum area: 
1 sample 
 
Uses: 
All points of 

Min T shows the time of the data point that represent the minimum value of the 
data samples between the endpoints of the selected area. 
Note: For a single point, Min T shows the time value in this point. 
Units: Seconds. 
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Measurement Area Explanation  
selected area  

Moment  
 

Uses: 
All points of 
selected area 

Central Moment is a general-purpose statistical computation that can be used to 
compute central variance and other higher-order moments of the data within the 
selected area. Specify the order as an integer (generally). The central moment is 
computed using the following formula: 

( )

n

xx
mn

i
i

m

∑
=

−
= 1µ  

Where: 
x—signal; 
n—points;  
m—order. 

Mut_inf   Mutual Information determines how much could probabilistically be known about 
an unknown signal given a known variable. Specify a time delay. Produces a 
single valued result. 

NLM   Nonlinear modeling (also called “arbitrary curve fitting“) determines the “best fit” 
model for the selected data of the selected channel. The measurement result 
corresponds to the value of one of the parameters of the best fit. NLM can be 
used to extract Tau (time delay LVP constant) for assessing cardiac condition. 
See page 315 for nonlinear modeling details. 
 If a Model Expression uses MMT() syntax to reference a measurement and 

that referenced measurement is linearly interpolated, the results of the NLM 
measurement will also be displayed as being linearly interpolated. 

 When combined with the Cycle/Peak Detector (on page 325), the NLM 
measurement can be useful for extracting cycle-by-cycle best fit models for 
an entire waveform. 

None n/a None does not produce a measurement value. It’s useful if you are copying a 
measurement to the clipboard or journal with a window size such that several 
measurements are shown and you don’t want them all copied. 

P-P Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

P-P (peak-to-peak) shows the difference between the maximum amplitude value 
and the minimum amplitude in the selected area. 
Results: The result is always a positive value or zero. 
Units: Volts 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 13 Volts (for whole wave). 
Rate_mean Uses: 

All points of 
selected area 

Extracts the mean value of the rate outputs within the selected area. Unless this 
measurement is used on a rate analysis or calculation channel, this measurement 
is not defined (****). The units of this measurement will match the amplitude units 
of the measurement channel. 

Rate_median Uses: 
All points of 
selected area 

Extracts the median value of the rate outputs within the selected area. Unless this 
measurement is used on a rate analysis or calculation channel, this measurement 
is not defined (****). The units of this measurement will match the amplitude units 
of the measurement channel. 

Rate_stddv Uses: 
All points of 
selected area 

Extracts the standard deviation value of the rate outputs within the selected area. 
Unless this measurement is used on a rate analysis or calculation channel, this 
measurement is not defined (****). The units of this measurement will match the 
amplitude units of the measurement channel. 

Samples Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

Samples shows the exact sample number of the selected waveform at the cursor 
position—the first data point is not displayed, but is plotted at zero. 
See page 93 for examples of selected area Samples. 
Note: When an area is selected, the measurement will indicate the sample 

number at the last position of the cursor.  
Units: Samples. 

Skew  Skew  is a statistical measure of the degree of asymmetry in a distribution (away 
from normal Gaussian distribution), e.g. if the distribution is weighted evenly or 
trends toward an edge. 

• A normal distribution has a skew of 0. 
• A distribution with a prominent left tail has a negative skew. 
• A distribution with a prominent right tail has a positive skew  

The following formula is used to extract skew: 
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Measurement Area Explanation  
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Where a signal (x) contains n points: 
Slope Minimum area: 

2 samples 
 
 
 
Uses: 
All points of 
selected area 

Slope computes the non-standard regression coefficient, which describes the unit 
change in f (x) (vertical axis values) per unit change in x (horizontal axis). 
For the selected area, Slope computes the slope of the straight line that intersects 
the endpoints of the selected area, using the formula: 

Slope = 
( ) ( )

1

1

xx
xfxf

n

n

−
−

 

Where: 
( )1xf , ( )nxf —values of a curve at the endpoints of selected area. 

1x , nx - values of horizontal axis at the endpoints of selected area. 
This value is normally expressed in unit change per second (time rather then 
samples points) since high sampling rates can artificially deflate the value of the 
slope. 
Note: Lin_reg (linear regression) is a better method to calculate the slope when 
you have noisy, erratic data. 
For a single point, Slope computes the slope of the line drawn between the two 
samples: the selected sample point and the sample point to its left. 
Results: 
If the data value at the starting location is greater than the data value at the 
ending location of the cursor, a negative delta will result. Otherwise, a positive 
delta will result. 
Units: Volts/sec. (or corresponding to Freq or Arbitrary setting) 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 233.33333 Volts/sec. (for samples 1-4) 
-166.66667 Volts/sec. (for samples 4-7) and 
-16. 66667 Volts/sec. (for whole wave). 

 
Stddev Minimum area: 

2 samples 
 
Uses: 
All points of 
selected area 

Stddev computes the standard deviation value of the data samples between the 
endpoints of the selected area. Variance estimates can be calculated by squaring 
the standard deviation value. 
The formula used to compute standard deviation is: 

Stddev = ( )∑
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Where: 
n—number of samples;  
i—index (i = 1.n); 

ix — values of points at horizontal axis ( 1x – the first point, nx – the last point); 

( )ixf - values of points of a curve ( vertical axis); 
 

=
−

f ( )∑
=

∗
n

i
ixf

n 1

1
 - the mean amplitude value of the data samples between 

the endpoints of the selected area. 
Results: The result is always a positive value or zero. 
Units: Volts 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 3.09570 Volts (for samples 1-4), 
1.000 Volts (for samples 10-12). 
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Sum Minimum area: 

2 samples 
 
Uses: 
All points of 
selected area 

Sum extracts a mathematical sum of the amplitudes of all of the samples within 
the selected area. This straight sum can be used as a building block for more 
complicated formulas. Examples of its utility include HRV measurements, various 
statistical measurements, and simple criteria for clustering. Sum is available from 
within the measurement popup menus and from analysis scripts that allow for 
extraction of measurements.  

Time Minimum area: 
1 samples 
 
Uses: 
All points of 
selected area 

See the X-axis: T measurement for explanation. 

Value Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

Value shows the exact amplitude value of the waveform at the cursor position. 
For the selected area, Value indicates the value at the last position of the cursor, 
corresponding to the direction the cursor was moved (the value will be the left-
most sample point if the cursor was moved from right to left). 
Units: Volts 

X-axis:T/F/X 
(horizontal units) 

Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

The X-axis measurement is the exact value of the selected waveform at the 
cursor position, based on the Horizontal Axis setting: 
 Measurement Horizontal Axis Setting Units  

X-axis: T Time Sec. 
X-axis: F Frequency Hz. 
X-axis: X Arbitrary units Arb. units 

For X-axis: T measurements, the time value is relative to the absolute time offset, 
which is the time of the first sample point. 
The X-axis: F measurement applies to frequency domain windows only (such as 
FFT of frequency response plots). The Freq function for time domain windows is 
described on page 99. 
Note: If a range of values is selected; the measurement will indicate the horizontal 
value at the last position of the cursor. 
Results: This calculation will always return a positive result. 
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Part B—Acquisition Functions: The Hardware Menu 
Overview 
The AcqKnowledge software adds acquisition and control capability to the complete MP150/MP36R Systems 
and other BIOPAC data acquisition hardware, such as wireless BioHarness, Mobita, or B-Alert. The MP (or 
Hardware) menu items will vary in appearance depending on the type of data acquisition hardware in 
communication with the software, and the Hardware menu title will reflect the currently connected hardware 
type. (It is also important to note that certain features in the MP150 and MP36R hardware menus are not 
supported in all hardware types.) For the purposes of this guide, all supported data acquisition systems will be 
referred to generically as being under the umbrella of the “Hardware” menu, unless otherwise noted. 
This section describes the commands and procedures used to establish the various acquisition parameters for the 
hardware, including how to: 

• Set Up channels for data acquisitions 
• Control acquisition parameters such as sampling rate and duration 
• Perform online calculations and digital filters 
• Set acquisitions to begin on command from a mouse click or external trigger 
• Display values numerically and graphically during an acquisition 
• Output waveforms and digital signals during an acquisition 
• Control the on-screen waveform display characteristics 

Some of the basic functions involved in setting up an acquisition were covered in Part A—Getting Started, but 
this section will cover them in more detail, as well as describe some additional features. All commands 
referenced here can be found under the hardware device menu. 
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Set Up Data Acquisition > Data Acquisition Settings 
In AcqKnowledge 4.4 and higher, many key setups are accessed by selecting Hardware menu > Set Up Data 
Acquisition. This option displays the Data Acquisition Settings window, comprised of the following items: 

• Channels – all channel and hardware module setups – see page 109 
• Length/Rate – all acquisition setup parameters for the hardware – see page 158 
• Event Marking – for setting up hotkeys to insert custom events during acquisition – see page 218 
• Segment Labels – for creating custom append segment labels – see page 238 
• Stimulator – for configuring all stimulator options – see page 176 
• Trigger – for configuring all triggering setups see page 173 
• Sound Feedback – for setting up audio output of channel data – see page 238 

Clicking a listed item populates the Data Acquisition Settings window with the selected item’s setup dialog. At 
the bottom right of the Data Acquisition Settings window is a “Save Graph Template” button. This enables 
unique settings from any selected feature to be saved into a graph template for future use. 
You may also save user-defined default settings for new graphs by choosing Display > Preferences > Hardware 
and choosing “User-defined default channel setup.” Following this, each selected parameter change must be 
accepted by clicking “Yes” to the resulting “save default settings” dialog. Once the settings are accepted, this 
dialog does not reappear unless the settings are subsequently modified. 
Acquisitions 
Acquisition is defined as data collection from an external source (such as electrodes connected to an amplifier). 

 Before you begin an acquisition, make sure the data acquisition hardware is turned on and connected to 
your computer. Please refer to the BIOPAC MP Hardware Guide for more information on connections 
for your particular hardware type. 

To begin collecting data and display data as it is being collected: 
1. Launch the AcqKnowledge application (you can double click the AcqKnowledge icon). 
2. Choose File > New and select document type “Graph Window.” 

 

NOTE: If more than one hardware type has 
been previously added via the “Connect to” 
menu, these will also appear in the “Choose 
Type” dialog (left).For deatails on connecting 
additional hardware types, see page 162. 
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3. Set up the specific channels you want to acquire before starting the acquisition. 

• See the Set Up Channels chapter (page 109) for details. 
4. Set up the acquisition parameters (such as sampling rate, acquisition length, and data storage options. 

• See the Set Up Data Acquisition chapter (page 158) for details. 

Edit menu functionality during acquisition 
The following Edit menu functions may move or alter memory and cannot be performed during acquisition: 
Undo, Cut, Clear, Clear All, Paste, Insert Waveform, Duplicate waveform, and Remove Waveform. 
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Chapter 5  Set Up Channels 
Set Up Channels—The Basics 

Before you collect data, you need to specify how many channels you will be collecting data on, and at what rate 
data is to be collected. Both of these functions are accomplished through menu items and dialogues. To enable 
collection on a given channel, select Set Up Data Acquisition > Channels from the hardware menu. 
AcqKnowledge 4.1 and higher for MP150 offers two methods of analog channel setup: 

Module-based setup View by Channels see page 111 for details 

  
 
If using AcqKnowledge with BioHarness™ or B-Alert™, Analog channels can be turned 
on/off but not changed. 

Module-based analog channel setup  
For MP150 units, AcqKnowledge 4.1 and higher offers a module-oriented analog channel 
setup option. In module mode, setup prompts the user to add modules/transducers and 
establish parameters, plus it detects potential channel conflicts between software 
assignment and the module channel switch setting and scales the signal to the correct value 
and units. Module setup is supported in MP150 hardware only. 

The module setup is recommended for easier setup and automatic scaling. In module mode, setup prompts the 
user to add individual modules based upon the module number. For modules with transducers, the unique 
transducers are added. The user is then prompted to input the settings of all of the switches on the modules and 
then perform any calibration steps, if required. Using this information, the module setup automatically sets the 
scaling and initial visual range to match the physical input units from the module or transducer. Additionally, 
module-based setup detects potential channel conflicts between software channel assignment and module 
channel assignment (red switch position).  
1. From MP150 > Setup Data Acquisition > Channels, select the analog tab and click Add New Module... 

NOTE: Module setup mode is activated by default when the “Create/Record a new experiment” launch 
option is selected in the Startup Wizard window. (The add module dialog shown in Step 3 is presented 
first.) 

  
2. Click Add New Module from the bottom of the dialog. 

  
3. Select a module, click Add and select the channel switch position.  
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4. If prompted, select a transducer and click Add. 

 
5. Input the settings of the switch on the selected module and click OK. Set 

the choose channel switch to the number set on the amplifier (some 
amplifiers, such as the OXY100C, have a switch on the front of the 
module). 
 Setup detects any potential channel conflicts between software 

assignment and the module’s red channel switch position. 
6. Establish the configuration parameters (gain and filters) and click OK. It 

is important to set the Gain and Filter settings to correspond to the switch 
settings on the amplifier. The software uses this information to scale the 
signal to the correct units. If the Gain is not set to match, the signal will 
be scaled incorrectly. 
 

7. Perform calibration steps, if required. The software will automatically 
scale certain signals, if they only require a zero setting. However, some 
signals require a two-point calibration. In this case, the software will 
generate additional prompts for the scale values.  
 
The following examples show the dialogs for setting up a force 
transducer. 

a. The software prompts the user for pretension amount; enter “0” if 
pretension is not required. 

 
b. Enter a low calibration value or “0” if calibrating between zero and a second weight, when OK is 

clicked, the software will take a voltage reading. 

 
c. Enter a high calibration value and click OK for the software will take a voltage reading. 

 
Note When recording is started, the data may show an offset. This offset is the amount that was 

entered in the pretension dialog. Adjust the tension applied to the transducer to center the signal 
on zero. 

Using this information, the module setup automatically sets the scaling and initial visual range to match 
the physical input units from the module or transducer. 
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“Apply data alignment corrections” option (AcqKnowledge 4.4.2 and higher) 

 
This checkbox option is found at the bottom of the Channels > Add New Module screen and is recommended 
when using the following hardware modules: 

• NIBP100D (via DA100C general purpose amplifier)  
• NIBP100D-HD (via HLT100C high level transducer module)  
• When combining BioNomadix wireless signals with wired signals.  

Checking this box automatically adds appropriate delays, ensuring all data will be properly aligned when the 
above combination of hardware is used. This avoids the need to use calculation channels to manually align data 
when combining hardware types that apply varying amounts of fixed delay. 
NOTE: If NIBP100D is not being used, or if BioNomadix is being used only with other BioNomadix receivers, 
then checking this option is not necessary. (It is unchecked by default.) 

View by Channels 
Channel Type 
To specify the channel type—Analog, Digital, or Calculation—click its tab at the top of the dialog. 

 
For each channel, there are three options for channel setup: Acquire, Plot, and Value. These options appear as 
boxes on the left side of the Input Channels dialog. 
 Acquire 
This option dictates whether data wil be collected on that channel. The default setup is not set to acquire any 
channels. To collect data, position the cursor over the Acquire box (on the far left) and click the left mouse 
button. 
To leave hardware connected to the data acquisition unit, but have the software essentially “ignore” the channel, 
leave the Acquire box unchecked. For example, if an input device (such as an ECG100C amplifier) is set to 
Channel 7, data from that channel will not be collected unless the Acquire box is checked. 
Plot 
The second option is for plotting data. The Plot option determines whether or not data will be plotted on the 
screen for each channel. Checking this option instructs the software to plot data on your computer’s screen. 
When this box is left unchecked, data will still be collected (assuming the Acquire box is checked) but will not 
be displayed during the acquisition. 
In most cases, checking this option is recommended. However, in large-scale acquisitions (i.e., many channels 
and/or high sampling rates) unchecking this option for some channels allows for faster display rates or to 
increase the display area for important channels (see Appendix B—Hints for working with large files). 
Alternatively, use a separate data view and enable channels for as desired for optimum viewing. 
The Plot state is applied only on initial acquisition into a graph or template. If data has been previously 
acquired, use the channel buttons in the graph window to change channel visibility, OR use the Display > Set 
Channel Visibility option to select/deselect the channels to be shown in the graph. 
Values 
The third option enables incoming data values to be displayed either numerically and/or in a “bar chart” format 
in a separate window during an acquisition. Checking this option enables a bar graph (by selecting Show Input 
Values... under the Hardware menu) that displays the numeric value for channels with this option checked. This 
is especially useful for tracking slowly changing values such as heart rate, respiration rate, or concentrations of 
chemicals in a substance. For more information on how input values are displayed, please turn to page 232. 
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Channel 
Click in the channel number box (i.e. A1) to make that channel active (“selected”) so its settings can be 
established or edited. 
Label 
Editable labels can be attached to each channel. To change the label for any channel, position the cursor in the 
area to the right of the channel numbers (A1 through A16) under the label heading and enter a text label. Up to 
38 characters are supported and these labels will appear next to the channel label boxes in the graph window. 
To edit the label after setup, use the Set Up Channel dialog at any time, or right-click the active channel label in 
the graph window to generate the Assign Channel Label dialog. 
Calculation Channel Presets 
When a new Calculation channel is enabled for the first time, a setup dialog is presented to assist in setting the 
correct preset type, source channel and preset parameters.  
To set an initial calculation channel preset: 

1. Click the Calculation tab. 
2. Enable the desired Calculation channel by checking the “Acquire, Plot and Value” checkboxes. 
3. The following setup dialog will appear. Select the desired Calculation preset and analog source 

channel, and click OK. 

 
4. After clicking OK, the setup dialog for the selected preset will appear. Set the desired 

parameters and click OK. (For detailed information about setting Calculation channel 
parameters, see Chapter 6 on page 126.) 

Calculation Presets are like “templates” for calculation channels. Each Preset stores: 
    a) Calculation channel type 
    b) Parameters for that calculation 
    c) Channel name. 
Calculation Presets establish settings to target application-specific analysis. Presets exist for a broad range of 
analysis functions, including Fourier Linear Combiners and Adaptive Filtering. Start with existing presets for a 
specific species or protocol—for example, human vs. small animal, or stationary vs. exercising measurements. 
The Channel Setup dialog contains a “Preset” pop-up menu by each channel that lists the current Preset or, if no 
Preset has been selected for that channel, the Calculation type (Integrate, Difference, etc.). When you select a 
Preset for a particular channel, the channel is configured with the settings associated with that Preset.  
The Setup dialog has a “Presets” pop-up menu that contains all of the Presets for the Calculation type being 
configured. For instance, if a Difference Calculation channel is being configured, all Presets for the Difference 
Calculation will be listed. Just click the Presets head and scroll to select the desired preset.  

             
 Calculation Presets 
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When you select a Preset, the Setup dialog is updated with the corresponding information. 
 The Setup dialog reads “none” if the channel configuration doesn’t match any Preset. The menu will 

flip to “none” when the settings for a channel are changed such that they no longer match a Preset.  
 Create a new Preset from existing Calculation channels. Click “Setup” to display the Calculation Setup 

dialog and click the “New Preset” button. The settings will be applied to the current channel, and a 
prompt will appear to enter a name for the new Preset. Preset names cannot be duplicated, nor can the 
default name of a Calculation channel type be used (Integrate, Difference, etc.). The new Preset will be 
included in the pop-up menus and saved with the file. 

 To reorder channel Presets (by type, use, etc.), choose Hardware > Organize Channel Presets and then 
use the up/down buttons as appropriate (see page 245). 

 Presets are not applicable to and therefore not selectable on Analog or Digital channels. 
Channel Sampling Rate  
The Variable Sampling Rate feature allows different channels of data to be down-sampled from the acquisition 
sampling rate; calculation channel must use sampling rate less than or equal to the source channel. Choosing 
lower sampling rates for signals where meaningful data falls below the Nyquist frequency of the acquisition 
sampling rate allows more data to be stored in memory or on disk. 
 Offline operations that involve multiple channels must use the same sampling rate for all Source and 

Destination channels. These operations include waveform editing, Waveform math, Expression 
calculations and Template functions; notable exceptions are “Off-line Averaging” under Find Cycle/Peak 
and “Reset via a Control Channel” under Integrate. 

 When wave data is copied to the clipboard or journal, data values will be inserted at the highest sampling 
rate. 

 There is no restriction on the acquisition length when using Variable Sampling Rates. 
 When Variable Sampling Rates are used in conjunction with the Append mode, and the mode is started 

and stopped manually, it is statistically possible that, prior to the next pass of the Append, extra data 
points may be inserted in various data channels to “line up” the data (see sample on page 113). These 
extra data points simply replicate the last sample in any affected channel. 
To minimize the impact of the extra data points: 
a) Make sure the lowest sampling rate is on the order of 10 Hz or higher, or 
b) Don’t use Variable Sampling Rates. 
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Set Up Channels—Advanced 
The previous section covered the basic options used in almost all acquisitions. In addition to the features 
described above, a number of other options are available in terms of setting up channels. These advanced 
features are also found under the Set Up Data Acquisition > Channels menu item. 
Most acquisitions involve collecting analog signals and then displaying them on screen. It is frequently useful, 
however, to collect other types of data (digital data, for instance) or to perform transformations on analog data 
as it is being acquired. Channels containing digital signals and transformed analog signals can be collected in 
addition to the 16 analog channels. 
In the upper left corner of the Channels dialog, there are three tabs titled Analog, Digital, and Calculation. 
These refer to the three respective channel types available in AcqKnowledge. The general features (acquiring, 
plotting, and the like) are the same for each type of channel, although there are considerable differences 
between the type of data each channel is designed to handle. Up to 16 channels each of analog, digital, and 
Calculation channels are supported in MP150 hardware, and 4 channels of analog, 8 channels of digital and 16 
Calculation channels are supported in MP36R hardware. Analog and digital channels may be acquired in any 
combination, and the only requirement for Calculation channels is that you have at least one input channel 
(either analog or digital). 
Analog channels 
Analog channels are the most common type of acquired channel and should be used to acquire any data with 
“continuous” values. Examples of this include nearly all physiological applications where input devices 
(transducers and electrodes) produce a continuous stream of varying data. The range of values for analog 
channels is ±10 Volts. 
AcqKnowledge supports the rescaling of Analog channel signals to more meaningful numbers. As an example, 
imagine a temperature transducer is connected to an SKT100C amplifier with a gain setting of 5°/Volt, and 
output set to channel 1. Ordinarily, the values from the amplifier would be read in as Volts or milliVolts. For 
this acquisition, the signal from the transducer would need to be expressed in terms of degrees Fahrenheit. To 
calibrate the transducer, bring it to two known temperatures. At the first temperature, take a voltage reading by 
selecting “Show Input Values” from the Hardware menu. (See page 232 for a description of the Show Input 
Values options). At 90° F, a reading of 0 Volts will be displayed. The transducer is then brought to a 
temperature of 95° F, resulting in a reading of +1 Volts. 
To scale the incoming signal to degrees F, click the Setup… button in the Input Channels dialog. 

  
Scaling dialog set to rescale Volts to degrees Fahrenheit and Use Mean Value Settings dialog 

The Input Volts and Map (Scale) Value boxes reflect the value of the incoming signal and how it will be plotted 
on the screen, respectively. Thus, an incoming signal of +1 Volts would be plotted as 95° F, whereas a signal of 
0 Volts would be plotted as 90° F. AcqKnowledge will perform linear extrapolation for signal levels falling 
outside this range (i.e., -2 Volts will be scaled to 80 ° F), as well as perform similar interpolation for values 
between this range. Enter these numbers in the scaling dialog, type in “degrees F” for Units, and click OK. 
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As a shortcut for scaling channels, use the Cal 1 and Cal 2 buttons. Click either of these buttons to read in the 
current voltage for the selected channel. In the above example, the transducer could simply be set to a known 
temperature, then Cal 1 could be clicked, and then the temperature could be entered in the Map (Scale) value 
box for Cal 1. 
Next, the transducer could be brought to another known temperature that is considerably higher or lower than 
the first. Click Cal 2 and the new known temperature could then be entered in the Map (Scale) value box for Cal 
2. AcqKnowledge calculates the slope and offset from the two points entered. Each data sample from channel 1 
will now be scaled according to the slope and offset calculations previously made. When an acquisition is 
performed, the amplitude scale (vertical axis) will reflect the rescaled units. 

It is important to note that Cal 1 and Cal 2 cannot be used when data is being acquired. In other 
words, a channel must be calibrated before it can be acquired. To set the calibration for a given 
channel, connect the input device to the data acquisition unit, power up the Hardware, and then 
perform your calibration before starting data acquisition. 

The Calibrate all channels at the same time option is used when identical types of transducers or signals are 
being simultaneously recorded on two or more channels. 
If this option is selected, when Cal 1 or Cal 2 is pressed: 

• Map (Scale) Value will be updated for all active channels 
• Input Volts need to be updated for each channel individually. 

The Use mean value option is useful if the input voltage signal is noisy around a mean value. The “Input Volts” 
value returned will be the mean value over the specified number of readings. When this option is selected, a 
Settings… button is activated and generates an “Analog Channel Calibration” prompt for the number of 
readings. 
The data is read the number of times indicated in the prompt and then the readings are averaged. The rate of 
obtaining these readings is indeterminate because the rate depends on the actual hardware unit as well as the 
communication type. 
Increased Channel Count Support (AcqKnowledge 4.3 and above) 
Previous versions of AcqKnowledge software supported a total maximum of 60 analog, digital and calculation 
channels per graph. In AcqKnowledge 4.3, channel count capability was extended to a theoretical maximum of 
15,000 channels. While it is not generally feasible or useful to work with this many channels, it is now possible 
to store and combine data derived from multiple hardware units, and perform complex specialized analysis with 
data output to channels in the existing graph. (For example, advanced ICG analysis can potentially add up to 20 
additional channels to the existing total.) 
When a large number of channels are present, the channel buttons appear in rows of 20 and will extend the 
height of the channel toolbar to accommodate any increase in channel count. 

 
Clicking into the right pane of the channel toolbar opens a contextual menu listing all channel numbers and 
channel labels. 
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Analog channels MP36R 
The MP36R analog channels may also be configured for gain and other parameters, but additionally allows the 
channel gain to be configured directly with a variety of input ranges. Gain settings are accessible via a pop-up 
menu in the Channel setup dialog. (MP36R > Set Up Data Acquisition > Channels > Setup) The Gain setting 
specifies the extent to which an incoming signal is amplified. The Gain is automatically set when a data type is 
selected from the available Presets. The preset Gain settings are only educated guesses and should be used as 
initial starting values. You may need to adjust the gain settings depending on how the amplified signal appears 
once sample data is collected. 

 
Offset 
To correct the offset of an incoming analog signal, you can add or subtract a constant to the signal prior to 
amplification. Offset can occur if a transducer or electrode has inherent offset. By default, Offset is set to zero, 
and the allowable entry range will vary depending on the Gain and Scaling values. 

To make inputting voltages easier, the analog channel scaling dialog for the MP36R displays the input voltages 
in units that adapt to the gain setting. (x200 is the default) 

The scaling units will adjust dependent upon the gain setting as follows: 

• If the gain is set to < x1000, the Scaling input units will display as millivolts (mV).  
• If the gain is set to > x1000, the Scaling input units will display as microvolts (μV). 

 

  
Channel gain set to < x1000 displays mV input units     

 

Channel gain set to > x1000 displays μV input units 
 

µV 
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Adjustable, user defined, digital IIR filters for MP36R 
The MP36R Unit allows up to three user-configurable, sequential, biquadratic (second order) Infinite Impulse 
Response (IIR) filters per MP unit channel. These filters are typically configured by choosing a Preset but can 
be changed manually via the Input Channel Parameters dialog (MP36R > Set Up Data Acquisiton > Channels > 
Setup button). Each of these three filters can be uniquely set up as a low pass, band pass, high pass or notch 
(band reject) filter. 
In the “Digital Filters” section, select Filter 1, 2, and/or 3 and then adjust the Type, Freq, and Q. 

 
The default setting is no filters applied. 

High Pass Filters MP36R 

These filters are implemented using resistors and capacitors in the front end circuitry of the MP36R unit. They 
are set via the “High Pass” section of the Input Channel Parameters dialog (MP36R > Set Up Data Acquisition 
> Channels > Setup”). 

 
High Pass Filter  Appropriate use 

0.05 Hz HP ECG 
Respiration data 

0.5 Hz HP ECG when there is a lot of motion artifact causing a shifting baseline  
EEG 
Pulse plethysmograph 
Most other types of AC Coupled data 

5 Hz HP EMG 
Heart Sounds 
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Additional controls in MP36R Input Channel Parameters 
Button Explanation 

New Channel Preset Allows a custom Preset to be saved under a unique name 
Advanced Opens Advanced dialog. The Advanced dialog may be used to specify additional settings, 

requirements, and dependencies for the preset. See below for complete explanation of all 
Advanced options. 

Scaling Use to configure the value of the incoming signal and how it will be plotted on the screen 
 
MP36R Advanced Preset Settings 
Click the Advanced button to open a dialog containing the following optional preset configuration options. 

  
Acquisition Tab Explanation 

Require minimum sampling rate When enabled, specifies that a minimum sampling rate must be selected 
in order for acquisition to continue. 

  
 Transducer Tab Explanation 

Verify connected 
transducer  

When enabled, the software will check for a specific transducer according to the settings in this 
group box prior to the start of each appended segment 

Title Editable text field used to identify transducer name. 

SSID If checked, indicates which SmartSensor resistor ID should be validated for this channel prior to 
each acquisition. The ID must be an integer between 1 and 23. See SSID table on page 121. 

ISID Device Name If checked, indicates that the internal transducer description should be validated for this channel 
prior to each acquisition.  

Fallback on SSID if 
ISID check fails 

If the ISID device name check is unsuccessful for a connected transducer, fall back and check 
the SmartSensor resistor ID. See SSID table on page 121 
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Range + Grids Tab  Explanation 
Apply initial visual range The initial vertical axis range of plotted data will be set as indicated at acquisition start of the first 

data segment. 
Top Indicates the maximum vertical visual range in destination channel units.  
Bottom Indicates the minimum vertical visual range in destination channel units.  
Apply locked vertical 
grid 

Locked vertical grid settings are applied for the channel. For more details on grid setups, see 
Grid Details on page 78. 

First grid line Provides the fixed location of the origin of the vertical grid. 
Grid spacing Sets the spacing interval between major vertical grid divisions.  
Apply locked horizontal 
grid 

A channel-specific independent horizontal grid will be applied when the channel is added to a 
graph. 

First grid line Sets the origin location of the horizontal grids. 
Grid spacing Sets spacing between major horizontal grid lines based on the time domain. 
Apply grid appearance Enables options for setting grid color/appearance of major and minor grid lines. 
Major line color Allows customization of major grid line color. 
Minor line color Allows customization of minor grid line color. 
Show minor grid Shows/hides minor gridlines 
Vertical precision Indicates number of digits displayed on vertical axis. 
Num minor divisions Sets the number of minor grid divisions for the channel. 
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Calibration Tab Explanation 
Use Calibration Additional calibration procedures will be applied to adjust the channel scaling based on 

values read from a physical transducer. 
Require calibration prior to 
acquiring data 

When checked, calibration will always be required for this channel prior to acquiring the first 
segment of data. 

Calibration Type Specifies calibration option to be performed on the channel. Two types are available: 
• Single point – records a single input voltage and adds it to the Input Volts value of 

both Cal1 and Cal2 
• Double point – records two independent voltages in a sequence of two dialog 

steps and records the first in the input volts for Cal1 and the second for the input 
volts in Cal2 

 
Prompt One prompt for  “Single point” calibration. Two prompts for “Double point” calibration. 

Field(s) for inputting dialog text to be displayed to the user for acquiring the single voltage 
input to apply to the scaling input voltage values. 

 



Part B — Acquisition Functions 121 

AcqKnowledge 4 Software Guide 
 

MP36R Transducer SSID Table 
Device Part #  Description SSID  ISID Name 
BSLCBL3A, BSLCBL4B  Recording cable 1  
BSLCBL5 3.5mm phone plug adapter 6  
BSLCBL8, BSLCBL9 High-impedance recording cable 1  
BSLCBL14A 3.5mm phone plug adapter to MP35 Input.   6  
BSLSTMB/A 10 V setting 18  
BSLSTMB/A 100 V setting 19  
BSL-TCI13 Piezo interface cable 1  
BSL-TCI21 pH probe interface 12  
SS1L, SS2L, SS2LA Electrode lead set 1  
SS2LB Electrode lead set N/A SS2LB 
SS3LA EDA (GSR) finger electrodes 2  
SS4LA Pulse Plethysmograph finger transducer 3  
SS5L, SS5LA, SS5LB Respiration Belt (for Chest) 4  
SS6L, SS7L, SS8L Temperature transducer  5  
SS9L, SS9LA BNC Adapter 6  
SS10L Pushbutton switch  7  
SS11LA Airflow transducer 8  
SS12LA Variable range force transducer 9  
SS13L Blood Pressure (Arterial) 10  
SS14L Displacement transducer 11  
SS17L Piezo microphone 14  
SS19L Blood Pressure  cuff (with Gauge) 10  
SS19LA Blood Pressure cuff N/A SS19LA 
SS19LB Blood Pressure Cuff N/A SS19LB 
SS20L, SS21L, SS22L, 
SS23L, SS24L 

Goniometer 16  

SS25L, SS25LA Hand Dynamometer 9  
SS25LB Hand Dynamometer N/A SS25LB 
SS26L, SS26LB, SS27L Accelerometer 17  
SS28L Heel Toe Strike assembly 9  
SS29L Multilead ECG cable 1  
SS30L Stethoscope, electronic 14  
SS31L Non-Invasive Cardiac Output Module 15  
SS32L Dissolved Oxygen probe 20  
SS33L GAS – O2 (Used on GAS-System2) 21  
SS34L GAS – CO2 (Used on GAS-System2) 22  
SS35L Flow transducer 18  
SS36L Reflex Hammer 9  
SS39LA MP3X Circuit Probe and Power Cable for Breadboard 6  
SS40L, SS41L, SS42L Diff. Pressure transducer 10  
SS43L Phychological response indicator 11  
SS56L Clench Force (Bulb) transducer N/A SS56L 
SS57L EDA (GSR) with electrode pinch leads  2  
SS57LA EDA (GSR) N/A SS57LA 
SS59L Superlab Interface cable for MP35 6  
SS61L Finger Twitch transducer 16  
SS62L Microphone 14  
SS63L, SS64L, SS65L, 
SS66L 

Fixed Range Force Transducer 9  

SS67L Pneumogram transducer  10  
SS68L Ph Probe 12  
SS70L BNC Adapter (for MP35), Isolated version 6  
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Digital Channels 
In contrast to analog channels, digital channels are designed to collect data from a signal source with only two 
values (0 and 1). This type of data can be useful in recording whether a switch is open or closed, and 
ascertaining if a device is on or off. Input values for digital channels have two values, +5 Volts and 0 Volts. The 
hardware interprets +5 Volts as a digital 1 and interprets 0 Volts as a digital 0. Since digital channels have a 
fixed value, the scaling option is disabled for these channels. The main function of digital channels is to track 
on/off devices such as push-button switches and/or to receive digital signals output by timing devices. 
Similarly, these channels are also used to log signals from devices that output auditory/visual stimulus for 
examination of stimulus response patterns. 

0 volts

+5 volts

Positive edge Negative edge 

(binary "1")

(binary "0") 

 
Calculation Channels 
Compared to either analog or digital channels, Calculation channels do not collect external data, but transform 
incoming data in some way. These channels do not alter the original data, but create new channels (with 
channel numbers starting at CH40) that contain the modified data. 
Calculation channels can be used to compute a host of new variables by using transformations (including BPM, 
integration calculations, and math functions). The channels are Set Up in much the same way (using 
Acquire/Plot/Values boxes) as analog or digital channels, with the exception of the pull-down menu next to the 
Calc button and the Setup dialog. 
To enable a Calculation channel or channels, check the Acquire box for each channel to be added (the Plot and 
Value boxes are optional). When a new Calculation channel is enabled, a dialog will appear enabling  the 
selection of the desired Preset type and Source channel. To change the Preset and Source channel types from the 
defaults of Integrate and A1, click the  button to the right of the Preset and Source channel fields and choose 
the desired option. 

 
After clicking OK in the above dialog, an additional Setup dialog for the selected preset is presented. See 
Chapter 6 for a detailed explanation of the various Calculation channel setup options. 
Once the Calculation channel parameters are set, the options referenced above can be subsequently modified by 
using the Setup button in the Channels dialog. (Highlight the desired channel in the list and click “Setup.”) 
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Up to 16 Calculation channels can be acquired, and you may use the output of one Calculation channel as the 
input for another channel, as long as the output channel has a higher channel number than the input channel. In 
other words, it’s possible for Calculation channel 3 to include the result of Calculation channel 1, but not the 
other way around. This allows for complex Calculations to be performed that involve two or more Calculation 
channels such as filtering ECG data then computing BPM. 

TIP: All of the operations (except Control and Metachannel) that can be 
performed online can also be performed after an acquisition has been 
completed. These options are available under the Transform and 
Analysis menus.  

Metachannel  
Calculation metachannels provide a method for 
expanding the 16 available calculation channels 
to allow for more complex online analysis. The 
metachannel calculation channel type combines 
multiple steps into a single calculation channel 
so that a chained computation can be 
performed using a single calculation 
metachannel. 

• AcqKnowledge can display the results 
of up to 16 metachannels, allowing for 
a total of 256 intermediate subchannel 
steps. 

 

 
One metachannel can contain up to 16 subchannels, each of which can be individually configured. Subchannels 
can perform any of the functions of top-level calculation channels. 
Each metachannel has one user-defined output channel. The output subchannel is the only waveform data that 
will be recorded in the graph for that metachannel. All other subchannels associated with that metachannel are 
temporary; they do not display in the graph and require no extra space in the graph file to compute. 
Metachannels alleviate the need to use top-level calculation channels for computing intermediate steps where 
only the final computation is desired. Metachannels also can be used as the basis of presets, allowing multi-step 
analyses to be applied with a single preset.  
Computation takes place at the lowest waveform sampling rate of all of the referenced source channels, and all 
subchannels are computed at this rate. 
Metachannels labels display in the graph as C#.# 
To have AcqKnowledge perform a Metachannel calculation: 

1. Choose Hardware > Set Up Data Acquisition > Channels. 
2. Click the Calculation tab. 
3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 

check the Plot and Values boxes as appropriate for each channel. 
4. Click the Preset pull-down menu and select Metachannel. 
5. Click the Setup button in the Input Channels dialog to generate the Metachannel dialog. 

Primary Source 
The primary source for a metachannel can be set to any analog or digital enabled channel, or an enabled 
calculation channel with a lower number. 
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Set Up Subchannel 
Click this button to display the calculation setup dialog for the 
selected subchannel and then set the calculation parameters 
and the source channel.  
Source channel: Each subchannel can be set to use the primary source channel as its data source or another 
channel (analog, digital, or lower-index calculation channel). When the primary source channel for the 
metachannel is changed, the source channel of each subchannel will implicitly be changed. 

Limitations on Subchannels 
Subchannels are allowed to take on any of the main calculation channel types. All calculation types are 
available, with some restrictions. 

• Output of reset events is not supported for Integrate and Rate subchannels. 
• For Expression subchannels, the expression language will be enhanced to allow for "PSC" to be 

typed into the expression to refer to the data of the primary source channel. 
• Unlike regular calculation channels, the actual data for subchannels is not retained in memory. 

Subchannels are only used as temporary data and the results discarded after the value of the 
output subchannel has been computed. 
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AcqKnowledge QUICK STARTS  
Quick Start templates (.gtl graph template files) are installed to the Sample Data folder. Use Quick Start files to 
establish the settings required for a particular application or as a good starting point for customized applications. 
See Open As Graph Template on page 252 for details.  

Q## Application(s) Feature 
1 EEG 

Sleep Studies 
Real-time EEG Filtering 
Real-time EEG Filtering 

2 EEG Evoked Responses 
3 EEG 

Evoked Response 
Event-related Potentials 
Event-related Potentials 

4 Evoked Response Nerve Conduction Studies 
5 Evoked Response Auditory Evoked response & Jewett Sequence 
6 Evoked Response Visual Evoked Response 
7 Evoked Response Somatosensory Evoked Response 
9 Evoked Response Extra-cellular Spike Recording 
10 Psychophysiology Autonomic Nervous System Studies 
12 Psychophysiology Sexual Arousal Studies 
13 EBI 

Cardiovasc. Hemodynamics 
Exercise Physiology 

Cardiac Output 
Noninvasive Cardiac Output Measurement 
Noninvasive Cardiac Output  

15 EOG Nystagmus Investigation 
16 EOG Saccadic Eye Movements 
17 Plethsymography Indirect Blood Pressure Recordings 
18A Plethsymography Arousal - Female 
18B Plethsymography Arousal - Male 
19 Sleep Studies Multiple-channel Sleep Recording 
20 Sleep Studies 

ECG 
Cardiovasc. Hemodynamics 

Online ECG Analysis 
Online ECG Analysis 
ECG Analysis 

21 Sleep Studies SpO2 Analysis 
22 ECG Einthoven’s Triangle & 6-lead ECG 
23 ECG 12-lead ECG Recordings 
24 ECG Heart Sounds 
25 Cardiovasc. Hemodynamics Online Analysis 
26 Cardiovasc. Hemodynamics Blood Pressure 
27 Cardiovasc. Hemodynamics Blood Flow 
28 Cardiovasc. Hemodynamics LVP 
31 NIBP Psychophysiology 
32 In vitro Pharmacology Tissue Bath Monitoring 
33 In vitro Pharmacology Pulsatile Tissue Studies 
34 In vitro Pharmacology Langendorff & Working Heart Preparations 
35 In vitro Pharmacology 

Pulmonary Function 
Isolated Lung Studies 
Animal Studies 

38 Pulmonary Function Lung Volume Measurement 
39 Exercise Physiology Respiratory Exchange Ratio 
40 EMG Integrated (RMS) EMG 
41 EMG EMG and Force 
42 Biomechanics Gait Analysis 
43 Remote Monitoring Biomechanics Measurements 
44 Biomechanics Range of Motion 
45 Vibromyography Muscle Activity 
46 Pressure Volume Loop Blood Pressure & Flow  
47 Heart Rate Alarm Monitor heart rate with audible alarm 
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 Chapter 6 Calculation 
Channel Presets 

Calculation Presets establish settings to target 
application-specific analysis. Presets exist for a 
broad range of analysis functions, including 
Fourier Linear Combiners and Adaptive Filtering. 
Start with existing presets for a specific species or 
protocol—for example, human vs. small animal, 
or stationary vs. exercising measurements. 
The Channel Setup dialog contains a “Preset” pop-
up menu by each channel that lists the current 
Preset or, if no Preset has been selected for that 
channel, the Calculation type (Integrate, 
Difference, etc.). When selecting a Preset for a 
particular channel, the channel is configured with 
the settings associated with that Preset.  
The Setup dialog has a “Presets” pop-up menu 
that contains all of the Presets for the Calculation 
type being configured. To enable the Preset pop-
up menu, set at least one analog channel to 
“Acquire” (calculation channels require a source 
channel). For example, if a Difference Calculation 
channel is being configured; all Presets for the 
Difference Calculation will be listed. Just click the 
Presets head and scroll to select the desired preset.  
After selecting a Preset, the Setup dialog is 
updated with the corresponding information. 
 The Setup dialog reads “none” if the 

channel configuration doesn’t match any 
Preset. The menu will flip to “none” when 
the settings for a channel are changed 
such that they no longer match a Preset.  

 To create a new Preset from existing 
Calculation channels: Click “Setup” to 
display the Calculation Setup dialog and 

click the “New Preset” button. The settings will be applied to the current channel, and you will be 
prompted to enter a name for the new Preset. Preset names cannot be duplicated, nor can the default 
name of a Calculation channel type (Integrate, Difference, etc.). Newly-created Presets will be included 
in the pop-up menus and saved with the file. 

 To reorder channel Presets (by type, use, etc.), choose Hardware > Organize Channel Presets and then 
use the up/down buttons as appropriate (see page 245). 

 MP150 hardware: Presets are not applicable to and therefore not selectable on Analog or Digital 
channels. 

 MP36R hardware: Presets are available on Analog channels but not Digital channels. 
 Watch the AcqKnowledge Preset Option video tutorial for a detailed demonstration of this feature. 

http://www.biopac.com/video/?video_category=acqknowledge-new-features&v=preset-options-in-acqknowledge�
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Integrate Calculation 

     
The online Integrate Calculation offers three basic options: 

Reset via channel. Perform a real-time integration of input data over a variable number of sample points. 
This option is extremely useful for converting flow signals into volumetric equivalents. The integral of flow 
is volume. For example, when recording airflow with a pneumotach, volume can be precisely calculated as 
the flow varies in a cyclic fashion: 

a)  Real-time conversion of flow signals into volume signals (i.e., Blood flow  Blood volume; Air 
flow  Air volume) 

b)  Any processing involving a need for a cyclic, continuous integral calculated in real time. For 
example: Acceleration  Velocity; Velocity  Distance; Frequency  Number of cycles; Power 
 Energy 

Average over samples. Perform a moving average (mean) and associated processing (Rectify; Root mean 
square) over the specified number of sample points. This option is useful to process EMG signals to: 

a)  Smooth noisy data 
b)  Display the real-time “integration” (rectified, then sample averaged) of the raw EMG data 
c)  Display the real-time “root mean square” calculation of the raw EMG data 
d)  Return real-time windowed standard deviation 

Timed reset. This option is available in AcqKnowledge 4.1 and above in the Integrate calculation channel 
and transformation. This mode computes a straight sum of the source data points and resets this sum after a 
fixed amount of time has elapsed. This periodic integral is used in several types of analysis, such as EMG 
analysis where it can generate an EMG signal or estimate the power in fixed time intervals. The time 
interval at which the integral resets to zero may be specified in seconds or in samples. The timed integrate 
reset functionality may also be used in calculation channel presets and by the Mac OS X Integrate 
automator action.  

To have AcqKnowledge perform an Integrate calculation in real time: 
1. Choose Hardware > Set Up Data Acquisition > Channels (click “View by Channels). 
2. Click the Calculation tab. 
3. Check an Acquire box for the Calculation channel you want to contain the modified data. You may also 

check the Plot and Values boxes as appropriate for each channel. 
4. Click the Preset pull-down menu and select Integrate. 
5. Click the Setup button in the Input Channels dialog to generate the Integrate dialog. 

(Off-line Integrate is available under Transform > Integrate.) 
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Destination 

Determined by the calculation channel selected. (C0, C1, C2, etc.) 

 
Source 

Any Analog or Digital channel being acquired as well as any enabled Calculation channels with a lower 
number. 

Reset via channel (Integrate option) 
This feature is used to integrate data over a data-dependent 
interval. Either the source channel or a different channel 
can control the integration process. 
Control channel 
Allows user to select any active channel as the integration 
control channel. (Calculation channels must have a lower 
number.) 
Reset Thresholds 
The threshold is to be set at points surrounding the flow 
level. Typical values are: 
LOW: a negative value close to 0.00 
HIGH: a positive value close to 0.00 
For airflow to volume conversion, the flow signal will vary 
positively and negatively around zero flow. 
Reset trigger  
The Reset trigger polarity determines on which slope 
(Positive ↑ or Negative ↓) the integration process will begin 

and end. 

Mean Subtraction 
This option will subtract the mean from the data evaluated during the integration period. If this option is 
selected, the integration will only proceed after all the data in the integration period has been collected. When 
collected, the mean value of all the data is subtracted from each data point in the integration period. In this 
fashion, the integral of the corrected data points will result in the integral returning to exactly zero at the end of 
the integration interval. Although this option will result in “well-behaved” integrations, the integrated data will 
be delayed by a fixed amount of time, as specified by the max cycle period. 

Online Enabling mean subtraction delays the signal by the mean cycle length. It waits for that period of 
time to pass so it can determine a mean value for the initial cycle, and it then tries to re-compute 
this mean for each cycle. If the resets are too short or too long, the window expires and the 
processing halts again until a new mean can be recomputed. Online processing may reset from 
threshold crossing in the control channel or window expiration when it loses mean tracking. 

Offline Tranformation version of this operation. Since all the data is available, the mean is computed 
from the data in the channel and the signal is not delayed. Also, since it isn’t doing windowed 
means, there are no window expiration events inserted. Offline processing may reset from 
threshold crossing in the control channel. 

Max cycle period 
The Max cycle period should be longer than the maximum time expected from trigger event to trigger event in 
the Control Channel. Typically, the default scale settings for cyclic integrated data will be fine.  
Output reset events—not available for metachannels 
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Add Events (markers) to show where Reset occurred and distinguish why the channel reached zero. 

 Threshold crossing on the 
control channel 
For example: Calculation 
channel resetting on positive 
crossings of 0V on CH 1. 

 

 
 Window expiry when mean 

removal is enabled 
For example: No threshold 
crossing within “mean cycle 
width” as specified in calc 
channel setup. Settings of 
calc channel: threshold 
crossings positive, 3V, Mean 
cycle subtraction, 1 second 
period width. First reset is 
due to threshold crossing; 
second reset is due to 
window expiry.  
 Zero value due to “true” zero 

being achieved due to 
mathematical results 
For example: Mathematical 
Source is sine wave, integral 
is cosine. Input (10V) never 
crosses threshold levels. 
Signal reaches zero 
mathematically; no reset 
events appear on output. 
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Average over samples (Integrate operation) 

Online sample averaging can be useful when there 
is a high degree of noise present in the data. At 
least some of this noise can be “averaged out” by 
pooling some number of adjacent data points 
together, taking the average of these points, and 
replacing the original values with the new averaged 
values. This process creates a “window” of moving 
averages that moves across the waveform 
smoothing the data.   

Integration used to smooth noisy data 

Samples 
To specify the number of data points to average across, enter a value in the Samples box. The number you 
select will depend in large part on the sampling rate you select and the type of noise present. All things being 
equal, for slower sampling rates you will probably want to mean average across a smaller number of samples. 
As you increase the sampling rate, you will probably want to integrate across more and more samples. As the 
number of samples specified in the samples box increases, the amount of high frequency information contained 
in the data will decrease. 
Parameters 

Rectify —The Average over samples calculation 
can also be used for producing an envelope of 
modulated data. For instance, EMG waveforms 
frequently contain high frequency information, 
which is often of little interest compared to the low 
frequency information also contained in the data. 
When the Rectify option is checked, 
AcqKnowledge will take the absolute value of the 
input data prior to summing and a plot of the 
waveform’s mean envelope over a specified 
number of samples will be obtained. 

 
Online “Average over samples” feature used as an 

envelope detector 

Typically, this option is only used for processing raw EMG and similar types of applications. The signal for 
Rectify is normalized by a factor of (# samples averaged)/(Channel sampling rate). 
Root mean square—provides the exact root mean square (RMS) of the input data (typically EMG) over the 
specified number of samples.  
Remove baseline—provides the exact standard deviation of the input data (typically EMG) over the specified 
number of samples. When the mean of the input data equals 0-0, the standard deviation and the RMS will be 
equivalent.  
Scaling… button—Since the integration values are going to be on a different scale than the original units, you 
need to change the scale of the integration channel to reflect the new units. Click the Scaling… button, to 
generate the Change Scaling Parameters dialog.  
The rescaling involves multiplying the “Input units” values by a factor determined by the sampling rate and 
number of samples mean averaged across. 

Map or Scale value = Input units x 
 averaged mean be  tosamples ofNumber 

 rate Sampling  

As an example, if data was being acquired at 75 samples per second, and you wanted to integrate across an 
interval of 10 samples, you would set the Integration Setup Scaling parameters so that +10 Volts corresponded 
to a Map (Scale) value of 75 and a Map (Scale) value entry of –75 reflected an Input value of –10 Volts. 
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 It is important to note that this rescaling should be performed independent of any rescaling performed 
on analog channels themselves. Even if an analog channel is being rescaled to some other units, the 
input values in the integration scaling should be set to +10 Volts (next to Cal 1) and –10 Volts (next to 
Cal 2). 

  
Integrate Calculation and Scaling dialogs for 10 point averaging 

When data is averaged in this way, a portion of the data at the beginning of the record (equivalent to the number 
of samples being integrated) should be ignored, as they will reflect a number of zero values being averaged in 
with the first few samples of data. 
 
Timed Reset (Integrate operation) 

 
Timed Reset operation computes a straight sum of the source data points and resets this sum after a fixed 
amount of time has elapsed. This periodic integral is used in several types of analysis, such as EMG analysis 
where it can estimate the power in fixed time intervals.  
The time interval at which the integral resets to zero may be specified in samples, milliseconds, seconds, 
minutes or hours. 
Timed reset functionality may also be used in calculation channel presets and by the Mac OS X Integrate 
automator action.  
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Smoothing Calculation 
The Smoothing Calculation is useful for removing noise of varying types from a data set. 

1. Choose Hardware > Set Up Data Acquisition > Channels. 
2. Click the Calculation tab. 
3. Check an Acquire box for the Calculation channel you want to 

contain the modified data. You may also check the Plot and 
Values boxes as appropriate for each channel.  

4. Click the Preset pull-down menu and select Smoothing. 
5. Click the Setup button in the Input Channels dialog to generate 

the Smoothing dialog. 
 (Off-line Smoothing is available under Transform > Smoothing.) 

  
Source Source is a pull-down menu of the available channels. 
Smoothing factor enter the number of samples to use as a smoothing factor. 
Smoothing method This calculation channel provides real-time Mean (default) or Median smoothing. 
 Mean value The default is mean value smoothing. Use Mean value smoothing when noise appears in a 

Gaussian distribution around the mean of the signal. 
Use Median value Click in the box to activate Median value smoothing if some data points appear completely 

aberrant and seem to be “wild flyers” in the data set. 
  For a given sequence of wave data, x = {x1, x2,...,xn}, Median value smoothing will sort the 

sequence and extract the median equivalent to the recommended NIST (National Institute 
of Standards and Technology) formula: 
• n is odd: median is the center element of the sorted list of n items. 
• n is even: median is the mean of the center pair of elements of the sorted list of n items.  

 The smoothing calculation channel is the primary method of computing real-time median 
values using the definition of median as given above. The smoothing output at a sample 
position is the median of the window of source channel samples including the current 
sample and the previous samples in the window. 

    The size of the window is 1 at the start of acquisition and increases incrementally until 
the final window size is reached. The median extraction method shifts between even and 
odd definitions as the window size is incremented. 

Scaling Click the Scaling button for access to options that allow you to modify the units or linearly 
scale the output. 

 
 Watch the AcqKnowledge Smoothing video tutorial for a detailed demonstration of this feature.

http://www.biopac.com/video/?video_category=acqknowledge-tutorials&v=acqknowledge-smoothing�


Part B — Acquisition Functions 133 

AcqKnowledge 4 Software Guide 
 

Difference Calculation 
The Difference calculation returns the difference between two data samples over a specified number of intervals 
and divides the Difference by the time interval spanned by the data values. The Difference Calculation is useful 
for calculating an approximation of the derivative of a data set in real time. 
To have AcqKnowledge perform a Difference calculation in real time: 

1. Choose Hardware > Set Up Data Acquisition > Channels. 
2. Click the Calculation tab. 
3. Check an Acquire box for the Calculation channel you want to contain the modified data. You may also 

check the Plot and Values boxes as appropriate for each channel. 
4. Click the Preset pull-down menu and select Difference. 
5. Click the Setup button in the Input Channels dialog to generate the Difference dialog. 

(Off-line Difference is available under Transform > Difference.) 
The Difference Calculation dialog allows you to specify the source channel and the number of intervals 
between samples over which the difference is to be taken, and also includes the option of rescaling the channel 
to reflect different units. 
Click the Setup button in the Input Channels dialog to generate the Difference dialog:  

  
Source When the Source channel contains relatively high frequency data, the Difference Calculation 

may result in a very noisy response, so it’s best to use Difference on relatively smooth data. 
Intervals Difference is calculated with respect to the number of intervals between points (rather than the 

number of sample points). For instance, two sample intervals span three sample points: 
POINT<interval > POINT<interval > POINT 

 A 1-interval difference transformation applied to a blood pressure (or similar) waveform will 
result in the widely used “dP/dT” waveform. 

 See page 307 for a complete description of the online Difference function. 
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Rate Calculation 

  
The Rate Calculation is used to extract information about the interval between a series of peaks in a waveform. 
This interval can be scaled in terms of BPM (the default), frequency (Hz), or time interval between peaks. 

 The BPM (or beats-per-minute) Rate function is used as a measure of peaks or events that occur in a 
sixty-second period. 

 The frequency rate function is commonly used to describe the periodicity of data, or the amount of 
time it takes for data to complete a full cycle (from one peak to the next peak). 

 The Interval Rate function returns the raw time interval between each adjacent pair of peaks, which is 
essentially the inter-beat interval (IBI), frequently used in cardiology research. 

These three functions essentially provide the same information in different formats, since a frequency of 2Hz is 
equal to an inter-peak interval of 0.5 seconds, both of which are equivalent to a BPM of 120. Other options 
allow you to record the maximum or minimum value of all peaks (the peak max/min option), or to count the 
aggregate number of peaks (the count peaks option).  
In order to calculate Rate information, you have the option of specifying the threshold manually or having 
AcqKnowledge automatically compute the default threshold value. This section describes the basic parameter 
settings for typical online Rate Calculations. 

NOTE: Parallel functions can be performed after data has been acquired. A 
detailed description of the Rate Calculation options can be found in the Find 
Rate section on page 341. 
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To perform a Rate Calculation in real time: 
1. Choose Hardware > Set Up Data Acquisition > Channels. 
2. Click the Calculation tab. 
3. Check an Acquire box for the Calculation channel you want to contain the modified data. You may also 

check the Plot and Values boxes as appropriate for each channel. 
4. Click the Preset pull-down menu and select Rate. 
5. Click the Setup button in the Input Channels dialog to generate the Rate dialog. 

(Off-line Rate calculation is available under Analysis > Find Rate.) 
Source—selected from the Source popup menu at the top of the dialog. 
Label—Use to create a label for the Rate channel 
Preset—Use to select from 17 pre-defined calculation channel presets. New presets affecting source channel, 
label and output settings can be created and saved by clicking “New Channel Preset.” 
Signal Parameters Tab 
Signal Type—Contains parameters for specific human and animal waveform morphologies. Choose from six 
pre-defined heart rate and respiration signal types, or click “New” to create and save custom setups. Unlike 
channel presets, all pre-defined and custom signal types appear in both calculation channel Rate (online) and 
analysis Rate (offline) dialogs. Signal type modifications affect settings in the Signal Parameters tab only. For 
more details on Rate signal types, see page 344. 
Peak Detect—Choose whether to look for positive or negative peaks in the signal. 
Remove baseline—provides the exact standard deviation of the input data (typically EMG) over the specified 
number of samples. When the mean of the input data equals 0-0, the standard deviation and the RMS will be 
equivalent. 
Baseline window width—Width of the window for the difference operation applied prior to peak detection. 
(E.g. the value of the source x ms previously is subtracted from the current value to generate the signal that is 
analyzed with the peak detection.) 
Auto Threshold detect—The most convenient way to calculate a Rate channel online is to have 
AcqKnowledge automatically compute the threshold value (the “cutoff” value used to discern peaks from the 
baseline). This is done by checking the Auto Threshold detect box. 
Noise rejection—AcqKnowledge constructs an interval around the threshold level when Noise rejection is 
checked. The size of the interval is equal to the value in the noise rejection text box, which by default is equal to 
5% of the peak-to-peak range. Check this option to help prevent noise “spikes” from being counted as peaks. 
Cycle Interval Window—When “automatic” Rate Calculations are set, specify a minimum rate and a 
maximum rate. These parameters define the range of expected values for the Rate Calculation. By default, these 
are set to 40 BPM on the low end and 180 BPM on the high end.  
The Rate Calculation will use these values to find and track the signal of interest, assuming the input BPM 
range is reasonably well bracketed by these values. Depending on the shape of the input cycle waveform, the 
Rate window settings may be closer or further from the expected rates. 

 For ECG-type data (where the waveform peak is narrow with respect to the waveform period), the 
Rate window values will closely bracket the expected values. 

 For more sinusoidal data, with the waveform energy distributed over the waveform period (as with 
blood pressure or respiration), the Rate window will closely bracket the expected rate on the high-end, 
but can be up to twice the actual measured rate at the low-end. 

One of the most frequent applications of the Rate Calculation is to compute BPM online for 
ECG, pulse, or respiration data. For more information on optimizing ECG amplifiers for online 
calculation of heart rate, see the ECG100C section of the Hardware Guide. 

Windowing Units—Use to select the unit type to be used in the rate detection. The options are Hz, BPM and 
seconds. 
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Output Tab 
Function —The popup menu includes options to scale the rate in terms of Hz, BPM, Interval, Peak Time, 
Count Peaks, Peak Minimum/Maximum, Peak-to-Peak, Mean Value, Area or Sum. 

 For more information on each of these functions, see the Calculation Channels section beginning on 
page 122. 

 Calculate systolic using the peak maximum Function, diastolic using the peak minimum Function, and 
mean blood pressure using the mean value Function. 

 NOTE: All of these Function options are available in the post-acquisition mode through 
the Analysis > Find Rate function. 

Use Averaging mode—Use to average the output of the selected function. Averages can be based upon a fixed 
time window or a fixed number of cycles. The ‘Recompute on every cycle’ option will start the averaging 
output after N numbers of cycles are detected and then remain fixed until the next N cycles are detected. 
Output reset events (not available for metachannels)—When auto threshold detection is being used, the 
minimum and maximum rates of the signal are specified in the Windowing controls. If the input signal falls out 
of this range, the value of the rate function and automatic threshold level will be reset. By enabling “Output 
reset events” a reset event will be placed on the output at the location of these window expirations. Rate 
detector is set to “Peak function, default window of 40 BPM to 180 BPM, auto threshold detect for positive 
peaks. The reset event occurs after the window expiration, approximately a full 40 BPM interval after the 
“peak” transition from 0 to 5 volts in the source signal. 

  
Show Threshold—Plots the threshold used by the Rate calculation function.  
Show Modified—Plots the modified data as processed by the Rate Detector. Typically, the modified data is a 
differential version of the original input data. The data will be modified if the “remove baseline” feature is 
checked.
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Math Calculation 
The Math Calculation performs standard arithmetic calculations using two waveforms or one waveform and a 
constant. Calculation channels with lower channel numbers may be also used as a waveform. 

1. Choose Hardware > Set Up Data Acquisition > Channels. 
2. Click the Calculation tab. 
3. Check an Acquire box for the Calculation channel you want to contain the modified data. You may also 

check the Plot and Values boxes as appropriate for each channel. 
4. Click the Preset pull-down menu and select Math. 
5. Click the Setup button in the Input Channels dialog to generate the Math dialog. 

(Off-line Math calculation is available under Transform > Waveform Math.) 
Use the pull-down Source menus to select the source channels (Source 1 and Source 2). 
The Sample rate line provides the sample rate for the channel selected as Source; the channel sample rate may 
be different than the acquisition sample rate. 
Use the pull-down Operation menu to select a function. In the example below, analog channel 1 (Source: A1) is 
added to analog channel 2 (Source: A2). To use this summed waveform as an input for another Math 
Calculation channel. One useful application would be to divide this waveform (C0) by K, where K=2, thus 
producing an arithmetic average of source channels A1 and A2. 

   
The “Constant” entry is activated when “K” is selected as a Source. 
As an alternative to creating an additional Calculation channel for dividing the summed waveform, you can use 
the scaling function to perform the same task. To do this, click Scaling… button and then set the Map (Scale) 
value for the summed waveform equal to +5 and –5 (to correspond to Input Volts values of +10 and –10 
respectively). This will effectively plot the sum of channels A1 and A2 as the arithmetic mean of the two 
waveforms. 

For additional information, see the sections on Function Calculation channels (page 138) and online 
Expression, page 141).  
For complex calculations (such as squaring a waveform then adding it to the average of two other 
waveforms,) Expression is a more efficient solution. These calculation channels allow more complex 
operations. Metachannels (page 123) allow the user to chain multiple calculation channels together. 
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Function Calculation 

 

 

The Function calculation can be used to perform a variety of 
mathematical functions to a single waveform. Like math 
Calculation channels, function Calculations can be chained 
together to produce complex functions (such as taking the absolute 
value of a waveform on one channel and Calculating the square 
root of the transformed waveform on another channel). These 
same functions are also available under the transform menu in 
AcqKnowledge for post-hoc operations. Many of these functions 
can also found in the online Expression, see page 141 for details). 
To have AcqKnowledge perform a Function Calculation in real 
time: 

1. Choose Hardware > Set Up Data Acqusition > Channels. 
2. Click the Calculation tab. 
3. Check an Acquire box for the Calculation channel you 

want to contain the modified data. You may also check the 
Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Filter. 
5. Click the Setup button in the Input Channels dialog to 

generate the Function dialog. 
(Off-line Function calculation is available under Transform > 
Math Functions.) 
Other mathematical Functions are available in the online 
Expression (see page 141). Function Calculations can be chained 
together to produce more complex Calculations, although it is 
more efficient to program complex functions using the Expression 
calculation. 
The Sample rate line provides the sample rate for the selected 
channel (may be different than the acquisition sample rate). 

Function 
Abs Returns the absolute value of each data point 
Atan Computes the arc tangent of each data point 
Exp Takes the ex power of each data point 
Limit Limits or “clips” data values that fall outside specified boundaries 
Ln Computes the base e logarithm for each data point 
Log Returns the base 10 logarithm of each value 
Noise Creates a channel of random noise with a range of ± 1 Volt 
Sin Calculates the sine (in radians) of each data point 
Sqrt Takes the square root of each data point. 
Threshold Converts above an upper threshold to +1 while converting data below a lower threshold to 0. 

Thresholding Algorithm Assume a domain variable 

 

t ∈ tstart , tstart +1,tstart + 2,{ } 
with tstart being an integer, a real-valued signal y(t) defined for all t, and two real valued levels ylow 
and yhigh satisfying the relation 

 

ylow ≤ yhigh . 

Define the Threshold function thresh(t) function such that: 

 

thresh(tstart ) =
1 y(tstart ) ≥ ylow

0 y(tstart ) < ylow

 
 
 

    

 

thresh(t) =
0 y(t) < ylow

1 y(t) > yhigh

thresh(t −1) ylow ≤ y(t) ≤ yhigh
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Filter IIR Calculation 
The Filter IIR Calculation channel allows you to perform real time digital filtering on analog, digital, or 
calculation channels. To have AcqKnowledge apply a digital Filter IIR Calculation in real time: 

1. Choose Hardware > Set Up Data Acquisition > Channels. 
2. Click the Calculation tab. 
3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 

check the Plot and Values boxes as appropriate for each channel. 
4. Click the Preset pull-down menu and select Filter. 
5. Click the Setup button in the Input Channels dialog to generate the Filter dialog. 

                      
Filter Setup & Output Options 

In the dialog above, the signal on analog channel one (A1) is run through a low-pass filter that attenuates data 
above 50 Hz. The “Q” for this filter is 0.707, which is the default. 

One possible application of the online filtering option is in conjunction with the Show Input 
Values option (see page 232). Raw EEG data, for instance, can be filtered into distinct 
bandwidths (alpha, theta, and so forth) using one source channel and multiple filter Calculation 
channels. The filtered data can then be displayed in a bar chart format during the acquisition 
using the Show Input Values option. 

Source Set the source channel. 
Sampling rate Select this to compute the frequency at the start of acquisition as a fraction of the channel 

sample rate. (Unselected by default.) 
Type (Output) Lists the filter options: low pass, high pass, band pass, band pass (low + high), band stop, and 

comb band stop. See About Filters in this section for more details on filter types. 
Frequency Fixed value—Type a value in the entry box. 
 Sampling rate—Sets the frequency to a fraction of the sampling rate and automatically updates 

when the sample rate is modified. 
 Line frequency—Uses the line frequency at which the data was recorded. 
Q coefficient The online IIR have a variable Q coefficient. The Q value entered in the filter setup box 

determines the frequency response patterns of the filter. This value ranges from zero to infinity, 
and the “optimal” (critically damped) value is 0.707 for the Low pass and High pass filters, and 
5.000 for the Band pass and Band stop filters. If you wish, you may change the Q. A more 
detailed explanation of this parameter and digital filters in general, can be found in Appendix 
B. 
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About Filters 
While the technical aspects of digital filtering can be quite complex, the principle behind these types of filters is 
relatively simple. Each of these filters allows you to set a cutoff point (for the low and high pass filters) or a 
range of frequencies (for the band pass and band stop filters). 
 A Low Pass filter allows you to specify a frequency cutoff that will “pass” or retain all frequencies 

below this point, while attenuating data with frequencies above the cutoff point. 
 High Pass filters perform the opposite function, by retaining only data with frequencies above the 

cutoff, and removing data that has a frequency below the specified cutoff. 
 Each type of Band Pass filter is optimized for a slightly different type of task. 

The Band Pass (low + high) filter is designed to allow a variable range of data to pass through the filter. 
For this filter, you need to specify a low frequency cutoff as well as a high frequency cutoff. This 
defines a range or “band” of data that will pass through the filter. Frequencies outside this range are 
attenuated. The Band pass (low + high) is actually a combination of a low pass and a high pass filter, 
which emulate the behavior of a band pass filter. This type of filter is best suited for applications where 
a fairly broad range of data is to be passed through the filter. For example, this filter can be applied to 
EEG data in order to retain only a particular band of data, such as alpha wave activity. 
The alternative Band Pass filter requires only a single frequency setting, which specifies the center 
frequency of the band to be passed through the filter. When this type of filter is selected, the “width” of 
the band is determined by the Q setting of the filter (discussed in detail below). Larger values for q 
result in narrower bandwidths, whereas smaller Q values are associated with a wider band of data that 
will be passed through the filter. This filter has a bandwidth equal to Fo/Q, so the bandwidth of this 
filter centered on 50 Hz (with the default Q=5) would be 10 Hz. This type of filter, although 
functionally equivalent to the band pass (low + high) filter, is most effective when passing a single 
frequency or narrow band of data, and to attenuate data around this center frequency. 

 The Band Stop performs the opposite function of a band pass. A Band stop filter defines a range (or 
band) of data and attenuates data within that band. In this case, the Band stop filter is implemented in 
much the same way as the standard Band pass, whereby a center frequency is defined and the Q value 
determines the width of the band of frequencies that will be attenuated. 

 The Comb Band Stop removes interfering harmonics; resonance, aliasing, and other effects may 
generate interference at multiples of a base frequency. It combines all the required filters instead of 
requiring a separate filter for each interfering overharmonic. For setup details, see page 289. 

Off-line filtering 
Apart from these online filter options, similar filters can be applied after an acquisition is terminated via the 
Transform > Digital Filters menu. Many of the biopotential amplifiers available from BIOPAC have selectable 
filters, which allow you to filter certain frequencies (including 50 Hz or 60 Hz electrical noise) and possibly 
reduce the need for online filters. 
Digital filtering can also be performed after an acquisition using the same types of filters. You can choose from 
the different filter types by selecting Digital filters from the Transform menu. The filters available after the 
acquisition use a different algorithm but operate in essentially the same way. 

For more information on digital filters and filters that can be applied after an 
acquisition, turn to the Digital Filtering section on page 283 or Appendix B. 
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Expression 

 
The online Expression calculation channel is available for performing computations more complex than 
possible in the Math and Function calculations, and is additionally available as an offline transformation and a 
measurement. (Different attributes may apply to each available Expression type.) The Expression calculation 
will symbolically evaluate complex equations involving multiple channels and multiple operations. 
AcqKnowledge can perform conditional evaluation, data extraction, logical operations, expressions requiring a 
range of samples or the results of the previous expression, and evaluation of generic formulas that can be 
expressed in a closed, recursive form. 
Unlike the Math and Function calculations—which can only operate on one or two channels at a time—the 
Expression calculation can combine data from multiple analog channels, and allows you to specify other 
Calculation channels as input channels for Equation channels. Also, computations performed by the Expression 
calculation eliminate the need for “chaining” multiple channels together to produce a single output channel. 
While the Expression calculation is more powerful than other Calculation channels, each Expression calculation 
requires more system resources than other Calculations. This essentially means that acquisitions that utilize 
Equation calculations are limited to a lower maximum sampling rate than acquisitions without online 
Expression functions. When an expression is evaluated, it is actually evaluated multiple times. The expression 
is computed starting at the first sample acquired, and is then evaluated once for each successive acquired 
sample. 
AcqKnowledge can accept the notations SC, MC, and CHn to reference the sample at the current evaluation 
position or SC(x), MC(x), and CHn(x) for values at locations prior to the present evaluation location using 
an offset expressed in sample intervals. For example, CH1(-1) will give the previous sample of Channel 1. 
The same features that are available in online Calculation channels are also available under the Transform menu 
for evaluation of complex equations after acquisition. Thus, simple Calculations such as summing two channels 
or finding the absolute value of a channel (and so forth) are best performed in either the Math calculation 
channels or the Function calculation channels. 
On the other hand, for complex Calculation channels, such as squaring one channel, multiplying it by the sum 
of two other channels, and dividing the product by the absolute value of another waveform, a single Expression 
calculation channel is more efficient than chaining five Math and Function calculation channels. 
Save to Calculation Channel 
To evaluate an expression and save the result to a Calculation channel in real time: 

1. Choose Hardware > Set Up Data Acquisition > Channels. 
2. Click the Calculation tab. 
3. Check an Acquire box for the Calculation channel you want to contain the modified data. You may also 

check the Plot and Values boxes as appropriate for each channel. 
4. Click the Preset pull-down menu and select Expression. 
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5. Click the Setup button in the Input Channels dialog. This will produce a dialog, where you can enter the 
expression to be evaluated. 

(Off-line Expression is available under Transform > Expression.) 
 

The different components of each expression can be entered either by double-clicking buttons from the button 
rows (sources, functions, and operators) in the setup expression dialog, or by typing commands directly into the 
Equation box. The Expression calculation uses standard mathematical notation. 
For each expression, you need to specify at least one source, the function(s) to be performed, and any operators 
to be used. Sources are typically analog channels, although you may also select Time from the source button 
row and AcqKnowledge will return the value of the horizontal axis (usually time) for each sample point. When 
the horizontal axis is set to frequency (in the Display > Horizontal axis dialog), the “time” item in the source 
button row will switch to “frequency.” 
When using the online Expression calculation channel, it is important to keep in mind that while different 
channels, functions, and operators can be referenced, the Calculation cannot reference future sample points. 
That is, data from waveform one can be transformed or combined in some way with data from waveform two at 
the same point in time, although data from one point in time (on any channel) cannot be combined with data 
from another point in time (on any channel). See the section on post-acquisition expression commands 
(beginning on page 309) for ways around this limitation. 
Functions The arguments to each function are represented in the Functions table in italics and may 

be replaced by any valid expression. Each argument is separated from its next argument 
by a comma. Expressions can only contain commas within balanced parenthesis pairs. An 
ellipsis (.”..”) at the end of a function description indicates that any number of arguments 
may be present provided they are in a comma separated list. When a function is added to 
an Expression, the cursor is placed between the parentheses.  

Conditionals Change output based upon a condition test. All of the conditionals treat the value zero as 
false and any non-zero value as true. Expressions can only contain commas within 
balanced parenthesis pairs. 

Offset Notation Offset notations take integer offsets in terms of the number of samples using the 
formation CH#(P) where CH# is the channel number and P is the number of points. For 
example, an offset of -1 will return the data point immediately to the left of the selected 
point and an offset of +1 will return the data point immediately to the right of the selected 
point. 

 To refer to previously acquired data, offsets must be negative. For notational 
convenience, offsets that result in an invalid negative sample position (e.g. no data is 
defined prior to the first sample in the graph) evaluate to zero. Any attempt to access a 
sample beyond the end of the data will result in an error. Any attempt to use a positive 
offset for an online Expression calculation channel will result in an error. 
CHn(x) Returns the value of channel with index n x samples away from the current 

evaluation position. 
SC(x) Returns the value of the selected channel x samples away from the current 

evaluation position. Only allowed for Transformations and Measurements; not 
allowed for Calculations. 

MC(x) When x is zero or positive, returns the value of the measurement channel x 
samples away from the current evaluation position. When x is negative, returns 
the result of the expression evaluation that occurred x steps previous to the 
current evaluation position. Only allowed for Measurement Expressions (see 
below); not allowed for Calculations or Transformations. 
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Recursive notation Since transformations and calculation channels replace the source data of the channel 
with the result of the expression evaluation in sequence, negative offsets are equivalent to 
returning the final result of the expression that was evaluated a certain number of steps in 
the past. The channel where the expression results are stored can be thought of as a 
storage record of the previous evaluation steps. Negative sample offsets, therefore, can be 
used to compute any formula that can be expressed in closed recursive form. For 
example, the recursive definition of the Fibonacci sequence is: 

Fn = Fn-1 + Fn-2 
To evaluate this as an expression transformation, use the expression: 

SC(-1)+SC(-2) 
Note that to actually get the Fibonacci sequence; the selected channel would need to have 
a constant value of one prior to the transformation. 

Expression Measurements are powerful tools for quick manual analysis and also for advanced 
Measurement  automated analysis when combined with the Cycle/Peak detector. Expression 

measurements extend measurements to evaluate simple formulas or complex data 
reduction. Each Expression measurement has an expression associated with it and the 
measurement result is derived from computing the Expression(s) on the selected data. 
Measurement expression dialog is 
generated the first time a measurement is 
set to Expression or when the 
measurement preset button is clicked. 
Preset menu allows access to pre-loaded 
commonly used expressions and displays 
user-defined custom presets, along with 
a list of recently-used expressions. 
OK invokes a syntax check. If there is an 
error, the user will be prompted to 
correct the error and the error will be 
selected (highlighted) in the Expression 
edit field. 
Cancel discards any changes to the 
Expression measurement and reverts 
back to the previous Expression. 
Clear erases the current contents of the 
expression edit field. 

 

 
 Measurement Channel 

Expression measurements can reference the “measurement channel” (MC), which refers 
to either the selected channel or a specific channel as set in the measurement channel 
selection box within the graph window. 
Negative sample offsets to MC are interpreted as returning the result of the Expression 
from a prior step. Transformations and calculation channels achieve this as they replace 
the contents of their destination channels sequentially. Measurements, however, do not 
actually replace the data of their source channels. Expression measurements are actually 
executed on a temporary copy of the channel data in memory. This implies that negative 
indicies to the measurement channel are interpreted exactly the same for measurements 
as for transformations and calculation channels even though the “transformed” data of the 
measurement is not visible. Negative sample offsets to MC that refer to the sample 
position prior to the leftmost sample of the selected area will always return zero. 
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Evaluation Rules 
When a new selection is made, the first step in evaluation searches through the 
Expression measurement for any MMT() invocations. Any measurement whose value is 
needed by MMT() is computed at this time prior to the Expression evaluation. This 
behavior is similar to calculation channels and successfully allows measurements to the 
right and bottom of the Expression measurement to be used in the expression. 
The expression is subsequently evaluated from the leftmost sample in the selection to the 
rightmost sample. It is evaluated at the waveform sampling rate of its source channel, 
with one expression evaluation per sample contained within the selected area. 
Interpolation is not used at the boundaries to maintain a consistent sample interval for the 
expression. After each expression evaluation, the result is cached in memory for potential 
negative MC result references. 
The value of the final expression, the rightmost sample, becomes the result of the 
measurement. 
Circularity Detection 
Expression measurements may reference other expression measurements or calculation 
measurements by using the MMT() function in the expression. This raises the possibility 
of circular dependencies being formed by the user if a measurement expression either 
directly or indirectly needs its own value to compute a MMT() invocation. Circular 
dependency checking will be in place at execution time and will result in an error. 
To refer an Expression measurement to its own value, use the MC notation. 
Error Reporting 
The Expression measurement result will display the text “Error” if there are syntax errors 
in the Expression measurement, errors computing measurements referenced by MMT(), 
or a circularity. 

Validation Tip To function correctly, AcqKnowledge requires real-valued data. You are encouraged to 
ensure that your expression results are real-valued. To test if a floating point number x is 
a real-valued number, use the expression: 
 
 NOT(OR(ISINF(x), ISNAN(x))) 

Note for variable sample rate processing:  
The Expression and Waveform Math functions will constrain operations between waves of different rates as 
follows: 
If an equation is operating on two or more waves of different sample rates, the result of the operation will 
always be output at the lowest sampling rate from the waves (Flow). If the destination channel for the result has 
an assigned rate other than (Flow), the operation will not be permitted. If the destination channel is set to a new 
channel, the operation will always be permitted. 
In AcqKnowledge 4 and higher, all sources for Expressions and Waveform Math operations must be sampled at 
the same waveform sampling rate. 
VSR data padding—If the channels are of unequal length (as a result of variable sampling rate or waveform 
editing), they will be padded for Append acquisition. Digital and Analog channels are stored as short integers by 
default; a waveform paste into a digital or analog channel, however, will result in its underlying data being 
converted to floating point. This will generate the “Abort/Replace” warning for pastes to Digital or Analog 
channels since the data format has changed since the last acquisition. 
Additionally, if an Analog or Digital channel is used as the source waveform for a Copy, it will also be converted 
to floating point and will result in the “Abort/Replace” warning being generated. 
Since Calculation channels are already floating point, pasting into them or copying from them will not change 
their data format. The channels will be padded with their last value and the append will commence. 
Waveform Cut operations do not change the underlying data format for Analog, Calculation, or Digital channels. 
If only Waveform Cut is used, no data format conversion will occur and channels will be padded with their last 
value and subsequent appends are allowed. 
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Source Description 

ACQLENGTH 
 

Calculation only Acquisition length from 
Set Up Acquisition; keeps Appended 
segments the same whereas “Sample” 
would increase with each segment. 

CH Value of the designated channel (CHn) at 
the current evaluation step. 

Primary Source 
Channel 
metachannels only 

Appears as PSC in the dialog. Refers to 
the data of the primary source channel of 
a metachannel.  

Time Time (in sec) of current evaluation step 

Sample  Sample index of evaluation step; the first 
sample in the graph will always be 
reported as a value of zero. 

MC Measurements only Value of the channel in 
the measurement menu—either the 
explicit channel or “SC”—at the current 
evaluation step. 

Pi  Value of pi (3.141592654…) to double-
precision accuracy. 

SC  
 

Transformation and measurement only Value 
of the selected channel at the current 
evaluation step; can still back-reference 
samples points. 

True  Evaluates to the value 1 (non-zero values 
are interpreted as True) 

False  Evaluates to the value 0 

Segment Timer Used as a source for the onscreen 
Stopwatch gauge view. 

Random Generates random white noise. 

Gaussian 
Random* 

Generates Gaussian white noise for 
startle responses. Returns a random 
value from a Gaussian distribution. 

*Standard Gaussian model; useful for peak fitting.  
param(0)*EXP(-((TIME-param(1))/param(2))^2 

Operator Operation 

+ Addition 

- Subtraction 

* Multiplication 

/ Division 

^ Power 

( Open parentheses 

) Close parentheses 
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FUNCTION  RESULT 
ABS Returns the absolute value of each data point. 
ACOS Computes the arc cosine of each data point in radians. (All trigonometric functions 

use 'radians' as the unit of angle for input or output as appropriate.) 
AND(x, y, …)  Computes a logical “and” operation for its arguments. Accepts up to eight (8) 

arguments and evaluates to 
1 if all of its arguments are non-zero values. 

 0 if one of its arguments is zero. 
ASIN Calculates the arc sine of each value in radians. (All trigonometric functions use 

'radians' as the unit of angle for input or output as appropriate.) 
ATAN Computes the arc tangent of each sample pointin radians. (All trigonometric 

functions use 'radians' as the unit of angle for input or output as appropriate.) 
CEIL(x) Computes the ceiling function (the closest integer larger than the value x). 
COND(T, A, B, C)  Three-way conditional takes four arguments: 

COND(test_expr, neg_test_value, zero_test_value, pos_test_value) 
Evaluates test_expr and if 

< 0, returns neg_test_value 
= 0, returns zero_test_value 

  >  0, returns pos_test_value 
COS Returns the cosine of each data point in radians. (All trigonometric functions use 

'radians' as the unit of angle for input or output as appropriate.) 
COSH Computes the hyperbolic cosine of each selected value 
EQUAL(x, y, …)  Performs a Logical equal (numerical comparison) of its arguments. Accepts up to 

eight (8) arguments and evaluates to 
1 if all of its arguments are equal. 

 0 if one of its arguments is not equal to the others. 
EXP Takes the ex power of each data point.. 
FLOOR(x) Computes the floor function (the closest integer less than the value x). 

IF(T, A, B)  
 

Two-way conditional takes three arguments: 
IF(test_expr, true_value_expr, false_value_expr) 
The conditional evaluates test_expr and if 

non-zero, returns true_value_expr 
0, returns false_value_expr 

ISINF(x)  Filters out infinities and unrepresentable numbers from data; important because 
such values can cause erratic behavior in autoscaling and other operations. Use to 
test whether any expressions have resulted in floating point overflow and have 
generated numbers too large to be represented in the computer. Evaluates to 

1 if x is inf, the floating point representation of infinity. 
0 if x is NaN or a real-valued floating point number. 

ISNAN(x)  
 

“Is not a number” can be used to test whether any expressions have resulted in 
floating point errors such as division by zero. Use to ensure that the output of 
transformations and equations does not produce numbers that AcqKnowledge 
cannot display. Evaluates to 

1 if x is NaN, the invalid floating point number. 
 0 if x is inf or a real-valued floating point number. 

LESS(x, y)  
 

Performs a numerical comparison of its arguments and evaluates to 
1 if x is less than y. 
0 if x is greater than or equal to y. 
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LOG Computes the natural logarithm of each value 
LOG10 Returns the base 10 logarithm of each value 

 
FUNCTION  RESULT 

MAXIMUM Returns the maximum value of all input arguments. 
MiINIMUM Returns the minimum value of all input arguments. 
NOT(x) Computes a logical negation of its argument. Evaluates to 

1 if x is zero. 
0 if x is non-zero. 

OR(x, y, …)  
 

Evaluates multiple variables; true if any are true. Computes a logical “or” operation 
for its arguments. Accepts up to eight (8) arguments and evaluates to 

1 if any one of its arguments is non-zero. 
 0 if all of its arguments are zero. 

ROUND(x) Returns an integer closest in value to the argument. For example: 
  round (2.4) = 2    round(2.5) = 3    round(-1.5) = -1    round(-1.6) = -2     

SIN Calculates the sine (in radians) of each data point. (All trigonometric functions use 
'radians' as the unit of angle for input or output as appropriate.) 

SINH Computes the hyperbolic sine for each sample point. 
SGN Performs the ‘sgn’ sign extraction function. Evaluates 1 if x > 0, -1 if x <  0, and 0 if 

x = 0. 
SQR Squares each data point. 
SQRT Takes the square root of each data point. 
TAN Computes the tangent of each sample point in radians. (All trigonometric functions 

use 'radians' as the unit of angle for input or output as appropriate.) 
TANH Calculates the hyperbolic tangent of each sample point. 
TRUNC(x) Removes the fractional part of the number and returns an integer. For example: 

  TRUNC(2.4)= 2    TRUNC(2.5)= 2    TRUNC(-1.5)= -1    TRUNC(-1.6)= -1 

Note When used with scientific notation, TRUNC(x) applies only to the fractional 
portion after the exponential factor is taken into account: TRUNC(2.93E+4) = 
TRUNC(29300) = “29300.” Since 2.93e+4 (29,300) has no fractional portion, 
the number is returned unchanged. Similarly, TRUNC(2.931245E+4) = 
TRUNC(29312.45) = “29312.” 

XOR(x, y, …)  Logical exclusive OR; true if an odd number is true. Computes a logical “exclusive 
or” for its arguments (e.g. “one or the other, but not both”). Accepts up to eight (8) 
arguments and evaluates to 

1 if an odd number of its arguments are non-zero. 
0 if an even number of its arguments are non-zero or 

if none of its arguments are non-zero. 
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Delay Calculation 

  

 
Delay setup dialog and resulting graph showing a 20 sample delay 

This option allows you to use a Calculation channel to plot another channel lagged (delayed) by an arbitrary 
interval. To have AcqKnowledge apply a Delay Calculation in real time: 

1. Choose Hardware > Set Up Data Acquisition > Channels. 
2. Click the Calculation tab. 
3. Check an Acquire box for the Calculation channel you want to contain the modified data. You may also 

check the Plot and Values boxes as appropriate for each channel. 
4. Click the Preset pull-down menu and select Delay. 
5. Click the Setup button in the Input Channels dialog to generate the Delay dialog. 

(Off-line Delay is available under Transform > Delay.) 
The delay interval can be specified either in terms of samples or seconds. These types of plots are useful for 
producing non-linear (“chaos”) plots in AcqKnowledge’s X/Y display mode (see page 38 for a description). 
When a delay channel is recorded, there is a segment at the beginning of the Calculation channel (equal to the 
value of the delay) that will read as 0 Volts. This is normal and occurs because the delay channel is waiting to 
“catch up” with the original signal. AcqKnowledge fills this buffer with zeros until the delay channel begins to 
plot actual data. In the example above, the delay channel contains a 0.25-second interval of zeros at the 
beginning of data file.
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Control Calculation 

 
The Control function is used to output a digital pulse when the value for a specified input channel exceeds a 
certain level, falls inside a given range, or falls outside a given range. This feature is unique in that the output is 
on a digital channel (which ranges from I/O 0 through I/O 15) rather than a Calculation channel. Also, unlike 
other Calculation channels, this Control Calculation can only be performed in real time (i.e., while data is being 
acquired) and cannot be performed in post acquisition mode. 
In addition to outputting a signal on a digital channel, the Control Calculation will also plot an analog version of 
the digital signal on the Calculation channel you specify. For instance, in the example below, Calculation 
channel C0 is used to perform a control function using analog channel 1 (A1) as an input and digital channel 0 
(D0) as an output. In addition to outputting a pulse on D0, the setup below will also produce a plot on channel 
40 (the first Calculation channel) that emulates the signal being output on digital channel 0. Since Calculations 
are analog channels, the Calculation channel does not contain a “true” digital signal, but is a reasonably good 
approximation. To retain the physical output generated by a Control channel, the output digital channel should 
be looped back to another digital input channel of the Hardware unit and acquired as well as being connected to 
any external devices. The calculation channel values are not guaranteed to precisely match the actual digital 
output. 
 
To have AcqKnowledge apply a Control Calculation in real time: 

1. Choose Hardware > Set Up Data Acquisition > Channels. 
2. Click the Calculation tab. 
3. Check an Acquire box for the Calculation channel you want to contain the modified data. You may also 

check the Plot and Values boxes as appropriate for each channel. 
4. Click the Preset pull-down menu and select Control. 
5. Click the Setup button in the Input Channels dialog to generate the Control dialog. 

There are four parameters that need to be specified for each Control channel: 
a) Source channel c) Type of threshold function 
b) Output channel d) Threshold level values  

“Source” refers to the input channel to be used for the Control function. As with other Calculation channels, the 
Control function can use either an analog channel or another (lower) Calculation channel as an input. In the 
previous example, analog channel 1 (A1) is used as the input channel. It is not possible to use a digital channel 
as an input channel for a Control Calculation. 
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The channel selected in the Output Channel section determines which digital channel the pulse will be sent to. 
The digital channels range from 0 to 15 (D0 through D15) and external devices can be connected as described 
in the section on UIM100C connections in the Hardware Guide. In the sample dialog shown, the digital pulse is 
sent over I/O line D0. 
Digital channels have two levels, 0 Volts and +5 Volts. When the signal transits from 0 Volts to 5 Volts, an 
“edge” is created and since the signal is going from low to high, this is referred to as a positive edge. Similarly, 
as the signal transits back from 5 Volts to 0, a negative edge is created. These transitions or edges can be used 
to trigger external devices when an analog signal level meets certain threshold criteria. 
The Threshold Function option sets the criteria for the Control channel. You can specify threshold conditions 
such that the digital I/O line goes to +5 Volts when the conditions are met, or you can program the digital line 
to go to 0 Volts when the threshold conditions are met. Threshold conditions can be set so that either (a) the 
digital line is switched when the value of an analog channel exceeds a specified value or (b) the digital line is 
switched when an analog channel falls within a given range. AcqKnowledge also allows you to create a single 
level threshold or a “wide” threshold. 

Tip  To use test conditions more complicated than simple thresholding, combine the conditional tests of 
Expression calculations with the Control channel to change digital output based on the Expression 
result. 

For example, suppose you want to set a Control channel to switch digital line 5 from low to high whenever the 
signal for Calculation channel one (C0) exceeds 85 BPM. Set the source channel to C0 and the output to D5. 
Select the upper right graph in the control dialog and set L2 and L1 to 85, as shown: 

  
Control dialog and graph showing result of BPM control example 

As you can tell from the preceding graph, there are a number of instances where C0 (heart rate) exceeds 85, 
usually for a short period of time. When it does drop below 85, it appears to return to a value greater than 85 
within a second or two. In instances such as this, it might be useful to “widen” the threshold so that the digital 
line is triggered whenever the input value is greater than 85, but the signal must drop significantly below the 
threshold value before the threshold is reset. 
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As another example, the upper threshold value (L2) is set to 85 and the lower threshold (L1) is set to 83, which 
means that the threshold will not reset until the signal from the source channel drops below 83. In the following 
example, the digital line is switched from low to high (from zero to +5 Volts) when the heart rate channel 
exceeds 85, and stays at +5 Volts for several seconds even though the source channel drops below 85 (but 
above 83). The digital line does not switch back to zero until the heart rate channel drops below 83 (toward the 
end of the record). Once this occurs, the threshold is reset and the digital line will switch again the next time the 
source channel exceeds 85 BPM. 

  
Control dialog and graph showing control channel with “wide” threshold 

It is also possible to have the digital line switch when the source channel drops below a certain value. In the 
example below, a simple threshold is used to switch the digital line high each time the source channel drops 
below 50 BPM. Since L2 and L1 are set to the same value, this is not a “wide” threshold (as above) and the 
threshold resets each time the source channel goes above 50 BPM. 

  
Control dialog and graph showing control channel detecting source channel levels less than 50 BPM 

These examples are only a few of the possible applications of the control channel using the two threshold icons 
on the left-hand side of the Control Setup dialog. You can construct variations of these (i.e., switching the 
digital line from low to high using a wide threshold whenever the source channel drops below a given channel) 
that are not discussed above. Moreover, each of the options can be construed somewhat differently than they 
have been presented here. For example, the previous example switches the digital line from low to high each 
time the signal on the source channel drops below 50 BPM. Conversely, it also switches from high to low each 
time the source channel value is greater than 50 BPM. This allows you to vary the default setting for the digital 
channels (whether the default is zero or +5 Volts) depending on what types of devices are connected. 
(For a description of how to connect various digital devices, see the section on UIM100C connections in the MP 
Hardware Guide.) 
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In addition to setting “above and below” type thresholds, you can program the Control channel such that the 
digital line is switched whenever the source channel falls within a given range or outside a specified range. In 
the example that follows, digital line 15 is set to switch from zero to +5 Volts whenever the source channel 
signal falls between the values entered in the L1 and L2 boxes. In this case, I/O is switched to +5 Volts 
whenever the heart rate is greater than 60 BPM but less than 80 BPM.  

  
Control dialog and graph showing control channel switching from 
low to high when source channel is between 60 BPM and 80 BPM 

You can also program the digital line to switch from high to low when the signal on the source channel falls 
within a given range. This is equivalent to setting the digital line to shift from low to high when the source 
channel values fall outside a given range (as shown below). 

  
Control dialog and graph showing control channel switching from 
high to low when source channel is between 60 BPM and 80 BPM 
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Fourier Linear Combiners: FLC, WFLC, CWFLC Calculations 
Fourier Linear Combiners are linear combinations of adaptable sinusoidal functions that are particularly well 
suited to processing cyclic data. Sine and cosine are harmonics that are multiples of a base frequency that are 
summed together, and the order is the fixed number of harmonics used in the model. Step size provides mu, the 
gain factor used to adjust the weights of the harmonics at each processing step. Step sizes must be much less 
than 1 for the system to converge. As step sizes decrease, relaxation time lengthens. The FLC model is adjusted 
based on the source data using least means square (LMS) feedback and the bias compensates for DC offset.  
To have AcqKnowledge apply an FLC Calculation in real time: 

1. Choose Hardware > Set Up Data Acquisition > Channels. 
2. Click the Calculation tab. 
3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 

check the Plot and Values boxes as appropriate for each channel. 
4. Click the Preset pull-down menu and select FLC, WFLC, or CWFLC. 
5. Click the Setup button in the Input Channels dialog to generate the appropriate dialog. 
 For offline calculation, see FLC Transform options, including Scaled FLC, on page 292. 

 
 

 
Basic FLC  
Simple summation of fixed 
numbers of sines and cosines; 
uses harmonics of a fixed 
frequency and adjusts weighting 
coeffiicients of the mixture. 

Weighted-Frequency FLC 
Base frequency of the harmonics 
is variable; adapts the frequency 
in response to the input signal 
using LMS feedback; the 
frequencies are similarly adjusted 
to the amplitudes. 

Coupled WFLC/FLC 
Runs a WFLC on the signal to 
determine the harmonic frequency 
and then runs the result through an 
FLC using the computed harmonic. 

Operates on a single channel at a 
time. 

Operates on a single channel at a 
time. 

The second FLC can be run on the 
same or a different channel. 

Well suited for extracting data of 
a known frequency band from a 
signal with a stable frequency. 
 Use as an adaptive noise filter 

to remove non-periodic and 
semi-periodic noise 
uncorrelated to the base 
harmonic frequency. 

Well suited for modeling periodic 
signals of an unknown and 
potentially varying frequency 
and/or amplitude. 
 No cycle boundaries or 

frequencies need to be pre-
determined. 

Well suited for real-time extraction of 
information from one signal based 
upon the frequencies contained in 
another signal. 
 Use to remove movement noise 

from ECG. 
 Unique configurations can be 

established with two input signals, 
one for frequency and one for 
amplitude. 
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Adaptive Filtering Calculation 

 
 See the Adaptive Filtering transform on 

page 289. 

Adaptive filtering is a signal processing technique that 
processes two different signals in relation to one another 
and can be used for noise estimation, noise reduction, 
general-purpose filtering, and signal separation. Adaptive 
filtering creates efficient high-quality filters with a 
minimal number of terms, which can be very useful in 
blocking mains interferences or other known periodic 
disturbances. 
 Useful for noise filtering where it is possible to 

acquire a signal that is correlated to the noise (similar 
to the way noise-cancelling headphones detect and 
remove outside noise). Applications include removing 
EMG from ECG or EOG from EEG. 

To have AcqKnowledge apply an Adaptive Filtering Calculation in real time: 
1. Choose Hardware > Set Up Data Acquisition > Channels. 
2. Click the Calculation tab. 
3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 

check the Plot and Values boxes as appropriate for each channel. 
4. Click the Preset pull-down menu and select Adaptive Filtering. 
5. Click the Setup button in the Input Channels dialog to generate the Adaptive Filtering dialog. 

The weights within an adaptive filter are modified on a step-by-step basis. AcqKnowledge uses the N-tap FIR 
adaptive filter, with coefficients updated using least means squares (gradient) feedback. 

Order Specify a positive integer for the number of terms to be used in the internal FIR filter. 
Step size Provides mu, the rate of adaptation of the coefficients within the FIR filter. 
Source channel The source channel will be replaced by the adaptive filter results. 
Noise channel The noise channel is the signal that is correlated with the noise to be eliminated from 

the Source; it is not modified by adaptive filtering. 
Source and Noise channels must have the same channel sampling rate (under Channel Set Up). 
 
Comb Band Stop Filter Calculation 
To have AcqKnowledge apply a Control Calculation in real time: 

1. Choose Hardware > Set Up Data Acquisition > Channels. 
2. Click the Calculation tab. 
3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 

check the Plot and Values boxes as appropriate for each channel. 
4. Click the Preset pull-down menu and select Comb Band Stop. 
5. Click the Setup button in the Input Channels dialog to generate the Comb Band Stop dialog. 

See page 139 for details. 
(Off-line Comb Band Stop filter is available under Transform > Digital Filters > Comb Band Stop. See page 
289.) 
 
Metachannel  
See Metchannel details on page 123. 
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Rescale Calculation 

 
Rescale applies two-point linear mapping and allows users to change the measurement units (for example, to 
change temperature from Celsius to Fahrenheit). The text corresponding to the new units can be manually 
entered. 
To have AcqKnowledge apply a Rescale Calculation in real time: 

1. Choose Hardware > Set Up Data Acquisition > Channels. 
2. Click the Calculation tab. 
3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 

check the Plot and Values boxes as appropriate for each channel. 
4. Click the Preset pull-down menu and select Rescale. 
5. Click the Setup button in the Input Channels dialog to generate the Rescale dialog. 

(Off-line Rescale is available under Transform > Rescale.) 

• Use the Rescale transformation (after acquisition) to adjust forgotten calibration of analog channels or 
reverse incorrect calibrations.  

• A "Rescale" Automator action has been added to allow rescaling to be performed in workflows. The 
Automator function is accessed from the Workflow menu in the Mac version of AcqKnowledge. (Not 
applicable to Windows.) 

The rescale formula is: 

 
 
Rescale Source Displays the label and number of the selected channel.  
Old Units Displays the values of the current vertical units of the channel 
New Units Allows for manual entry of the new units to be used. The new units will be displayed in the 

vertical units of the channel 
Note  Transform > Rescale: The units cannot be modified when transforming from the 

selected area because it is not possible to display different vertical units for 
different time ranges in the same channel. 
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Slew Rate Limiter 

 
Slew Rate Limiter is an effective tool for signal separating, denoising and removing motion artifact during and 
after recording. The algorithm restricts the rate of change of a signal to a specific time window or sample width 
window. The allowable amount of motion artifact over a given time/sample window can be precisely adjusted 
from a minimum allowable change to a maximum allowable change, thereby eliminating artifacts that exceed 
the selected amplitude range within a given time period.  
The slew rate limiter algorithm restricts the rate of change of a signal to a specific window. If two different 
types of signals with significantly differing rates of change are mixed together, limiting the allowable rate of 
change of the mixed signal allows for signal separation by reducing the impact of a fast moving signal on a 
slow one (and vice versa). The slew rate limiter formula is: 
Assume a mixed signal y. Define a time window width w. Define the minimum allowable change in amplitude 
over the time window w as and a maximum allowable change in amplitude as K max≥ 0 where K maxKmin . 
The slew rate limiter function is then defined as: 

 
where sgn is the standard mathematical sign function and is used to preserve the relative direction of the change 
in the signal and random is a pseudorandom non-zero number used to avoid the singularity where sgn is zero, 
enforcing that the rate of change will not drop below K min  . 
The slew rate limiter may be applied in real time as an online calculation channel, or in post-processing via the 
Transform menu (see page 311). As with all online and offline transformations, signal type settings can be saved 
as custom presets by clicking the “New…” button and naming the new preset. 
To have AcqKnowledge apply the Slew Rate Limiter in real time:  

1. Choose Hardware > Set Up Data Acquisition > Channels. 
2. Click the Calculation tab. 
3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 

check the Plot and Values boxes as appropriate for each channel. 
4. Click the Preset pull down menu and select Slew Rate Limiter. 
5. Click the Setup button in the Input Channels dialog to generate the Slew Rate Limiter setup dialog. 
6. Set the desired time window to apply the slew rate limiter algorithm based on seconds or samples. 
7. Set the minimum and maximum allowed change to adjust the sensitivity to motion artifact. 
8. Click OK and run the acquisition. Any artifact that falls outside the boundaries of the 

maximum/minimum allowed change setting will be eliminated from the recorded data. 
 Watch the AcqKnowledge Slew Rate Limiter video tutorial for a detailed demonstration of this feature. 

http://www.biopac.com/video/?video_category=acqknowledge-tutorials&v=slew-rate-limiter-in-acqknowledge�
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Filter - FIR 
In AcqKnowledge 4.4 and higher, FIR Filters are available as an online calculation channel. Until recently, real-
time FIR filtering during acquisition wasn’t feasible due to processing power limitations, but these constraints 
are no longer an issue for modern dual-core and quad-core processors. 
Online FIR filters are similar to their offline transformation menu counterparts with the exception of the 
following convention. 
Delay at current settings: For FIR filtering in general, a delay is imposed on the output signal, and this 
parameter shows the number of delay samples the current settings will introduce. If the number of coefficients 
is fixed, the delay value will equal the number in the “Fixed” editable field. If the number of coefficients is set 
to be optimized for sample rate and cutoff, the delay value will vary. The filter algorithm compensates for this 
delay in order to assure proper alignment of filter output with the acquired signal. 
When modifying the fixed number of coefficients or the frequency, the delay value is updated accordingly. 
However, it should be noted that a close comparison between online and offline FIR filters will reveal that they 
are not perfectly in phase, but out of phase by half of the imposed FIR calculation channel delay. 
As in other AcqKnowledge calculation channel presets, any modified Filter – FIR setup can be saved as a 
custom preset by selecting “New Preset.” 
To have AcqKnowledge apply the Filter – FIR in real time: 

1. Choose Hardware > Set Up Data Acquisition > Channels. 
2. Click the Calculation tab. 
3. Check the Acquire, Plot, and Values box for the Calculation channel to contain the filtered data. 
4. Click the Preset pull down menu and select Filter – FIR. 
5. Click the Setup button to generate the Filter – FIR settings dialog. 
6. After starting acquisition, real time FIR filtering will appear in a dedicated calculation channel for the 

duration of the recording. 
 
For specific details on the various FIR filter types, windowing, and recommended settings, see the offline Filter 
– FIR Transform option on page 286. 
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Chapter 7   Data Acquisition 

 
Data Acquisition—The Basics 
Once you have selected channels to be acquired (see Chapter 5 Channel Setup on page 109), the next step is 
to set up the acquisition parameters. These options control the data collection rate, where data will be stored 
during an acquisition, and the duration of each acquisition. Choose Hardware > Set Up Data Acquisition > 
Length/Rate to generate the following options. 
Storage Mode 
At the top of the dialog are three popup menus that allow you to control a number of aspects for storing the data 
from each acquisition. 
Record/Record last allows you to control whether the software saves all the data or only the most recent 
segment of the data. 
 Record—the hardware will store data for the amount of time that is specified in the acquisition length 

box. This is the default and is appropriate for almost all types of acquisitions.  
 Record last—only available when acquisitions are set to “Save Once” using “Memory”—the hardware 

will acquire data continuously, but will only store the most recent segment of data equivalent to the 
duration in the acquisition length dialog. That is, if the value in the acquisition length box is 30 seconds 
and record last is selected, the hardware will acquire data ad infinitum, but will only store the most recent 
30 seconds of the data.  

Save once/Autosave file/Append sets how the data is saved to a file. Append mode is the default setting.. 
 Save once—AcqKnowledge will begin an acquisition when the mouse is clicked on the start button, and 

will stop either when the acquisition length has been reached or when the stop button is clicked with the 
mouse. 

 Autosave file —allows you to perform several acquisitions one after another, and save the data from each 
acquisition in a separate file. When the Autosave option is selected, a File button will appear to the left of 
the sample rate dialog. Click File to generate a standard Save dialog to enter the root file name for the 
data from each acquisition. After you click Save in this dialog, another dialog is generated with options to 
append an incrementing number, time (system clock), or date (system clock) to the filename: Media 
functionality does not support the Autosave file acquisition mode.  

 Append —similar to ‘Save Once’, except that Append allows you stop and restart acquisitions at 
arbitrary intervals. Append mode is unique in that clicking on the Stop button only pauses the acquisition, 
which can then be restarted by clicking on the Start button. 
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In Append mode, each time an acquisition is 
restarted, an append event is inserted into the 
recording. Append events can be configured 
to include user-defined labels and time/date 
stamps via the Segment Labels setup (see 
page 238). Although you can pause for any 
period of time, the Hardware will only 
acquire data for the amount of time indicated 
in the Acquisition Length box. Data can be 
acquired in Append mode while being saved 
to memory, disk, or the MP hardware unit 
(but not in Averaging mode).  

Sample data Acquired in “Append” mode. 
Events indicate where Acquisition was paused. 

Appended segments can be stored to disk, memory, or MP150. (MP36R, BioHarness, Mobita, or B-Alert 
does not support data storage to the hardware unit.) 
 Append to Disk: In this mode, it is usually best to record all channels at the same rate. If the user 

stops the acquisition, the length will be the same for all channels—so the next segment of appended 
data will neatly link onto the end of the existing record.  
 Any existing AcqKnowledge 4 can be appended. Change the acquisition mode to Append; any of 

the storage options are applicable 
 Append to disk requires AcqKnowledge 4 format files. If you open any other file format, you will 

be prompted to translate the file. 
 Append to Memory: In this mode, data is appended to the “uneven” waves in the same manner as 

described for Append to Disk. When channels are sampled at different rates, this mode will respond 
faster than Append to Disk because the data files are already in memory so the software does not have 
to rewrite all the data files in the graph.  

 A Reset button is generated in the Set Up Acquisition dialog when Append is selected. Click 
the Reset button to erase the acquired data file and start a fresh acquisition file (this is 
essentially the same as saying yes to an “Overwrite existing data?” prompt).  
The Rewind button to the right of the Start/Stop button will delete the last recorded segment. 
Ctrl-Rewind (Windows) or Option-Rewind (Mac OS X) will delete all recorded segments 
(similar to the Reset button). 

Append plus external trigger 
Appended segments can be started with an external or internal trigger. The experiment can be 
tailored to start at points of interest by applying a trigger. See Triggering details on page 173. 

Append plus Variable Sampling Rates 
If the mode is started and stopped manually, it is statistically possible that, prior to the next pass 
of the Append, extra data points may be inserted in various data channels to “line up” the data 
(see sample on page 113). These extra data points simply replicate the last sample in any 
affected channel. To minimize the impact of the extra data points, make sure the lowest 
sampling rate is on the order of 10 Hz or higher, or don’t use VSR. 
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Disk/Memory/MP/Averaging determines where to store data during an acquisition. Once data has been 
acquired and is stored in a file, it is stored on a hard disk or other similar device. There are a number of options 
for storing data during an acquisition. The best choice as to where data should be stored during an acquisition 
depends in large part on the nature of the acquisition itself, and the type of computer being used. 
 Memory stores data in computer memory during an acquisition. After the acquisition is finished you will 

have to select Save As... from the File menu to permanently save this to your computer’s hard disk. This 
usually allows for faster acquisition rates, although most computers have less available RAM than disk 
space. 

 Disk saves data directly to the computer’s hard disk during an acquisition. Disk mode is fast enough (in 
terms of maximum sampling rate) for many applications, especially when only a few channels are being 
acquired. Saving data to Disk also allows for longer acquisitions. A final advantage of saving data directly 
to Disk is that if there is a system failure (including power outage), all the data collected up to that point is 
saved on disk and can normally be recovered, whereas the data is deleted if it is being saved to computer 
memory.  

IMPORTANT—When saving files to Disk, always be sure to save your files under a different name 
BEFORE you start each acquisition. Otherwise, any previous data in that file will be overwritten.  
In Memory mode, simply save the file after the acquisition. 

 MP150 stores a small amount of data on the hardware itself. The MP150 is limited only by internal 
memory, with storage estimated at 4 MB and 400 kHz aggregate sampling rate. 
Obviously, data cannot be sampled this fast for a very long period of time if it is to be stored in the 
hardware. Also, as more and more channels are acquired, the duration of acquisition to the hardware unit 
will shorten. Data stored to the hardware is not plotted on the screen as it is being acquired, but will 
automatically be plotted on the screen as soon as the acquisition is terminated. 

 Averaging is used exclusively for acquisitions involving repeated trials; see page 162. 
Acquisition Sample Rate 
The value in the box labeled “Sample rate” indicates how many samples the hardware should take per channel 
during each second of data acquisition. The sample rate can be changed by clicking on the pull-down menu. 
Individual channels can be down-sampled (variable sample rates), on the channel pane of the Data Acquisition 
Settings dialog. The down-sampled or channel sample rates are limited to specific power of 2 less than the 
acquisition sample rate; for example, If the acquisition sample rate is 100 samples/seconds, then the available 
channel samples rate are 100, 50, 25, 12.5, etc. 
Depending on the nature of the data being acquired, the “best” choice in terms of sampling rate will vary. 
Technically speaking, the minimum sampling rate should be at least twice the highest frequency component of 
interest. This means that if the phenomenon you are interested in observing has frequency components (which 
are of interest) of 100 Hz, you should sample at least 200 times per second. Fourier analysis (FFT) can be used 
to determine what frequency components are present in the data (see page 318 for a more detailed description of 
the FFT function). 

TIP: A good rule of thumb is to set the sampling rate to at least three to four times the highest 
frequency component of interest. 

In less technical terms, lower sampling rates can be used for data with slowly changing values (e.g. respiration, 
EDA, GSR), whereas higher sampling rates should be set for data where values change markedly in magnitude 
or direction (e.g. ECG, EEG, evoked response). 
The maximum allowable sampling rate will automatically adjust itself according to the storage mode, how 
many channels are being acquired in the channel setup window and the type of computer being used.  
If data is being stored to disk or computer memory (RAM) during an acquisition set to a sample rate that is too 
high, the acquisition will begin normally, but AcqKnowledge will stop the acquisition and display a message 
indicating that the acquisition buffer has overflowed. The data up to this point has been saved, and acquisition 
or channel settings should be adjusted; lower sampling rate; shorter length or fewer channels 
The sample ECG waveforms below illustrate the effect of different sampling rates on quality of data. Each 
black dot corresponds to a sample point. 
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 Top waveform: data is sampled relatively slowly; difficult to make out the shape of the waveform. 
 Bottom waveform: sampled at a relatively high rate; increased resolution of the waveform. Waveform 

components that were obscured at slow sampling rates are now well defined, and measurements taken on 
this waveform would be able to better establish the maximum amplitude, time between different ECG 
complexes, etc. 

 

 
Representation of ECG waveform sampled 
with relatively few samples per second 
“True” ECG wave is superimposed over dots 
that indicate sample points. 
 

 

 
 
Representation of same ECG waveform 
sampled at a relatively higher sampling rate. 
 

As shown, under-sampling completely misses the QRS complex of this waveform, although it might detect 
components of the QRS in subsequent beats. Although this is an extreme example of how under-sampling can 
affect digitally processed data, it is important to note that the rate at which data is sampled has important 
implications for the interpretation and analysis of data. 
Acquisition length 
To set the duration of an acquisition, enter a number in the acquisition length box. By default, 3600 seconds of 
data will be recorded. Select the length units from the popup menu to the right of the length box. The units are 
milliseconds, seconds, minutes, hours, or samples. Changing this option will not change the length of the 
acquisition, only the units used to describe it. Thus you can describe the same acquisition as lasting 30 seconds, 
or 0.5 minutes, or 30,000 milliseconds. Scaling the duration of an acquisition in terms of samples is essentially 
the same as the time scaling options, except the length of the acquisition will be expressed in the total number 
of samples to be collected on one channel. 
Regardless of what units you use to determine the length of acquisition, AcqKnowledge will end an acquisition 
when the value in the total length box is reached. The acquisition can be halted at any time by clicking the 
“Stop” button. 
Multiple Hardware 
AcqKnowledge can be used with multiple data acquisition units to: 
 Control multiple, independent experiments on one computer 
 Increase the total number of channels used for a single experiment (e.g., 32-channel EEG) 

To synchronize the Start of multiple units, use the External Trigger function. 
To combine nearly unlimited channels of data into one file, use the Merge Graphs feature (see page 276). 
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Each graph window can 
support a different Hardware 
unit. To open a graph for a 
separate hardware unit, select 
File > New > Graph. 

 
To show/hide the “Connect to:” information, go to Display > Show > and toggle the “Hardware” option, or 

select this item from the “Show/Hide” popup menu .  
 
To switch the hardware unit 
associated with a graph 
window, click the “Connect 
to” box and select an available 
unit or choose Add New 
Device. Different hardware 
types may be added and 
consolidated in the list by 
selecting ‘Add New Device.’ 
The ‘Choose MP150’ dialog 
shows the MP150 units 
residing on a local network. 
(Network functionality is 
limited to MP150 hardware 
only.) 
Click the Help… button to 
open a troubleshooting guide 
for communication problems. 

 
NOTE: When switching to a BioHarness BT device from another hardware 
type, a new graph must be launched in order for the BioHarness settings to 
take effect. (File > New > Graph Window) 

 
 

Averaging (MP150 Hardware only) 
Overview 
In some instances, the signal of interest does not stand out against the background or ambient noise (the level of 
ambient noise exceeds the signal produced by the object of interest), and the only way to detect the signal of 
interest is to perform repeated trials as part of one acquisition, and average the trials together. Since the “noise” 
associated with the signal is assumed to be random, and the “signal” is assumed to be systematic, the noise 
should approach zero as the individual trials are averaged together.  
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Signal (top) measured in the presence of noise 
(middle), which results in the bottom waveform 
when measured in standard Acquisition mode 

 
Same signal averaged in the presence of noise 

over 2,000 trials to produce the lower waveform. 
 

Typically, any averaging acquisition consists of three general components: 
(a) the stimulus signal 
(b) the duration of the acquired data, and 
(c) a small amount of processing time (or overhead) that takes place between acquisitions. 

The duration of the stimulus signal and the duration of data to be acquired can be set by the user. The amount of 
overhead required is a function of the acquisition length, the sampling rate, and the number of channels being 
averaged. 

Acquisition length

Stimulus signal

Overhead

Latency
 

Stimulus signal usually some sort of pure tone or pulse; occurs at the beginning or during 
each trial. 

Acquisition length refers to the amount of data to be acquired during each trial. 
Overhead refers to a period of time after data has been acquired that is needed to 

perform the mathematical averaging. 
Latency refers to the total time elapsed between the start of one trial and the start of 

the subsequent trial. 

Important usage notes 
 The maximum length of a single averaging pass is restricted to 2 seconds; if longer averaging passes 

are required, use regular data acquisition and use the Ensemble Average offline analysis option to 
generate averages in post-processing. 

 The preferred hardware setup for on-line averaging mode is direct connection to the MP150 via 
cross-over cable. To improve stability, avoid interruptions during acquisition: 

• Do not access top-level menus (File, Edit, Transform, etc.) or generate popup dialogs (Setup…). 
• Avoid running other programs—helps ensure that required system resources (processor time, 

memory, and network throughput) remain available. 
• If the MP150 is connected over a network, avoid running applications that consume network traffic 

(Internet Explorer, mail client, media player)—these may interrupt/delay communication to the MP150.  
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Averaging Setup 
For Advanced Averaging, see page 165 
To set up Averaging: 

1. Choose MP150 > Set Up Data 
Acquisition > Length/Rate and select 
“using Averaging” option. 

2. Click the Setup button to generate 
the Averaging options dialog. 

3. Set the Averaging options as detailed 
below. 

4. Click OK to close out of the dialog. 
5. Set the Stimulus (see page 176). 
6. Use the buttons in the graph window 

to Start or Stop the averaging 
acquisition. 

Online averaging progress bar 
An online status bar is added to graph 
windows in AcqKnowledge 4 when online 
averaging acquisitions are in progress. The 
status bar displays the number of averaging 
passes that have been completed and the 
number of passes that have been rejected by 
the MP150 firmware. This is similar to the 
text displayed in the status area of Windows 
AcqKnowledge 3.9.1 and earlier. 

 
 

Averaging Options 
Averages  
Select the number of trials to perform from the pull-down menu, to a maximum of 10,000. 
Latency 
Latency is the total time from the start of one trial/average to the next; it includes the time for stimulus signal, 
acquisition and overhead. As general rule, set latency to three times acquisition length plus any experimental 
delays, for example allowing the subject's signal to return to the baseline. The default setting for latency is 100 
msec. 
If the latency is set to a value too short to allow for averaging to take place, an Acquisition Warning will be 
generated:  

 

 Adj Latency: automatically adjust the latency 
to the shortest possible value that still allows 
for data to be acquired and processed. 

 Adj Length: reduce the amount of data 
acquired without changing the latency. 

 Abort: return to the graph window without any 
data being collected. 
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External trigger 
To initiate a trial from an External Trigger signal enable the Ext Trigger in the Averaging options dialog as well 
as the Positive or Negative Edge. The trigger can be set up in the Trigger pane of the Data Acquisition Setting 
dialog. See page 173. 
 
Artifact rejection 
Occasionally during an acquisition, extreme levels of unwanted signal artifact may be present. Checking artifact 
rejection allows you to determine what signal levels constitute artifact, and have the MP System reject these 
trials. When artifact rejection is enabled, the MP System will ignore any trials that contain signals exceeding the 
artifact rejection thresholds, keep track of how many trials have been rejected, and add that number of trials to 
the total number of trials to be acquired. This allows a user to “re-try” a trial that was rejected due to the 
presence of artifact. 
To set these parameters, you need to set a high threshold and a low threshold. Both thresholds refer to the scale 
limits (normally ±10 Volts). If the high and low artifact rejection thresholds are set to 80% and 30% 
(respectively), the MP System will reject any trial where the signal exceeds +8 Volts or –3 Volts. 
When the channel scaling feature is used to change the range of Map (Scale) values to something other than ±10 
Volts, the artifact rejection formula for symmetrical limits is: y = ((2·PV)/100)·x – PV 

where y = voltage threshold 
 PV = Peak Value 
 x = percent threshold (whole number) 

If non-symmetrical limits are used, the following equation is used: y = ((V1-V2)/100)·x + V2 
where y = voltage threshold 
 V1 = Higher Peak Value 
 V2 = Lower Peak Value 
 x = percent threshold (whole number) 

Enable Channels 

To add analog channels to the average, check 
additional channels in the Enable list. 
 Channels must be set to “Acquire” under 

Hardware > Set Up Data Acqusition > 
Channels to be selectable here; otherwise the 
channel box will be grayed out. 

  
 

 

Stimulus Signal 
Although AcqKnowledge does not require a stimulus signal to be output for Averaging trials, most applications 
that use signal averaging make use of a stimulus signal. Digital stimuli (i.e., clicks) or analog stimuli (i.e., tones, 
pulses, and arbitrary waveforms) may be output.  
In almost all cases, the most convenient way to output a stimulus signal is to output a predefined wave on 
analog output channel A0 and/or A1. You can create pulse waveforms, tone waveforms, ramp waveforms, and 
arbitrarily shaped analog waveforms. Use MP150 menu > Stimulator Setup to set all of the stimulus output 
functions (see page 176). 
When you start Averaging, the Start button turns to Averaging status and the green dot turns to “A” to indicate 
that Averaging is in process. 
Advanced Averaging—P300 
Advanced averaging can be used to set up P300 protocols. A sample P300 setup is included in the Samples 
folder. 
To set up Advanced Averaging: 
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1. Open two or more graph files. 
2. Use Set up Acquisition to set each graph file for Averaging (see page 162). 
3. Click the Averaging Setup button and set Averaging Options as desired for each graph file. 

 Advanced Averaging will use the defaults if you choose not to set Averaging Options for 
Latency, Artifact Rejection, or Enabled channels.  

4. Use Setup Stimulator to establish the desired stimulus output for each graph file (see page 176). 
 Set the Output channel to the same channel (A1 or A0) for all graph files. 
 Set the Stimulator Output to During Averaging Pass (recommended). 

5. Save each graph file with an appropriate name. 
6. Choose MP150 > Set Up Advanced Averaging. 

 

This menu option is only enabled if two or more open 
graphs are set to Averaging.  
 

7. Set the Advanced Averaging options: 

 

a. Averages: Select the number of averages from the 
pull-down menu (max 10,000). 

b. Graph: Assign a Graph from the pull-down menu of 
open graph files. Up to eight graph files can be used in 
Advanced Averaging. 

c. Trial distribution: Use the slider to assign a percentage 
for each graph; the total will adjust to 100%  
Note The software counts 0 as 1, so the percentage of 

the active graph should be entered as one less 
than the desired output (for 50% enter 49%). 

8. Click the Start button in the Advanced Averaging setup dialog to begin acquisition. 
9. Review the status in the “Completed” bar that is activated when Start is pressed and/or in the status 

display at the bottom of the AcqKnowledge software window. 

 
 

10. Save each graph file. 
11. Make sure that the Graph names are correct in the Advanced Averaging setup dialog, and click 

“Yes”save the setup as an Averaging file. 
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Repeating 
Use the Repeat mode to acquire data from repeated trials using the same parameters for each trial. Checking the 
Repeat every box at the bottom of the acquisition setup dialog enables two additional popup menus at the 
bottom of the dialog. These allow for control of how many times an acquisition will repeat as well as the 
interval between trials. When this is unchecked, the acquisitions will repeat as soon as possible (usually 
instantaneously, but slightly longer if data must be saved to a file between trials). 

 
Interval The entry to the right of the “Repeat every” checkbox tells AcqKnowledge how long to pause 

between the start of one acquisition and the beginning of the next acquisition. This can be scaled in 
terms of seconds, minutes, or hours using the first popup menu. 

 It is important to note that this value measures the interval between the start of two adjacent trials, 
rather than the interval between the end of one trial and the start of the subsequent trial. If the repeat 
interval is set for 15 minutes and the acquisition length is set to 60 seconds, then there will be a 14-
minute pause between the end of the one trial and the beginning of the next. 

Trials Set how many trials to acquire: 
for perform a finite number of trials; enter the number of trials to acquire in the “times” field. 
forever perform an infinite number of trials. Trials will be repeated at the specified interval until 

the acquisition is stopped either by clicking on the stop button in the graph window or if 
there is not enough free memory on the target storage device. 

Regardless of which options are checked, data for each trial is acquired according to the acquisition parameters 
specified in the dialog. In the above example, each trial of data will be sampled at 50 Hz and will last 1 minute; 
the trials will be repeated every 15 minutes for a total of 8 trials. 
Selecting the option to Record and Save Once to Disk/Memory will overwrite the previous collected data. 
However a warning will appear unless the “Warn on Overwrite” option is disabled. Another option is to select  
Autosave file from the Save once/Autosave file/Append option. When the repeating option is checked and 
Autosave is selected, AcqKnowledge will save the data from each trial using the file name and extension 
indicated by the autosave feature. See page 158 for a more detailed description of Autosave. 
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Setup Channel Options 

Channel The Channel column contains the alpha-numeric channel numbers. “Analog” (or 
continuous) input channels begin with “CH” and run from CH1-CH4 for MP36R and 
A1-A16 for MP150. “Digital” input channels begin with “D” and run from D1-D8. 
“Calculation” channels begin with “C” and run from C0-C15. 

Use the scroll button  to set up additional Digital or Calculation channels. 

Acquire When the Acquire Data box is checked for a given channel, data will be collected on 
that channel. 

Plot If Plot on Screen is also checked, data will be plotted on screen in real-time during the 
acquisition. If the plot box is unchecked, data will still be recorded for that channel, but 
the waveform display will be disabled. To display the waveform plot during or after 
acquisition, show the channel. (Alt+click the channel box above the graph.) 

Valua Checking the Value box means that you can choose to display (numerically and/or 
graphically) the values for each channel in real time. To display the values, you must 
also select Show Input Values (via the Hardware menu). Input values are displayed in a 
separate window from the main graph window. 

Default For MP36R, the default is to collect one channel of data on analog channel 1 (CH1), and 
to plot and enable value display for this channel. For MP150, a channel must be enabled 
by choosing “acquire” prior to recording, if “View by Channels” mode is used. 

TIP Usually, you will want to check all three boxes for each channel you acquire data on. 

Label The Label entry for each channel allows you to type in up to 49 characters to identify the 
channel. 

Presets 

 

Clicking on the Presets button will generate a menu of available presets for the channel. 
Presets for common applications configure the hardware gain, filters, etc. 

 For a detailed summary of Analog Input channel, Digital Input channel, and 
Calculation channel options see the Presets section beginning on page 122. 

Setup 

 

To Change Parameters for a Preset, click the Setup… button. If you change the 
parameters, you have the option of creating a New Channel Preset to make the 
established parameters available to other channels. 

If you make a change to a preset and start recording in the Append mode, you will be prompted as follows. 
Choose Abort, save your data, and then change the presets to acquire as a new data file. 
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Starting an acquisition 
After setting up the channels and defining the acquisition parameters, you are ready to start the acquisition. If a 
file window is not already open, choose File > New to generate a graph window. 

In the lower corner of the screen, next to the  button, you should see a button with a circle to the left 
of it. The circle indicates the status of the communication link between your computer and the hardware. If the 
unit is properly connected to the computer and is turned on, the circle should be solid and green. If the unit is 
not properly connected, a solid gray circle will appear.  

Start the acquisition by clicking the  button or by selecting “Ctrl + Spacebar.” If there are no input 
devices (e.g., electrodes or transducers) connected to the hardware, it will collect a small value of random signal 
“noise” with a mean of about 0.0 Volts. 

 For information on how to connect measurement devices to the MP36R, see the BSL Hardware Guide. 
 You may also start an acquisition using a variety of “triggers,” which are discussed on page 173. 

Once acquisition starts, the  button in the acquisition window changes to . The two 
opposing arrows to the right of the button indicate that data is being collected. Also, the “Busy” status indicator 
light on the front of the MP150/MP36R will illuminate, showing that data is being collected. 

Stopping an Acquisition 

To stop an acquisition at any time, click the  button in the lower right corner of the screen or select 
“Ctrl + Spacebar.” An acquisition will stop automatically when it has recorded an amount of data equal to the 
Acquisition Length entry. 

Rewind 

 The Rewind button to the right of the Start/Stop button allows you to erase the last recorded data segment 
and continue to append data to the existing data file. This function will erase the last segment along with the 
Append Event  for that segment; the application will keep track of Append Event labels, so that the label 
always matches the segment number. 

 
If the “Warn on Overwrite” option is active, a warning dialog will be generated before the segment is deleted.  

Saving acquisition data 
To save a data file, pull-down the File menu and choose the Save command. 
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Timers (Stop watches and Elapsed timers) 
The Timers function allows for easy visualization and measurement of elapsed time within the AcqKnowledge 
user interface, and consists of a simple toolbar display. Timers can be helpful when actions need to be 
performed at specific intervals prior to and during an experiment. The Timers function provides an easy-to-read 
digital display in the toolbar region, and supports the creation of multiple timers, which can be added or 
removed as needed.  

Timer Types 
There are two main types of timers, acquisition controlled (“elapsed” timers”) and independent timers (“stop 
watches”). Manual “stop watch” timers can be used at any point for tracking time independently of acquisition, 
while elapsed timers are tied to a recording in progress and unavailable unless an acquisition is running.  
Independent Timers (Stop watches) 
Independent timers are manually started and stopped, and have a countdown feature with an audible alarm and 
flasher. Multiple timers can be added to the toolbar region, and can be started and stopped independently. Pause 
mode is not supported. Although the timer can be stopped at any time, restarting it resets the timer back to 
0:00:00. 
Elapsed Timers (Acquisition controlled) 
Elapsed timers start when the acquisition “Start” button is clicked and continue counting for the set duration of 
the recording, or until the acquisition “Stop” button is clicked. When acquiring in Append mode, the elapsed 
timer is reset at the beginning of each new segment. Any trigger or delay time applied between segments is not 
included in the elapsed time. Multiple elapsed timers can be added to the toolbar region. This mode does not 
support the countdown or alarm feature. 
To set up a timer: 

1. Display > Show > Timers or click the Show/Hide toolbar button  and choose “Timers,” 
2. The timer toolbar will appear as shown below: 

 
3. The elapsed timer option is enabled by default. If only a single elapsed timer (acquisition 

controlled) is desired, simply start the acquisition and the timer will start automatically. 
4. If an independent timer (stop watch) is desired, right click on the numbers portion of the timer 

toolbar and choose “Settings.” In the Timer Settings, choose “Independent start” and click OK.  
To start/stop independent timers: Click on the toolbar number display to toggle start/stop, or  right click on 
the toolbar number display and choose “Start timer” or “Stop timer” (see figure below). 
To set up multiple timers: 

Click the Timers toolbar icon and choose the desired timer type. Repeated clicking on a timer 
option will create additional timers of that type, which will appear in the timer toolbar region. 

  
To set an alarm: 

1. Click the Timers toolbar icon and choose “Create alarm.” 
2. Right click on the numbers display portion of the new alarm 

and choose “Settings.” 
3. Set the desired time in the “Countdown timer” field. 
4. Check “Sound alarm” and “Blink upon alarm.” 

NOTE: These settings will remain the default for subsequent alarms until the settings are changed. 
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Overview of Timer Settings 

 
 

CONTROL DESCRIPTION 
Timer name: 
 

Field for assigning name to timer. 

Start timer with acquisition: Timer will start and stop with data recording only. 
Independent start Timer is started and stopped manually, independent of acquisition 

status. 
Countdown timer Sets the countdown time duration. 
Sound alarm Selects the audible alarm option and specifies the number of times 

the alarm will sound. 
Blink upon alarm Enables the timer numbers to flash on and off when the countdown 

is complete. 
Display > Font family: > Font size > 
change color 

Selects timer font style, size and color. 

Include fractional seconds Sets option to display 1/100ths of a second in timer display. 
All parameters established in the Timer Settings are retained in saved graphs and graph templates. 

Electrode Checker 

 
The Electrode Checker, in conjunction with the MP36R unit, measures how well electrodes are making 
contact with the surface of the skin. To use this feature: 

1) Attach the electrodes as you normally would. 
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2) Connect the electrodes to an electrode lead set (such as the SS2LB). 

3) Instead of connecting the electrodes to one of the four analog inputs, connect the Simple Sensor end 
of the electrode lead to the Electrode Check port on the front of the MP36R acquisition unit. 

4) Click the MP36 menu and scroll down to select Electrode Checker . 

This will generate a small “thermometer-like” display. At the bottom of the display you should see a number 
with kΩ (Kohms) symbol after it. This value describes the impedance of the electrode/skin contact, with lower 
numbers being associated with better conductivity. The better the conductivity, the “cleaner” the signal 
displayed on the screen. If the MP36R is off or no nothing is connected to the “Electrode Checker” on the 
MP36R unit, the Electrode Checker display will say “OFF.” 

   
Poor contact Good contact  Off 

TIP While there are few absolutes as to what constitutes “good” contact, one rule of thumb is that this 
number should be below 10 kΩ, and the lower the better. 

TIP To decrease the impedance of an electrode connection, you may want to “abrade” the surface of the 
skin with an abrasive pad (such as ELPAD). This removes a thin layer of dead skin cells and 
should result in a signal that has relatively little noise. 
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Chapter 8 Set Up Triggering 
 
During a normal acquisition, the hardware will begin collecting data as soon as the Start button is clicked. It is 
also possible to begin an acquisition in a delayed fashion using a trigger. Using this feature enables an 
acquisition to start “on cue” from a variety of different trigger sources. All trigger options are configured in the 
Set Up Triggering dialog, which is accessed via MP menu> Set Up Data Acquisition > Trigger. By default, 
the trigger is Off. Other options can be selected from the popup menu in the Trigger Setup dialog. To begin an 
acquisition with a trigger, first choose the trigger options most appropriate for the experiment and then click the 
Start button. After the Start button has been pressed, data will be acquired as soon as the trigger is activated. 
There are two general types of trigger sources: digital channels and analog channels. 
Digital Triggers (MP150 only) 

Digital channels are channels that contain binary 
(either/or) data as typified by a switch being either open or 
closed. This type of data can be acquired from a push-
button switch or other device that produces an on/off 
pulse. For instance, it is sometimes useful to have an 
acquisition begin when a subject presses a button or when 
a signal generator sends out a pulse. These are typical 
digital signals and the trigger devices that emit these 
signals can be connected via the UIM100C. Most stimulus 
generators are equipped to output a digital pulse 
simultaneously with the stimulus signal. 
In a simple trigger design, an external switch is connected 
to the TRIG and GND D input as shown above. Since this 
switch will be either open or closed, the data will be 
digital and have two levels, +5 Volts and 0 Volts. A value 
of +5 Volts is interpreted as a binary 1, and a level of 0 
Volts is interpreted as a binary 0. In the setup above, when 
the switch is closed (i.e., the button is pressed) the signal 
changed from +5 Volts to 0 Volts, creating a transition or 
“edge.” 
If the trigger is set to external, and the edge is set to 
positive, the acquisition will begin as soon as the push-
button is pressed anytime after the start button in the graph 
window is pressed. Once the button is pressed, the 
acquisition will proceed according to the acquisition 
parameters you have set (acquisition length, sampling rate, 
and the like). 
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Analog Triggers 
Initiate an acquisition when an analog channel reaches a certain level. To enable the analog trigger feature, data 
must be acquired to either memory or disk, and a value must be entered in the Delay box (although the delay 
may be set to zero). The channel containing the data to be used as a trigger does not require the 
acquire/plot/values boxes to be checked in the Set Up Channels dialog. Leaving these boxes unchecked will 
allow the incoming data to trigger an acquisition but will not cause the trigger channel to be acquired or plotted. 
Select Hardware > Set Up Data Acquisition > Trigger to generate the Trigger dialog: 

 
MP150 Triggering options 

 
MP36R Triggering options 

 External: Select for Digital Trigger. 
 CH #: Select for Analog Trigger; must be acquiring to Memory or Disk. Specify the analog 

channel that contains the trigger data and then specify a voltage Level to initiate the trigger. 
Acquisition will begin when the data on the specified channel reaches the specified Level.  
 To trigger an acquisition when an ECG wave on analog channel 1 reaches a certain voltage 

or value, you would set “Source” to CH 1 and then set the Level when the entry box is 
enabled. 

 Triggering from an analog channel requires oversampling by a factor of 4, which ensures 
that the trigger signal will not be missed. The sampling rate can be adjusted in the Set Up 
Data Acquisition > Length/Rate dialog. 
o  For example, an initial sampling rate of 1,000 samples/second should be increased to 

4,000.  
Level  The Level option is activated when a Source CH is selected. Set a level to initiate the trigger (e.g., 

if the ECG wave peaks at 2 mV, set the trigger level just under 2 mV). 
Edge  Triggers can have a positive or negative edge, defined as follows: 

Edge Digital Analog 

Pos Signal changes from 0 to 1 Signal changes direction from downward 
to upward. Once the trigger level is 
crossed, the acquisition will start. 

Neg Signal changes from 1 to 0 Signal changes direction from upward to 
downward. Once the trigger level is 
crossed, the acquisition will start. 

 For ECG data (and other types of data with peaks of relatively short duration) there will be 
only minor time differences between one edge and the next, although the positive and 
negative edges can be widely separated in time for data with slowly changing values (such 
as EDA or skin temperature data). 
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Mode  Once the trigger channel and level have been specified, the final parameter is the delay. Delay can 
be measured in terms of samples, milliseconds, seconds, or minutes, and may be set to zero if 
desired. The delay option instructs the hardware to wait a specified period after the trigger level is 
reached before beginning the acquisition. 

Delay When using a trigger, the default setting is for the acquisition to begin immediately after the 
trigger pulse or level occurs. You can modify this default by using the Delay option in the Trigger 
Setup dialog. This feature allows an acquisition to begin a specified period after the trigger level is 
reached. To start an acquisition one second after a switch closes, set the trigger to external and 
enter 1.00 in the box next to Delay. The default scale for Delay is seconds, meaning that the 
acquisition will begin a specified number of seconds after the trigger has been initiated. The scale 
of the delay can be changed from seconds to samples, milliseconds, or minutes.  

 NOTE: Delay option not available in MP36R hardware. 
Pretrigger During normal triggered acquisitions, data is collected only after the trigger has been activated (or 

after some delay). For some applications, it is useful to collect data on events that occur just prior 
to the trigger event. As an example, if an acquisition was set to begin when a device (such as a 
tone generator or flash) sends an output pulse, it might also be important to collect information on 
the subject’s state just before the stimulus. 

 Pretrigger functionality is not supported in all acquisition modes (MP150 > Set Up Data 
Acquisition > Length/Rate): NOTE: Pretrigger option is not available in MP36R hardware. 

 

Mode Source: EXTERNAL Source: CH  # 

Disk Pretrigger supported Pretrigger supported 

Memory Pretrigger supported Pretrigger supported 

MP150  Pretrigger supported not available 

Averaging not available not available 

 When the Pretrigger function is enabled, start an acquisition by clicking the Start button. When the 
internal memory in the data acquisition hardware is full, the hardware will start replacing the 
oldest data with the newest data (similar to the record last feature). This process continues until the 
trigger event occurs. Following the trigger, the hardware will collect data until the total length is 
reached. The acquisition now contains data from both before and after the trigger. 

 The amount of data collected before the trigger event is determined by the value in the box next to 
the Pretrigger popup menu. As with Delay, scaling can be set in terms of samples, milliseconds, 
seconds, or minutes. The duration of the Pretrigger may also be adjusted using the scroll box to the 
right of the Pretrigger dialog. 

 When Pretrigger is selected, it is important to note… 
 The total length of the acquisition includes the duration of the Pretrigger. If the acquisition 

length is set to 120 seconds and the Pretrigger is set to 20 seconds, only 100 seconds of data 
will be collected after the trigger event occurs. 

 Since the total length of the acquisition includes the duration of the Pretrigger, the duration of 
the Pretrigger may not exceed the length of the acquisition. 
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Chapter 9  Set Up Stimulator 
Note This chapter refers to stimulator setup for MP150 hardware only. For MP36R, see the 

next chapter, ‘Output Control.’ 

 
Although data acquisition is the primary function of the MP System, AcqKnowledge supports output of a signal 
through one or two analog channels while data is being acquired. This type of signal output  is configured in the 
Stimulator setup window. 
Four types of signals can be output: 

Square waveforms—page 182  Ramp waveforms—183 
Tone waveforms—183 Arbitrary waveforms—184 

Each of these waveform types can be set to repeat signal output either Once or Continuously, and parameters 
can be set to either Relative or Absolute time scales. To set the type of waveform to be output, select MP150 > 
Set Up Data Acqusition > Stimulator. Like the standard graph window, the Stimulator setup window plots time 
on the horizontal axis and amplitude on the vertical axis.  
Use the Stimulator window to create and shape waveforms for output. Adjust the Stimulator Sample Rate 
(described below) to further control the parameters of the Stimulator Output design. 
For any waveform (or stimulus) to be output, the following parameters must be specified; the type of stimulus, 
the “shape” of the signal, the output channel to be used, and how many times the stimulus should be output.  
All the above parameters are set up from within the Stimulator Setup dialog. Regardless of the type of 
waveform selected, stimulus signals will normally be output when an acquisition is initiated, either as a result of 
clicking the “Start” button, using the “manual stimulator control” or via a trigger being activated. 
Stimulator Sample Rate 
A very powerful feature intrinsic to the MP150 unit is the ability to set a stimulation signal output rate that is 
different than the acquisition rate, thus permitting considerable flexibility for a variety of physiological 
applications. For a full explanation of MP150 Stimulator sample rates, see page 185. 
Use the “Stimulation sample rate” pull-down menu to select a unique sample rate for the stimulator. 

  See also: Application Note AH162 - Using the Stimulation Features of the MP System.

http://biopac.com/AppNotes/app162stim/stimftr.htm�
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Stimulator Parameters 
The Stimulator parameters are set by using the buttons in the right pane of the setup window. 
Reset Refresh the display; use after the time scale has been adjusted. 

Scaling  Scaling button—Rescale stimulus signals to units other than 
Volts according to the Change Scaling Parameters. 

 This type of rescaling does not change the amplification of the 
signal, it is useful for recalibrating the output signal to more 
meaningful units. In the example shown here, an output signal of 
+10 Volts is rescaled to +128 dB, while an output signal of –10 
Volts is rescaled to reflect 0 dB. 

 

Relative  Set the duration of each segment of the output waveform in Seg # Width. In the sample dialog 
shown below left, a 5000 msec output is created by entering individual segment widths: 500 + 400 + 
250 +200 + 3650 = 5000 msec. 
Note  In AcqKnowledge 4.4 and higher, the segment level fields are hidden by default and must be 

expanded by clicking the Segment Configuration “+” button (below). 

 
For details about stimulator segment and width configuration, see page 182. 

 

 
Output 

Analog Output 0/Analog Output 1: Signals can be output on one or two analog output channels. The 
output channels are listed as A0 and A1 and correspond to Analog Output 0 and Analog Output 1 on the 
UIM100C module. 

 For dual stimulation and independent control, connect an output device to A0 and A1.  
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 See Analog Output for MP150 Users notes on page 180. 
The maximum resolution of a stimulus signal output through an analog channel is 22 µsec; this means 
that the shortest segment in the stimulus signal must be at least 22 µsec in duration. 

Duration 
Set independently for A0 and A1. 

 
 Off: Turn Output OFF (no stimulus signal output). 
 Output once: Output the stimulus signal once. 
Output continuously: Output the stimulus signal for the duration of the acquisition (forever). 

 When Output continuously is selected, a vertical line is generated at the end of the first section of the 
waveform in the stimulator window to indicate where the first output signal ends and the second begins. 
The line can be dragged left or right like a vertical segment in a stimulus waveform to control the duration 
of the waveform as it is continuously output. Maximum continuous waveform output is 20 kHz.  

 
 

Use to choose the Stimulator sample rate for the generated signal. (The Stimulator sample rate is independent of 
the acquisition sample rate. See page 185 for sample rate details.) 

 
Control timing of output by aligning it with the Start button, waiting until a trigger is initiated before generating 
the signal, or manually toggle the selected stimulator on or off. Click the “lock” button  to synchronize both 
stimulator outputs to the On/Off buttons. 
 Note “Wait until trigger” option is only active if Triggering is enabled in the “MP150 > Set Up Data 

Acquisition > Trigger” menu. 

Trigger 
When a trigger option is selected (in the Trigger Setup window), AcqKnowledge allows selection of 
additional options with respect to when the signal is output. By default, the stimulus signal will be output 
when you click the start button. When a trigger is enabled, however, you have the option of either 
outputting the signal when the start button is pressed or when the trigger is initiated. The trigger option is 
added to the stimulator window when a trigger is enabled in the Setup Trigger box (described on page 
173). 

Manual Stimulator Control 

 Only available when a stimulator is connected and with MP150 units running firmware 1.1.14 
or higher. 

When an MP150 unit is being used, the manual stimulator controls at the bottom of the Stimulator Setup 
dialog can be used to start and stop stimulators independently of the acquisition. If changes are made to the 
stimulus wave while a stimulator is running, the stimulator will need to be turned off and then back on to 
apply the changes to the settings. 
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The manual stimulator controls cannot be used if the MP150 is set to acquire in averaging mode. 

• The stimulator output will start simultaneously with the acquisition. 
• The On/Off buttons will start and stop the stimulator output. 

 If Dual Stimulator settings are active, “Start with” applies to both stimulators. 
 A “lock” between the two sets of controls can be used to turn both stimulators on or off at 

the same time. This lock is useful for two-channel stimuli delivery, such as stereo sound. 
UNLOCKED 

  
LOCKED—Both channels Start/Stop together 

 
Stimulator Output Type 

 
If an averaging acquisition is selected in the MP hardware setup, the timing can be set to delay the averaging 
pass until after the signal is generated, or to include the signal output in the averaging pass. Note that the signals 
cannot exceed the duration of the averaging pass. 
The “Digital” setting will generate a true digital pulse (0 Volts and +5 Volts) prior to the averaging pass on 
digital I/O Channel 15. 

 For Averaging details, see page 162. 

   
Finish all output, then start averaging pass Include output in averaging pass 
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Analog Output for MP150 Users 
The two MP150 Analog Output channels can independently output static or dynamic values: 

• Static output: Use “Manual Control” (page 233) to set the output level for each channel in the range -10V to 
+10V. 

• Dynamic output: Use “Stimulator Setup” (page 176) to define the output level and pattern. 
The MP150 will automatically use the “Manual Control” value if: 

• No acquisition is in progress OR 
• Acquisition is in progress but the Stimulator is disabled via the “Setup Stimulator” dialog. 

The MP150 will only use the “Stimulator Setup” value if: 
• Acquisition is in progress (or before Averaging pass) AND 
• Stimulator is enabled via the “Stimulator Setup” dialog. 

When the stimulator is in use: 
1. Any Stimulator Output starts (from before Time = 0) with the value established for “Manual Control.” 
2. If Segment # Width = 0 the stimulator ignores the associated Segment # Level. 
3. If the stimulator is in 1x mode, after the output waveform is sent, the value of the last segment is fixed until 

acquisition stops. 
4. When acquisition stops, the stimulator resets to the “Manual Control” value. 

The following dialogs and output illustrations demonstrate how the “Manual Control” value influences Analog Output 
for the Stimulator when an MP150 is used: 

Acquisition parameters: 

 
 

Stimulator parameters: 
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Manual Control list box: 

 

Stimulator Output pattern (using MP150) 

:  

 
For details on Manual Control, see page 233. 

  

 
Dual Stimulation 
For independent control of two stimuli (such as sound and electrical output), set stimulator functions for Output 
to A0 and A1 for each MP150 unit. Click the tab for each output at the top of the Stimulator Setup dialog and 
complete independent settings. 

 
 For additional stimulus paradigms, add MP150 units (see Multiple Hardware, page 161). 
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Square waves 

 Square waveforms are useful for 
generating pulse waveforms, which can be 
used as stimuli or to trigger a stimulus-
generating device (such as a flash device or 
a tone generator). 
To output a square wave, choose the 
“Output Once” in the “Duration” section. 
You should see a rectangular wave appear 
in the window. You can control the shape 
of the wave by manipulating the various 
segments of the wave. A square wave has 
five segments, and AcqKnowledge allows 
you to set the level (amplitude) and width 
(duration) of each segment. 
NOTE: in AcqKnowledge 4.4 and higher, 
the segment level fields are hidden by 
default and must be expanded by clicking 
the Segment Configuration “+” button 
(below). 

 

In a square wave, each of the editable segments is oriented horizontally, with vertical segments connecting the 
adjacent sections of the wave. The first segment of a pulse waveform is the segment that appears at the far left 
of the waveform section. By positioning the cursor on this segment of the waveform, you can tell from the box 
at the bottom of the screen that the level (vertical offset) of the first segment is 0 Volts, and the width of the first 
segment is 500 msec. 
To adjust the level of a segment, either: 

a) Enter the desired level in the box that says Seg # Level; or 
b) Position the cursor on the first segment of the waveform and drag it up or down using the mouse 

(segment 2 is selected in the preceding dialog, and appears in red). 
To change the duration of a segment, either: 

a) Enter a value in the Seg # Width box at the bottom of the Stimulator Setup dialog; or 
b) Position the cursor on the first vertical segment in the setup dialog, click the mouse button, and drag the 

vertical segment left or right. Moving the first vertical segment left shortens the duration of the first 
segment, whereas moving the first vertical segment right lengthens it. 

Each of the segments in the wave can be “edited” in this way. 
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Tone Stimuli 

 Tone waveforms allow for the creation of pure tone signals of any duration, magnitude, and frequency. 
This option outputs a pure sine wave, which is useful for audiological and stimulus response testing.  

A tone waveform is comprised of two segments, 
with only the second segment being the actual tone 
itself. This allows you to include a pre-signal delay 
(by setting the level for Segment #1 to 0 Volts and 
the duration to a desired value). 
To set the duration of the tone, adjust the length of 
segment #2 (by changing the Seg #2 Width value 
box or by clicking and dragging the segments 
within the window). As shown, there is an 
additional (uneditable) section of the waveform 
after the second section. This segment returns the 
last value from segment two, and continues to 
output that signal level until the acquisition is 
terminated (if the stimulator is set to output once) 
or until another signal is output (if the MP System 
is set to output continuously).  
There are three additional parameters for Tone 
waveforms: frequency; magnitude; and tone phase. 
 Tone frequency refers to the frequency of the second segment of the waveform. This can be set to any 

value, although the most common settings are between 20 Hz and 20,000 Hz. 
 Magnitude refers to the peak-to-peak range of the signal, which can range from ± 0 to ± 10 Volts. 
 Phase of the stimulus signal can be any value equal to or greater than 0 degrees. Phase settings of more 

than 359 degrees will be rescaled to fit the 0°-359° range. In other words, setting the phase to 360° or 
720° has the same effect as setting the phase to zero degrees. 

 
Ramp Waves 

 Ramp waveforms are useful for constructing a 
monotonically increasing or decreasing stimulus 
signal.  
Ramp waves are comprised of three segments and 
the amplitude and duration can be set discretely for 
all three sections.  
  
 



184 AcqKnowledge 4 Software Guide 

Visit the online support center at www.biopac.com 

Arbitrary Waveform 

 The Arbitrary waveform option is used to to set 
a waveform’s shape and length using standard 
AcqKnowledge editing functions. 

 The length of an arbitrary waveform is 
only limited by the available memory. 

 Unlike the other types of waveforms, 
Arbitrary waveforms have no segments, so 
the “shape” of the waveform is determined 
by selecting an existing waveform and the 
only parameters that can be set are Scaling, 
Repeats, and Trigger. 

 Maximum continuous output is 20 kHz. 
To create an arbitrary waveform: 
 A. Copy waveform segment 

1. Open a waveform in a standard graph 
window. 

2. Select the section of the waveform to be outputted.  

 
Return to the Stimulator Setup dialog—the selected area will automatically be pasted into the dialog.  

Stimulator Icons  
Waveforms: 

 
Square wave 

 
 

Tone (sine) wave 

 
 

Ramp wave 

 
 

Arbitrary wave 

Parameters: 
 

Reset the display (use after adjusting the time scale) 

 
 

Scaling (rescale Stimulus signals to different units) 

 
 

Set time base to relative 

Output:  Tab to output to Analog Output channel 0 (default) 
  Tab to output to Analog Output channel 1 
 

 

Manually start and stop stimulator output by clicking the On/Off 
buttons. When the padlock is engaged, both stimulator outputs can 
be controlled simultanously. 
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MP150 Stimulator Sample Rates 
The MP150 is the most common data acquisition device used with AcqKnowledge, and when combined with 
the UIM100C and STM100C modules, capable of outputting various waves at different rates, durations and 
types. As explained ealier in this chapter, there are four basic Stimulator signal types: Square, Sine, Triangle 
and Arbitrary waves. Square, Sine, and Triangle waves are limited to 4096 samples, which may be outputted 
once or continuously. 4096 samples also define the upper limit of a short burst wave. Arbitrary waves, like the 
other types, can be outputted once or continuously, but are not subject to the 4096 sample upper limit. 
The Stimulator output sample rate is configured in AcqKnowledge by choosing MP150 > Data Acquisition Set 
up > Stimulator > Stimulator sample rate. The stimulator sample rate may be the same, lower, or higher than the 
acquisition sample rate.  The output signal can be redirected to an analog input channel. In this case, the number 
of samples displayed in the graph is determined by the acquisition sample rate. If the source wave can be 
uploaded entirely to the MP150 memory (≤ 512K samples), then the number of samples displayed in a 
reference analog input channel may be estimated with this formula: 

Displayed Samples = AcqRate/StimRate*#Sample(source wave) 

Arbitrary wave sources are derived from any waveform within a saved data file or from a newly created 
waveform. Calculation channels, Transform and Edit operations may also be used to create unique waveforms.  

 
Example source wave 

The Expression calculation channel, Absolute value transformation and Edit Copy/Paste operations were used 
to create the example waveform ahown above. The highlighted portion was used as the source wave.  
The MP150 supports an aggregate (combined channel) sample rate of 400 K samples and has an internal 
memory of 512 K samples.  

Aggregate Sample Rate = # analog channels * Acquisition Sample Rate 
Any down sampling of channels is applied in AcqKnowledge, and does not affect the sampling rate generated in 
the MP150. 
Up to 512,000 samples can be uploaded into the MP150 memory and then outputted as a stimulator signal. 
Longer source waves will upload the first 512,000 samples, and the remaining waveform data as memory 
becomes available.  
The following components affect the limits for the stimulus output:  

- Acquisition setup 
o mode  

 MP150 Memory 
 Save to disk or memory 
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o sampling rate  
- Stimulator setup 

o Duration 
 Output Once 
 Output Continuously 

o Stimulator sample rate 
o Analog Output: one or two analog output enabled 

- Source graph/wave length 
o  Short burst wave ≤ 4096  
o Long waves > 4096 and ≤ 512 K samples 

 Within the limits of the MP150 internal memory 
o Longer waves > 512 K samples 

There are two basic AcqKnowledge acquisition modes, “Save to MP150 Memory” and “Save to Memory/Disk.” 
On-line Averaging also uses the MP150 memory.   
Save to MP150 Memory: This acquisition mode was designed for short burst signals at high acquisition 
sample rates with short duration. While longer acquisition can be acquired in this mode, the system may be 
slow to respond. Depending on the computer resources, it may take several seconds for the screen to update. 
Should this become an issue, adjust the CPU allocation in the AcqKnowledge Preferences. In the Preferences, 
select “Performance” and move the slider to the right toward Better data transfer for high speed acquisition.  

AcqKnowledge Preferences are accessed from the Main Toolbar  or via Display > Preferences.  
Analog Output Upper Limits Summary 
The upper limits for short burst, long, and longer waves are provided below.  
Note: At high or maximum aggregate acquisition sample rates, the display may become sluggish and data may 

take several seconds to be displayed. Additional user actions may overwhelm the system. 

 Short Burst Wave (≤ 
4096 samples) 

Long Wave (> 4096 
samples but ≤ 512 K 

samples) 

Longer Waves (≤ 
512 K samples) 

Stimulator Sample Rate: 100 K max  
(sample rate not 

adjustable for 
averaging) 

100 K max 20 K max 

Acquisition Modes: Save to MP150 
Memory 

Save to Averaging 

Save to MP150 Memory 
Save to Memory or Disk 

Source Output Maximum 
per Analog Output: 

4096 samples 512 K samples (256 K if dual stimulators are 
used via outputs A0 and A1) 

Maximum Aggregate 
Acquisition Sample 

Rate: 

400 K 
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Chapter 10 Output Control 
Note Output Control chapter refers to MP36R hardware only.  
 For MP150, see the previous chapter, ‘Set Up Stimulator.’ 

The MP36R hardware can output pulses or analog voltages via the Analog Out 
port; this port is also used to connect to BIOPAC’s external stimulators. The 
MP36R has an additional I/O Port which is used to output digital (TTL Level) 
signals. 

Parameters for output signals are set via Output Control. Access to a specific 
Output Control is via the MP36R > Output Control submenu. 

There are three basic Output Control categories: 

• Pulse – Pulses, Stimulator-BSLSTM, Low Voltage Stimulator and Human Stimulator-STMHUM 

• Pulse trains – Pulse Sequence, Sound Sequence and Visual Stim Controllable LED-OUT4 

• Other – CH to Output, Digital Outputs, Arbitrary Wave Output 

There are a total of ten Output Controls for the MP36R: 

Output Control  See… MP36R Functionality 

CH# to Output  page 189 Direct analog CH1-4 to output listen to signals 

Digital Outputs  page  191 Control 8 digital outputs 

Pulses  page 186 Use with third-party devices; software can control 
  pulse width and repetition. 

Stimulator - BSLSTM  page 192 Use with BSL Stimulator 

Low Voltage Stimulator   page 192 MP36R: Use OUT3 adapter for MP36R built-in low 
  voltage stimulator. Software can control pulse  
  amplitude, width and repetition (-10 to +10 V) 

Pulse Sequence  page 188 Direct analog CH1-4 or digital D1-8 output. Allows 
  for output of customized pulse trains. 

Human Stimulator – STMHUM page 193 Hand-held stimulator, allowing the subject to control 
  the stimulus delivery. Configurable from 1-100 V. 

Visual Controllable LED – OUT4 page 198 Direct analog CH1-4 or digital D1-8 output. Allows 
  for output of customized pulse trains to an LED  
  tranducer for visual stimulus studies (OUT4). 

Arbitrary Wave Output  page 199 Arbitrary wave output is very similar to the stimulator
  in the MP150, allowing for generation of square, sine 
  or ramp signals, or arbitrary signals from another open 
  graph window. 

Sound Sequence  page 198 Outputs customized sounds assignable to a user  
  configurable pulse train. 

To open an Output Control, select it from the MP 36R > Output Control submenu. A checkmark appears next 
to the submenu selection and an Output Control panel is displayed, bordered in red in the active data window. 
To close an Output Control, select from the menu again (toggles between display and hide) or right-click in the 
open control panel and choose Close. 

Only one Output Control panel per graph may be open at any time. Switching between different data files may 
display different output control panels, which operate differently. 
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Because some output devices can be used for stimulation on humans and can achieve voltages up to 100 Volts, 
built-in software logic makes output control as safe as possible. See page 213 for safety notes regarding human 
subjects. The following applies to all Output Controls. 

The output will not operate unless its software control panel is open. 

When an Output Control panel is closed, or the AcqKnowledge application is closed, MP36R output goes to 0 
Volts, preventing the output device from sending pulses. 

When an Output Control panel is opened, output is always OFF until activated by a click of the ON/OFF switch 
in the control panel or, if parameters allow, a click of the Start button in the data acquisition window. 
(Exceptions are the Digital Outputs Control when set to the preference “Set each output immediately.”) 

If desired, custom Output preference parameters can be saved as a preset for a current graph (file preset) or for 
all graphs (global preset) by using the “Save Settings” button in the Output Preferences window. A saved 
Output preference can be selected from the Output Settings pop-up menu in the Output Control’s panel. 

Output Control Preferences  dialogs establish the parameters for output. Preferences dialogs are only available 
when the corresponding Output Control panel is open and active.  

To generate the Preferences dialog: 
Open an Output Control panel and then right-click over it to generate a pop-up menu. Choose 
Preferences to open the dialog (Close will close the control panel). 

 
If a control panel entry box is grayed, its values may be already be established or limited by settings in the 
Preferences dialog. If Preferences parameters allow, enter values directly in the Output Control panel. 

   
Key into the entry boxes and then enter the value by pressing the Enter key. 
Use the Tab key or mouse to move to another entry box. 
Click the OK button if in the preference dialog. 
Values entered into a control panel or its Preferences dialog that are outside the specifications of the output 
device, or outside the limits defined by the Preferences dialog, may change automatically to reflect either the 
closest value to that requested that the hardware can achieve, or the closest increment defined by the limits in 
Preferences. (The system will not check while you type, it checks and may make changes after the value is 
entered.) 
For example, if a Pulse width of 5 ms is entered into the Pulses Output Control panel entry box, but Preferences 
defines a range limit of .5 to 2 ms for Pulse width, the system will automatically change the new entry to 2 ms.  
Saving Panel settings: 
Output Control panel settings will be retained until a file is closed or saved. If a file is closed but not saved, 
settings will be lost (defaults established); if a file is saved, panel settings will be saved.
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CH# to Output 

 
The CH# to Output Output Control redirects an analog input signal to the Analog Out port on the back of the 
MP36R UNIT. The signal from the assigned channel will continue to be record and plot data.  

This Output Control is used commonly when attaching headphones to the MP36R unit to listen to signals 
coming in on an analog input channel; for example listing to the Electromyogram.  

To display this control panel: 

Choose MP 36R > Output Control > CH# to Output to open the control panel. 

MP36R users may use analog input CH1-CH4. Channel 3 is the default setting. If another channel N has been 
designated, the menu will read “CH<N >.” 

Use the control panel ON/OFF Switch to start and stop output. OFF grounds the output so no signal (or sound) 
should be present. 

Set Preferences to designate which channel to redirect to output. 

Open the Preferences dialog by right-clicking the control panel. 

Use the pull-down menu to select the desired channel CH 1-4 to use for the output. 

Click OK to set the output channel and return to the control panel. 

Note Only the Hardware settings (Gain, Offset, Input Coupling) 
from the Input Channel Parameters dialog (MP36R > Set Up 
Data Acquisition > Channels > Setup) will be applied since 
output is established prior to the processing of Digital Filters.  

See MP36R Input > Output Scaling values on the next page. 
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MP36R Input > Output Scaling 

The MP36R hardware can pipe signals from any channel input to the output using the “CHX to Output” control 
panel in the AcqKnowledge software—due to the difference between the input and output range, there will be a 
change in signal level (scaling). The output range depends on the output pin used as shown in the following 
table. 

Output Pin 
(Analog Out port) 

Pin Description Output Range 
(Volts) 

Pin 1 Headphones,  
A.C. Coupled 

-2.048 to +2.048 

Pin 2 
Low Voltage Stimulator, 
D.C. Coupled 

-10 to +10  

The input range is gain-dependent.  The table below shows the scaling (multiplying) factors to use for each gain 
setting. 

Gain Input Range 
+- millivolts 

Output Scale**—accurate to ±10% 
Factor 1 Factor 2 

Pin 1 (Headphone out) Pin 2 (Low Voltage 
Stimulator) 

x5 ± 2 V 1.024 5 
x10 ± 1 V 2.048 10 
x20 ± 500 mV 4.095 20 
x50 ± 200 mV 10.238 50 

x100 ± 100 mV 20.475 100 
x200 ± 50 mV 40.950 200 
x500 ± 20 mV 102.375 500 

x1,000 ± 10 mV 204.750 1,000 
x2,000 ± 5 mV 409.500 2,000 
x5,000 ± 2 mV 1023.750 5,000 

x10.000 ± 1 mV 2047.500 10,000 
x20,000 ± 0.5 mV 4095.000 20,000 
x50,000 ± 0.2 mV 10238.000 50,000 

Notes 

* 1: To properly measure the output signal you need at least a 2K Ohm load. 

** 2. Input to Output scaling is accurate to within 10%. 
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Digital Outputs Control 

 
The Digital Output Control manages the signal output for each of the eight digital lines via the I/O Port located 
on the back of the MP36R. Digital lines are used to control external devices. 

The digital output uses standard TTL levels which correspond to the control panel setting as follows:  

Control Panel setting   Output Voltage level (Volts) 

0 0 

1 +5 

To display this control panel: 

Choose MP36R > Output Control > Digital Outputs to open the Digital Outputs Control panel 

Click each digital output line to set its digital state to 0 (off) or 1 (on). 

To set Preferences for Digital Outputs, open the 
Preferences dialog by right-clicking the control panel. 

Select from the following two options: 

Set each output immediately (default) allows you to 
toggle the state of each digital output line between 0 and 1, 
and change the state immediately. In this mode, no Set 
button is available in the control panel. Output for each line 
is set upon clicking its toggle button. 

Set all outputs when Set button is pressed allows you to toggle the state of each digital output line, but the 
states will not physically be changed until the Set button is clicked on the control panel. In this mode, a Set 
button is available in the control panel. When the Set button is clicked, all eight digital lines will update 
simultaneously. 
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Pulses Output Control 
Stimulator – BSLSTM Output Control 
Stimulator – Low Voltage Output Control 
Stimulator Human Stimulator (STMHUM) Output Control 

Control panel options for Pulses, Stimulator – BSLSTM and Stimulator – Low Voltage  

 
Additional control panel options for Low Voltage Stimulator 

A variety of pulse output options are available. Exercise caution when using any of the options with human 
subjects—see the Safety Note on page 213. 

Pulses Output Control 

Select this Output Control for general pulse output, or when synchronizing to 3rd-party devices. 

Use for reaction time measurements, where a subject listens with headphones for a series of “clicks” (pulses) 
and responds as quickly as possible with a button press. Determine reaction times by calculating the time 
between the start of the pulses and the responses. 

Use with the BIOPAC STP30W Stimulus Presentation System (SuperLab) to measure responses to visual or 
auditory stimuli. To perform sophisticated evoked response averaging tests (e.g. P300), pair triggers with 
different visual or auditory stimuli. 

Use to trigger another device (automatically send a pulse from the MP36R UNIT when acquisition starts). 

Use to control a 3rd-party stimulator. BIOPAC recommends use of the BIOPAC BSLSTM Stimulator with the 
MP UNIT and BIOPAC software. If using the BSLSTM Stimulator, use the Stimulator - BSLSTM Output 
Control instead of this Pulses Output Control. 

Stimulator – BSLSTM 

Select this Output Control when using the Biopac Student Lab stimulator 
(BSLSTM) 

Use with stimulation electrode HSTM01 for safe stimulation of human 
subjects (0 – 100 Volts), as well as lower voltage (0 - +10 Volt) general-
purpose stimulation, such is used with amphibian muscle or nerve 
preparations. 
 

Set up note Placing the BSLSTMA/B unit too close to MP36R hardware can result in data distortion of the 
BSLSTMA/B pulse width signal; distortion is more apparent at higher sampling rates. 

• NEVER set the BSLSTMA/B atop MP36R hardware 
• Position the BSLSTMA/B away from the MP36R hardware to reduce the signal distortion 

Low Voltage Stimulator  

Select this Output Control for low-voltage (-10 - +10 Volt), direct drive 
stimulation via MP36RAnalog Out port (with or without OUT3 BNC 
adapter). 



Part B — Acquisition Functions 193 

AcqKnowledge 4 Software Guide 
 

Use with stimulator electrode HSTM01 for safe, stimulation of human subjects (0 – 100 Volts), as well as lower 
voltage (0 - +10 Volt) general-purpose stimulation, such is used with amphibian muscle or nerve preparations. 

Outputs through a BNC connector so it can be used with most stimulation cables (such as those that terminate in 
a needle probe). 

Stimulator Human Stimulator – STMHUM 

Select this Output Control to conduct stimulation studies that enable subjects to control the stimulus delivery. 
This hand-held stimulator connects directly to the MP36 Analog Out port 
and has a red button for delivering the stimulus signal. The electrodes on 
the bottom of the unit are placed directly onto the subject. The STMHUM 
functions much like the BSLSTM but with no additional hardware required. 
The voltage range is 0 – 100 volts and can be limited or locked to a user 
defined level in the STMHUM Output Control panel, which resembles that 
of the Low Voltage Stimulator. 

To use one of these control panels: 

Choose MP 36R > Output Control and then select Pulses, Stimulator – BSLSTM, Low Voltage Stimulator, or 
Human Stimulator (STMHUM). 

Right-click the Output Control panel to generate the Output Preferences dialog. 

 
Set the Preferences. 
General: ON/OFF, Number of pulses, Event options — see page 205
Advanced: Pulse width, Pulse repetition (rate) and Verify Transducer (STMHUM) — see page 209
Level (Low Voltage Stimulator and STMHUM only): Pulse level — see page 211
Reference Channel (Low Voltage Stimulator, Pulse Sequence and STMHUM only): The Reference Channel is 
the channel on which the pulse is outputted, and configurable as Analog channels CH1-CH4, or Digital 
channels D1-D8. 
Once configured, Preferences may be saved using the Save Settings command, activated by pressing the saved 
settings from the pop-up menu in the control panel (see page 205). 
Confirm the settings in the control panel. Adjust as desired within the parameters established in Preferences. 
Entry limits: Settings entered into the Preferences dialog may establish, or limit, the values in the Output 
Control panel entry boxes. Enter pulse settings directly into the control panel only if the Preference settings are 
not locked to a specified value. A grayed or disabled entry box indicates that the values are locked. 
Initiate the pulse sequence as defined in Preferences (see page 205). 
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 ON/OFF Button in Output Control Panel uses the switch in the Control panel. 

Recording uses the Start /Stop button in the data acquisition window. 

To close an Output Control panel: 

Right-click anywhere in the Output Control panel to generate a pop-up menu and then choose Close, or select it 
(or another output control) from the MP36R > Output Control submenu. 

 
Pulse Sequence Output Control 
In AcqKnowledge 4.2 and higher, this Output Control allows sequences of pulse configurations and delays to be 
sent to the MP36R unit, making it possible to create more complex stimulus setups. 
 
Enabling the pulse sequence output control option will display the following control panel at the top of the 
graph window: 

 
 
Pulse sequence configuration is performed in the Preferences dialog of this output control panel. (Accessible via 
right-click on panel shown above.) When a pulse train element is selected in the configuration, the controls will 
become visible in the right hand portion of the preferences dialog. The configuration makes use of three basic 
building blocks: 
 
A sequence consisting of a number of delay and pulse train elements. The final configuration consists of one or 
more sequences that are outputted in order. Normally the entire configuration is outputted. There is a special 
operational mode on ‘Start with Recording’ that will take only the indexed sequence matching the current 
recording segment. 
 
A pulse train element consists of  Pulse count, Width and Pulse repetition, These elements can be fixed or 
randomly generated. 
 
A delay element that allows for the introduction of time during which no pulses will be generated. 
 
Each one of these building blocks also has a “repeat” count associated with it that will perform the action a set 
number of times. (Adjust by selecting the desired ‘Repeat’ and inputting a new value) Individual sequences, 
pulse trains and delays can be added, deleted, repeated and reordered as desired. In the right pane of the 
Preference dialog (shown below), fixed or random pulse counts, widths and repetitions can be configured and 
combined. As in other Output Controls, custom settings can be saved and organized in a list view. (See below 
for additional setup dialogs)  
 
For a full explanation of preferences and tabs common to all Output Control panels, see the “Pulse Definition” 
section on page 203 and the “Output Control” section on page 204.  
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 Preferences available in Pulse Sequence tab 
Add: Displays pop-up menu for adding Sequences, Pulse Trains or Delays. 

Output: Displays the configured sequences and sequence elements for the current or saved session. 

Repeat: Editable field for setting the number of times the pulse train or pulse train element is repeated 

Pulse count: Fixed – a set number of pulses is generated per sequence. 
 Random – set a random number of pulses to be generated per sequence. 

Width: Fixed – each pulse width will be of a set duration, in units of microseconds, milliseconds, or 
 seconds. 
 Random – sets the pulse width duration to fall between two set time ranges. 
Pulse repetition: Fixed – sets a fixed interval between the start of one pulse to the start of the next pulse 
 Random – sets a random interval between two set values for the start of one pulse to the start 
 of the next pulse. 
Move Up/Down Delete: Selectively reorders or deletes the various pulse train elements. 
Save Settings: Saves modified settings as a custom preset for the current graph, or for all graphs. 
Organize List: Orders custom presets into a list and categorizes the custom presets for the current file or 
 globally across the application. 
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Preferences available in Options tab 

 

 
  Preferences available in Reference Channel tab 
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Delay Preferences 
 

About Delay between Pulse Trains: 
The amount of actual Delay between pulse trains will vary from the set value depending upon the pulse 
repetition value that is used. In the example sequence below, a Delay of 100 milliseconds between pulse trains 
has been set up, combined with a pulse repetition rate of 20 milliseconds. Because the pulse repetition rate is 
applied before the Delay occurs, the actual Delay between pulse trains in this case will be 120 milliseconds. If it 
is critical that a Delay reflect an exact value, it is advisable to subtract the selected pulse repetition value when 
setting up the Delay parameters. 
 

 
 Delay between pulse trains 
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Visual Stim Controllable LED – OUT4 Output Control 
This Output Control is used to set up parameters for the OUT4 LED transducer used for conducting visual 
stimulus studies, in which flashes of light of varying intensities and intervals are presented to a subject. The 
OUT4 LED transducer is connected directly to the MP36 Analog Out port.  
To use this Output Control choose MP Unit > Output Control > Visual Stim Controllable LED. 

 
The Visual Stim Controllable LED Output Control panel is identical to the Pulse Sequence control panel, but 
with the addition of an intensity control for controlling the LED brightness level. The preferences operate 
identically to those of the Pulse Sequence Output Control covered in the previous section.  

  
Pulse Sequence Tab for Visual Stim Controllable LED Options Tab for Visual Stim Controllable LED 

 
Reference Channel Tab for Visual Stim Controllable LED 

For specifics on the Visual Stim LED preferences set up, see the Pulse Sequence Output Control section on 
page 194. 
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Arbitrary Wave Output 
AcqKnowledge with MP36R supports signal output through one analog channel while data is being acquired. 
This is configured by using the Arbitrary Wave Output option. 
Four types of signals can be output: 

Square waveforms—page 182  Ramp waveforms—183 
Tone waveforms—183 Arbitrary waveforms—184 

Each of these waveform types can be set to repeat signal output either Once or Continuously, and parameters 
can be set to either Relative or Absolute time scales. Like the standard graph window, the Stimulator setup 
window plots time on the horizontal axis and amplitude on the vertical axis.  
Use the Stimulator window (see following page) to create and shape waveforms for output. Adjust the 
Stimulator Sample Rate to further control the parameters of the Stimulator Output design. 
For any waveform (or stimulus) to be output, the following parameters must be specified; the type of stimulus, 
the “shape” of the signal, the output channel to be used, and how many times the stimulus should be output.  
The above parameters are set up from within the Stimulator Setup dialog. Regardless of the type of waveform 
selected, stimulus signals will normally be by clicking the AcqKnowledge graph’s “Start” button or by using the 
On/Off Output Control panel button. 
To set up the Arbitrary Wave Output: 

1. Select MP36R > Output Control > Arbitrary Wave Output. 
2. Right click the Arbitrary Wave Output Control panel and choose “Preferences” to launch the Stimulator 

setup window. 

 
3. Set the desired waveform type and stimulator options in the Stimulator window. 

The MP36R Stimulator setup window (see following page) is nearly identical to the MP150 setup window 
detailed in the previous Stimulator chapter, with the following exceptions: 

• The signal output is limited to one analog channel (vs. two in MP150 hardware). 
• The pulse sequence is initiated by starting the acquisition or by toggling the On/Off button on 

the Output Control panel (vs. the Timing or Trigger controls in MP150 hardware). 
• Stimulator averaging output is not supported in MP36R hardware. 
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Stimulator Icons  
Waveforms: 

 
Square wave 

 
 

Tone (sine) wave 

 
 

Ramp wave 

 
 

Arbitrary wave 

Parameters: 
 

Reset the display (use after adjusting the time scale) 

 
 

Scaling (rescale Stimulus signals to different units) 

 
 

Set time base to relative 

Output: 

 

Sets Stimulator to be active when “Start” button is 
clicked OR when toggled via the ON/OFF button on 
the Arbitrary Wave Output control panel. 
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Duration 

 
 Off: Turn Output OFF (no stimulus signal output). 
 Output once: Output the stimulus signal once. 
Output continuously: Output the stimulus signal for the duration of the acquisition (forever). 

 When Output continuously is selected, a vertical line is generated at the end of the first section of the 
waveform in the stimulator window to indicate where the first output signal ends and the second begins. 
The line can be dragged left or right like a vertical segment in a stimulus waveform to control the duration 
of the waveform as it is continuously output. Maximum continuous waveform output is 20 kHz.  

Stimulator Sample Rate 

 
Use to select the Stimulator sample rate for the generated signal. (The Stimulator sample rate is independent of 
the acquisition sample rate. See page 185 for sample rate details.) 
For more details on all other MP36R Stimulator parameters and functionality, see the previous MP150 
Stimulator chapter on page 176. 

  See also: Application Note AH162 - Using the Stimulation Features of the MP System. 

 
Sound Sequence Output Control 
In AcqKnowledge 4.2 and higher, Sound Sequence Output Control offers users the option of configuring and 
customizing sounds to be outputted for aural stimulus experiments. The control panel and Preferences dialogs 
used for Sound Sequence closely resemble that of Pulse Sequence. The built-in sound resource (a default 
“click”) may be used or any other file in *.WAV format can be substituted via the “File” and “Browse” button. 
The “Width” and “Pulse Repetition” values are dependent upon the duration of the sound file selected for 
output. The “Test” button will output an audio sample of the selected sound resource. 
 

 

http://biopac.com/AppNotes/app162stim/stimftr.htm�


202 AcqKnowledge 4 Software Guide 

Visit the online support center at www.biopac.com 

 
 
The option all sequences means that each configured sound sequence (regardless of number) will be outputted 
within the same segment. If "Once" is selected in the "Output entire pulse sequence" option, a configured 
sequence will be heard one time only. If "Continuously" is selected, the first Sound Sequence will be repeated 
after the last one has completed, looping the pattern repeatedly until the recording is stopped. 
 
The option each sequence means that each sound sequence will be outputted on a segment-by segment-basis 
only. For example, if one Sound Sequence is configured, it will only be heard during the first recording 
segment, but not during the second recording segment). If two Sound Sequences are set up, the first one will be 
heard during the first segment and the second one during the following segment. If no additional Sound 
Sequences have been configured, nothing will be heard during the third segments and beyond. (Exception: If 
"Save Once" acquisition mode is used, the Sound Sequence will be repeated when the recording is overwritten 
during subsequent passes). 
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Pulse Defititions 
The following terms are used in the Output Control panels, Preferences, and guidelines for Pulses, Stimulator – 
BSLSTM, Low Voltage Stimulator and Human Stimulator-STMHUM. 

 

 

Delay before first 
Pulse 

Initial delay from start of acquisition to start of first pulse. 

Number of pulses Number of successive pulses that will be sent out at the specified Pulse Width, 
Repetition and Level. Set for Single (1), Multiple, or Continuous (Cont). 

Pulse Level Amplitude of the pulse, expressed in Volts. 

Note: The output of the BSLSTM is 0 Volts when the pulse is not active. 

Pulse Repetition 

Also called — 
Events per second 
Pulse frequency Pulse 
sequence  
Pulse train 
Repetition rate 
Sample train 

Can be expressed as Period (ms) or Rate (Hz). 

Period: Time between pulses; measured in milliseconds from the start of one pulse to 
the start of the next pulse. 

Rate: Number of pulses that occur in a one-second interval; measured in Hertz. 

Rate relates to Period as: Rate (Hz) = 1000 / Period (ms) 

Pulse Width Time that the pulse is in the non-zero or active state. 
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Output Control Panel Descriptions 
The Output Control panels for Pulses, Stimulator – BSLSTM, Low Voltage Stimulator and Human Stimulator-
STMHUM work in conjunction with Preferences to control pulse output. Control panel functions are detailed 
here: 

OUTPUT CONTROL PANELS 

General Notes Pulse parameters can interact with each other. 
For example, the pulse repetition period cannot be set to a value less than the pulse 
width. 
In order to simplify the interaction, the Pulse width entry overrides other entries as 
required; it is the priority parameter. 
For example, if the pulse width is changed such that it exceeds the pulse repetition 
period, the pulse repetition period will be automatically adjusted to accommodate the 
new pulse width entry.  If, however, the pulse repetition period is changed such that 
it is less than the pulse width, the repetition period will be changed, upon attempted 
entry,  to the closest value that can be achieved without changing the pulse width.  
Entries are checked and rounded (not truncated) as necessary to meet limitations of 
the hardware or the Preferences. 
When a file is opened, the output device will not turn ON automatically. A user must 
manually press either the “Record” button or the “Start” button. 
The exceptions are the “Voltage Output” control panel and the “Digital Outputs” 
control panel if “Set each Output immediately” is selected; these settings will output 
values immediately. 
Output control settings are “local,” which means that they are stored at the data file 
level, not the program level. Use the save as graph template (File > Save As) option 
to use existing Preferences in new data files. 
If a file is saved with an Output Control panel visible and then closed, the panel will 
be visible when that file is re-opened. 

Preferences Right-click a control panel to generate the Preferences dialog, and then select a tab 
for the settings you want to adjust. 

 
Output Settings 

 
 

Displays the name of the current Preferences setting. The pull-down menu lists the 
names of all output Preferences saved using the Save Settings button (see page 205). 
The pull-down menu is not accessible when an output pulse train is in progress. 
If no settings configurations have yet been saved when the Output Control panel is 
first opened and no parameters are changed, the Output Settings box displays 
“Default.”  
When output settings are saved, the Output Settings box displays the name of the last 
selected setting. Use Organize List to change the display order of the menu, rename, 
or delete items (see page 205). 
When a saved setting is selected from the pull-down menu, the Output Control panel 
and all Preferences dialog options will be updated. 

For Reference Channel—Low Voltage Stimulator; Human Stimulator; Visual Stim 
Controllable LED (OUT4) and Pulse Sequence only. All Output Settings must use 
the same reference channel assignment; other parameters can be unique for each 
setting. 
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OUTPUT CONTROL PANELS 

 

 
Once configured, Preferences may be saved using the Save Settings button at the 
bottom of the Preferences dialog. Save Settings generates a dialog to name and save 
a defined configuration of Stimulator output settings. Saved configurations are 
accessible via the Output Settings pull-down menu in the Output Control panel. 
When a setting is selected from the menu, all current output parameters are updated 
to reflect the saved settings. 

Multiple configurations can be saved as long as each has a unique name; the Save 
button will be inactive if the name you enter is not unique.  

Settings can be saved locally (to a specific file) or globally. The data file or template 
file holds the output parameters as established when the file was saved plus any other 
named configurations of Output Settings. 

 

 
Use the Organize List button at the bottom of the Preferences dialog to order, 
rename or delete saved Preferences settings. The up or down arrows are only 
available if two or more settings have been saved. Select a setting and then click the 
up and down arrows to set the position, or choose rename or delete. Selecting 
“Delete All,” removes all saved settings will be deleted and the default options will 
be reactivated. 

 

GENERAL TAB (OUTPUT PREFERENCES) 

General Tab 

The General tab is 
available when using 
Pulses, Low Voltage 
Stimulator, 
Stimulator-BSLSTM 
and Human 
Stimulator-
STMHUM. 
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GENERAL TAB (OUTPUT PREFERENCES) 
 

Number of Pulses 

 

Indicates the number of pulses to be output. When the Output Control panel is 
closed, the pulse output will be immediately stopped. 

Single will establish a single pulse for outputting. All pulse repetition options, entry 
boxes and scroll bars in both the control panel and preferences windows will be 
disabled (grayed). 

Multiple will establish a specific number of pulses for outputting. The selection will 
activate an entry box where you can enter 1-254 pulses. When this option is selected, 
the Pulse Repetition scroll bar is activated in the Output Control panel. 

Continuous will establish a continuous pulse train for outputting. When this option 
is selected, the Pulse Repetition scroll bar is activated in the Output Control panel. 

If “Initiate pulse sequence with ON/OFF button in Output control panel” is set, the 
pulse sequence will be stopped prior to acquisition and will have to be manually 
turned back on after the recording. 

Initiate pulse 
sequence with… 

ON/OFF Button 

 
OFF (red) 
 

 
ON (green) 
 

 
AUTOMATIC 
START (yellow) 

 

Controls the start and stop of pulses. Changes to Pulse Width and Repetition Rate 
can be made in the Output Control panel entry boxes during a pulse sequence, and 
during a recording, if all other Preferences parameters allow it. Any change in the 
pulse output will occur immediately. This lets you change the stimulator output “on 
the fly.” 

When “Initiate pulse sequence with ON/OFF button” is selected: 
The ON/OFF button controls pulse output independent of the acquisition status. 
OFF is always available. 
The ON/OFF button reflects the current output state, with one exception: if the pulse 
sequence lasts less than 0.5 seconds, the button will remain in the “ON” state for at 
least 0.5 seconds to indicate that the ON state occurred. 
When the Number of Pulses selected is Multiple, ON/OFF acts as a momentary 
switch. Press the ON (green) button to start pulses; 
it will automatically turn OFF (red) at the end of the specified pulse train. 

The switch defaults to OFF. Saving a data file or saving as a Graph Template will 
save all stimulator preferences except the status of the pulse switch, which will 
always be saved in the OFF position. 
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Recording 

 
Start button 
 

 
Stop button 

When “Initiate pulse sequence with Recording” is selected: 
If the preference setting “Initiate pulse sequence with: ON/OFF button” is active, the 
control panel changes will take effect immediately. If settings are changed during a 
pulse train, changes do not take effect until the next time the stimulator starts. 
Pulse output turns ON and OFF corresponding to the Start and Stop of the recording.  

When in this mode, and not recording, the ON button will display as yellow, 
indicating that pulse output will automatically begin at the “Start” of the recording. 

Pulse outputting can be turned OFF during a recording, but it cannot be turned back 
ON until the end of the recording. 

When a Repeat sequence is running, pressing the OFF button will turn OFF the 
output for the entire recording sequence and the button will display as OFF until after 
the last sequence, when the switch will display as yellow ON (automatic start) 
indicating that pulse output will begin again at the “Start” of the next recording 
sequence. You cannot turn pulse outputting back ON during a repeated recording 
sequence. 

When the acquisition stops, all stimulator pulses will cease, regardless of the Output 
Control panel settings. 
The pulse output will stop concurrent with the end of the acquisition, even if the 
specified pulse output is not completed before the acquisition ends. When a new 
acquisition is started, the pulse output will start from the beginning. 
In this mode, no changes can be made in the Output Control panel until the recording 
stops. Changes made after recording stops will take effect when a new recording is 
started. 
When a pulse is sent out, the event label and indicator arrow will be generated (if the 
event preference is turned ON and events are displayed). 

After initial delay 

(Applicable to Pulses, 
Stimulator - 
BSLSTM, Low 
Voltage Stimulator 
and Human 
Stimulator-
STMHUM only) 

After initial delay of … is enabled only when “Initiate pulse sequence with 
Recording” is chosen. Specify a delay interval from the start of recording to the start 
of the first pulse. This is useful for viewing data prior to the stimulus pulse. The 
BIOPAC output device determines the delay range. 

INITIAL PULSE DELAY MP36R or BSLSTM 

 Range 0 - 100 milliseconds 0 or .5 - 100 milliseconds* 

 Resolution 10 microseconds 1.953 microseconds 

*Entries greater than 0 milliseconds must be at least 0.5 milliseconds. 
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Pulse Events 

 

 
An advantage of using the AcqKnowledge software for output signals is that 
information regarding the pulse is automatically recorded along with the data. The 
amplitude reflects the output pulse level. 

 Events can be automatically inserted and labeled for each Reference pulse or 
change in pulse train. The label will contain the Pulse width and Pulse rate (and 
system time stamp if selected). 

 Events reflect setting changes made during an acquisition.  

 All output pulse information is automatically recorded and archived with the 
saved data. 

Set the event option by clicking in the box to “Create event when output is changed.” 

Set the “Include time/date” option in the global Preferences (MP36R > Set Up Data 
Acqusition > Event Marking) 

 
The event label accurately captures pulse data, but the event arrow may not always 
line up exactly with the leading edge of the pulse; this typically is not a problem 
because the recording will include the actual stimulus pulse which can be used for 
timing measurements. Depending on the acquisition Sample Rate, the leading edge 
of the pulse in the recording may not correspond to the exact time the pulse was 
sent—it may be off by as much as one sample period. If the event precision is critical 
for your recording, increase the Sample Rate. 

To display events, use the toolbar icon or Display > Show > Events. 

The Range switch on the front of the BSLSTM stimulator should be set to 10 V or 
100 V prior to recording and should not be changed during recording; if using a 
Preset, the corresponding Preset should also be selected prior to recording. The pulse 
level can then be determined by moving the decimal to the right or left depending on 
how the range was switched.  
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ADVANCED TAB (OUTPUT PREFERENCES) 

Advanced Tab 

(Applicable only to 
Pulses, Stimulator - 
BSLSTM, Low 
Voltage Stimulator 
and Human 
Stimulator-
STMHUM) 

 
Pulse Width 

 

Indicates the Pulse Width setting, which determines the maximum Pulse Rate 
frequency. The Pulse Width value is limited by the Preference setting. 

The entry is activated when the value is changed and the Tab or Enter key is pressed; 
it does not require a stimulator restart to take effect. 

The Pulse width entry overrides other entries as required. 

An entry may be automatically changed if any of the following conditions apply, in 
which case the closest possible value will be selected: 

It falls outside the allowable range. 

It is rounded to .01 millisecond increments (MP36R resolution). 

Width has been limited by the Pulse Width: Limit Entry settings of Preferences. 

Allow any entry Pulse width is limited to the output capabilities of the BIOPAC MP36R unit. This 
option allows any entry within the allowable range specified below: 

PULSE WIDTH RANGE MP36R hardware    

Range  .050 – 100 milliseconds  

Resolution 10 microseconds  

Lock entry to This entry locks the width to a single, specified value (within the allowable range). No 
other value can be entered. 

Pulse Repetition 

 

Indicates the Pulse Repetition period (Hz or ms). 

The Pulse period must be greater than the Pulse width. See  “TBPMIN” in the 
Output Preference > Advanced Tab Limits table on the next page. 

The full range of acceptable Pulse Rate values is from .2 to 6,667 Hz (MP36R). 

The maximum Pulse rate (PRPMAX) depends on the Pulse width setting: 

Pulse width 100 ms  maximum Pulse rate = 9 Hz 

Pulse width .020 ms  maximum Pulse rate = 3333 Hz 

The formula for pulse width vs. pulse repetition is PRPMIN = PW + TBPMIN 
Where: PRPMIN = the MINimum Pulse Repetition Period allowed. 
 PW = Pulse Width setting 
 TBPMIN = MINinum Time (in ms) between successive pulses 
       for the output device (see device specifications) 
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If “Limit changes from ___ to ____” is selected in Advanced preferences, then 
PRPMAX will be determined by the formula above or the specified limit, whichever 
is greater. 
An entry may be automatically changed: 

• If it falls outside the allowable range. 
• To round it to .01 Hz increments (resolution of system). 
• To make it at least 0.1 millisecond greater than the Pulse width. 
• By the Pulse Repetition Rate: Limit entry Preference. 
• By the Pulse Repetition: Adjust entry increments Preference. 

You may manually enter any value for pulse width, but when using the scroll bar or 
arrows, entries will be constrained by the “Adjust entry increments” Preference 
setting. 

Pulse Repetition 
Scroll Bar 

The Pulse Repetition Scroll Bar adjusts rate or period by the increment of change and 
limits established in Preferences. With each click of the scroll bar arrows, the rate will 
be increase by the specified increment. 
When “Initiate pulse sequence with ON/OFF button in Control Panel” is selected, 
changes take effect upon release of the scroll box as long as the stimulator is running. 
The scroll bar is disabled when Number of Pulses is set to “Single” or Pulse 
Repetition is set to Lock Entry to...” 

Display as Pulse repetition can be displayed as 
Pulse Rate (expressed in Hz), or 
Pulse Period (inverse of Pulse Rate, expressed in milliseconds). 
Pulse Repetition Rate relates to the Pulse Repetition Period as: 
Pulse Rate (Hz) = 1000 / Pulse Period (milliseconds) 
The “Display as” units selection is also used for: 
Pulse repetition entries in the control panel. 
Scroll bar increments. 
The Pulse Repetition Rate: Limit entry Preference. 
The Pulse Repetition: Lock entry Preference. 
The Pulse Repetition: Adjust entry increments Preference. 

When units are changed from Rate in Hertz (Hz) or Period in milliseconds (ms), the limits 
of the Pulse Repetition range will be converted by the formula: 
Period increment in ms = Round to nearest whole number [Period Range * (Rate 
increment in Hz /Rate Range in Hz)] 

For example, if the Range was 1Hz to 10 Hz with an adjustment increment of 1Hz, 
the proportional calculation would be Period increment = 900 ms (1Hz / 9 Hz) = 100 
ms 

Allow any entry Pulse width is limited to support the output capabilities of the BIOPAC output device. 
See Output Preference > Advanced Tab Limits table for allowable range. 

Limit entry Establishes minimum and maximum values that can be manually entered or changed 
with the scroll bar. 

Lock entry Locks the Repetition to a single, specified value (within the allowable range). No 
other value can be entered in the control panel. 

Adjust entry Controls the scroll bar or scroll arrow increment; does not apply to manual entry. 
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Advanced Tab Limits Pulses BSLSTM  

Pulse width     

 Range (ms): .050 – 100 .049  – 100  .050 – 100 .049  – 100 

 Resolution (ms): .010 .001953  .010 .001953 

Pulse Repetition     

 Rate range (Hz): .2  – 16,667 .2 – 10,204 .2 -  2,000  .2 – 2,004  

 Period range (ms): .060 – 5,000 .098  - 5,000  .500 – 5,000 .499 – 5,000  

 TBPMIN Minimum time  
 between Pulses  (ms): 

.010 .049 .450 .450 

 Resolution (ms): .010 .001953 .010 .001953 

Initial Pulse Delay     

 Time range (ms): 0 – 100 0 or .5 - 100  0 – 100 0 or .5 - 100 

 Resolution (ms): .010 .001953 .010 .001953 

 
LEVEL TAB (OUTPUT PREFERENCES) 

About Level 

 

Low Voltage Stimulator and Human Stimulator-STMHUM allows the software to 
specify the pulse amplitude.  The amplitude can be set to any value within the 
limits of the stimulator; the range is -10 to +10 Volts for the Low Voltage 
Stimulator and 0-+100 V for the Human Stimulator-STMHUM 

Pulse Level 

Low Voltage only 

 

The Level entry box allows the user to 
manually enter any value within the limits 
of the system or within the limits of the 
Preference settings from the Level tab. 
 
The Level entry box will be inactive 
(grayed) if: 
The Level preference “Lock entry to” is 
active. 
If “Initiate pulse sequence with Recording” is active (from the General tab) and a 
pulse sequence is in progress or “wait for trigger” is in progress. 
Use the entry box or the scroll bar to set the Pulse level. When a value is entered 
which is out of range, the value will be rounded to the closest value obtainable 
after the “Enter” or “Tab” key is pressed. 
If “Initiate pulse sequence with ON/OFF button in control panel” is active (from 
the General tab), then values entered during a pulse sequence will take place 
immediately. 
If “Initiate pulse sequence with Recording” is active (from the General tab), any 
entry made between acquisitions will take place on the next “Start” of acquisition. 

Allow any entry The level is limited to the output capabilities of the stimulator. This option allows 
any entry within that range.  

Limit entry This entry reduces the range within the limits of the stimulator’s output 
capabilities. 

Lock entry This entry locks the level to a single specified value. 
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Adjust entry This setting affects the scroll bar or scroll arrow increment only; it does not apply 
to manual entry. 

The smallest increment is 5 mV, as limited by the MP36R. The specified 
increment is used to round manual entries to the closest obtainable value. 

REFERENCE CHANNEL TAB (OUTPUT PREFERENCES) 

Reference Channel 

 

 
This option allows monitoring of  the output signal on one of the analog or digital 
input channels without making any physical connections. This is an internal, 
hardware/firmware, feature that recreates the output signal and allows recording 
in “real time.” The assigned reference channel will override any “real” input 
signal. 
The reference signal is not the real signal, but is a very accurate “estimate” of the 
real signal. The pulse timing accuracy will be within 100 microseconds. If an 
analog input channel is used as the reference channel, the pulse level will be 
accurate within 5%. If the stimulation encounters a load that reduces or distorts 
the pulse output, the reference signal will not reflect this amplitude distortion. 
If a digital input channel is used as the reference channel, only a digital 
representation of the pulse will be generated; 0 to 5 volts. 

Channel Assignment Use the pull-down menu to choose which analog or digital input channel will be 
used as the output reference channel. 

When a new reference channel is assigned, a warning will be generated to alert 
you that this setting will overwrite the existing Channel Setup parameters for the 
selected channel. 
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For example, if CH1 is set up for ECG data and then selected as the Reference 
Channel, the ECG parameters will be replaced. If another channel is then selected, 
CH1 will be reestablished with the default analog input parameters, and the ECG 
settings would need to be recreated via presets or manual entry. 

The reference Channel label should read: “(Selected Output) - Reference Out.” 

When an Analog Input Channel is assigned as the Reference channel, that channel 
(as viewed from MP36R > Set Up Data Acquisition > Channels) will be in a 
locked mode and the Preset pull-down menu will be disabled. The assigned 
reference channel will be inactive for “real” inputs until the Reference Channel 
Preference is changed to “None” or another channel.  

Once the control panel with an assigned Reference channel is closed, the data 
Acquisition Settings > Channels will automatically update to the default settings. 

Generate using You can specify how the Reference signal should be shown. 

If using analog input from CH1 - CH4, you may select actual or fixed (max) 
amplitude and actual pulse or fixed pulse width. Fixed pulse widths are useful 
when the pulse width is much smaller than the sample interval (1/sample rate) is 
used. 

For example, Frog muscle stimulation uses a 1 ms pulse width and a sample rate 
of 2000 samples/second to capture the muscle response. At this sample rate, the 
stimulus pulse cannot be reliably recorded. By using the  fixed width of 15 ms, the 
pulse should be recorded. 

If using digital input from D1 - D8, select actual or fixed (15ms) pulse width. 

Usage Guidelines & Setup Summary for BSLSTM Output Control 
HUMAN SUBJECT SAFETY 

• Before using the stimulator on human subjects, it is very important to limit the 
energy the stimulator outputs. For optimal safety: 

• Before powering on the BSLSTM stimulator, set the voltage level to zero by 
rotating the LEVEL knob on the front of the BSLSTM fully counterclockwise. 

• Use BIOPAC HSTM Series Probes. You MUST use these probes in order to 
limit the energy the stimulator can output. 

• Never create an electrical path across the heart. 
• Never use on subjects with pacemakers. 
• Read this manual and the BSL Hardware Guide to become familiar with 

Stimulator operation. 

1. Connect the BSLSTM Stimulator to the MP36R and power on both units. (For instructions on how to 
connect the BSLSTM to the MP36R Acquisition Unit, refer to the BSL or MP Hardware Guides.) 

2. Connect the Stimulator Trigger cable to the Analog Out port of the back of the MP36R hardware. 

3. Connect the Stimulator Reference Output cable to an Input Channel on the front of the MP36R 
hardware. This channel will be set up in Step 8 below as the Stimulator Reference Channel. 

4. The Reference pulse has a fixed Pulse width of 15 milliseconds, so chosen so that the Sample Rate of 
the recording may be as low as 100 samples/second and still capture the Reference pulse. 

5. Before powering on the BSLSTM stimulator, set the voltage level to zero by rotating the LEVEL knob 
on the front of the BSLSTM counterclockwise all the way to the left. 

6. Open a new data acquisition graph. 
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7. Confirm that Events are activated. Events are activated by default. If not activated for a given 
recording, choose Display > Show > Events. 

8. Set up the Stimulator Reference Channel. This is the Analog Input Channel on the front of the 
MP36R that receives the Stimulator Reference Output cable from the back of the BSLSTM. Remember, 
the reference channel is is generated from the stimulator and not the software. 

9. Choose MP36R > Set Up Data Acquisition > Channels. This will generate a Set up Channels dialog. 

10. Select the Acquire, Plot and Enable options for the analog channel to use as the Stimulator Reference 
Channel. 

11. Click Presets and scroll to select “Stimulator (0-10V)” or “Stimulator (0-100V)” to match the Range 
switch setting on front of the BSLSTM. 

12. Click Setup to view or change the analog channel parameters. Review the BSLSTM Stimulator section 
(page 192) and Analog Channel Setup section (page 116) before modifying channel/preset parameters. 

13. You may set the Gain and other input parameters as desired. 

14. Click OK to accept the parameters.  

15. Close the Set up Channels window.  

16. Adjust the voltage output of the stimulator by using the Level control on the front of the BSLSTM. 

17. Rotate the Level knob clockwise to increase and counterclockwise to decrease, reading the voltage in 
the BSLSTM’s digital display. 

Stimulator Safety Features 

The stimulator cannot operate unless its Output Control panel is open. 

The Pulse ON/OFF Switch on the Stimulator Output Control panel must be OFF in order to open and configure 
Stimulator Preferences. 

If the Stimulator Output Control panel (or the AcqKnowledge application) is closed in the middle of a pulse 
train while the stimulator is running, the stimulator will shut down and the pulses will stop. 
If another data acquisition window is activated, the stimulator will stop and remain OFF unless restarted using 
the parameters associated with the new data window. The only exception is that if the stimulator is ON and the 
data window corresponding to current stimulator parameters is acquiring data, then the stimulator will continue 
to run until the end of the acquisition. 
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Chapter 11  Set Up Event Marking 
Events (Markers) 

 

 

 

 
Event Toolbar Event Insertion Event Control 

Event (Marker) Overview 
For detailed analysis, it can be useful for waveforms to have extra information associated with them. This 
information might include waveform boundaries from ECG analyzers, spike classifications from a spike sorter, 
heartbeat classifications, or even detailed user notes. AcqKnowledge 4 uses “event” functionality to store and 
manage this information. 
An event is a piece of information associated with a specific time in a waveform. An event can capture points of 
interest within a file (i.e. subject moved, dose added) or on a particular channel (i.e. T-wave onset). Once events 
are marked in the file, AcqKnowledge can use the event information for analysis, including measurement (page 
231) and cycle detection (page 325). 
 An event has the following pieces of information associated with it: 

o Event type 
o Sample location: the time position in hardware samples where the event is defined. 
o Channel: the channel for which the event is relevant. 

o Some events, such as the time of the start of an appended segment, may be relevant to all of the 
channels of a graph—these are “Global” events. 

o Label: a string of text that can be entered either automatically or by the user to provide more 
information about an event. Labels can be fixed or sequential in AcqKnowledge 4.2 and up. 

 Different event types can be entered automatically or manually. These different event types allow 
events to be filtered and also support analysis routines that key off of these events. 

o Event insertion tool 
o Set up Event Marking (see page 218) to manually insert events during acquisitions 
o Copy/paste measurements and Copy/paste wave data operations can insert events at the 

selection boundaries; choose “Mark with events” under Preferences (see page 216) 
o Cycle Detector Output Events option (see page 325) 
o Contextual menu in Event region 

 
o Specialized Analysis (see page 348) to automatically insert events according to complex 

analysis algorithms 
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Event Toolbar 

 
The event toolbar displays the visible events in the graph and provides a quick editing area for event 
descriptions. The right button toggles visibility of the Event Palette for detailed control (see page 219). The 
palette will “refresh” when events change the event configuration, such as horizontal scrolling, scale changes, 
changes in the selected event via clicking in the graph window, editing of the event label by using the event bar, 
transformations that define new events for the graph, waveform editing operations, and additions of new events 
by clicking the event bar at the top of the graph window. The right/left arrow buttons are for navigating through 
events. If events are placed in the waveform, the arrow navigation will locate events in the selected channel 
only. 
 
Event Tooltips 
If events are being displayed within the plotting area and tooltips are enabled, a tooltip will be associated with 
every event in the plotting area. The tooltip includes the event type description, the user-defined label (if 
present), the time location of the event, and the amplitude of the waveform at the event location. While this 
information can be drawn directly on the graph, event tooltips assist in browsing event information when the 
screen becomes too crowded and there is not enough room to display all of the times, amplitudes, and labels. 
Event tooltips are displayed under the event icon. 
 If the event is being plotted directly on the waveform, this will be the point on the waveform associated 

with the event. 
 If there is an indicator and the event icon is at the top of the indicator, the tooltip will be anchored at the 

top of the indicator. 
 If the events are being plotted at the top of each track, the tooltip is anchored at the top of the plotting 

area directly underneath the event icon. 
Event tooltips will not be displayed if tooltips are disabled, if events are only being displayed in the events bar 
at the top of the screen, if X/Y mode is in use, or if events are not currently visible. 
Preferences for Events 

  
Preferences  > Event Summary and Waveform 

Use the “Event Summary” section of the Preferences dialog to set options for pasting summaries of events into 
the journal.  
 Group events 

Sorted by type sorted by event type descriptions first 
Sorted by channel grouped based upon where they are defined (Global events appear first, followed 

by groups for each individual channel). 
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 Sort Grouped events 
Sorted by time sorted in order by increasing time 
Sorted by label sorted alphabetically by label 

 Include only events visible on the screen 
Determine if the summary is generated for all of the events that are in a graph, or only for those events 
that are currently visible on the screen. If there are thousands of events in a file, this feature allows the 
list to be pared down to those of interest. 

Event summary options will be saved with the graph if the graph has a graph journal, and can be pasted into the 
journal using “Summary in Journal” Event Palette Actions command (see page 223). 
Other event preferences are available under Preferences > Waveforms 

• Mark waveform edits with events 
• Mark selection with events in graph—enabling this preference automatically brackets the edges of 

selected data areas with “selection begin” and “selection end” events when measurements or 
waveform data are pasted to the Journal. (This option is also available under Preferences > 
Measurements.)  

 
“Selection Begin” and “Selection End” events 

“Selection begin” and “selection end” events may also be applied manually by selecting an area of data 
and choosing the “Mark Selection” button in the Selection Palette. 
• Include time value— include the time value (relative to start = 0) for the paste. 
• Include timestamp—Include time and date stamps for when the paste occurred; this timestamp will 

match any timestamp pasted into the journal. When selected, any selection events added to the graph 
will have their labels set to match the timestamp. 

• Auto-paste results in independent journal (Preferences > Journal)—Selection events and time 
stamp events can be automatically inserted to an independent Journal. 

Combine these options to retain enough information to reproduce measurement results and correlate 
measurement results with specific areas of the graph; this helps verify the accuracy of measurement results 
made through manually constructed graph selections. 
Any change to these settings will be retained within a saved graph file and will become the default for newly 
constructed graphs. 
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Event Marking Setup 

 

Events of different types 
can be inserted during 
acquisition, whether or 
not events are visible in 
the graph. When a hotkey 
is pressed during 
acquisition, an event will 
be inserted into the graph 
at the end of the most 
recently acquired data. 
Each hotkey can have a 
different configuration, 
adjustable through a 
dialog accessible via the 
“Hardware > Set Up Data 
Acquisition > Event 
Marking...” menu item.  

Hotkey Assign Escape or F1 through F9. When a different hotkey is chosen, the other controls of the 
dialog change to reflect the configuration of the new hotkey. 

Action Choose whether the Hotkey assignment creates an event or a focus area. 
Event type Lists the standard hierarchical menu of available event types; Types are detailed on page 225. 

Choosing a new type from the pull-down menu will change the type of event inserted when the 
hotkey is pressed during acquisitions. 

Channel Contains a “Global” entry and all of the channels (analog, digital, or calculation) set to 
“Acquire” in Set Up Channels. 
 “Global” will define global events drawn in the event bar above the graph data 
 Choosing a new channel from this menu will cause events to be inserted on the appropriate 

channel of the graph when the hotkey is pressed. 
Label Edit field for label text and toggle optional inclusion of time stamp and/or date stamp. Stamps 

correspond to the time of the system clock when the key was pressed, that is, the time of the 
event insertion in “real clock time.” 
 Fixed - Provides a fixed label from text entered into the label field to the right. This label is 

used every time the assigned hotkey is pressed. (AcqKnowledge 4.2 and higher) 
  Sequential - Labels for events will iterate sequentially through the entries in the table index 

when the assigned hotkey(s) is pressed. The area under ‘Label’ is editable for entering text.  
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Additional Hotkey Setup Controls Function 
Add Adds an editable label field to the list.  
Rename Allows renaming of the existing segment label. 
Delete Deletes a selected custom label. 
Delete All Deletes all custom labels. 
Up Incrementally moves a selected label up the list. 
Down Incrementally moves a label down the list. 
Top Moves a selected label to the top of the list. 
Bottom Moves a selected label to the bottom of the list. 
Include time Adds timestamp to labels when checked 
Include date Adds current date to labels when checked 

Create/Toggle Focus Area Action 
Selecting the ‘Create/Toggle Focus Area’ action presents a similar setup dialog, but dictates that hotkeys setups 
will be assigned to defining Focus Areas instead of inserting events.  

 
When this option is chosen, pressing an associated hotkey during a recording will initiate a focus area in the 
graph. Toggling the same hotkey will conclude the focus area. The focus area will appear highlighted and 
outlined in the graph following the second (termination) keystroke. As with events, multiple hotkeys and labels 
can be assigned.  
Example for setting up a Focus Area Hotkey: 

1. Choose the desired hotkey from the Hotkey list. 
2. Under Action, select ‘Create/toggle focus area.’ 
3. Assign the focus area a label by typing it into the ‘Base focus area label’ field. 
4. If additional focus area hotkey assignments are desired, choose another hotkey 

from the list, and repeat steps 2 and 3. 
5. When focus area hotkey assignments are completed, click OK. 

 If the same hotkey combination is repeated to create subsequent focus areas, the base focus area 
label will remain the same but with incrementing numbers appended to the title. 

 If a different hotkey combination is used for subsequent focus areas, unique base focus area names 
will be used as assigned.  

 Starting a focus area assigned to one hotkey and then starting another focus area assigned to a 
different hotkey will terminate the original focus area and start a new one. 

 Focus areas can be created and toggled while a recording is in progress. 
 Focus areas can be shown/hidden by choosing the the Show/Hide toolbar 

function (right) and checking or unchecking the “Focus Areas” option.  
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Event Palette 

  

 
 

 

The event palette is a floating window that 
provides a quick summary of events for the 
top most graph and can used to examine, 
search, and modify events. Events can be 
extracted in a time range for a specific 
event type and specific channels. 
There is only one visible event palette for 
the entire application. The palette consists 
of four sections: event list, selected event, 
display, and event actions. Each section 
can be shown or hidden by toggling the 
disclosure button next to its title. 
 Event List, see page 220. 
 Selected event, see page 221. 
 Display, see page 222 
 Actions, see page 223. 

o See the Event Journal 
Summary enhancements. 

Event List 

 

The event list provides an expandable, scrollable, 
hierarchical view of the events in the topmost graph. 
Events are grouped by their channel on the top level. 
The event list has three columns of information: 
 Events: the readable type for each event 
 Location (Time): the time location for each event 
 Label: the user defined description for the event. 

Sort the contents in ascending or descending order on each column by clicking the column header. Events and 
Description will sort in standard alphabetical order, Location will sort based on the horizontal axis location of 
each event. 
Select a single event from the event list by clicking on a single event. The event will be selected in the graph 
window and made visible if it is not currently displayed. 
List visible events only toggles the checkbox to switch between the two display modes. 
 When enabled, the event list will display only those events that are being displayed on the plotted portions 

of the graph. As the user navigates through the graph with the scrollbars, horizontal scale, or other means of 
changing the amount of visible data, the event list will continually refresh to contain the new set of visible 
events. 
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 When disabled, the event list will display all of the events for the entire graph. This can allow for easier 
navigation through graphs with hundreds of events, such as PhysioBank files. 

 

Selected Event 

 

 

 
Event type options are 
detailed on page 225. 

When a single event is selected, the type, channel (or “General” for global events), user-defined label, and 
location of the event will be filled in and can be edited. The controls can display information about only one 
event at a time; if no event is selected, the controls will be grayed out. 
Event Location 
“Location defines the position where the selected event occurs, relative to the first sample in the file. To change 
the location of an event, change the position entered in the Location box. Precision matches the horizontal axis 
setting. 
Events (with the exception of Append events) may be repositioned if desired. Alt-click (Windows) or 
Option+click (Mac) over the event icon and hold down the mouse button. Then simply drag the event to the 
desired location on the event bar and release the mouse button. 
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Display 

  
 Event display location Event display detail 
Display controls determine the location and detail of events to be drawn in the frontmost graph. 
 Location—Choose one of the five display methods (described on page 222). 
 Detail—the three checkboxes to establish how much information to include with events. 
 Indicator length—Set the slider to shorten or lengthen the indicator line. This option is only active if 

the display mode is “On waveform, with indicator” or “At top, with indicator.” 
 Font – Align – Selects font style and alignment of Event labels. 
 Angle – Determines the angle in degrees that the Event text can be displayed in the graph. Value can 

be positive or negative. 
 Set as Defaults – Saves any modified event palette settings as the default for newly inserted events and 

subsequent graphs. Applying this option has no effect on previously existing events. (AcqKnowledge 
4.4.1 and higher only.) 

 
Location & Display Description 

In event bar 

 

Event icons are displayed in the global events bar located on top of the plot area in the 
graph window. This does not allow for distinguishing what channel a specific event 
belongs to. 
 To select the event, click the icon in the events bar. 

On waveform 

 

Event icons are displayed above or below the actual sample in the source channel 
corresponding to the location of the event. 
 To select the event, click the event icon on top of the waveform. 

Top of plot 

 

Event icons are displayed at the top of the channel track, either on top of the grid or in 
a channel-specific events bar. 
 To select the event, click the icon at the top of the channel track. 

On waveform, with 
indicators 

Event icons are displayed above the data with a vertical line of configurable length 
running through the data sample of the source channel at the event’s location. 
 To select the event, click the event icon or the indicator line. 
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Location & Display Description 

 
Top of plot, with 
indicators 

 
 

Event icons are displayed at the top of the channel track with a vertical line of 
configurable length running through the data sample of the source channel at the 
event’s location. 
 To select the event, click the event icon or the indicator line. 

Detail When an event is being plotted within a graph, either on the top of a channel or 
floating above the data, the event's location, description, and amplitude of the 
waveform at that location can optionally be displayed along with the event icon. 
Plotting of additional information can be used for graphical annotations on the data 
and for clarifying event location for hardcopy or presentation. 

Actions 

 
Actions Button Description 

Find It is easy to create many more events then one can easily scroll through and locate 
in a list. Find controls the automatic location of events based on established search 
criteria. 
Click the Find button to generate the Event search criteria dialog, and then 
combine or restrict information to define desired events: event type, specific 
channel location, or label search. 
Click “Find First” to search for the first event in the graph that matches the 
criteria. If found, the event will be selected and made visible in the graph window. 

Find Next Finds the next single event that matches the established search criteria until no 
remaining events match the search criteria. 

Cut Selected Event Active only when an event is selected, removes the selected event from the graph. 

Clear 
Clear all 

Generates a search criteria dialog (similar to the Find dialog) and removes all 
matching events from the graph. There is also an option to clear events defined 
within a focus area without affecting the remaining events, or to clear events 
defined outside of a focus area while leaving events within the focus area intact. 
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Summarize in 
Journal 

Displays a dialog with controls that affect which events are included in the 
summary. 
Events can be filtered by visibility on the screen. Creates a textual summary of all 
of the events in the journal. 
 See “Event Preferences” on page 216 for more information about 

modifications to the traditional events summary. 

Event Journal Summary Enhancements 

 
Events to be included in the summary can be filtered using the same criteria as 
Find... in the Event Palette. By adding the ability to summarize only events 
matching specific criteria, textual reports of arrhythmias or other infrequently 
occurring events of interest can be generated with ease. Events defined within or 
outside of focus areas can also be included or excluded from the summary. 

When “Summarize in Journal” is clicked on the event palette, a dialog will be 
displayed with controls that affect which events are included in the summary. 
If there is no journal for the current graph, you will be prompted to create a 
journal. 

 
Mark Selection Defines two new Global events in the graph at the precise time locations of the 

currently selected area (the highlighted wave data section). If there is no selection 
in the graph, this button has no effect. The events that are inserted will have the 
“Selection Begin” and “Selection End” event types. 
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Restore from 
Snapshot 

Enables deleted events to 
be restored from events 
present in a Data Snapshot.  
This option becomes active 
only if a Data Snapshot of 
the main graph is 
displayed. The following 
prompt will be displayed 
when Restore from 
Snapshot is selected. For information on Data Snapshots, see page 54.  

Audio 

 
This option allows you to record audio (such as verbal observations) and 
link it to selected events in your event list. The controls are very simple to 
use, and the audio is recorded via your computer microphone or selected 
audio capture device.  
To set up a recording, select an event in the Event list and click “Record.” 
This opens the “Record Audio” setup dialog (see right). 

Record Audio 
buttons 

Description 

Input device: Select the onboard audio capture device to be used for the recording. Use the default or 
select another from the list of supported devices. 

Record Click to start the recording. 

Stop Click to end the recording. 

Preview Listen to the recording before linking it to an event. If recording is acceptable, click OK. To 
repeat recording, click Record again. 

Once a recording is accepted, it can be played back by clicking “Play” in the Audio controls or by selecting the 
audio-linked event in the Event list. Selecting the linked event in the graph’s event bar will also play the 
recording. Recordings can be erased by clicking the “Remove” button. One a recording is removed, it cannot be 
recalled. 

 
Event Type Options 
Event Types are pre-defined options for assigning event information. The Event Type is for marking purposes 
only and does not imply any analysis has or will occur for the event (unless Specialized Analysis was 
performed, see page 348). 
Once Event Types are defined, some analysis functions can be automated, including measurement (page 231) 
and cycle detection (page 325). 
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Event classifications: 

 

Event classifications group similar event types together into a logical 
category. Event classifications present event types in a hierarchical 
fashion and allow other event classifications to be contained within 
them. 
For example, the “Hemodynamic” event classification includes a 
“Beats” sub-class with pre-ventricular contraction and escape beat 
event types. 

Event type Classification 
Global This is the same as ‘untyped’ markers from AcqKnowledge 3.6 or earlier. 

Unrecognized event types will be classified as global events. 

Append Automatically inserted by the program on append operations.  Custom Append 
labels can be created in Hardware > Set Up Segment Labels. (See page 238.) 

Notes Annotation event to add notes on the data. 

User-defined Hotkey insertion for user-specific events; 9 types can be inserted via the 
keyboard during acquisition. 

Pharmacology Basic pharmacological events: baseline, washing, and dosing. 

Waveform Edits Automatically inserted by the program on cut or paste operations in a graph file. 
The description consists of the edit operation performed and a timestamp. 
Insertion of waveform edit events is off by default, but can be turned on for GLP 
purposes. 

Selections Used to mark boundaries of selected areas. 

Classification Pre-defined Event Type Options 

Default “Esc” key inserts global event. 

General Waveform onset or end Maximum and minimum 
Change in signal quality or rhythm Reset  
Recovery Append 

Hemodynamic 
 >  Beats 

Normal Nodal premature 
Paced Supraventricular premature 
Fusion of paced and normal Premature ventricular 
contraction 
Unclassifiable R-on-T premature ventricular 
contraction 
Left bundle branch block Fusion of ventricular and 
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normal 
Right bundle branch block Atrial escape 
Bundle branch block Nodal escape 
Atrial premature Supraventricular escape 
Aberrated atrial premature Ventricular escape 

Hemodynamic 
 >  Blood Pressure 

Systole End Systolic pressure 
Diastole End Diastolic pressure 

Hemodynamic 
 >  ECG Complexes 
 

QRS onset, peak, and end U-wave peak 
T-wave onset, peak, and end PQ junction 
P-wave onset, peak, and end J-point 
Q-wave peak ST segment change 
S-wave peak T-wave change 

Hemodynamic 
 >  Impedance 

A-point  O-point 
B-point  X-point 
C-point Y-point 

Hemodynamic 
 >  Monophasic AP 

Plateau Upstroke 

Hemodynamic 
 >  Other 

Start of ventricular flutter Pacemaker artifact 
Ventricular flutter wave Isolated QRS-like artifact 
End of ventricular flutter Non-conducted P wave 

Notes Arrow—short, medium, or long Star 
Flag 

Pharmacology Baseline Wash 
Dose 

Neurophysiology Spike Episode Begin Spike Episode End 

Respiration Inspire Start Inspire End 
Apnea Start 

Stim/Response Stimulus Delivery Response 

EDA Skin Conductance Response Specific SCR 

Clustering Cluster 1-9 Cluster n 
End Cluster Outlier 
Training Set 

User-defined User Type 1-9 

Classification Pre-defined Event Type Options 

Waveform Edits Cut Paste end 
Paste begin  

Selections Selection begin Selection end 

B-Alert Start of Eye Blink Artifact End of Eye Blink Artifact 
Start of Excursion Artifact End of Excursion Artifact 
Start of Saturation Artifact End of Saturation Artifact 
Start of Spike Artifact End of Spike Artifact 
Start of EMG Artifact End of EMG Artifact 
Workload – EMG Start Workload – EMG End 
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Workload – Invalid PSD Start Workload – Invalid PSD End 
Dummy Data Start Dummy Data End 
Misaligned Data 

BioHarness Button Pressed 

SMI Import Left eye hit object Right eye hit object 
SMI stimulus image has been presented to the subject 

Mobita Start out of range End out of range 

Sleep Scoring Wake Onset Wake End 
REM Onset REM End 
Sleep Stage 1 Onset Sleep Stage 1 End 
Sleep Stage 2 Onset Sleep Stage 2 End 
Sleep Stage 3 Onset Sleep Stage 3 End 
Sleep Stage 4 Onset Sleep Stage 4 Ebd 
Unscored Onset Unscored End 
Sleep Spindle Onset Sleep Spindle End  

Event Measurements  
Measurements are a quick way to extract information from a graph. Three measurements extract information 
from events. When combined with the Cycle/Peak Detector (page 325), they are also powerful data reduction 
tools. These event measurements can provide quick summaries of event information, compute mean intervals 
between event types, and detail other operations. 

 evt_ampl Event Amplitude Measurement (see below) 
 evt_count Event Count Measurement (see page 229) 
 evt_loc Event Location Measurement (see page 229) 

Event Amplitude Measurement 

 

evt_amp – Extracts measurement results where events are 
defined. Note that the amplitude is always taken from the 
measurement channel, which may be different from the 
channel on which the events are defined. Useful for 
extracting information such as the average T wave height 
within the selected interval. The measurement result is 
displayed without units (matching Value and other 
amplitude events). 
Select Event Amplitude or click the measurement info 
button to generate the settings dialog. 

Event Type Determines the type of events that will be processed; Types are detailed on page 225. 
Location Determines where the processed events need to be defined. The menu options are: 

 Measurement channel only—Only extracts amplitude values for events that are defined on 
the channel specified in the measurement channel pull-down menu. Global events and other 
channel events are not included. 

 Global events only—Only extracts amplitude values for events that are defined as global 
events appearing in the events bar; changing the measurement channel will not affect the 
measurement result. Channel events are not included. 

 Anywhere—Extracts amplitude values for events defined on any channel and also global 
events; changing the measurement channel will not affect the result 

Extract Determines what processing will be performed on the amplitude values extracted from events that 
match the Type and Location settings. The processing options are: 
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 Amplitude at first event only—The value of the measurement channel at the time of the first 
matching event in the selected area. 

 Amplitude at last event only—The value of the measurement channel at the time of the final 
matching event in the selected area. 

 Sum of amplitudes at all events—Computes the sum of the value of the measurement channel 
from each matching event within the selected area. 

 Mean amplitude from all events—Computes the average amplitude value of the measurement 
channel from all of the event locations within the selected area. 

 Minimum amplitude from all event —Computes the minimum amplitude value of the 
measurement channel from all of the event locations within the selected area. 

 Maximum amplitude from all events—Computes the maximum amplitude value of the 
measurement channel from all of the event locations within the selected area. 

 Median value of amplitude from all events—Computes the median of the set of measurement 
channel amplitudes at all events. 

 Peak to peak interval of the set of amplitudes from all events—Takes the peak-to-peak 
difference from the set of measurement amplitudes at all events (max - min). 

 Standard deviation of amplitudes from all events—Computes the standard deviation of the set 
of measurement channel amplitudes at all events. 

If there are no matching events of the selected type in the selection, the measurement result will be zero. 
Event Count Measurement 

 

evt_count – evaluates the number of events within the 
selected area. The measurement result is unitless. 
Select Event Count or click the measurement info button to 
generate the settings dialog. 

Event Type Determines the type of events that will be counted; Types are detailed on page 225. 
Location Determines where the counted events need to be defined: the pull-down menu options are: 

 Measurement channel only—Only includes events that are defined on the channel specified 
in the measurement channel pull-down menu; global events and other channel events are not 
included. 

 Global events only—Only includes events that are defined as global events appearing in the 
events bar; channel events are not included. Changing the measurement channel will not 
affect the measurement result. 

 Anywhere—Includes events defined on any channel and also global events. Changing the 
measurement channel will not affect the measurement result. 

If there are no matching events of the selected type in the selection, the measurement result will be zero. 
 
Event Location Measurement 

 

evt_loc – extracts information about the times of events. 
The measurement result will take on the units of the 
horizontal axis; if specific units were set for time or 
frequency via Preferences, those units will be used. 
Select Event Location or click the measurement info button 
to generate the settings dialog. 

Event Type Determines the type of events that will be processed; Types are detailed on page 225. 
Location Determines where the processed events need to be defined. The menu options are: 
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 Measurement channel only—Only extracts the time of events that are defined on the channel 
specified in the measurement channel pull-down menu; global events and other channel 
events are not included. 

 Global events only—Only extracts the time of events that are defined as global events 
appearing in the events bar; channel events are not included. Changing the measurement 
channel will not affect the measurement result. 

 Anywhere—Extracts the time of events defined on any channel and also global events. 
Changing the measurement channel will not affect the measurement result 

Extract Determines what will be extracted from events that match the Type and Location settings: 
 First event location only—The measurement will equal the time at which the first matching 

event in the selected area is defined. 
 Last event location only—The measurement will equal the time at which the final event 

within the selected area is defined. 
 Sum of all event locations—The times at which all matching events are defined are added 

together to produce the measurement result. This sum of times can be combined with Event 
Count measurements to compute average intervals over the selected area. 

If there are no matching events of the selected type in the selection, the measurement result will be zero. 
Printing Events 
When a graph is printed and events are displayed onscreen for the graph, event icons will print as they are 
displayed. Event icons will be scaled, depending on the printer's DPI, to be proportional to the vertical scale 
plotted on the screen. If events are located at linearly interpolated positions, event icons will be dimmed on the 
printout (see the Variable Sample Rate section). 

Event display setting Printed result 

Global events Global events are drawn above and outside of the data plotting rectangle in the 
printout. If the event labels are close together, their alignment will be staggered to 
show separate lines of label text. (AcqKnowledge 4.2 and higher) 

In event bar All events are drawn above the data area of the printout. Only labels may be drawn 
with the events. 

Top of plot or 
Top of plot, with 
indicator 

Channel-specific events are drawn at the top edge of their channel’s track. No 
indicator lines are drawn. Depending on the display settings of the graph, the event 
label, amplitude of waveform at the event location, and Time of the event may be 
printed below the event icon  

On waveform or 
On waveform, with 
indicator 

Channel-specific events are drawn immediately above the position of the 
waveform sample at their location and will appear to be printed immediately above 
the data of the waveform. No indicator lines are drawn. The vertical printing 
position of an event icon will be identical for “On waveform” and “On waveform, 
with indicator” displays. Depending on the display settings of the graph, the event 
label, amplitude of the waveform at the event location, and time of the event may 
be printed above the event icon. 

“Draw vertical divider at event locations” option in the Print Setup dialog. 
 Enabled: draws a dashed vertical line at the precise time location of each event. Vertical divider lines for 

the event type will extend  
Global Through all channels of data 
In event bar Through all channels of data 
Top of plot From the top to the bottom of the relevant channel track 
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On waveform From the top to the bottom of the relevant channel track 
 Disabled: prints only the event icon, label, amplitude, and time. No indicator lines will be printed for the 

event display. The vertical divider can be used in place of indicator line drawing. 
 
Events and Waveform Editing 
Waveform editing will adjust event locations for channel-specific events. Waveform editing will never alter the 
time values for Global events (not associated with any specific channel, such as append events). 
Copy  When a portion of a waveform is copied the channel events will also be copied to the clipboard.  
Cut When a portion of a waveform is cut, events within that selected area will be removed and channel 

events to the right of the removed area will be shifted to the left. 
 If waveform editing event insertion is active, a waveform edit event will be inserted at the location 

of the edit operation indicating a “Cut” operation in its description. 
Paste When the waveform is pasted from the clipboard, the channel events will appear at their same locations 

and any channel events to the right of the end of the pasted segment will be shifted by the length of the 
pasted segment. 
 If waveform event insertion is active, a waveform event marker will be inserted at the beginning 

and at the end of the pasted segment. 
Constructing Graph Selections from Events 
Graph selections can be defined from events (in addition to the I-beam tool).  

1. Click the first event to select it. 
2. Hold down the Control key (Windows) or Command key (Mac) and click the second event. A selected 

area will be created in the data between the two events. 
 
Event Plotting and Variable Sampling Rate 
Event positions are defined in terms of the hardware sampling rate. The Variable Sampling Rate feature can 
generate waveforms with a sampling rate lower than the hardware sampling rate. Through explicit event 
definition, waveform downsampling, or other operations, events on a downsampled channel may not align with 
an actual waveform sample, but rather occur at a hardware sample position in between the waveform samples. 
These events will be drawn using linear interpolation when applicable, and only if the waveform is being drawn 
in line plot mode. In step plot and dot plot modes, regular event drawing routines are used, with the vertical 
position and amplitude of the nearest waveform sample to the event’s left. 
When an event is to be drawn on an intermediate position on a waveform, the linearly interpolated value is 
calculated for the hardware sample location. The interpolated value is derived from the closest waveform 
sample to the left and to the right. The vertical position on the waveform of the event and indicator line will 
match the vertical position of the linearly interpolated sample amplitude. This will place it immediately above 
the line connecting the two waveform samples on screen. 
If an event is being drawn using linear interpolation 
 Event icons will be dimmed, regardless of their display position (on waveform or top of the plot). 
 Indicator lines will be drawn on the waveform at a linearly interpolated position and the indicator line will 

be a gray dashed line instead of a solid black line. (Indicator lines are never printed.) 
 Amplitude labels, if included with the event, will correspond to the linearly interpolated amplitude at the 

event location and the linearly interpolated amplitude will be drawn in italicized text. 
 Watch the AcqKnowledge Event Marking tutorial video for a detailed explanation of this feature. 

 
 
 

http://www.biopac.com/video/?video_category=acqknowledge-tutorials&v=event-marks�
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Chapter 12  Other Hardware Menu Commands 
This chapter covers the following MP hardware menu items not appearing in other chapters: 
Show Input Values Display channel data values in real time in a color bar graph format. 

Show Manual Control (MP150 only) Monitor and/or output pulses through the digital input/output. 

Show Gauge Displays onscreen blood pressure gauge or stopwatch. 

MP150 Info (MP150 only) Displays configuration and firmware information for the MP150 
hardware. 

BioNomadix Logger options Only applicable when BioNomadix Logger hardware is used. Contact 
BIOPAC for information about the Logger. 

Autoplot – Scrolling – Sweep – Warn 
on Overwrite options 

Data display options during acquisition. 

Organize Channel Presets Rename, delete, reorder or configure channel presets. 

Set Up Linked Acquisitions Record data simultaneously from multiple hardware devices. 

Manage Hardware Connections Connect, disconnect or switch supported hardware types. 

Show Input Values 

             
The Show Input Values option of the MP (Hardware) menu generates an Input Values window, which displays 
channel values in real time, whether an acquisition is in progress or not—which allows you to display values 
prior to or after an acquisition.  
The Input Values display can be set to numeric, horizontal or vertical bar graph format, and it can be resized 
and moved to any position on the screen. To set the display mode, use the “Mode” menu generated via the 
“Options” button.  

Note The Input Values window only displays values for channels that were Set Up with the “Values” box 
checked (see page 111 for more information). 

Hold Regardless of the display options selected, the display can be “frozen” at any point in time by 
clicking the Hold button. Clicking this icon will hold the values at their level(s) when the icon 
was pressed. The window will remain frozen until the icon is clicked again. Once the values 
are “unfrozen,” the values will return to the standard real time display mode. 

 
Options  
 
 

Mode controls the format of the values display. 
• Numeric Values—displays the voltages of the appropriate channels numerically. 
• Bars: Horizontal bars or Vertical bars—the range of values of the bar graphs 

corresponds to the range for that channel in the graph window. To see the bar “bounce” 
less for a particular channel in the graph window, increase the units per division. 

• Font and Size determine text display from fonts installed on your computer 
Precision controls the total number of digits displayed. 
Show controls the amount and type of information displayed regarding each channel. Click the 
box next to each option to activate or deactivate it. 
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• Channel Numbers will display the channel numbers (A1 for the first analog 
channel, for example). 

• Units will display the units for each channel (as indicated in the main graph 
window).  

• Labels will display the channel labels (ECG 1, Respiration, etc.) along with the 
input values. This feature is especially useful when values from multiple 
channels are being displayed simultaneously. 

• Min/Max will display the range of values associated with the data. This range 
corresponds to the upper and lower display limits for each channel as it appears 
in the graph window. 

• Values will display number values along with the horizontal or vertical bar chart. 
Manual Control (MP150 only) 

 

 
STM100 option 

The Manual Control dialog allows you to monitor and/or output pulses through the digital input/output (I/O) 
channels, as well as manually set the magnitude of the signal on either of the analog output channels. The 
digital outputs in Manual Control cannot be used to trigger an online Averaging acquisition. 

Stimulator Usage Note 
Use Manual Control to specify the stimulation output level  

a. If the wide range of waveform output options available in the Stimulator Setup dialog cannot 
match your specifications.  

b. For pre-stimulation and post-stimulation. 
See page 180 for important Analog Output details. 

The 16 digital channels are sectioned off into two blocks, with the first block consisting of I/O channels 0 
through 7, and the second block consists of I/O 8 through 15. 

• All the channels within a given block are programmed together and can be set as either inputs or 
outputs. 

• The two blocks can be set independently. 

o For example, one block can be set to input data and the other to output data, or one block is 
inactive and the other block reads or outputs data. 

To read incoming values for a given block of digital channels, click the Input button below the row of channels 
for which you wish to have input values displayed. This enables a block of digital channels to receive incoming 
data. To read the values for the entire block simultaneously, click the Read button to the left of the channel 
boxes for that block. Since these are digital channels, the values on the individual channel boxes will toggle 
between 0 and 1. 
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• When AcqKnowledge is launched, values for digital channels #0-7 always read "0" and  #8-15 always 
read "1" to allow for compatibility with the STM100C module, which utilizes the lower eight digital 
lines for attenuation control. 

When Read Continuously is enabled (below the Input button), the values will be read in real time. When 
unchecked, the displayed values correspond to the values for that block of channels as of the last time the Read 
button was depressed. This mode provides much the same information as the Show Input Values mode. 
To output values for a given channel, the block containing that channel must first be enabled to output data. To 
do this, click the bar below the channel boxes so the button reads “Output.” You can then program the 
individual channels within that block. These channels will toggle between 0 and 1, with a 0 corresponding to 
zero Volts and a 1 corresponding to + 5 Volts. To output a digital 1 on I/O channel 3, the dialog would be setup 
as shown above. 
The function buttons toggle as follows: 

Input toggles to Output When Input is selected, the checkbox is “Read continuously.” 
Set toggles to Read When Output is selected, the checkbox is “Set immediately.” 

To output a signal on Channel 3, click the Set button to the left of the channel box. If the Set immediately box is 
checked, the signal will be output when the channel button is clicked. 

IMPORTANT 
Potential use conflicts can arise between the parameters set in the Manual Control window and 
those set for digital channels in the Set Up Channels window. 

STM100 option  

 
STM100 option  
When the STM100C stimulator module is connected to an MP150 System, the output level can be controlled 
via the STM100 option of the Manual Control dialog. 
Attenuation Attenuate the output signal by a given number of decibels (dB) for controlled stimulus 

applications. To output a signal with no attenuation, simply set the “Stim 100 Attenuation“ to 0 
dB.  

 Manually outputting a value on a digital channel can stop an acquisition if data is being 
collected at very high speeds (greater than 10,000 samples per second aggregate). 

Invert output  Check this box to invert the polarity of the signal output through the STM100C. 
 This function can also be achieved by flipping the polarity switch on the STM100C from 

positive (POS) to negative (NEG). 
 
For more information on the STM100C stimulator output module, see the MP Hardware Guide.pdf. 
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Set Up Linked Acquisitions 
This Hardware menu option allows acquisitions to be configured and recorded simultaneously from multiple 
hardware devices types over separate graphs. (For example, acquisitions can be simultaneously linked to two 
MP150,  two MP36R units or an MP150 and a B-Alert unit..) In order for Linked Acquisitions to function, each 
selected graph must be connected to a different hardware unit. (If two or more graphs are connected to the same 
hardware unit, the linked acquisition session will not start.)  
To add or change the hardware device to any open graph, click the “Connect to:” toolbar button and select or 
add a new device from the menu. (“Connect To” toolbar button must be enabled via Display > Show > 
Hardware.) 

 
The linked acquisition can output recorded data into the separate graphs, or optionally, merge the data into one 
graph. If the latter option is chosen, data from the separate graphs will be contained in separate labeled channels 
within the merged graph. 

The sample rates and recording duration can vary between the linked acquisition graphs, but all recordings are 
limited to Save Once to Memory mode. Append or Disk modes are not supported in linked acquisitions. 

 
Top Column Description 

Graph Title Displays the titles of the available graphs. 

Acquire Includes or excludes graphs from linked acquisition. 

Status of 
Hardware Device 

Shows current status of hardware. 

Master Synch. 
Dev. 

Indicates the hardware providing the synchronization signal. This option is supported in 
MP150 hardware only. 

Name of 
Hardware Device 

Identifies hardware device linked to graph. 
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Functions Description 

Merge results into new graph at the end of 
acquisition 

Outputs data collected from multiple recordings into one 
graph. 

Resample merged data to: highest acquisition 
sample rate 

Data in all graphs will be resampled to highest used sample 
rate among all graphs in the set. 

Resample merged data to: lowest acquisition 
sample rate 

Data in all graphs will be resampled to lowest used sample 
rate among all graphs in the set. 

Specify synchronizing method Offers various options for synchronizing the linked 
acquisitions. 

“Use the timestamp” method – Compares all timestamps, detects the one with the latest time, and then cuts 
the beginning section of the data in each channel.  
“Use the master synchronization” method – Used specifically for pairing and synchronizing data obtained 
during linked MP150 and B-Alert acquisitions. This is the only option where the Master Sync Device radio 
button is active. This option requires the use of a BIOPAC CBLX10 cable to link the MP150 hardware with the 
B-Alert X10 headset. This cable allows for the injection of signals used to align data recordings between the two 
independent units. (See the MP Hardware Guide for more details on the CBLX10.) 
“Use simple cutting of data” method – Searches for the shortest acquisition length and uses this parameter to 
calculate how much data will be removed from the beginning of longer acquisitions. This is the least precise of 
the three synchronization methods. 
Start Acquisition Starts the recording for all selected graphs. 

Limitations on Linked Acquisitions synchronization methods 
Synchronization Mode Description Criteria 

Any method Minimum number of selected 
graphs 

2 

Minimum number of analog 
channels 

1 

Minimum length of acquisition 
when B-Alert device is used 

12 sec. 

Master synchronization device 
method 

Allowed hardware types MP150 and B-Alert only 

Minimum sample rate on first 
channel of B-Alert hardware 

256 s/s 

Linked Acquisitions and wireless connections: In general, if the computer is trying to use multiple network 
cards at the same time with an MP150, the MP150 either needs to be on the primary network, or additional 
network cards must be disabled, or network bridging must be enabled in the Windows system settings. When 
self assigning IP addresses, the MP150 may also choose a new IP address each time it is power cycled, which 
will prompt for reconnection. 

 Watch the AcqKnowledge Linked Acquisitions video tutorial for a detailed explanation of this feature. 

http://www.biopac.com/video/?video_category=acqknowledge-new-features&v=linked-acquisitions-in-acqknowledge�
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Manage Hardware Connections 

 

 

 

 

 The Manage Hardware Connections option 
enables easy connection and disconnection 
of new hardware, and allows switching 
from a particular hardware unit (or 
hardware type) to another. The following 
controls are available: 
Connect New Hardware 
Choosing ‘Connect New Hardware’ opens a 
popup menu for selecting and adding 
additional hardware units. Once a new 
hardware unit added, it will be available for 
use in the application, and will appear in the 
connected hardware list. (The example at 
left shows the selection of additional 
MP150 units on a local area network.) 
The ‘Choose MP150’ pull-down menu lists 
all MP150 units that are powered ON and 
sitting on the same local area network. The 
software pings the selected MP150 unit and 
if available, the unit is added to the list. If 
the unit is busy or othewise unavailable, a 
“Cannot connect to MP150” prompt such as 
the example below left is displayed. 
Disconnect 
Use to disconnect from any available 
hardware in the list. 
Playback from Graph 
Launches the “Open for Playback” dialog. 
For more information on Playback Mode, 
see page 43. 
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MP150 Info 
Select MP150 Info from the MP150 menu to generate a dialog with information about the software and 
firmware versions being used by AcqKnowledge: 

 
Manufacturer ROM is the factory-installed firmware version; check this before you “Reset” the MP150 unit for 
a Firmware Rollback (see page 567). 
Note: For information about AcqKnowledge software, click Help > About AcqKnowledge.  
Segment Labels 
Selecting Set Up Segment Labels from Hardware > SetUp Data Acquisition > Segment Labels launches a setup 
dialog enabling assignment of user-defined labels to append event segments. The Segment Label options are 
applied to the active graph only. The selected settings will be saved with the graph, but will not be applied 
globally to existing or subsequent graphs. 

 

  
 
 Add  Adds a segment number to index. Segment text can be edited under ‘Label.’ 
 Rename Used to rename an existing segment label. 
 Delete  Deletes a selected segment from Index. 
 Delete All Deletes all segments from Index. 
 Top/Bottom Moves selected segment to top or bottom of Index. 
 Up/Down Incrementally moves a selected segment up or down the Index. 

Enabling checkboxes below the   icons adds time/date stamps to the segment label. 
 
Sound Feedback 
Sound Feedback enables data to be redirected to the computer's default audio output in real time. This feature 
can be used to monitor waveform data as sound through the computer speakers or headphones.  
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SOUND FEEDBACK 

CONTROLS 
FUNCTIONS 

Sound enabled Turns sound feedback of data on and off. 

Output Sampling Rate Selects from available sampling rates of the default audio device. 

Source Channel Selects the analog, digital or calculation channel from which the audio will be acquired. 

Reset Adaptive Gain Control Resets gain control to adapt to the current level of the signal. Use after sound feedback 
has started to re-adjust the level after accidental spikes or large artifacts. 

Enable low pass filter Applies a low pass filter at the Nyquist frequency (50% of the acquisition sampling rate). 
This IIR filter can help smooth out transition artifacts due to upsampling of data to the audio 
sampling rate. (Enabled by default) 

Median removal controls 
(Window width, Recomputate) 

Removes baseline offset from the output signal. 

Window width Sets width of median removal window (in seconds). Must be a positive value. 

Recompute every Provides the time duration (in seconds) after which the median of the data is regenerated 
from the raw source data. Must be a positive value. 
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Gauge 

 

The Gauge is accessed 
via Hardware > Show 
Gauge. The optional 

“Gauge” display shows 
one channel of data in 
a gauge/dial indicator 

format. 

The Gauge displays as 
a separate window, 

viewed simultaneously 
with graph and other 

windows. 

NOTE: The Gauge feature is available in AcqKnowledge 4.2 and higher only. 

The Gauge window: 

• Will display one channel of data: (analog or calculation) 
• Updates and displays simultaneously with the graph window. For analog channels only, the display will 

update when the recording is stopped, but at a slower rate than when the recording is running. 
• Can update during and in between acquisitions for all hardware devices; display may be updated at a 

rate slower than the sample rate and may display a value that represents the average of several samples.  
• The background image (BMP, JPG or TIFF), indicator origin, range, length, thickness and color are all 

user-configurable. An optional range band overlay can also be enabled. 
• Selectable gauge bitmaps include Blood Pressure Cuff, BPM or Stopwatch 
• All window preferences as well as the window visibility, size and position will be saved with the file. 
• Window sizing is “fixed” to the size of the background image, meaning it will have a 1 to 1 

correspondence with the monitor pixels 
Gauge Preferences 

Gauge Preferences are accessed by right-clicking over the gauge and using the 
contextual menu. There are four tabs for setting the various Gauge parameters. 

 
Background is the default tab presented in Gauge Preferences and contains options for setting the Background 
image. 
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Channel  Provides a pop-up menu for assigning any one of the ENABLED analog or calculation 
channels. 

Background Image  Displays the path and file name of the current background image. The default image is a 
blue blood pressure gauge sized at 451 x 451 pixels.  

Browse  Allows alternative background images in different directories to be used in place of the 
default gauges. The Browse location will default to the file path used by the currently 
selected background image. To change the background image, click the “Browse” button 
and locate the desired file. fter the background image is specified, the pixel Width and 
Height will be updated. The Width and Height fields are not editable.  

Use Default  Displays a menu of available default background images. (Pressure, Stopwatch and 
BPM). 

Opacity Changes the transparency of the gauge image. 

Indicator  
The “indicator” or “needle” is a simple line vector drawn from an assigned center point to an endpoint 
calculated according to the “Length” parameter.  

 
Origin  Center point of the indicator line referenced from the top left of the image (not the top left of 

the window) meaning neither the frame of window nor the title bar is included. The “X” 
parameter specifies the horizontal distance in pixels and the “Y” parameter the vertical 
distance. “X” cannot exceed the Width of the background image and “Y” cannot exceed the 
image Height. The default values are: Origin: X: Width/2, Y: Height/2. Note that the pixel 
count starts at “0” so a 225 pixel square image will have its center point at 112 pixels. 

Length  Specifies indicator span in pixels starting from the “Origin.” Default is the smallest of the 
Length or Width dimensions divided by 2. 

Thickness  Specifies the indicator width in pixels, with a selectable range between 1 and 10. The default is 
1 pixel. 

Color  Specifies color of the indicator “needle” as Black (default) or White. 

When recording is stopped  

If the source channel is a Calculation channel, no gauge 
updating will occur when the recording is stopped. Under 
this circumstance, the “When recording is stopped” options 
become available. This allows the user to specify whether 
the indicator should not be displayed, should be reset to 
zero, or should retain the last value. 

Mapping 

For setting up two point mapping: Input to Angle. 
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Input  Defines the input values in the scaled units. The units shown in the example are volts, but 
would reflect the units of the source channel (mmHg, psi, etc.). The Input mapping of the upper 
scale value is set to a default of 50 of the source channel unit type. 

Angle  Any angle can be entered, but 0, 360, 720, etc degrees means that the indicator will always be 
pointing straight down.  

When assigning mapping angles: Because the indicator “needle” must rotate clockwise, the 
first value should be the lower angle. The first value also defines the indicator’s starting angle 
but does not to need to be 0 degrees. For example, the Stopwatch Gauge’s starting angle should 
be 180 degrees (pointing straight up). If half-circle gauges are used, the starting angle may be 
90 degrees.  

Indicator is limited to specific mapping  

If this option is enabled, and the indicator needle reaches its mapped upper limit, it will stop 
rotating and turn red. If this preference is not selected, the needle will not change color if the 
defined mapping limits are exceeded and the needle will just continue in a clockwise rotation.  

Range Band (Default OFF) 
Use the Range Band as an optional feature to highlight a specified area of the Gauge View. 
 

  
 

Start/End  Defines a “pie” shape (defined by Mapping values) sourced from Gauge center and 
superimposed over the background image.   

Color  Clicking on the color bar will bring up a color palette, which allows any color to be selected. 
The default color is green. 

Opacity  Used to adjust the transparency of the Range Band. 100% means the background image will be 
fully obscured behind the range band, and 0% means the Range Band itself will not be visible. 
The default setting is 50%.  

Segment Timer “Stopwatch” option  
(Available in AcqKnowledge 4.2 and higher only) 
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In addition to the standard Gauge described above, the Segment Timer Gauge option offers an analog 
“Stopwatch” view of an acquisition in progress. As the recording progresses, a circular onscreen stopwatch 
gauge displays the elapsed time with a sweep-second indicator. All customizable parameters shown above for 
the default Gauge view are applicable to the Stopwatch view. A custom mapping for the Stopwatch view can be 
created, or use the pre-configured “Segment Timer Gauge” graph template in the Sample Data folder. 
 
Using the Segment Timer graph template – open the sample template in the following directory:  

Main drive\Program Data\Biopac Systems, Inc\AcqKnowledge 4.4\Sample Data\Segment Timer Gauge.gtl 

Clicking ‘Start’ will show the Stopwatch in progress. The template is setup to record ECG Lead II on CH 1 and 
is tied to a new Segment Timer calculation channel. However, no connections are needed to verify the segment 
timer and the template can be customized as desired. To change parameters, choose Preferences from right 
contextual menu with mouse positioned over the gauge window.  

When the recording is stopped, timer indicator will also stop. When the next recording segment begins, the 
segment timer will reset to 0. (This default can be changed in the Gauge Preferences). 

 
 

To configure a new Segment Timer Stopwatch view: 

1. Set up desired acquisition parameters and channels. 

2. Hardware menu > Set Up Data Acquisition > Channels > 
Calculation tab and choose the Segment Timer preset. 

3. Hardware menu > Show Gauge and open Preferences by 
right-clicking the contextual menu over the Gauge window. 

4. In the Gauge Preferences, choose “C0 – Segment Timer” for 
the Channel and “Stopwatch”, as shown on right. 

5. Choose the “Mapping” tab, enter the following Input to Angle 
mapping values and click OK: 
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6. Start the acquisition. Note the Stopwatch view will accurately reflect the time scale of the recording  

in progress. 

Autoplotting, Scrolling and Sweep Display Modes 
Checking or unchecking the Autoplotting, Scrolling and Sweep options controls how data is displayed on the 
screen during an acquisition. By default, AcqKnowledge displays the most recently collected data first, and if 
more than one screen of data is to be collected, then the time scale will “scroll” so that the newest data is always 
on the right edge of the screen. 
When Scrolling is disabled and Autoplotting is enabled, the screen will be cleared when the data reaches the 
right edge of the screen, and plotting is redrawn from the left. 
When both Scroll and Autoplot are unchecked, the incoming data will be plotted until the screen is full. Once 
the screen is full, data will continue to be collected, but only the first screen is displayed. By default, the 
hardware will display the first eight seconds of the data record, but this can be reset manually by changing the 
horizontal scale. To toggle Autoplot ON or OFF in the middle of an acquisition: 

 select Ctrl+T (Windows) or Command+T (Mac OS X) on the keyboard, or 
 Choose the MP menu and enable or disable “Autoplotting” 

Sweep display mode is similar to an oscilloscope sweep display in which data is plotted left to right, 
but old data remains visible on the screen while new data is incoming. This type of display is also seen 
in some clinical devices. 
In order for Sweep display to function: 

 Autoplotting must be enabled 
 Scrolling must be disabled 
 Sweep must be enabled 

In this configuration the old data remains visible while incoming data in the 
form of a black vertical line “sweeping” across the old data from left to right. 
The old data and horizontal time scale are redrawn with once the line sweeps 
across its axis. 
Limitations: Sweep mode when scale modifications affecting the vertical or 
horizontal scale are applied. This includes: autoscaling, show all data, adaptive 
scaling, zoom, window resizing, end of acquisition. Sweep can be toggled from 
the hardware menu during acquisition and is data view independent. The sweep 
state is saved in graph files and templates. 
Sweep mode is applicable in Scope, Chart, Stacked Plot, and Split View modes. 
It is not supported in XY mode. 

Manual, Autoscrolling and Sweep options can also be accessed via the , , or  button in the lower 
right region of the horizontal axis region. For full details on this tool, see Autoscroll Horizontal Axis Controls 
on page 52.  

“Sweep” mode cursor 
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Warn on Overwrite 
Selecting the “Warn on overwrite” option from the Hardware menu will generate a prompt each time you start a 
new acquisition: 

 
If you click “Yes,” then AcqKnowledge will erase your current file and overwrite with a new acquisition. If you 
don’t want to erase the file you’re working in, click “No” and then open up a new file to work in. 
This prompt will appear at the beginning of each acquisition when the hardware is in Save Once with repeats 
mode. “Warn on Overwrite” can be disabled by deselecting this option under the Hardware menu. 
Organize Channel Presets  

 
The Organize Channel Presets option controls the channel presets (established or custom) in the Hardware > Set 
Up Channels dialog; you can rename, rearrange or delete Presets. This option can be used to place the most 
frequently selected Presets at the top of the menu or group related Presets, such as established ECG Presets. 
Click a Preset description to select it, and then use the buttons to organize the Presets.  
Up and Down buttons move the selection one space at a time. 
Top and Bottom buttons jump to the start or end of the list. 
 Rename a Preset by typing in a new title and clicking OK. 

You can’t use any name currently used by a Preset or any name that matches a Calculation type 
(Integrate, Rate, etc.). 

  
Delete a Preset by selecting that option. You cannot delete the Default Analog Input preset. When you delete a 
Preset, you will be asked to confirm the request because it is an irreversible action.   
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Add Separator adds a new Separator entry to the Preset list and is useful for dividing different Preset types. If 
a Preset is currently selected in the list, the Separator will be added below it. (See diagram above) If no preset is 
selected, the separator will be added to the end of the list. Separators can be rearranged or deleted in the same 
manner as Presets. (AcqKnowledge 4.2 and higher only) 
The default location for Preset files is Computer > Local Disk > ProgramData > BIOPAC Systems, Inc > 
AcqKnowledge 4.4 > Presets. 
 
Exit Playback Mode 
This option is enabled when Open File for Playback (see page 43) has been selected. Select to resume 
acquisition functionality (change Playback menu to Hardware menu, Replay button to Start button).
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Part C—Analysis Functions 
OVERVIEW 
This part describes how to analyze data; in most cases, analysis is performed after the data has been collected. 
This involves creating, managing, and saving files, as well as editing data, performing mathematical 
transformations, and displaying data in various ways. Many of the functions covered here are also discussed in 
Part A—Getting Started. Features that can be computed during an acquisition (primarily transformations and 
calculations) are discussed in Part B—Acquisition Functions. 
For general information about sections of the graph window, and to become familiar with the “look and feel” of 
AcqKnowledge, turn to the Editing and Analysis Features chapter. Descriptions of functions can be found in the 
chapters describing each menu. All of the commands discussed here can be found under the File, Edit, 
Transform, or Display menu items. 
 

Menu See… Type of Commands 

File Page 248 General file management commands, including opening, saving, and 
closing files. Export data files. 

Edit Page 272 Cut, copy, and paste between and within files. Export data files. 

Transform Page 282 Operations that primarily modify the data in the graph. 

Analysis Page 313 Operations that primarily derive data and measurements from the graph. 

Specialized Analysis Page 348 A courtesy copy of the new Specialized Analysis package with 
automation and scoring routines is included under the Analysis menu. 

Display Page 427 Control how data appears on the screen either during or after an 
acquisition. 

Media Page 458 Capture and Playback controls to synchronize video/audio with data. 

 
Toolbars 
Many of the most commonly used features in AcqKnowledge can easily be executed with a mouse click. The 
toolbar contains shortcuts for some of the most frequently used AcqKnowledge commands; icons are grayed out 
when they are not applicable. Custom toolbars can be created by clicking the Customize Toolbars icon.  
 Click Display > Show > to view the toolbar options. Check a toolbar option to activate it. 
See page 57 for Toolbar icon definitions. 
 
Shortcuts 
Keyboard shortcuts are detailed on page 65. 
Mouse shortcuts are detailed on page 69, including contextual menus. 
  



248 AcqKnowledge 4 Software Guide 

Visit the online support center at www.biopac.com 

 Chapter 13 File Menu Commands 
Overview 

 
Most of the items in the File menu are standard menu items and follow the standard Windows conventions or 
Macintosh conventions. By default, all files are created and saved in the AcqKnowledge file format, a 
proprietary format used to store binary data. Data can be read in from either text files or AcqKnowledge files, 
and can be saved in text, graphic, or binary format. As a rule, storing data in the AcqKnowledge format saves 
information in the most compact format possible and takes up less disk space than other file formats. In most 
cases, you will probably be working with graph windows and saving data in the AcqKnowledge format. 
New 

Graph Window 
In almost all cases, you will need to create a new graph window before 
beginning an acquisition so that the data may be displayed on the screen. When 
a new graph window is created, you can modify any of the window parameters, 
including horizontal scale, vertical scale, window size and position. In addition, 
you can also set the acquisition parameters for sampling rate, number of 
channels, and acquisition length. These settings take effect once an acquisition 
begins.  
New > Graph-specific Journal 
Creates a graph-specific journal; see page 53 for details. 
 
New > Independent Journal 

Creates an independent journal; see page 53 for details. 
New > Data View 

Creates a new Data View for the active (frontmost) graph and names the window “Data View of 
‘Filename’.”  For Data View details, see page 44. 
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New > Batch Acquisition 
Use the Batch Acquisition feature to configure advanced experimental setups and acquire data from a 
sequence of templates. Each template in the Batch may have different acquisition settings, channel 
configurations, and stimulator setups. Use a Batch for long duration experiments with hardware setting 
changes across segments, to automate routines, or to run multiple experiments on the same experimental 
setup in succession. 
 For example, if an experiment has a preparatory period, a stimulus period, and a response period, three 

graph templates could be batched: 
 A template to acquire for the length of the preparatory period 
 A second template with a stimulator configured for the stimulus period 
 A third template to acquire the response period without stimulation 

All three templates could be added in sequence to a single Batch Acquisition, which would then acquire all 
of the data for all three templates with a single start. 
To create a new batch, choose File > New > Batch Acquisition to generate the Batch dialog. 

 

The Templates controls at the top allow you to add, 
remove, or re-order the templates. 
 Double click a template in the list to open the 

output graph from the most recent acquisition. 
 Batch acquisition cannot combine acquisitions that 

do not end, so the acquisition storage mode for 
template files cannot be set to “Save last,” 
“Autosave” or “Repeat forever.” 

 

Status 
N/A No status is available for the template, no batch acquisition has been performed. 
In Progress Data is currently being acquired for the template. 
Waiting A batch acquisition is in progress but has not yet reached the step where the template is used. 
Complete Data acquisition for the template has been finished successfully and has been saved to disk at 

the batch output location. 
Error A batch acquisition was aborted manually or due to communication errors. The data for the 

template may not have been saved or may be unreliable. 
Batch Errors 
Misconfigured templates and misconfigured averaging templates may generate the Adjust 
Length/Adjust Latency/Abort Acq warning prior to the start of acquisition. Clicking “Abort” 
will halt the batch acquisition. Misconfigured templates may result in those rare cases where 
data was acquired into a graph template with a different hardware configuration prior to saving 
the template to disk. 

Saving to: 
Use the “Change” button to specify the 
directory where the acquisition output should 
be saved. 

 
Use MP Unit: 
Specify the MP unit that should be used for the 
Batch Acquisition. 

This menu lists all of the available hardware units. 
Entire menu dimmed out while batch acquisitions are in 
progress. 
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Start/Stop Acquisitions  

Toggles to starts and stop batch acquisitions; dimmed when the specified MP 
unit is being used to acquire data unless it is a batch acquisition that is in 
progress. Batch acquisitions may be terminated by using either a control in the 
batch user interface or by clicking the “Stop” button in the graph window 
actively acquiring data for the current template of the batch. During the 
execution of an individual template acquisition, errors may occur that 
abnormally terminate that acquisition (i.e., communications errors with the MP 
unit, errors in calculation channel, disk errors, etc.). When the acquisition in 
progress is terminated due to an error, the batch acquisition will be halted as 
well.  

 If a batch acquisition is aborted early, the batch output directory 
will contain the full result graphs for all of the templates that were 
previously completed successfully. It will also contain a partial 
graph file for the template that was being used at the time the 
acquisition was aborted. Templates that were not used will not 
have any associated graph files. 

Resume  
When a batch acquisition is terminated prematurely, the acquisition may be 
restarted from the first template in the sequence or from where it was stopped 
(e.g. the template with the error status). 

Batch Acquisitions can be saved for use at a later time using File > Save Batch 
Acquisition As. Batch Acquisition files retain all of the settings for their 
individual templates and can be used even if the original templates used to 
configure the batch no longer exist or have been moved. Each template is 
acquired and saved into an output graph file that can be opened at a later point in 
time to examine the results.  
To open a Batch Acquisition, use File > Open and select type “Batch 
Acquisition.” 
When a batch acquisition is started, the templates will acquire data in the order indicated from the specified MP 
unit. Files are saved before the next acquisition is started. 

 If the batch acquisition completes successfully, the batch output directory will contain all of the 
graph files that were created during the acquisition. Each output graph is saved into a user-specified 
directory and is titled “Batch n - template name” where n is the order in the acquisition sequence. 
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Open 
The File > Open command generates the standard file open menu, and allows you to open a variety of different 
file formats from the popup menu at the bottom of the dialog.  

 
Multiple files 

To open multiple files in a single dialog, hold the Control/Command key down and select multiple files. To 
open consecutive multiple files in a single dialog, select the first file, hold the Shift key down and select 
multiple files. AcqKnowledge can only recognize one Journal file at a time, so multiple selection is disabled 
when the file type is set to Journal or Journal Template. 

Graph The default file formats (*.acq) is referred to as “AcqKnowledge” files. The 
AcqKnowledge file format is the standard way of displaying waveforms in 
AcqKnowledge. These files are stored in a compact format that retains information 
about how the data was collected (i.e., for how long and at what rate) and takes 
relatively little time to read in (compared to text files, for instance). AcqKnowledge files 
are editable and can be modified and saved, or exported to other formats using the Save 
as command. Format options for the graph file include 

• Graph—AcqKnowledge 4 
• Windows AcqKnowledge 3 Graph—previous release format 
• Macintosh AcqKnowledge 3—previous release format 
• Biopac Student Lab PRO Graph—import files created using the Biopac 

Student Lab PRO software; to open BSL Lesson files (.ldd), manually add the 
extension “.acq” to the end of the file. 
BSL File Import Notes 

BIOPAC produces two different software lines, the AcqKnowledge software 
for research and the BSL software for higher education. These two 
applications use different file formats, making it difficult to analyze data 
recorded in one with the other.  

AcqKnowledge can directly import data files that were created in Biopac 
Student Lab PRO. This allows data acquired with an MP36, MP35 or MP30 to 
be analyzed using the advanced analysis routines of AcqKnowledge.  

Hardware and calculation channel settings are also imported. This allows for 
the migration of some BSL PRO templates to AcqKnowledge. Only basic 
analog, digital, and calculation channels can be acquired; templates that use 
any of the BSLSTM or other output options are not supported. 

Importing is limited to graph files created with BSL 3.6.6 or higher. It is not 
possible to import files created with earlier versions of BSL. To import from 
earlier BSL versions, those files must first be opened with BSL 3.6.6 or higher 
and re-saved to disk to update the file format. The updated files can then be 
imported directly into AcqKnowledge. 
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When saving files, AcqKnowledge must save using the AcqKnowledge graph 
file format or another available export format. It is not possible to open 
AcqKnowledge graph files with BSL Lessons or BSL PRO. 

Template Graph Template files (*.GTL)  
This powerful feature allows for creation of a template file with predefined experiment 
parameters. Simply click “Start” to run the experiment.  
The Graph Template option allows you to open a copy of a master file so you can 
maintain the master settings. Graph template files open to previously saved setup 
parameters (as established under the Hardware menu) primary graph window size.  
This feature can be especially useful for recreating protocols in the laboratory. You can 
Set Up an experiment and save it as a Graph template, then simply open the Graph 
template file and click the Start button to acquire data under the same settings. 
When a Graph template file is opened: 

a) The graph window will not contain any data. (Since no data is saved in the 
template, arbitrary waveform output setups, which require a source date file, 
will not function in a template.) 

b) The journal window will contain text you entered and saved with the 
template—this is a handy way for you to place instructions or information 
about the experiment for yourself or others. 

AcqKnowledge “Quick Start” (*.gtl graph template) files are available for over 40 
applications. Just open the graph template file to establish appropriate settings for the 
selected application, and then click Start. Quick Start files were installed to the Sample 
Data folder and can be used to establish the settings required for a particular application 
or as a good starting point for customized applications. 

Text .TXT. Text files are a convenient way of transferring information between applications, 
and most spreadsheet and statistics programs are capable of importing or exporting data 
in a text file format. AcqKnowledge assumes that the text file contains numeric data laid 
out in columns and rows, and that there is some delimiter between each column. It also 
assumes that each column represents a distinct variable or channel of data. Normally, 
the values in each row represent the state of each variable at different points in time. 
When a text file is opened, the numeric values will be plotted as waveform data in a 
standard graph window and non-numeric values will be ignored. Each column of data is 
read in as a separate channel. 

Journal *.JCQ—Opens an independent journal; see page 53 for details. 
Open the journal file from the File Menu (File > Open > Journal); right-clicking or 
double-clicking a saved Journal file will open a blank application window. 

Jrnl 
Temp 

*.JTL—Opens a journal template; see page 53 for details. 

 Options 
When the Files of type: Text option is select, an Options button is activated. Clicking on 
this button generates another dialog that allows you to control the amount and type of 
data to be read in, as well as the time scale for data display. 

 

N
O
T
E 
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Wave data starts on line 
 To control how much data is read in, enter a value in the read line box at the top of 

the dialog. This tells AcqKnowledge which row contains the first data point in the 
series. By default, this is set to 1, although you may want to set it to another value 
since some applications (usually spreadsheets) generate a “header,” or text 
information at the top of a file. You can also read in a limited amount of data by 
entering a value in the box to the right of the line box. This value indicates the last 
line to be read in as data. By default, text files will be read in starting at line one 
and data will continue being read in until the end of the file is reached. 

Interval 
 To control the horizontal scale (usually time) for the text file after it is displayed in 

the graph window, change the Interval between sample points, which can be 
expressed either in terms of time or frequency. The interval between samples is 
equal to the reciprocal of the sampling rate; Interval = 1/(Sample Rate). For 
example, if data was collected at 50 samples per second, there is an interval 
between sample points of 0.02 seconds. AcqKnowledge would then assume that 
there is a 0.02 second “gap” between the data point in row two and the data point in 
row three (and all subsequent pairs of adjacent rows). Likewise, if you have a data 
file that spans 10 seconds and has 100 rows of data, the interval between sample 
points will be 0.01 seconds. 

 Most files contain time domain data, although some applications generate 
frequency domain data (the results of a spectral analysis, for example). The 
principle here is the same as with time data, that there is some interval between 
different frequencies. If a text file contains 20 sample points covering the range 
between 0 and 60 Hz, then the interval would be set to 3Hz per sample. 

Column Delimiter 
 This setting tells AcqKnowledge what characters indicate a “gap” between two 

columns. This can be set to tab, comma, or space. All text files must have some 
sort of column delimiter, unless there is only one channel of data present. 
 Tab delimited text files —the most common type— have a tab between each 

column for every row of data. These files are most often generated by 
spreadsheets and similar packages. 
 Comma delimited files place a comma between each column of data for each 

row, much the same way as a tab delimited file. Statistics programs such as 
BMDP and SAS frequently create these types of files. 
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  Space delimited files are also commonly created by statistics packages, and 

place some number of spaces (usually two) between each column of data for 
every row which contains information. 
 None. If you are not sure which delimiter to use, select “none” and 

AcqKnowledge will automatically select a delimiter. 
When either tab or comma is selected, AcqKnowledge will read in a new column 
each time it sees a delimiter, even if there are no numeric values between 
delimiters. For example, the following text file will read in three channels of data, 
although the channels will be of different lengths. 

0.301424, 0.276737, 0.045015 
0.338723, 0.808811, 0.542627 
0.354271, 0.506313, 0.715995 
0.001325, 0.762115 
946207, 0.894992 
0.926409, 

 Sample text file 
The first channel will contain six data points, the first being 0.301424 and the last value 
being 0.926409. The next channel will contain three data points, starting with 0.276737 
and continuing through 0.506313. The software considers that there is no other data 
values for channel two. The third channel starts with the entry 0.045015 and the last 
data point for this channel is 0.894992. There are only five data points in the last 
channel. 

AVG  Advanced Averaging Experiment—not supported in AcqKnowledge 4.0. 

PhysioNet PhysioBank is a public service of PhysioNet and offers downloadable archives of 
gigabytes of “standard” data for cardiac arrhythmias, gait analysis, and other types of 
physiological signals. AcqKnowledge can use PhysioBank data directly and can be 
integrated with other software tools that understand this interchange format. 
A PhysioBank file is usually comprised of several files, including a header file (usually 
“*.hea”), and all of the files must be located in the same directory for the PhysioBank 
record to open successfully. Open using the header file. 
Opening a PhysioNet file will import data and annotations into a new graph window. If 
“atruth” annotations exist, they will be translated into appropriate events on the 
appropriate channel. All annotation types are retained except LEARN annotations, 
which are treated as UNKNOWN. 

MAT MATLAB® format AcqKnowledge can open files created as a MATLAB work space. 
 Windows™ can open MATLAB v6 compatible MAT files, including MATLAB 7 

if the “v6” flag is specified in MATLAB before saving. 
 Interoperability with earlier versions of MATLAB is not guaranteed. 

Uses the “MAT-file” binary format to load numerical and textual information. If the 
MAT-file is properly formatted with the following arrays, AcqKnowledge will 
reconstruct the graph with appropriate sampling rate, channel labels, units, and data: 

data units labels isi isi_units start_sample 
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 MATLAB files open with no Start button. 
 If the MAT file is missing any of the 

expected variables or contains extra 
variables, only one two-dimensional array 
variable can be imported into a graph. A 
MATLAB Import Options dialog will be 
generated. Choose which variable data is 
stored in, what dimension maps to 
samples, channel indices, and sample rate, 
and then click OK to open the file. 

 If AcqKnowledge can’t recognize the file 
format, an error prompt will be generated 
and a blank graph window will be opened. 

 

 
 

Raw This low-level data exchange option interprets all data at a single sample rate; variable 
sample rates are not supported. All of the data will be unscaled when opening 
(importing) files. That is, a value of 0 will be imported as a zero voltage. Scaling will 
need to be manually applied to the data. Options to open (import) raw data: 

Data type: 32-bit or 64-bit IEEE floating point format or 8-, 16-, and 32-bit 
integer formatted data 

# of channels: Enter the number of channels stored in the data file as a positive 
integer less than or equal to 60. 

Layout: Packed sequential: All of the data for an individual file is located in 
a single block of the file and multiple channels follow one another. 

 Interleaved: Data is grouped into a single “frame” for each sample 
location with one data element for each channel, so data for a 
particular channel is spread throughout the file (similar to Linear 
PCM audio file format). 

Endian: Little and big endian byte ordering, matching the data formats of x86 
and PowerPC/Sparc, respectively. Set to big for Mac-Power PC 
generated raw files (default), or to little for Mac-Intel generated or 
Windows-generated raw files. 

Set to x/sample: Specify the inter sample interval of data in the file, which will be 
translated into an appropriate sampling rate. The edit field will 
accept an arbitrary floating point number. The units menu contains 
μsec, msec, sec, MHz, kHz, Hz. The edit field will be dynamically 
converted to match the units selection; no conversion will be used 
when switching between frequency and time. 

Batch Batch files (*bcq) is the format used for a saved Batch acquisition setup. All previous 
configurations are saved in this file, so a Batch experiment can be rerun without having 
to repeat the setup. When a saved Batch file is opened, the batch setup window appears 
with previous graph templates intact. From here, the setup can modified and saved 
under the same or a different name. 

Igor Pro Igor Pro Experiments (compatible with Igor Pro 3.1, 4.0, and 5.0). 
The waves contained in an Igor Pro packed experiment can be opened (imported) in 
AcqKnowledge provided that the packed experiment files comply with the following: 
 no text waves 
 no complex waves 

 all waves in Version 2 or Version 5 format (Igor defaults) 
 all waves one-dimensional (vectors) 
 all waves multiples of the same fundamental inter sample interval 

If the wave has an associated wave note, it will be used as the channel label. 
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WAV WAV files containing 60 channels or less can be imported. When this format is chosen, 

the list of available files will be filtered such that only files ending in the”.wav” 
extension or having the “WAVE” type are shown. When a WAV file is selected, it will 
be analyzed to determine if it is compatible with the AcqKnowledge application. 
If the file is compatible, a new graph window will be created displaying the data 
contents of the WAV file. 

• Each channel will be numbered “Channel n” where n is an increasing digit. 
These channels will be unitless in amplitude. 

• All of the data will be converted into the 64 bit floating point format for storage 
in memory and in the ACQ formatted files on disk. 

• The horizontal axis of this graph will be set to time and the sampling rate set to 
match the rate as specified in the WAV file headers. 

• This graph will be marked as an imported graph into which data cannot be 
acquired. 

 
• This will dim the start button and any appropriate hardware menu entries that 

would be used to access the invalid hardware settings. 
EDF Opens files with .eeg and .edf extensions saved in European Data Format (EDF). Data is 

imported entirely into memory in a newly created graph window titled after the 
filename, similar to other file import routines. All scaling factors will be applied to the 
data as it is imported, and it will be converted to double precision floating point format. 
Since EDF format includes data that is not used by AcqKnowledge, only the following 
items are imported: 

• channel data 
• channel labels 
• units 
• sampling rate (taken from maximum sample rate of all channels) 

All other information stored in the EDF file will be discarded when the file is imported. 
Only 60 channels of data can be imported from an EDF file. Channels will be imported 
starting with the graph file index 1. If there is a 60th channel, it will be placed into the 
channel with index 0. If an EDF file contains more than 60 channels, only the first 60 
channels will be imported and a prompt will advise that not all of the channels could be 
imported. 

ACT Opens actigraphy files generated from analysis of existing accelerometer data files 
related to sleep studies and wake/sleep activity. Actigraphy licensed functionality is 
required for this file format to be active. For information on Actigraphy, see page 519. 

BBS Opens Biopac Basic Scripting files. Biopac Basic Scripting licensed functionality is a 
scripting language development option for AcqKnowledge. For more details, see page 
484. 
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Open Recent 
The File > Open Recent command generates a list of recently used files. These files can be opened directly from 
the list or with a Ctrl (PC) or Command (Mac) keystroke combination.  

 
The listed files appear in the order they were opened, with the most recently-opened file appearing at the top. 
Default number of files appearing in the list can be modified in the Preferences. (Display > Preferences > Other 
or Main Toolbar) 

Open for Playback 
The File > Open for Playback command generates a standard file open dialog; see page 43 for Playback details.  
SMI BeGaze Import 
This option allows for import of SensoMotoric 
Instruments BeGaze software’s eye tracking data and 
aligns the data with other physiological signals 
recorded in AcqKnowledge. In order to use the SMI 
BeGaze Import feature in AcqKnowledge, the BeGaze 
eye tracking data must first be exported to a text file 
format readable by AcqKnowledge. (BeGaze software 
offers text file export of the eye position, pupil width 
measurements, analyzed data and eye tracking events.)  
BeGaze eye tracking data can then be imported into an 
existing AcqKnowledge graph, a new graph, or aligned 
to existing data.  
To use TTL display trigger synchronization, the digital 
output line from the SMI hardware must be connected 
to the hardware unit used for recording record data, 
and digital channels must be enabled during data 
acquisition. The time of the first image presentation 
within the BeGaze data will be placed at the first 
positive peak within the digital signal. The software’s 
timestamp alignment will extract the recording time 
from the BeGaze data and align it with the internal 
AcqKnowledge timestamps. For more details about 
timestamp alignment, see page 258. 
When importing and aligning data to an existing graph, physiological data must be recorded into a single 
segment. Data recorded as multiple appended segments will not be properly aligned.   
BeGaze exports may contain only a subset of the recorded and analyzed data. Signals not present in the export 
file will be removed from the 'Signals to import' checkbox options. 



258 AcqKnowledge 4 Software Guide 

Visit the online support center at www.biopac.com 

Importing SMI Begaze Data into AcqKnowledge 
To import SMI Begaze eye tracking data into AcqKnowledge: 

1. In Begaze software, export the eye tracking data to *.txt format and save the file. 
2. Launch a new graph in AcqKnowledge or open an existing graph for BeGaze data import. 
3. In AcqKnowledge, choose “File > SMI BeGaze Import” and navigate to the *.txt file exported in Step 1 

and click “Open.” This will launch the SMI Data Import setup screen. 
4. Under “Import data into:” choose the AcqKnowledge destination graph for SMI Begaze data import. 
5. Choose the desired aligment option (digital trigger signal, timestamps from AqcKnowledge and SMI 

data, or no alignment.) 
6. Select the eye tracking signals and SMI events to import and click “Import.” 

The selected SMI signals and events will be placed into the AcqKnowledge graph at the appropriate locations. 
Note: The SMI Begaze Import feature is available in AcqKnowledge 4.3 and higher only. 

 Watch the AcqKnowledge SMI BeGaze import and synchronization video tutorial for a detailed 
demonstration of this feature. 

Using the Software Timestamps Option to Align Data 
If the existing AcqKnowledge graph and SMI *.txt file selected for import were recorded in different time 
zones, selecting the “software timestamps” option helps compensate for the timezone disaparity and aligns the 
data accordingly. In order for the timestamp alignments to be accurate, it is essential to know the timezone the 
SMI *.txt file was recorded in. (The “export timezone” default setting is determined by the clock time/date 
properties of the AcqKnowledge computer.) However, if the SMI eye tracking data was exported from another 
computer in a different timezone, changing the “export timezone” parameter to match that timezone will help 
properly align the imported data with the current timezone of the AcqKnowledge graph. This is best illustrated 
in the following example. 
In this example, the exported SMI BeGaze eye tracking data selected for import into AcqKnowledge was 
recorded in the “Europe/Berlin” timezone, while the AcqKnowledge graph was recorded in the “America/Los 
Angeles” time zone. To synchronize both files timestamps to the current timezone: 

1. Follow Steps 1-4 from above (“Importing SMI BeGaze Data”). 
2. Under “Align to existing data,” select the “software timestamps” option. 

 
3. Scroll down the “Export timezone” list and select “Europe/Berlin.” (Or an applicable timezone.) 

 
4. Click “Import.” 

If the AcqKnowledge graph and the SMI BeGaze file selected for import were recorded/exported in the same 
timezone, it is not necessary to use the “software timestamps” alignment option. In this intance, choose the “No 
alignment” option. 

Dataquest Import 
Dataquest ART is a data acquisition software package from Data Sciences International (DSI). This package is 
used with a variety of devices including implantable telemetry units. The File > Dataquest Import option allows 
data acquired from ART files to be directly extracted into AcqKnowledge. The following Dataquest file 
information is supported and retained in AcqKnowledge: 

• Data accuracy 
• Retention of animal IDs 
• Import of either waveforms or parameters 

http://www.biopac.com/video/?video_category=data-integration&v=smi-begaze-import-and-synchronization�
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• Provides choice of animal subects to be imported 
Datquest File Description 
Unlike graph files, Dataquest ART saves data as multiple files in a single directory. Each file may be either a 
continuous recording or consist of multiple segments. 
A recording may contain multiple animals/subjects. Each animal/subject is given an animal ID. This animal ID 
forms the basename of all of the various Dataquest data files. 
Two primary types of data are recording for each animal: waveforms and parameters. Waveforms are the semi-
continuous raw data recorded from transmitters during the segment. For multi-channel recordings, each channel 
may have an independent sampling rate and the sampling rate may vary within an individual channel for an 
individual experiment, but the duration and recording frequency are identical across all channels and animals.  
Parameters are derived measurements such as heart rates, mean pressure, and other values derived from the raw 
data.  The user's protocol may dictate which type of data will be useful in the analysis, but many DSI customers 
perform further data reduction on the parameters instead of working with the raw data. 
Dataquest splits waveforms and parameters up into separate files. Specific ID parameters are stored into a 
sequence of files named “ID.P##” where ## is a continual incrementing sequence of alphanumerics 0-9A-Z.  
Each individual waveform is stored into a series of files named “ID.C##.” C is a single character indicating the 
channel number 0-9A-F, for up to 16 channels.  ## is a continual incrementing sequence of alphanumerics 0-
9A-Z, similarly to parameter files. 
Each individual parameter or waveform file may contain data from multiple segments. A new file is created 
once the size of a particular storage file reaches a user-specified limit. The total number of files, therefore, does 
not necessarily equal the number of segments. 
The data for each specific segment in the file also contains a timestamp indicating the calendar time of the 
beginning of the segment. 
Creating Graphs from Dataquest Data 
Although related, waveforms and parameters are very different types of data. AcqKnowledge primarily stores 
and analyzes continuous signals. As parameters are not continuous signals, they are not easily combinable with 
waveforms in a single graph. Therefore, parameters and waveform data are imported differently. 
Waveform Graphs 
Waveform graphs are imported with waveform data within individual channels. Dataquest waveforms may have 
different sampling rates for each individual waveform and potentially varied sampling rates within an individual 
waveform. The imported graph’s sampling rate will be set to the highest sampling rate of all segments of the 
file.   
If a file contains multiple animal units, you can control which animals should be imported. By default all animal 
units are imported into a single graph. 
Each data segment is seaparated by an append marker to allow the use of Find Cycle across discontinuous data 
segments. The append marker label corresponds to the segment timestamp of the in the local time zone.   
For each animal with ID, the individual channels are imported with labels as “ID – label” if the DSI file 
contains a label for the channel. If there is no label is found, it will be labeled with its index “ID – Channel C” 
where C is the index from the beginning of the specific DSI file extension. 
Parameter Graphs 
Parameters are stored by Dataquest as one set of numbers per segment. Parameter graphs are imported using the 
same approach as rate detector XY output graphs. The graph will be set up as an arbitrary horizontal axis 
labeled “segment index.” Each parameter will be imported into a single graph channel, with the channel named 
“ID – Param,” “ID” replaced with the animal ID, and “Param” replaced with the name of the parameter as read 
from the Dataquest DSI file.  The parameters are then imported as data points. 
Only subsets of animals may be chosen; all parameters will be imported for the chosen animals. Users wanting 
a subset of parameters may optionally erase or hide graph channels after the data is imported. 
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To Import Dataquest files into AcqKnowledge: 
1. Choose “File > Dataquest Import.”  

 
2. Navigate to the Datquest file and click “Choose.” 

3. Make the desired selection in the Dataquest Import dialog and click OK. 

 

Close 
This File menu command will close the active file window and prompt you to save if necessary.  

 
Close without saving 

 Windows—click the  in the upper right corner of the file window 

 Mac OS X—click the  in the upper left corner of the file window 
Click “No” when AcqKnowledge asks you if you want to save the changes. 

Close during acquisition 

 
Close multiple data views 

Set the level of close functionality under Display > Preferences > Other or Main Toolbar. 
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Save 

  
This menu command will save any changes made to a file. If more than one file is open, this command only 
applies to the active window. For untitled files, you will be prompted to name the file you wish the data to be 
saved in. The file will remain open after you have saved it, allowing you to continue working.  

• The Save menu is dynamic and corresponds to the type of file you are trying to save, i.e. Save Graph, 
Save Journal. 

Files should be less than 2 GB, except AcqKnowledge 3.9 “Graph” files on the Mac, which can be larger if not 
compressed. Data files greater than 2 GB can be opened, but edit, transformation and analysis operation cannot 
be performed. 
To save data in another format (such as a text file), use File > Save As. 
 
Save As 

Choosing File > Save As produces a standard dialog that allows you to 
save data in a variety of different formats and to any location. As with all 
save last dialogs, you can use this to save a file to a different file name or 
directory than the default settings. 
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Graph AcqKnowledge format 

The default file format for the File > Save as command is to save files as an 
AcqKnowledge 4 file, which is designed to be as compact as possible. These files can 
only be opened by AcqKnowledge 4, but data can be exported to other formats once it 
has been read in. 

• To save in the previous release format, choose Windows AcqKnowledge 3 
Graph. When a file is saved in AcqKnowledge 3 format, the following 
calculation channel types will revert to Integrate: Band Stop Comb Filter, 
Adaptive Filter, FLC, WFLC, CWFLC, Rescale and Metachannels. 

File Compatibility  
Windows AcqKnowledge cannot save as Macintosh AcqKnowledge files. 
Macintosh AcqKnowledge 3.9 and above can save as “Graph (Windows)” files, but it 
saves in Windows AcqKnowledge 3.7.1 format. In this earlier format, all data is 
retained, but new Windows AcqKnowledge features (like dual stimulation, data 
views, embedded archives, etc.) are lost along with any settings specific to Macintosh 
AcqKnowledge (like events, adaptive scaling settings, etc.). 
 Macintosh AcqKnowledge 3.9 and above can save PC-compatible Graph (*.acq) 

and Graph Template (*.gtl) files. Variable sampling rate information and 
hardware settings are retained, and Journals can be read from and written to PC 
files. Choose the format “Graph (Windows)” to create PC-compatible files. 

The Mac version does not save PC GLP files or compressed PC files.  

GTL Graph Template 
This feature can be especially useful for recreating protocols in the laboratory. You 
can Set Up an experiment and save it as a Graph template, then simply open the Graph 
template file and click the Start button to acquire data under the same settings.  

TIP: Check the existing Quick Start template files listed on page 252 before 
creating or saving a new template. With over 40 templates provided, you 
may find one to establish the settings required for your particular 
application or to use as a good starting point for customized applications. 

The Save As Graph template option saves the setup parameters established under the 
hardware menu and retains the size of the primary graph window. In general, the 
minimum file size for graph templates is 700 K-800 K; file size may increase as setup 
options are enabled. 
When a file is saved as a Graph Template: 

a) No graph data will be saved. 
• Since no data is saved in the template, arbitrary waveform output 

setups, which require a source date file, will not function in a 
template. 

• You must select Save / Save as and select “File of type .ACQ” to 
save the graph data. 

b) Journal text will be preserved. Any text you entered will be saved to the 
Journal window and stored with the template—this is a handy way for 
you to place instructions or information about the experiment for yourself 
or others. 

When this feature is used with the menu.dsc customization feature it is easy to comply 
with GLP standards and save your protocol as an SOP. When you change the menu.dsc 
file for a graph template file, save the “menu.dsc” file with the exact same name but 
save it to the new lesson folder you have created. For full GLP features, contact 
BIOPAC about the Lab Assistant GLP System. 

N
O
T
E 



Part C — Analysis Functions 263 

AcqKnowledge 4 Software Guide 
 

TXT Text  
Saves graph data in text format. When Save As Text is selected, an Options button is 
generated. Clicking on this button generates a Save Options dialog that allows you to 
control how much data is saved and the format it is saved in.  

 
Include header 

When the first box is checked, a “header” is included at the top of the text file that 
contains information about the sampling rate, number of channels, date created, and 
other information relating to the data. This information is frequently useful, but some 
programs will attempt to read in the header information as data, which could result in 
nonsensical results. You may wish to include the header as it can always be edited 
out later using a text editor or the journal. 

Horizontal Scale 
The second checkbox allows you to include the horizontal scale (usually time) values 
in the text file, along with the data to be saved. This allows you to produce time 
series plots in other applications, as well as correlating events to time indexes in 
graphing and statistical packages. Since a separate row is generated for each sample 
point, To exceed the limitations of programs if data is collected at a fast sampling 
rate (many spreadsheet programs are limited to about 16,000 rows). You may wish to 
consult the section on resampling data after an acquisition is completed (page 308 ). 

Delimiter 
When data is saved as a text file, each channel of data is saved as a separate column, 
with the number values for each data point saved in rows. Use the pop-up menu to 
select the delimiter to separate the columns of data in the text file. By default, a tab is 
placed between each column for every row of data; this format is called a tab-
delimited text file and almost all applications will read in tab-delimited text files. 
However, you may also save data in a comma-delimited format or a space-delimited 
format. 

Line ending 
Use to create text files that are compatible with Classic Mac OS applications (Mac), 
Unix-compatible applications (Unix), or PC-compatible applications (DOS). 

Precision 
Use to define the number of significant digits used for the horizontal scale when 
pasting wave data. Very high sampling rates may require more than the default value 
of 6 digits to accurately resolve the inter-sample interval. 

PhysioNet This format requires that the WFDB library is on your computer. PhysioBank is a public 
service of PhysioNet and offers downloadable archives of gigabytes of “standard” data 
for cardiac arrhythmias, gait analysis, and other types of physiological signals. 
AcqKnowledge can use PhysioBank data directly and can be integrated with other 
software tools that understand this interchange format. 
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Saving a file in PhysioNet (WFDB) format will export the entire contents of the graph 
to a PhysioBank record. The record will consist of multiple files, all in the location 
specified for export. There will be a header file (*.hea) and a single data file for each 
channel of the graph (starting with “d” and ending with the base name of the header 
file). The files must not be separated for a successful move or copy. 
Export Limitations 

Precision Some precision may be lost due to differences in binary representation 
between AcqKnowledge and PhysioBank formats. 

Events Events will not be exported to the PhysioNet format. 
Channels Only 32 channels of data can be exported from a graph (the max allowed 

in a PhysioBank file). 
Rate If you are exporting a graph that uses variable sampling rates, all of the 

channels in the exported file will be downsampled to the lowest waveform 
sampling rate of the source graph. 

*.MAT 
MATLAB 

MATLAB® format. Uses the “MAT-file” binary format to save numerical and textual 
information as Filename.mat. 
 Windows™ create MATLAB Version 6 files, which are compatible with both 

MATLAB Version 6 and MATLAB Version 7. 
 Interoperability with earlier versions of MATLAB is not guaranteed. 
The following variables will be in the workspace when the file is opened in MatLab. 

data Contains the data of the graph in floating point format, for all of the 
channels of the array. The first dimension of this array is the amount 
of data in each channel, the second dimension increments with each 
channel. Therefore, each column contains a full channel of data that 
can be accessed in MATLAB via data (1:length, [channel number]). 

units This string array contains the textual representation of the units of 
the samples stored in data, with one element per channel of data. 

labels This string array contains the labels of each of the channels, with one 
element per channel. 

isi This floating point array of one element gives the number of units of 
a single inter sample interval of the data. 

isi_units This single string array provides a units string for a single unit of isi. 
Time data will always be “ms,” frequency data will always be 
“kHz,” and other values will be represented by an Arbitrary 
horizontal axis type in an ACQ graph. 

start_sample Contains the time offset of the index 0 sample of data in isi units. 
This will be 0 for many graphs, but if only a selected area of a graph 
was exported into the MAT file, the start_sample will contain the 
offset from the original data corresponding to the start of the data 
array in the MAT file. 

Raw Options to save (export) data for low-level data exchange are: 
Data type: 32-bit or 64-bit IEEE floating point 
Layout: Packed sequential: All of the data for an individual file is located in a 

single block of the file and multiple channels follow one another. 
 Interleaved: Data is grouped into a single “frame” for each sample 

location with one data element for each channel, so data for a particular 
channel is spread throughout the file (similar to Linear PCM audio file 
format). 
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Endian: Little and big endian byte ordering match x86 and PowerPC/Sparc data 
formats, respectively. To exchange with Windows applications or Mac-
Intel, set to little endian; to exchange with standard Mac applications, set 
to big endian. 

 
Raw Data Export Limitations 

Formats Raw export only allows data to be saved in 32-bit and 64-bit IEEE floating 
point format. 

Rates All files will be interpreted at a single sample rate; variable sample rates 
are not supported. If a graph with variable sampling rates is exported, 
channel data for downloaded channels will be padded to match the highest 
waveform sampling rate. 

Length If channels have unequal lengths, the overall file length will match the 
longest channel. Shorter channels will be padded at the end using their 
final sample value so that all channels contained in exported files will be 
equal in length. 

Scaling When integer-valued analog channels are exported from AcqKnowledge to 
raw files, all relevant scaling and offset will be applied—the data in the file 
will appear the same as if the channel had been internally converted to 
floating point format before export. 

 If the value of a channel is outside the maximum/minimum value that a 
chosen export data type can represent, the value will be clipped 
accordingly. (AcqKnowledge uses a 64-bit data type, so this should only be 
a problem if exporting to 32-bit floating point values.) 

Igor Pro Igor Pro Experiment format. 
An AcqKnowledge graph will be saved (exported) to a single packed experiment file, 
with each channel saved into a separate Igor wave that preserves the channel label, 
waveform sampling rate, and unit information. Vertical units will be stored as data units, 
and horizontal units will be stored dimension units; extended units are supported. The 
scaling of each wave will be adjusted to match the waveform sampling rate. All data 
will be stored in 64-bit floating point format in a one-dimensional wave. The waves will 
be named incrementally from “wave0” and the channel label will be stored in the wave 
note field. Files will have the type/creator pair “IgsU/IGRO” and a .”pxp” extension will 
be added to the file name for compatibility with Igor Pro for Windows™. 

WAV This option saves the graph data into a WAV audio file for exchange with other 
applications. The .”wav” extension will automatically be added if the save as filename 
does not end with it. 
The “Selected area only” checkbox will be active for WAV export. When checked, only 
the highlighted area will be exported to the WAV file. The final sample of this range is 
not included in the export, mirroring the other file export routines of AcqKnowledge. 
All exported WAV files use the 64 bit floating point format. This format preserves full 
operational precision. Most audio applications should be able to support floating point 
WAV files. Exported data will not be normalized when it is exported. Any 
normalization to audio ranges should be performed prior to exporting the data. 
WAV files are normally either one or two channels (e.g. mono or stereo). 
AcqKnowledge graph files, however, usually contain more than two channels. Although 
they can contain more than two channels, most audio applications may not be able to 
recognize these multiple channel files. 

• If a graph file contains only one or two channels of data, a WAV file will 
automatically be created without further interaction. 

o Graphs with a single channel will result in mono WAV files. 
o Graphs with two channels will result in stereo WAV files. 
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• If a graph contains more than two channels, the user will be presented with the 
following choice: 

 
o all channels—create a multiple-channel WAV file with one channel per 

channel of data in the graph. While this WAV file may be easily opened 
by some applications, it may not be fully compatible with audio 
applications and other applications expecting two channels or less. 

o selected channel only—create a single channel mono WAV file using 
only the data of the selected channel. This will be the selected channel 
in chart mode, the active channel in scope mode, or the vertical channel 
in X/Y mode. This single channel export may be useful for exporting 
audio channels that are recorded along with physiological data, such as 
heart sounds, audio stimuli, and the like. 

After a WAV file is exported, the WAV file will not be reopened; the open graph will 
be left unmodified. To view the exported file, import the WAV file. 

EDF Saves file in European Data Format (EDF). The saved file will automatically have an 
.edf extension added onto it if the user did not include it. Users will be able to save 
either the entire graph or only a selected portion of data. 
AcqKnowledge does not retain sufficient information to accurately complete an EDF 
header. When exporting, the following default values will be used: 

EDF Header Element Default 
subject ID Empty* 
recording ID Empty* 
recording date Set to the modification date of the graph file on disk. 

If no graph file is on disk, the current date is used. 
recording time Set to the modification time of the graph file on disk. 

If no graph file is on disk, the current time is used. 
transducer description Empty* 
filter description Empty* 
 * Empty: indicates that the field will be left blank 

All other fields will be filled with corresponding information from the graph, including 
channel titles, sampling rates, channel units, and scaling factors. Variable sampling rate 
information will be preserved as it can be expressed in the EDF format. 
EDF is used by many applications and online recording databases to store information, 
particularly EEG recordings. EDF is an open file format originally developed for sleep 
studies. It stores continuous time recordings of data in a binary format. Since its original 
proposal, EDF has been adopted by a number of open source and commercial tools as a 
supported data file format. Usage has also expanded beyond sleep studies into other 
types of recording.  

JPG AcqKnowledge also supports formats for saving graphical information. Most drawing, 
page layout, and word processing programs can read .JPG files. This is particularly 
useful for writing reports. A. JPG file can be opened in any standard drawing program 
and can then be embellished or used to highlight any particular phenomena of interest.  
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When data is saved as a graphic, only the data currently on the screen is saved. So, if 
you have a data file that spans eight hours but only two minutes is displayed on the 
screen, only two minutes of data will be converted to a graphic file. Since 
AcqKnowledge uses information about the computer screen in creating the graphic file, 
the default resolution of the file will be the same as the window. Most word processors 
and graphics packages allow for some way to resize and scale graphics. 

Compressed Saves a compressed AcqKnowledge formatted file. The degree of compression varies 
based on data characteristics, but will generally achieve about 60% compression. Saving 
small files (less than 200K) may have little effect. Using a sample file as an example: 

 
Compressed graphs no longer allow data acquisition and will open with no Start button. 
A warning prompt will be 
generated when you try to 
compress a graph in which 
data can be acquired (Start 
button active): 

Excel 
Spread-

sheet 

Excel Spreadsheet Export—Graph data can be saved directly to an Excel spreadsheet by 
using the Excel Spreadsheet format in File > Save As. Each channel will be placed into 
its own column of the spreadsheet. Also available for File > Save Journal Text As, Find 
All Cycles journal, and Specialized Analysis tools. 

Note  The Excel spreadsheet option requires Excel or a compatible spreadsheet 
application that can read Excel files (OOo, Symphony, etc.). If Analysis results 
are exported to an Excel spreadsheet, and a compatible application is not 
available, results will open as a text document the data and nonsense characters.   

Save Selection As 
To save only the data that has been selected with the I-beam tool, choose File > 
Save Selection As; this option saves the selected area to another file and does 
not affect the current file that you are working in. Specify file name and file 
type and then click Save. 
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Save Journal Text As 

 
Choosing File > Save Journal generates a save dialog to save the journal text as a separate file. Specify file 
name and file type and then click Save. 

Journal 
  

Text (*.TXT) format—Saves an independent journal; see page 53 for details. 

Jrnl 
Temp 

.JTL format—Saves a journal template; see page 53 for details. 

Excel 
Spread-

sheet 

Excel Spreadsheet File (*.XLS)—Journal text can be exported directly into an Excel 
spreadsheet by using the File > Save Journal Text As with the Excel Spreadsheet format. Each 
line of text in the journal will be saved as a single row with tabs separating columns. A 
selected portion of a journal can also be written to a spreadsheet. This export allows for 
textual data reduction results to be easily exported into a spreadsheet to allow for further 
analysis. 

• Also available for File > Save As, Find All Cycles journal, and, for Specialized 
Analysis tools. 

Note  The Excel spreadsheet option requires Excel or a compatible spreadsheet application 
that can read Excel files (OOo, Symphony, etc.). If Analysis results are exported to an 
Excel spreadsheet, and a compatible application is not available, results will open as a 
text document the data and nonsense characters.   

 
File Format prompts 
When a file open or save function requires a format change for compatibility or alters file content, a prompt will 
be generated to require the user to confirm the option to update format or convert and save.  
 

  
Created with a previous version of AcqKnowledge  Windows PC AcqKnowledge format 
 

  
Saving as a “Graph Template” will erase all data Imported from another file format 
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Send Email Attachment 
Use this feature to create an email attachment containing an image of the active AcqKnowledge graph, along 
with the journal contents. (AcqKnowledge 4.2 and higher only). 

When using this feature: 

o The default email program will launch, along with a ‘compose new email’ window. 

o An Open Document (*.odt) text file containing an image of the currently opened graph and associated 
journal text will be copied to the attachment field. The formatting and images present in the journal 
should be preserved. 

o Further details can be typed into the body of the email prior to sending. 

In order to open the attachment, the email recipient must have a word processing application compatible with 
*.odt file format, such as OpenOffice, NeoOffice or Microsoft Word™. 

Copy to Dropbox – Open from Dropbox 
The Dropbox options allow for copying or opening AcqKnowledge data files to or from a Dropbox account 
directly from within the AcqKnowledge application. This is useful for storing files online where they may be 
accessed from any computer. In order to use this feature, access to an active Dropbox account is necessary.  
To create a Dropbox account, go to www.dropbox.com. 
To set up AcqKnowledge to use Dropbox: 

1. File > Copy to Dropbox. If Dropbox is being used for the first time in AcqKnowledge, or if you 
are not logged in to a Dropbox account, the following authorization dialog will appear.  

  
2. Click the “Authorize Button” and sign in to your Dropbox account. 

   
3. Click “Allow” to grant AcqKnowledge permission to create a new Dropbox folder (above left). 
4. A confirmation dialog will appear indicating AcqKnowledge is successfully connected to 

Dropbox (above right). Close or minimize your Internet browser window. 
5. Dimiss the Step 1 Dropbox authorization dialog by clicking “Login.” As long as you remained 

logged in to your Dropbox account, this setup procedure will not need to be repeated. 
To Copy files to Dropbox: 

1. File > Copy to Dropbox. 
2. Accept the default filename or enter a new one and click OK. 

  
3. A confirmation dialog will appear indicating the file is stored on Dropbox. 

https://www.dropbox.com/�
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To open files stored on Dropbox: 
1. File > Open from Dropbox. 
2. Select the desired file from the list of stored AcqKnowledge files and click “Open.” 

 
NOTES: 

• If Dropbox is being used for the first time in AcqKnowledge, or if you are not logged in to a Dropbox 
account, the authorization dialog shown on the previous page will appear before you can access a 
stored file. 

• More than one file can be opened from the list, but they must be selected individually. Multiple 
selections are not supported. 

• To log out of Dropbox from AcqKnowledge, choose File > Logout from Dropbox. 
Page setup 
Choosing File > Page Setup produces a standard printer setup dialog that allows you to setup any available 
printers. All the options in this dialog function as described in your system manual. There is also an options 
button that allows you to make several printing adjustments with respect to fonts, image orientation, and 
graphics presentation. 
Print 
The File > Print menu that AcqKnowledge uses is similar to the standard computer print dialog; however, there 
are additional options available 

The Print menu is dynamic and corresponds to the type of 
file you are trying to print, i.e. Print Graph, Print Journal. 
Click Print for more options. 
Note: In Mac OS X, the option to create a PDF file appears 
in the initial Print dialog. 
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• Print Options 
 Plots per page—Control how many plots appear per page when the file is printed. Printing more than 

one plot per page has the effect of “snaking” graphs on a page much the same way text appears in a 
newspaper. For example, if this option was selected so that two plots were printed per page, 
AcqKnowledge would divide the amount of data to be printed on that page into two graphs—one graph 
printing at the top of the page, the second graph printing at the bottom of the page. This option allows 
you to print records on considerably fewer pages than standard printouts, and is most effective when 
only a few channels of data are being printed. 
 Fit to pages—Print the contents of a window across multiple pages. When a record is printed over 

multiple pages, the amount of data on the screen (the amount of data to be printed) is divided by the 
number of pages entered in the dialog. The graph on the screen is then printed across the number of 
pages specified in the Total pages box at the bottom of the File > Print dialog. These two options apply 
only to graph windows, and do not apply to Journals. 

• Draw vertical dividers at event positions—Adds visible borders at points where events occur. 
• Print waveform data in black—Waveforms will appear black when printed, regardless of selected colors 

in graph channels. 
• Print waveform background in white—Prints white background, regardless of selected background 

colors in graph channels. 
• Print focus areas—Turns focus areas on or off for the printout. 
• Range Options—determine the range of data that will be included in the printout  
 Visible portion only synchronizes the range of data in the printout to match the range of data that is 

visible on the screen. 
 Selected portion only prints only the data that is selected in the graph. This option is disabled if there 

is no selection in the graph. When working with Journals, it is easy to generate large amounts of text 
content in the window. Only a portion of this information may actually be of interest and this feature 
allows for only portions of the text to be printed. If there is no selected text, the entire journal or 
modification log will be printed regardless of this setting. 
 Entire graph prints all of the data contained in the graph from zero to the maximum length channel. 

• Print to PDF file—generate a PDF file. 
Quit  

Select Quit from the File menu to exit AcqKnowledge software; you will be prompted to save any open 
graph files that have been modified since they were last saved. 
Mac OS X only—Use Quit under the AcqKnowledge menu (page 456) to exit the software. 



272 AcqKnowledge 4 Software Guide 

Visit the online support center at www.biopac.com 

Chapter 14 Edit Menu Commands 
Overview 

  
  

One of the most useful features in AcqKnowledge is the ability to edit and work with data by cutting and 
copying sections from one window to another. In this sense, AcqKnowledge can manipulate data much as a 
word processing program  handles blocks of text. To select an area of interest in the AcqKnowledge data for 

further study, use the I-beam selection tool to highlight an area.  This selection tool is used for a variety of 
purposes including cutting and pasting waveform data, making measurements and determining which portion of 
a waveform to save as text values. To select this tool, click its icon on the toolbar. Notice that the cursor 
changes into the familiar “I-beam” cursor when moved within the graph area. Click the mouse and drag to 
select a portion of the waveform. 

IMPORTANT 
When multiple waveforms are present, the highlighted area appears to include all of the waveforms, 
but most modifications and transformations apply only to the selected channel. 

Once a section of a waveform has been selected, functions such as editing, transformations, saving data to the 
journal, saving as text, and using the measurement functions can be performed on the selected area. The cursor 
always selects at least one sample point; when there is no defined area, a single sample point will be selected, 
and the cursor will blink. Highlight a larger area by positioning the cursor over the first point of interest, hold 
down the mouse button, and drag the cursor either left or right to highlight an area. Modify the selected area by 
placing the cursor anywhere on the graph, then holding down the shift key and clicking the mouse. This feature 
is useful for fine-tuning the selected area. To fine tune, first coarsely select an area. After zooming in (with the 
zoom tool) on either edge, then use the shift key to precisely align the edges of the selected area. 
AcqKnowledge also allows the selection of an area spanning multiple screens. To do this, first select an area 
that contains the leading edge of the portion of the graph that you are interested in. Next, use the horizontal 
scroll bar to scroll to the end of the area that you are interested in. Then place the mouse near the area of interest 
and click the button while holding down the shift key. While still depressing the mouse button, move the cursor 
to the exact position desired.  
By using the selection tool to select areas of the waveform, the Cut, Copy, Paste and Clear functions are 
designed to work in much the same manner as any text editor. These functions operate only on the selected area. 
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Edit menu functionality during acquisition 
The following Edit menu functions cannot be performed during acquisition: Undo, Cut, Clear, Clear All, Paste, 
Insert Waveform, Duplicate waveform, and Remove Waveform. 
Undo / Can’t undo 
The Undo command allowsfor restoration of data that was unintentionally deleted or modified. Undo applies to 
editing commands and transformations (such as digital filtering and mathematical operations). 
There are some important exceptions to the Undo command. 
First, neither Edit > Clear all nor Edit > Remove waveform can be undone. It is a good idea to make backup 
files before performing any editing, especially when using these commands. 
Second, changes in the display options (i.e., changing the horizontal scale or changing the color of a waveform) 
cannot be undone, since they are easier to manipulate and less drastic than cutting data out of a waveform. If 
you modify the screen scale (or other display parameters) you will still be able to undo your latest data 
modification, which is much more difficult to recover than a screen parameter change. 

TIP: If you accidentally remove a waveform or choose Clear All, one way to recover 
the data is to close the file without saving the changes. The data file can now be 
reopened, as it was when it was last saved; any changes made since it was last 
saved will be lost. 

Perform multiple levels of undo on a per graph basis. The most recent operation is undone first followed by the 
previous operation until the maximum number of Undo operations are reached. The maximum number is set in 
Application Preferences (Display > Preferences > Graph > Maximum levels of undo) .  

 
NOTE: Specialized Analysis (page 348) scripts are complex and undo may not function for all steps. 

Cut 
When Edit > Cut is selected, the selected portion of the active graph channel removed and copied to a clipboard, 
where it is available for pasting into other windows.  
Cut cannot be performed during acquisition. 
 When a selected area is removed from a waveform, the data will shift left to “fill in” the deleted area. So, 

if ten sample points are deleted, all data after the selected area will be shifted over ten sample points. 
Since this alters the relationship of events to the time base, you might want to consider alternatives to 
cutting sections of data—such as using smoothing, digital filtering, or the connect endpoints functions to 
transform the section of data. 

Area selected using the 
editing tool  
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Same data with selected 
area Cut out  

Note that the data 
after the selected 
area has shifted 
backward in time. 

 
 
Copy 
Choosing Edit > Copy will copy the selected area of the active graph channel to the clipboard without 
modifying the text/waveform on the screen. 
 Once the area has been copied, it can be inserted in another window of the same type using the Edit > 

Paste command or, for waveforms, the Edit > Insert waveform command. 
 To copy a waveform to another channel in the same graph window, choose the Edit > Duplicate 

waveform command. 
 Edit > Copy applies only to a selected area of graph data. To copy and entire graph, use Edit > Clipboard 

>  Copy Graph (see page 277.) 
 
Paste 
The Edit > Paste command will take the contents of the clipboard and paste it into the currently selected area of 
the active window of the same type. 
 If no area is selected, the data is pasted at the beginning of the waveform in a Graph window or the end of 

the text a Journal window. 
 Paste cannot be performed during an acquisition. 

 
Clear 
The Edit > Clear command works much the same way as the Cut command, with the key difference being that 
data is not copied to the clipboard. This function deletes the selected area from the selected channel only. If the 
entire waveform is selected (as with the Edit > Select all command), the clear command will delete all the 
waveform data and leave an empty channel. 
Clear may move or alter memory and cannot be performed during acquisition. 
 As with the cut command, the clear function operates on only one channel, and when a portion of the 

waveform is deleted, the remaining data will shift left. If multiple channels of data are present, one 
channel will be “shorter” than the others. 

 To remove a selected area of data from multiple channels, use the Edit > Clear all command. 
 
Clear all 
Choosing Edit > Clear all will delete the selected area from all channels. This is similar to the clear function in 
that data is removed and is not copied to the clipboard. The Clear all command, however, removes a section of 
data from all waveforms, whereas the clear command applies only to the selected channel. 
Clear All may move or alter memory and cannot be performed during acquisition. 
 When Edit > Select all is chosen prior to performing the Clear all function, all waveform data for all 

channels will be deleted. 
 The Edit > Undo command does not work for Clear all. 
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Select All 
When Select all is chosen from the Edit menu, the entire selected channel becomes highlighted. For almost all 
commands, when a waveform is selected using Select all, subsequent operations apply to the selected channel 
only. 
 The exception is when Edit > Clear all is chosen after Edit > Select all. When this occurs, all data from 

all waveforms will be deleted. 
 
Insert waveform 
The Edit > Insert waveform command is useful for copying a waveform (or a section of a waveform) within the 
same or another graph. However, within the same graph, Duplicate waveform is simpler.To do this, first select 
the area to be copied using the cursor and the Edit > Copy command. Next open the graph window to insert the 
waveform into.  
Select the new graph and choose Edit > Insert waveform. A new (empty) channel will then be created and the 
data copied into the empty channel.  
 Insert waveform cannot be performed during acquisition. 
 This command cannot be undone directly, although selecting the inserted channel and choosing Remove 

waveform from the Edit menu effectively undoes this operation. 
 
Duplicate waveform 
Choosing Edit > Duplicate waveform will create a new channel in a graph window and copy an entire 
waveform (or a selected area) to the new channel. When a portion of the waveform is selected, only the 
highlighted area will be duplicated. 
Duplicate waveform may move or alter memory and cannot be performed during acquisition. 
 To duplicate the entire waveform, choose Edit > Select all and then select Duplicate from the Edit menu 

or click the right mouse button and select Duplicate from the pull-down menu.  
 
Remove waveform 
Deletes the entire selected waveform, regardless of what other options are selected. Remove waveform may 
move or alter memory and cannot be performed during acquisition. 
 The Edit > Undo command does not work for Remove waveform. 

 
Remove last appended segment 

Removes the last appended segment. Equivalent to the  Rewind toolbar icon. 

 
 Edit > Undo does not work for Remove last appended segment. 

 
Create Data Snapshot 
The Snapshot options store “snapshots” of the original acquired data at specific stages along with the full graph 
file. Use snapshots for analysis or reporting to compare results to original waveforms or intermediate stages of 
analysis. This is essentially an embedded archive; it is not a backup tool. 

IMPORTANT: Archive functions do not create a new file—they are not backup functions. 
Original data is copied and pasted to the end of the original file.  
You cannot use this feature to recover lost or damaged graph files. 

See page 54 for Snapshot details. 
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Merge Graphs 
Combine multiple graph files into a single file for performing cross-file analysis and storage. Use merge with 
the multiple-hardware capabilities to produce single graph files containing multiple streams of data from an 
individual subject.  
Use Merge Graphs to combine data from multiple graph files acquired with the same acquisition rate into one 
merged graph file.  
Note  Merge Graphs requires AcqKnowledge to allocate additional memory and then load the data into 

memory; when this operation is executed on large data files, the application may crash—on Windows 
OS, the resulting file size of a merge should be less than 2 GB; data files greater than 2 GB can be 
opened, but edit, transformation and analysis operation cannot be performed. 

1. Select Edit > Merge Graphs to generate the Merge Graphs dialog. 
2. Click Add Graph to generate the Choose Graph dialog. 
3. Choose a file to add to the merge. 
 “Add” the “Matching graph” listed (this pull-down menu includes all open files with the same 

acquisition rate) 
 “Add File…” to browse and select a file that is not already open 

4. Adjust the selection for individual channels if desired. 
 Click the “+” to list individual channels in the graph file. 
 Toggle the checkbox to add or remove the associated channel/graph file. 
 You cannot delete a file name from the list, but you can remove it from the merge. 

5. Repeat as desired for multiple files. 
6. Click Merge and wait (you can check the status in the Total Channels bar). 
7. Save the merged file. 
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Merging graphs as data segments 
Individual graphs may also be merged into a single channel as appended segments. This can be useful for 
concatenating data types that don’t support append mode, or when importing data from software that outputs 
each session as a self-contained graph file.  
To merge separate files into sequential segments, check the Merge Graphs “as data segments” option and select 
the data files as shown in steps 1-7 above. The same limitations exist for appended graphs as do for graphs 
merged into individual channels. (All selected graphs must share the same sample rates and channel 
configurations.) 

 
Additional navigation controls become available when merging graphs as appended segments. This allows you 
to reorder the data segments into the sequence desired for the merged file. By default, the first graph added to 
the list will be displayed as data segment 1, but this can be easily modified by selecting any appended graph and 
moving it up or down the list via the “Up”, “Down”, “Top”, “Bottom”, or “Delete” navigation buttons. 
Clipboard 

  
All of the clipboard commands involve copying data from AcqKnowledge to the standard Windows clipboard, 
where the contents of the clipboard are made available for other applications. Transferring data to the clipboard 
allows data to be copied from AcqKnowledge to other applications even after closing the graph window and/or 
quitting AcqKnowledge.  
Data can be copied to the clipboard in two formats: 

Text/Alphanumeric Copy Measurement and Copy Wave Data save information to 
the clipboard in text/numeric format. 

Graphic format Copy Graph transfers the image in the window to the clipboard. 
 Copy Measurements 

Copies the contents of all visible measurement popup menus, along with the values associated with 
these windows. Once the measurements have been copied, they can be pasted into any application that 
allows paste functions, including word processors, drawing packages, and page layout programs. A 
sample of measurements pasted from AcqKnowledge into a text document follows: 

BPM = 85.714 BPM delta T = 0.700 sec p-p = 0.8170 Volts 
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 Copy Wave Data 
Copies the data (in numeric form) for all channels from the AcqKnowledge graph into the clipboard. 
When an area is selected, only the data in the highlighted area will be copied to the clipboard. As with 
the copy measurement command, once the data is stored in the clipboard, it can be pasted into virtually 
any application. 
When multiple channels of data are copied to the clipboard, the data is stored in columns and rows, 
with data from each channel stored in a separate column. For a four-channel record, four columns of 
data will be copied to the clipboard. As with a text file, AcqKnowledge will insert a delimiter between 
each column of data. The default delimiter is a tab; you can change the delimiter to either a space or tab 
in the options dialog in the File > Save as dialog. See page 252 for more detailed instructions on how to 
set the column delimiter. Transferring data through the clipboard performs essentially the same function 
as saving data as a text file (using the File > Save As command), with the obvious exception that 
transferring data through the clipboard does not save data to disk. 

 Copy graph 
Copies the graph window as it appears on the screen to the clipboard, where it is stored in graphic 
format. You can then place the graphic into a number of different types of documents, including word 
processors, drawing programs, and page layout programs. The JPEG graphic format are common to 
almost all applications, and images saved in these formats can be edited in most graphics packages and 
many word processors. 
Using the copy graph function is similar to saving a graph window as a JPEG  (using the File > Save As 
command), except that using the file save command writes a file to disk, whereas transferring data 
through the clipboard does not save a file. 
 

 Copy Acquisition Settings 
Creates a textual summary of the current acquisition settings and sends it to the clipboard, where it can 
be pasted into the journal via Edit > Journal > Paste Acquisition settings, or pasted to another program. 
The summary includes sampling rates, channel configuration, calculation channel settings, triggering 
options, averaging options, and if any stimulator is active. This is useful for retaining records for 
acquisition parameters (and for technical support, if necessary). Use this feature to keep a textual record 
or printout of the configuration of your hardware unit along with your data. 

 Copy Data Modification History… 
Copies the transformation history for all channels or a selected channel to the clipboard. Modification 
history includes the transformation name, channel (analog, calculation, or digital), date & time, and 
relevant transformation parameters, including starting and ending sample position. 
Use Edit > Paste to move it from the clipboard to an active Journal window or other word processing 
application. 

 
 Copy Focus Area Summary 
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Copies the starting and ending position of the focus area in horizontal axis units. Summary includes focus 
area label. 
 Copy Event Summary 
Copies events to the clipboard as selected in the Event Summary setup dialog. 

Journal 

  
The Edit > Journal sub-menu options are similar to those found in the Edit > Clipboard menu. The key 
difference is that data (whether measurements or raw data) is pasted directly into the journal rather than copied 
to the clipboard. 
 Paste Measurements 

Choosing Paste Measurements from the Edit > Journal menu will cause all visible measurement 
windows to be pasted into the journal. Each time this is selected, the measurements and values are 
pasted into the journal using the precision specified in the Display > Preferences dialog. You can also 
change the total number of measurements displayed by adding more rows of measurements. Use the 
Preferences menu (see page 444) to change the number of measurement rows or the measurement 
precision displayed on the screen. 
Paste Measurement shortcuts: 

 Keyboard: Ctrl + M 
 Mouse: Right-click in the Journal and choose “Paste Measurement” 

 Paste Wave Data 
Converts the selected area of the waveform to numeric format and paste it into the journal in standard 
text file format. As with the copy wave data command (in the Edit > Clipboard submenu) this will paste 
the selected area from all channels, not just the selected channel, and will place a delimiter between the 
columns when two or more channels are being pasted to the journal. By default, tab characters are used 
to separate columns; you can change to comma or space delimiters in the File > Save As > Options 
dialog. See the Save As section on page 261 for more information on how to change the column 
delimiter. 

 Paste Acquisition Settings 
Pastes the acquisition settings to the journal as they were copied via Edit > Journal > Copy Acquisition 
settings. 

 Paste Modification History… 
Use after Copy Data Modification History… to paste the transformation history from the clipboard for 
all channels or for the selected channel to an active Journal window or other word processing 
application. Modification history includes the transformation name, channel (analog, calc, or digital), 
date & time, and relevant transformation parameters, including starting and ending sample position. 



280 AcqKnowledge 4 Software Guide 

Visit the online support center at www.biopac.com 

 
 Paste Focus Area Summary 

Pastes the focus area summary to the journal as copied via Edit > Journal > Copy Focus Area 
Summary. 

 Paste Event Summary 
Pastes the event summary to the journal as copied via Edit > Journal > Copy Event Summary. 
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 Manage PDFs 
Use this option to select and import (embed) PDF files into the Journal as tabbed windows. Multiple 
PDFs may be imported and each PDF appears under its own tab heading. Choose Edit > Journal > 
Manage PDFs, or right-click in the Journal and choose Manage PDFs. The following dialog will appear: 

 
Control Description 

Embed New Launches a “File > Open” dialog for navigating to 
the directory containing the PDFs to be embedded. 

Remove Removes a PDF from the list. (The actual PDF is 
not deleted.) 

Up Moves the selected PDF up the list and determines 
its tab order in the Journal. 

Down Moves the selected PDF down the list and 
determines its tab order in the Journal. 

OK Imports the embedded PDFs into the Journal 

After embedding PDFs into the Journal, you may toggle between them by clicking the tabs. Clicking the 
Journal tab will activate the Journal window. Saved Journal content is not affected by embedded PDFs. 

• The Journal formatting tools are not available when a PDF is actively displayed. 
• The Manage PDFs option is only available when the Journal is displayed (Show > Journal). 

 

 Show Journal 

Toggle to display/hide the Journal window. 
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Chapter 15 Transform Menu Commands 
Overview 

  
The Transform menu contains operations that primarily modify the data in the graph. 
AcqKnowledge provides a number of options for post-acquisition analysis and transformations. These 
transformations perform a range of operations on the data, from digital filtering and Fourier analysis to math 
functions. All of these options can be found under the Transform menu, and are disabled while an acquisition is 
in progress. Unless otherwise noted, all transformations described here apply to the selected channel only. Some 
options (such as the expression and math functions) allow users to specify a channel (or channels) to be 
transformed.  
It is important to remember that AcqKnowledge is always selecting at least one point, and the cursor will flash 
whenever only one point is selected. Some of the transformation functions (e.g., math function, waveform 
math) can operate on a single sample point, and will transform a single sample point when only one is selected.  
There are two ways to apply a transformation to an entire waveform. 
a) For transformations that generate a dialog, check 

the “transform entire waveform” box (usually 
located toward the bottom of each dialog). This 
will transform the entire waveform, regardless of 
whether a single point, area, or the entire 
waveform is selected. 

b) For transformations that do not generate a dialog, use the Edit > Select all command prior to selecting the 
transformation. This will transform the entire waveform for all of the transformation functions. 

• Edit > Select All is not necessary when only a single point is selected prior to selecting the 
transformation because AcqKnowledge will automatically apply the transformation to the entire 
waveform since it is not possible to perform these transformations on a single point. 

 



Part C — Analysis Functions 283 

AcqKnowledge 4 Software Guide 
 

Recently Used Transformations 
The Transform > Recently Used submenu allows quick access to a user’s most recently used transformations 
and analysis commands. The Recently Used submenu also appears at the top of the Transform submenu 
available from the context menus of waveforms.  
The submenu lists a default of five of the most recently used transformations, with the most recently executed at 
the top of the menu. To adjust the number of recent transformations displayed, select Display > Preferences. 

 
The recently used transformation listing is saved and restored across subsequent launches of AcqKnowledge. It 
also is application wide: Executing a transformation in any graph will add that transformation onto the recently 
used list. The recently used list is independent for each user account.  

 
The recently used transformations can also be launched by the keystroke combinations appearing in the menu. 
(AcqKnowledge 4.2 and higher) 

Digital Filters 

 
FIR filters are linear phase filters, which mean that there is no phase distortion between the original signal and 
filtered waveforms. 
IIR filters are not phase linear filters, but are much more efficient than FIR filters in processing data. The IIR 
filters are useful for approximating the results of standard biquadric filters of the form: 

(as2 + bs + c) / (xs2 + ys + z) 
These types of filters are commonly implemented in electronic analog circuitry. IIR filters are also used for 
online filtering (discussed on page 139). 
 See Appendix B for more information about the differences between these types of filters. 

Adaptive filtering is a signal processing technique that processes two different signals in relation to one another; 
see page 289 for details. 
To understand how digital filters work, it is important to understand the nature of analog signals and their 
frequency components. All analog signals are comprised of signals of various frequencies. A commonly used 
analogy is that of the color spectra. Just as white light is made up of a variety of colors that have different 
wavelengths (frequencies), physiological signals are comprised of specific signals with unique frequency 
signatures. 
For example, an electroencephalogram (EEG) recording is comprised of several different types of signals, each 
of which has a different frequency signature. Alpha waves (one of the most studied EEG signals) have a 
frequency range of about 8 Hz to 13 Hz. This means that alpha waves go through a complete cycle (from peak 
to peak or trough to trough) anywhere from eight to 13 times a second. 
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There are, of course, signals that have other frequency signatures in EEG data. Most types of physiological data 
have a number of different frequency signatures present in the overall signal. In addition, frequency components 
besides the signal(s) of interest are often present. In the U.S., it is not uncommon for 60 Hz electrical noise to be 
acquired along with physiological signals (in other countries, AC interference is present at either 60 Hz or 50 
Hz). 
Use digital filtering to retain only the frequency components of interest and remove other data (whether it is 
“noise” or merely physiological signals outside the range of interest). 
It is important to note that the way in which data is filtered depends in large part on the sampling rate at which 
the original data was acquired. For instance, if data was collected at 50 samples per second (50 Hz), it is not 
possible to filter out 60 Hz signals. 
In fact, data must be sampled at a rate equal to at least twice the frequency of the signal to be removed. So, if 
data is to be collected and the information between 80 Hz and 120 Hz is to be removed, the data must be 
sampled at 120 Hz*2, or 240 samples per second (or faster). Also, each channel of data is filtered separately, so 
removing one type of data from one channel will not affect any other channels. 
Digital filters can be divided into four general classes: 

low pass     band pass     high pass     band stop 
Descriptions of these four classes of filters follow, with visual examples of how these filters work. In each of 
the four examples, a single channel of data containing frequency components in three ranges (low frequency, 
mid-range, and high frequency) is acquired. 
 Low frequency data, by definition, has slowly changing values, much like respiration patterns or core 

temperature variations. 
 High frequency data, compared to low frequency data, is noticeably more “spiked,” much like an EMG 

signal. As you can tell, the high frequency wave repeats itself about five times in the time it takes the 
low frequency wave to repeat once. 

 Mid-range data falls somewhere in between these two extremes. 
In the examples that follow, one possible way that these data could have been collected is if respiration were 
measured, but the measurement was contaminated with high-frequency muscle movement and mid-frequency 
signal coming from AC interference. The data is then passed through a filter, where some of the frequency 
components are removed. 
Low pass filtering 
In the example below, a low pass filter attenuates the data above a given threshold, allowing only lower 
frequency data to “pass” through the filter. 

Low
Pass
Filter

Incoming data Filtered data

Low
frequency
data

Mid
frequency
data

High
frequency
data

Low
Cutoff

 
High pass filtering 
In the example below, a high pass filter removes the low and middle range data, but allows the high frequency 
data to pass through the filter. 
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Whereas the low pass and high pass filters retain data either above or below a given threshold, the next two 
types of filters work with a range, or band, of data. 
Band pass filter 
The band pass filter, allows only the data within the specified range to pass through the filter. A band pass filter 
is useful when you want to retain only specific waves from an EEG record. For instance, to retain alpha waves, 
you can set the filter to only pass data between 8 Hz and 13 Hz. 
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Band stop filter 
The band stop filter allows data to pass above and below the specified range. This type of filter is typically 
applied to remove extraneous 60 Hz or 50 Hz noise from a data record.  
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FIR Filters 

 
Digital filter dialog  
When you select an FIR filter type, the corresponding Digital Filter dialog will pop up, allowing you to specify 
a number of different filtering options. 
1. Window. The Window popup menu allows you to choose from a 

variety of filtering algorithms. The filter default is set to a “Blackman” 
type. These different Windows (described in detail in Appendix B on 
page 562) allow you to “fine tune” the filter response. 

2. Cutoff Frequency (Hz) (or threshold). Enter a fixed value or set to a 
fraction of the sampling rate or to line frequency. 
Sampling rate—frequency is set to a fraction of the sampling rate and 
automatically updates when the sample rate is modified. 
Line frequency—frequency is set to the line frequency at which the 
data was recorded. 
Fixed at —Fixed value guidelines are as follows: 
• Low Pass Filter—data with frequency components below the 

cutoff will pass through the filter, whereas frequency components 
above the threshold will be removed. For low pass filters, the 
default cutoff frequency is the waveform sampling rate divided by 
eight and can be set to any value between 0.000001Hz and 0.5 
times the sampling rate. 

• High Pass Filter—data with frequency components above the 
cutoff will pass through the filter, whereas frequency components 
below the threshold will be removed. For high pass filters, the 
default threshold is the waveform sampling rate divided by four 
and can be set to any value between 0.000001Hz and 0.5 times the 
sampling rate. 

• Band-type Filters—a low threshold and a high threshold must be specified to define the band of data 
(the frequency range) that is either passed or stopped, depending on whether it is a Band Pass or Band 
Stop filter. In either case, the default for the low threshold is the waveform sampling rate divided by 
eight and the default for the high threshold is the waveform sampling rate divided by four. The 
threshold settings can take on any value from 0.000001Hz and 0.5 times the sampling rate, but the two 
thresholds cannot be set to the same value and the high threshold must be greater than the low 
threshold. 

3. Number of Coefficients. Enter a fixed value or enable the optimize option. 
• Fixed at—This determines how well the filter will match the desired cutoff frequency (or range). The 

minimum number of coefficients is 3 and the maximum must be less than the total number of sample 
points in the selected area. The software will truncate the maximum number of coefficients to the 
highest odd number less than the total. 

• Optimize for sample rate and cutoff—the number of coefficients is set as four times the sampling rate 
divided by the cutoff frequency of the filter. Optimize does not necessarily produce the best quality 
filter, but it takes less time. 

The recommended number of coefficients is  
4 x (waveform sampling rate/lowest frequency cutoff for the filter) 
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For every filter except the band pass, the lowest frequency cutoff is equal to the specified cutoff frequency 
for the filter; for the band pass filter, the lowest frequency cutoff is the low frequency cutoff setting. Filters 
that use a small number of coefficients tend to be less accurate than filters that use a large number of 
coefficients. Larger coefficients increase filter accuracy, but also increase the processing time required to 
filter the data.  
To see how changing the number of coefficients affects the way data is filtered, it can be useful to examine 
the filter response patterns. In the example below, data was collected at 500 Hz and the band stop filter was 
designed to remove 60 Hz noise using a low cutoff of 55Hz and a high cutoff of 65Hz. The same data was 
band stop filtered using 39 coefficients (upper waveform) and then 250 coefficients (lower waveform). 

 
Along the horizontal axis, the units are scaled in terms of frequency, with lower frequencies at the left of 
the screen. The values along the vertical axis are scaled in terms of dB/V and indicate the extent to which 
various frequencies have been attenuated. 
In both filter response waveforms, there is a downward-pointing spike that is centered on 60 Hz. The 
baseline of the filter response corresponds to a value of approximately 0 on the vertical axis, indicating that 
the signals significantly above or below 60 Hz were not attenuated to any measurable extent. As you can 
tell, however, the filter does not “chop” the data at either 55Hz or 65Hz, but gradually attenuates the data as 
it approaches 60 Hz. 
For example, the upper waveform in the filter response plot represents data that was filtered using a value 
of 39 coefficients. The slope is relatively shallow when compared to the lower waveform, which represents 
a filter response performed with 250 coefficients. Although the filter that used 250 coefficients took slightly 
longer to transform the data, the filter response pattern indicates that the data around 60 Hz is attenuated to 
a greater degree. Also, the 250-coefficient filter started to attenuate data considerably closer to the 55 Hz 
and 65 Hz cutoffs, whereas the default filter began to attenuate data below 55 Hz and above 65 Hz. 

TIP: A good rule of thumb is to use a number of coefficients greater than or equal 
to two times the sampling rate divided by the lowest cutoff frequency 
specified. For example, if running a low pass filter at 1 Hz on data sampled at 
100 Hz, choose at least (2 x 100/1) or 200 coefficients in the filter. Additional 
coefficients will improve the response. 

4. Show Filter Response. When checked, this option generates a plot of the 
filter response in a new window, labeled “Frequency Response” (see 
example above).  
 Units: Select linear units or dBV. 

5. Don’t modify waveform. This option is useful in conjunction with the “Show Filter Response” option. 
When both boxes are checked, AcqKnowledge will produce a plot showing the filter response, but will not 
modify the waveform. This allows you to repeatedly specify different filter options (without modifying the 
waveform) until the desired frequency response is achieved. 
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6. Filter entire wave. If this option is checked, AcqKnowledge will filter the entire wave and replace the 
original. If you want to keep the original, duplicate it prior to filtering. 

IIR Filters 
To access the IIR filter dialog, click the Transform menu, scroll to select Digital Filters, drag right to IIR and 
drag right again for the filter options. For all filter types, the software will limit the frequency setting so it 
cannot exceed one-half the channel sampling rate. For real-time filter options, see page 139. 

  
Low Pass and High pass Pass data that falls below or above the specified standard. The Low Pass default is 

waveform sample rate/8; the High pass default is waveform sample rate/4. 
Band Pass (low + high) Pass a variable range of data. Specify a low frequency cutoff and a high frequency 

cutoff to define the range or “band” of data that will pass through the filter; 
frequencies outside this range are attenuated. For the Band Pass Low + High filter, 
the low default is waveform sample rate/8 and the high default is waveform sample 
rate/4. 
 This filter is best suited for applications where a fairly broad range of data is to 

be passed through the filter. For example, apply to EEG data to retain only 
alpha wave activity. 

Band Pass (single freq) Requires only a single frequency setting, which specifies the center frequency of 
the band to be passed through the filter. The “width” of the band is determined by 
the Q setting of the filter (discussed in detail below). Larger Q values result in 
narrower bandwidths, whereas smaller Q values are associated with a wider band 
of data that will be passed through the filter. This filter has a bandwidth equal to 
Fo/Q, so the bandwidth of this filter centered on 50 Hz (with the default Q=5) 
would be 10 Hz. Although functionally equivalent to the Band Pass (low + high) 
filter, this filter is most effective when passing a single frequency or narrow band 
of data, and to attenuate data around this center frequency. The Band Pass (single 
frequency) default is waveform sample rate/8. 

Band Stop (single freq) Defines a range (or band) of data and attenuates data within that band (the opposite 
function of a band pass). This filter is implemented in much the same way as the 
standard Band Pass, whereby a center frequency is defined and the Q value 
determines the width of the band of frequencies that will be attenuated. The Band 
Stop (single frequency) default is waveform sample rate/8. 

Q coefficient The online filters are implemented as IIR (Infinite Impulse Response) filters, which 
have a variable Q coefficient. The Q value entered in the filter setup box 
determines, in part, the frequency response of the filter. This value ranges from 
zero to infinity, and the “optimal” (critically damped) value is 0.707 for the Low 
Pass, High pass and Band Pass filters. A Q of .707 for any of these filters will 
result in a second order Butterworth response. The Q is set to a default of 5.000 for 
the single frequency Band Pass and Band stop filters. For more details about the Q 
setting, see the Appendix. 

Sampling rate Sets the Frequency to a fraction of the sampling rate and automatically updates when the 
sample rate is modified. 

Line frequency Sets the Frequency to the line frequency at which the data was recorded. 
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Adaptive Filtering 

 

 
 See the Adaptive Filtering Calculation 

Channel on page 154. 

Adaptive filtering is a signal processing technique that 
processes two different signals in relation to one another 
and can be used for noise estimation, noise reduction, 
general-purpose filtering, and signal separation. Adaptive 
filtering creates efficient high-quality filters with a minimal 
number of terms, which can be very useful in blocking 
mains interferences or other known periodic disturbances. 
 Useful for noise filtering where it is possible to acquire 

a signal that is correlated to the noise (similar to the 
way noise-cancelling headphones detect and remove 
outside noise). Applications include removing EMG 
from ECG or EOG from EEG. 

The weights within an adaptive filter are modified on a step-by-step basis. AcqKnowledge uses the N-tap FIR 
adaptive filter, with coefficients updated using least means squares (gradient) feedback. 
Source signal 

The source channel will be replaced by the adaptive filter results. 
Noise signal 

The noise channel is the signal that is correlated with the noise to be eliminated from the Source; it is 
not modified by adaptive filtering. 
Source and Noise channels must have the same sampling rate. 

Order 
Specify a positive integer for the number of terms to be used in the internal FIR filter. 

Step size 
Provides mu, the rate of adaptation of the coefficients within the FIR filter. 
 

Comb Band Stop Filter  
Comb Band Stop filters out a fundamental frequency and its overharmonics (integer multiples of the base). 
Resonance, aliasing, and other effects may generate interference at multiples of a base frequency. The Comb 
Band Stop filter combines all the required filters instead of requiring a separate filter for each interfering 
overharmonic.  

    
 Transformation Dialog Calculation Channel Dialog 



290 AcqKnowledge 4 Software Guide 

Visit the online support center at www.biopac.com 

 Comb Band Stop filters remove a fundamental frequency and its overharmonics (e.g., integer multiples of the 
base frequency) from a signal, and are useful for removing noise. AcqKnowledge approximates a Comb Band 
Stop filter by cascading a series of IIR Band Stop filters, and is limited to removing frequencies and 
overharmonics. The number of filters used can be fixed at a particular number (e.g., limiting the number of 
harmonics to filter out) or configured to automatically remove all possible harmonics for any given sampling 
rate. 

• Mac OS — Use the "Comb Band Stop Filter" Automator action to integrate Comb Band Stop 
filters into Workflows. 

For a given base frequency  and quality factor Q, the comb filter approximation will be given by the set of 
following formulas: 

( )( )xFFFFy kωωωω  ⋅⋅⋅= 32  

where F  represents a standard two-tap IIR band stop filter for the frequency  with coefficients 
computed using the quality factor Q. 
The number of overharmonics of the base frequency to be removed is given by the integer value k. The 
maximum allowable number of overharmonics may be automatically determined given the sampling 
frequency f s: 














=

ω2max

f
k s  

This limits the maximum overharmonic frequency to be less than the Nyquist of the sampling 
frequency. 

After the first comb filter is performed, the most recently used settings for the comb filter will be displayed, 
(except for “Transform entire wave,” which will be reset each time the dialog is opened). 
Textual export will include the source channel, base frequency, quality factor, and number of harmonics. 
 
Comb Band Stop Filter Dialog 
number of samples Width of the selection. 
@ samples/sec Waveform sampling rate of the source channel. 

• The channel sampling rate of the calculation channel can not exceed the channel 
sampling rate of the source channel. Downsampling will be applied to the source 
channel prior to comb filter processing, if required, and all Nyquist frequency 
restrictions will be determined from the calculation channel sampling rate. 

Frequency Fixed—The comb filter will remove this base frequency and integer multiples of this 
frequency. 

• Must be positive and less than the Nyquist frequency (half the sampling rate). 
Sampling rate—Sets the frequency to a fraction of the sampling rate and automatically 
updates when the sample rate is modified. 
Line frequency—Uses the line frequency at which the data was recorded. 

Q Quality factor used when computing the coefficients of the IIR notch filters. 
• Must be positive. 

all up to Nyquist Removes all integer multiples of the base frequency. This will include all multiples of 
the base frequency that are less than the Nyquist frequency. 



Part C — Analysis Functions 291 

AcqKnowledge 4 Software Guide 
 

 
Harmonics Removes the base frequency and integer multiples of the base frequency up to and 

including the multiple contained in the edit field 
• Must be an integer greater than 0 and must not exceed k max  
• The final multiple must be less than the Nyquist frequency. If it is not, the input will 

need to be corrected before the comb filter can be applied. 
OK If the settings are valid, executes the comb filter transformation. Verification of certain 

calculation channel parameters does not occur until the start of acquisition as sampling 
rates may be changed after calculation channels are configured. 
Prior to the start of acquisition, the following will be checked: 

• source channel to ensure it is still being acquired. 
• base frequency of the comb filter to ensure it is less than the Nyquist frequency of 

the channel sampling rate. 
• if the user has manually specified that a fixed number of overharmonics should be 

used, the number of overharmonics to ensure the highest used overharmonic does 
not exceed the Nyquist frequency of the channel sampling rate. 

If any of the parameters are invalid, a prompt will be displayed indicating which settings 
are incorrect and must be fixed for the acquisition to be started. 

Cancel Quits without modifying any data.  
Source All enabled analog, digital, and lower-index calculation channels. 
Label When the calculation type of a channel is changed to comb filter, the title of the channel 

will be replaced with the default label “Cn –Filter” where n is the index of the calculation 
channel. 

• Must be 40 characters or less. 
Preset Displays the title of any Calculation Preset currently applied to the calculation channel. 
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Fourier Linear Combiners 
Transform > Fourier Linear Combiners: 

  
 
 See FLC Calculation Channel 

options on page 153. 
 See FLC references on page 293. 

Fourier Linear Combiners are linear combinations of 
adaptable sinusoidal functions that are particularly well 
suited to processing cyclic data. Sine and cosine harmonics 
of a base frequency are summed together and the order is 
the fixed number of harmonics used in the model. Step size 
provides mu, the gain factor used to adjust the weights of 
the harmonics at each processing step. Step sizes must be 
much less than 1 for the system to converge. As step sizes 
decrease, relaxation time lengthens. The FLC model is 
adjusted based on the source data using least means square 
(LMS) feedback and the bias compensates for DC offset. 

 

Basic FLC  
Simple summation of fixed numbers of sines and cosines; uses 
harmonics of a fixed frequency and adjusts weighting coefficients 
of the mixture. 
Operates on a single channel at a time.  
Well suited for extracting data of a known frequency band from a 
signal with a stable frequency. 
 Use as an adaptive noise filter to remove non-periodic and 

semi-periodic noise uncorrelated to the base harmonic 
frequency. 

 

Scaled FLC 
Fundamental harmonic frequency can vary on a cycle-to-cycle 
basis. The frequency remains fixed within a single cycle and must 
be known before processing.  
Scales the harmonics used in each cycle based on cycle 
boundary events (defined through the Cycle Detector, ECG 
Analysis, or manually). Events from one signal can be used to 
drive analysis of another signal.  
Well suited for signals with detectable boundaries, such as ECG. 
 Use to extract information that is tightly coupled to other 

cyclic signals, such as extracting ICG based upon 
Knowledge of the RR cycles of the ECG. 

 

Weighted-Frequency FLC 
Base frequency of the harmonics is variable; adapts the 
frequency in response to the input signal using LMS feedback; 
the frequencies are similarly adjusted to the amplitudes. 
Operates on a single channel at a time.  
Well suited for modeling periodic signals of an unknown and 
potentially varying frequency and/or amplitude.  
 No cycle boundaries or frequencies need to be pre-

determined.  
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Coupled WFLC/FLC 
Runs a WFLC on the signal to determine the harmonic frequency and 
then runs the result through an FLC using the computed harmonic. 
The second FLC can be run on the same or a different channel. 
The transformation will occur in the channel  designated as “ Output.” 
Well suited for real-time extraction of information from one signal 
based upon the frequencies contained in another signal. 
 Use to remove movement noise from ECG. 
 Unique configurations can be established with two input signals, 

one for frequency and one for amplitude. 
 

FLC References 
The basic Fourier linear combiner (FLC) is described by Vaz and Thakor. 

 Christopher A. Vaz, and Nitish V. Thakor, “Adaptive Fourier Estimation of Time-Varying Evoked Potentials,” 
IEEE Trans. Biomed. Eng., VolBME-36, pp. 448-455. 

The weighted-frequency Fourier linear combiner (WFLC) and the coupled weighted-frequency Fourier linear combiner 
(CWFLC) are described by Riviere, Rader, and Thakor.  

 Cameron N. Riviere, R. Scott Rader, and Nitish V. Thakor, “Adaptive Canceling of Physiological Tremor for 
Improved Precision in Microsurgery,” IEEE Trans. Biomed. Eng., Vol BME-45, pp. 839-846. 

The scaled Fourier Linear Combiner (SFLC) is described by Barros, Yoshizawa, and Yasuda. 
 Allan Kardec Barros, Makoto Yoshizawa, and Yoshifumi Yasuda, “Filtering Noncorrelated Noise in 

Impedance Cardiography,” IEEE Trans. Biomed. Eng., Vol BME-42, pp. 324-327. 
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Math Functions 
AcqKnowledge allows you to perform a wide range of mathematical and 
computational transformations after an acquisition has been completed. Unless 
otherwise noted, each of these functions applies only to the selected area of the 
selected channel. If no area is selected (i.e., a single data point is selected), the 
cursor will blink and AcqKnowledge will transform the entire wave. If a math 
function attempts to divide by zero, a zero will be returned. 
For complex transformations involving multiple functions, you may want to use 
the Expression transformation (see page 309 for details). 
The following table describes the commands available in the Transform > Math functions menu: 

Transform > Math Explanation of Command 

Abs (Absolute Value)  Computes the absolute value of the data. All negative data values are made 
positive, with no change in magnitude. This function can be used to rectify data. 

Atan (Arc Tangent) Returns the arc tangent of each data point in radians. This rescales the data such 
that the range is from -π/2 to π/2. 

Connect endpoints 
(Connect the endpoints) 

Draws a line from the first selected sample point to the last selected sample point 
and interpolates the values on this line to replace the original data. The connect 
endpoints function is useful for removing artifacts in the data or in generating 
waveforms. 
In the example below, the “noise spike” in the data is an undesired measurement 
artifact that should be removed. The Cut operation will remove data, but the 
subsequent data will be shifted to the left. Connect endpoint preserves the time 
series of data on the horizontal axis by connecting the edges of the selected area.. 

 

 
Area selected before (top) and after (bottom) connect endpoints function 

 

Exp (Exponential) Computes the function ex, where x is the waveform data and e is 2.718281828. 
This is the base of the natural logarithms. 
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Limit (Limit data values) “Clips” data outside the range specified by the set of boundaries in the limit dialog. 

This operation prompts the user for an upper and lower limit. Any data values 
outside these limits will be clipped. To limit only one boundary (high or low), set 
one edge to the desire level and the second boundary beyond the Max/Min value 
of the data within the selected area. For example to set all negative values to zero 
and leave the positive values unchanged: set the lower limit to zero and the upper 
limit to a value greater than max for the selected area. 

Ln (Natural Logarithm) Computes the natural logarithm of the selected section. The inverse of this function 
is the exponential function, Exp. 

Log (Base 10 Logarithm) Computes the base 10 logarithm of the selected section. 

In order to perform the inverse of this function, which would be 10x, use the 
Waveform Math power operator with the constant k=10 as the first operand and 
the waveform data as the second operand. 

Noise Converts the selected section into random data values between –1.0 and +1.0. 
This is mainly useful for creating stimulus signals and other waveforms. 

Sin (Sine) Calculates the sine of the selected section. The data is assumed to be in radians. 

Sqrt (Square Root) Takes the square root (√) of each data point in the selected section. 

Threshold (Threshold 
data values). 

Transforms all data points above the threshold to +1 units, and converts all values 
below the lower threshold to 0 units. Once the data crosses a threshold it will 
continue to be set to +1 for the upper cutoff and 0 for the lower cutoff, until it 
crosses the opposite threshold. The most common application of this function is to 
serve as a simple peak detector, the results of which can be used in rate or phase 
calculations. 
Threshold Algorithm 
Assume a domain variable 

 

t ∈ tstart , tstart +1,tstart + 2,{ } with tstart being an 
integer, a real-valued signal y(t) defined for all t, and two real valued levels ylow and 
ymax satisfying the relation 

 

ylow ≤ yhigh . 

Define the threshold function thresh(t) function such that: 

 

 

thresh(tstart ) =
1 y(tstart ) ≥ ylow

0 y(tstart ) < ylow

 
 
 

 

 

 

thresh(t) =
0 y(t) < ylow

1 y(t) > yhigh

thresh(t −1) ylow ≤ y(t) ≤ yhigh
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Template Functions 

  
The Template Functions are useful for comparing waveforms. Technically, the template functions provide 
correlation, convolution, mean square error, inverse mean sqaure error, remove projection, normalized cross 
correlation transformations of a template waveform against another waveform. To activate the full template 
menu, select an area and then select set template. 
Set Template 
Use the following ECG waveform as an example and contains an abnormality. After detecting an abnormality, 
this operation can help detect if there are other (similar) abnormalities in the recording. To do that, it’s 
necessary to select the pattern to search for, and then compare that pattern to other data sets in the file. 
Selecting a section of a wave to be used as a template: 

1) Highlight the section to be used as a pattern. 

  
2) Click the Transform menu and choose Set template from the Template functions submenu. This copies 

the selected portion into a buffer for subsequent template functions 
3) Select the waveform and position the cursor at the beginning of the data. 
4) Choose Correlation from the Template functions submenu. The center waveform in the graph below 

shows the result of the correlation. 
Note the higher amplitude peaks where the template data more closely matches the waveform. The lower 
waveform illustrates the mean square error function, which is similar to the correlation function. 
This indicates that there are two abnormal beats in the waveform. The first one appears at about 3 seconds 
and is the one used as a template; the second one appears at about 11 seconds. 
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Result of correlation and mean square error functions 

5) Use the zoom tool to inspect the abnormalities more closely. 
 

Remove mean 
A drifting baseline can be problematic when comparing waveforms. The effectiveness of a comparison of a 
template or waveform with a slowly drifting baseline will be increased by applying the Remove mean template 
function. The remove mean option causes the mean amplitude value of the template and the compared section 
of the waveform to be subtracted from each other before the sections are compared. This way, a large baseline 
offset will have very little effect on the comparison. This option is toggled every time it is selected and is 
enabled when a check mark is present. 
For example, the following graph shows the original waveform at the top, the correlated waveform with mean 
removal in the middle, and the same correlation without mean removal at the bottom. Note how the mean 
removal effectively compensates for the drifting baseline in the original waveform. 

 
Correlation with and without mean removal 
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Template algorithms 
The template functions are: correlation, convolution, mean square error, inverse mean square error, normalize 
cross correlation, remove projection and adaptive template matching. 
a) Correlation is a simple multiplication and sum operation. The template is first positioned at the cursor 

position in the waveform to be correlated. Each point in the template waveform is multiplied by the 
corresponding point in the data waveform (the waveform to be correlated) and summed to produce the 
resulting data point. The template is then moved one data sample forward and the operation is repeated to 
produce the next resulting data point. The resulting data points replace the waveform to be correlated. 
The correlation function algorithm can be expressed by the following formula, where foutput(n) is the 
resulting data point, ftemplate(k) is the template waveform data points, and K is the number of data points 
in the template: 

∑
K

1 =k 
waveformtemplateoutput (n)f * (k)f = (n)f  

 
b) Convolution is identical to the correlation function except that the template waveform is reversed during the 

operation. This function is not generally useful by itself, but can be used as a building block for more 
sophisticated transformations. The convolution function algorithm can be expressed by the following 
formula, where foutput(n) is the resulting data point, ftemplate(k) is the template waveform data points, and 
N is the number of data points in the template: 

f (n) =  f (-k) *  f (n + k)output template waveform

k = -N/2

N/2 - 1

∑  

 
c) Mean square error positions the template at the cursor position in the waveform to be compared. Each point 

in the template waveform is subtracted from the corresponding point in the waveform to be compared. The 
result is squared and summed to produce the resulting data point. The template is then moved one data 
sample forward and the operation is repeated to produce the next resulting data point. The resulting data 
points replace the waveform. 
The mean square error function tends to amplify the error (or difference) between the template and the 
waveform, which makes it useful when looking for an extremely close match rather than a general 
comparison. When a match is found, the mean square error algorithm returns a value close to zero. 
The mean square error function algorithm can be expressed by the following formula, where foutput(n) is 
the resulting data point, ftemplate(k) is the template waveform data points, and K is the number of data 
points in the template: 

f (n) =  [f (k) -  f (n)]output template waveform

k = 1

K

∑
2

 

 
d) Inverse Mean square error simply inverts the result of the mean square error algorithm. Accordingly, when 

this algorithm finds a match between the template and the data, the algorithm returns the inverse of a value 
close to zero and, typically, a large positive spike will occur at the point of the match. 
 

e) Remove Projection Template removes the projection of a reference signal from another part of a signal 
(whereas the other template functions revolve around the comparison of a portion of a signal against a 
reference signal). 

Remove Projection treats the template in memory as a vector. The projection of the selected area onto the 
template is computed as a vector dot product. This projection is then removed from the source data.  
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After a remove projection transformation, the remaining data consists of the part of the signal that is the 
most unrelated to the template. 

Remove Projection can be useful for emphasizing signal differences. For example, it may be useful for 
exploring differences in an arrhythmia in comparison to a normal reference beat. It may also be useful as a 
denoising building block by removing the projection of a signal against idealized noise in the template. 

The number of samples in the template should match the number of samples in the selected area of source 
data. 

• Dot product is undefined for vectors of mismatched dimensions. 

• If the template is longer than the selected source data, the template will be shortened (for that single 
transformation; it will be restored afterward) so its length matches the selection width. 

• If the selection is longer than the template, any data occurring after the end of the template will not 
be transformed. 

To create a Remove Projection template: 
1. Highlight the portion of data to be used as the reference signal. 
2. Transform > Template > Set Template. 
3. Highlight the portion of the data to be analyzed. 
4. Transform > Template > Remove Projection. 
 

f) Normalized cross-correlation (NCC) is useful when searching for variations in the signal. Regular cross-
correlation (Transform > Template > Correlation) can exhibit large amplitude spikes when the energy of a 
signal varies greatly or amplitudes change suddenly, causing jumps that are not necessarily indicative of a 
match with the template. Normalized cross-correlation is a statistical method that can help resolve these 
issues by applying normalization to both the template and signal being searched. This reduces the effect of 
amplitude variation in the result, making normalized cross-correlation useful for template matching 
purposes. 
This transformation computes the windowed normalized cross-correlation, and results in a value between -1 
to 1, which indicates the linear fit of the data set. Normalized cross correlation is defined as: 

∑ ∑
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where x = template 
y = signal 
L = length 

= mean value of the signal f 
At the end of the transformation, the source data will be replaced with the sliding NCC values. Data outside 
the selected area will be left unmodified. If the selected area is zero width when the transformation is to be 
executed, the entire waveform will be transformed. 
If selection is shorter than the template, the missing data at the right end of the selected area will be filled 
with zero padding until it matches the length of the template. This padding occurs in memory and will not 
affect the source data in the graph. The same zero padding is used when computing NCC at the end of every 
selected area when the template is running off the end of the data. This zero padding should trend the NCC 
to zero at the right edge of the transformed area, in most cases. 
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Adaptive Template Matching 
Many different types of physiological analysis involve 
locating repetitive features within a signal. These may 
occur at regular intervals or may occur sporadically. 
Sometimes the areas of interest may be intermingled with 
other results, such as occasional heartbeat arrhythmias 
occurring in a long-term ECG recording. Template 
matching is one frequently used approach for locating 
areas of waveforms that exhibit certain characteristics. An 
example selection is specified as the input template. Then, 
using cross correlation or related methods, the areas of an 
arbitrary wave that most strongly match the example can 
be located. 
Adaptive Template Matching allows the template to vary 
during execution to incorporate changes to the 
morphology of signal attributes. The adaptation consists 
of a moving average of a number of the most recent 
matching attributes. A template match will be defined as a 
peak in the windowed normalized cross correlation of the 
adapting template with the signal.  

Normalized cross correlation helps to eliminate artifact due to baseline shift and changes in overall power 
and amplitude. This heuristic is sensitive to waveform morphology instead of amplitude. 
Template width 

The number of samples in the template that will be used as the initial template for the transformation, as 
set using Transform > Template Functions > Set Template. 

Note One template is shared globally by all graphs and data views in AcqKnowledge. 
Average template window size 

Input positive integers only. Provides the number of previous matches to be used for constructing the 
average template estimate. 

Correlation threshold 
Floating point input in the range -1 to 1. Provides the threshold used for peak detection on the 
normalized cross correlation signal. Corresponds to r in the algorithm description. 

Normalize matching data before updating average template 
Toggle check box. When enabled, the reference set normalization algorithm option is used. This 
performs mean subtraction and unit magnitude normalization to every member of the reference set prior 
to constructing the average template. This option can help to compensate for unintentional weighting of 
the windowed average template towards larger amplitude data. 

Reject matches closer than 
When checked, the minimum match interval algorithm option is used. This rejects matches that are too 
close together and can compensate for degeneration of the algorithm into continual matching due to 
signal self similarity. The edit field contains the minimum width that must separate valid matches. The 
width must always be a positive number. The popup menu specifies the units of the separation interval. 
Its contents are dependent on the horizontal axis type: 

Time (seconds & HH:MM:SS) Frequency Arbitrary 
samples samples samples 
milliseconds Hz arbitrary units 
seconds 
minutes 
hours 
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Output 
Show normalized cross correlation values provides access to the sequence of correlation values that is 
examined by the heuristic for potential matches. Viewing the normalized cross correlation signal can 
provide feedback that is useful for proper threshold selection and for detecting whether the heuristic has 
fallen into one of its degenerate cases (e.g. NCC signal hovering around the threshold for extended 
periods of time). When checked, a new channel will be added into the graph containing the normalized 
cross-correlation values computed by the algorithm. The channel will be labeled “NCC Values.” 
Generate synchronization waveform allows for the generation of spike trains. The value of the wave in 
the graph will be zero by default. At each sample position where a match with the average template is 
triggered, the wave value will be set to one. A single sample position set to 1 indicates a single valid 
match. This synchronization wave can be used in conjunction with the cycle detector to perform further 
data reduction, input to the rate detector for computing match frequencies, and other analysis. 
Define events at match locations output allows placement of an event on the waveform being analyzed 
at the location of each valid match. The event output can allow adaptive template matching to be used 
to construct classifiers that provide event locations for further data reduction with the cycle detector.  

 Type—Used to choose the type of event that will be defined at match locations. Displays the 
standard hierarchical menu list of event types. 

 Label—Label to be given to events defined at match locations. 
Transform entire wave 

When checked, the entire waveform will be analyzed. When unchecked, only the selected area will be 
transformed. 

Integral 
Integral is essentially a running summation of the 
data. Each point of the integral is equal to the sum 
of all the points up to that point in time, exclusive 
of the endpoints, which are weighted by half. The 
exact formula is below, where f( ) is the data values 
and ∆Ts is the horizontal sampling interval 
(reciprocal of the sample rate): 

 

f (n) =  f (k) f (n -1) +  f (n)] / 2]* Tsoutput input

k = 1

n -1

input input∑ + [[ ∆  

The units will be (amplitude units • horizontal units). The integral function can be used to compute the area 
under the curve in a continuous fashion. For instance, in data acquired by an accelerometer, the integral of the 
data would be the velocity, and the integral of the velocity would be the distance. As with all transformations, 
this function can be applied to either a selected area or to the entire waveform. 
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Derivative 
Derivative calculates the derivative of the selected area of a waveform. Since high 
frequency components return nonsensical results in a derivative, a low pass 
filtering function is included in the Derivative function (see page 284 for more 
information on low pass filters). Derivative is based on an FIR filter 
implementation. 
The Filter Response for a Derivative transformation will be displayed in linear 
units or in dbV. The Derivative FIR filter frequency response will appear as a 
linearly increasing magnitude up to the point of the specified cutoff frequency, 
at which point, the filter magnitude will drop off sharply.  

 
Derivative may provide better results than Difference; if high frequency noise is present in the signal. 
Cutoff Frequency The value entered in the cutoff frequency box should be roughly equivalent to the highest 

frequency component of interest present in the time series data. The default cutoff 
frequency is 0.125 times the waveform sampling rate. 

 Sampling rate—Sets the frequency to a fraction of the sampling rate and automatically 
updates when the sample rate is modified. 

 Line frequency—Uses the line frequency at which the data was recorded.  
 # of Coefficients Fixed—The default number of coefficients is (4 x waveform sampling rate)/Cutoff 

Frequency. As the number of coefficients (Q) increases, the Derivative becomes more 
accurate. Fixed can produce better filters but may take longer to execute. 

 Optimize for sample rate and cutoff—Estimate the number of coefficients as four times 
the sampling rate divided by the cutoff frequency of the filter. Optimize does not 
necessarily produce the best quality filter, but takes less time. 

 
Units Select linear units or dbV. 

 
 

TIP: A good rule of thumb is to use a number of coefficients greater than or equal to 
two times the sampling rate divided by the lowest cutoff frequency specified. For 
example, if running a low pass filter at 1Hz on data sampled at 100 Hz, choose at 
least (2 x 100/1) or 200 coefficients in the filter. Additional coefficients will 
improve the response. 
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Integrate 

 

The Integrate transformation operates 
the same as the Integrate calculation—
see page 127, except it does not have a 
Max Cycle option, which is not relevant 
post-acquisition, and Reset via channel 
with mean subtraction enabled functions 
differently online and offline. 
 
Root mean square is implemented as:  

Sqrt(sum(x^2)/(n)) 

Reset 
Online Mean subtraction causes the online version to be delayed by the mean cycle length. It waits for 

that period of time to pass so it can determine a mean value for the initial cycle, and it then 
tries to re-compute this mean for each cycle. If the resets are too short or too long, the window 
expires and the processing halts again until a new mean can be recomputed. Online processing 
may reset from threshold crossing in the control channel or window expiration when it loses 
mean tracking. 

Offline  Since all the data is available, the mean is computed from the data in the channel and doesn't 
delay the signal. Also, since it isn’t doing windowed means, there are no window expiration 
events that are inserted. Offline processing may reset from threshold crossing in the control 
channel. 

Output Reset 

 
Enable the 
checkbox 
option to 
create an 
Event at each 
signal reset. 
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The Integrate formula is the same in the calculation (online, real-time) mode and the transformation (off-line, 
post-processing) mode; it varies only based on the parameters selected. 

Notes 

• For the first points, value of index “i” will be less than or equal to zero; it means that for 
summation you have only values beginning with ( )1xf . 

o For the first point for summation you have: ( )1−xf , ( )0xf , ( )1xf . 

( )1−xf and ( )0xf  - don’t  exist, so you have only ( )1xf . 
o For the second point for summation you have: ( )0xf , ( )1xf , ( )2xf . 

( )0xf  - doesn’t exist, so you have only ( )1xf + ( )2xf . 
• The Integrate formula is implemented as a Standard Deviation formula (see 

mathworld.wolffram.com > Wolfram Research > equation 5 at 
http://mathworld.wolfram.com/StandardDeviation.html. 

• The Root Mean Square formula is identical to the Standard Deviation formula, but without mean 
removal; this is the n-1 definition. 

o For an explanation of n-1 versus n in the formula, see notes in: 
http://duramecho.com/Misc/WhyMinusOneInSd.html  

o For a window size n, to convert from the n-1 definition to the n definition, use
n

n )1( −  

• The formulas to calculate RMS are optimal 
for data with a zero mean (typical for 
biopotential data). Data with a non-zero 
mean can be rescaled with the Transform 
option Rescale. Choose Transform > 
Rescale, and then enter the following 
parameters: 

Input value    Map 
(Scale) value 

 10 7.07107 
 -10 -7.07107 

 

 

 
1. Via samples, no extra parameters selected 

( ) ( ) xxfxF
j

sji
ij ∆= ∑

+−=

*
1

 

Where: 
i - index for source values (***the real range is 1..j); 
j - index for destination values (1..n); 
n - number of samples; 

ix , jx - values of points at horizontal axis; 

( )ixf - values of points of a curve; 
( )jxF - integrated values of points of a curve; 

s – number of samples to average across; 

1
1

−
−

=∆
n

xx
x n  - horizontal sample interval; 

1, xxn  - values at horizontal axis at the endpoints of selected area. 
 
 
 

http://mathworld.wolfram.com/StandardDeviation.html�
http://duramecho.com/Misc/WhyMinusOneInSd.html�
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Integrate formulas, continued…  See Notes on page 304
  2. Via samples, rectify 

 ( ) ( )( ) xxfABSxF
j

sji
ij ∆= ∑

+−=

*
1

 
Where:           
i - index for source values (***the real range is 1..j); 
j - index for destination values (1..n); 
n - number of samples; 

ix , jx - values of points at horizontal axis; 

( )ixf - values of points of a curve; 
( )jxF - integrated values of points of a curve; 

s - number of samples to average across; 

1
1

−
−

=∆
n

xx
x n  - horizontal sample interval; 

1, xxn  - values at horizontal axis at the endpoints of selected 
area. 

 

3. Via Samples, root mean square (RMS) 

 ( )
( )( )

1
1

2

−
=

∑
+−=

s

xf
xF

j

sji
i

j  

Where: 
i - index for source values (***the real range is 1..j); 
j - index for destination values (1..n); 
n - number of samples; 

ix , jx - values of points at horizontal axis; 

( )ixf - values of points of a curve; 
( )jxF - integrated values of points of a curve; 

s - number of samples to average across. 
 

4. Via samples, root mean square, remove baseline 

 ( )

( )
( )

1

1

2

1

−



















−

=

∑
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+−=

+−=

s

k

xf
xf

xF

j

sji

j

sjm
m

i

j
 

Where: 
i and m- indexes for source values (***the real range is 1..j); 
j - index for destination values (1..n); 
n - number of samples; 

ix , jx - values of points at horizontal axis; 

( )ixf - values of points of a curve; 
( )jxF - integrate values of points of a curve; 

s - number of samples to average across. 
k - coefficient: for the first few points that have index j < s  k=j, 

for the other points with j > =s    k=s 
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Smoothing 

 
The smoothing function is a transformation that computes the moving average of a series of data points and 
replaces each value with the mean or median value of the moving average “window.” This has the same effect 
as a crude low pass filter, the advantage being that there is less change to shape and amplitude of the original 
waveform. 
Samples AcqKnowledge allows the user to set the width of the moving average window (the number 

of sample points used to compute the mean) to any value larger than three. By default, this is 
set to three samples, meaning that AcqKnowledge will compute the average of three adjacent 
samples and replace the value of each sample with the mean or median before moving on to 
the next sample. For data acquired at relatively high sampling rates, it is recommended to set 
the smoothing factor to a higher value, since smoothing three sample points when data is 
collected at 1000 Hz will only average across three milliseconds of data, and will typically do 
little to filter out noise. To set the size of the window, enter a value in the Transform > 
Smoothing dialog. 

 This function is most effective on data with slowly changing values (e.g., respiration, heart 
rate, GSR) when there is noise apparent in the data record. 

Mean value Mean value smoothing is the default and should be uses when noise appears in a Gaussian 
distribution around the mean of the signal. The Mean value smoothing formula is shown 
below, where “m” is the number of points in the window and “n” is the sample number: 

m/(k)f   = (n) f
1)/2]-[m+nk

(m/2)-n=k

inputoutput ∑
=

 

Median value Use Median value smoothing if some data points appear completely aberrant and seem to be 
“wild flyers” in the data set.  

  The Median value smoothing formula is shown below, where “m” is the number of points in 
the window and “n” is the sample number: 

[m/2]) n [m/2];-(n median   = (n) f output +  
 

 Watch the AcqKnowledge Smoothing video tutorial for a detailed demonstration of this feature. 

http://www.biopac.com/video/?video_category=acqknowledge-tutorials&v=acqknowledge-smoothing�
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Difference  

 
The Difference function measures the difference (in amplitude) of two sample points separated by an arbitrary 
number of intervals. The difference is then divided by the total interval between the first selected sample and 
the last selected sample. 
When the difference transformation is selected, a difference interval dialog will be generated and the number of 
intervals between samples can be entered (default of 1). 
For data with no high frequency components, a 1-interval difference transformation approximates a 
differentiator. 
The formula for the difference transformation is shown below, where “m” is the number of intervals difference, 
[ ] rounds the integer down, “n” is the sample number, and ∆Ts is the horizontal sampling interval: 

foutput(n) = finput(n + [m/2])—finput(n—[(m+1)/2]) 
 (∆Ts * m) 

Example for boundary values when 
m = 3: 

foutput(0) = (finput(1)—finput(0)) / (∆Ts * m) 
foutput(1) = (finput(2)—finput(0)) / (∆Ts * m) 
foutput(2) = (finput(3)—finput(0)) / (∆Ts * m) 
 

If you enter an odd number 
(K = odd): 

foutput(K) = (finput(K+1)—finput(K –2)) / (∆Ts * m) 
 

If you enter an even number 
(K = even): 

foutput(K) = (finput(K+2)—finput(K –2)) / (∆Ts * m) 

 
 
Note:  The online (real-time) Difference calculation is calculated differently because projected values are not 

available. The online Difference formula is: 

foutput(n) = finput(n –m)—finput(n) / (∆Ts * m) 
 Using the default difference setting of 1 interval will produce a “∆P/∆T” waveform when the 

transformation is applied to a blood pressure or similar waveform.  
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Resample  

 
 

Variable sampling rate and the flexible acquisition speeds of hardware units can create data sets that are at 
different sampling rates. For some types of data analysis, the data must be resampled to a common sampling 
rate. AcqKnowledge has resampling facilities with Transform > Resample Graph; Transform > Resample 
Waveform, and Pasting between graph windows of different sample rates when the “Interpolate pastings 
between graphs” Preference is enabled (via Display > Preferences, page 450). 
AcqKnowledge provides three interpolation methods for resampling data. Any changes made to the interpolated 
pastings between windows Preference and the interpolation method used in the Preferences dialog will be 
retained across launches of the software. 

Padding—Padding will use the closest original value of the waveform to the left of the new sample 
position for the value, constructing a padded square save as the data is resampled. Padding is desirable 
when it is imperative no new data or data approximations get introduced into an analysis. 
Linear—Linear interpolation is the default; previous software versions generated any missing data via 
linear interpolation. This method uses the sample points of the old waveform as the endpoints of a line. 
Missing data points are approximated from points lying on this linear segment. 
Cubic spline—Cubic spline interpolation will construct a spline for the entire data set and use the values of 
this spline as the new waveform values. A natural fit spline is used that keeps zero second derivative at the 
endpoints of the fit. Cubic splines are useful when the analysis requires data with a smooth derivative. 

Resample Graph 
Apply an arbitrary, user-defined sample rate to all waveforms present in a file. 
 This option will adjust as needed the channel sampling rate as well as the acquisition sampling rate. 

Resample Waveform 
 For Resample Waveform, the highest rate that can be entered is the Acquisition Sample Rate. 
Resamples the active channel to a different rate. Resampling data maintains the same time scale but 
changes the number of samples per second. This option can be used to increase the number of sample points 
per interval (usually samples per second). When this is applied, AcqKnowledge will interpolate between 
sample points to adjust to the new rate. This will add data points, although not necessarily more 
information. 
 Resampling to a lower sampling rate will “compress” a data file and information will be lost. 
 For example, a 4-channel data file sampled at 250 samples per second for 15 minutes requires about 

1.8 MB of disk space. If these channels are resampled to 100 samples per second, the size of the file 
on disk is about 720 KB, a considerable reduction. 

 The highest rate a channel can be resampled to is the file acquisition rate (Hardware menu > Set Up 
Acquisition). 

 If data is resampled to a lower rate and then resampled again at a higher rate, the waveform will 
maintain the resolution of the lower sampling rate, only with more data points. 
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Expression 

   
 
See the tables on page 145 for descriptions of sources, operators and functions for the Expression dialog. 
The post-acquisition Expression transformation is available for performing computations more complex than 
available with the Math and Function calculations. The post-acquisition version of the Expression 
transformation includes all the same features as the online version described on page 141. The Expression 
transformation will symbolically evaluate complex equations involving multiple channels and multiple 
operations. Unlike the Math and Function calculations, which can only operate on one or two channels at a 
time, the Expression transformation can combine data from analog or digital channels, as well as calculation 
channels with a lower channel number. Also, computations performed by the Expression transformation 
eliminate the need for “chaining” multiple channels together to produce a single output channel.  
To have AcqKnowledge solve an expression and save the result to a new channel, choose Transform > 
Expression. For each expression, specify a source channel (or channels), the function(s) to be performed, any 
operators to be used, and a destination for the result. The components of each expression can be entered either 
by selecting them from the pop-up menus (sources, functions, destination, and operators), or by typing 
mathematical commands directly into the expression box. 
Any expression can be assigned a specific name and saved as a custom preset. A pop-up menu of recently used 
expressions is also available in the Preset menu, along with a pre-loaded list of commonly used expressions. 
The Expression transformation can reference past and future points. 
Delay 
The Delay transformation allows the addition of time delays in postprocessing (similar to the Delay calculation 
channel that can be used to add time delays to signals). The time delay can be added by introducing zero-valued 
samples at the start of the area to be delayed. The length of the waveform will remain the same; an amount of 
data at the beginning of the wave prior to the delay will be lost, with the length equal to the delay. To set up a 
delay, choose the Transform > Delay menu item. 

 
When inputting the delay amount, the units can be changed between seconds and samples. 

• Delay by samples is applied according to the acquisition sampling rate, not the channel sampling rate.  
The Automator action allows Delay to be used in Automator workflows. See page 25.  
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Rescale 
The Rescale transformation operates identically to the Rescale calculation—see page 155. 

 
Waveform Math 

 
The Transform > Waveform Math operation allows arithmetic manipulation of waveforms. Waveforms can be 
added together, subtracted, multiplied, divided or raised to a power. These operations can be performed using 
either two waveforms or one waveform and an arbitrarily defined constant. Operate on the entire waveform by 
choosing Transform entire wave, or operate on portions of the waveform that have been selected using the 
cursor tool. If there is no selected area, only one sample point (the one selected by the cursor) will be 
transformed.  
All of the main components of a waveform math calculation can be selected from pop-up menus in the 
Waveform Arithmetic dialog. 
Source  The channels to be used in the transformation are referred to as source channels (Source 1 and 

Source 2), and can be combined using any of the operators in the pop-up menu. Source 
channels allow you to select any of the existing channels in the current window, or a constant 
(defined by K). 

Constant The “Constant =” entry box is activated when a Source is set to “K, Constant.” 
Operand  The pop-up menu allows selection of addition, subtraction, multiplication, division or power 

functions.  
Destination  Save the results to an existing channel or create a new channel. Choose an existing channel 

from the pop-up menu or select the “New” option, which will create a new channel (using the 
next available channel). 

Waveform math can be used many ways. As one example, two waveforms can be added together. The 
following screen shows a sine wave in channel 14 and a triangle wave in channel 16. 
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To add these two waves, select Transform > Waveform Math and set source 1 to channel 14, the operator to 
addition “+”, source 2 to channel 16, and destination to New as shown here: 

 
Click OK to perform the transformation. The following screen shows the sum of CH14 and CH16 on a new 
channel. 

 
NOTE:  If you select two waveforms of unequal length as sources, the length of the resulting 

waveform will be equal to that of the shortest one. Likewise, if one of the source 
waveforms extends only into a portion of the selected area, the resultant waveform 
will only be as long as the shortest source portion. If waveform math is performed on 
a selected area and output to an existing waveform that does not extend into the 
selected area, the resultant waveform is appended to the destination waveform. 

Slew Rate Limiter 

 
The Slew Rate Limiter transformation is used for denoising and removing motion artifact during and after 
recording. The allowable amount of motion artifact over a given time/sample window can be precisely adjusted 
from a minimum allowable change to a maximum allowable change, thereby eliminating artifacts that exceed 
the selected amplitude range within a given time period.  
Tailor the range for a given type of artifact by modifying the Time window and Minimum/Maximum allowed 
change parameters. Parameters for various levels of artifact detection can be permanently stored by clicking 
“New…” and saving the signal type as a custom preset. 
To apply the slew rate limiter transformation in AcqKnowledge: 

1. Select the desired source channel in the data. 
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2. Transform > Slew Rate Limiter. 
3. Select the time window using a sample interval or a time value. 
4. Set the desired minimum allowed change value. 
5. Set the desired maximum allowed change value. 
6. Click OK. 

Any artifact that falls outside the boundaries of the maximum/minimum allowed change setting will be 
eliminated from the data.  
See also: Slew Rate Limiter online calculation channel on page 156. 

 Watch the AcqKnowledge Slew Rate Limiter video tutorial for a detailed demonstration of this feature. 

http://www.biopac.com/video/?video_category=acqknowledge-tutorials&v=slew-rate-limiter-in-acqknowledge�
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Chapter 16 Analysis Menu Commands 
Overview 
The Analysis menu contains operations that derive data and measurements from the graph—plus a courtesy 
copy of the Specialized Analysis package with classifiers and automation routines. 
 
Histogram 

  
The Histogram function produces a histogram plot of the selected area. When a histogram is created, the sample 
points are sorted into “bins” along the horizontal axis that contain ranges of amplitude values. These bins divide 
the range of amplitude values into equal intervals (by default, ten bins) and the individual sample points are 
sorted into the appropriate bin based on their amplitude value. 
For instance, if a waveform had a range from 65 BPM to 85 BPM, the lowest bin would contain all data points 
with a value from 65 BPM to 67 BPM. The second lowest bin would hold all data points between 67 BPM and 
69 BPM, and so on, until the tenth bin was created. AcqKnowledge then counts the number of “hits” (the 
number of data points) in each bin and plots this number on the vertical axis. 
Analysis > Histogram Options: 
bins Determines how many bins the data will be divided into; the default is ten bins.  
Autorange  Fits all the data selected into a bin; the bin sizes are determined by the extent of the data and the 

desired number of lines. Automatically sets the center of the lowest bin equal to the minimum 
value of the waveform (or the selected area, if a section is highlighted), and centers the highest 
bin on the maximum value of the waveform (or selected area, if any).  

 Disable to fix the bin sizes and enter values for Highest Bin and Lowest Bin.   
When you click OK, a histogram plot will be generated in a new window. By default, AcqKnowledge displays 
the frequency of occurrence for each bin on the vertical axis. To calculate the cumulative frequency, select the 
entire histogram waveform and choose Integrate from the Transform menu. 
Since the histogram function sorts sample points into a relatively small number of categories, the histogram 
window is likely to display a large number of “hits” in each bin, especially if data was collected at a relatively 
fast sampling rate. If this is the case, you may want to resample the data at a lower rate (using the Transform > 
Resample function). The caveat to this is that resampling the data may cause a bias, unless the data was filtered 
to remove all frequency components that are more than 0.5 the resampling rate. 
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Autoregressive Modeling 
About autoregressive modeling 

Autoregressive modeling is linear mathematical modeling algorithm well suited to operation on discrete series of 
data. Using autoregressive models of physiological data, it is possible to perform advanced time series 
analysis, compression, denoising, arrythmia detection, and waveform classification. Its ability to be used to 
extrapolate spectral features from waveforms at low sampling rates makes autoregressive modeling quite 
useful for electrogastrogram analysis.  

AR modeling has a large number of applications in physiological signal analysis. These applications derive from 
its ability to approximate data through a more compact representation in AR coefficients. Other applications 
leverage AR modeling's ability to generate additional data for a signal with roughly the same characteristics. 
Specialized applications exist for ECG, EEG, and EGG in addition to general purpose analysis procedures. 

 
AR Time-Frequency Analysis is on page 317. 

Autoregressive modeling estimates the 
parameters of a fixed-order autoregressive 
model, representing a model output value 
as a linear sum of previous input values. 
AR modeling may replace the source data 
with the model of equivalent length. The 
output length is equal to the source data, 
unless specified. 

Output can also paste model parameters as tabular text to a journal. If “Don’t modify waveform” and “Show 
model in separate graph” are both enabled, a new graph window will be generated to display the specified 
number of samples resulting from the best-fit autoregressive model. 
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Nonlinear Modeling 
About nonlinear modeling 
Modeling is used in physiological data to assess how well data conforms to a theoretical model. This is 
used to express a sampled signal in a continuous form and to perform data reduction. The nonlinear 
modeling features in AcqKnowledge support more advanced physiological analysis than is possible with 
the linear regression measurement, which is a rudimentary single order linear model. 
Nonlinear modeling is the process of finding the best fit of a mathematical function to an arbitrary data 
set. Fitting the function—or model—to the data consists of choosing a set of function parameters that 
minimize error between the actual data points and the values generated from the model function. 
Nonlinear modeling functions can be arbitrarily complex. When the model is close to the shape of the 
data, the fits between different data sets may be good indicators of subtle variations in the data. 
Most general-purpose methods of performing modeling are iterative and require an estimator for the 
function. A commonly used estimator is the least means squares (LMS) estimator. Nonlinear models can 
be estimated from data by combining LMS estimators with multidimensional function minimization 
algorithms. 
Applications in hemodynamics 

Many pressure and ECG signals exhibit regular morphologies. Fitting data to models that share these 
characteristics helps emphasize subtle differences in waveforms though variations in their model 
parameters. Nonlinear modeling is one of the most accepted methods for computing indexes for the 
relaxation period of left ventricular pressure. Cardiac researchers have used the time constant “tau” 
in various studies on cardiac function and abnormalities. Tau is determined by one of the parameters 
to an exponential model of the trailing end of the pressure signal. Studies have indicated that tau can 
be a good indicator of cardiac dysfunction, but reliable methods for its calculation have proven difficult 
and the effort is ongoing. The generic modeling abilities in AcqKnowledge allow researchers to 
analyze data using the tau constant and potentially develop robust algorithms for its calculation. 

 
See the NLM measurement on page 103

Nonlinear modeling (also called “arbitrary curve fitting“) 
determines the “best fit” of an arbitrary function to 
source data; the function is called a model. 
A model must match underlying trends in the data to 
produce meaningful results. Also, to properly interpret 
the value of the best fit coefficients and any further 
derived results, users must consider the limitations of the 
simplex search method, which include: estimation only; 
not guaranteed to terminate; not guaranteed to find the 
exact solution; may get stuck in local minima. 

Nonlinear modeling generates a new display and replaces source data with a model of equal (unless specified) 
length and also pastes model parameters as text to a journal. The sampling rate and axis units match the source 
graph. 
Max Iterations 

Indicates the number of iterations after which the simplex search will be terminated if no convergence has 
been achieved. 

Tolerance 
Provides the tolerance used for termination of the algorithm. If the estimator decreases in two consecutive 
steps by less than this tolerance, the simplex search will halt. 
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Model Origin Placement 
Controls where the zero point of the model is placed. Selection-relative placement is useful when comparing 
different sections of the same channel of data by looking for variations in their best fit model parameters. If 
channel data is used as part of the Model Expression the location from where the channel data is extracted 
will not be translated; regardless of the model origin setting, the channel data will be used from the selected 
area only. 

Model Expressions 
These model expressions use the same expression format as other parts the program, such as the Expression 
calculation channel. See the function tables starting on page 145 for details on Sources, Functions, and 
Operators. 

Preset 
The following presets for the most common types of models are included. Users can extend presets or create 
custom models if these presets are too general to achieve exact fits with simplex search. Presets are stored at 
Computer > Local Disk > ProgramData > BIOPAC Systems, Inc > AcqKnowledge 4.x > Presets. 

Preset Description Expression 

Cubic 3rd order polynomial. param(3)*(TIME^3)+param(2)*(TIME^2)+param(1)*TIME+param(0) 

Gaussian Standard Gaussian model; useful 
for peak fitting. 

param(0)*EXP(-((TIME-param(1))/param(2))^2 

Linear Basic linear fit of the data. param(1)*TIME+param(0) 

Logarithmic Logarithmic growth and decay; 
useful for initial rapid growth/decay 
followed by gradual 
decline/increase. 

param(0)*LOG(TIME-param(1))+param(2) 

Logistic Logistic LVP relaxation model; 
TL given by a(1). 

param(0)/(1+EXP(-TIME/param(1)))+param(2) 

Monoexponential Exponential LVP relaxation model; 
Te given by a(1). 

param(0)*EXP(-TIME/param(1))+param(2) 

Power Series Useful for a wide variety of data, 
e.g. reactant analysis. 

param(0)+param(1)*(TIME^param(2)) 

Quadratic 2nd order polynomial. param(2)*(TIME^2)+param(1)*TIME+param(0) 

Weibull 
Distribution 

Commonly used in reliability 
analysis. 

param(0)*param(1)*TIME^(param(1)-1)*EXP(-param(0) 
*TIME^param(1)) 

Sources 
All channels except the active can be used as sources with the Model Expression. 

Parameters 
Parameters are represented by param(n) where n is an integer index starting from zero. For example, in the 
linear model param(0)*x+param(1), param(0) can be interpreted as the “a” in “ax+b and param(1) can be 
interpreted as the “b” in “ax+b.” 

Output to Journal displays the result of the modeling as text in the journal. 
Show model in separate graph generates a separate graph to display the best fit model. 
Length specifies the length of the separate model graph in samples. 
Don’t modify waveform suppresses replacement of the selected source data. 

 If the model fitting does not complete successfully, the original data will be preserved regardless of 
the state of this selection. 

Transform entire wave 
Fits the entire data of the selected waveform to the model, with model origin at start of graph. 
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Power Spectral Density 

 

The Power Spectral Density (PSD) function extracts the 
power present at different frequencies within a signal and is 
useful for EMG analysis. The PSD transformation 
approximates the same result as squaring the linear FFT 
magnitude. PSD is not available when the horizontal units 
of the source graph are set to Frequency. 
AcqKnowledge uses the Welsh periodogram to average 
signal time-sliced portions of the signal and reduce noise 
effect, and generates a two dimensional graph displaying 
the wattage of a particular frequency component in a signal. 
Windowing options are Hanning, Hamming, or Blackman. 
The graph is plotted as horizontal frequency vs. vertical 
(units)^2/Hz, where units are the vertical axis units of the 
source data.  

Use linear detrending for each window—when enabled, linear regression detrending is applied for each 
individual segment prior to the FFT computation; when disabled, windowing only is applied.  
Detrend each segment independently—becomes available when “Use linear detrending” is enabled. When 
this option is enabled, detrending is applied independently for each segment; when disabled, detrending from 
the previous segment will be incorporated into the next segment. 

AR Time-Frequency Analysis 

 

The AR Time-Frequency transformation can be used to 
examine changes in the spectral density of a signal using 
enhanced frequency resolution from derived AR models. 
Examining frequency changes over time can be a useful tool 
for arrhythmia detection and rough classification of 
waveforms. 
Autoregressive spectrum time-frequency analysis divides a 
waveform into equal-length time segments, calculates an AR 
model (see page 316) for each individual time segment, and 
then computes a power spectrum from the model. (To perform 
raw data time-frequency analysis, use the Cycle/Peak detector 
with the FFT 3D output option.)  
 

Time interval—Enter a positive floating point value to specify the segment width; the source signal is split into 
fixed length segments of this width and a frequency spectrum is generated for each segment from a model of its 
data. 
Model order—Enter a positive integer to specify the order of the AR model that is constructed on an interval 
by interval basis. 
Frequency resolution—Enter a positive integer to indicate the number of points contained in the FFT of an 
individual time segment; it will be rounded to the closest power of 2 when analysis is performed. 
Amplitude scaling—“Normalize amplitudes” scales amplitudes such that the maximum peak-peak distance is 
equal across time intervals. 
Show 3D Output—Constructs a 3D surface plot of the time-frequency analysis with amplitude vs. frequency 
vs. time. 
Paste results to journal—Inserts a series of tab-delimited tables representing the frequency distributions on a 
cycle-by-cycle basis into the Journal. 
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FFT Fast Fourier Transformation 

 
The FFT algorithm requires that the length of your data be an exact power of 
two (i.e., 256 points, 512 points, 1024 points, and so on). 

The Fast Fourier Transformation (FFT) is an algorithm that produces a description of time series data in terms 
of its frequency components. This is related to the frequency spectrum. The FFT displays the magnitude and 
phase of the time series data selected and displays only the DC and positive frequency components; the FFT 
does not display negative frequency components. To reconstruct a signal from additive sines or cosines, you 
need to include both the positive and negative frequency components. Since it’s not physically possible to 
generate a negative frequency signal, you need to double the amplitude of the corresponding positive frequency 
component. 
The output from an FFT appears in a graph window with magnitude (vertical axis) plotted against various 
frequencies (horizontal axis). A large component for a given frequency appears as a positive (upward-pointing) 
peak. The range of frequencies plotted is from 0 Hz to 1/2 the sampling frequency. Thus, if data was collected 
at 200 samples per seconds, AcqKnowledge will plot the frequency components from 0 Hz to 100 Hz. 
Fourier analysis can yield important information about the frequency components in a data set, and can be 
useful in making determinations regarding appropriate data cleaning techniques (e.g., digital filtering). The FFT 
algorithm assumes that data is an infinitely repeating periodic signal with the end points wrapping around. 
Thus, to the extent that the amplitude of the first point differs from the last point, the resulting frequency 
spectrum is likely to be distorted as result of this start point to end point discontinuity. This can be overcome by 
“windowing” the data during the transformation. For more information on the windowing feature, see the 
window section that follows. 
The FFT transformation cannot be performed in real time (i.e., during an acquisition). To emulate an online 
spectral analysis, use online filters and the Input Values window. See page 232 for more information about real-
time frequency information. 
 
Pad If a section of data is selected that is not a power of two, AcqKnowledge will always “pad” data 

up to the next power of two, filling in the remaining data point with either 
Pad with zeros: a zero 
Pad with  last point: the last data point in the selected area 
In other words, if 511 data points are selected, AcqKnowledge will use a modified version of 
the waveform as input. The modified waveform will have 512 points, and the last point in the 
modified wave will be either a zero or equal to the 511th point of the original data. 
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Show Mod. To view the modified waveform being used as input for the FFT, check the Show modified 
input box. Whenever possible, it is best to use an input waveform (select an area) that is an 
exact power of two. The waveform is modified by applying the windowing and padding 
options. Window functions diminish the discontinuities that occur at either end of the wave. 

 
Window The FFT algorithm treats the data as an infinitely repeating signal with a period equal to the 

length of the waveform. Therefore, if the endpoint values are unequal, you will get a frequency 
spectrum with larger than expected high frequency components due to the discontinuity. 
Windowing these data minimizes this phenomenon. For example, to apply a window 
transformation to a sine wave whose endpoints do not match up, check the box next to Window 
and choose a type of window from the pop-up menu. Each of the windows has slightly different 
characteristics, although in practice each provides similar results within measurement error.  

 As shown below, the frequency spectra of the windowed and non-windowed data differ 
significantly when the endpoints are unequal. When data are not windowed, the very low and 
very high frequencies are not attenuated to the same extent as when windowed. 
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Remove  Sometimes, data contains a positive or negative trend that can cause extraneous  
Trend  frequency components to “leak” into the frequency spectrum. In this case, you could select 

remove trend when you perform the FFT, which will draw a line through the endpoints, and 
then subtract the trend from the waveform.  

For example, the 
following sine wave 
has an upward trend 
through the data 
(positive trend 
component). The lower 
graph shows FFTs of 
the skewed sine wave 
data with and without 
the trend removed. 
Note that the spectrum 
of the data without the 
trend removal has 
gradually decreasing 
frequency components, 
while the data with the 
trend removed has far 
fewer frequency 
components except for 
the single spike due to 
the sine wave. 

 

without trend removal

trend removed

 
Remove Mean  Remove mean calculates the mean of all the points in the selected area and then subtracts it 

from the waveform. This is generally useful for windowing a waveform that has a large DC 
offset. 

 As an example, you might start with a sine wave with a 10-volt DC offset (with a little noise 
added to broaden the spectrum), and perform spectral analysis with and without mean removal: 

 
 Note the large spectral components at the beginning of the top plot, without mean removal. 

This is due to the offset of the original data. The bottom plot is with mean removal. 
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 Since the offset of the waveform is often an artifact of the way it was generated, the remove 
mean option provides a more accurate indication of the true spectral components. This is 
especially true for applications where low frequency components are of interest. If your data 
has a large DC offset and you plan on windowing the data, you will generally get a more 
meaningful spectrum if you remove the mean prior to windowing (which is the same order the 
FFT uses). 

Linear By default, the FFT output is described in terms of frequency along the horizontal axis and 
dBV on the vertical axis. The Bell scale (from which dB are derived) is logarithmic, and in 
some cases it may be useful to have the output scaled in linear units. To do this, click the button 
next to linear and check OK. The other options in the dialog work as they normally do when the 
dB scaling option is selected. The relationship between log and linear units is: dBVout = 20 log 
VIN. 

Phase The standard FFT produces a plot with frequency on the horizontal axis and either dB/V or 
linear units (usually Volts) on the vertical axis. In some cases, it may be useful to obtain phase 
plots of the waveform (as opposed to the default magnitude plots). Phase plots display 
frequency along the horizontal axis, and the phase of the waveform (scaled in degrees) on the 
vertical axis. This option functions exclusive of the magnitude option—you can check either 
independently, or if you check both, two plots will be produced (a magnitude plot and a phase 
plot). 

 
Inverse FFT 

 

The Transform > IFFT menu option is generated after an FFT is 
performed. An Inverse FFT (Transform > IFFT) converts spectral 
values back to a time series waveform to reverse the FFT 
transformation. Any modifications to the original data (such as 
windowing or padding) will be shown in the resulting time series 
data. 
To obtain a meaningful IFFT result you must have a graph window 
open with at least one magnitude channel and at least one phase 
channel. With the window open, choose IFFT from the Transform 
menu to generate the Inverse FFT dialog. 

To accurately recreate the time series waveform  
1. Select the source channels for the inverse FFT in the Magnitude and Phase pull-down menus. 
2. Select whether to express Magnitude in linear units or dB logarithmic units (decibels). To determine 

this setting, check the vertical axis units of the magnitude channel; this should correspond to the 
Magnitude scaling choice that was used when performing the forward FFT. 
 The Phase waveform must be in degrees. 

3. Click OK to perform the IFFT. 
 The result is generated in a new time domain window, labeled “IFFT of Spectral…”
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To perform an FFT, you might start with an electroencephalogram (EEG) signal acquired when the 
subject alternated between eyes open and eyes closed. Typical results suggest that higher levels of alpha 
activity (activity with frequency components between 8Hz and 13Hz) are to be expected when a subject’s 
eyes are closed. 

1. The raw data, prior to FFT, is shown here: 
 Eyes

open
Eyes

Eyes
open

closed

 
2. Select Transform > FFT from the menu. 

The FFT Parameters dialog will be 
generated; in this example, the Window 
function chosen is Kaiser Bessel: 

 

13107

 
3. Click OK. 

A frequency domain window (a graph 
window which places frequency along the 
horizontal axis rather than time) will be 
created and displayed, showing the spectrum 
of the input data. 
The window is named “Spectral of (the 
original window name)” and ends with the 
channel number, as shown here: 
The resulting magnitude value for each 
component is equal to the peak value of the 
sine wave contributing to that component. 
The entire pattern of frequency components 
is known as the frequency spectrum of the 
data. The somewhat erratic appearance of the 
spectrum is usually due to small-scale 
variations in the original waveform. 

4. Optional—This “noise” can be removed by 
applying a smoothing transformation to the 
FFT output. In the graph shown, there is a 
pronounced frequency component centered 
on 8Hz, which corresponds to the alpha wave 
frequency band (8Hz—13Hz). The frequency 
spectrum (0-20 Hz shown) used 20-point 
smoothing. 

 

 
 
 
 
 
 

 

 Watch the AcqKnowledge FFT video tutorial for a detailed demonstration of this feature. 

http://www.biopac.com/video/?video_category=acqknowledge-tutorials&v=fast-fourier-transform�
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DWT/SWT  

 

About Wavelet Transformation 
Wavelet transforms are similar to Fourier transforms. Instead of 
projecting a signal in a space of sines and cosines, wavelet transforms 
project a signal into a space comprised of orthogonal functions called 
wavelets. Discontinuities are more obvious in wavelet transforms than in 
sines and cosine analysis, making wavelet transforms a better choice 
for decomposing a signal to its fundamental form. Wavelet transforms 
can be used for noise reduction and filtering, extracting features from 
signals that are not apparent in time or frequency domains, and 
predicting signal qualities from a small number of data points. 

Discrete wavelet transformations (DWT) break a source signal into high-frequency and low-frequency 
components. Use for ECG and EEG analysis. DWT creates a new graph with wavelet coefficients on the 
horizontal axis and the amplitude for each coefficient on the vertical axis, pastes acquisition settings to the 
graph journal, and places an event at each boundary between the high- and low-frequency components 
produced at each iteration.  
 Wavelet type Specify Biorthogonal 4.4, Symlet 4, Coiflet 6, Daubechies 8 or Spline 3. 
 Number of iterations Specify the number of transforms to execute. 
Stationary wavelet transformations (SWT) differ from DWT in that the “stationary” transformation retains all 
coefficients at each processing level, so each level’s output is equivalent to the length of the input signal. At 
each output level, the low and high pass filters are upsampled by inserting 2k−1 zeros between each wavelet 
filter coefficient. This method retains information unnecessary for reconstruction of the original signal but 
produces output that may be more useful for identifying and enhancing specific characteristics of the original 
signal.  
To enable the SWT option, check the “Use algorithme à trous / SWT” box. Like the DWT transformation, the 
SWT output will appear in a new graph.  
Multi-channel output: This option places a copy of the original source data in the first channel of 
the output graph. Coefficients for each level are inserted as subsequent channels of the graph labeled “dn” with 
n replaced by the level of decomposition. The final channel is prefixed with an “h” indicating the high-pass 
coefficients left over from the final run. 
If either the multiple channel or the SWT options are used, the Inverse DWT cannot be used to reconstruct the 
original data. To reconstruct the original data, appy regular DWT with single channel output. 
Inverse DWT 

Operational on the result of a DWT. Projects data from wavelet 
space to time space. For correct recomposition of the source 
data, the wavelet type specified for the IDWT must match the 
wavelet type used for the DWT. Amplitudes of the wavelet 
coefficients may be changed, but an IDWT will fail if the 
horizontal units, events at DWT iteration level boundaries, or 
file length have been modified. 

Principal Component Analysis 

 

About Principal Component Analysis 
Principal Component Analysis decomposes source signals into a 
new signal space (constructs an orthogonal set of vectors). PCA is 
useful as a feature extraction and data reduction tool.  
Changes in the values of the mixing matrix may be indicative of 
changes in underlying signal morphologies that other methods 
cannot easily detect.  
For example, PCA is useful for EEG analysis; where it can reduce 
32 channels to the fundamental elements of signals.  



324 AcqKnowledge 4 Software Guide 

Visit the online support center at www.biopac.com 

AcqKnowledge uses a mean-adjusted covariance matrix method to generate a new PCA graph with each 
component in a separate channel. The coordinates of the new space are the eigenvalues extracted from the 
matrix defined by the source data and are called “Principal components.” The extracted eigenvectors are the 
“mixing matrix.” Sine and cosine are orthogonal signals. The principal components are numbered in order of 
decreasing eigenvalues, which implies that the first principal component contains the majority of the variation 
of the source signals. Results are also pasted in to the journal, including the eigenvalue magnitudes and the 
eigenvector matrix. To determine the percentage contribution of each component, review the eigenvalue 
magnitudes. Select two or more channels—all of the selected channels must have the same sampling rate. 

Inverse PCA 
Available only for graphs produced by PCA. Reconstructs the source signals based on the components and 
mixing matrix of the PCA graph. The graph is reconstructed in a new window, with a list of the components 
used pasted to the journal. 
 For noise reduction, use only the strongest principal components to reconstruct the source signals. 

Independent Component Analysis 

 

About Independent Component Analysis  
Independent Component Analysis is useful for signal separation, 
denoising, and advanced EEG analysis to remove noise signals or 
locate approximate regions of active processing centers in the brain. 
ICA is a form of statistical blind separation that attempts to separate 
mixed (overlapped) signals based on the assumption that they are 
statistically independent. 
 For example, if two microphones in a room record one person 

reciting Shakespeare and another person playing the banjo, the 
recordings will capture both the speaker and the banjo. After 
performing ICA on the two recordings, one result will have only 
the speaker and the other will have only the banjo. 

AcqKnowledge uses the FastICA algorithm to generate a new ICA graph with each component in a separate 
channel.  
For more information on the FastICA algorithm, see this link. 
Select two or more channels—all of the selected channels must have the same sampling rate. 
Specify tolerance and number of iterations. 
ICA limitations to consider for application and interpretation: 

1. The number of mixed sources must be equal to the number of independent components (as in the 
example where two microphones captured two sound types). 

2. Sources must be statistically independent; highly-correlated signals cannot be effectively separated. 
3. Sources must have non-Gaussian probability distribution. It is not possible to separate out components 

like white noise through ICA. 
4. Signal mixing must be a constant, linear process. Any type of non-linear signal propagation cannot be 

expressed in linear combinations of sources, the underlying assumption of ICA. 
5. The component sources must be stationary (that is, point sources). 

 
Inverse ICA 
Available only for graphs produced by ICA. Reconstructs mixed signals based on the components and 
mixing matrix of the ICA graph. The statistical nature of the algorithm implies that it cannot perfectly 
reconstruct original source data—it estimates the most probable set of source signals. The graph is 
reconstructed in a new window, with a list of the components used pasted to the journal. 

http://research.ics.aalto.fi/ica/fastica/fp.shtml�
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Find Cycle (Peak Detector)  
 Watch the six-part AcqKnowledge Find Cycle video tutorial for a detailed demonstration fo this feature. 

 
The Find Cycle/Peak Detector setup dialog is accessed by choosing Analysis > Find Cycle, or using the Ctrl+F 
keystroke. 
Overview 
The advanced Cycle/Peak Detector combines with the powerful Event Marking System. Use it to perform 
amplitude, time, or event-based measurements. New output options for measurements, averaging, events, 
clustering (K-means), and 3D surface (cycle data, histogram, FFT, and DWT). 
The Find Cycle detector uses three tabbed settings panels to define and automate cycle/peak detection: 

Cycles/Peaks   Selection Output 
Cycle detector settings are graph-independent, which means that find cycle/peak operations can be performed 
in multiple graphs without needing to re-enter graph-specific settings for each run. By using multiple data 
views, different find cycle/peak operation can be performed on the same set of data without losing settings 
between “Find Next Cycle/Peak” operations. 
When the Cycle/Peak Detector is first opened for a graph, the dialog will be filled with the values from the last 
successfully executed find Cycle/Peak operation. Subsequently, changes to the settings will be applied only to 
that graph. 

TIP When running the cycle detector multiple times and you need to put the edge back at the beginning 
of the waveform for the next pass, use the keyboard shortcuts Home, End, Page Up, and Page 
Down to quickly change edge location (see page 65). 

Cycles/Peaks tab 

  
Peaks Events 

 
Fixed Interval 

http://www.biopac.com/video/?video_category=acqknowledge-tutorials&v=acqknowledge-find-cycle-peak-detector-part-1�
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Find Cycle controls available at bottom of dialog 

Find Next Cycle 
When selected from the Analysis menu (or Ctrl+E), both edges will move one peak to the right while staying 
above the threshold.  
Find All Cycles in Graph 
When selected from the Analysis menu, Find Cycle setup dialog or selecting Ctrl+R, the software will find all 
cycles/peaks through the end of the file. If your data file is very large, it may take some time to find all the 
cycles since AcqKnowledge loads data from disk while it scans for the cycles. 
Find in Selected Area 
When selected from the Analysis menu or in the Find Cycle setup dialog, only cycles within a selected area will 
be detected, all others will be ignored. 
Find All Cycles in Focus Areas 
If the graph contains defined focus areas, this option will limit cycle detection to focus areas only. If no focus 
areas are defined, this option will not be available. This is selectable via the Analysis menu or in the Find Cycle 
setup dialog. 
Find First Cycle 
Use this option to apply changes to the Find Cycle setup and locate the first cycle. This is selectable via the 
Analysis menu or in the Find Cycle setup dialog. 
Preview (Selection tab) 
When selected, a preview of the selected Find Cycle operation is displayed prior to applying the settings. 

 
Find Cycle definitions 
A cycle is defined as the interval between two events of user-
specified types. The Cycles/Peaks tab offers three general 
methods for establishing cycle parameters: 
 Peaks: Data driven maximum and minimum (see page 

 329) 
 Events (see page 329) 
 User-defined fixed time intervals (see page 329) 

When the cycle location mode is switched on the “Cycles/Peaks” tab, the edge selection offsets will be checked. 
If they are non-zero, a prompt will appear, warning that that the edge adjustment offsets may not apply for the 
new cycle location mode. The user can reset the offsets to zero (default) or retain the (non-zero) settings used in 
the previous cycle location mode. 
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Peaks 
Peak direction Postive/Upward – searches for positive voltage spikes in the signal. 
 Negative/Downward – searches for negative volage spikes in the signal. 
Level Important usage note—Level is not set automatically when the Cycle/Peak detector is 

generated. (Automatic Level is used in previous versions of AcqKnowledge for Mac and 
current version for Windows.) 

Use selected... To optimize the threshold detection level for the selected area of data in the graph, click the 
“Use selected maximum/minimum” button underneath the level. When changing the source 
channel or peak direction, also use this button to re-compute the recommended level based 
upon the new settings. The recommended level is  “Tracking using % of peak value” (see 
below) using a percentage factor of 75%. 

Threshold Fixed—Keeps the threshold voltage level constant. 
 Tracking The Tracking threshold mode modifies the threshold after it finds a peak, depending upon the 

value of the new peak, and will compensate for a slowly drifting baseline. 

Hints regarding the use of Tracking Threshold Options 
• If data has a very consistent cyclical nature, either Tracking Option will work. 
• If data has spurious positive or negative peak values present, the Means Reference 

Tracking Option is a better choice. 
• If data has an erratic baseline, but consistently sized, positive and negative peaks, the 

Peaks Reference Tracking Option is a better choice. 

Tracking using mean value and % of peak value—Adjusts the threshold voltage level after 
each peak, based on the average of the last cycle’s data and the specified percentage of the 
current peak voltage. The Means reference option will determine the Mean Value of all the 
data, from peak to peak. This Mean Value establishes a variable reference upon which the 
tracking threshold operates. The software determines the new threshold (NT) as follows: 

For Positive Peaks 
NT = Mean Value + (Positive Peak Value - Mean Value) x (% factor) 

For Negative Peaks 
   NT = Mean Value - (Mean Value - Negative Peak Value) x (% factor) 

 Tracking using % of peak value—Adjusts the threshold voltage level dynamically based on 
the specified percentage of the value of the most currently found peak. The Peaks reference 
option will determine the Positive Peak Value and Negative Peak Value of all the data, from 
peak to peak. The Positive and Negative Peak Values establish a variable reference upon 
which the tracking threshold operates. The software determines the new threshold (NT) as 
follows: 

For Positive Peaks 
NT = Neg. Peak Value + (Pos. Peak Value—Neg. Peak Value) x (% factor) 

For Negative Peaks 
NT = Pos. Peak Value - (Pos. Peak Value—Neg. Peak Value) x (% factor) 

Events 
Event-based cycle location can extract information from events or define events based upon the output of the 
peak detector. A cycle is defined as the interval between two events of user-specified types. 

Start / End Define the event; any of the predefined event types can be explicitly matched. 
Match pairs “Match pairs of events only” is active when the Start event criteria are identical to 

the End event criteria. Toggle the checkbox to set this option. For a cycle to be 
located, a pair of two distinct events that match the criteria must be present.  
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The event occurring earlier in time matches the interval start (formerly “left 
edge” in AcqKnowledge versions 4.4.1 and earlier), later in time matches the 
interval end (formerly “right edge” in AcqKnowledge versions 4.4.1 and earlier). 
This is the default search mode; this is the only search mode when the criteria are 
different. 
When unchecked, a single event can be used as the Start event and the End event 
of a cycle, which produces a zero width cycle. This is useful for adjusting a 
selection relative to an event, such as locating the first second prior to each event 
of a specific type. This single-event matching option makes it possible to hit time 
periods for each event since each cycle consumes two events. 

Located on Specify the channel when the event must be defined, either its actual channel or 
“Global” for events not associated with any channel. Select “Anywhere” to search 
for events of specific types across channels. 

With Labels 
optional 

Toggle the “With labels containing text” checkbox to set this option. 
When checked, the matching event’s label must contain the text in the edit box to 
the right of the checkbox. 
 The text search is not case sensitive. The search must be non-empty for cycles 

to be located properly. 
When unchecked, the matching event can have any label, including none. 

The Cycle detector uses the following algorithm to search for cycles in the graph: 
1. From the starting point, find the first event matching the criteria of the Start event. This will be defined 

as the left event. If no event matches the Start criteria, no more cycles are in the file. 
2. If the Start event criteria match the Ending event criteria and zero width cycles are allowed (e.g. “Match 

pairs of events only” is unchecked), define the right event as identical to the left event and go to step 5. 
3. From the location of the left event, find the closest event matching the criteria of the End event. This 

will be defined as the right event. If no event matches the End criteria, no more cycles are present in the 
graph. 

4. Within the time region between the left and right events, search for any events that match the Start 
criteria. If such an event occurs, redefine the left event to be this matching event and repeat the step. If 
no event is located, then the closest pair of events has been located. 
 This step is useful for working with data that has missing portions of the sequence, as can come out 

of some classifiers. For example, if two event types A and B are used as the endpoints, a sequence 
of three events AAB will match the last two events as the cycle. This is logical in the case of 
physiological data where, if B should occur periodically in the signal, AA is an indicator of an 
abnormality or missed classification. 

5. Set the selected area to the time interval whose endpoints are the left and right events. 
6. Perform selection adjustment and output as indicated by the settings on the “Selection” and “Output” 

tabs. 
7. If “Find All Cycles” is being performed, return to step 1 and use the ending event location as the new 

starting point to find any remaining cycles in the graph. 

Fixed Interval 
Fixed interval-based cycle detection is based upon cycles found in consecutive time intervals of a fixed width. 
The time width is user defined and the starting point of the cycle detection can be placed at the current location 
of the cursor, or to begin at an exact point of time in the graph.  
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The time units for starting the first interval and setting the interval width can be selected in milliseconds, 
seconds, minutes or hours. 
Selection tab 
Use the Selection tab to adjust the range of data that will be analyzed to generate any output. By default, the 
data range is set to be the entire cycle as located by the settings on the Cycle/Peak tab, but it can be adjusted to 
analyze only specific portions of the cycle. 
The controls on the Selection tab vary based on the settings on the Cycle/Peak tab 

Peak When the Cycles/Peaks location method is “Peaks,” you can adjust the Selection based on the 
times of the peaks in the data or the times of the threshold crossings prior to the peaks. 

 
To perform analysis on the entire data within each cycle, the selection should be from the 
“previous peak” to the “current peak.” To examine fixed-width time windows located at each 
peak, use the “current peak” to “current peak” settings and adjust the two time offsets 
accordingly. Note that your settings must place the left edge earlier in time than the right edge 
for the peak detection to succeed properly. 

 
“Move Cursor To Origin” (at bottom left of screen) sets the graph data selection back to the first 
sample. Use this to reset the cursor in order to find all of the data in the graph. 

Event When the Cycles/Peaks location method is 
“Events,” you can adjust the Selection 
based on the locations of the events that 
define the boundaries of a cycle. 
For a specific cycle, the starting event will 
be the event at the left boundary of the cycle 
and the ending event will be the event at the 
right boundary of the cycle. The starting 
event will never be located after the ending 
event in time. 
To analyze data over each entire cycle, use the “starting event” to “ending event” setting. To 
examine fixed-width time windows occurring within each cycle, set the left edge and the right 
edge to the same event (e.g. “starting event” to “starting event” for time windows at the 
beginning of each cycle) and adjust the offsets accordingly. Note that your settings must place 
the left edge earlier in time than the right edge for the peak detection to succeed properly. 

Fixed When the Cycles/Peaks location method is “Fixed time 
intervals,” you can adjust the Selection based on the 
endpoints of the time interval. 
To analyze the data over each entire interval, use the 
“previous interval” to “current interval” setting. 
To examine fixed-width time windows within each 
interval or only a sub-portion of each interval, use the 
“current interval” to “current interval” setting and adjust 
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the time offsets accordingly. Note that your settings must place the left edge earlier in time than 
the right edge for the peak detection to succeed properly. 

Output tab 

 

The Cycle/Peak Detector includes six Output 
options, which can be independently enabled: 
Measurements, Averaging, 3D Surface, Events, 
Focus Area and Clustering. The selected output, if 
any, is listed at the top of the Output tab as Enabled 
output. 

Output Measurements 

 

Toggle each checkbox to enable/disable the option: 
 Paste measurements for each cycle to the 

Journal. 
 Plot measurement results; display 

measurement values as channels in 
graph. 

 Save measurements to Excel spreadsheet 
file, plus output options. In order for 
spreadsheet output to be generated, a 
“Find All Cycles” operation is required.  

 Apply Measurement Preset – this option 
replaces the current measurement 
configuration with any of these 
selectable presets. 

NOTE: If the horizontal axis is in world time 
(HH:MM:ss), any time measurement exported to 
Excel will be reported in standard time units, such as 
seconds or minutes. 

Output: Averaging—Offline 

 

Use Averaging Output” to perform offline ensemble 
averaging of source data or ensemble averaging of event 
locations. Specify the channel where the cycles/peaks 
are to be located in the “Cycles/Peaks” tab and specify 
the channel whose data should be ensemble averaged in 
the “Average” controls on the “Output” tab. 
Toggle the “Average channel events checkbox near the 
bottom of the tab to turn event averaging on and off. 
Offline averaging can produce average locations of 
events within the defined cycle along with the average 
data. When a cycle is found, any events in that cycle 
will be noted. Events that are on the channel of data 
being averaged will be examined for inclusion in the 
average.  

Index For each individual cycle, each event will be given an index starting at 0 and increasing to one less 
than the number of occurrences of that event type within the cycle. The time offset for each event 
from the start of its cycle will be averaged along with the offset for events with the same index 
from all other cycles. When the graph of the averaged data is produced, these average time offsets 
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from the start of the cycle will be used to define new events for the averaged data. If the events and 
averaging interval were correlated with the data, the average event offset will produce a reasonable 
representation of the appropriate event locations for the averaged cycle. 
 Average events reflect the accuracy of classifiers and the consistency of data used to locate each 

cycle. 
Label Each event is labeled with the number of cycles contained in the event. Differences in the event 

sequence can cause spurious events to be inserted. The label helps in manual inspection for events 
that were only in one or two cycles. 

Rejection Toggle the “Events must be in…” checkbox to turn rejection on and off, and specify a percentage 
for the relative number of cycles an event must appear in to be considered valid. 

Remove… When mean removal is enabled, the mean value of the data within each cycle is subtracted prior to 
including it in the overall signal average. This mean removal option is useful for: 

o Extracting signals that are “riding” on top of other signals with high DC offset (e.g., MRI 
artifact on top of skin temperature) 

o Compensating for baseline drift where there are not enough cycles present in the data for 
the baseline variation to completely cancel itself out. 

Output 3D Surface 

 

 

 
 
Toggle the “Generate a surface” checkbox at the top of the 3D tab to turn Surface Output on and off. 

1) Choose a channel to generate a 3D surface from. 
2) Confirm or establish the cycle period of interest on the channel. 

 Use the Cycles/Peaks tab and the Selection tab to adjust the threshold and edge positions for the 
cycle period for 3D output. 

3) Choose a cross-section output format for the cycle data: cycle data, histogram, FFT, or DWT. 
 For histogram, FFT, or DWT, click “Configure Transformation” to change the settings. 

4) Select surface and background colors. 
5) Set axis options. 
6) Click OK. 

Use the cursor to rotate the 3D image; the magnitude of display response increases as you leave the center of 
the screen (keep cursor close to center for slow response/display control). 



332 AcqKnowledge 4 Software Guide 

Visit the online support center at www.biopac.com 

  
3D Output Example Compare ECG cycles in 3D Output. The following example shows how to 

AcqKnowledge will generate a 3D image using each cross section of ECG. 
a)  Cycles/Peaks tab: set the threshold level to identify each R-wave. 
b)  Selection tab: set the edge to 

Current Peak 
Left edge -.5 seconds 
Right edge .5 seconds 

c)  On the Output tab 
Enable 3D Output 
Specify the channel to generate a surface from. 
Choose “cycle data” for the cross-section format. 

d)  Click Find All Cycles. 
Output Events 

 

Toggle the “Output events” checkbox at the top of the 
Events tab to turn Event Output on and off. 
The Cycle/Peak Detector Output mode can define 
events at specific locations; a maximum of two events 
per cycle can be inserted with Event Output. After the 
Cycle Detector has located a cycle and adjusted the 
selection, the data within that cycle can be analyzed 
and used to create new events in the graph (data-
driven or time specific). 

Event definition 

  

 
Insertion method & 
channel selection 

Brief definitions follow, see the Event Location table on page 334 for details: 
To pllace the event directly at the specified interval (start or end). See Interval 
Adjustment on page 333. 
Percent change looks for a crossing based on a percentage of the value of the 
signal at the corresponding edge and places the event when a signal increases or 
decreases in value from the edge. 
% peak to peak looks for a point where the signal's value has changed by a 
percentage of the maximum peak-to-peak amplitude distance over the selected 
area and places the event when a signal increases or decreases in value from the 
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edge 
Minimum place events at the minimum of a specific channel's data within the 
selection. 
 
Maximum place events at the minimum of a specific channel's data within the 
selection. 
The channel whose data should be examined is specified in the pull-down menu 
directly to the right of the insertion method pull-down menu: 

Output type For each insertion method, the “Output type” pull-down menu adjusts the event 
type of the inserted event. 

Output channel Sets the channel where the event is inserted, either “Global” for defining global 
events or specific channels. 
 None—disables any insertion for that event and all of the other controls 

will be hidden except the insertion method pull-down menu. 
 Interval start / Interval end—a pull-down menu is displayed to be used to 

change between the different offset methods 
 Minimum / Maximum  

Output label Use this edit field to type in specific label text. Each event that is inserted will 
have its label set to this text. By default, it is empty (inserted events will not be 
labeled). 

Interval Adjustment When an “At location” method is used, options will be generated to fine-tune 
event placement relative to the Interval end or Interval start of the selection. 

Offset Underneath the insertion method pull-down menu, a set of controls will be 
added, allowing the user to specify the percentage, choose whether to search for 
an increase or decrease, and choose the channel whose signal should be 
examined. 

 
When the offset method is “Threshold crossing,” the event will be placed when 
the signal on a channel crosses a threshold.  
There are a number of possible ways to configure the threshold crossing: 
 Fixed—The edit field may contain a specific voltage level for the threshold. 

In this configuration, an event will be placed if the value of the channel 
specified in the next pull-down menu crosses this fixed voltage value. 

 + value—The edit field may specify an offset from the value of the channel 
at an interval start or end. The threshold voltage level is the value of the 
chosen source channel plus the offset from the edit field. To specify a 
threshold lower than the value of the channel at the interval start or end, 
choose the – value option. Mean and percentage of peak-to-peak + or – 
options are available as well. 

Direction of 
 crossing 

The direction of the crossing can be specified. 
 + (positive crossing)—the signal must approach the threshold from below 

and cross to above the threshold before an event is inserted. 
 - (negative crossing)—the signal must approach the threshold from above 

and cross to below the threshold before an event is inserted. 
 ± (mixed threshold)—an event will be inserted at the first positive or 

negative crossing that is encountered. 
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Event Location Table 
Insertion Method Location Process 

Interval, at location Place an event at the left or right boundary of the selected area, as specified. 
Interval +/- percent 
offset 

Given a particular channel, place an event at the specified time within the 
selection when the signal increases or decreases by a specific percentage. 

 
Interval start + Place at the time closest to the left boundary of the 

selection. The percentage is calculated from the value of 
the signal at the left boundary of the selected area. 

 
Interval end - Place at the time closest to the right boundary of the 

selection. The distance between the event and the right 
edge of the selection will have an amplitude difference 
equal to the indicated percentage of the right edge’s 
value. 

If the signal does not increase or decrease by that percentage within the 
selection, no event will be inserted. 

Interval +/- percent peak 
to peak offset 

Given a particular channel, place an event at the specified time within the 
selection when the signal increases or decreases by a specific percentage of 
the peak to peak delta of the selected area. 

Interval start + Place at the time closest to the left boundary of the 
selection. The percentage is calculated from the result of 
subtracting the minimum value of the signal over the 
selected interval from its maximum. 

Interval end - Place at the time closest to the right boundary. The 
distance between the event and the interval end of the 
selection will have an amplitude difference equal to the 
indicated percentage of the minimum value of the signal 
over the selected interval subtracted from its maximum. 

If the signal does not increase or decrease by that percentage within the 
selection, no event will be inserted. 

Interval +/- threshold 
crossing 

Starting at the specified boundary of the selection, determine a threshold 
value. This threshold voltage may be: 

 fixed voltage level 
 value of signal at the specified interval + offset 
 mean value in selected area + offset 

Interval start + Search for the first location where the signal on a 
particular channel crosses the threshold. 

Interval end - Examining data from right to left, search for the rightmost 
location where the signal on a particular channel crosses 
the threshold. 

If the direction of the threshold crossing matches the user specified direction, 
then an event is inserted. If it does not, then the next threshold crossing is 
located and the process repeats. If the threshold is never crossed within the 
selected area in the user-specified direction, no event is inserted. 

Minimum The event will be placed at the time location corresponding to a specific 
channel’s minimum value within the selected area. 

Maximum The event will be placed at the time location corresponding to a specific 
channel’s maximum value within the selected area. 
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Output Focus Area 
Use this tool to define and highlight focus areas within the graph and include them in the Find Cycle output. 

 
Define focus areas at selection boundaries 

When checked, focus area output is enabled. Focus area selection boundaries will be defined as determined in 
the Find Cycle selection setup. 

Label basename 

Use to assign a name or label to the cycles located in the focus area. The defined basename will appear in the 
focus area section of the graph, along with incremented numbers for each subsequent cycle. (See below) 

 
Find Cycle data derived from multiple focus areas can also be exported to either a single spreadsheet, or 
multiple spreadsheets. If the “Multiple” option is selected, each defined focus area will have data exported to a 
separate spreadsheet. (i.e., three focus areas will output three spreadsheets.) 

 
Output: Clustering 

Clustering is the process of taking a set of data points and partitioning them into a fixed number of groups 
called clusters. Each cluster represents data points that may share some type of commonality. This can be used 
to assign each data point to a class of similar points. Clustering can be used for hemodynamic analysis and is 
one of the basic analysis tools used for spike analysis in neurophysiology. 

Algorithm Overview 
K-means clustering is an iterative algorithm that begins with a data set of real-valued points in an n-
dimensional space. Given this data set, one then specifies how many clusters are present. The k-means 
clustering algorithm attempts to find the location at the center of each of these clusters. Essentially, this 
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algorithm partitions the data set into k groups such that the sum of the differences between the centers of 
each group and its remaining members is minimized. 
A basic algorithm description is: 

A. Given a total of k clusters, choose k potential cluster centers. 
B. Assign each member of the data set to a cluster according to the closest potential cluster center 

using a Euclidean distance function (sum-of-squares). 
C. Adjust the location of the potential center for each cluster to a more optimal value. The most basic 

method is to assign the new center to match the mean value of all of the members of the set. 
D. Determine if the set of clusters and centers is satisfactory. If not, go to step 2 and repeat the 

clustering process. 
There are many different variations on what constitutes satisfactory ending conditions. The most ideal 
stopping criteria are when the cluster assignments no longer change with successive iterations. When there 
is no change in the centers, the solution perfectly minimizes the Euclidean distance sum for each cluster, 
unique up to variations in ordering of the dimensions. In practice, determining the perfect clustering of a 
data set is computationally intensive and may require some time to process. Approximations of perfect 
clustering are quicker to compute and usually produce sufficiently accurate results. 
 A waveform segment is reduced to a single data point by extracting numerical quantities known as 
features. Feature clustering is a very common data reduction method in use by clustering-based spike 
sorting software. Each feature is a single real-valued number extracted from the data. Examples of features 
are: maximum amplitude in waveform segment, minimum, time to maximum, time to minimum, peak to 
peak distance, sum of all values, maximum slope of peak. 

A commonly used clustering analysis starts with two features. The features are then calculated for each 
waveform segment and presented on a scatter plot, allowing the user to visually determine how many 
clusters may be present. A k-means clustering analysis is then run on these data points to determine the 
center of the clusters in feature space. With the center known, each waveform segment is then assigned to a 
cluster depending on the values of its features. 

Clustering Settings 

  
Number of clusters 

After features have been extracted, data points constructed from the feature are split up into a number of 
groups. Enter the number of clusters into which the data is to be partitioned.  
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Locate Cluster Centers 
Clustering has a good potential to form the basis for classifiers to score physiological data. The cluster 
centers can be located by keeping ther centers fixed and manually setting the cluster centers (above left) or 
by automatic learning, which dynamically locates the cluster centers based upon a training set of all data,  a 
subset of data based upon a percentage, or based upon a selected event in the data. 
Manually 
The manual method allows the centers of each cluster to be manually typed in and edited. Instead of 
running a full k-means algorithm to locate centers, the k-means algorithm will simply run through the data 
set and assign each element to the closest cluster center and apply any outlier detection. 
This simplistic clustering will allow centers as computed from a previous run to be used in subsequent 
clustering. Using manually specified centers is necessary to provide consistency when clustering data that 
may occur in different experiments or different graph files. The use of manual centers allows for the 
clustering implementation to be used as a classifier to compare new data sets to clusters as determined from 
either ideal or previously scored data sets. 
By Learning 
The learning method will use the full k-means clustering algorithm as described above. This consists of 
choosing candidate centers, computing mean distances, adjusting the candidate center positions, and 
repeating until termination conditions are met. 
The data set used to compute the center positions can either be the full data set, a subset of the data or an 
event within the data set. 

Training Set Definition 
The training set is the set of data that is used during the iterative portion of the clustering algorithm that 
learns the potential center of each cluster. Training sets are only used for learned centers. There are three 
ways to specify a training set for use in clustering: 

• Use all of the source data when searching for the centers.  
• Allow the training set to be a specific percentage of the total source data set with members of the 

training set chosen at random. 
• Manually identify the training set with events located in the data. 

Partial clustering refers to running the k-means clustering algorithm on only a subset of the source data. 
There are a number of reasons to perform partial clustering. One is computational efficiency. K-means 
clustering can be a time intensive procedure, as each iteration of the algorithm must recompute all of the 
distances to reclassify the entire data set. By performing partial clustering, it is possible to reduce the 
complexity of the k-means clustering step by limiting the amount of source data that needs to be processed 
in each step. This may be acceptable in situations where perfect partitions are not required. 

Another use of partial clustering is to construct a classifier. A classifier is some method for assigning a 
particular data point to a specific class. To construct a classifier using k-means clustering a k-means 
algorithm is run on a training set that has known desirable data properties for splitting data into a number of 
classes. Once the centers of this training set are known, they can be used to perform another clustering 
analysis on a set of unknown data and determine how well that data exhibits the properties of the training 
set. 

Max. iterations 

This field is used for entering the maximum number of iterations the k-means algorithm is run. If the 
specified number of iterations is reached, prrocesing will halt and not centers will be located. 

Tolerance 

This value represents the minumum distance allowed for center adjustment. If the centers move by less than 
this value in subsequent learning steps, they will be considered stable and clustering will commence. 



338 AcqKnowledge 4 Software Guide 

Visit the online support center at www.biopac.com 

Remove Outliers 

The clustering analysis allows for optional removal of outliers, or spurious data points. When enabled, each 
cluster is assigned a boundary. After each data point has been assigned to the cluster, the standard deviation 
of the distance of each point from the center of the cluster is computed. When outlier rejection is enabled, 
any data point that is farther away from the center than a specific number of standard deviations will be 
removed from the cluster. Enabling outlier removal retains only the points in a cluster that have the 
strongest association with each other. 

Clustering Criteria 

 

For a particular segment of a waveform, features are 
extracted based upon user-specified criteria. 

Segment Width Peak to Peak 
Value (left edge) Time peak to Peak Delta 
Max Sum 
Min Median 
Time to Max Mean 
Time to Min Measurement Result 

Multiple segments are located using the Find 
Cycle/Peak functionality. After the criteria have been 
computed for each segment, clustering is then 
performed. This allows segments to be partitioned 
based upon their features. For example, “Segment 
Width” criteria can be used to partition ECG cycles 
into two clusters of shorter segments and longer 
segments. 

The criteria Segment Widths are reported in milliseconds, as are the other time-based criteria (Time to Max; 
Time to Min; and Time Peak-to-Peak Delta). If the measurements are fixed to units of milliseconds, then K-
Mean Criteria results will match measurement magnitude results. Clustering is defined with a hard left to right 
directionality for all measurements. Therefore, Delta T will have opposite signs than the same measurement 
pasted with Find Peak. 

Clustering Output 

The output of a clustering analysis can be 
presented in multiple ways, including events, 
waveforms in the graph, textual tables, and 
visual scatterplots. These outputs allow for visual 
examination of the clustering results for 
anomalies and also provide a foundation for 
further data reduction using other AcqKnowledge 
tools. By examining waveform data in a reduced 
feature space, it may be possible to construct 
clustering configurations that allow for 
separation of neuron action potentials into 
different classes, detection of heart arrhythmias, 
and other classification tasks.  

One of the traditional methods of presenting 
results of a k-means analysis is through 
scatterplots. Scatterplots are dot plots with a 

single dot per waveform segment run through the k-means clustering algorithm. They provide good visual 
references that can be used to estimate the potential number of clusters actually present in data and to compare 
the distinguishing abilities of different sets of criteria. 
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The scatterplot can be extended into three dimensions to provide feedback on relations between three criteria at 
the same time. With each criterion assigned to one of the three coordinate axes, a small sphere centered around 
the criteria values for a waveform segment can be constructed. Displaying the spheres for all data points would 
create the 3D scatterplot.  

To generate 3D criteria scatterplots, select at least three criteria. There is also an option to change the 3D 
scatterplot background color and export results to an Excel spreadsheet. (See example scatterplots, next page). 

 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
If the “Paste measurement to Journal” preference is set, measurement values will be pasted into the Journal each 
time a cycle is found, as shown above. Each column corresponds to a measurement value (in this case, Value 
and BPM). 

Excel Spreadsheet Export—The cycle detector has also been enhanced to allow for the direct creation of 
spreadsheets. The cycle-to-cycle values of the measurements can be inserted directly into an Excel spreadsheet 
file. Each measurement is placed into an individual column and each cycle corresponds to a single row. To 
generate the spreadsheet a “Find All Cycles” operation is required.  

• Also available for File > Save As, File > Save Journal Text As, and Specialized Analysis tools. 
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The following example details how to detect the positive spike in the QRS complex—a typical use of 
the Find Cycle (peak detection) function. 

 
1. Select the area around a typical peak.  

 
2. Select Find Cycle (Locate cycles from peaks). 
3. Enable “Use selected maximum” on the Cycles/Peaks tab to automatically set an appropriate threshold 

value based on the amplitude of the cycle detector. 
4. Click the Output tab and choose the desired option(s), such as paste measurement controls to update the 

journal with the measurement values from the new peak. 
5. Click a Find button. 

• Find first cycle – the edge will blink at the first cycle point 
• To manually move through the file, click Find next 
• Or, select an area and choose Find all 
• Or, place the edge in the data and Find all will detect cycles from that point forward. 

• Find All Cycles will find all cycles from the beginning of the selected area to the end of the waveform. 
• Find in Selected Area will only find cycles in the selected area. 
• Find in Focus Area will only find cycles in focus areas. 

To use an offset 
Use the Selection controls to set a time window around the selected cycle; previous peak controls the left edge, 
Current peak has options to control the left and right edges.  
1. Use steps 1-4 above. 
2. Click the Selection tab. 
3. Set the desired edge values. 

• For example, to set the time window 0.5 seconds prior to the previous peak. 

 
To control the left and right edges, select current peak and enter the appropriate time window to define an 
interval around the cycle. 
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Find Rate 

  
The Rate Detector is critical to AcqKnowledge’s ability to extract information from physiological data that has 
a degree of periodicity. Physiological data that can be investigated using the AcqKnowledge Rate Detector 
includes: 

• ECG (e.g. Heart Rate or Inter-Beat-Interval recording) 
• Blood Pressure (e.g. Systolic, Diastolic, Mean, dP/dt Max, dP/dt Min) 
• Respiration (Respiration Rate measurement) 
• EMG (Zero Crossing or Mean Frequency analysis) 

The Find Rate function allows you to compute rate calculations (including BPM) for data that has already been 
collected. Although this function uses the same algorithm as the online rate detector (which uses a Calculation 
channel), it can be advantageous to perform rate calculations after the data has been acquired. One benefit is 
that off-line rate computations do not require that a separate channel (i.e., a Calculation channel) be acquired. 
Since the number of acquired channels is reduced, other data can be collected and/or data can be sampled at a 
higher rate. 
Rate detector settings are graph-independent, which means that find rate operations can be performed in 
multiple graphs without needing to re-enter graph-specific settings for each run. By using multiple data views, 
different find rate operations can be performed on the same set of data without losing settings between “Find 
Rate” operations. When the Rate Detector is first opened for a graph, the dialog will be filled with the values 
from the last successfully executed Find Rate operation. Subsequently, changes to the settings will be applied 
only to that graph. 
Modes of Operation 
The Rate Detector incorporates a significant amount of flexibility to optimize performance when extracting data 
from periodic physiological waveforms. There are three basic modes of operation for the Rate Detector: 
1) Fixed threshold detect mode 
2) Auto threshold detect mode (enables Noise rejection) 
3) Remove baseline and Auto threshold detect mode 
Generally, it’s best to use the simplest Rate Detector mode that is suitable for your application. If the simplest 
mode doesn’t work, add layers of sophistication, one at a time. For example: 
If the Fixed threshold mode can’t or will not work, use the Auto threshold detect mode. 
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If the Auto threshold detect mode is similarly unavailable, adjust the Noise rejection or add the Remove 
baseline option.  

1) Fixed threshold detect mode: 
Fixed threshold detect mode is the simplest mode of operation for 
the Rate Detector. As shown here, the Threshold Level has been set 
to 0.00 Volts. If the waveform crosses 0 Volts, the Detector will 
begin to look for Positive or Negative peaks (based on the Peak 
detect setting). 
Not available in Fixed mode: 
Noise rejection 
Baseline window width 
Windowing options 
 
 
 
 
 
 
 
2) Auto threshold detect mode:  
Auto threshold detect mode is a more advanced and flexible mode of 
operation for the Rate Detector. In this case, the Rate Detector will 
create a variable threshold defined as: 
 Positive peak search 
  0.75 • (Old Peak Maximum - Old Peak Minimum) 
 Negative peak search 
  0.25 • (Old Peak Maximum - Old Peak Minimum) 
Furthermore, the Rate Detector will construct a moving file of data 
points defined by 1.5 times the number of samples that can be placed 
in the largest rate window size (defined by the Window settings). If 
the Rate Detector loses sync (no trigger event inside the window), 
the threshold is changed to the mean value of the moving file of data 
points. This operation permits successful recovery in the event 
of spurious waveform data values. 
The Noise rejection setting creates Hysteresis around the variable 

threshold. The Hysteresis level is defined as: 
Hysteresis = Noise rejection (%) • (Old Peak Maximum - Old Peak Minimum) 
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3) Remove baseline and Auto threshold detect mode: 
Remove baseline and Auto threshold detect mode is an advanced 
and flexible mode of operation for the Rate Detector. Primarily, 
the Rate Detector performs an automatic (and hidden) moving 
difference function on the waveform data. The difference function 
is performed over a variable number of samples defined by: 
# of points = (baseline window width / 1000) * Sampling Rate 
This difference waveform is then passed through the variable 
threshold: 
Positive peak search =  0.75 • (Old Peak Maximum - Old Peak 
Min) 
Negative peak search = 0.25 • (Old Peak Max - Old Peak Min) 
Furthermore, the Rate Detector will construct a moving file of data 
points defined by 1.5 times the number of samples that can be 
placed in the largest rate window size (defined by the Window 
settings). If the Rate Detector loses sync (no trigger event inside 

the window), the threshold is changed to the mean value of the moving file of data points. This operation 
permits successful recovery in the event of spurious waveform data values. 
 

FIND RATE OPERATIONAL SUGGESTIONS 

Option Waveform Characteristics 

Fixed threshold option • Waveform data has clearly defined positive or negative 
peaks (like respiratory or air flow data), which are 
consistently higher (in magnitude) than the rest of the 
waveform. 

• waveform data has clearly defined zero-crossings (like 
EMG), and you wish to determine the rate of these 
crossings 

Auto threshold detect option • Waveform data has a moving baseline, but the peaks are 
otherwise larger in magnitude than other parts of the 
waveform (blood pressure). 
You may need to adjust the Noise rejection (Hysteresis) to 
optimize performance. 

Remove baseline and 
Auto threshold detect options 

• Waveform data has high narrow peaks (like most ECG 
leads), which may or may not be larger in magnitude than 
other (slow moving) parts of the waveform. 
You may need to adjust the Noise rejection (Hysteresis) to 
optimize performance. 
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Signal type 
The Signal type menu contains parameters for specific human and 
animal waveform morphologies. All pre-defined and custom signal 
types are common to both calculation channel Rate (online) and 
analysis Rate (offline) dialogs. Signal type modifications affect 
settings in the Signal Parameters tab only, and do not affect the 
Output tab settings. 
Select from six pre-configured signal types or click “New” to 
create, name and save custom setups. This allows quick access to 
frequently used Rate detection signals without the need to recreate 
modified settings. Custom Rate signal types may be added or 
deleted in the same manner that channel presets are in other areas of the AcqKnowledge application. 
Peak detect 

By default, the Peak Detector searches for Positive peaks (upward pointing, such as the R-wave of an ECG 
signal) to calculate the rate of a waveform. In some instances, however, you may have to base the rate 
calculation on negative peaks (downward pointing). To do this, select Negative peak. 

Remove baseline 
The Remove baseline option applies a difference operation to preprocess the signal. This option is useful 
when signals have a slowly fluctuating baseline. 

Auto threshold detect 
When the Auto threshold detect box is selected in the Find Rate dialog, AcqKnowledge automatically 
computes the threshold value using an algorithm that accentuates peaks and uses information about the 
previous peak to estimate when and where the next peak is likely to occur. This threshold detector is typically 
more accurate than a simple absolute value rate calculation function, and is able to compute a rate from data 
with a drifting baseline and when noise is present in the signal. (For a detailed description of how the 
calculation is performed, contact BIOPAC Systems, Inc. for the complete Application Note.) 
 When Auto threshold detect is enabled, the Noise rejection and Window options are enabled. 

Threshold level 
This option (activated when “Auto threshold detect” is not selected) lets 
you enter a threshold level to be used for a simple absolute value rate 
calculation function. 
 The Auto threshold detect option is typically more accurate.  

Noise rejection 

Noise rejection (activated when “Auto threshold detect” is enabled) 
constructs an interval around the threshold level. The size of the interval 
is equal to the value in the “Noise rejection” text box. Checking this 
option helps prevent noise “spikes” from being counted as peaks. 
 The default is equal to 5% of the peak-to-peak range. 

 

Cycle Interval Window 
The Cycle Interval Window is used to specify an 
upper and lower limit for the Rate calculation. 
Window is activated when “Auto threshold detect” 
is enabled; the Windowing Units pull-down menu is 
only activated when the selected Function can have 
variable units. (Hertz, BPM or Seconds.) 
Setting the upper and lower bounds for the 
“window” tells AcqKnowledge when to start looking 
for a peak. 

 

Defaults:  Min 40 BPM 
  Max 180 BPM 
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AcqKnowledge will try to locate a peak that matches the 
automatic threshold criteria within the specified window. 
If no peak is found, the area outside the envelope will be 
searched and the criteria (in terms of peak value) will be 
relaxed until the next peak is found. 
For instance, once the first peak is found, AcqKnowledge 
will look for the next peak in an interval that corresponds 
to the range set by the upper and lower bounds of the 
window. The interval associated with the upper band of 
180 BPM is 0.33 seconds (60 seconds ÷ 180 BPM), and 
the interval for the lower band is 1.5 seconds (1 minute ÷ 
40 BPM). If a second peak is not found between .33 
seconds and 1.5 seconds after the first peak, then 
AcqKnowledge will look in the area after 1.5 seconds for 
a “smaller” peak (i.e., one of lesser amplitude). 
For those rate functions that require a window interval in 
seconds, you will probably want to enter numbers like 
.33 seconds and 1.5 seconds (which correspond to the 
BPM defaults of 40 and 180). These numbers will be 
suitable for detecting the heart rate of an average subject. 

 

 
 
Window (Peak Interval) 

A simple peak detector uses what is called a threshold-crossing algorithm, whereby each time the amplitude 
(vertical scale) value exceeds a given value, the peak detector “remembers” that point and begins searching 
for the next event where the channel crosses the threshold. The interval between the two occurrences is then 
computed and usually rescaled in terms of BPM or Hz. This is how the AcqKnowledge rate Calculation 
functions when all options are unchecked. 
In the sample waveform shown here, the threshold was set to 390 mV to detect the peaks of the waveform and 
provide an accurate rate calculation. Since it only recognizes signals greater than 390 mV as a peak, this 390-
mV threshold is referred to as an “absolute threshold.” Most waveforms are not so well behaved, however, 
and artifact can be introduced as a result of movement, electrical interference, and so forth. Combined with 
actual variability in the signal of interest, this can result in “noise” being included with the signal, as well as 
baseline “drift can render absolute threshold algorithms useless. 
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Additional Find Rate Dialog Settings, Output Tab 

 
Function 

The Rate Detector Function menu lists a variety of calculations, which are discussed below. 
Rate (Hz), Rate (BPM), Interval (sec) 

The most commonly used function is the Rate (BPM) option, which calculates a rate in terms of beats 
per minute or BPM. Rate calculations can also be performed that return a rate value scaled in terms of 
frequency (Hz) or time interval (sec). When rate is reflected in terms of a time interval, the time 
difference (delta T) between the two peaks is returned. This is sometimes referred to as the inter-beat 
interval (IBI). The frequency calculation returns the rate in Hertz (Hz), which is computed by dividing 
1 by delta T. These measurements are perfectly correlated with the BPM calculation, since BPM is 
equal to 60 times the frequency calculation, or 60 divided by delta T. 

Peak time 
Returns the time (in seconds) at which the peak occurred. Like the other Rate functions (e.g., BPM and 
Hz), the value of the last peak time will be plotted until a subsequent peak is detected. The resulting 
plot will resemble a monotonically increasing “staircase” plot. 

Count peaks 
Produces a plot of the number of peaks (on the vertical axis) vs. time on the horizontal axis. When used 
with the delta measurements (in the measurement windows), this is a convenient way to calculate how 
many peaks occur within a selected area. 

Peak maximum/minimum 
Tracks the maximum value of the peak (the ECG R-wave). This correlates to the systolic pressure in 
blood pressure readings. To search for minimum peak values, select negative from the Peak detect 
section of the dialog.  

Peak-to-peak 
Looks at the vertical difference between the maximum and minimum values of the waveform on a 
cyclical basis—useful when you want to determine the amplitude of your pulsatile signal. 

Mean value 
Computes the mean of a pulsatile signal on a cycle-by-cycle basis between two peaks; produces a 
staircase plot. 
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Area 
This function computes the area of the signal between two peaks, on a cycle-by-cycle basis.  

Sum (not shown) 
This function extracts the sum of all amplitudes for each cycle.  

Use Averaging Mode 
Use this option to average the output of the selected function using values based upon a fixed time window or a 
fixed number of cycles. If the average is taken from a fixed number of cycles, there is an additional option to 
recompute on every cycle. When unchecked, the output will be reset after the selected number of cycles are 
detected and remain fixed until the next group cycles are detected. When checked, the output will start after the 
first cycle is detected and will then be refreshed on every cycle. 
Output reset events 

This option controls the definition of reset event insertion into the graph. 
If no thresholds are found within the user-specified window width, the automatically detected threshold level 
will “reset” and tracking will start anew; the output of the rate detector function may also drop to zero. When 
“Output reset events” is enabled, a reset event will be added to the channel whenever the threshold is reset 
due to window expiration 
 This helps distinguish zero-valued output due to 

window resetting and true zero-value output. 
In the sample shown, the signal drops to zero during a 
period of analysis (e.g., due to lead clip falling off). 
Reset events indicate automatic threshold tracking was 
lost in this interval and the points where the search for 
a new level begins. 
 

Put Result in New Graph 
When this option is checked, the results from the find rate calculation are plotted in a new graph window with 
data displayed in X/Y format, with time on the horizontal axis. By default, this option is unchecked and the 
resulting transformation is placed in the lowest available channel of the current graph. 
NOTE: When put into a new waveform or used as a calculation channel, the output rate function uses 
padding to generate a signal at a continuous sampling rate. The extracted value is used for padding until the 
next cycle is detected. This padding can cause unsuitable weighting for statistical analysis. For accurate 
statistical analysis with only one value for each cycle, use the offline rate detector "show output in new 
window" to produce a "value" waveform with one output point for each cycle. This output is suitable for 
export to Excel or other software for statistical analysis. 

Find Rate of Entire Wave 
When this option is checked, the rate (or other function from the Find rate command) will be calculated for 
the entire wave (other than the selected area, if any). 

Don’t Find 
Saves dialog settings so you can close out of the dialog and select an area. When you reopen the dialog, the 
settings will be established as before you closed out, and you can click the OK button to perform the Find 
Rate function. This is useful for setting parameters using an area of a waveform and then repositioning the 
cursor at another point in the record. 

Specialized Analysis 
The Specialized Analysis package includes tools to automate analysis to save hours (or days!) of processing 
time and standardize interpretation of results. 
A courtesy copy of the Specialized Analysis package is installed under the Analysis menu with 
AcqKnowledge™ 4. 
See the next chapter for full details.  
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Chapter 17 Specialized Analysis 

 

 

The Specialized Analysis package includes comprehensive 
analysis tools to automate analysis to save hours (or days!) of 
processing time and standardize interpretation of results. 
• AcqKnowledge™ 4 includes a courtesy copy of the 

Specialized Analysis Package under the Analysis menu.  
Specialized Analysis provides extensive post-acquisition analysis 
options similar to modules from Mindware Technologies, 
PONEMAH Physiology Platform, EMKA Technologies, SA and 
other advanced analysis applications. If you need still more 
analysis options, save the data as MatLab, Igor Pro, PhysioNet, 
raw, or text format—or compress the file to reduce file size by 
about 60%. 
Analyze data collected on Hardware Systems with Windows OS 
or Mac OS X.  
 
See the Analysis menu on page 313 for other operations that 
derive data and measurements from the graph: 

Histogram 
Autoregressive Modeling 
Nonlinear Modeling 
Power Spectral Density 
AR Time-Freq Analysis 
FFT  
DWT  
Principal Component Analysis  
Independent Component Analysis  
Find Cycle  
Find Next Cycle  
Find All Cycles in Focus Area 
Find All Cycles  
Find In Selected Area 
Find Rate 

The Specialized Analysis package includes the following Analysis Packages and Classifiers: 
Analysis package—bundle of transformations created to assist with analysis in a specific area of research.  
Classifier—special-purpose transformation that defines events at well-known points of interest on standard 
waveforms, such as the ECG wave boundary classifier and the QRS beat detector and arrhythmia detector. 
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Detect and Classify Heartbeats 
Locate Human ECG Complex Boundaries 
Locate Animal ECG Complex Boundaries 
Gastric Wave Analysis 
Gastric Wave Coupling 
Chaos Analysis 

Detrended Fluctuation Analysis 
Optimal Embedding Dimension 
Optimal Time Delay 
Plot Attractor 

Correlation Coefficient 
Electrodermal Activity 

Derive Phasic EDA from Tonic 
Event-related EDA Analysis 
Locate SCRs 
Preferences: Output Display Format; Phasic EDA 

Construction Method: Smoothing Baseline Removal or 
High Pass Filter 

Electroencephalography 
Compute Approximate Entropy 
Delta Power Analysis 
Derive Alpha-RMS 
Derive EEG Frequency Bands 
EEG Frequency Analysis 
Remove EOG Artifacts  
Seizure Analysis 
Preferences: Output Display Format 

Electromyography 
Derive Average Rectified EMG 
Derive Integrated EMG 
Derive Root Mean Square EMG 
EMG Frequency & Power Analysis 
Locate Muscle Activation 
Preferences: Output Display Format 

Ensemble Average 
Epoch Analysis 
Focus Areas 

Define Between Events 
Define for Appended Segments  

Hemodynamics 
Classifiers: ABP; LVP; MAP  
Arterial Blood Pressure 
Baroreflex Sequence Analysis (licensed feature) 
Baroreflex Slope Analysis (licensed feature)  
ECG Interval Extraction 
Estimate Cardiac Output from ABP  
Left Ventricular Blood Pressure  

Monophasic Action Potential 
Preferences: Output Display Format; LVEDP Location 

Method; dP/dt pk-pk %; MAP Plateau Location Method; 
dP/dt MAP pk-pk % 

HRV and RSA 
Multi-epoch HRV – Statistical 
Multi-epoch HRV and RSA – Spectral 
R-R Poincare Plot 
RSA – Time-series  
Single-epoch HRV – Spectral 

Impedance Cardiography 
Body Surface Area Ideal Body Weight 
ICG Analysis VEPT 
PEP Pre-ejection Period 
dZ/dt Derive from Raw Z 
dZ/dt Classifier: B, C, X, Y, and O Points 
dZ/dt Remove Motion Artifacts 
Preferences: Output Display Format; C-, B-, and X-Point 

Location; Stroke Volume Calculation Method; Body 
Measurement Units; Body Surface Area Method; Ideal 
Weight Estimation Method; dZ/dt Max Method 

Magnetic Resonance Imaging 
Artifact Frequency Removal Signal Blanking 
Artifact Projection Removal Slew Rate Limiter 
Median Filter Artifact Removal 

Neurophysiology 
Amplitude Histograms Classify Spikes 
Average Action Potentials Dwell Time 
Histograms 
Generate Spike Trains Locate Spike 
Episodes 
Find Overlapping Spike Episodes 
Set Episode Width and Offset 
Preferences: Detect Spike; Default Episode Width; Default 

Episode Offset; Default # of Spike Classes 
Noldus 
Principal Component Denoising 
Remove Mean 
Remove Trend 
Respiration 
 Compliance and Resistance 
 Penh Analysis 
 Pulmonary Airflow 
Spectral Subtraction 
Stim-Response 

Digital Input to Stim Events Stim-Response Analysis 
Waterfall Plot  
Wavelet Denoising 

AcqKnowledge File Portability  
Use Specialized Analysis to analyze AcqKnowledge data files collected on Hardware Systems running on 
Windows/PC or Mac OS X. Open/save the following file formats: 
Opening files for Specialized Analysis 
The default file formats (Graph and .ACQ) are referred to as 
“AcqKnowledge” files. The AcqKnowledge file format is the standard 
way of displaying waveforms in AcqKnowledge. These files are stored in 
a compact format that retains information about how the data was 
collected (i.e., for how long and at what rate) and takes relatively little 
time to read in (compared to text files, for instance). AcqKnowledge files 
are editable and can be modified and saved, or exported to other formats 
using the Save as command.  
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File Compatibility 
 Mac AcqKnowledge 3.9and above can open and create PC-compatible Graph (*.acq) and Graph Template 

(*.gtl) files. Variable sampling rate information and hardware settings are retained, and Journals can be read 
from and written to PC files. Files must end on a multiple of the lowest channel sampling rate to be fully PC 
compatible. 

Saving files after Specialized Analysis 

 
Saving Files AcqKnowledge 4 

The default file format for the File>Save as command is to save files as an 
AcqKnowledge file. Selecting Graph (MPWS) or .ACQ (MPWSW) from 
the popup menu in the Save As dialog will save a file as an AcqKnowledge 
file, which is designed to be as compact as possible. These files can only 
be opened by AcqKnowledge, but data can be exported to other formats. 
File > Save Selection As allows you to save only a portion of your file. 
When this option is enabled, only the data that has been selected with the 
I-beam tool will be saved. This option saves the selected area to another 
file and does not affect the current file that you are working in. 

File Compatibility  
Windows AcqKnowledge 3.9 and above files can be opened with Mac AcqKnowledge 3.9 and above, but some 
advanced features may not transfer. 
Mac AcqKnowledge 3.9 and above can save as “Graph (Windows)” files, but it saves in Windows 
AcqKnowledge 3.7.1 format. In this earlier format, all data is retained, but newer AcqKnowledge features (like 
dual stimulation, data views, embedded archives, etc.) are lost along with any settings specific to Mac 
AcqKnowledge (like events, adaptive scaling settings, etc.). 
 Mac AcqKnowledge 3.9 and above can save PC-compatible Graph (*.acq) and Graph Template (*.gtl) 

files. Variable sampling rate information and hardware settings are retained, and Journals can be read from 
and written to PC files. Choose the format “Graph (Windows)” to create PC-compatible files. 

The Mac version does not save PC GLP files or compressed PC files.  
Files must end on a multiple of the lowest channel sampling rate to be fully PC compatible. 

Excel Spreadsheet Export—The Specialized Analysis tools have been updated to automatically export their results to 
an Excel spreadsheet if desired. The spreadsheet contents mirror the tabular Journal text output. All the spreadsheets 
are saved as temporary files, so they need to be re-saved in order to be saved permanently. 

• Also available for File > Save As, File > Save Journal Text As, and Find All Cycles journal. 

Note Specialized Analysis scripts are complex and undo may not function for all steps. 
 Some of the specialized algorithms are very complex and processor intensive, so they may take a long (even 

very long) time to return a result. 
 Most specialized analysis operations create additional channels in the graph, thus changing the underlying 

data in the source channel. In this instance, attempting to acquire appended data into the source channel of a 
graph that has had an analysis operation applied will result in a standard message: “You have modified or 
edited data in a way that prevents appending acquisition. You can replace the existing data or abort.” This is 
normal for analysis operations that have modified the underlying graph data. Under this circumstance, all 
analysis operations will generate this message with the exception of the following: 

• DWT/IDWT  
• HRV 
• ICA/IICA  
• PCA/IPCA  

• Detect and Classify Heartbeats 
• Power Spectral Density 
• Nonlinear Modeling

 
 In AcqKnowledge 4.3 and later, an option to perform analysis on the entire graph or on the focus areas only 

is presented in setup dialogs for most Specialized Analysis tools. (This option not present in earlier 
AcqKnowledge versions.) 
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Detect and Classify Heartbeats 

 
This robust QRS detector is tuned for human ECG Lead II signals. It locates QRS complexes and places an event 
near the center of each QRS complex to identify the type of heartbeat event: 
 Normal: The beat was recognizable as a valid heartbeat falling in a human heartbeat rate. 
 PVC: The beat was shorter than the beats around it and may be a pre-ventricular contraction. These events can 

be found in the “Hemodynamic > Beats” submenu of the event type listing. 
 Unknown: The beat wasn’t recognizable as a valid heartbeat. This may occur on the first beat prior to the 

QRS detector locking onto the signal. It may also occur if tracking is lost due to changes in signal quality. 
The Cycle/Peak detector may be used with these events to perform further cardiac analysis. 
For information on the algorithm used in Detect and Classify Heartbeats, see page 426. 

 Watch the AcqKnowledge Detect and Classify Heartbeats video tutorial for a detailed demonstration of this 
feature. 

Locate Human ECG Complex Boundaries 

 
Locate Human ECG Complex Boundaries performs ECG waveform boundary detection for human ECG Lead II 
signals; ECG signals must be sampled at 5 kHz or below to be analyzed with this classifier. It will attempt to 
locate the boundaries of the QRS, T, and P wave and will define events for each individual complex. It will 
attempt to insert the following events; all of these complex boundaries can be found in the “Hemodynamic > ECG 
Complexes” submenu of the Event Type listing. 

Wave Type Event Placement & Description 
QRS Onset 

Peak 
End 

Before the beginning of the Q wave 
At the top of the R wave 
After the end of the S wave 

T-wave Onset 
Peak 

At the onset of T 
At the peak of the T wave 
Note: This may not be a positive peak if the T-wave is inverted. If the T-wave seems 

to be bi-phasic, two T-wave events will be inserted and the event description 
will indicate that the T-wave is bi-phasic. 

 End At the end of T 
P-wave Onset 

Peak 
At the onset of P 
At the top of the P wave 

Note: This may not be the absolute maximum, but rather the likely center of P. 
 End At the end of P 

The Cycle/Peak detector may be used with these events to perform further cardiac analysis. 
For information about the algorithm used in Locate Human ECG Complex Boundaries, see page 426. 

http://www.biopac.com/video/?video_category=automated-analysis-demos&v=classify-heartbeats�
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Locate Animal ECG Complex Boundaries 
Locate Animal ECG Complex Boundaries optimizes the ECG 
waveform boundary detection for animal input. Smaller animals 
such as mice often lack a detectable T wave, so in the setup dialog 
the T wave boundaries are disabled by default. If appropriate to the 
experiment, T wave detection can be applied by enabling the 
“Define T wave boundaries” checkbox. The average heart rate can 
also be customized to reflect the normal range of a particular animal 
subject. (The default rate is 600 BPM.) 
For information about the algorithm used in Locate Animal ECG Complex Boundaries, see page 425. 

 See the AcqKnowledge Locate Animal ECG Complex Boundaries video tutorial for a detailed explanation of 
this feature. 

Gastric Wave Analysis 

 

 
 

 Gastric Wave Analysis uses autoregressive time-frequency analysis to determine the classifications of gastric 
waves present in an EGG signal. The single wave analysis determines the percentage of gastric waves that fall 
within the frequency bands corresponding to normal, bradygastric, and tachygastric waves. The analysis also 
indicates the percentage of waves that fall outside of these boundaries and are arrhythmias. The frequency bands 
are expressed in units of “contractions per minute” and may be adjusted by the user. Presets for commonly used 
subject and wave types are predefined; you may extend these presets with your own. 

Gastric Wave Coupling 

   
Gastric Wave Coupling takes two EGG signals and uses autoregressive techniques to classify the contractions in 
those signals according to user-configurable frequency bands (similar to single channel Gastric Wave Analysis). 
In addition to providing classification information for the two signals, Gastric Wave Coupling provides a 
measure of the percentage of coupling between the two signals—this measure that can be used to determine the 
amount of slow-wave propagation across the stomach. 

http://www.biopac.com/video/?video_category=acqknowledge-new-features&v=locate-animal-ecg-complex-boundaries-in-acqknowledge�
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 See the AcqKnowledge Gastric Wave Analysis and Gastric Wave Coupling video tutorial for a detailed 
explanation of this feature. 

Chaos Analysis 

 
The “Chaos” analysis package assists the user in exploring the chaotic nature of data, including measurement 
selection and visualization of time domain attractors in the data. 
 

Detrended Fluctuation Analysis  

  
Modified root mean square analysis, useful for evaluating self-similarity in a long-term, non-stationary data 
series. Source data is mean-adjusted and then integrated; it is then split up into n segments of equal length, and in 
each segment, via linear regression, the best fit least squares line is computed. For a particular value of n and a 
number of samples N, the characteristic fluctuation of the piecewise linear fit yn. is defined as: 

F n 1
N k 1

N

y k yn k 2  

F(n) is evaluated over a user-specified range for the number of divisions. n will equal the total length divided by 
the number of divisions. A log-log plot of the interval width n in samples versus the corresponding value of F(n) 
will be created. If a linear relationship appears to exist in this graph, then the source signal displays some form of 
self-similarity. The slope of the line in this graph is related to the scaling exponent. 
 For more information on Detrended Fluctuation Analysis, see http://www.physionet.org/physiotools/dfa/ 

 
Optimal Embedding Dimension  

            

Indicates the number of times the dimensionality of the data is increased by adding additional copies of the data. 
Many of the fractal measurements take an embedding dimension parameter. Increasing the dimensionality of the 
data may improve the quality of the results. In general, embedding dimensions should always be less than 8. 
After the most relevant time delay for the data has been selected, Optimal Embedding Dimension assists in 
choosing the embedding dimension that appears to give the most accurate results. The embedding dimension is 
chosen to be the earliest dimension in the search range where the fractal correlation dimension measure reaches a 
local maximum. This indicates the lowest dimension where the data has the potential to exhibit the most self-
similarity. 
 Since real data may not be fractal in nature, there may be no local maximum for the embedding dimension. In 

this case, it is not possible to determine the optimal dimension. 
Optimal Time Delay  

   
Assists in picking a time delay that is most relevant for the data. It runs through and locates the earliest time delay 
in the specified interval range where the mutual information measurement reaches a local minimum.  

http://www.biopac.com/video/?video_category=automated-analysis-demos&v=gastric-wave-analysis�
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Optimizing the time delay in this fashion picks the shortest delay where the signal exhibits the most independence 
with respect to its time-delayed version. 
The fractal dimension and other chaos-related measurements operate on a single channel of data. In the process of 
extracting these measures, a signal is compared with a time-delayed version of itself to examine the patterns in 
dynamics of the data. These measures take a fixed time delay setting. The Optimal Time Delay transformation can 
be used to choose the best value for the parameter. 

 
Plot Attractor  

 
Assists in constructing X/Y plots for the attractors of time 
delayed data. By visually examining the shape of the attractor 
at a given time delay, To develop an intuitive sense for the 
underlying nature of the data and the dynamics of the system. 
Plot Attractor functions on the active channel of the graph. It 
prompts the user for a time delay and then constructs a new 
graph window with an X/Y plot of the attractor of the original 
signal against the time delayed version of the signal. It does 
not perform any additional computation aside from assisting 
in the setup and configuration of the attractor plot. 

 

Correlation Coefficient 

   
The correlation coefficient is a statistical measure related to the degree of variance or covariance between two data 
series. Given two data series x and y of length n, the correlation coefficient r is given by the formula: 

 (see http://mathworld.wolfram.com/CorrelationCoefficient.html) 
The square of the correlation coefficient can be used to determine the proportion of variance in common between the 
two signals. As the square gets closer to 1, the signals are a better statistical match for each other. 
To derive the correlation coefficient, two channels of data are compared against each other. 

• the channels must have the same length 
• the channels must have the same waveform sampling rate 
• all of the data of the entire graph for the two channels will be used to compute the correlation coefficient. 

Electrodermal Activity 

 
 

http://mathworld.wolfram.com/CorrelationCoefficient.html�
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Overview 
The Electrodermal Activity analysis routines are separated into three menu options that transform the tonic EDA 
signal to create a phasic waveform, locate and score skin conductance responses, or perform a detailed event-related 
EDA analysis by combining event information from the Stim-Response: Digital Input to Stim Events routine (see 
page 420) to the event-related EDA Analysis routine. The Event-related routine will automatically derive the phasic 
waveform and locate SCRs. 
The routines employ a scoring system that marks the waveform and the point of stimulus delivery. It’s easy to 
manually adjust the automated scoring by relocating the event onset/peak/end before rerunning the analysis. The 
event-related analysis provides a variety of measures from the SCR data, including classification of specific and non-
specific responses. The results are pasted into the journal file or Excel for further analysis. 
Preferences must be established for each routine and can be adjusted at any time via the Preferences option (page 363). 
The time to complete the analysis routine will vary based on the number of SCR responses and the sample rate of the 
data. 
 
Definitions 
The prompts and results of the Electrodermal Activity analysis package use the following terminology and units: 

µmho—the unit abbreviation for micromhos, used in channel labels and analysis results; micromho is equivalent 
to microsiemens. 
EDA (Electrodermal Activity)—the general area of skin conductance signals. Sometimes referred to by the older 
term “galvanic skin response.” 
Tonic EDA—continuous data acquired from an EDA electrode that includes all baseline offset. Sometimes 
referred to as “skin conductance level.” Averaging the tonic EDA over a specific period of time results in the 
average skin conductance level over an interval. Tonic EDA is recorded using BIOPAC equipment with the high 
pass filtering set to off (DC mode). 
Phasic EDA—a continuous signal indicative of localized changes in the tonic EDA signal. Sometimes referred to 
as “continuous skin conductance response.” Phasic EDA can be thought of as AC coupled tonic EDA. The EDA 
analysis package offers multiple ways of constructing phasic EDA including smoothing and high pass filtering. 
The EDA analysis package performs the majority of its analysis on tonic EDA signals, so if phasic EDA is being 
recorded directly it is recommended that a second channel be used to record tonic EDA. 
Skin Conductance Response (SCR)—an individual localized change in the tonic EDA signal. An SCR may occur 
in response to a stimulus or may occur spontaneously. In general, there are multiple SCRs present in a tonic EDA 
signal and they can be detected as deflections from the localized baseline. 

Reference 
The Electrodermal Activity analysis package was developed to support the parameters established in: 

M. E. Dawson, A. M. Schell, and D. L. Filion. The electrodermal system. In J. T. Cacioppo, L. G. Tassinary, and 
G.B. Bernston, editors, Handbook of Psychophysiology: second edition, pages 200–223. Cambridge Press, 
Cambridge, 2000. 

 
Derive Phasic EDA from Tonic 

Given a tonic EDA signal, this transformation uses baseline smoothing or high pass filtering (the method 
currently set in Preferences) to construct a new Phasic EDA channel in the graph containing the estimate of the 
phasic EDA. This routine is automatically included in both the locate SCR and Event-related EDA routines. 
Phasic EDA refers to a continuous signal indicative of localized changes in the tonic EDA signal. This data is 
sometimes referred to as “continuous skin conductance response.”  Phasic EDA can be thought of as AC coupled 
tonic EDA. The EDA Analysis Package offers multiple ways of constructing phasic EDA including smoothing 
and high pass filtering. The EDA Analysis Package performs the majority of its analysis on tonic EDA signals, so 
if phasic EDA is being recorded directly it is recommended that a second channel be used to record tonic EDA. 
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Event-related EDA Analysis 

   
The Event-related EDA Analysis transformation 
routine assists in the extraction of EDA measures that are linked to specific stimuli. The stimulus event marks 
must be included in the file BEFORE using this analysis.  
This analysis routine requires four elements: 

1. Tonic and Phasic waveforms. 
Tonic EDA Channel: A Tonic EDA signal must be present in the graph.  
Phasic EDA: 

Construct new: Given a tonic EDA signal, a phasic EDA will be automatically constructed using 
baseline smoothing or high pass filtering (the method currently set in Preferences).  
Use Channel: If the graph contains a phasic waveform, select the appropriate channel. 

2. Stimulus delivery events.  
Digital events with a common event type must be located BEFORE using this analysis.  
The Event-related EDA Analysis requires that an event be defined in the graph at the location of the 
delivery of each stimulus. This event may be defined using the Event Tool, hotkey insertion during 
acquisition, or any other method of defining events. All of the stimulus delivery locations to be 
extracted must have the same event type (e.g. “Flag”). To analyze multiple different event types, the 
transformation script must be executed multiple times. 
 If you are using E-Prime, SuperLab, or some other stimulus delivery system and have the digital 

events captured in the AcqKnowledge file, we recommend that you use the Stim-Response: 
Digital Input to Stim Events routine (see page 420). This routine will automatically classify and 
label the digital events for use by the Event-related EDA analysis. 

Stimulus event type: If using the Digital Input to Stim Events, select Stim/Response > Stimulus 
Delivery. Stimulus delivery events are located by event type or by specific channel of the graph. 
Stimulus event location: Specify the location as anywhere, global only, or on a specified channel. 
See the Events section for details. 

3. Skin conductance responses. 

 
Sample EDA Analysis Output 

All SCR events are marked on the tonic waveform as 
follows:  
 ( open paren. The point at which the phasic signal 

crosses the SCR threshold level 
established in EDA Preferences; see 
page 363 

 blue waterdrop blue marks the peak response of a 
nonspecific, event-related SCR  

red waterdrop marks a specific SCR “SRR” with a 
flag numbered with the stimulus event 
type 

  ) close paren. The point at which the phasic signal 
crosses the zero threshold level 



Part C — Analysis Functions 357 

AcqKnowledge 4 Software Guide 
 

If the tonic EDA signal does not already have SCR events defined on it, SCR events will be 
automatically constructed on the channel using the Locate SCRs transformation routine. 

4. Specified time window between the stimulus event and the skin conductance response. 
The transformation takes a maximum allowable separation window between the stimulus event and 
SCR response. Each stimulus delivery event is paired with the closest SCR event. SCRs that 
correspond to a stimulus delivery are known as specific SCRs (abbreviated “SRR”). SCRs generally 
occur within a certain timeframe after stimuli. The time window allows responses too close to stimuli 
to be rejected and classified as non-specific. 
Minimum separation: specify in relation to the stimulus event (includes time unit options). 
Maximum separation: specify in relation to the stimulus event (includes time unit options). 
Given a response time window [resmin, resmax], for each stimulus delivery event at a time t, SCR onset 
events that are not presently matched as SRRs will be searched for in the window [t+ resmin, t+ 
resmax]. The SCR onset event within this window closest in time to [t+ resmin] will be paired with the 
stimulus event and considered a SRR.  
 

SRR are marked as a red waterdrop icon with a flag numbered with the corresponding 
stimulus event type when “Output events for specific SCRs” is enabled.  

 
Each SRR will be 
matched to only one 
stimulus delivery event. If 
the closest SCR to a 
stimulus is farther away 
than this time interval, it 
is not assumed to be a 
response to the stimulus. 
It may be a response to a 
later stimulus or it may be 
a non-specific SCR that 
occurred spontaneously. 

Output Events for Specific SCR 
Enable this option to mark specific skin conductance events as a red waterdrop icon with a flag numbered with 
the corresponding stimulus event type. 

Event-related EDA Analysis Output Options 
Enhancements provide more options for multiple stimulus event types and unmatched events, including:  
 Labels and additional measures are available in the specific stimulus and SCR analysis table  
 Text and Excel tables may be optionally sorted either by time or grouped by stimulus label  
 A new table has been added listing stimulus events that were not paired with an SCR  
 The SRR/NS.SSR Rate analysis, which counts frequencies of SCRs in specific time periods, may 

now be driven by time periods defined using pairs of events or a selection in the graph  
 A table has been added listing amplitude/frequency percentage statistics for all matched and 

unmatched stimuli events (e.g. total stimulus count, percentage of stimuli that were pared with an 
SCR, etc.)  

 Additional optional Specific-SCR events may be defined on the tonic EDA waveform at the 
positions of specific SCRs with labels matching the stimulus to which they were responses. This 
allows for further peak-detector based runs to perform additional data reduction.  

Event Related EDA Event Types: 
 Waveform Onset 
 Waveform End 
 Skin Conductance Response 
 Specifc SCR 

Waveform Onset and Waveform End events are also available for other Specialized Analysis operations. 
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Amplitude Summary Output Options 
For each specific SCR that is paired with a stimulus delivery event, the following measures are extracted in 
table format and can be sorted by Time or by Event label. If text output is enabled in EDA Preferences, the 
average value of SCL, Latency, SCR Amplitude, and SCR Rise Time will be included as the final row of the 
table. 

Name Abbrev. Description Units 

Stimulus 
Delivery Time 

Stim Time The time within the recording where the stimulus delivery event 
was located. 

seconds 

Skin 
Conductance 
Level 

SCL Amplitude of the tonic EDA signal at the time when the stimulus 
was delivered. 

µmho 

Response 
Latency 

Latency Time separating the stimulus delivery from the onset time of the 
corresponding SCR. 
This latency will always be less than the maximum allowable 
latency specified as a parameter for the analysis. 

seconds 

SCR 
Amplitude 

SCR 
Amplitude 

Height of the corresponding SCR as determined by the change in 
the tonic EDA amplitude from the time of SCR onset to the 
maximum tonic EDA amplitude achieved during the SCR: 

[EDA(tmax) – EDA(tonset)] 

µmho 

SCR Rise 
Time 

SCR Rise 
Time 

Time taken for the tonic EDA to reach its maximum value within 
the SCR:  

 [tmax - tonset] 

seconds 

Absolute 
SCR Size 

SCR Size Contains the SCR Size, which is the absolute amplitude of the 
paired SCR event. This is the amplitude of the “SCR” event in the 
triplet. Formula: EDA [tmax] 

µmho 

SCR Onset 
Threshold 

SCR Onset 
 

Contains the absolute amplitude of the waveform onset event of 
the specific SCR. Formula:  
EDA [tonset] 
 

µmho 

Stimulus 
event label 

StimLabel 
 

Contains the label of the stimulus delivery event. N/A 

The SCR Size and Onset Threshold values will be included for the textual table, graphical channel output, and 
in the Excel spreadsheet. The stimulus event label will be included only in the textual and Excel spreadsheet 
output; it is not possible to represent textual information in graph channels. 

Sorting Options 

The output table rows may appear in one of two orderings.  

• “Sort tables by time” - Consecutive rows will be arranged in order of increasing time. 

• “Sort tables by event label” - Case-sensitive lexicographical sort based on the StimLabel column; “AAAA” 
will be considered as unique from “aaaa” / “AaAa”, etc. 
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SSCR/NSSCR Summary Count Options 
In addition to the above measures extracted for each specific SCR, the analysis performs rate extractions for 
specific and non-specific SCRs. By examining how the rate of SCR occurrences changes, long-term 
experimental trends can be investigated. This analysis is placed into a second set of waveforms (or a second 
table for text and Excel output). 
Fixed width: fixed width window is specified as the “SCR count interval width” when performing the analysis. 
The entire recording is split up into fixed-width epochs of this granularity with the first epoch aligned at the 
start of the recording. For each fixed-width epoch, the following are extracted: 

Name Abbrev. Description Units 

Epoch Start 
Time 

Start Time Time location in the recording of the start of the epoch being 
examined. 

seconds 

Specific SCR 
Rate 

SRR Frequency of the occurrences of specific SCRs within the epoch. 
Specific SCRs are those SCRs that were successfully matched to 
a corresponding stimulus delivery event. 

Hz 

Non-specific 
SCR Rate 

NS.SRR Frequency of the occurrences of non-specific SCRs within the 
epoch. These are SCRs that occur spontaneously and are not 
paired with any known stimulus. 

Hz 

Between event pairs: Select an event type from the pull-down menu. The software will locate the event 
markers at the beginning and end of the region of interest and perform the analysis between the two points This 
option is useful if the recording is broken into defined periods—such as baseline, event, and response—using 
the event hotkeys. 
Manually selected area: Highlight the area where NSSCR/SSCR rates 
should be computed and then click “Do EDA Analysis” in the graph window. 
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Amplitude/Frequency Percent Summary 
The “Stimulus Matching Summary” table for Textual and Spreadsheet output provides overall summaries for 
each unique event label for Stimulus Delivery events. The table has one line for each unique event label; the 
labels are numbers starting with 1. 
This table provides an overall average for amplitude, magnitude and % Frequency for the specific SCR 
associated with Stimulus Delivery events. In this case, frequency is referring to the ratio of Stimulus Dellivery 
events to the occurance of specific SCRs. 
Assume we have a set S of all Stimulus Delivery events of an identical label. 
This will be split into two subsets: Smatched consisting of all Stimulus Delivery events that have an associated 
SCR with them, and Sns consisting of the non-specific stimulus events that do not have an associated SCR with 
them. Given these sets, the following definition holds: 

 
For an individual event, define the SCR Amplitude function:  

 
The following are the definitions of measures that will be included in the table: 

Name Abbrev. Description Units 

Amplitude Amplitude Average value of the SCR amplitude of the specific SCR events. Defined by the 
following formula: 

 

umho 

Magnitude Magnitude Weighted average of the SCR amplitude of the specific SCR events over the entire 
set of specific and non-specific events.  Defined by the following formula: 

 

umho 

Matched Matched Total number of specific SCRs associated with a Stimulus Delivery event. Defined 
by the following formula: 

 

 

Non-
matched 

Non-
matched 

Defined by the following formula: 
Non-matched = Stimulus Delivery Total count – Specific SCR Total count 
 

 

Total Total Total count of Stimulus Delivery events.  Defined by the following formula: 

 

 

Frequency 
(%) 

Freq% Percentage of stimulus events that were paired with an SCR.  Defined by the 
following formula: 

 

 

Label Label Textual label of the events that are included in S.  
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Locate SCRs 

  
The Locate SCRs routine will identify skin conductance response and score the waveform. This analysis is useful 
for analyzing spontaneously occurring skin conductance responses. The routine is automatically included in the 
Event-related EDA routine. All SCR events are marked on the tonic waveform as follows:  

 ( open paren. The point at which the phasic signal crosses the SCR threshold level established in EDA 
Preferences; see page 363 

 blue waterdrop The peak response point of a nonspecific, event-related SCR  
  ) close paren. The point at which the phasic signal crosses the zero threshold level 

This transformation requires a tonic EDA signal. If a phasic EDA has already been constructed for this tonic 
EDA, it may be used; otherwise, the transformation will create a phasic EDA automatically according to the 
settings in the Preferences. 
Given a tonic EDA, the Locate SCRs transformation defines an event for each skin conductive response in the 
tonic EDA. SCR location is a two stage process. First, all potential SCR occurrences are located on the signal. 
Second, all potential SCR occurrences that are not large enough are rejected. 
Potential SCR occurrences are detected by performing thresholding positive peak detection on the phasic EDA 
signal (using H and P as set via Preferences): 

1. Given a detection threshold H (expressed in µmho), search for a positive threshold crossing in the 
phasic EDA signal. This position is recorded as the start of the potential SCR. 

2. Continue examining the phasic EDA until the first negative threshold crossing of 0 µmho occurs. This 
position is recorded as the end of the potential SCR. 

3. Return to step 1 to continue searching for more potential SCRs. 
After all of the potential SCRs have been located, the set of valid SCRs is constructed as follows: 

1. Determine the overall maximum amplitude of the phasic EDA signal within all potential SCRs. 
2. Given a percentage P, construct a threshold level T of P percent of the overall maximum phasic EDA 

signal value located in step 1. 
3. Examine each potential SCR. Find the maximum phasic EDA. If m < t, discard the potential SCR. 

Mark the potential SCR as a valid SCR. 
If the tonic EDA channel chosen for analysis already has SCR events defined on it, the SCR events will be 
replaced with the newly detected SCR events. No existing SCR events will be erased without a confirmation. 
Once SCR events have been defined, they can be used in conjunction with the Cycle Detector for performing 
further data reduction. The “event count” measurement can be used to estimate SCR frequency during individual 
time ranges of the experiment. 

Events on Tonic EDA 
After valid SCRs are located using the algorithm above, events are inserted into the graph that can allow for 
further data analysis around the SCR positions. Three events are defined on the tonic EDA waveform for each 
individual valid SCR: 

1. “General > Waveform onset” event at the SCR onset time. This is the point where the threshold H was 
crossed in the phasic EDA. 

2. “EDA > Skin conductance response” event at the time where the tonic EDA reaches its maximum value 
within the SCR (max in time range). 

3. “General > Waveform end” event at the ending SCR time. This is the point where the zero threshold was 
crossed in the phasic EDA. 
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Events for SCRs will always occur as described above, in the order shown. 
EDA Measurements 
To perform Event-related EDA analysis, choose Analysis > Electrodermal Activity > Event-related EDA Analysis.  
To take measurements from the skin conductance response analysis, set measurements for event count, event location 
and/or event frequency. Set the source channel as the Tonic EDA channel and select the location (measurement 
channel only, global events only, anywhere) and measurement parameters as desired. This method is useful for 
spontaneously occurring skin conductance response analyses. Take measurements over a manually selected area or 
use Find Cycle analysis to take automatically measurements over a user-defined time interval. 
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EDA Preferences… 

 
The following EDA Preferences can be configured and will be applied to all options in the analysis package: 

• Display results as text, graph channels, or Excel 
• Construct Phasic EDA using High pass Filtering or Smoothing Baseline Removal 

o High pass Filtering—High pass filtering constructs phasic EDA by applying a digital IIR high pass filter 
(f = 0.05 Hz, Q = 0.707) to the tonic EDA signal. This high pass filter essentially AC couples the tonic 

EDA signal similar to using the high pass hardware filter available on the GSR100C module. 

   
 0.05 Hz High Pass Filter   Smoothing Baseline Removal 

o Smoothing Baseline Removal—Smoothing baseline removal constructs phasic EDA by subtracting an 
estimate of the baseline conductance from the tonic EDA. Set the baseline estimation  

• Baseline estimation: The estimate of the baseline is generated using median value smoothing. This is more 
computationally intensive than high pass filtering. Increasing the window will increase sensitivity and return 
more responses. 

   
Baseline window set to 4 seconds Baseline window set to 8 seconds 

• SCR detection parameters: threshold detection level H and percentage P, see page 361. 
o The default values are H = 0.02 µmho, P = 10, where H is detection threshold and P is percentage 
o Setting H to 0 and P to 10% will approximate the SCR detection algorithm referenced in  

K. H. Kim, S. W. Bang and S. R. Kim, “Emotion recognition system using short-term monitoring of 
physiological signals,” Medical & Biological Engineering & Computing, vol. 42, pp. 419-427, 2004. 

o Setting P to 0% will retain all potential SCRs (none will be rejected in the second phase). 
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Electroencephalography 

 
Compute Approximate Entropy 

 
Approximate entropy is a statistical measure that attempts to quantify the predictability of a data sequence. A 
perfectly predictable data series (such as a pure sine wave) has approximate entropy of zero. Several studies are 
beginning to examine approximate entropy of EEG data and its relationship to external factors such as drugs and 
sleep states. 
The Compute Approximate Entropy script divides an EEG signal into fixed-width epochs and computes the 
approximate entropy for each epoch. Derivation of the approximate entropy is a computationally intensive process 
and may take several minutes or hours to complete. To obtain only the sub-ranges of the EEG data, use the “focus 
areas only" option to restrict the approximate entropy computations to that data range only. 

Delta Power Analysis 

 
Delta power is the total power of the EEG signal that occurs within the delta frequency band as configured in the 
Preferences. Delta power has been examined in a number of various EEG studies as an indicator of 
sleep/wakefulness and other conditions. By examining changes in the delta power, it may be possible to correlate 
delta power with effects of external factors. 
The Delta Power Analysis script divides an EEG channel into fixed-width epochs. For each epoch, the power 
spectral density is computed and the total power within the delta frequency band is derived from the PSD. This 
delta power value is then placed into the graph or into the journal as specified by the output preferences. 
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Delta power can be measured from either a filtered or unfiltered EEG channel. To compute delta power for 
individual frequency bands, they must be derived prior to running the Delta Power Analysis script. 

Derive Alpha RMS 

 
The Derive Alpha RMS script constructs an integrated RMS waveform from an alpha EEG signal (the alpha EEG 
signal can be constructed with Derive EEG Frequency Bands). Alpha RMS is the windowed root mean square 
value of the signal using a window width of 0.25 seconds. Individual channels are selectable for analysis. 

Derive EEG Frequency Bands 

 
The Derive EEG Frequency Bands script applies filtering to an unfiltered EEG lead signal to generate the 
following five standard EEG bands: Alpha, Beta, Theta, Delta, and Gamma.  
The frequencies for each band are specified in the analysis package preferences. Filtering is performed using the 
digital filter, IIR Band Pass Low+High. 
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EEG Frequency Analysis 

   
EEG may be characterized in terms of frequency and the power within specific frequency bands. The EEG 
Frequency Analysis script performs various feature extractions from EEG signals using FFT and other techniques 
to examine the power within the EEG signals. This analysis may be performed for multiple EEG leads 
simultaneously, allowing for either analysis of multiple leads or analysis of multiple EEG alpha, beta, theta, or 
delta bands from a single raw lead. 
The EEG Frequency Analysis script divides the EEG signals into fixed-width time epochs. For each individual 
time epoch, AcqKnowledge’s Power Spectral Density function is used to estimate the power spectrum of that 
epoch using a Welch periodogram estimation method. From this PSD the following measures are extracted for 
each epoch: 

Name Abbrev. Description Units 

Mean Power MeanP The average power of the power spectrum within the epoch. 
(Units Note: V will be replaced with the voltage units in which 
the EEG was recorded) 

V 2

Hz  

Median 
Frequency 

MedianF Frequency at which 50% of the total power within the epoch 
is reached. 

Hz 

Mean 
Frequency 

MeanF Frequency at which the average power within the epoch is 
reached. 

Hz 

Spectral Edge Spectral 
Edge 

Frequency below which a user-specified percentage of the 
total power within the epoch is reached. This percentage can 
be set using “Preferences” and defaults to 90%. 

Hz 

Peak 
Frequency 

PeakF Frequency at which the maximum power occurs during the 
epoch. 

Hz 

 
 Watch the AcqKnowledge EEG Frequency Analysis video tutorial for a detailed demonstration of this feature. 

http://www.biopac.com/video/?video_category=automated-analysis-demos&v=eeg-frequency-analysis-acqknowledge-demonstration�
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Seizure Analysis 
Seizure Analysis is designed to enhance functionality of the Epoch 
wireless EEG system commonly used for acquiring small animal signals. 
Long term EEG recording is often used for studying seizure activity. 
Unlike human EEG, EEG for non-anesthetized animals may contain a 
variety of superimposed artifacts resulting from random motion and 
scratching. Seizure Analysis offers a reliable means of differentiating 
actual seizure activity from other types of motion artifact. 
The Seizure Analysis tool consists of a configurable difference interval, 
slope threshold, time epoch width and spike detector. Using the default 
values found in the figure above, seizure activity is defined as follows: 

1. Perform a difference on the EEG data with a 16 ms window 
width. At this window width, normal EEG spikes in the signal 
have a roughly logarithmic distribution. 

2. Identify maximum threshold for normal spike distribution, 
chosen at 270 microvolts on the difference signal.  

3. Perform peak detection on the difference signal with the fixed 
chosen threshold. Spikes above this threshold are considered candidate epileptic spikes and marked with a 
check mark on the waveform. 

After spikes are located seizures will be located using a spike frequency method: 
1. Split data up into 10 second periods. 
2. Count the number of spikes in each period. If more than 20 spikes occur within the period, the period is 

marked as a seizure. 
Using Seizure Analysis 

1. Analysis > Electroencephalography > Seizure Analysis and set the EEG data results preferences if necessary. 
(See page 370) 

2. If more than one EEG channel is to be analyzed, as is often the case with the Epoch EEG system, the 
following selection screen will appear. If there is only one channel of EEG data in the file, this screen will not 
be displayed and the seizure analysis screen depicted above will appear. 

 
3. Set the desired parameters for seizure detection and click OK. 
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If the EEG Analysis Preferences are set to display 
results as graph channels, two new channels of data will 
be created. The first channel shows a tachogram of the 
number of epileptic spikes identified within the Time 
epoch. The second channel displays a square wave that 
runs from 0 to 1; a 1 indicates that an epoch matches 
the seizure threshold. In the default setting, 20 seizure 
spikes have to be identified within a 10 second epoch 
for the epoch to be classified as containing a seizure. 
 
If the “Output focus areas for seizures” option is 
checked, a focus area is created for each epoch that 
contains a seizure. This option is useful for running 
additional analysis routines and taking measurements 
over just the areas of data that contain seizures. 
 
 
 
 
 
Seizure Analysis Parameters 

CONTROL DESCRIPTION 

Difference Interval Alters the time window used to compute the difference for 
slope detection. Default value is 3.2 samples. 

Show difference output The difference interval used for spike detection will be 
displayed in the graph. 

Difference threshold level Adjusts the fixed threshold level used to locate peaks in 
the difference signal corresponding to EEG spikes 

associated with seizures. Default value is 270 microvolts. 

Time epoch width Adjusts the time width used for seizure detection. Default 
value is 10 seconds. 

Spike count threshold Sets the number of spikes that must be present in the 
specified time window (epoch) in order to be indentified 

as seizure activity. 

Analyze: entire graph The entire graph is scrutinized for potential seizure 
activity. 

Output focus areas for seizures In addition to normal output, the analysis will create focus 
areas in the graph at each identified seizure period. 

Analyze: focus areas only Only focus areas will be scrutinized for potential seizure 
activity. 

Output events for seizure intervals A pair of “waveform onset” and “Fwaveform end” events 
will be created at boundaries of identified seizure areas. 
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Spike Event Output 
For all types of seizure analysis output, this analysis will leave Stim-Response  events on the EEG channel wherever 
spikes are detected according to the analysis parameters. These events allow for visual verification of spike detector 
functionality. If any Response events are found on the EEG channels at the start of the analysis, then following dialog will 
be presented: 

 
Clicking “Yes” removes the existing events.  Only Response type events will be removed from the EEG channels; other 
types of events, or events on other channels will not be affected. 

 Watch the AcqKnowledge Seizure Analysis video tutorial for a detailed demonstration of this feature.  
Remove EOG Artifacts  

  
Some EEG recordings involve subjects performing various visual tasks such as reading or watching video. Under 
these conditions, EEG may be susceptible to interference from the much stronger EOG signal arising from eye 
motion, particularly if EEG is recorded from near the front of the skull. Remove EOG Artifacts helps remove EOG 
interference from the EEG signals, recovering the EEG data for use in further analysis. 
EOG removal is performed using a blind signal separation technique known as Independent Component Analysis. 
ICA is used to split up statistically independent signals that have been mixed together during recording. Since EOG is 
independent of EEG, ICA can be used to remove it.  
In order to use Remove EOG Artifacts, a distinct EOG signal must be acquired in addition to the EEG signals. The 
EOG signal is required to identify the components correlated to eye motion. 
EOG artifact removal functions better when it is performed on multiple EEG leads simultaneously. Better results may 
be obtained by including EEG leads that do not exhibit EOG interference since the increased number of leads allows 
for more fine-grained signal separation. Good results can be seen with as few as two EEG leads and one EOG lead. 
While this technique can be performed with a single EEG lead, the results will not be as dramatic. 

Note ICA is a non-deterministic technique, so it may not be possible to automatically separate the signals for 
every EOG/EEG data set. For ICA to be successful, it may be necessary to fine-tune the parameters of the 
ICA search procedure to match the data, use a different electrode configuration, or use fewer or more 
leads. 

http://www.biopac.com/video/?video_category=automated-analysis-demos&v=seizure-detection-using-acqknowledge�
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Preferences… 

 
Adjust the EOG ICA Tolerance level and the EOG ICA maximum number of iterations by accessing Transform > 
Specialized Analysis > Electroencephalography > Preferences. EOG ICA Tolerance is used as the termination 
condition of ICA signal separation. The EOG ICA maximum number of iterations is another termination 
condition of ICA signal separation and represents the maximum point at which the search is aborted. For more 
information on these settings, see the documentation for the Independent Component Analysis transformation. 
Because ICA is a statistical technique, any filtered data produced with Remove EOG Artifacts should be carefully 
verified against other information to ensure that the approximations produced via ICA represent information that 
is truly correlated to the expected ECG. 
The spectral edge percentage indicates the cutoff percentage of the total power at which spectral edges will be 
placed. The default value is 90%. 
The frequency bands of alpha, beta, delta, and theta may be modified to match different analysis protocols. The 
default frequency ranges are:  

• Alpha—8 Hz-13 Hz 
• Beta—13 Hz-30 Hz 
• Delta—0.5 Hz-4 Hz 
• Theta—4 Hz-8 Hz 
• Gamma—36 Hz-44 Hz 
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Electromyography 

 
Derive Average Rectified EMG 

  
Average rectified value (ARV) is defined as a time windowed mean of the absolute value of the signal. ARV is 
one of the various processing methods used to construct derived signals from raw EMG data that can be useful for 
further analysis. 
To perform ARV, a time window must be specified for the sliding mean. The default time window setting is 30 
milliseconds, but this value can be adjusted depending on the desired amount of smoothing effects. It is advisable 
to closely examine results for time windows larger than 30 milliseconds as it is possible for delay to be introduced 
into the result. 
The ARV is computed using the Integrate transformation with a Rectified Average over Samples configuration. 

Derive Integrated EMG 

  
Integrated EMG (iEMG) is defined as the area under the curve of the rectified EMG signal, that is, the 
mathematical integral of the absolute value of the raw EMG signal. When the absolute value of the signal is taken, 
noise will make the mathematical integral have a constant increase. Integrated EMG splits up the signal into 
fixed-width timeslices and resets the integral at the start of each timeslice. To derive iEMG, the width of this 
timeslice must be specified. Similar to ARV, timeslices longer than 30 milliseconds may introduce delay into the 
result. 
The integrated rectified EMG signal will appear like a “sawtooth” style wave. In addition to the true iEMG, this 
script will output a second waveform whose value is the maximum value of the iEMG signal in each timeslice. 
This Maximum iEMG is easier to interpret visually and approximates the envelope of the iEMG signal. 
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Derive Root Mean Square EMG 

 
Root Mean Square EMG (RMS EMG) is defined as the time windowed RMS value of the raw EMG. RMS is one 
of a number of methods used to produce waveforms that are more easily analyzable than the noisy raw EMG. 
To construct the windowed RMS signal, a time window must be specified for the sliding mean. The default time 
window setting is 30 milliseconds, but this value can be adjusted depending on the desired amount of smoothing 
effects in the RMS EMG. It is advisable to closely examine results for time windows larger than 30 milliseconds 
as it is possible for delay to be introduced into the result. 
RMS EMG is computed using the Integrate transformation in a Root Mean Square Average over Samples 
configuration. 

EMG Frequency and Power Analysis 
Several frequency domain techniques may be used for data reduction of EMG signals. The EMG Frequency & 
Power Analysis script extracts several measures derived from the power spectrum of an EMG signal. The EMG 
signal is split up into a fixed number of time periods; within each window, the power spectrum is computed using 
the Power Spectral Density transformation. For each time period, the following measures are extracted: 

Name Abbrev. Description Units 

Median 
Frequency 

MedianF Frequency at which 50% of the total power within the epoch 
is reached. 

Hz 

Mean 
Frequency 

MeanF Frequency at which the average power within the epoch is 
reached. 

Hz 

Peak 
Frequency 

PeakF Frequency at which the maximum power occurs during the 
epoch. 

Hz 

Mean Power MeanP The average power of the power spectrum within the epoch. 
(Units Note: V will be replaced with the voltage units in 
which the EMG was recorded) 

V 2

Hz  

Total Power TotalP The sum of the power at all frequencies of the power 
spectrum within the epoch. 
(Units Note: V will be replaced with the voltage units in 
which the EMG was recorded) 

V 2

Hz  

Locate Muscle Activation 

 
When performing gait analysis, exercise physiology, or other research, identification of periods where the muscle 
is active can allow for correlation of external factors to muscle activity.  
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Locate Muscle Activation attempts to identify various periods of muscle activity using statistical methods. The 
transformation requires a raw, unfiltered surface EMG channel. It takes a window width of w seconds, by default 
0.25 seconds.  It is important that the first w seconds of the EMG signal be “background noise”, that is, that the 
muscle being examined is relaxed for the first quarter second. This quarter-second period is used to estimate 
baseline parameters that affect the entire process. 
Note The LMA analysis expects EMG to be an AC-coupled signal centered around zero without baseline offset. 

If the signal is centered below zero, then no muscle activations are located. The Remove Mean function 
from the Analysis menu can be used to center the signal around zero for most waveforms. 

This transformation implements a variation of the Hodges and Bui detection algorithm as described in: 
P. W. Hodges and B. H. Bui, “A comparison of computer-based methods for determination of onset of muscle 
contraction using electromyography,” Electroenceph. Clin. Neurophysiol., vol. 101, pp. 511-519, 1996. 
The variation implemented is a threshold-based algorithm roughly consisting of the following steps: 

1. Determine mean value  and resting standard deviation  of the first w seconds of the signal. 
2. Construct a filtered ARV EMG signal, z. The window width w is used when constructing the ARV signal. 
3. Extract the variance of the signal with respect to the noise with the formula 

 
4. Using a threshold h, determine when the signal g lies below and above the threshold. Portions of time 

above the threshold are periods of muscle activity. 
5. Discard any transitions across the threshold if they are shorter in duration than a user-specified time, t. 

There are two methods of specifying the threshold h. An adaptive method examines the signal g and chooses the 
threshold to be the median of g over the entire waveform. Alternatively, the threshold can be specified manually. 
Using a manual threshold can be useful in adjusting the detection to better match specific EMG data. A suggested 
threshold is 2.5. By lowering the threshold, a larger quantity of data will be considered as muscle activity. By 
raising the threshold, a larger quantity of data will be considered to be noise. 
The transition discard time t is specified in seconds. The default value of t is 0.1 seconds. If muscle activity is 
being inaccurately identified as inactivity for short periods within active times, try increasing the value of t. Do 
not set t to be greater than the smaller of either the shortest duration of a single muscle contraction or the shortest 
rest interval between consecutive muscle contractions. 
There are two outputs from the Locate Muscle Activation script.  

• A new waveform, Muscle Active, will be added to the graph. The value of this wave will be zero when 
the muscle is at rest and one when the muscle is active. This wave can be used to quickly visually 
examine the record for periods of activity.  

• Events are also generated on the raw EMG waveform. A Waveform Onset event is placed at each 
transition from inactive to active, and a corresponding Waveform End event is placed at each active-to-
inactive transition. You can use these events in conjunction with the Cycle Detector to perform further 
data reduction based on muscle activity. 

The detection of muscle activation onset and end from surface electrode EMG is an imprecise process. The output 
of this location should be visually examined for misidentification of activation periods that are too short, too long, 
overlapping, or missed. 

Preferences… 
The Preferences allow the type of output to be chosen for 
displaying results: text, graph channels, or Excel. 
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Ensemble Average 

  
Ensemble Average assists in performing offline averaging. Offline averaging produces an average waveform from 
a number of cycles, also known as an ensemble average. Averages of multiple channels can be extracted 
simultaneously and be consolidated into a single graph window showing the results. Offline averaging is also 
available as a function within the Find Cycle feature. 
This option provides two methods for locating individual members of the ensemble. 
 Peaks: Data-driven peak detection with positive or negative peaks in the data. This method automatically 

derives appropriate threshold levels from a user-selected peak and is useful for constructing averages keyed 
to periodic signals with strong spikes, such as ECG. 

 Events: Place members of the ensemble surrounding events in the waveform. Events must be previously 
defined by the user, either manually or through another automated process. This method is useful for 
constructing averages keyed to any types of events in a graph. 
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Epoch Analysis  

  
Extracts basic measures from fixed-width time segments of data. A fixed-width time segment of data is known as 
an epoch. The location of these fixed-width intervals can either be keyed off of locations of events in the graph or 
tied to regular time intervals (e.g. occurring at a constant frequency). All of the standard AcqKnowledge 
measurements can be extracted on an epoch-by-epoch basis with the exception of Calculate. 
Epoch-by-epoch measurement results can be viewed either as channels of 
data in the graph, a textual summary, or on an Excel spreadsheet; textual 
summaries include a final row with an overall average of each extracted 
measurement.  
Times output by Epoch Analysis are always expressed in seconds; all other 
units correspond to the current preferred measurement unit settings 
accessible under Display > Preferences. 

 
NOTE: The Expression measurement function MMT() is available in Epoch Analysis, but the results may not be 
reliable. 
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Focus Areas between Events and Segments 
In addition to the standard focus area functionalities discussed on page 89, focus areas can also be used as an analysis 
tool to define areas of interest between certain event types or between appended segments.  
Define Between Events 
The parameters for defining focus areas using this method are highly customizable, and can be based upon specific 
event types or titles as well as various event locations in the graph. The following table explains the various focus area 
start and end event options. 

 

Focus area label basename: 
Use to assign a title for the focus areas. Successive focus areas will use 
the same title with the addition of incrementing numbers. 
Event type: 
Use to select the type of event for defining the focus area. 
Location: 

• Anywhere—all channel and global events are included in the 
event matching criteria. 

• Global—when selected; only global events are included. 
• Channel—when selected; only events in an individual channel 

are included. Select the desired channel from the combo box 
menu. 

Event labels must match: 
When checked, only events with labels matching the edit field text will 
be defined. When unchecked, all events of the selected type are 
matched, regardless of label. 
 

Define for Appended Segments 
This method simply defines the time range between appended segments as focus areas. No configurable options exist 
for this feature within the Analysis menu. 

Hemodynamic Analysis 
Hemodynamics is the study of blood and circulation related data. This analysis package concerns itself with 
interpretation of ECG, blood pressure, and monophasic action potential data; ECG signals must be sampled at 5 
kHz or below to be analyzed with this package. 
IMPORTANT: These routines are designed specifically for human subjects and may not function well, or at all, 

on animal subjects, particularly small animals. 
The Hemodynamic analysis package consists of:  

a)  ABP Classifier 
b)  Arterial Blood Pressure 
c)  Baroreflex Sequence Analysis (licensed feature, see page 515) 
d)  Baroreflex Slope Analysis (licensed feature, see page 515) 
e)  ECG Interval Extraction 
f)  Estimate Cardiac Output from ABP 
g)  Left Ventricular Blood Pressure 
h)  LVP Classifier 
i)  MAP Classifier 
j)  Monophasic Action Potential 
k)  Preferences 

The time units reported by all of these transformations are in seconds unless otherwise noted. 
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ABP Classifier  

   

 
Places systolic and diastolic events at appropriate locations on a continuous arterial blood pressure signal 
recording using either invasive means or a continuous noninvasive pressure monitoring system. The ABP 
classifier functions directly on the pressure data and may fail for signals that exhibit strong noise characteristics or 
large baseline drifts. Pre-filtering the signal may improve classification accuracy. 

Arterial Blood Pressure  

  
Extracts various cycle-by-cycle measures from arterial blood pressure (ABP) and ECG signals. It can function on 
an individual ABP signal or, when used in conjunction with an ECG Lead II signal, extract additional Q relative 
measurements. 
 If the ECG and ABP signals have not been classified when this analysis is performed, events for diastolic, 

systolic, and ECG boundaries will be inserted as necessary. 
 If systolic, diastolic, and Q events are already present on the signals, however, they will be used. 
 Adding smoothing or a low pass filter to the signal may improve Arterial Blood Pressure results. 
On a cycle-by-cycle basis, the arterial blood pressure analysis transformation extracts the following measures: 

Name Abbrev. Description 

Diastolic - Minimum pressure occurring during the cycle 

Ejection time ET Time interval between the diastolic pressure and the minimum of dP/dt 

Heart rate HR Heart rate in BPM as extracted from the diastolic-to-diastolic time interval for a 
given cycle 

Maximum dP/dt dP/dt max Maximum amount of the change in the pressure during the cycle 
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Mean blood 
pressure 

MBP Mean blood pressure: 

 

Pdiastolic +
Psystolic − Pdiastolic

3
 

Minimum dP/dt dP/dt min Minimum amount of change in the pressure during the cycle 
 

QA Interval QA Time interval between ECG Q wave and the diastolic pressure 

Recovery 
interval 

%REC Time required for the pressure signal to decrease by a user specified percentage of 
the pulse height 

Systolic - Maximum pressure occurring during the cycle 

Time to peak 
pressure 

TTPK Time interval between the diastolic and the systolic pressures 

When textual output is used, the average of all of these measures will be output as the last row of the table. 
 
ECG Interval Extraction  

 
Extracts cycle-by-cycle time and voltage measurements for various points and intervals between waveforms in the 
cycle on ECG Lead II signals. This interval extraction is based off of the waveform boundary locations with 
additional logic for defining explicit Q and S wave events. QRS peak events as output for boundary location are 
used as the R peak location. 
 If the ECG signal was not classified before running the interval extraction analysis, it will be classified 

automatically. 
This analysis extracts the following cycle-by-cycle measures: 

Name Abbrev. Description 

Corrected QT 
interval 

QTC QT time interval divided by the square root of the RR interval 

Heart rate HR RR time interval expressed in BPM 

P height P-H Amplitude at the peak of the P wave in a cycle 

PRQ interval PRQ Time between the onset of the P wave to the Q wave 

QRS width QRS Time between onset of the QRS complex and the end of the QRS complex. Equivalent 
to the time between onset of Q and end of S 

QT interval QT Time between the beginning of the Q wave and the end of the T wave 

R height R-H Amplitude of the R wave in a cycle 

RR interval RR-I Time between consecutive R peaks in the waveform 

ST interval ST Time between the S wave to the end of the T wave 

At the end of the text table output, the average of all of the cycles will be displayed. Additionally, both text and 
Excel output will indicate the number of cycles that did not have all three of the QRS, P, and T waves defined. 
These are cycles where the classifier missed a boundary and are listed as “Bad cycles,” which may happen due to 
noise or other artifacts in the signal. 
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Estimate Cardiac Output from ABP 
This analysis algorithm, based on the universally recognized Liljestrand non-linear compliance formula, derives an 
estimate of cardiac output (CO) from an existing arterial blood pressure (ABP) signal. Using this method, it is 
possible to obtain an accurate measure of this data in a noninvasive fashion. For optimal results, the analysis must first 
be calibrated through the Estimate Cardiac Output from ABP setup dialog in which an initial resting cardiac output is 
selected.  Adding smoothing or a low pass filter to the signal may further improve results. 

1. Select the desired Hemodynamics > Preferences settings. (See page 383 for details.) 
2. Hemodynamics > Estimate Cardiac Output from ABP. 
3. Select the channel containing the blood pressure signal. 
4. Choose an estimated calibration cardiac output level based upon typical male, female, or custom parameters. 
5. Select the entire graph or desired focus areas for analysis and click OK. 
6. Follow the “Highlight a systole in the BP data” prompt and click OK. 
7. Click “Systole Is Selected” to begin the analysis. 

  
If no systolic/diastolic events exist in the selected BP channel, they’ll automatically be scored and added using the 
ABP classifier analysis script. Cardiac output results are presented in graph, text or spreadsheet format, depending on 
the desired extraction method set up in the Hemodynamics preferences. 
For text and spreadsheet output, the following measures are extracted. 

Name Abbrev. Units Description 

Start Time --  The time at the beginning of each cycle. 

Heart Rate HR BPM Heart rate as extracted from blood pressure signal in BPM. 

Estimated Cardiac 
Output 

CO L/m Estimated cardiac output as computed using the estimated calibration 
constant and Liljestrand formula. 

Estimated Stroke 
Volume 

SV L CO/HR 

For graph channel output, the following channels are added to the graph: 

Channel Label Units Description 

Heart Rate - ch bpm Heart rate as extracted from blood pressure signal in BPM (e.g., time duration of the 
cycle in seconds / 60). 

Estimated CO - ch L/m Estimated cardiac output as computed using the estimated calibration constant and 
Liljestrand formula. 

Estimated SV - ch L Estimated stroke volume.  Equal to: CO / HR. 

If focus areas only are being analyzed, a new set of three channels will be defined for each focus area. 
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 Watch the AcqKnowledge Cardiac Output from ABP video tutorial for a detailed demonstration of this 
feature. 

Left Ventricular Blood Pressure 

 
Extracts various cycle-by-cycle cardiac measures of left ventricular blood pressure data, optionally in conjunction 
with an ECG Lead II signal. Examines the LVP signal, ECG, and derivative of the LVP signal. 
 If the LVP and ECG signals have not been classified before this analysis is executed, they will be classified 

automatically. 
 Derivatives of the LVP signal can be pre-existing or can be constructed automatically. 
 If an ECG signal is not included, only pressure related measures will be extracted. 
The analysis outputs the following information on a cycle-by-cycle basis and the textual output cites the average 
of all of these cycle-by-cycle measurements: 

Name Abbrev. Description 

Contractility 
index 

CI maximum value of dP/dt during the cycle divided by the pressure at that time 
location 

Developed 
pressure 

DP Amplitude interval between end diastolic pressure and systolic pressure 

dP/dt Max - Maximum change in pressure over the cycle 

dP/dt Min - Minimum change in pressure over the cycle 

End diastolic 
pressure 

LVEDP End diastolic pressure for the cycle. This is not necessarily the minimum pressure 
during the entire cycle. 
LVEDP is located on the LVP signal using the method set in the preferences. 

Minimum 
pressure 

MIN Absolute minimum pressure occurring during the entire cycle. This is not 
necessarily equivalent to the end diastolic pressure 

QA Interval QA Time interval between the Q wave of the ECG and the end diastolic pressure 

Rate - heart rate in BPM as extracted from the time interval between consecutive end 
diastolic pressure locations 

Recovery time %REC Time it takes for dP/dt to increase from the minimum dP/dt location to a user 
specified percentage of that minimum value 

Systolic pressure SYS Maximum pressure occurring during the entire cycle 

Tau - Monoexponential time relaxation constant tau computed on a cycle by cycle basis.  
See “Computation of Tau” on page 381 for specifics. 

Tension time 
index 

TTI Integral of the pressure between end diastolic and the time of minimum dP/dt 

 

http://www.biopac.com/video/?video_category=automated-analysis-demos&v=estimated-cardiac-output-from-blood-pressure�
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Computation of Tau 
There are many different methodologies used to extract the time constant from LVP data. The time constant is 
extracted from a best fit parameter of a model to the trailing edge of LVP data on a cycle by cycle basis. This 
analysis uses a monoexponential model of zero asymptote for computing tau.  
The relaxation period is defined as the range of data between the time of minimum dP/dt in the cycle to the point 
where the LVP pressure signal drops below the previous LVEDP level. Within this range, the following model is 
fitted to the data using the simplex search method: 

τ
t

eP0  

where P 0  is the value of the LVP signal at the time of dP/dt minimum and t is the time coordinate shifted such 
that t is 0 at the time of dP/dt minimum. The best fit value from this model is used as the value of the relaxation 
time constant. 

 
LVP Classifier  

Operates on left ventricular blood pressure (LVP) data to define events at the systolic pressure and the left 
ventricular end diastolic pressure for each cycle. 

 
The location of these points is performed using filtered derivatives of the original LVP signal. Pre-filtering the 
signal (low pass of 50 Hz or less) or smoothing the signal before running the classifier may improve accuracy. 
The LVP classifier locates LVEDP (left-ventricular end diastolic pressure) by examining the derivative of the 
pressure signal based upon the location method specified in Preferences: 
 Adaptive threshold of 0 plus a percentage of the peak to peak change in pressure. The percentage is user-

specified; the default is 1%. If the LVP signals do not have “flat” valleys, this percentage may need to be 
increased to fine-tune positioning of LVEDP. 

 First zero crossings before contraction. 
 Watch the AcqKnowledge LVP classifier video tutorial for a detailed demonstration of this feature. 

http://www.biopac.com/video/?video_category=automated-analysis-demos&v=lvp-analysis�
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Monophasic Action Potential  

  
Performs classification of MAP data acquired from a human or animal subject and extracts various cycle by cycle 
intervals. Locates upstroke, maximum, 100% recovery, and user-specified recovery points on the action potential.  
 Classification is performed using the action potential with its smoothed derivative; pre-filtering noise with 

low pass filters may improve classification. 
 If upstroke, maximum, and plateau events are already defined on the MAP signal, the classifier is not invoked 

and only recovery events are defined. 

Plateau position 
To better handle animal subjects and different potential morphologies, there are two methods for locating the 
plateau position in monophasic action potential data; use Preferences to set the method. Each method defines 
recovery percentage time locations depending on the signal between its maximum and the beginning of the 
plateau. The plateau is located by examining the derivative of the MAP immediately following its maximum 
value after an upstroke.  
 The first method uses an adaptive threshold of zero plus a percentage of the peak to peak change in the 

derivative between the maximum and the first zero crossing after the maximum. If the signal remains above 
the upstroke voltage in this interval, a quick algorithm is used to locate 100% recovery and user-specified 
percentage levels.  

 The default percentage is 0.1%, which will place the plateau position very close to the second zero crossing. 
This slight window around zero helps place plateau start events better for MAP data that has plateaus that 
continue increasing after their starting position. 

 Searches for the second zero crossing after the maximum. If the signal drops below the voltage level of the 
upstroke in this interval, a different (slower) algorithm is used to ensure the recovery percentage is relative to 
the upstroke voltage and not the minimum occurring between the maximum and plateau. 

The analysis outputs the following information on a cycle-by-cycle basis and the textual output cites the average 
of all of the cycle-by-cycle values: 

Name Abbrev Description 
100% recovery 
period 

100% 
REC 

Time interval from the upstroke for the signal to recover back to the upstroke voltage 
level 

dV/dt maximum dV Max Maximum change in voltage over the cycle 
dV/dt minimum dV Min Minimum change in voltage over the cycle 
End diastolic 
voltage 

EDV The value of the signal at the beginning of the upstroke 

Max voltage MAX The maximum value of the signal over a single cycle 
Minimum 
voltage 

MIN The minimum value of the signal over a single cycle. This may be less than the 
upstroke voltage depending on the morphology of the action potential 

Plateau voltage 
 

PLAT The value of the signal at the start of the plateau after the completion of the upstroke 

Rate - This is the heart rate in BPM as extracted from the time interval between consecutive 
upstrokes 

Stroke amplitude AMP Voltage interval between the plateau and the upstroke voltage 
User recovery 
period 

%REC Time interval from the upstroke for the signal to recover a specific percentage of the 
interval between the upstroke and the maximum voltage between the upstroke and the 
plateau 
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 Watch the AcqKnowledge Monophasic Action Potential video tutorial for a detailed demonstration fo this 
feature. 

MAP Classifier  
The classifier portion of Monophasic Action Potential only – defines upstroke, plateau, and percentage recovery 
events on MAP signals without performing the additional MAP data extraction. 

 
The start of the plateau is located using either the second zero crossing of the derivative or a percentage of the 
cyclic peak-to-peak distance of the derivative. The plateau location method can be configured in Preferences. 

Preferences 

 
Display results as 

Several of these transformations produce large amounts of cycle-by-cycle derived measures. Results can be 
displayed as a tab delimited table in the journal, as waveforms in the graph, as an Excel spreadsheet or various 
combinations. Results are displayed as text-only by default. 

 LVEDP location method – see page 381
 adaptive threshold of 0 plus a % of pk-pk change in pressure 
 first zero crossings before contraction on the dP/dt signal 

 MAP Plateau location method – see page 382
 adaptive threshold of 0 plus a % of pk-pk change in the derivative between the max and the first 0 

crossing after the max 
 second zero crossing after the maximum 

  

http://www.biopac.com/video/?video_category=automated-analysis-demos&v=monophasic-action-potential-analysis�
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ABP Location method (Arterial Blood Pressure) 
 Adaptive template matching 

This arterial blood pressure cycle location method uses adaptive template matching (see page 300). A 
single cycle is selected, systolic to systolic, which sets an example template. Subsequent blood pressure 
cycles are located by correlation to this template with the template adapting to the signal. This may 
function better if there is artifact in the pressure signal, however may not be as suitable for signals that 
have significant changes in heart rate. Location may also improve if a different cycle is chosen as the 
initial template. Adding smoothing or a low pass filter to the signal may improve results for Estimated 
Cardiac Output, ABP Classifier and Arterial Blood Pressure. 

 Tracking peak pressure level  
The Tracking peak pressure level ABP location method is similar to the cycle detector's peak location 
method. This method sets a detection threshold from a selected systole and adjusts the threshold based on 
a customizable tracking percentage. The default tracking percentage is 60%. If the blood pressure signal 
is highly variable, this tracking percentage may need to be lowered. If the tracking percentage is set too 
high, blood pressure cycles may be missed. 

HRV and RSA Analysis 
AcqKnowledge includes flexible options for extracting a wide range of heart rate variability (HRV) and respiratory 
sinus arrhythmia (RSA) measures. This analysis feature allows you to: 

• Extract HRV measures over user-defined areas of data, such as fixed time trials (“epochs,”) events and 
focus areas. 

• Obtain RSA measures using frequency-based HRV. 

• Automatically compute HRV using geometrical and statistical methods. 

Multi-epoch HRV – Statistical 

 
This analysis computes statistical measures of heart rate variability in user-specified time intervals. These 
measures (RMSSD, SDSD, and pNN50) can be extracted by fixed time intervals, time between event boundaries 
or focus areas. Output from the script is a spreadsheet containing these statistics and the time intervals over which 
they are computed. ECG complex events are also scored in the source graph. See Application Note 129 for a 
detailed explanation of HRV statistical analysis measures.  

The following table describes options in the Multi-epoch HRV Statistical Analysis setup: 

Control Description 

ECG Channel: Selects the channel to extract the statistics from. The ECG channel should be selected. 

Extract HRV 
statistics for: 

Select how the time ranges used for extracting ststistics are applied. The options are Fixed 
time trials, Time between event boundaries and Focus areas. 

Epoch width: Indicates time duration and time units for each epoch. 

Start first epoch 
at: 

Chooses location for starting first epoch. (Beginning of graph, current cursor location or a 
specific time point in the graph.) 

http://www.biopac.com/heart-rate-variability-hrv�
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Multi-epoch HRV and RSA – Spectral  

 
This routine performs RSA and HRV analyses on specified time slices along an ECG waveform, whether by markers, 
fixed time intervals or focus areas. Then the HRV parameters of VLF, LF, are teased out of the journal, formed into a 
table, and written back into the journal or to an Excel spreadsheet. The following table describes the HRV and RSA 
Spectral Analysis options: 

Control Description 

HRV Preset Selects the heart rate variability preset to be used in the analysis. (This must first be pre-
defined in the main HRV analysis dialog for conveying PSD, frequency bands, etc.) For more 
information, see Single-epoch HRV – Spectral.) 

ECG Channel: Selects the channel to extract the statistics from. The ECG Lead II channel should be 
selected here. 

Extract HRV and 
RSA by: 

Selects how the segments to be analyzed should be located. Available options are by: 
• Periodic time intervals – this option segments the data into fixed width epochs that 

occur at regular frequency intervals. It is equivalent to the “fixed time interval” option 
of epoch analysis.   

• Fixed-width intervals around events – “Fixed width intervals around events” is akin to 
the “at events” option of Epoch Analysis. It searches for individual events and then 
analyzes a fixed interval of time with that event either as the beginning point or the 
endpoint of the time window.   

• Time between event boundaries – allows the segments to be located between two 
different individual events. The boundaries should ideally be two different types of 
events.  If set to the same type, you will be prompted for whether the ending event of 
a pair should be immediately reused as the start of the next time interval. 

• Focus areas – this method extracts the HRV for each focus area defined within the 
graph.  

See page 385 for specific setup descriptions for the above options. 

Output type: Select the analysis output format – Text, Excel, or both. 

Output events at 
analysis 
boundaries: 

Defines new markers at the time boundaries of each analyszed data segment. This is useful 
when performing validation of the analysis. 

If Periodic time intervals are chosen, the following setup criteria are available: 
• Epoch width: – sets the duration and time units for each epoch 
• Start first epoch at: – choose location for starting first epoch. (Beginning of graph, current cursor location 

or a specific time point in the graph.) 
• Time between epochs: – indicates the time separating one epoch to the start of to the next. 
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If Fixed width intervals around events is chosen, the following setup criteria are available: 
• Event type: – choose the specific type of event to be used in the analysis. 
• Before events: – when selected, the event marks the end of the analysis time interval. 
• After events: – when selected, the event marks the beginning of the analysis time interval. 
• Epoch width: – sets the duration and time units for each epoch. 

If Time between event boundaries is chosen, the following setup criteria are available: 
• Start event: – select the starting event type at the beginning of each time segment. 
• End event: – select the ending event type at the end of each time segment. 

R-R Poincare Plot 

 

 
Poincare plots are constructed from ECG Lead II data. A Poincare plot is an XY plot with RR intervals in seconds 
on one axis and on the other axis the sequence delayed by one beat (RR vs. RR+1).  This plot may be used to 
visually inspect for patterns in the sequence similar to an attractor plot. The RR intervals are measured in seconds.  

This generates a new dot plot graph window in XY mode, no textual output is generated. Click the  button to 
exchange the X and Y axis (flip the plot diagonally.) Use “Plot recent data only” to isolate a subset of the most 
recent data points. Enter the desired number of data points to be displayed and check the “Plot” box. Or, with the 
box checked, enter the desired value and hit the Enter (Return) key. 
Applying the R-R Poincare plot option also scores the ECG source graph with QRS events. 
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Respiratory Sinus Arrhythmia (RSA Time-series) 

 
IMPORTANT—Respiration analysis assumes a bidirectional airflow signal that records both 
inhale and exhale. Unidirectional respiration signals cannot be analyzed at this time. 
Respiratory Sinus Arrhythmia is used to explore the connection between respiration and changes to heart rate. 
Variations in the heart rate can be directly correlated with vagal tone. The RSA index can be used to investigate 
changes in this connection during recording. 
This RSA index is computed using the peak-valley method as outlined in: 

Grossman, P., van Beek, J., & Wientjes, C. (1990). A comparison of three quantification methods for 
estimation of respiratory sinus arrhythmia. Psychophysiology, 27, 702-714. 

This method uses both a recorded ECG Lead II signal and a respiration signal. By using respiration information, 
this analysis method can provide breath-to-breath analysis that does not require parameter tweaking for individual 
subjects. 
While designed for use with the RSP100C/TSD201 respiration module and transducer combination, it should be 
possible to use other estimates of respiration. The respiration signal is used to locate periods of inhalation and 
exhalation. Inhalation begins at valleys in the signal while expiration at peaks. Any respiration estimate that 
exhibits this morphology should be sufficient. 
The RSA index outputted by this analysis is linearly scaled as per the recommendations in Grossman et. al. For 
comparison to other methods or studies using logarithmic scaling, Transform > Math Functions > Ln 
transformation can be used after analysis to convert results to logarithmic scaling.  
In AcqKnowledge versions 4.4.1 and higher, selecting the “Generate logarithmic RSA” checkbox will 
automatically output the logamrithmic result. 
RSA results are triggered from the respiration cycle. The RSA analysis outputs the following measures: 

Cycle Index of the respiration cycle in the analysis. 
Time Location of the start of the respiration cycle on the time axis. 
Min Rate Minimum heart rate occurring during the inspiration window of the respiration cycle, expressed 

in milliseconds (IBI). 
• If a respiration cycle is invalid, this measure will be set to 0. 

Max rate Maximum heart rate occurring during the expiration window of the respiration cycle, expressed 
in milliseconds (IBI). 

• If a respiration cycle is invalid, this measure will be set to 0. 
RSA RSA index for the respiratory cycle, expressed in milliseconds. This is the max rate minus the 

min rate. This is output in linear scaling.  
 If a respiration cycle is invalid, this measure will be set to 0. 



388 AcqKnowledge 4 Software Guide 

Visit the online support center at www.biopac.com 

Single-epoch HRV – Spectral 

Single-epoch HRV – Spectral (formerly referred to as Heart Rate Variability in AcqKnowledge versions 4.3.1 and 
earlier), is the examination of physiological rhythms that exist in the beat-to-beat interval of a cardiac signal. Single-
epoch HRV assists in performing frequency domain analysis of human ECG Lead II data to extract standard HRV 
measures. The HRV algorithm in AcqKnowledge 3.9 and above conforms to the frequency domain algorithm 
guidelines as published by the European Heart Journal (1996) 17, 354-381. 

  

 
Single-epoch HRV processing in AcqKnowledge consists of three stages: 

1. The RR intervals are extracted for the ECG signal. 
 A modified Pan-Tompkins QRS detector is used. 

2. The RR intervals are re-sampled to a continuous sampling rate in order to extract frequency information. 
 Cubic-spline interpolation is used to generate this continuous time-domain representation of the RR 

intervals. 
3. The frequency information is extracted from the RR intervals and analyzed to produce standard ratios. Power 

sums are reported in units of sec2. 
 A Welch periodogram is used to generate the Power Spectral Density (equivalent to Transform > Power 

Spectral Density). 
The initial implementation of the HRV algorithm was primarily for use with long duration recordings. HRV algorithm 
improvements allow for further customizations to the algorithm:  
 Windowing type for FFTs used to construct the PSD may be changed between Hamming, Hanning, and 

Blackman.  
 Overall window length for segmenting source data for individual FFTs to include in PSD average may be 

modified . 
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 Length of the individual FFTs in the average can be manually specified.  
 Scaling has been changed for PSDs, which are now scaled relative to the sampling frequency. 
 Summary of power in individual frequency bands has been changed . 
 Instead of a straight sum, an average power value is now reported . 
 Power at endpoints is halved (e.g. divided by 2).  
 Sympathetic/Vagal ratios may optionally include the very low frequency band in the total power estimate  
 The modifications to the HRV algorithms that affect its power spectrum estimation have also been applied to 

the PSD transformation.  
After selecting Analysis > HRV and RSA > Single-epoch HRV – Spectral, choose the appropriate tab(s) and establish 
settings.  
Preset controls, Transform entire wave checkbox, and OK/Cancel buttons apply across all of the tabs.  
Preset—The preset menu can be used to save a variety of HRV settings, including: beat detection parameters, spline 
resampling frequency, and frequency band ranges. Choose a preset from the popup menu to apply its settings. To 
construct a new preset with the currently displayed settings, choose Add New Preset. A default preset for adult human 
subjects is supplied. 
RR intervals 
Select a method to locate R waves: QRS Detector or Events. 

QRS detector 

 
The heart rate variability implementation has a built-in QRS detector. The detector does not run on raw source 
data; it uses a modified Pan-Tompkins algorithm to normalize the ECG data to 1, whereby the peak amplitude of 
the highest R-wave represents 1. Use the tachogram output to examine the output of the QRS detector. 
 R wave threshold—The detection threshold must be specified in terms of percentage of maximum R peak 

level; this helps to clarify the units in which this threshold is expressed. The default threshold level of .5 
should place the threshold in the middle of the R-wave, which should function on a wide range of data sets. If 
the R-wave amplitude varies a lot, it might be necessary to adjust the threshold level. 

o R wave threshold is expressed in normalized units, which are in the range (-1, 1): positive for 
positive R wave peaks. The maximum voltage in the signal maps to 1.0 and the minimum voltage 
in the signal maps to -1.0. 
Pan J and Tompkins WJ. A Real-Time QRS Detection Algorithm. IEEE Transactions on 
Biomedical Engineering 32(3):230-236, 1985.  

Events 

 
R-wave peaks will be located using events already in the graph of the channel of data to be analyzed. This 
assumes a single event is placed at each R-wave peak and that all of the R-peak events are of the same event type. 
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When using events, the built-in QRS detector is not used; the exact positioning between the events on the channel 
is used to extract the RR intervals.  
By using events, it is possible to use other QRS detectors within AcqKnowledge for performing HRV analysis. It 
is also possible to apply spectral HRV-style analysis to data in other domains as long as intervals can be reduced 
to events. 
Spline resampling frequency 
For highest accuracy, set to no less than twice the topmost frequency of the very high frequency band. 

Frequency Bands 

 
Enter the start and end of each specified frequency band to adjust the boundaries of the frequency analysis. They 
are preset to the frequency ranges recommended by the European Heart Journal (1996) 17, 354-381. Output of 
derived parameters is presented in a dialog and may also be pasted as text to the Journal. 

 Very high frequency band, usually used in rat studies, is disabled if the spline resampling frequency is less 
than the upper bound of the very high frequency range. 

PSD Options 

 
PSD Options establish parameters for the power spectral density transformation used to compute the spectrum 
from the interpolated tachogram; the options contained in this tab mirror the controls of the Analysis > Power 
Spectral Density transformation. 

The use of linear detrending in each individual segment of source data prior to the windowed periodogram 
analysis can be enabled or disabled. When disabled, the algorithm may be tuned to correspond to 
implementations that do not apply linear trending, such as MATLAB, which uses windowing only. The same 
PSD options are available via Analysis > Power Spectral Density so users can regenerate the spectrum from 
either the raw or interpolated tachogram output as necessary. 

After the user modifies the parameters for the PSD transformation, those parameters will become the new 
default values each time the dialog is displayed. When the application is relaunched, the default settings will 
be used (user changes are not persistent). 
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Window Used to change the window that is applied to each segment of the source data prior to 

computing the PSD to be included in the average. Includes the following options: 

Hamming Hanning Blackman 

Window size The specified number of samples must be a power of two. Note that the window function is 
applied to the entire window width of the data; using a subset of the windowed data will not 
include the final portion of the windowed data. 

 If the FFT size is less than the window size, only a subset of the windowed sample data 
will be used.  

Automatic If selected, the window size is selected automatically depending on the size of the 
source data. For a data length of n samples, choosing this radio button will use the 
window size: 

L =
n

4.5  

Manual If selected, the window size will be input manually by the user in the associated 
edit field. The window size must be greater than three and must be less than the 
length of the data selection. Users will be warned on invalid window sizes when 
attempting to click OK. 

Overlap length After each individual FFT, the window of source samples is shifted over by a certain amount to 
compute the next FFT, so there is an overlap of source samples in successive windows of 
source for the next FFT in the average. 

Automatic If selected, the number of samples to overlap successive windows will be 
computed automatically. Given a window length L computed according to the 
window width choices, choosing this radio button will use an overlap number of 
samples:  

L
2  

Manual lf selected, the number of samples to overlap successive windows of source data. 
Overlapping reduces windowing artifacts The overlap length must be positive and 
must be less than the window size. Users will be warned on invalid overlap lengths 
when attempting to click OK 

FFT width Automatic If selected, the number of points to use for each individual FFT will be computed 
automatically. Given a window length L computing according to the window width 
choices, the number of points in the FFT will be set to: 

 
 The number of points in the FFT is set to 256 if the window width is less than 

256. Otherwise the length is set to the next power of two higher than the 
window width. 

Manual  If selected, the number of points in the FFT will be specified manually in the edit 
box to the right of the radio. The number of points in the FFT will be required to 
be a positive power of two. It is recommended that the FFT length be set larger 
than the window size. If longer than the window size, zero point padding is used. 
Users will be warned on invalid FFT number of points when attempting to click 
OK. If the user inputs a number of points for the FFT that is shorter than the 
window width, a confirmation dialog will be displayed to the user warning that the 
windowing is shorter than the requested FFT width and asked if they want to 
continue. 
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Use linear 
detrending for 
each window 

When enabled, linear regression detrending is applied for each individual segment prior to the 
FFT computation. When disabled, windowing only is applied. 

Detrend each 
segment 
independently 

This option is only available when “Use linear detrending” is enabled. When this option is 
enabled, detrending is applied independently for each segment; when disabled, detrending 
from the previous segment will be incorporated into the next segment. 

Transform 
entire wave 

When enabled, the entire waveform is delayed. When unchecked, only the selected area is 
delayed. 

 If there is no selection in the graph, the checkbox is enabled and dimmed. 

 As the selection changes in the graph with the selection palette, the state of this checkbox 
is updated. 

Improvements to PSD Options (AcqKnowledge 4.3 and higher) 

 The PSD output is now scaled so power values are scaled by the sampling rate.  That is: PSDnew=
PSDold

f s
 

 Reporting a sum for a frequency range when computing the power in an individual band has been changed.  
Given a frequency range f low , f high define the set S of all samples of the PSD where 

( ) ( ){ }highlow fPSD,,fPSD=S … .    Define the sum of the power within the frequency range as:  

( )
| |

| | ( )
| | 122

1

2

1

−

−
×








∑

−

S
ffS

+S+S=f,fs lowhighS
S=i

=i
ihighlow .  This applies the scaling factor to a sum of the 

frequencies in the frequency range, with the magnitudes at the endpoints divided by 2.  Previous versions 
would perform a direct sum of all amplitudes within the frequency band. 

 Result reporting has been changed for the overall ratios.  The VLF section is now included in the ratios.  A 
new VLF ratio has been introduced.  Define ( )highlowvlf vlf,vlfs=s , ( )highlowlf ,lflfs=s  , and 

( )highlowhf hf,hfs=s  .  The new VLF ratio is: 
hflfvlf

vlf
vlf s+s+s

s
=ratio .  The new sympathetic ratio is 

defined as: 
hflfvlf

lf
lf s+s+s

s
=ratio . The new vagal ratio is defined as:  

hflfvlf

hf
hf s+s+s

s
=ratio .  The 

previous algorithm defines the sympathetic ratio as: 
hflf

lf

oldlf s+s
s

=ratio .  The previous algorithm defines 

the vagal ratio as:
hflf

hf

oldhf s+s
s

=ratio . 
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Output 

 
Create standard result presentation graphs or assess 
performance of the HRV algorithm. Output options 
allow access to intermediate computation data for 
algorithm validation and/or measurements.  

 
RR Interval table 

• If the combined output formula is selected, the analysis output will contain an additional line of text:  “VLF 
Ratio” with the corresponding percentage. 

Spectrum 

Displays the power spectrum density (PSD) estimation from which the PSD summations and 
sympathetic/vagal ratios are computed. 

Raw tachogram 

Plots the raw R-R intervals found by the QRS detector. Perform statistical HRV measures on the R-R 
intervals without exporting the textual R-R table to excel. 

Interpolated tachogram 

Plots the resampled R-R intervals after cubic spline interpolation is applied and extracts the PSD from 
this data. 

IMPORTANT—Recording good data is essential for performing HRV analysis. The protocol for data acquisition, 
filtering, artifact detection and correction in Application Note 233 results in great improvements in HRV analysis.  

“Results reveal that even a single heart period artifact, occurring within a 2-min recording epoch, can lead to 
errors of estimate heart period variability that are considerably larger than typical effect sizes in 
psychophysiological studies.” —Berntson & Stowell, 199 
• See Application Note 233 Heart Rate Variability—Preparing Data for Analysis Using AcqKnowledge 

(online at www.biopac.com) 

 Watch the AcqKnowledge HRV Analysis video tutorial for a detailed demonstration of this feature. 

The note explains how to optimize ECG R-R interval data for Heart Rate Variability studies by using a template 
matching approach. It also explains how to identify erroneous R-R interval values caused by signal artifact and shows 
methods for correcting the errors by using the tools in the AcqKnowledge software. The note explains how to:  

A. Record good ECG data 
B. Prepare data for the tachogram  

1. Filter the ECG data 
2. Transform the data using Template Correlation function  

C. Create a tachogram  
D. Identify problems with the tachogram data  
E. Correct tachogram data  

http://www.biopac.com/�
http://www.biopac.com/video/?video_category=automated-analysis-demos&v=hrv-analysis-fully-automated-routine-in-acqknowledge�
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Impedance Cardiography Analysis 
The Impedance Cardiography analysis package assists in the analysis of cardiac output and other hemodynamic 
parameters using noninvasive bioimpedance monitoring techniques; signals must be sampled at 5 kHz or below to 
be analyzed with this package. This analysis offers a variety of approaches for estimation of cardiac measures. 

 
Body Surface Area  

Determines the body surface area estimation in square meters for a subject of a given height and weight, using the 
formula set in Preferences. It can be used to calculate body surface area independent of any of the other analysis 
routines, which may be useful for validation purposes or other derived calculations. 
Body Surface Area equation 
Use the Preferences option to select an algorithm for estimating body surface area of a subject and deriving stroke 
volumes from impedance data. 

Method Formula 

Boyd 

 

BSA= 0.0003207 × Height(cm)0.3 ×Weight(g)0.7285−0.0188 log(Weight(g ))  

DuBois and DuBois 

 

BSA= 0.20247 × Height(m)0.725 ×Weight(kg)0.425  

Gehan and George 

 

BSA= 0.0235 × Height(cm)0.42246 ×Weight(kg)0.51456 

Haycock 

 

BSA= 0.024265 × Height(cm)0.3964 ×Weight(kg)0.5378  

Mosteller 

 

BSA=
Height(cm) ×Weight(kg)

3600
 

dZ/dt Derive from Raw Z  
This is a convenience utility for working with impedances recorded using the BIOPAC EBI100C amplifier or the 
raw impedance output of the BIOPAC NICO100C module. When computing derivatives from raw impedance 
signals from an EBI100C, this will apply appropriate filtering for a thoracic impedance signal and properly invert 
the derivative to match traditional dZ/dt presentation. 

dZ/dt Classifier  
Places events at common inflection points on a dZ/dt waveform to derive other measures. 
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The classifier will attempt to locate the following points on the ICG signal: 
 B point – opening of aortic valve (set location in Preferences) 
 C point – Maximum left ventricle flow (set location in Preferences) 
 X point – Closing of aortic valve (set location in Preferences) 
 Y point – Closing of pulmonal valve 
 O point – Widest opening of mitrial valve 
The algorithm for locating these points on the ICG signal examines local minima and maxima in the dZ/dt signal 
as well as values of its second derivative. Filtering is applied to the second derivative signal to improve accuracy. 
 Pre-filtering the dZ/dt signal may improve accuracy slightly. 
In a particular cardiac cycle, if there is not enough definitive change in the ICG signal to locate a particular point, 
the point will be omitted. This may most commonly occur with the Y point since its inflection between X and O is 
subtle and may be lost. 
The location routine, as with impedance cardiography measurements in general, is sensitive to motion artifacts. It 
is intended to function on signals acquired from subjects at or near perfect rest. Swings in the dZ/dt signal may 
cause the classifier to fail. It is recommended that motion artifacts be removed before running the dZ/dt classifier 
or any other ICG analysis tools that may invoke the classifier on an ICG signal. If artifacts are present within the 
signal, the template matching cycle location method will exhibit better behavior than the fixed threshold method. 
The choice between these two methods can be made with the Preferences option of the analysis package. 
B-point Location—Use Preferences to set the dZ/dt B-point location method. 

There is no standard method generally accepted for programmatically locating B-points on an ICG waveform. 
The appropriate choice of B-point location method may depend on the data or on subjective preference. On 
average, all five methods will produce similar results for clean data. ICG Preferences has five options for B-
point location: 
 Second derivative classification – Given a C peak, it searches within a 150ms to 100ms time window 

before the C peak for the maximum of the second derivative of impedance ( Z ). The B point is placed 
at this maximum. 

 Third derivative classification – Given a C peak, it searches for the maximum value of the third derivative 
of impedance ( Z ) within 300ms before the C peak. The B point is placed at this maximum. 

 Cycle-by-cycle ‘Isoelectric’ crossings – Given a cycle defined by two C peaks, the mean of the dZ/dt 
signal is computed over the cycle. The B point is then placed at the closest time to the right C peak that is 
still underneath this baseline zero level. 

 R to C polynomial model - Location of B point based on locations of R and C points according to 
polynomial equation found in Lozano et al. (2007). Psychophysiology, 44:113-119. 

 Min derivative in C-QRS interval – Start at C, move backwards in time 35 ms, start looking for minimum 
of derivative of dZ/dt, stop at peak of QRS + 25 ms. Minimum dZ/dt derivative in window (35-(R+25)) 
ms is B. 
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C-point Location—Use Preferences to set the dZ/dt C-point location method. 
In several of the ICG analysis scripts, the B, C, X, Y, and O points will need to be located on the dZ/dt 
waveform. The starting point of this process is locating individual cycles on the dZ/dt waveform to define the 
C points. Use Preferences to set the cycle location method: 
 Template Matching – the user is expected to select a representative cycle of the dZ/dt waveform. The 

entire cycle should be selected (e.g. visually to approximate a C-C interval, a X-X interval, etc.). The 
entire dZ/dt signal is then correlated with that representative cycle, and individual cycles are picked out 
from locations of maximum correlation. 

 Fixed Thresholding – the user is prompted to select one of the C peaks of the dZ/dt waveform. The 
voltage level of this peak is then used to compute an Ohms/sec thresholding level. Peak detection is 
then run on the dZ/dt waveform using that voltage level as the threshold. 
Since ICG is subject to many artifacts such as respiration components and motion artifacts, the default 
method used is template matching. For extremely clean ICG signals, however, fixed thresholding can 
be used effectively as well and will provide a quicker analysis. 

 Adaptive template matching – the user is prompted to select a representative cycle of the dZ/dt 
waveform. This is used as a basis for an adaptive match to locate cycles. Adaptive template matching 
will adapt to changes in the dZ/dt waveform as conditions change within the experiment. Two 
parameters may be set. The window size is the number of ICG cycles to use for estimating the next 
template. Smaller values will track changes more quickly; larger values will reduce interference from 
artifact. The correlation threshold is the value above which a match is found. It refers to the normalized 
cross correlation of dZ/dt with the template and should be between 0 and 1. Values closer to 1 will 
require precise matches and skip artifacts. Values closer to 0 will use looser match constraints and may 
be required if the ICG is changing rapidly.  

X-point Location 
There are two methods that may be used to locate the X point of the ICG waveform at the closing of the aortic 
valve. The choice of appropriate X point location method is dependent on the electrode configuration that is 
used to acquire the ICG signals. In certain electrode configurations, the dZ/dt minimum may actually occur 
closer to the A-wave complex than to X, making the first (and default) option of searching for the first turning 
point a more reliable solution. You may want to acquire a phonocardiogram in conjunction with ICG to help 
determine which method will be more accurate at locating X. 
 Search for the first turning point in the dZ/dt signal that occurs after the C point location and place X at 

the first positive zero crossing in the second derivative of impedance (d2Z/dt2).This is the default X point 
location method. 
 Locate the X point at the minimum value of dZ/dt over each cardiac cycle. 
 Start at C, move forward in time 150 ms, start looking for minimum of dZ/dt, stop at 275 ms. Minimum 

in window is X. 
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ICG Analysis  

 
The ICG Analysis routines include 20 derived impedance and hemodynamic measures that correspond to various 
values that are generated by other industry-standard impedance cardiography analysis tools. Many users tend to be 
interested only in a subset of the various measures produced by the analysis (e.g. only heart rate and cardiac output); 
the extra measures can “clutter” the output and frustrate users who have to delete them manually. 

The ICG Analysis output options feature adds a new step to the ICG Analysis where the user may toggle the output of 
individual measures on and off. This allows users to suppress generation of all output for a measure including the 
graph channels, column in the Excel spreadsheet, and column in the text output.  

ICG Analysis performs a full impedance cardiography analysis on data, extracting intervals and derived cardiac 
measures. The minimal set of signals required to run this analysis is an ECG Lead II signal and either a raw 
impedance signal or a dZ/dt signal. 

 If a raw impedance signal is present from an EBI100C or NICO100C and no derivative has been constructed, 
the analysis will automatically construct the appropriate derivative and perform classification. 
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 If both a raw impedance and a dZ/dt signal are present, the baseline impedance will be derived on a cycle-by-
cycle basis to improve the accuracy of the analysis. 

 If no raw impedance signal was acquired, a default fixed baseline impedance can be used. 
 If a NICO100C amplifier is used, it is recommended that both the raw impedance and dZ/dt signals be 

acquired to improve analysis accuracy. 
 To automatically apply motion filtering to the dZ/dt signal, use Preferences to enable Motion Filtering (see 

page 402). 
 ICG Preferences must first be selected in order to generate the main ICG Analysis setup window. 
In addition to the minimal set of signals, it is also possible to use arterial blood pressure, central venous pressure, 
and pulmonary arterial pressure signals to improve the quality of the algorithm results. If any of these signals are 
not present, default fixed estimated values can be substituted for the mean pressures instead of deriving pressures 
on a cycle-by-cycle basis. 
ICG Analysis may potentially perform classification of both the dZ/dt and the ECG Lead II signals. The various 
notes for understanding the limitations of these classifiers apply and should be understood to properly interpret 
failures in the analysis. 
ICG Analysis will produce the following information on a cycle-by-cycle basis: 
At the end of the textual table an average of all of the cycle-by-cycle values will be appended. 
 

Name Abbv. Description Units Formula 

Acceleration index ACI Maximum blood acceleration 1 / sec^2 

 

d2Z
dt2

max

TFI
 

Cardiac index CI Normalized cardiac output m^2 / min 

 

CO
BSA

 

Cardiac output CO Volume of blood pumped each 
minute 

l / min 

 

SV × HR 

Heart rate HR Heart rate in BPM as computed 
from the RR interval. 

BPM 

 

60
RRi

 

Left cardiac work LCW Work exerted by the left ventricle 
each minute 

kg m 

 

MAP − PAP( )× CO × 0.0144 

Left cardiac work index LCWI Normalized left cardiac work kg m / m^2 

 

MAP − PAP( )× CI × 0.0144 

Left ventricular ejection 
time 

LVET Time interval between B and X. 
Time interval between aortic valve 
open and close. 

sec Not applicable 

Mean blood pressure MBP Mean blood pressure as measured 
on the arterial blood pressure 
signal, or fixed estimate if no ABP 
signal is present. 

mmHg 

 

Pdiastolic +
Psystolic − Pdiastolic

3
 

Mean central venous 
pressure 

CVP Mean central venous pressure over 
cycle, or default value if no CVP 
signal is present. 

mmHg Not applicable 

Mean pulmonary arterial 
pressure 

PAP Mean value of the pulmonary 
arterial pressure of a cycle, or 
default value if no PAP signal is 
present. 

mmHg Not applicable 
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Name Abbv. Description Units Formula 

Pre-ejection period PEP Time interval between the Q wave 
of the ECG and the B point of the 
ICG. 
Time interval between systole and 
aortic valve open. 

sec Not applicable 

RR interval RR-i Time interval between R peaks in 
the waveform. 
 

sec Not applicable 

Stroke index SI Normalized stroke volume (ml / beat)/ m^2 

 

SV
BSA

 

Stroke volume SV Volume of blood pumped by left 
ventricle in a single beat 

ml / beat Set equation in Preferences: 

Kubicek—Estimates SV from the 
derivative of the impedance signal 
and blood resistivity: 

 

SV = ρ ×
L2

Z0
2 ×

dZ
dt max

× LVET 

Note  may be either the absolute 
maximum or the BC delta in 
amplitude, as set in Preferences. 

 Sramek—Estimates SV from the 
derivative of the impedance signal and 
the estimated volume of electrically 
participating fluid (VEPT): 

 

SV =
VEPT

Z0

×
dZ
dt max

× LVET  

o In the ICG analysis routines, 
VEPT is estimated using a 
truncated cone model. 

 

VEPT =
0.17H( )3

4.25
 

     Sramek-Bernstein—Estimates SV 
from the volume of electrically 
participating tissue scaled according to 
body habitus. The SV equation is: 

LVET
dt
dZ

Z
VEPTSV ××=

max0

)(δ  

where 

( )
25.4

17.0)(
3H

weight
weight

VEPT
ideal

actual ×=δ  

Ideal body weight is computed using the 
method set in the Preferences. To best 
match the original Sramek-Bernstein 
equation, use the Met Life Tables ideal 
body weight method. 

Systemic vascular 
resistance 

SVR Afterload; arterial flow resistance dynes sec / 
cm^5 

 

80 ×
MAP − CVP

CO
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Name Abbv. Description Units Formula 

Systemic vascular 
resistance index 

SVRI Normalized afterload dynes sec m^2 / 
cm^5 

 

80 ×
MAP − CVP

CI
 

Systolic time ratio STR Ratio between electrical and 
mechanical systole 

none 

 

PEP
LVET

 

Thoracic fluid content TFC Electrical conductivity of the chest 
cavity 

1 / Ohms 

 

1
TFI

 

Thoracic fluid index TFI Mean value of the raw impedance 
over the cycle, or fixed baseline 
value if no raw impedance signal is 
present. 

Ohms Not applicable 

Velocity index VI Maximum velocity of blood flow 
in the aorta. 

1 / sec 

 

dZ
dt max

TFI
 

Note  may be either 
the absolute maximum 
or the BC delta in 
amplitude, as set in 
Preferences. 

Ideal Body Weight  
Body Weight is derived from a person’s height, gender, and (for the Met Life method) frame size. It describes the 
ideal weight based upon various estimates. Ideal body weight is subject to much interpretation, so a number of 
methods are provided. Ideal Body Weight results are always expressed in kilograms. 
Use Preferences to set the Ideal Body Weight computation method; the selected method is also used for ICG 
Analysis. 

Method Formula 

Devine Men 50 kg + 2.3 kg per inch over 5 feet 
Women 45.5 kg + 2.3 kg per inch over 5 feet 

Metropolitan Life 
Tables 

The weight is taken from the standard Metropolitan Life tables, which are based on gender, 
height, and frame size. The Metropolitan Life tables specify weight ranges; the ideal body 
weight is computed as the average of the endpoints of each weight range. Ideal weights are 
based on height with shoes on and are only defined for heights between 
Men 5' 2''and 6' 4'' 
Women 4' 10''and 6' 0'' 

Miller Men 56.2 kg + 1.41 kg per inch over 5 feet 
Women 53.1 kg + 1.36 kg per inch over 5 feet 

Robinson Men 52 kg + 1.9 kg per inch over 5 feet 
Women 49 kg + 1.7 kg per inch over 5 feet 

 
PEP Pre-ejection Period  

The pre-ejection period is the time interval between the electromechanical systole and the onset of ejection of 
blood from the left ventricle of the heart. This can be derived from standard ECG data and ICG data as the 
interval between the Q point on the ECG and the B point on the ICG. The Pre-ejection Period analysis tool helps 
extract PEP measurements from ECG Lead II and ICG data. PEP can also be computed using the full ICG 
Analysis tool on page 397. 
To use Pre-ejection Period analysis, both an ECG Lead II and an ICG (dZ/dt) signal must be present. If either of 
these signals requires classification, the analysis will run the appropriate classifier to define the relevant events on 
the signals. To automatically apply motion filtering to dZ/dt, use Preferences to enable Motion Filtering (see page 
402). 
PEP analysis will output the following information on a cycle-by-cycle basis and the final line of the textual 
output will be the average of all of the cycle measurements. All time unit output is in seconds unless  
otherwise noted. 
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Name Abbrev. Description 

Heart rate BPM The heart rate for the cycle as indicated in BPM. Derived from the RR interval. 

Pre-ejection 
period 

PEP Time interval between the Q wave of the ECG and the B point on the ICG for the cardiac cycle. 
If the PEP cannot be computed for a particular cycle, it will have the value “----” in the textual output 
or 0 in the graphical output. 

RR interval RR-i Time interval between R peaks of a single cycle of cardiac data. 

dZ/dt Remove Motion Artifacts  

   
Applies SFLC motion artifact removal to a dZ/dt signal. Uses cycle information from an ECG signal to construct 
a sinusoidal model of the ICG signal containing only components that are correlated to the heart rate. 
 
IMPORTANT 
Motion artifact removal will affect the amplitudes of the dZ/dt signal, so results derived from a motion filtered 
dZ/dt signal should be additionally verified for accuracy. 
This tool performs the same type of filtering as the ICG Analysis and Pre-ejection Period tools when the Motion 
Filtering preference is enabled. 

VEPT  

 
Uses the truncated cone method to compute the volume of electrically participating tissue (VEPT) in cubic 
centimeters of a subject. You will be prompted to enter the height of the subject in the units set under Preferences. 
It can be used to calculate VEPT independent of any of the other analysis routines, which may be useful for 
validation purposes or other derived calculations. 
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Preferences 

 

Display results as 
 Textual tables in the journal 
 Channels of data inserted into the graph. 

C-point location –see page 396
B-point location – see page 395
X-point location – see page 396
Stroke volume equation – see page 399
 Kubicek, or Sramek, or Sramek-Bernstein 

dZ/dt Max method – Baseline drift in ICG signals 
can introduce drift artifacts into stroke volume, 
cardiac output, and other measures that are sensitive 
to changes in dZ/dt max. The Preferences offer two 
settings. “Max dZ/dt in cardiac cycle” will extract the 
maximum amplitude of dZ/dt as the max value. This 
is the traditional way of measuring dZ/dt max. A 
second estimate option, “change in voltage from B to 
C” will take the amplitude delta between B and C as 
the estimate of dZ/dt max. This will produce different 
stroke volume results, but is useful for removing 
motion artifact and improving consistency. 
Body Measurement Units system for inputting  
 English system: body height in feet and 

inches, distance between measuring electrodes 
in inches, and body weight in pounds 

 Metric system: body height in meters and 
centimeters, distance between measuring 
electrodes in centimeters, and body weight in 
kilograms. 

Body Surface Area equation – see page 394
 Boyd; DuBois and DuBois; Gehan and 

George; Haycock; or Mosteller 
Ideal Body Weight method– see page 400

Motion Artifact Removal 
The Pre-ejection Period and ICG Analysis transformations have the ability to optionally apply motion 
filtering automatically to the dZ/dt signal. Motion filtering is performed using an SFLC keyed to the R waves 
of an ECG signal. The SFLC filtering approach is similar to performing cycle-by-cycle averaging of the dZ/dt 
signal. This motion filtering approach may cause errors to be introduced in derived calculations, so any results 
with motion filtering turned on should be validated additionally. 
Filter Magnitude Level – relaxed, aggressive, and custom. 
 “Relaxed” uses a SFLC step size of .001. This allows the filter to adapt moderately quickly to changes in 

the dZ/dt signal. 
 “Aggressive” uses a SFLC setting of .0001. The filter will adapt less quickly to changes in the ICG signal, 

allowing better filtering out of motion artifacts at the expense of a lessened response to changes in 
underlying ICG morphology. 

 “Custom” allows for an arbitrary SFLC step size. The step size must be greater then zero and much less 
than 1 for the filter to converge. 
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Magnetic Resonance Imaging 

 
Magnetic resonance imaging, or MRI, is often used to study the brain and other organs in the body. As access 
increases to MRI machines, researchers are beginning to combine MRI with traditional physiological signal recording. 
The strong magnetic fields used by MRI equipment can cause profound artifacts in physiological recordings, which 
can make the analysis of physiological recordings acquired in an MRI difficult. Some artifacts are external 
interference while other artifacts can be caused by currents being induced in electrode leads or even in the body itself. 

Artifact Location and Trigger Signals 
Most of the MRI analysis options require information to identify the positions of various artifacts. Event positions 
can be used or a “trigger signal” waveform in the graph can be used to identify periods when the MRI is active. 
Some MRI machines have a TTL output that is synchronized with periods where the MRI is on. 

• Whenever possible, this trigger signal should be acquired with the hardware unit along with the  
physiological data. 

Trigger detection off of an MRI trigger signal waveform is performed using fixed level thresholding on the 
waveform data. The threshold level is set to be the minimum value of the entire trigger signal plus 1/10th of the 
peak-to-peak distance of the trigger signal. The threshold is kept data dependent to allow for artificial trigger 
signals to be derived from data if the MRI unit does not provide its own. The trigger signal may be acquired on 
either an analog or digital channel. 
Event driven artifact location can be useful when trigger signals are not available from the MRI or are not 
recorded. A cycle detector analysis can be used to place events at the onset of each artifact, or these events may be 
placed manually. Event based detection is also useful for applying the procedures for artifacts that are not directly 
related to the MRI trigger signal, such as for removing the cardiac interference from EEG data caused by the 
magnetic field of the MRI machine. 
For more information on cycle detector analysis, see the Find Cycle section on page 325. 

 
Artifact Frequency Removal 
MRI > Artifact Frequency Removal 
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Two large sources of interference in MRI recordings are the current induced by the MRI magnetic field and the 
RF pulses used for triggering molecule alignment. While the overlap of this interference may be difficult to 
separate in the time domain, the MRI interference may have a distinctive signature in the frequency domain. 
Artifact Frequency Removal is a frequency domain adaptation of the ensemble projection removal of the Artifact 
Projection Removal transformation. It attempts to cancel out MRI artifact by removing the frequencies most 
strongly associated with the MRI signal. 
For each channel of data to be denoised, either the MRI trigger signal or event positions are used to locate periods 
of MRI activity for constructing an ensemble average. The FFT of this ensemble average is computed, and the 
magnitude of the average FFT is set as the reference. Cyclic mean removal is applied to each period of artifact to 
compensate for baseline drift or signals with expected DC offset. A second pass is then made through the data. 
For each individual artifact, the FFT of that artifact is computed and the projection of that FFT onto the average 
FFT is removed. After projection removal, negative Fourier components are discarded and a time-domain signal 
is reconstructed using the inverse Fourier transform. This reconstructed, filtered signal is used to replace the MRI 
artifact in the original data. 
Application of projection removal in the frequency domain has similar limitations to applying it in the time 
domain, that is, it assumes that the MRI interference is stationary (which is not necessarily the case). Variations in 
the MRI interference may cause this method to fail. 
IMPORTANT Artifact Frequency Removal requires an MRI triggering signal or artifact onset events to locate 

artifact positions. 
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Artifact Projection Removal 

  
Artifact Projection Removal attempts to remove the noise components from the artifacts within a signal. An 
ensemble average is made for each period of MRI artifact in a channel. Cyclic mean removal is applied to each 
period of artifact to compensate for baseline drift or signals with expected DC offset. As the artifacts are averaged 
together, the actual interference with the physiological signal caused by the MRI should become the dominant 
feature if a sufficient number of artifacts are present. A second pass is made through the artifacts to remove this 
average MRI artifact from each individual period. 
The average artifact is removed using the Remove Projection transformation. This performs a vector projection of 
the signal onto the averaged artifact estimation and subtracts this projection. This is an improvement over straight 
subtraction of the average artifact as vector projection can compensate for changes to amplitude that may occur 
over time. 
Artifact projection removal cannot compensate for MRI interference that varies in frequency due to changes in 
orientation of electrode leads within the MRI or other factors that may alter the MRI artifact. 
Artifact projection removal is an adaptation of a denoising technique described in: 

M. Samonas, M. Petrou and A. Ioannides, “Identification and Elimination of Cardiac Contribution in Single-
Trial Magnetoencephalographic Signals,” IEEE Trans. Biomed. Eng., vol. 44, no. 5, pp. 386-393, 1997. 

IMPORTANT Artifact Projection Removal requires an MRI triggering signal or artifact onset events to locate 
artifact positions. 
 

Median Filter Artifact Removal 

 
Median Filter Artifact Removal provides a basic artifact removal suitable for slow moving signals such as 
respiration, GSR, or temperature. It performs a windowed median transformation on the source channel with a 
window width of 1/10th of the acquisition sampling rate. 
This median filtering approach is explained in the BIOPAC MRI application note AH223. 
Median Filter Artifact Removal does not require an MRI triggering signal. 
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Signal Blanking 

  
MRI artifact can grossly distort low level physiological signals, and this distortion can be several orders of 
magnitude larger than the signal of interest. A common practice for analyzing the physiological data is to discard 
the MRI artifacts and only examine the portions of the signal in between the MRI artifacts. One approach for this 
is outlined in BIOPAC MRI application note AH223. 
Signal Blanking provides an alternate approach for discarding MRI artifacts from the signal. Using the MRI 
triggering signal or artifact event locations, this analysis option will locate the periods of MRI activity and 
“blank” the physiological signal during this period. 
Two types of “blanking” can be performed: 

• Set value to zero – The waveform is set to zero during each artifact. 
• For integrated measures, zeroing the signal may be preferable as it will have no effect on the running 

sum. 
• Connect endpoints – For each artifact, a selection is made and the values within the interval are replaced with 

a line connecting the signal value before the MRI artifact to the signal value at the end of the interval. 
• For statistical measures or DC coupled signals, connect endpoint (linear interpolation within the 

interval) may be preferable to avoid causing the output to trend towards zero. 
IMPORTANT Signal Blanking requires an MRI triggering signal or artifact onset events to locate artifact 

positions. 
 



Part C — Analysis Functions 407 

AcqKnowledge 4 Software Guide 
 

Neurophysiology 
The Neurophysiology analysis package assists in the analysis of spikes within extracellular microelectrode recordings, 
such as those recorded using an MCE100C module. All of these analysis options require a continuous recorded single 
channel of microelectrode data. 

• A spike is a deviation from the baseline caused by a neuron action potential. Frequently extracellular spikes will 
resemble exponentials. The point of maximum value of the spike will be used to locate neuron firing. 

• A spike episode consists of a fixed time window around a spike that aims to capture the underlying neuron 
firing time. The episode consists both of the rise time (the time taken to reach maximum) and the relaxation 
period around the spike. 

 

Amplitude Histograms 
 

  
 

IMPORTANT To run this analysis option, the signal must first be transformed by the Classify Spike Episodes 
option or the Locate Spikes option. (See pages 408 and 409.) 

Amplitude histograms show the population density of the maximum amplitude of neuron firing events. They may be 
used to interpret changes in neuron firing due to drug response or as rough indicators of the approximate number of 
classes of action potentials in a signal. Amplitude histograms can be generated on classified or unclassified signals. 

• On classified signals, an overall amplitude histogram will be created for all of the spikes in addition to a single 
amplitude histogram per class (reflecting only the episodes of that class. 

• On unclassified signals, a single amplitude histogram will be created from the maximum voltage within all of 
the spike episodes. 

Average Action Potentials 

 
IMPORTANT To run this analysis option, the signal must first be transformed by the Classify Spike Episodes 

option or the Locate Spikes option. (See pages 408 and 409.) 
After a classification has been completed for a spike signal, to assign spike episodes to different groups, users 
may wish to view the average shape of the waveforms of each class. Examining the shape of the different classes 
provides visual feedback as to the efficiency of the clustering, can allow for identification of certain classes as 
noise or artifacts, and helps to determine if the identified classes are indeed unique. Average Action Potentials can 
be generated on classified or unclassified signals. 
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• On classified signals, the resulting ensemble averages will have multiple channels. 
o The first channel will be the overall average of all of the spike episodes. 
o The remaining channels show the average of the members of each individual spike class. 

• On unclassified signals, a graph will be produced with a single channel showing the average of all of the spike 
episodes. 

Classify Spikes 

  
This analysis option will automatically classify action potentials in microelectrode data and divide them into 
different spike classes. 
If the Locate Spike Episodes option wasn’t used to find spikes before this option was selected, the Locate Spike 
Episodes option will be automatically performed prior to the clustering.  
A single-feature k-means clustering classifier is used, and the entire data set is used for the clustering portion of 
the algorithm. The determining feature is the Sum criteria— that is, the sum of all of the data points within the 
waveform segment; this was one of the first features used in early action potential classifiers. 
The clustering may not produce meaningful classes, so results should be examined for accuracy. 
This style of classifier is for rudimentary spike analysis. For more advanced classification techniques, use the 
clustering algorithm in the Find Cycle detector. (See page 335.) 

Dwell Time Histograms 

   
IMPORTANT To run this analysis option, the signal must first be transformed by the Classify Spike Episodes 

option or the Locate Spikes option. (See pages 408 and 409.) 
A dwell time histogram shows the population density of the duration of a neuron firing event. Dwell times can be 
approximated for an action potential by measuring the absolute value of the time interval between their maximum 
and minimum voltage levels reached during the firing of the neuron. After the minimum value in the firing 
recording has occurred, the neuron will be returning to its resting state, so the time difference is a good 
approximation for the firing duration. The dwell time histogram plots this time difference versus number of action 
potentials that have similar time differences. Examining varieties in dwell times can help to illustrate drug 
responses or to perform rudimentary classification of action potentials. 
Dwell times will be defined as the time difference between the positions of the maximum signal value and 
minimum signal value within a spike episode. Since dwell time histograms can be used for classification 
purposes, they can be run on classified or unclassified microelectrode signals. 

• On classified signals, an overall dwell time histogram will be constructed for all of the spikes in addition to a 
single histogram per class, showing times of only the spikes in that class. 

IMPORTANT If cluster events from a previous spike 
classification are already defined on the 
recorded waveform, this option will erase 
them and replace them with the new 
classification of the potentials. 
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• On unclassified signals, a single dwell time histogram will be created for all of the spikes. When run on a 
classified signal. 

Find Overlapping Spike Episodes 
IMPORTANT To run this analysis option, the signal must first be transformed by the Classify Spike Episodes 

option or the Locate Spikes option. (See pages 408 and 409.) 
In many extracellular recordings, it is frequent for there to be more than one neuron firing in response to the same 
stimulus. This can result in overlapping spike episodes when both neurons fire in close succession. Some types of 
analysis and spike classification are not able to produce meaningful results if too many overlapping episodes 
occur. “Find Overlapping Spike Episodes” can be used to locate overlapping episodes. After the spikes have been 
located in a signal, this option can be used to iterate only to those that are overlapping.  
“Next Overlap” and “Cancel” buttons are available in the toolbar of the graph window to allow for iteration 
through the episodes. 
Note This option is “view only.” Overlapping episodes are not affected by the analysis and will need to be 

manually removed manually to delete them from the file. 
Generate Spike Trains 

 
IMPORTANT To run this analysis option, the signal must first be transformed by the Classify Spike Episodes 

option or the Locate Spikes option. (See pages 408 and 409.) 
Spike trains are good visual indicators of when action potentials are firing and are good synchronization waves for 
further analysis and data reduction. A spike train is a channel in a graph whose value is 0 when there is no spike 
and 1 when there is a spike. 
Spike train generation will operate only on signals whose action potentials have already been classified.  

• A single spike train will be generated as a channel in the graph for each class of action potential in 
the signal. Be sure to choose “Graph Channels only” or “Text and Graph Channels” in the 
Neurophysiology Preferences. (See page 410.) 

• If text output is enabled, the spike trains will be pasted as tables in the journal with one table per 
spike class. 

• If spreadsheet output is enabled, the tables will be placed side by side so index 1 of the tables lines 
up for each action potential. 

Locate Spike Episodes 
Neurophysiology > Locate Spike Episodes  

 
This option provides the basic spike detection for a microelectrode signal. Spike detection is performed using the 
following steps: 
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1. Obtain mean value of the entire signal. 
2. Obtain standard deviation of the entire signal. 

OR: Obtain an Amplitude/Half Width Discriminator of the entire signal. See Neurophysiology Preferences 
for more information (page 410). 

3. Detect spikes where the signal rises above a fixed threshold determined by adding a multiple of the standard 
deviation to the mean. 

4. Position the episode around the threshold crossings according to the width and offset entered previously. 
A “Spike Episode Begin” event will be placed at the start of each spike episode and will be located offset 
milliseconds away from the threshold crossing. A “Spike Episode End” event will be placed at the end of each 
episode. 

• If text output is enabled, a table of the start time of each episode will be placed in the graph’s 
journal. 

• If spreadsheet output is enabled, a new spreadsheet will be created with the start time of each 
episode. 

Spike episodes may also be located manually by using the Cycle Detector to define “spike episode begin” and “spike 
episode end” events in the graph. 
Set Episode Width and Offset 

   
The first time spike detection is performed on a graph, the episode width and offset need to be entered. This width 
and offset is remembered and is used for all future spike detections in the graph performed by “Locate Spike 
Episodes” and other transformations. The width and offset that are entered are retained even if the file is saved 
and reopened. 
Use this option to view or change the current width and offset. 

Preferences 

 
 

Preference Description Default 
Setting 

Display results as: Determines whether analysis results will be displayed as graph channels, 
textual tables in the journal, or Excel spreadsheets. Not all of the output 
types are applicable for each Neurophysiology analysis option. 

Text output to 
journal only. 
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Preference Description Default 
Setting 

Locate spikes 
using: 

Choose how spikes are searched for in the signal.  
Mean + Stddev—uses fixed level peak detection with a level that is 
computed from the mean value plus a configurable number of standard 
deviations of the data.  
Amplitude/Half-width Discriminator—allows for basic isolation of spike 
shapes that have peak voltages within a configurable range and spike half-
widths within a configurable range; uses the amplitude of the spike as well 
as the width of the spike to determine what constitutes a valid spike event. 
Half-width For a given spike, the discriminator searches from the 

maximum value of the spike to both the left and right of the 
maximum for the sample positions where the value has 
dropped below 50% of the maximum. The time interval 
between these sample positions is defined as the estimate of 
the half width. The acquisition sampling rate can be increased 
to improve accuracy of the spike half width estimates as 
neuron firing events involve high frequency components. 

 
Each time the discriminator is run, the user must input the amplitude low 
and high values as well as the minimum and maximum spike width. The 
discriminator searches for spikes in a signal x as follows: 
 

1. Performs regular peak detection on x using a fixed threshold alow. 
This locates the local maxima occurring after each threshold crossing 
of the low amplitude area. This results in a sequence p of potential 
spike locations. 

 
2. For each potential spike location p, computes the half-width time 

interval. 

 
 where  t50r is the first time > p such that  

   t50l  is the first time < p such that 
  

Accepts the spike for each potential spike location p as a valid spike s if, 
where a is amplitude and t is time window: 

 

 
 
For each valid spike location s, positions the spike episode 
 
   start output at s+offset 
  end output at s+offset+width 
 
The spike discriminator generates output only for spikes that fall within the 

bounds of the amplitude and offset windows. If a spike 
candidate falls outside the windows, no output is generated. 

Mean + 
Stddev 

Spike stddv 
amplitude 
multiplier: 

Spikes are located in the signal by looking for locations where the signal 
deviates from its baseline by a certain number of standard deviations. This 
multiplier is set in this preference. 

4 standard 
deviations 
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Preference Description Default 
Setting 

Default Episode 
Width 

The first time that any of the spike detection is run on a graph, the time 
width of each fixed width episode must be specified. This preference 
provides the default value that is seeded in the dialog. 
The episode width for an individual graph does not need to match this 
default. 

10 
milliseconds 

Default Episode 
Offset 

Each fixed width episode is located around one of the spikes in the signal. 
The offset allows for the episode to begin before (or after) the spike 
threshold crossing so the leading edge of the spike can be captured. 
Negative numbers indicate episodes are to start before the spike threshold 
crossing, positive numbers indicate episodes that start after. 

-2 
milliseconds 

Default Number of 
Spike Classes 

The Classify Spikes script requires the user to input the number of classes 
into which the spikes will be partitioned. This preference allows the default 
number to be modified. 
The number of classes that wind up being used does not need to match this 
default. 2 

 
Noldus Format 
Supports import and export of files in Noldus Observer format. Noldus is a popular Human Behavioral analysis 
software package and the AcqKnowledge Noldus feature allows behavioral markers to be imported from Noldus into 
AcqKnowledge and AcqKnowledge marker information to be exported into Noldus. The following options are 
available: 

Export Events to Noldus XT 

 
AcqKnowledge events can be exported to Noldus by “all types” or based upon selective criteria. 

Import Markers from Noldus XT 

The Import markers feature will read the Noldus file data and define the events in the active AcqKnowledge graph. 
For each range of behavior, a pair of global markers will be added with labels correlating to the behavior type as well 
as the start of and end of the behavior.  

 Watch the AcqKnowledge Noldus Observer import and export video tutorial for a detailed demonstration of 
this feature. 

http://www.biopac.com/video/?video_category=data-integration&v=noldus-observer-xt-importexport-in-acqknowledge�
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Principal Component Denoising 

 
Removes noise from certain types of signals. For principal component denoising to be effective, more than two 
signals should be used as sources and all source channels must have identical waveform sampling rates. PCA 
denoising is most effective on signals that are known to contain a high degree of similarity, such as multiple ECG 
leads or multiple EEG leads. PCA denoising should not be used on signals of different types or units as all of the 
principal components may be needed to fully capture the differences in the signals. 
 To determine if PCA denoising will be effective on a particular set of data or to compute a appropriate 

variance percentage for denoising, examine the principal components directly with “Transform > Principal 
Component Analysis” before selecting this option. 

Given a set of signals, a principal component analysis is performed. The strengths of the components are then 
analyzed, and the original signals are reconstructed from a subset of the principal components that capture a 
certain percentage of the total variance of the signals. This essentially eliminates one or more of the higher-order 
principal components. For certain types of signals, these principal components are the ones that model the noise 
inherent in the signals. 
1. Check the “Denoise” column for the channels to be denoised. 
2. Enter the overall percentage of the variance. 
3. After the percentage is entered, the denoising process will begin. 

 
Remove Mean 

Available in AcqKnowledge 4.1 and above—Remove Mean allows for mean subtraction to be performed for the 
selected area (or entire wave if no data is selected). It will result in the mean value being the new zero value for 
the waveform. 
 

Remove Trend 

    
Available in AcqKnowledge 4.1 (and 4.0 Windows or 3.9 Mac)—Remove Trend helps to remove baseline drift or 
other linear trends from data. This tool makes it easier to apply trend removal to only specific segments of a 
waveform. Given a selected segment of data, or an entire waveform, it computes the trend between the two 
endpoints (similar to the Slope measurement) and then removes this trend from the selected area such that the 
endpoints of the selection lie at the same voltage. 

Linear Regression 

Use linear regression to estimate the trend to be removed from the waveform. 
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Slope between endpoints 

 Left keeps the starting point of the selection fixed at the same voltage. The software adjusts the data from 
left to right such that the right endpoint is aligned with the initial starting voltage. 

 Right keeps the ending point of the selection fixed at the same voltage. The software adjusts the data 
from right to left such that the left endpoint is aligned with the initial ending voltage. 

Respiration 

 
IMPORTANT—Respiration analysis assumes a bidirectional airflow signal that records both inhale and 
exhale. Unidirectional respiration signals cannot be analyzed at this time. 
The respiration analysis package helps to analyze respiration- and airflow-related data. Other tools exist for 
respiration related analysis including AcqKnowledge transformations and the Respiratory Sinus Arrhythmia 
analysis in the Hemodynamics analysis package. 

Compliance and Resistance 
Compliance and Resistance analysis can be used to extract pulmonary resistance and pulmonary compliance in 
addition to basic airflow measures. This analysis requires an airflow signal and a pressure signal. The analysis 
will extract all of the measures of the Pulmonary Airflow analysis for the airflow signal. It also will locate apnea 
periods after exhalation using the same user-configurable threshold method as the Pulmonary Airflow analysis. 
IMPORTANT— The flow signal must be recorded correctly for Compliance and Resistance analysis to 
work. Compliance and Resistance analysis assumes positive flow indicates inhalation and negative flow indicates 
exhalation (the flow conventions of the recommended connections for a BIOPAC TSD107 pneumotach or a 
TSD117 airflow transducer). 
• If the flow signal was recorded with exhalation positive instead of inhalation positive,  

multiply the flow signal by -1 to invert the signal. 

 
Pulmonary resistance is computed using the isovolumetric method. On both sides of the tidal volume peak for a 
breath, the position where the volume reaches a user-specified percentage of the tidal volume is located. The 
pulmonary resistance is defined as the difference in pressure divided by the difference in flow at these two 
isovolumetric positions. Due to the discrete nature of sampled data, these points may not be exactly equal in 
volume. To improve the accuracy of the isovolumetric method, increase the sampling rate used to acquire data. 
Dynamic pulmonary compliance is extracted on a breath-by-breath basis by dividing the tidal volume by the 
change in pressure between the exhale start and inhale start locations of the breath. 
Individual breaths are defined as the period between consecutive Inhale Start events. Airflow units are assumed to 
be the standard liters/sec and pressure units mmHg. For each breath period, the analysis will define the following 
events: 
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• Inhale Start event on flow signal at start of inhale 
• Exhale Start event on flow signal at start of exhale 
• Apnea Start event on flow signal at beginning of apnea period (if present) 
• Recovery events on volume signal at isovolumetric positions to left and right of tidal volume peak 

If Inhale Start and Exhale Start events are already present on the flow signal at the start of analysis, those events 
will be used to define the breath periods. Apnea Start and Recovery events will always be regenerated by the 
analysis. 
The analysis will extract the following measures from the data: 

 
Name Abbrev. Description Units 

Cycle  Index of the breath in the data, beginning at 1.  
Time  Starting time of the inhale of the breath. seconds 

Peak Inspiratory 
Flow 

PIF Maximum absolute flow occurring during the inhale portion of 
the breath. 

liters/sec 

Peak Expiratory 
Flow 

PEF Maximum absolute flow occurring during the exhale portion of 
the breath. 

liters/sec 

Tidal volume TV Total volume of air inhaled during the breath. liters 
Minute volume MV Volume of air that would be inspired during a minute given the 

tidal volume and breathing rate of this breath. 

TV * BPM 

liters/ 
minute 

Breaths per minute BPM Breathing rate. 

60
TT  

BPM 

Inspiration time IT Time interval between the start of inhale and the start of exhale. seconds 

Exhalation time ET Time interval between the start of exhale and either: 

 start of apnea (if apnea present) 

 start of subsequent breath (if no apnea present) 

seconds 

Total breath time TT Time interval between the start of inhale and the start of inhale 
of the following breath. This is the sum of the inhalation time, 
exhalation time, and apnea time. 

seconds 

Apnea time AT Time after end of exhalation where the airflow signal remained 
within the apnea threshold defined at the start of the analysis. 

seconds 

Pulmonary 
resistance 

RES Change in pressure divided by change in flow at the isometric 
volume locations: 

 

mmHg/ 
(liters/ 
sec) 

Pulmonary 
compliance 

Cdyn Tidal volume divided by the change in pressure between exhale 
and inhale locations in the breath: 

 

liters/ 
mmHg 

 
If text output is being generated, an additional row will be added containing the average values of the measures. 
Time and count are not output as waveforms in the graph since they can be found in the horizontal axis. 
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Penh Analysis 

Penh Analysis script assumes standard recording methodology for a full body plethysmograph. Positive flow is 
treated as exhalation and negative flow is treated as inhalation. 

 
Penh Analysis extracts measures from data recorded in a full body plethysmograph. It operates on a single 
channel of data recorded from an airflow transducer connected to the plethysmograph. The analysis takes a single 
parameter: the Rt percentage. This percentage is used to locate the plateau, or “pause,” in the airflow signal. The 
pause begins at the time when the Rt percentage of the exhalation volume has been reached. The Rt percentage 
may be adjusted by the user and is set to a default of 65%. This analysis will place Inhale Start and Exhale Start 
events on the airflow signal. If these events are already present when the analysis starts, the user-defined inhale 
and exhale events will be used instead. This allows for the analysis to be repeated after manual inspection and 
correction of inhale and exhale locations and allows for different methods to be used to define the breathing 
boundaries. 
AcqKnowledge 4.4.1 and higher also includes the following Penh Analysis options for enhancing data accuracy: 
Flow threshold – Using this setting allows breath detection to occur only when a subject’s inspiratory flow 
exceeds a user-defined setting in units of liters per second. For example, if the threshold is set to 1.5 L/sec, the 
inspiratory flow must exceed 1.5 L/sec for each valid breath. If the setting is left at 0, all breath activity will be 
included in the output. 
Breathing rate artifact rejection – Using this option will discard any respiration cycles that fall outside the 
boundaries of a user-defined minimum and maximum respiration rate. This is useful for eliminating unwanted 
signals resulting from small zero crossing spikes or other high frequency noise in the breath signal. This option is 
enabled by default and set to the average range of a mouse breathing rate. 
Show analyzed area waveform – this option adds a new waveform to the graph indicating the time areas 
included in the analysis output. This analysis waveform can be useful for visually assessing the effectiveness of 
modifying the artifact rejection settings. 
Penh analysis will place Recovery events on the airflow channel at the time positions where the corresponding 
percentage of the volume has been exhaled. The percentage used for the analysis is displayed in the label of the 
Recovery events. 
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For each exhalation period, the Penh Analysis will extract the following: 
 

Name Abbrev. Description Units 
Cycle  Index of the exhalation cycle in the data, beginning 

at 1. 
 

Time  Starting time of the exhale for the cycle. 

This is the location of the Exhale Start event. 

Seconds 

Peak inspiratory 
flow 

PIF Maximum absolute airflow occurring in the 
inspiration cycle immediately preceding the 
exhalation cycle. 

This measure is recorded as an interval, so its value 
is always positive. 

Airflow 
channel units 

Peak expiratory 
flow 

PEF Maximum airflow during the exhalation cycle being 
examined. 

Airflow 
channel units 

Exhalation time Te Total time elapsed between the start of the 
exhalation cycle and the end. 

This is the time interval between the Exhale Start 
and following Inhale Start events. 

Seconds 

Relaxation time 
interval 

Rt Time required for the subject to exhale the specified 
percentage of the total exhaled air. 

This is the time interval between the Exhale Start 
and the subsequent Recovery event. 

Seconds 

Pause  Numerical factor describing the characteristics of 
the plateau at the end of the expiration cycle. 
Computed using the formula: 

Te
Rt
− 1  

 

Enhanced pause Penh Pause scaled to be relative to the strength of the 
inhale and exhale.  This helps take breathing 
variability into account.  Computed using the 
following formula: 

 

 

 
The Penh analysis excludes the following exhale cycles from the analysis: 

• Exhale cycles that do not have a preceding inhale (may occur for partial cycles at the start of the data 
recording). 

• Exhale cycles that do not have a corresponding recovery time (often occurs during apnea). 
• Cycles that fall outside the boundaries of the selected flow threshold and artifact rejection parameters. 

(AcqKnowledge 4.4.1 and higher) 
In addition, during periods of apnea, the analysis may produce invalid results, such as zero width recovery times. 
These results may be excluded from the analysis by either using waveform editing to remove apnea periods, 
discarding all events during apnea periods and rerunning the analysis, or deleting the corresponding rows from the 
Excel output. 
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Pulmonary Airflow  

 
The Pulmonary Airflow analysis follows the flow conventions of the recommended BIOPAC connections for a 
TSD107 pneumotach or a TSD117 airflow transducer. Positive flow is assumed to indicate inhalation; negative 
flow is assumed to indicate exhalation. 
The Pulmonary Airflow analysis extracts basic parameters from a calibrated airflow signal, such as would be 
recorded using a pneumotach or airflow transducer. In addition to inspiration and expiration, Pulmonary Airflow 
also can be used to examine apnea. Apnea is defined in this analysis as pauses in breathing that occur after an 
exhalation. 
When performing the analysis, an airflow signal ƒ is chosen. An apnea threshold  fa is also entered. Inhalation is 

defined to begin at the point where . Exhalation is defined to begin at the point where . Apnea is 
defined to be the period between exhalation and inhalation where the flow lies within the apnea threshold: 

. At least two consecutive samples must occur within the apnea threshold for a period of apnea to be 
defined. This allows for valid transitions from exhalation to inhalation to occur even if one of the samples in the 
transition happens to fall within the apnea threshold due to sampling. 
The Pulmonary Airflow analysis will generate a tidal volume waveform if it is not present in the graph. It also 
will add Inspire Start and Expire Start events on the airflow signal if they are not present. New Apnea Start events 
will be defined each time the analysis is performed. 
Individual breaths are defined as the period between consecutive Inhale Start events. Airflow units are assumed to 
be the standard liters/sec.  
For each breath period, the analysis will extract the following: 

 
Name Abbrev Description Units 

Cycle  Index of the breath in the data, beginning at 1.  
Time  Starting time of the inhale of the breath. seconds 

Peak Inspiratory Flow PIF Maximum absolute flow occurring during the 
inhale portion of the breath. 

liters / sec 

Peak Expiratory Flow PEF Maximum absolute flow occurring during the 
exhale portion of the breath. 

liters / sec 

Tidal volume TV Total volume of air inhaled during the breath. liters 
Minute volume MV Volume of air that would be inspired during a 

minute given the tidal volume and breathing rate 
of this breath. 
TV∗ BPM  

liters / minute 

Breaths per minute BPM Breathing rate for the breath. 

60
TT  

BPM 
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Name Abbrev Description Units 
Inspiration time IT Time interval between the start of inhale and the 

start of exhale in the breath. 
seconds 

Exhalation time ET Time interval between the start of exhale and 
either: 

 start of apnea (if apnea present) 

 start of subsequent breath (if no apnea 
present) 

seconds 

Total breath time TT Time interval between the start of inhale and the 
start of inhale of the following breath. This is 
the sum of the inhalation time, exhalation time, 
and apnea time. 

seconds 

Apnea time AT Time after end of exhalation where the airflow 
signal remained within the apnea threshold 
defined at the start of the analysis. 

seconds 

If text output is being generated, an additional row will be added containing the average values of the measures. 
Time and count are not output as waveforms in the graph as they can be found from the horizontal axis. 

Preferences 

  
 
Spectral Subtraction 
Spectral subtraction is a denoising technique that operates on data projected into the frequency domain. It is 
frequently used in speech analysis denoising applications. Spectral subtraction examines a reference noise signal and 
performs a Fourier transform to get the noise frequency distribution. To denoise a signal, the Fourier transform of the 
signal is performed. The noise estimate frequency distribution is then subtracted from the source signal. The resulting 
processed spectrum with the noise frequencies removed is then reconstructed into a time domain signal using the 
inverse Fourier transform. 
Spectral subtraction performs noise removal on the entire channel in a single Fourier transformation, which allows for 
denoising where the noise is stationary; there is no provision for sliding window spectral subtraction at this time. 
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The spectral subtraction is performed using a formula with two adjustable parameters. Given a frequency spectrum 
Fnoise and a mixed signal Fmix, the denoised frequency spectrum is computed using the following formula: 

 
where 

Alpha is the “scaling factor” and can be used to adjust the strength of the noise estimate. 
Gamma (γ) is the “power factor” and can be used to vary how the noise is removed. 

γ = 1 allows for pure subtraction 
γ = 2 allows for Euclidean distance formulas 
and so on 

Fdenoise that is less than zero is discarded and replaced by zero to maintain a valid set of Fourier coefficients for the 
reconstruction. 
When spectral subtraction is being used in practice, the noise signal may not always match the length of the signals to 
be denoised. To define the subtraction formula, the spectrum of the noise must have the same number of points as the 
spectrum to be denoised. If there is a length mismatch, the noise spectrum is resampled automatically to match the 
length of the spectrum to be denoised. Cubic spline interpolation is used during the resampling to provide a better 
estimate of the overall noise spectrum. 
 
Stim-Response 

 
The Stim-Response analysis package can aid in analysis of stimulus-response studies. It allows for measurements to 
be extracted in tabular format for multiple stimulus classes. Stim-response configuration enhancements in 
AcqKnowledge 4.1 add the following functionality:  
 Measurement configuration is preserved across launches of the application. 
 Measurement presets may be accessed directly from the specialized analysis routine. 
 Additional checking for invalid channels and measurement expressions that cannot be applied to the source data  
The Event-related EDA Analysis routine uses the stimulus events to categorize specific and non specific responses. 
Responses are matched to the appropriate stimulus events using a user defined time window. See the Electrodermal 
Activity EDA Event-related analysis section for further information. 

Note: Excel spreadsheet generation is supported in AcqKnowledge 4.0 Windows 
 or AcqKnowledge 3.9.1 Mac and higher. 
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Digital Input to Stim Events 
Digital Input to stim events identifies and labels stimulus events corresponding to any combination of digital inputs. A 
light bulb icon is placed in the global events bar, the event is labeled with the stimulus event type, and the mouse-over 
tag includes the event time. All event information is accessible and exportable from the Event Palette. 

 
The Digital input to stim events function works with TTL trigger information coming from applications such as E-
Prime®, SuperLab®, DirectRT®, MediaLab®, Inquisit®, and Presentation. It converts TTL data acquired on the 
digital channels of a hardware device into stimulus events. The system also works with analog and calculation channel 
signals coming from switch transducers. Unlike TTL signals, a voltage threshold level is used to determine the 
transition from low to high.  
 This analysis option converts TTL or switch data acquired on hardware 
into stimulus events. Stimulus delivery events are defined in the graph for 
each low to high transition of the digital data, the indications of stimulus 
delivery. The digital channels are interpreted as a binary number. Each 
stimulus event placed into the graph has the corresponding number 
included with its label. This allows further analysis to distinguish between 
different types of stimulus events by using the Cycle Detector’s label 
matching capability. 

   

“Specific channels only” dialog 

 



422 AcqKnowledge 4 Software Guide 

Visit the online support center at www.biopac.com 

  
Digital line decoding can be two byte (using all 16 digital lines) or 
single byte (on either the low eight or high eight digital lines). Big 
endian bit and byte ordering are used, with digital line 0 
representing the least significant bit. 
When the stimulus labels are constructed, all numbers are zero-
prefixed. All stimulus events will have the same number of base-10 
digits with leading zeros, regardless of magnitude. This provides 
each stimulus event type with a unique label that can be used with the Cycle Detector (which uses substring 
matching). 
Some systems that trigger digital lines such as parallel ports may not be able to do so instantaneously; they may 
require a time window before the transition from one state to another is fully complete. A “transition latency” time 
window can be given to the analysis, specified in microseconds, milliseconds, seconds, minutes, hours, or samples. If 
non zero, any transitions that are separated by less than this latency are treated as a single transition and only one 
stimulus event is inserted. The decoded value used for the transition is the maximum value observed during the 
transition latency window. In the following example graph, the three digital TTL inputs correspond to one event, as 
marked by the red icon in the global events bar. A transition latency of .5 seconds will consider all three as part of the 
same event since the transitions occur within .5 seconds of each other.  

 
 Watch the AcqKnowledge Digital Input to Stim Events video tutorial for a detailed demonstration of  

this feature. 
Stim-Response Analysis 
Stim-Response Analysis allows for extraction of measurements within fixed width intervals occurring at Stimulus 
Delivery events. Stimulus events must be present to perform this analysis. The Stimulus Delivery events may be 
defined either manually, with the Cycle Detector, or using the Digital Input to Stim Events analysis option. The 
information that can be extracted includes the majority of the measurements available from the graph window 
measurement toolbar, matching the Epoch Analysis options. 
Unlike Epoch Analysis, the Stim-Response Analysis splits the analysis based upon the event labels. Stimulus Delivery 
events with different labels are interpreted as different stimulus types. Analysis results for each individual stimulus 
type are summarized in separate tables. Each independent text table has its own average of the measurements over that 
stimulus type. 
Additional options are available for positioning the fixed width interval where measurements should be made: 

• At each stimulus event – The measurement interval is aligned so the start of the measurement matches the time of 
the Stimulus Delivery event. 

• At fixed interval offset before or after stimulus – The measurement interval begins a fixed amount of time either 
before (for pre-stim studies) or after the time of the Stimulus Delivery event. This allows measurements to be 
made at a time relative to each stimulus onset and may be useful for measurements focusing on a specific time 
range (e.g. P300). 

http://www.biopac.com/video/?video_category=automated-analysis-demos&v=digital-input-to-stim-events�
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• At matching response event – This option assumes that a second set of Response events have been defined for 
each stimulus either manually or using the Cycle Detector. Each Stimulus Delivery event is paired with the 
closest Response event occurring after it. The fixed width measurement interval is aligned so the start of the 
measurement window is the time of this matching Response event. 

• To use the “at matching response event” window positioning option, Response events must be defined in the 
graph. Response events are in the “Stimulus/Response” event submenu. These events are not defined 
automatically. 

• Response events can be inserted manually into the graph using the Event tool. 
• Response events can be inserted using the event output of a data-driven Cycle Detector analysis. 

Note If EDA/SCR signals are being analyzed in response to stimulus delivery, also examine the “Event-related EDA 
Analysis” transformation located under Analysis > Electrodermal Activity. 

 Watch the AcqKnowledge Stim-Response Analysis video tutorial for a detailed demonstration of this feature. 
Waterfall Plot 

  

 
Assists in configuring the Peak Detector for 3D surface generation. These surfaces showing cycle-by-cycle data of 
the graph are commonly known as waterfall plots. Cycles are located in the graph using the same sequence of 
steps as the Ensemble Average transformation script. Instead of generating the averaged graph, however, a 
number of 3D surfaces are generated. One surface is generated for each channel that is selected by the user. 

Wavelet Denoising 

 

Sample output  
Wavelet Denoising applied to heart 
sounds data may help clarify S1 and 
S2, as shown: 

http://www.biopac.com/video/?video_category=automated-analysis-demos&v=stim-response-analysis�
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Wavelet Denoising uses the forward and reverse wavelet analysis operations to project source data into the 
wavelet domain, modify the wavelet coefficients (called “shrinking” the coefficients), and then reconstruct the 
data from the modified coefficients. Wavelet Denoising allows for noise to be removed from a signal while 
minimizing effects on portions of the signal that strongly adhere to a wavelet’s shape. 
To perform wavelet denoising: 
1. Choose the wavelet type to use for the denoising (Biorthogonal 4.4, Symlet 4, Coiflet 6, or Daubechies 8). 

Certain signals may work best with different wavelet types. 
2. Enter the number of iterations to use in the wavelet decomposition. 

Different numbers of iterations will have different effects on the results. 
3. Choose which type of thresholding should be used to shrink the wavelet coefficients. 
 Hard thresholding replaces coefficients below the threshold with zero while leaving all other coefficients 

unmodified. 
 Soft thresholding zeroes out coefficients below the threshold and subtracts the threshold for coefficients that 

are above it. 
Soft thresholding may be useful for reducing edge effects, but hard thresholding will affect amplitudes less. 

4. Choose the threshold level to use for shrinkage. 
 Fixed threshold for all levels. If you choose a fixed threshold, an additional window will appear into which 

you can type your threshold. 
 Adaptive threshold level based on the number of coefficients in the DWT iteration (a VIS shrink 

procedure). 
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ECG Analysis Algorithm References 
AcqKnowledge 4 software implements the open source ecgpuwave ECG boundary location software and the open 
source OSEA QRS detector and beat classification library for ECG analysis. 
Automated ECG Waveform Boundary Location 
 ecgpuwave ECG boundary location software 

AcqKnowledge 4 software incorporates the ecgpuwave ECG boundary location software. Ecgpuwave is an 
implementation of a waveform boundary detection algorithm primarily developed by Pablo Laguna at the 
University of Zaragoza in Spain. This algorithm incorporates a variant of the Tompkins QRS detector, but 
contains additional rules that allow it to automatically extract the following characteristics of an ECG signal 
on a cycle by cycle basis: onset of P, P peak, end of P, onset of QRS, peak of QRS, end of QRS, onset of T, 
peak of T, and end of T. 
The algorithm is tuned to human ECGs through comparison with manual classification. Particularly, it seems 
to be within the standard deviation of human examiners for the onset and end of T waves, a particularly 
difficult feature to extract from an ECG complex. It also has the ability to take multiple ECG leads into 
account to reduce errors and misclassifications and appears to function for one to twelve lead ECGs. The 
algorithm is well documented in a number of papers. This algorithm development was sponsored by several 
government agencies including CICYT in Spain and the NIH. 
The ecgpuwave tool is distributed from the PhysioNet NIH servers (http://www.physionet.org). This is a tool 
written in Fortran that will read WFDB formatted files. It will then output a series of annotations in WFDB 
format indicating the locations of the various ECG complexes within each cycle. It also depends on another 
tool, sortann (available from PhysioNet), to perform post-processing. This software reads and writes 
PhysioBank formatted files. This tool is only available on OS X. 
AcqKnowledge can automate the process of running ecgpuwave on source data and import its output back 
into AcqKnowledge. To run ecgpuwave on an ECG signal from within AcqKnowledge, select the ECG 
channel as the active channel and then choose “Analysis > Locate Human ECG Complex Boundaries”*. 
AcqKnowledge will execute ecgpuwave on that signal and read in its waveform boundary location output, 
placing events on the channel. You will only be able to see this output if you have events shown. 
Alternatively, you can save your file to PhysioBank format, run ecgpuwave manually from a Terminal, save 
the annotations to “atruth” and then reopen that PhysioBank file to see the ecgpuwave results; this is the same 
process that AcqKnowledge performs. 
Source code for ecgpuwave detector is released under a GPL license and can be found on the AcqKnowledge 
CD. 
 
 
*To apply the proper algorithm for animal subjects, choose “Analysis > Locate Animal ECG Complex 
Boundaries.” 

http://www.physionet.org/�
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OSEA QRS Detector 
 OSEA QRS detector and beat classification library 

Since the release of software version 3.9,  AcqKnowledge incorporates the open source OSEA QRS detector 
and beat classification library. 
The OSEA library is a set of routines provided by EP Limited (http://www.eplimited.com). This C++ based 
software library provides robust QRS complex detection and rudimentary beat classification. This library is 
well documented and tested. The QRS detector uses a standard Tompkins-based filtering and derivative 
detection algorithm and has been in development since about 1985; the beat classifier development began in 
1997. This algorithm development is sponsored by the NIH. 
This algorithm is fairly robust against arrhythmias, baseline drifts, discontinuities, and other artifacts in the 
ECG signal. It achieves a 90% success rate on identifying QRS complexes on sample arrhythmia databases. 
The algorithm is tuned to human ECGs. 
The QRS detector is optimized for 200 Hz sampled data. If the sampling rate is lower or higher, data will be 
internally resampled to 200 Hz before processing. The sampling rate difference may result in slightly different 
placement of beat events for different sampling rates. 
QRS detection can be performed by selecting the desired channel of ECG data and choosing Transform > 
Specialized Analysis > Detect and classify beats. AcqKnowledge will execute the OSEA beat detector on the 
source data and output a sequence of events on that channel of ECG data. You will only be able to see this 
output if you have events shown. 
Source code for the QRS detector is released under an LGPL license and can be found on the AcqKnowledge 
CD. 

 
Open Source Licensing 

The ecgpuwave and OSEA algorithms are available as open source, which means that their source code is 
publicly available. The source code can only be used, however, under conditions of their licenses. 
 ecgpuwave is under the GPL license 
 OSEA is under the LGPL license 

For the full text of both licenses, visit the Free Software Foundation (http://www.fsf.org). 
 

http://www.eplimited.com/�
http://www.fsf.org/�
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Chapter 18 Display Menu Commands 
Overview 
The Display menu includes a number of features that control how the waveforms appear on the screen and how much 
data is displayed at a time.  

  
Display menu and Show sub-menu 

Although most of these these options change the appearance of the data, they do not modify the data itself.  
See the following shortcut options for Display menu commands: 
 Toolbar shortcuts, page 57 
 Context-sensitive shortcuts—page 69 
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Tile Waveforms 
Tiling is an operation performed on all waveforms to visually separate them on the screen. Tile Waveforms adjusts 
the vertical offset to center waveforms in the display; if there are multiple waveforms displayed in chart mode, the 
waveforms will be centered in their “tracks.” Tiling does not adjust the scale of the waveforms; it only affects the 
midpoints of the visible portion of the waveform. Tiling does not affect the vertical scale factor previously set for each 
channel (whereas Autoscale may affect the vertical scale factor as well as the offset). 
In Scope mode:  

• Tiling staggers the midpoint of the channels to visually separate them on the screen while 
maintaining their scales. 

• Waveforms are spaced evenly along the vertical axis of the screen, and each waveform is centered 
vertically in its division. 

To apply tiling only to the selected waveform, hold down the CTRL key on Windows or the Option key on Mac OS X 
before selecting Tile Waveforms.  
When grids are locked, tiling will retain the appropriate heights and percentages. 
When grids are unlocked, the scale may be slightly larger in order to optimize the tick marks displayed on the vertical 
axis. 

  
Before Chart mode tiling After Chart mode Tiling 

  
Before Scope mode tiling After Scope mode Tiling (red lines for illustration only)  

Note that the waveforms are centered relative to the horizontal divisions of the plotting area; the range and midpoint 
of the second waveform (blue square wave) are indicated in the figure above. 
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Autoscale Waveforms 
The primary use of Autoscale is to make all of the data of 
the channel within the current time range visible on the 
screen. 
When Autoscale Waveforms is selected, AcqKnowledge 
determines what the “best fit” is for each displayed 
waveform. The percentages and midpoints are identical 
whether grids are locked or unlocked. 

 

The software adjusts the vertical offset so that each channel is centered in the window (or within the channel track in 
chart mode) and adjusts the units per division on the vertical axis so that the waveform fills approximately two-thirds 
of the available area. In chart mode, the waveforms are autoscaled to fit their sections. In scope mode, the screen is 
evenly divided into horizontal “bands” and each waveform is scaled to fit the division without overlapping. 
 The autoscaling algorithm for Chart mode and X/Y mode is: 

1. Find maximum value of the channel in the time area, max. 
2. Find minimum value of the channel in the time area, min. 
3. If grids are locked, adjust scale such that max-min occupies 75% of the channel's track in Chart mode, or 75% 

of the entire plotting area X/Y mode. 
4. Adjust the midpoint so (max-min)/2 is at the vertical center of the channel's track in Chart mode, or vertical 

center of the entire plotting area in Scope and X/Y modes. 

  
Before autoscaling LVP channel After autoscaling LVP (red lines for illustration only) 

 The autoscaling algorithm for Scope mode is: 
1. Divide the plot height into m equal sections of height h each. 
2. Assign each visible channel to one of these plot sections. 
3. If grids are locked, Scale the waveform such that the range between the max and min values will occupy 75% 

of h. 
4. Place the midpoint between the max and min at the center of the waveform's section. 

In scope mode, the screen is evenly divided into horizontal “bands” and each waveform is scaled to fit the 
division without overlapping. 
Note: Autoscaling a single channel in Scope mode results in that channel occupying 1 / 
(num_visible_channels) of the overall waveform plotting area. It will be placed in the region of the graph that 
corresponds to its position in Chart mode.  
See following page for examples of autoscaling in Chart and Scope modes. 
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Autoscale Single Waveform 
Use this option to perform the above autoscaling operations on a single selected channel rather than on the entire 
graph. 
Overlap Waveforms 
Overlapping waveforms places all of the waveforms at the same scale and midpoint so that the plotting location of a 
specific voltage on screen is at the same spot for every channel. Overlapping is useful for examining closely 
associated waveforms, such as the calculated diastolic, systolic and mean calculation channels “overlapped” with the 
raw blood pressure waveform from a continuous blood pressure signal. 
In scope mode, when Overlap Waveforms is selected, the waveforms are “overlapped” into one screen. All of the 
currently displayed waveforms are arranged in the graph window with the same vertical scale and offset so all the 
displayed waveforms will fit on the graph; their magnitude reflects their size relative to the other waveforms. The 
overall chosen scale for all the displayed waveforms will be a function of the pk-pk value of the combined waves. 

  
Before Overlapping in Scope mode After Overlapping in Scope (red lines for illustration only) 
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Compare Waveforms 
Compare Waveforms displays all of the channels with the same amplitude scale. Compare Waveforms automatically 
sets the vertical scale to be the same for all channels and adjusts each channel offset so that all displayed waves are 
centered in the display. The scale for all the displayed channels is determined by the channel with the largest pk-pk 
range in the display interval. Compare Waveforms is useful for gauging the relative amplitudes of a number of 
channels by placing them all on the same amplitude scale and discounting the effect of waveform offset (or baseline). 
 In Chart mode, Compare Waveforms functions on each channel in its track. 

  
 In Scope mode, the channel scaling is similar but disperses the channels through the plot area similar to 

tiling. For a graph with m channels being plotted: 

  
Autoscale Horizontal 
The Autoscale Horizontal command is a convenient way to display the entire data file (in terms of duration) on the 
screen. When this is selected, the display will be adjusted so that the duration of the entire waveform fits in the graph 
window. For long waveforms, this can take some time to redraw.  
An Autoscale Horizontal function cannot be reversed with Edit > Undo. To revert to the previous display settings, use 
the Display > Zoom back command. 
Show All Data 
The Show All Data command enhances the view by autoscaling first horizontally, then applies an “autoscale all 
waveforms” operation. This enables all data vertical and horizontal data in the entire graph to be displayed for easy 
viewing. 
Show Default Scales 
This option will resets a graph’s vertical and horizontal scaling parameters to the default settings used when the graph 
was first opened. 
Zoom Back / Forward 
Zoom functions can affect the horizontal scale, the vertical scale, or both. Zoom restoration is functional for the Zoom 
tool, Autoscaling, and the Tile, Overlap, and Compare Waveform options. Zoom scales are stored until another zoom 
function is performed. Multiple levels of Zoom are supported. 

 Zoom Back will restore settings one level at a time; This selection can be used to restore the original 
zoom scales. Essentially, Zoom back acts as an “undo” command for the zoom forward command and any 
other function that changes the amount of data displayed (either in terms of time or amplitude) 

 Zoom Forward will redo a zoom function after it has been undone; you can repeat this selection to restore 
the latest zoom scales. 

Zoom functions will work without limitation, until another Zoom is performed. 
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Reset Chart Display 
The Reset Chart Display option redistributes the chart displays evenly after the boundaries have been changed so that 
each channel’s vertical size is the same. This function, which only works in Chart Mode, can be useful for expanding 
a display region for analysis and then returning to the original display. 

  
Before Reset Chart Display …and after 

Reset Grid 
To return to the original grid, choose “Display > Reset Grid.” This will reconstruct the default, unlocked grid of four 
divisions per screen with solid light gray grid lines. 
 
Adjust Grid Spacing 
To modify the horizontal and/or vertical grid spacing, choose “Display > Adjust Grid Spacing.” This will generate a 
dialog for you to modify the locked axes of the selected waveform. See page 79  for details. 
 
Set Wave Positions...  
By default, channels are arranged on the screen based on their channel numbers, with the lower number channels 
being displayed at the top of the screen. The Set Wave Positions option allows waveforms to be placed in a user 
defined order. 
 In chart mode this will result in vertical ordering of the individual waveforms. 
 In scope mode this will result in vertical ordering of the individual waveforms after a tiling or autoscaling 

operation. 
It’s also possible to set any waveform to ignore the autoscaling and tiling functions. This is useful for selectively 
applying autoscaling to certain graph channels of interest while omitting others. 
The waveform positioning function is selected through the Set Wave Position in the Display menu. The following 
dialog will then appear, with a scrolling list of all stored channels:  
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If more channels are present than those displayed, scroll through the list by clicking on the vertical scroll bar at the 
right. The list will scroll when moving past the top or bottom when clicking and dragging the waveform positions. 
The “Tile” checkbox to the left of each channel enables tiling and autoscaling for each channel when checked. Click 
the checkbox to toggle the enable.  
The on-screen position of the waveforms is the same as the ordering shown in the above dialog (from top to bottom). 
The waveforms can be repositioned by reordering the channel labels as they appear in this dialog. To change the order 
of any waveform, select the channel label (e.g., CH1, ECG) and then click the Move Down or Move Up button. 
Repeat this operation until the waveforms are in the desired order. 
 Click OK to apply the selected order to the display screen. 
 Click Cancel to revert all waveform positions to those set before the dialog was opened. 

Set Channel Visibility 
Set Channel Visiblity offers an alternate means of showing and 
hiding channels. Simply check or uncheck the channel “Show” 
checkboxes to show or hide them. All channels can be shown or 
hidden simultaneously by holding down the Alt key while clicking 
the left mouse button. See also: Show/Hide Channels on page 89. 

Wave Color 
Select Display > Wave Color and then set the desired color of any 
waveform. In scope mode, the vertical scale, channel text, channel 
units and measurement popup menus take on the same color as the 
selected waveform. When adding new waveforms, AcqKnowledge 
assigns waveform colors in the following order: black, red, green, 
blue, magenta, burgundy, and custom. 

  
Or, click the right mouse button to bring up a menu, select Color, and then select the desired waveform color from the 
color palette menu.  

Active Slice Color 

 
To change the Active Slice Color in Stacked Plot mode (see page 40), use Display > Show > Active Slice and then 
select Drawing options. 
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Horizontal Axis 
Horizontal Axis generates the Horizontal Scaling dialog. Set the axis in 
terms of time, frequency, or arbitrary units, and set the horizontal sample 
interval (the amount of time between two sample points) and the first 
sample (sample offset).  
Time domain scaling has two options to store and display data: 

• (ss.sss) —absolute seconds; the time scale for an event occurring 30 
seconds into the record would be 30.00 seconds 

• (HH:MM:SS) —hours:minutes:seconds; the time scale for the same event would be 00:00:30. 
Set the Time Unit precision via Display > Show > Selection palette, then press Enter (return) to accept changes. 

 
The Frequency Units option plots data from a Fourier analysis or other data with a frequency base (rather than a time 
base). This option is only available when frequency units are present in the graph. As with the time options, this 
feature is typically used for importing text files from other applications. For instance, when importing a text file with 
1,000 sample points that covered a frequency range from 0 Hz to 100 Hz, set the interval to 1000 Hz/100 samples, or 
0.1 Hz per sample in the box to the left of the interval text box. Similarly, if the frequency range was 20 Hz to 100 Hz, 
set the offset to 20 Hz. Arbitrary base units can also be attached to the data (rather than a time or frequency base 
When the horizontal axis corresponds to wavelength, and the data consists of 100 samples covering a range from 1 to 
10 Angstroms, the interval should be 0.1 units per sample. 
Arbitrary units are generally useful for changing the time base (or other horizontal scale) of data that has been 
imported into AcqKnowledge as a text file. For instance, to analyze data imported from a text file that contains 30 
seconds of data that was collected at 100 samples per second (100 Hz), the first step would be to open the file 
(following the directions on page 251). 
When arbitrary units are selected, two additional text boxes appear at the bottom of the dialog. The upper Units text 
box is used to provide a name for the horizontal scale units and the lower Units text box is used to provide an 
abbreviated label for the horizontal units. 
By default, AcqKnowledge assumes that the data was collected at 50 Hz, and would therefore plot the data so that a 
60 second record was displayed that appeared to be collected at 50 samples per second. To change this to reflect the 
rate at which data was actually collected, change the sample interval box in the horizontal scaling dialog. When data 
are displayed on a 50 Hz time base, the sample interval will read 0.02 seconds per sample. This means that there is a 
0.02-second “gap” between sample points in the record. To display data at 100 samples per second, change the 
interval to 0.01 seconds per sample. 
To determine the sample interval for other sampling intervals, divide 1 by the rate at which data was sampled (in 
terms of samples per second). Thus, a sampling rate of 0.5 Hz would translate into a sample interval of 2.00 seconds 
between samples, and data collected at 100,000 Hz (100 kHz) would have an interval between sample points of 
0.00001000 seconds. 

TIP:  To confirm that AcqKnowledge is storing data in the same time base it was collected in, 
choose Channel Info from the Display menu. This will generate a dialog that describes 
(among other things) the sampling rate AcqKnowledge uses in analyzing the data. Once 
data has been saved as an AcqKnowledge file, X-axis base information is automatically 
saved along with the data. AcqKnowledge also saves X-axis in Frequency (FFT) or 
Arbitrary (Histogram). 

Show 
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Selecting Display> Show generates a submenu controlling the data display options and other additional information 
appearing in the graph window. To enable an option, select it in the submenu. A checkmark appears next to the 
enabled menu items. The three display modes and the two plotting modes are mutually exclusive, but the remaining 
items can be enabled independently.   
Show Option Shortcut Explanation 

Annotations  Toggle show/hide of text annotations.  

Channel 
Buttons 

 When the Channel Buttons option is selected, the channel boxes appear just above 
and below the graph area. 

 Channel Buttons with Channel 1 selected 
These buttons are useful for selecting channels and “hiding” channels by positioning 
the cursor over the channel box, holding the ALT key on the Windows or the 
Option key on the Mac, and clicking the mouse button. 

Channel Input 
Values 

 When enabled, adds real-time display of channel amplitude values above the graph. 
(“Show textual value display” must be enabled in the Vertical Axis settings.) 

Chart 
 

Activates the Chart display mode (see page 38). 

Display Mode 
Toolbar 

 Activates toolbar shortcuts for Chart, Scope, X/Y, Stacked Plot, Horizontal Split 
View and Data View. 

Dot plot  Dot Plot allows viewing of data in a “dot” format. This is useful for demonstrating 
the concept of discrete digital sampling by dividing the waveform up into data 
points or “dots.” 

Dot size  

 

Dot size is enabled after Dot Plot is selected. 
Dot size specifies how large each dot will be. Each dot 
is measured by the number of monitor pixels it 
occupies. 
Each “dot” corresponds to a sample point. (For 
example, data collected at 100 samples per second 
whould display 100 dots per second.) 

Events  Displays the event marker region at the top of the graph window. See page 216 for 
Events. 

Event Bar  Enables Event Bar display on toolbar. 

Event Pallete  Displays the Event Palette (see page 219 for Event Palette details.) 

Focus Areas  Enables Focus Area display. See page 89 for Focus Areas. 

Focus Areas 
Bar 

 Enables Focus Area Bar display on toolbar. 

Grid 
 

Superimposes a Grid on the graph window (see page 51). To change grid precision, 
use the axis scaling dialog of the horizontal or vertical axis.  

Grid Options  Activates the Grid Options dialog (see page 81 ) 

Hardware  Show/Hide Hardware “Connected to:” dialog in the graph display; includes  
network access. 

Journal   Activates the Journal (see page 53). 

Last Dot Only  Plots only the most recently acquired data point. Only available in X/Y mode. 
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Show Option Shortcut Explanation 
Line Plot Right-click 

menu 
Connects each sample point with a line to create the waveform. Waveforms that are 
displayed in line plot mode match a true analog plot (as closely as possible). This is 
the default display mode for most waveforms, except histogram plots, which are 
displayed in Step Plot mode (see 313). The line options can be changed by clicking 
the right mouse button, which will generate a menu displaying several commonly  
used features. 

Line Thickness  Right-click 
menu 

 

Line thickness is enabled when Line or Step plot are 
enabled. Use to specify the plot thickness in pixels. 
(AcqKnowledge 4.2 and higher) 

 
Sine wave set to thickness of 5 pixels 

Main Toolbar  Controls visibility of Main Toolbar buttons (Grid, Show/Hide, Preferences and 
Customize Toolbar). 

Measurements  Displays the measurement popup menus and windows above the graph window (see 
pages 50 and 91).  

Scaling Toolbar  Controls visibility of Scaling Toolbar shortcut buttons (Autoscale Vertical, 
Autoscale Horizontal, Show All Data, Center Data Vertically, Center Data 
Horizontally). 

Scope 
 

Activates the scope display mode (see page 38). 

Selection 
Palette  

 
Many tools within the AcqKnowledge environment are based around the selection. 
The selected range of data in the graph is used as the source for measurements, 
waveform editing, transformations, and other operations. The Selection Palette is a 
floating dialog that can be used to precisely enter the selection. 

• The Selection Palette can be used to adjust the selection at times when it is 
not possible to use the selection tool in the graph window, such as when 
transformation dialogs are being displayed for the graph. 

• The selection palette offers a way to change the selected area without 
having to cancel the transformation setup and lose any parameters typed in 
the dialog. 

To display the Selection Palette, choose Display > Show > Selection Palette. This 
dialog contains two edit fields that display the location of the left and right edges of 
the selection using the measurement units currently displayed in the horizontal axis. 
As the selection is changed, the new selection boundaries are shown. 
The Selection Palette also can be used to manually type in the edges of the 
selection. Double-click the edges and type in the new horizontal position of the edge 
of the selection. Press “Return” to adjust the selection to that time location and 
update measurements and the visible display on the screen. 
 
For graphs displayed in X/Y mode, the Selection Palette can be used to adjust the 
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X-axis range of data plotted on the screen. Limiting the time range can be useful for 
generating X/Y plots for different intervals of the graph for comparison, such as 
examining PV loops from different time periods of a recorded signal. 
Click the small arrow in the top right of the selection palette for the following 
additional options: 

 
• Mark Selection—Use this option to bracket a selected area with event 

markers. 
• Paste edges in Journal—This option pastes a line of text into the Journal 

that includes the left and right edge measurements of the selection. 
• Create Focus Area—This option turns data highlighted by the selection 

palette into a labeled Focus Area.  
• Time units—Use this submenu to change the time units used in the 

selection palette. The following time units are available: Match units on 
axis; Hours; Minutes; Seconds, Milliseconds, Microseconds and Samples. 
The Time units submenu will be dimmed unless the graph displays 
time/arbitrary measures). 

• Frequency units— Use this submenu to change the frequency units used in 
the selection palette. The following frequency units are available: Match 
horizontal axis, Kilohertz, Hertz, Millihertz and Samples. The frequency 
submenu will be dimmed unless the graph displays frequency-based 
measures.  

Note Changing time/frequency units in the selection palette can be helpful during 
zoom operations when the units displayed in the horizontal axis may not be 
the most convenient for inputting new selection boundaries.  

• Arbitrary Units—Use this submenu to change the arbitrary units used in 
the Selection Palette display (Units or Samples). 

Spectrum 
Analyzer 
Palette 

 Provides a dynamic display of the frequency decomposition of data, in real time or 
post-acquisition. See page 441 for details. 

Timers  Enables display of stopwatch and elapsed timer toolbar. 

Location 
Palette 

 AcqKnowledge 4.4 and higher supports import of GPS location data into 
AcqKnowledge graphs. This is useful for correlating a subject’s geographic location 
with physiological data acquired during extended exercise studies where a subject 
might wear a long-range wireless device, such as BIOPAC’s Mobita and 
BioHarness loggers. The Location palette, like the Selection and Spectrum Analyzer 
palettes, is a floating dialog that can be dragged, resized or repositioned as desired.  
In order for the Location palette to be operational, the subject must first log data 
with a compatible GPS tracking device, such as the BIOPAC GPSTRACK. The 
resulting GPS data can be imported from the tracking device into the 
AcqKnowledge exercise study graph, which populates the Location palette in a 
navigable map format. The resulting map shows the physical location of the subject 
throughout the exercise. 
After Import: 
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• Browsing GPS graph data with the I-beam selection tool will relocate 
the red navigation arrow to the map location occupied by the subject at 
that exact point of the experiment. 

• The map view is zoomable, and any of three different map servers can 
be selected in the preferences. 

 
Location palette showing coordinates, zoom and recenter tools 

To log GPS data: 
1. Attach the GPSTRACK device to the subject and turn on the power. 
2. Run the experiment. (For example, subject walks, runs, or bicycles an 

assigned geographical route during an exercise study where data is being 
acquired into AcqKnowledge via a wireless logger.) 

3. At the conclusion of the experiment, turn off the GPSTRACK and remove it 
from the subject. 

To import GPS data into AcqKnowledge: 
1. With the exercise study graph open in AcqKnowledge, launch the Location 

palette (Display > Show > Location Palette). 
2. Connect the GPSTRACK to the computer’s USB port. 
3. Click the arrow in the upper right corner of the Location palette and choose 

“Import Location Data.” The GPSTRACK used will appear in the “Import 
from:” menu. 

  
4. Click OK to import location data into the graph. The imported location data 

will be saved with the graph. Be sure to select the correct GPS device or file 
format. (AMCO AGL 3080, Columbus GPS, *txt or *.gpx format.) 

Explanation of Options: 
• Import Location Data – Use this option to import logged GPS 

data into AcqKnowledge graph. 
• Erase log after data is imported – If selected, the log file on the 

GPS device will be deleted following import. 
• Export Location Data – Use to export GPS data in graph to a text 

file format. 
• Remove Location Data – Removes all location data from graph. 
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• Reconnect to Map Server – Use to connect/reconnect to any of 
three supported map servers (Nokia Ovi Maps, Google Maps, Open 
Street Map) 

The default Map Server may also be selected in the Location Preferences (Display 
> Preferences > Location). 
Limitations: 
When using Edit > Merge to merge graph files from multiple hardware units: If only 
one graph file contains embedded GPS data, the GPS data will be copied into the 
merge output graph. If more than one graph has GPS data, no GPS information will 
be present in the merge output graph. 
Data snapshots will archive any GPS data present in the graph and retain it in the 
snapshot. When the snapshot is restored, the archived GPS data will be extracted 
into the newly created graph window, showing the data from the snapshot. 
GPS data in a graph file is read-only and cannot be modified directly within the 
software. To modify the GPS information, the data must first be exported, edited 
externally, and then re-imported. 

Stacked Plot 
Options 

 Displays options that can help visually distinguish 
the active slice from other slices being drawn in 
Stacked Plot mode. See page 41 for details. 

 

Step plot  Displays waveforms in a “step” plot, meaning that the lines connecting sample 
points are drawn either vertically or horizontally. Step plot is most useful for 
displaying histograms and similar plots, but since it displays data much as it appears 
to a digital processor (like the MP and other hardware units), it can also be useful 
for examining the effects of various sampling rates.  

NOTE: Step plot is mutually exclusive of line plot. 

Toolbar  Displays the toolbar (shortcut) icons across the top of the display (see page 57). 

X/Y 
 

Activates the X/Y display mode (see page 38). 
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Customize Toolbars 

 
Use the Customize toolbar feature to create custom toolbars for easy access to post-processing Analysis and 
Transform actions. Toolbars are dockable and custom toolbar placeholders can be named independently of toolbar 
actions.  

 Actions – Menu list of available Analysis and Transform functions 

 Toolbars – List view of custom toolbar placeholders 

 Current Toolbar Actions – List view of available actions from Analysis and Transform menu 

Button Function Explanation 

 
Add toolbar button Adds placeholder for new toolbar. (More than one toolbar action can 

be grouped under one placeholder). 

 Remove toolbar button Removes placeholder for toolbar. 

 Rename toolbar button Allows existing custom toolbar name to be edited. 

 
Up arrow Moves a toolbar action up the list. 

 
Left arrow Removes a toolbar action from the list. 

 
Right arrow Adds a toolbar action to the list. 

 
Down arrow Moves a toolbar action down the list. 

 
Clear button Removes all toolbars from Toolbars and Current Toolbar actions list. 

 
OK button Enforces addition or removal of toolbars from list or application 

toolbar region. 

 
Apply button Applies changes without closing Customize Toolbar window. 

 
Cancel button Dismisses any toolbar changes without applying. 
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Spectrum Analyzer Palette Details 

 
Spectrum Analyzer breaks time domain signals into their respective frequency components to provide a dynamic 
display of the frequency decomposition of data, in real time or post-acquisition. Spectra can be generated in real time 
based on the most recently acquired data or post-acquisition based on the selected area of a saved data file. 

• Spectrum analyzers can be useful for locating and correcting noise sources in a system as well as other 
frequency domain analysis. 

• The Spectrum Analyzer displays the FFT of a portion of data of a single channel. 
The spectrum analyzer applies to all graph windows displaying data in the time domain. Viewing the underlying time 
domain data at the same time as the spectral information also provides useful visual feedback with regards to signal 
quality. The palette allows for continuous availability of the spectrum analyzer across multiple graphs and for 
positioning alongside original data. The channel is always indicated by the popup menu within the spectrum analyzer 
itself. The graph whose data is analyzed will always be the topmost graph; this is the graph whose window is highest 
in the Z ordering. 
Mode: 
 Real-time Analyzes the most recently acquired data in a graph. The analyzer generates full FFT output so, in 

linear units, it is the regular FFT multiplied by two. The analyzer extracts the spectrum based on a 
sliding window of samples at the tail end of the signal and periodically refreshes the spectrum plot 
during acquisition. The analyzer uses a fixed width window size. The first spectrum will be generated 
after the number of samples needed to fill the initial window has been acquired. If no data is being 
acquired, the analyzer will not display any frequency information and will appear to be off. 

 Selection Analyzes the highlighted section of the active channel of a saved graph (post-acquisition). Select the 
channel to be analyzed from the channel popup menu. 

Palette popup  (upper right) Displays the spectrum analyzer palette popup menu for 
performing other operations on the spectrum including extracting the 
spectrum to a new graph window and copying spectrum data to the 
clipboard or journal. Options are dimmed if there is no spectrum 
available. 
New … New Graph with Spectrum constructs a new graph window 

with the contents of the spectrum. This allows for more detailed examination of the 
spectrum than is possible with the tools in the spectrum analyzer palette. 

Paste… Paste Spectrum to Journal makes a textual representation using the current Journal 
preferences and copies the text into the graph journal of the graph whose data is being 
analyzed. This will prompt to create a journal if none exists.  

Copy… Copy Spectrum to Clipboard makes a textual representation using the current Journal 
preferences and copies the text to the Clipboard. 
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Settings… Displays the spectrum analyzer settings dialog. Equivalent to using the Settings button at 
the bottom of the palette; see Settings below for details. 

Channel Indicates which channel of the hardware setup or graph is being analyzed. The “Channel” popup 
menu contents vary with the analyzer mode: 

 Real-time Channel popup menu lists active channels whose “Acquire” checkboxes are checked in Hardware > 
Set Up Channels. The channels will be listed as “{A,D,C}{0-16}, chan_title” where chan_title is 
replaced with the manually entered title in the channel setup window. 

 Selected The channel popup menu matches the channel menu of measurements in the topmost graph window. 
The menu starts with “SC, Selected Channel” which, when chosen, uses the data of the active channel 
of the graph. The remainder of the menu lists the channel numbers and labels of the channels within 
the topmost graph. 

Plot display Plot of the spectrum of the corresponding data. 
 Vertical axis units match the source channel (displays either “dbV” or linear) 
 Horizontal axis displays frequency and is always displayed in “Hz.”  

 If there is a valid data selection that can be used to compute a spectrum, the spectrum will be 
displayed in this area. If there is no valid data selection, no axes will be displayed and the plot will be 
replaced with the text “Not Available.” The following conditions cause spectra to be unavailable: 
 graphs that contain no data (either no channels or only empty channels) 
 graph is being displayed in XY mode 
 graph uses either frequency or arbitrary units for its horizontal axis 

When operating in selected area mode, the following additional conditions also cause spectra to be 
unavailable: 
 selection contains no data on the active waveform 
 selection is a single-point selection (not enough data to compute FFT) 

When operating in real-time mode, the following additional conditions also cause spectra to be 
unavailable: 
 no data acquisition is in progress 

Auto Vert Click to autoscale the spectrum to fit all amplitudes within the visible spectrum plotting area. 
Auto Horiz Click to autoscale the spectrum to fit all frequencies within the visible spectrum plotting area. 
Settings 

   
 Plot color Colorwell that changes the color used to draw the spectrum in the palette. Click to display a standard 

color picker. 
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Window Width specifies the window size used when performing analyses in real-time mode. The spectrum 
will always reflect the frequency characteristics of the most recently acquired data of the graph, using 
this window size as the number of sample points to use. This popup will list various powers of two, 
ranging from 256 to 4096 samples. 

  
 FFT Options 
 Padding—used whenever the number of input points is not an exact power of two. Data can be 

padded either with zero or with the amplitude of the last data point. 
 Remove mean—Subtracts the mean value of the data is prior to frequency analysis. This helps 

remove the zero frequency component caused by DC offset. 
 Remove trend—Connects the endpoints of the data with a line and removes this linear trend from the 

data prior to frequency analysis. This can help compensate for drifting baselines. 
 Units—control whether the data is displayed using a logarithmic scale or a linear scale. 
 Window—enables the standard AcqKnowledge FFT windowing options, to adjust the data to remove 

effects resulting from the discontinuities of data at the two edges. See page 318 for details about FFT. 

Value Click the crosshair icon  to display the frequency and amplitude values of the spectrum when 
moved within the spectrum display. The mouse cursor will change to a crosshair when inside the 
spectrum plot. The frequency and amplitude values corresponding to the mouse position are displayed 
above the spectral plot. Hold the mouse button down to display the amplitude of the spectrum at the 
horizontal mouse position, along with a crosshair cursor highlighting the exact location shown on the 
spectrum. If the active spectrum is compressed (that is, if multiple samples exist for a particular 
horizontal position), the value extracted will be the maximum value displayed at that pixel position. 

Zoom Click the magnifying glass  to perform zoom operations. Click and drag the mouse cursor (which 
will change to a magnifying glass) in the plot display to select the area to zoom in on. Alternately, 
click either of the axes of the spectrum palette to display a dialog used to enter display ranges 
manually. Enter the start and end points of the desired range for each axis. There are no grids in the 
spectrum analyzer palette, so the axis scaling dialogs of graphs are not applicable. Note: adaptive 
scaling will be disabled for the spectrum display when either the zoom tool or the axis endpoint entry 
dialogs are used. 

TIP: To zoom out, hold the Alt key (PC) or Option key (Mac) while clicking mouse 
over zoomed area. 

 



444 AcqKnowledge 4 Software Guide 

Visit the online support center at www.biopac.com 

Channel Information 
The Display > Channel Info… command generates an information dialog for the selected channel. 
Channel Information may also be displayed by right-clicking in the channel and selecting “Channel Info…” from the 
contextual menu. 

 
Line Freq Files created with AcqKnowledge 4 include the line frequency (50 Hz or 60 Hz); files created in earlier 

versions will list “Unknown.” 
Channel Use this popup menu to select the desired channel for displaying information. 
Interval The time between sample points, which is the reciprocal of the sampling rate. The sampling rate can be 

modified by using the resample function (described on page 308), by changing the interval horizontal 
scale (see page 434), or by pasting data collected at one sample rate into a graph containing data sampled 
at a different rate. 

Length Indicates the overall length of the channel in samples and in time. The waveform length is generally the 
same for all channels but there are exceptions: 

• Downsampling a channel during acquisition 
• Transform > Resample Waveform/Graph 
• Edit operations – Cut, Copy, Paste, Clear 

Min Provides the minimum value for the waveform data. 
Max Provides the maximum value for the waveform data. 
Mean Provides the mean value for the waveform data. 

The fields below the statistical information contain transformation histories, time/date stamps, parameters, and values 
for selected channels. 

Paste Selected Channel to Journal Pastes transformation modification history for selected channel to Journal. 
Paste All Channels to Journal  Pastes transformation modification history for all channels to Journal. 
Preferences... 
To generate the Preferences dialog, select Display > Preferences on Windows or AcqKnowledge > Preferences on 
Mac. Use Preferences to control measurement options, how waveforms are displayed, and other AcqKnowledge 
features. Select an option in the list on the left of the Preferences dialog and then set the respective preferences 
displayed on the right. 
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See page… 
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Measurements Preferences 
 Measurement rows—determines how many measurement rows will be displayed in the graph window. 

o Use Display > Show > Measurements to hide the measurements; see page 435 for details. 
 Measurement columns—determines how many measurement columns will be displayed in the graph window. 
 Precision—controls the accuracy of digits displayed right of the decimal (1-8) for all measurement results. For 

example, with the precision set to 3, a measurement result might be 125.187. 
 Use linear interpolation—toggle to enable/disable measurement interpolation. 
 Time/Frequency units—sets the measurement unit to use for time and frequency pop-up measurements. This 

locks the units for the measurement result display (i.e., if seconds is selected, a result of 70 seconds will display 
as “70 seconds” rather than “1.16667 minutes”). 

o Best match—Scales units to best match the interval for time and frequency based on the total file. For 
example, won’t set a 3 hour file to display in msec. 

 Include for Journal/Clipboard options 
 measurement name (i.e., BPM, Delta T, Freq, etc.) with the values. 
 measurement units (i.e., volts, mmHg, and so forth) after the numeric values. 
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 measurement parameters used to compute the measurement function result, such as the location and 
operator used for Calculate measurements. 

 channel numbers at the top of each column of data. 
 timestamp—Automatically insert the time of day and the date when pasting measurements or wave 

data. This timestamp can be correlated with selection events to reconstruct the selected area.—useful 
for GLP auditing. 

 Use a separate line for each measurement in the journal/clipboard 
 Mark selection with events in graph—Automatically insert a pair of Global Selection Begin and Selection 

End events at the selection boundaries when pasting measurements or wave data. These events will be 
timestamped with the time of day and the date when the paste occurred. This timestamp can be matched to the 
result of “Include timestamp” to recreate selected areas for reconstructing measurement results or re-executing 
wave data exporting—useful for GLP auditing. 

 Journal Table Export Options – Sets the options for how multiple measurement rows are displayed in a 
Journal table. 

o Put all values in a single table row – Extends multiple measurement rows horizontally into one table 
row. 

o Use one table row for each measurement row – Divides the measurements into multiple table rows in 
the same manner shown in the measurement toolbar. 

Waveforms Preferences 
In the center of the dialog are two options that control how waveforms are displayed on the screen. 
 Gray non-selected waves—When enabled, the active wave will be drawn in a solid color and any non-selected 

waveforms will be drawn using lighter, dotted lines (or with lighter colored dots if dot plot is in use). This can 
help emphasize the selected waveform when viewing data in Scope mode. 

 Draft mode for compressed waves—allows for some (“compressed”) waveforms to be plotted in “draft” 
mode, which results in faster plotting time, although the display is not exact. A waveform is considered 
compressed when more than three sample points are plotted per pixel on the screen. For example, on a VGA 
display that is 640 pixels wide, a compressed waveform would be any type of waveform displaying more than 
2000 samples (approximately) on the screen at any one time. Using the default horizontal scale (which plots 
eight seconds of data on the screen), any data sampled at more than 250 samples per second would be 
considered “compressed.” 

 Scaling/Transformations—the following options determine how data will appear on the screen after it has 
been transformed (e.g., filtered or mathematically operated on). Neither option affects how data appears on the 
horizontal axis, although both options change how data is presented along the amplitude (vertical) axis. 

o Duplicate before transformations will create a new channel showing the data as it originally 
appeared before the transformation was applied. This will preserve the original view for comparison 
to the tranformation. 

o Autoscale after transformations will automatically rescale all waveforms after a transformation to 
provide the “best fit” along the amplitude axis. 

o Tile after transformations tiles all visible waveforms after any transformation, and is mutually 
exclusive of the autoscale command. Tiling visually separates the waveforms on the screen. 

 Mark waveform edits with events—Insert an event at points where waveform edit commands have been 
applied. 

 Include time value—copies the horizontal scale values along with the waveform data when data is copied to 
the clipboard. This means that when you paste data from the AcqKnowledge screen into a spreadsheet or similar 
application, horizontal scale information is retained. 

 Include timestamp—Automatically insert the time of day and the date when pasting measurements or wave 
data. This timestamp can be correlated with selection events to reconstruct the selected area.—useful for GLP 
auditing. 
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 Mark selection with events in graph—Automatically inserts a pair of Global Selection Begin and Selection 
End events at the selection boundaries when pasting measurements or wave data. These events will be 
timestamped with the time of day and the date when the paste occurred. This timestamp can be matched to the 
result of “Include timestamp” to recreate selected areas for reconstructing measurement results or re-executing 
wave data exporting—useful for GLP auditing. 

Event Summary Preferences 
For the event summary that can be pasted to the journal, choose a method to group the events (i.e., type or channel), to 
sort the events (by time or label) and indicate whether to include all events or include only visible events in the 
summary. Beginning in AcqKnowledge 4.2, there is an option to include a header row at the top of the summary. 
Access Event (Marker) preferences under Display > Preferences > Event summary; see page 216 for details. 
Graph Preferences 
 Display Style can be set to Windowed or Tabbed view. Tabbed graphs can be navigated by clicking on the 

identifying tab at the top of the application window, or by clicking Ctrl+Tab. A tabbed graph may be moved to 
it’s own window by right-clicking on the desired graph and choosing “Move Tab to New Window” (below 
right). The default setting for AcqKnowledge is tabbed view. When set to Windowed, multiple graphs apppear 
as separate windows, which can be positioned as desired. 

   
o Editing > Interpolate pastings instructs AcqKnowledge to interpolate/extrapolate time base 

information when working with data sampled at two different rates. AcqKnowledge will interpolate 
data to fit the sample rate of the destination window. When doing this, data should be copied to a 
higher resolution window.  

 Maximum levels of undo—Set the maximum number of undo operations. Unlimited may be memory-
intensive, depending on the detail of each operation. 

 Link selections between data views for new graphs – automatically synchronize selected areas of data views 
between graphs for a new graph. 

 Enable cursor tools during acquisition – Allows access to cursor tools while recording is in progress. 
 Show append boundary dividers – Controls visibility of append event boundary dividers. 
 Axis controls – Controls visibility of set screen vertical axis controls. 
 Chart Track Divider Appearance –Users may change the color used to draw the dividers between channels 

tracks The Preferences > Graph panel contains "Chart Track Divider 
Appearance" options.  

 Default uses operating system specific dividers, which is a  light 
color. 

 Custom activates a colorwell for choosing a solid color to be 
specified for all dividers. The preference setting and color are shared 
by all open graphs and data views, as this is an application-level 
preference. 

 Plotting Background Colors – Starting with AcqKnowledge 4.2, customizable background colors for active 
graph channels are available.  

 Normal activates a colorwell for choosing background color of the non-selected channels.  
 Selected channel activates a colorwell for choosing background color of the selected channel. 
 When closing… determines the degree of closing and what prompts, if any, for multiple data views. 
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 Recently Used—set the number of recently used Transform and Analysis options to list in the Transform > 

Recently used sub-menu; provides quick access to common options. Recently used items can also be launched 
using keystroke the combinations appearing in this menu. 

Journal Preferences 
The Journal Preferences dialog contains options controlling the format of data when it is pasted into the journal or 
clipboard. 
 Change font type and size to any font installed on your computer.  
 Wrap Journal text—Wraps text to window size. 
 Tabs: Specify the tab interval to make columns more readable when you have a high precision setting. 

Auto-paste results—Toggle the checkbox to enable/disable the option to paste results to independent journals. 
Display Style— Choose whether Journal window is fixed, dockable on any edge of graph, or independently floating. 
Hardware Preferences 
 Always work with no data acquisition hardware connected sets the default communication for no connection 

so the connection error is not displayed each time the software is launched. 
 Line frequency is specified during software installation and can be changed here. (50 Hz for Europe and 60 Hz 

for the Americas.).Every time data is recorded, the line frequency setting is saved along with the data. If no line 
frequency data was saved, the line frequency setting for the installed/active version of AcqKnowledge will be 
used. 
 Default analog channel display units – Use to set default channel units to volts or millivolts. 

• Volts – displays in Volt units, visible range +/-10V (MP150 default) 
• mV – displays in Millivolt units, visible range +/- 50 mV (MP36 default) 
 Data Acquisition Hardware Priority launches a dialog allowing the default hardware device ordering to be 

set. This ordering is used to establish hardware communication when the application is first launched or if none 
of the previously-connected MP devices are available. 

 Restore data acquisition hardware configuration on launch – when checked, communication with the last 
known hardware unit will be reeastablished. When unchecked, the application will search for available new 
hardware units. 

 When creating new graph windows use sets the default channel and hardware options for new graphs. 
• Minimal channel setup – new graphs will use the application’s factory default channel settings for the selected 

hardware. 
• User-defined default channel setup – all new graphs are created with the user’s default settings. To remove 

established default settings, click the “Clear Default Setup” button. 
• Channel setup of last active graph – the settings of the most recently created active graph will be applied to all 

new graphs. 
 Auto-connect to BioNomadix Loggers will search for any BioNomadix Loggers that may be attached to the 

computer and attempt to connect to the unit. 
Performance Preferences  
 Use all available memory instructs AcqKnowledge to attempt to use all the available memory for loading data. 

Otherwise, a variable sized buffer is used to load portions of large data files. This option works best if there is 
enough free memory to load the entire data file. 

 CPU allocation sets the priority for CPU (system resource) allocation. For a data focus, move right, for a 
function focus, move left. 
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• If buffer overloads occur, move indicator toward Better data transfer for high speed acquisition. 
• To allow autoscale during acquisitions or jumping between hardware units, resizing displays, or working 

in other programs, move toward More responsive. 
Networking Preferences  
Network data transfer and Remote Monitoring are not supported in AcqKnowledge 4.0-4.1. 
Enable networking to allow applications running on other computers attached to the same network to gain access to 
data from AcqKnowledge as it is being acquired. Data is sent to other applications over a network using TCP 
(recommended) or UDP connection during acquisitions. All types of channels may be exported, including analog, 
digital, and calculation channels. AcqKnowledge will continue to function normally while data transfer is in progress, 
displaying the new data in the graph window and performing any autoscrolling.  
Respond to auto-discovery—Toggle the checkbox to enable/disable response during network data transfer. 
The network data transfer feature is not intended for strict real-time delivery. It also does not provide direct control 
over the MP150 unit. Perform all hardware configurations manually using the AcqKnowledge interface.  

Enable Remote Monitoring to allow acquisitions on the computer to be viewed remotely over a network through a 
client/browser interface. Acquisitions can be started and stopped remotely and graph data viewed while recording is in 
progress. This is handy if the AcqKnowledge computer recording the experiment is in one area and the researcher 
monitoring the experiment is in another. 

For applications that require low latencies, high-data throughput, or direct hardware configuration and control, use 
BIOPAC Hardware API.  
Other Preferences 
 Show menu tooltips enables display of tooltips describing menu item functions. Tooltips appear when menu 

items are moused over. 
 Create Data Snapshots after acquisitions toggles the snapshot (embedded archive) feature, which stores 

snapshots of original acquired data along with the graph file for easy comparison of results to original 
waveforms or to intermediate stages of analysis; see page 54 for details. 
IMPORTANT: Archive functions do not create a new file—they are not backup functions.  

Original data is copied and pasted to the end of the original file.  
You cannot use this feature to recover lost or damaged original data. 

When this Preference is enabled, a date-stamped archive of the data in the graph will be created each time the 
acquisition is stopped. In Append mode, the entire graph is backed up with each Append, old data as well as the 
newly acquired data.evt_ 
This is a memory intensive function; each snapshot that is added to a graph file will increase its size on disk by 
approximately 40%. You will be prompted about memory; click OK to proceed.  

 
 Reset toolbar positions—Resets location of toolbars to default setting. 
 Create configuration file— Create default menu configuration file to customize menu display. See page 564 

for customization details. 
 Maximum number of files in File > Open Recent—Sets the number of files that will appear in the ‘File > 

Open Recent’ list. 
 When application is launched:—Chooses between display of Startup Wizard or a new empty graph following 

application launch. 
 Default audio device—Use this option to select the default audio device to be used by the application. 
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Window Preferences 
 Always keep the following windows on top: — Sets options for keeping any of the following windows active 

above the main application window: Input Values, Manual Control, Stimulator Control, Media Capture 
Preview, Media Capture Viewer, Media Playback Viewer, Gauge View. 

Focus Areas Preferences 

 
 Show background—Sets option for main graph visibility in the background of the selected focus area. 
 Color (background)—Sets background color of focus areas. Click color square to change color of focus area 

background. (This option not active if “Show background” is unchecked.) 
 Opacity—Sets transparency level of background. (0 is transparent, 100 fully opaque.) 
 Show borders—When checked, borders will appear on both sides of the focus area. 
 Color (borders)—Click to change the color of focus area borders. 
 Width—Controls width of focus area borders. 
 Show Labels—Controls visibility of Focus Area labels. Labels can be shown or hidden. 
 Label Position—Controls where the Focus Area labels will appear in the graph. Options are at the top part of 

the waveform or the bottom part of the waveform. 
Location Preferences 
 Default Map Server – selects the map server used to display GPS tracking data in the Location Palette. The 

available map servers are Nokia Ovi, Google Maps or Open Map. 
 
Resetting All Preferences to Factory Default 
You may reset all preferences to the default factory configuration by holding down the Shift key while launching 
AcqKnowledge. This dialog will appear: 

 
It is important to note that accepting this option will reset ALL application defaults to the factory configuration.  



454 AcqKnowledge 4 Software Guide 

Visit the online support center at www.biopac.com 

Scroll options 

The Scroll options help navigate through large data files. Right-click below 
the horizontal scroll track to generate the contextual menu with scroll options. 

 

 
Size window... 

 

The Size Window function is useful for setting exact dimensions 
for the size of the graph window. Use this to create consistently 
sized windows for pasting into documents.The two text box fields 
are used to enter interior screen width and height, both of which are 
scaled in terms of pixels.  

Each operating system may add additional dimensions as necessary to put in window adornments depending on the 
appearance configuration preference of the user (e.g. extra space for title bar of the window, any additional space put 
around the edges of the window frame, etc.). 
When the Reset chart boundaries box is checked, the boundaries between the waveforms will be reset so that each 
channel “track” is the same size.  
When Use as default for new windows is checked, the user-modified dimensions are applied as the default graph 
window size. 
When “Retain current dialog settings” is checked, the dimensions used when the dialog was previously dismissed are 
applied to all subsequent graphs.  
Cursor Style 

 
This option allows the active cursor tool to be adjusted via the Display menu. (AcqKnowledge 4.2 and higher) 

Create Data View 

 
Creates a new Data View for the active (frontmost) graph and names the new window “Data View of ‘Filename’” For 
Data View details, see page 44. 
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Create Focus Area 
This option becomes available only when an area of data is selected, and brings up a Focus Area naming dialog. For 
full details on using the Focus Area feature, see page 89. 
Organize Data Snaphots 
Arrange data snapshots (as created via Edit > Create Data Snapshot). 

 

 
Show All Data Snaphots 

 

 

1 
 

2 
 

3 

 1 Manual Archive: description and time 
 2 Original file 
3 Auto-Archive: time only  

To view the embedded snapshot(s)/archive(s) associated with a graph file, choose Display > Show Original Data/All 
Data Snapshots. This will open a new graph window for each archive/snapshot associated with the graph. The time 
portion of the Filename for each graph is from the computer clock (saved with semi-colons because you cannot save a 
file with colons in the filename). The “Snapshot from…” graph will open with no Start button. 
Each embedded archive is essentially a “snapshot” of the original acquired data that is stored with the graph file so 
you can view the archive at a later time to compare results to original waveforms or intermediate stages of analysis. 
Append events are not preserved in the snapshot/embedded archive file. For details on creating snapshots/embedded 
archives, see page 54. 
Load All Data Into Memory 
Use with large files to improve plotting performance, measurement response, etc. Memory can hold up to two 
gigabytes of data. 
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Chapter 19 Program & OS Menus 
AcqKnowledge menu 

 

Mac OS X only—System generated menu. Use for Quit and Preferences. 
(Quit can also be found in the File menu.) 
 

 

Window menu 
The Window menu is a standard OS 
function. See Windows or Macintosh OS 
Guide for details. 
 
Bring All to Front 
If other programs are running, this 
command will bring all AcqKnowledge 
windows to the front (on top of all other 
application windows); this command does 
not change the windows size or position. 
Additional options become available 
when the Tabbed graph display preference 
is selected. (Right figure) 

   

Help menu 

 

Use the User Support System pdf files for online help with the software. 
Selecting “About AcqKnowledge” from the Help menu generates a dialog 
that providing information about the AcqKnowledge software being used 
and system parameters, which can be useful when contacting Technical 
Support. 
Note: For information about the MP150 data acquisition unit and 

firmware, click MP150 menu >MP150 Info. 
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Click the System Info button for more detailed information. 

 
The Copy to clipboard button makes it easy to paste system info into an 
email for Technical Support. 
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Chapter 20 Media Menu 

     
Also applicable to multi-camera systems and CAM-HFR-A high-speed camera. For Media Menu setup for CAM-
HFR-A, see page 464. 

Available in AcqKnowledge 4.1 and above for Windows—Media functionality allows users to capture and playback 
video and/or audio with a USB web cam or firewire DV device and synchronize it with physiological information 
from an hardware device. The key functionality is a strong link between the video and data cursor when graphs are 
being used in post-acquisition mode; changing the selection in the graph window will automatically jump the video to 
the time corresponding to the cursor position. The reverse tie is also in place where scrolling the video will move the 
data cursor to the corresponding data point in the graph. 

For synchronized playback of media player with AcqKnowledge cursor in data view, BIOPAC recommends that the 
users sample the hardware unit at least as fast as the video frame rate 30Hz. In this case, any measurement errors are 
limited to the basic frame rate error window (1/30 sec). For exact match of Video and Data samples, BIOPAC 
recommends frame rate 25 fps and acquisition rate 25 samples/second (or its derivatives). 

Set Up  Establish Sources, Output and Media parameters. Set device type for audio and or/video. 
Use refresh after connecting a new device to make it a selectable option. Browse using 
standard file open/save functionality to specify media files. If desired, set a Delay between 
file segments. 

Show Capture Viewer Use for video signal directly from a video camera; this option is disabled (grayed) in the 
record mode when both the Capture video and Capture audio options in the Media Setup 
dialog are off. 

 
Show Playback Viewer Use to play back media from the disk (stored media files); this option is disabled (grayed) if 

there is no media assigned to the file. 
Video Playback and Capture preview include a right-mouse contextual menu item “Grab bitmap” which, when 
selected, generates a Save As dialog to save the current displayed frame as a *.bmp image. 

Media Notes 

 ::  Media capture performance is improved under Windows 8 and 7 OS. If the selected webcam drops frames 
because of poor performance/low quality, the degree of synchronization will be compromised. Testing 
indicated the Microsoft Lifecam NX-3000 gave reliable performance with no dropped frames. 

 :: Several AcqKnowledge files can point (link) to the one media file.  

 ::  AcqKnowledge files can link to media files created by other programs. If the media file is shorter or longer 
than the AcqKnowledge files, just align the two files at the start. 

 ::  AcqKnowledge files alignment precision with the media file is user-controlled through the use of a delay 
function that allows a forward or backward time shift. 

 ::  AcqKnowledge files store the location (path) of the media file. This path is editable, so the AcqKnowledge 
file can link to other media files too. 

 :: Media functionality does not support the Autosave file acquisition mode. 

 ::  Using the “Reset” function on appended acqusitions does not delete any previously recorded Media segments. 
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Synchronization Tip 

To optimize synchronized playback of the media and the physiological record, use the OUT103 LED to determine the 
delay between the media and the data. The LED must be in view of the video camera and the LED channel must be 
recorded.  

Media synchronization - Windows only - AcqKnowledge 4.1 and above 
Option 1: MP150 and UIM100C setup using an Analog Output 

a. Connect the OUT103's 3.5 mm phone plug from the LED to one of the arms of the included Y-cable. 
b. Connect the included CBL100 to the other arm of the Y-cable. 
c. Connect the stem of the Y-cable to one of the two Analog Output connections near the bottom of the front 

face of the UIM100C. 
d. Connect the other end of the CBL100 to an otherwise unused Analog Channel also on the front face of the 

UIM100C. 
e. Use "MP150 > Set Up Channels..." (in AcqKnowledge 4.4, choose "Channels" in the left pane after choosing 

"MP150 > Set Up Data Acquisition...") and acquire and plot the analog channel to which the CBL100 is 
connected. 

f. Use "MP150 > Set Up Stimulator..." (in AcqKnowledge 4.4, choose "Stimulator" in the left pane after 
choosing "MP150 > Set Up Data Acquisition...") to send 5 volt pulses through the Analog Output. 

Option 2: MP150 and UIM100C setup using a Digital I/O Channel 
a. Connect the OUT103 2 mm pin adapter to the 3.5 mm plug on the OUT103 cable. 
b. Connect the red OUT103 2 mm pin to a Digital I/O channel on the rear of the UIM100C and the black pin to GND 
 D on the rear of the UIM100C.  
c. Use MP150 > Set Up Channels to acquire and plot the Digital I/O channel the OUT103 is connected to. 
d. Set MP150 > Show Manual Control 
        - set for 'Output' 
        - enable the 'Set immediately' option 
        - click the Digital I/O channel the OUT103 was connected to toggle between 0 to 1  
   If necessary, click the 'Set' button to update the manual control and output a digital pulse. 

 MP36R setup - additional items required   
a. Connect an OUT3 (BNC adapter) to the 'Analog Out' port on the rear of the MP36R. 
b. Connect a BSLCBL6 (interface cable: BNC to 3.5 mm) to the OUT3. 
c. Connect the OUT103 3.5 mm plug to the BSLCBL6 3.5 mm socket.  
d. Set MP36 > Output Control 'Low Voltage Stim' option 
        - set Pulse width to 100 msec 
        - set Pulse level to 5 Volts 
        - set Reference Channel to any digital channel 
        - click the 'ON' button to output a digital pulse 

• Once the LED has illuminated and you can see the square wave in the file, you can hide the channel. 

• After the recording is complete, use the I-beam selection tool to measure the offset between the LED 
illumination and the leading edge of the digital impulse. Use a Delta T measurement to determine the 
delay information; Delay may be positive or negative based on camera performance. Delay should be 
entered in the Linked Media row for each segment—see page 461. 

http://www.biopac.com/stimulator-mp36-bnc-adapter�
http://www.biopac.com/cable-stimulator-bnc-mm-socket�
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Media > Set Up 
 
Source  

Use this dialog to select media source and select audio and video to record.  Click Refresh to update the list if a 
video or audio device is connected after the dialog was opened. When video/audio for capture is selected, an 
output file must also be selected.  Input file name and click OK; this will close the Media Setup dialog and 
automatically open the media window if the Capture option is ON.   
All video camera, audio (microphone) input parameters can be setup by user with the UI provided by camera 
manufacturer, or use the “Configure” button for direct access to camera properties, such as exposure, saturation, 
contrast, white balance, etc. 

   
Output 

Video/audio capture requires a media file specified with full name with disk location.  *.avi or *.wmv file formats 
are supported. Users can save AcqKnowledge data and media streams onto separate hard drives. 
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Linked Media  
IMPORTANT An AcqKnowledge data file must be opened before linking to a media clip.  

  
If media was captured with the data file, the Linked Media dialog will display a row for each appended 
segment in the AcqKnowledge data file and will list the file location of the corresponding media for each segment. 
The samples above show four AcqKnowledge data segments and four linked media Files. 
Click anywhere in the row (or choose the Edit button) to set a delay to synchronize the media file with the 
physiological data. Delay range: Min= 1 millisecond, Max = segment duration. 
 See Synchronization Tip on page 459. 

If media was not captured with the data file, click the appropriate row and click “Link” to browse to the 
desired media file from that segment. 
Delay—Each segment can have a distinct delay. Click in the Delay 
cell or click Edit to generate the dialog for Delay entry. 

“+” Delay places start of video file after graph start 

“-” Delay places start of video file before graph start 

The best possible synchronization can’t be better than the video frame rate (usually 1/30 of a second).  

Media > Capture 
Use Set Up to assign a Source and Output to enable the Capture menu option. There are no Preview window 
controls and the size reflects default video camera resolution. 

Playback Preview 
As the media file is manually scrolled or automatically played, the AcqKnowledge cursor keeps moving to reflect 
the corresponding location in the AcqKnowledge graph. If the AcqKnowledge cursor is moved, the media file is 
automatically scrolled to keep time sync with the data file.   
In AcqKnowledge 4.2 and above: Media files linked to appended data segments are loaded in sequential order. 
After playback of the first media segment, the cursor will automatically advance to a still-frame view marking the 
beginning of the next segment. The Play button must be pressed in order to play back subsequent segments.  

Audio Mute button and level slider 
Video Digital indicator (time in milliseconds or frame number for the segment clip) and Horizontal slider 

(progress bar) to navigate the media file. The start point can be set from either the media clip or the data 
file. For precise selection, hold the shift key and use the forward or backward arrow keys on the media 
player or the keyboard to move single video frame (mostly 1/30 seconds) or data point.   

 Use the scroll bar to navigate to different frames. Synchronization should be maintained with data in the graph 
window. This should result in a single sample selection cursor shown at the time closest to the displayed video 
frame.   
The media window displays the text “No media assigned” in Playback Preview when the media window is visible 
but there is no video/audio file assignment for given data segment.  
During the capture or playback of audio only, the media window will be displayed with a static 
musical note image as shown at right. 
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The Playback viewer uses standard media player controls. 

 

 
Go to previous segment / go to beginning of 
segment 

 Step backward a frame/sample 

 Fast backward / reverse rewind 

  
Play/ pause 

 Fast forward 

 Step forward a frame/sample 

 Go to following segment 

 Mute sound 
 
Media Playback Example 

1. Launch AcqKnowledge 4. 
2. Open a saved acquisition file.  

 

 
3. Select Media > Show Playback Viewer. 
4. Here you can play with contents: 
 Select I-beam cursor on graph and push 

“Play” button on the player.  
 Change selection with I-beam on graph 

and see the video. 
 

 
IF media is not assigned, locate the video clip 
for the appropriate segment: 

a.)  Select Media > Set Up 
b.)  Select the “Linked Media” tab  
c.)  Select Segment 1 and click “Edit. 
d.)  Click “Link” and select a saved media 

file. 
 

 
 



Part C — Analysis Functions 463 

AcqKnowledge 4 Software Guide 
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Media Capture Setup with CAM-HFR-A High Speed Camera 
The CAM-HFR-A is a high speed camera capable of capturing more precise video at rates up to 100 frames-per-
second. AcqKnowledge versions 4.3.1 and higher support use of this camera. The Media setup procedure differs from 
that of a standard USB camera, with the AcqKnowledge Stimulator providing a “sync pulse” between the MP150 and 
the camera. Therefore, no manual synchronization procedure is required. The following pages describe hardware and 
software setup for the CAM-HFR-A. 

 
A.  Connect Camera Hardware: 

Before you begin: 

Make sure the camera drivers and the provided ETHCARD3 Network Interface Card are installed on computer. 

1. Connect the CBLHFR 6-pin-connector to the camera input. 

2. Connect the female end of the CBLHFR connector to the AC300A power supply adapter cable. 

3. Connect the CBLHFR Trigger Cable to a UIM100C Analog Output. 

4. Plug the AC300A power supply cord into wall socket. 

5. Connect the Ethernet cable between the camera’s Ethernet port and the ETHCARD3 network interface card 
supplied with your system. Attach the 6 mm lens to camera (included as LENS-CAM-A). 

6. Launch the pylon IP Configuration Tool from the Desktop shortcut to verify camera/network connection. If 
successful, the camera’s network settings will appear in the IP configuration window as shown below. (Make 
sure the IP configuration is set to DHCP.) 

 
NOTE: If the camera’s network settings don’t appear in the pylon IP Tool Configuration window, click the 

“Refresh” button and highlight the camera device from the list at the top of the Configuration Tool. 

If the camera’s network settings still don’t appear, or appear in the pylon IP Configuration Tool window  
as “unreachable,” reset the IP configuration to Static IP. 
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B.  Set Up Camera Configuration in AcqKnowledge Software: 

1. Launch AcqKnowledge and select 
Media > Set Up. The Basler camera 
should appear as selected in the 
“Video” list. 

2. Check the “Video” option (and 
“Audio” if sound is to be recorded). 

 

 

3. Click the “Output” tab and type in a 
media file name. 

4. Click “Browse” and choose a 
format** (*.wmv or *.avi) and 
directory for the new media file. 

5. Click “Save.” 

 

 

6. Click “OK” to bring up the Video 
Capture Viewer. This is useful for 
determining proper camera 
positioning, lighting, etc. 

7. To access the “Video” properties 
(Exposure or Gain controls), go to 
Media > Set Up and click the 
“Configure” button. 

NOTE: The “Configure” button is not 
active until the Media > Set 
Up dialog is dismissed with 
“OK” and reopened. 

 

8. Click the “HW Trigger” tab to:  

• Use the MP150 Stimulator to 
trigger and synchronize the 
camera recording with 
AcqKnowledge data collection. 

• Set the camera frame rate (25, 
50, or 100 fps). 

   

**Dropped frames while recording in *.avi format are an indication that the computer may lack sufficient  
resources to support this larger-scale format. If this occurs, it’s advisable to use *.wmv format instead. 

NOTE: The CAM-HFR-A can link with only one graph at a time. A previous graph must be closed prior to connecting to a 
second graph, or a conflict error message will result. 

For camera specifications, see the CAM-HFR-A Product Sheet or the BIOPAC Hardware Guide. 

 Watch the AcqKnowledge CAM-HFR-A video tutorial  for a detailed demonstration of this feature.

http://www.biopac.com/video/?video_category=hardware-tutorials&v=cam-hfr-a-high-frame-rate-camera-system�
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Part D — Licensed Functionalities 
AcqKnowledge Licensed Functionalities consist of powerful optional features not included in the standard 
AcqKnowledge installation. These features become available with the purchase of an enhanced licensing level, and 
can be purchased individually or in a bundle at any time and added to an existing installation. 

Access to the licensed features is enabled by a USB License Key provided by BIOPAC, and the USB key must be 
connected in order for the licenses to be active. With the license key connected, information about the available 
licenses can be found by going to Help > About and clicking the “Licensed Features” button. 

 
The following chapters offer an overview of the various licensed features.available from BIOPAC.
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Chapter 21 Licensed Functionality: Network Data Transfer 
Network Data Transfer (NDT) functionality is available through an optional license available 
with AcqKnowledge 4.1.1 or above. The license must be authorized to access NDT 
functionality. To add an NDT license to an existing MP System, please contact BIOPAC. 

Network Data Transfer (NDT) is a real-time data transfer system that allows access to the data 
being acquired into a graph by AcqKnowledge for use in an external application; the 
AcqKnowledge process and the custom application may run on the same computer.  
Make TCP or UDP connections to external applications and stream binary data during acquisitions. Network Data 
Transfer is supported in MP150 hardware only. 

The NDT license  

 allows Network Data Transfer functionality  

 links the Network Data Transfer Reference under Help 

 includes network data transfer Preferences 

 
Most of the settings for the network data transfer functionality are set by clients through control connections. Several 
settings for the AcqKnowledge server may be set directly in the AcqKnowledge preferences. Versions of 
AcqKnowledge that include network data transfer functionality have an additional "Network" group of settings 
underneath their Preferences. These Preferences are accessed from the Display menu ( Windows 8, 7/Vista) or from 
the AcqKnowledge menu (Mac OS X): 
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NDT is a basic method for allowing third party applications to tap into the data stream being generated by both the 
MP unit and AcqKnowledge during data acquisitions. NDT provides  

 networking facilities that allow for integration into a distributed application environment 

 basic control facilities to allow external applications to query and control the AcqKnowledge application state. 

The NDT system is split into two separate types of connections: data connections and the control connection.  

A. Data connections deliver data from AcqKnowledge to external applications during acquisitions.  

B. Control connections are made from external applications to AcqKnowledge to query application state and 
adjust data connections. 

The server refers to the AcqKnowledge process and the computer on which it is running. The client refers to the 
custom application that is to receive data from AcqKnowledge and the computer on which it is running.  

All connections should be made using standard network protocols, either TCP or UDP. Single system image 
architectures should make connections using the loopback interface. It is assumed that network implementations have 
appropriate IP networks in place with routing between machines that can be identified either by IP address or by 
hostname. Firewalls must be properly configured to allow network communications between the client and server. 
Appropriate network configuration is the user’s responsibility. 

Data Connections 

Data connections are used to deliver data from the AcqKnowledge server to the client application. Data connections 
stream both data acquired from an MP unit and computed data from AcqKnowledge calculation channels. Data 
connections are available in a variety of formats and can be configured to meet the needs of the client application and 
bandwidth requirements. 

Data connections are created only at the start of acquisitions. It is not possible to “attach” to data acquisitions that are 
already in progress. 

XML-RPC calls for retrieving data are also described in this section. These connections are not persistent and not 
established from server to client, but rather a request made from client to server. The recommended mode of operation 
is regular TCP or UDP operation. 

Variable Sampling Rates 

AcqKnowledge uses variable sampling rates that allow different channels of data to be acquired at different sample 
rates. This allows fast moving signals (such as EMG) to be acquired at high sampling rates while simultaneously 
recording slow moving signals (such as respiration) at lower sampling rates. The primary use of variable sampling 
rate is to optimize storage requirements by minimizing space spent retaining slow moving data. 

In addition to the storage optimizations, variable sampling rates are also used to optimize data connections. Channels 
that are sampled at lower rates require less network bandwidth to transfer from client to server. If channels of data 
cannot be disabled and overall bandwidth is limited, variable sampling rate can be used to lower the bandwidth 
required to move data between the server and the client. 

The use of variable sampling rates requires the client to be aware of downsampled channels and handle data 
accordingly. Variable sampling rate may also affect the interpretation of the incoming data connection stream, as 
indicated below. 

Transfer Types 

Clients may choose between two different transfer types:  

 single connection uses one data connection between the server and the client to deliver all data 

 multiple connection uses multiple data connections delivering data simultaneously 

Single Connection 

The single connection transfer type uses a solitary connection between the server and the client to deliver data. When 
multiple channels of data are being delivered, all data is sent over the single connection in an interleaved format. The 
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interleaved format mingles the data of all channels in order. For example, an interleaved representation of two 
samples from three channels of data would be: C1 C2 C3 C1 C2 C3. This is equivalent to two sample frames where a 
frame contains the data at a particular sample location for all of the channels, in this case “C1 C2 C3.” Frames are 
delivered sequentially over the data connection. 

The single connection transfer type allows for all data to be processed from a single location and uses only one 
network connection resource. Single connection transfer has drawbacks including the need for the client to demux the 
data stream as well as account for variable sampling rates. 

Variable Sample Rate Considerations 

When variable sampling rate is being used, the single connection transfer type has the characteristic where not 
all frames have the same size. If a frame occurs at a sample position where a channel is not being sampled, 
that channel will not be included in the frame. 

All downsampling within the AcqKnowledge variable sampling rate environment occurs at integer divisions 
of the base sampling rate. Only frames with indexes (zero-based) that are evenly divisible by the 
downsampling divider will contain data for that channel. 

It is the responsibility of the client to compute and retain the frame index and to properly check 
channel dividers against the frame index to determine which channels are represented in that 
frame. 

Frame 0 always contains a data point from every channel. 

For example, consider a three channel acquisition. Channels 1 and 3 have a downsampling divider of 1, that 
is, they are being acquired at full speed. Channel 2 has a downsampling divider of 2, that is, channel 2 is 
being acquired at half speed. The first five frames of data in the single connection transfer type will appear as 
follows: 

C1 C2 C3 | C1 C3 | C1 C2 C3 | C1 C3 | C1 C2 C3 

Note how frames 1 and 3 are shorter as they occur at positions where channel two is not defined. 

If variable sampling rate is being used, clients are required to perform proper frame indexing in order to 
demux the interleaved data stream. If clients cannot handle variable sampling rate correctly and are using the 
single stream transfer type, clients should check all of the downsampling dividers using the control 
connection to AcqKnowledge and warn the user if the configuration cannot be supported with that client. 

Multiple Connection 

The multiple connection transfer type uses a single connection from server to client for each channel of data that is 
being delivered. Using multiple connections offers the benefit of avoiding the client having the need to demux all of 
the data from each sample. If the client is operating in a high-load environment, the elimination of the demuxing may 
be useful in reducing processor overhead. It also allows client code to be simpler if variable sampling rate is being 
used. 

The primary disadvantages of using the multiple connection transfer type are the usage of more network ports and the 
client assuming responsibility for synchronization of data across multiple channels. The data immediately available on 
one network connection may not be guaranteed to be the identical sample index of data being received for another 
channel. The client must keep track of sample index on an individual channel basis to properly synchronize data 
across multiple channels. 

Variable Sampling Rate Considerations 

Using variable sampling rate in a multiple connection transfer type is significantly easier. Each individual 
channel's connection delivers data at that channel's sampling rate. On a given connection, all samples have an 
identical length. 

Clients still must be aware of variable sampling rates. The sampling rate of information on a downsampled 
channel connection is different than the sampling rate of information on an upsampled channel connection. If 
the client is performing any time domain measurements or other computations involving the sample interval, 
the difference in inter-sample-interval must still be taken into account. 
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XML-RPC 

The XML-RPC transfer type allows clients to explicitly request data from the server. Instead of data being 
automatically pushed to clients, the client must post an XML-RPC function call to the server. This allows the 
client to query the server for the most recently acquired data sample value for a particular channel. Clients 
that do not require continual data streams or interact with only slow moving data may wish to use this method 
communication method. This method returns values only; no information about sample indexes or lengths is 
returned. 

XML-RPC has significant overhead for both client and server, so this transport method cannot handle more 
than a few requests per second. If faster response time is required, the client should implement either the 
single connection or multiple connection streaming methods. 

XML-RPC is not a true data connection as it does not involve the server constructing a streaming connection 
to the client. 

Transport Protocol 

Data connections offer a choice of using either TCP or UDP as the transport protocol for delivering data to the client. 
Choice of protocol depends on application requirements. When a client is receiving data, it is assumed that all data 
connections are using the same transport protocol. 

TCP/IP 

TCP is the preferred transport protocol. As TCP guarantees reliable, ordered delivery, all data is simply transferred 
from the server to the client without any additional information. Data is streamed continuously as it becomes 
available. TCP is recommended for all clients that require a guarantee of receiving all information. It is also 
recommended for any configuration using up to two computers. The port number used for data connections is 
specified by the client using the control connection prior to the start of acquisition. Once a client passes along port 
information, the client should begin listening for connections on that port. 

When using TCP data connections, the start of acquisition is signaled to clients by the establishment of a connection 
on an appropriate port to the client. The end of an acquisition is signaled by the termination of the connection. 

UDP 

UDP is a connectionless protocol that does not guarantee either delivery or properly ordered reception of packets by 
clients. Data connection is allowed to be switched to UDP delivery mode. The primary benefit of using UDP 
datagrams is that a single data stream can be multicast to a number of computers. Multicasting is not offered 
implicitly by the AcqKnowledge data connection protocol but can be achieved implicitly by requesting a data 
connection be bound to a broadcast address. 

UDP delivery used fixed size datagrams. The default size is 512 bytes. Clients can modify this size to any fixed 
number of bytes prior to the start of acquisitions. The UDP packet size is stored in the template and is different for 
each graph. UDP clients that require a specific packet size should set that packet size prior to the start of  
each acquisition. 
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Each datagram will contain the following: 

Field Data Type Offset Description 

Starting sample 
index 

unsigned long 
(four bytes, 
network order) 

0 byte This indicates the starting sample position of the first sample of data 
contained in the packet. This number is always monotonically 
increasing and can be used to reassemble datagrams that are received 
out of order. 

This field is always stored in network order. Usage of htonl()/ntohl() 
should convert from network order into host endian. 

Length of data 
section in bytes 

unsigned long 

(four bytes, 
network order) 

4 bytes Total number of bytes in the data section. Data is sent by 
AcqKnowledge as it is available, so not all data packets will contain 
the same amount of data. 

This field is always stored in network order. Usage of htonl()/ntohl() 
should convert from network order into host endian. 

Data section (type and 
endian specified 
by client) 

8 bytes Data section containing the binary data that was acquired. The data is 
converted into the appropriate data as configured by the client. 

All of the data delivery is performed as data is available from the MP unit. The actual size of the data section in 
packets that get delivered to the client is dependent on the speed of data acquisition and other activity on the host 
computer. If variable sampling rates are being used, frames will not be split up. All of the data for the final frame is 
contained in the UDP packet. If a frame will not fit in the amount of space in a packet, it is sent in the next packet. 

There are no provisions for clients to request retransmissions of packets from the server. Clients should be aware that 
data may not be delivered when using UDP and should be prepared to examine sample indexes at the beginning of 
each packet and handle missing data accordingly (padding, warning user, etc.). 

The port on which datagrams is delivered is specified by the client prior to the beginning of acquisition on the control 
connection. Once the client specifies its port, it should begin listening for datagrams delivered to that port. The start of 
acquisition is signaled by the first datagram that is sent to that port. The sample index of the first datagram 
corresponds to the first hardware sample of data acquired by AcqKnowledge. If the graph is initially empty, the index 
is zero. 

Unlike TCP connections which get explicitly disconnected at the end of acquisitions, there is no direct messaging for 
UDP delivery indicating the end of acquisitions. Datagrams will not be sent to the client after the end of acquisition. 
Clients requiring explicit termination notification should either use TCP or implement a timeout mechanism combined 
with an XML-RPC getAcquisitionInProgress call on the control connection to locate the end of acquisitions. 

XML-RPC 

The XML-RPC “get most recent data sample” call will use standard XML-RPC connection semantics involving the 
client making an HTTP POST request to the server and interpreting the response as appropriate. Handling of XML-
RPC can be performed by a library in the client's appropriate implementation language. 

Real-time Delivery Guarantees 

No delivery time guarantees exist for any data connection. Data is delivered to the client as it becomes available. The 
overall latency of the system from physical sample time to data delivery is dependent on  a number of factors 
including network load, AcqKnowledge overhead (which is variable due to calculation channel processing time, user 
interface activity, thread scheduling, and other operations), system load, and other factors. The actual sampled data 
itself is guaranteed to be accurate; the sample time of a signal acquired into the hardware unit is always accurate.  
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It is only the time between the physical time corresponding to a sample and its delivery to the client application that is 
variable. 

Clients that require strict real time guarantees or more predictable latencies should investigate using the hardware API 
on their local machine. 

Data Formats 

It is assumed that the data transfer feature is used in a mixed host environment, potentially with clients running in 
environments that have restricted data types. The sampled information delivered by a data connection is allowed to be 
controlled to appear in a variety of different formats for the client: 

 64 bit floating point – This format will always be available for all channels and may be delivered in either big 
endian byte order or little endian byte order. This is equivalent to a C style double data type. 

 32 bit floating point – This format will always be available for all channels and may be delivered in either big 
endian byte order or little endian byte order. This data type is not native to AcqKnowledge, so the precision of 
received data may differ from data as recorded by AcqKnowledge. This is equivalent to a C style float data 
type. 

 Signed 16 bit integer – This format is available only for analog data channels. It may be delivered in either big 
endian byte order or little endian byte order. This is equivalent to a C style short data type. Clients receiving 
data in 16 bit integer format should use the control connection to determine appropriate floating point scaling 
factors that need to be applied to the data to convert into actual units. 

Data formats should be specified by the client prior to the start of acquisition. If left unspecified, the default data 
format depends on channel type: 

Channel Type Default Data Type 
Analog 16 bit signed integer, little endian 

Digital 16 bit signed integer, little endian 
Calculation 64 bit floating point, little endian 

XML-RPC get most recent sample requests will always return the double type of XML-RPC (in ASCII notation). 

Default Data Connection Settings 

If the client does not modify any data connection settings, the following is used: 

 Single connection transfer type 

 TCP/IP transport protocol 

 Port 15020 for single connection 

 For multiple connections, each channel type (16 channels per type) is set as follows: analog channels [15020-
15035], digital channels [15040-15055], calculation channels [15060-15075]. 

 Default data formats for each channel type as indicated in the “Data Formats” section 

Note that no channels are enabled for delivery by default. Both data connection delivery and get most recent sample 
tracking are disabled. Clients will still need to enable channels in order to receive data. 
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Locating AcqKnowledge Servers 

It is possible that clients and servers may be located on networks with dynamic IP addresses or other features that 
make establishing the connection between machines difficult. In this case, a simple UDP broadcast mechanism can be 
used to locate known servers. 

AcqKnowledge will listen for incoming UDP packets on port 15012. If the UDP packet contains the sequence of 
ASCII characters “AcqP Client” and only that sequence, it will send a broadcast packet containing “AcqP Server 
Port:” followed by the port number on which the server is listening for control connections. The port number is 
expressed in base 10 ASCII notation. 

It is possible to configure AcqKnowledge to not acKnowledge discovery requests for security purposes. 

Control Connections 

Clients connect to an AcqKnowledge server using control connections. A control connection allows the client process 
to control how data is going to be delivered to it, query settings, modify settings, and perform other basic operations 
without requiring graphical interaction with the AcqKnowledge environment. 

On the start of an acquisition, all data connections are established to the client that most recently established a control 
connection unless the client has modified the destination by using the  changeDataConnectionHostname command. 

It is possible to configure AcqKnowledge to not respond to any control connections for security purposes. 

The majority of all control connections use XML-RPC. The XML-RPC specification can be located at 
http://www.xmlrpc.com/spec. XML-RPC consists of an HTTP POST request being assembled by the client along 
with data content expressed in the XML-RPC notation. The remote procedure call will then return with an appropriate 
response to the caller. By design, XML-RPC is client and platform agnostic. 

XML-RPC implementations exist for a number of languages. If there is no implementation in the client's language, 
hardcoded requests can be embedded or a small helper application or shared library can assist in providing the control 
connection interface. 

The URI that should be used when connecting to the server is the recommended “/RPC2” for XML-RPC. For 
example, a URL for localhost control connections would be “http://localhost/RPC2.” 

TCP Port 

Only one control connection may be opened by a client to a server at a time. The server will listen on port 15010 by 
default. As this port may conflict with other network services or may need to be modified for firewall accessibility, 
AcqKnowledge will allow the server port to be modified by the user in the Display > Preferences panel. Clients should 
be aware that control connection port numbers are not fixed and should either allow users to change the port number 
from the client or use the dynamic discovery mechanism for locating AcqKnowledge servers. 

Control Procedure Calls 

Control procedure calls are remote procedure calls with a set method name and response. All method names and 
strings are case sensitive. The available control calls are roughly split up into querying acquisition parameters, 
configuring data delivery, and limited calls for modifying acquisition parameters and affecting application state. 

Channel Index Parameter Structures 

Some procedure calls take a channel index structure as a parameter. This is an XML-RPC structure that consists of 
the channel type and index. The channel type is a string member named “type” that is one of the following strings: 
analog, digital, calc. The channel index is an integer member named “index” and contains a zero-based index 
indicating the channel. For example, the following channel index parameter structure can be used to refer to calc 
channel 2 (recall, in AcqKnowledge calc channels are indexed from zero): 

<struct> 
 <member> 
  <name>type</name> 
  <value><string>calc</string></value> 
 </member> 

http://www.xmlrpc.com/spec�
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 <member> 
  <name>index</name> 
  <value><int>2</int></value> 
 </member> 
</struct> 

Querying Acquisition Parameters 

The calls for querying acquisition parameters are intended to allow clients to request information required for them to 
fill out appropriate parameters and to verify that previous control requests have been properly applied. The following 
control calls are recognized: 

getMPUnitType 

Method name: acq.getMPUnitType 
Parameters: None 
Return value: int 

 Retrieves the type of MP unit to which the server is connected. This may be zero (indicating no unit is 
connected, e.g. “No Hardware” mode), 150 (for MP150), or 36 (for MP36R). 

 The client can use this value to decide between appropriate templates to download or other channel settings. 

getEnabledChannels 

Method name: acq.getEnabledChannels 
Parameters: string 
Return value: array populated with int 

 Retrieves the channels that are available for acquisition and data delivery over a data connection to the client. 
The type of channels that are to be returned are specified in the string parameter. The string parameter may be one of 
the following: analog, digital, calc. The type must be lowercase. “analog” returns information about analog channels, 
“digital” digital channels, “calc” calculation channels. 

 The enabled channels are returned as an array of channel indexes, zero-based. These are the indexes that can 
be validly used in calls for configuring data connection parameters. 

getChannelScaling 

Method name: acq.getChannelScaling 
Parameters: channel index parameter structure 
Return value: struct containing scaling 

 For channels that can be delivered in short integer format, the channel scaling provides the scale factor and 
offset used to convert the short into physical units using the formula: sample*scale+offset. The scaling is returned as a 
structure containing two double-valued members: “scale” contains the multiplication factor, “offset” contains the 
offset factor. 

 Channels that cannot be delivered as short integers cannot be scaled. If this method is called with an invalid 
type of channel, a fault response is returned. 

getSamplingRate 

Method name: acq.getSamplingRate 
Parameters: None 
Return value: double 

 Returns the current sampling rate expressed in Hz. This is the rate at which data is sampled for a channel 
whose downsampling divider is 1. 

getDownsamplingDivider 

Method name: acq.getDownsamplingDivider 
Parameters: channel index parameter structure 
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Return value: int 

 Retrieves the downsampling divider for a particular channel. A channel is sampled at the base sampling rate 
divided by this factor. This factor is also used to determine which frames contain samples for this channel. 

Data Connection Configuration Commands 

While it is possible to configure data connection parameters using AcqKnowledge, frequently clients may need to 
alter data connection configurations based upon dynamic information regarding the machine on which they are 
running (e.g. port collisions with other services, unexpected endian changes, etc.). The following commands may be 
used to configure how data is delivered to the application. 

getDataConnectionMethod 

Method name: acq.getDataConnectionMethod 
Parameters: none 
Return value: string 

 Returns the method currently being used for data connections between the server and client. The string value 
is either: single, multiple. “single” corresponds to a single data connection being made between the server and the 
client with all data interleaved over that connection. “multiple” corresponds to opening an individual connection to 
the client for each channel. 

changeDataConnectionMethod 

Method name: acq.changeDataConnectionMethod 
Parameters: string 
Return value: 0 on success, or fault code 

 Changes the method used to deliver data to the client. The parameter is a string that is one of the following: 
single, multiple. “single” opens up a single data connection and sends data in an interleaved fashion. “multiple” opens 
up an individual data connection for each channel. 

getDataConnectionHostname 

Method name: acq.getDataConnectionHostname 
Parameters: none 
Return value: string 

 Returns the currently set hostname for data connections. When data connections are established on the start of 
acquisition, the IP address associated with this hostname is sent the data. Hostnames must properly resolve in order 
for data connections to be made; DNS configuration is outside of the scope of the network data transfer feature. 

 If this hostname is empty, data connections is made to the most recently connected client application. This is 
the default setting. 

 Hostnames are unique on a graph by graph basis and are saved in templates and graph files. Clients 
redirecting data to another machine should check and set the data connection hostname as appropriate prior to the start 
of acquisition. 

changeDataConnectionHostname 

Method name: acq.changeDataConnectionHostname 
Parameters: string 
Return value: 0 on success, fault on error 

 Changes the destination machine for data connections, the recipient of the network delivered data. If the 
parameter is an empty string, data connections will automatically be made to the most recently connected client. The 
empty setting is the default. 

 If non-numeric hostnames are specified as parameters, they must be resolvable. If a hostname cannot be 
resolved, a fault is returned. Proper DNS configuration of the server is beyond the scope of the network data transfer 
feature. 
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getTransportType 

Method name: acq.getTransportType 
Parameters: None 
Return value: string 

 Retrieves the transport type that is being used to deliver data from the server to the client. The transport type 
is a string that is one of the following: tcp, udp. Note that the XML-RPC data delivery method may be used in 
addition to this transport type if channels are enabled. 

changeTransportType 

Method name: acq.changeTransportType 
Parameters: string 
Return value: 0 if successful, else fault code 

 Change the transport type that is used to deliver data from the server to the client. The transport type is a 
string that has one of the following values: tcp, udp. XML-RPC last value data delivery may be used in addition to 
this type provided channels are enabled properly. 

getUDPPacketSize 

Method name: acq.getUDPPacketSize 
Parameters: None 
Return value: int 

 Returns the current size in bytes of UDP packets that is delivered to clients. Datagrams are always this fixed 
byte length although each individual datagram may contain varying amounts of data. 

setUDPPacketSize 
Method name: acq.setUDPPacketSize 
Parameters: int 
Return value: 0 on success, fault on error 

 Changes the size in bytes of UDP packets that are delivered to clients. Each individual datagram will always 
be this fixed length although the amount of data sent in specific packets may vary. 

getUDPBroadcastEnabled 

Method name: acq.getUDPBroadcastEnabled 
Parameters: None 
Return value: boolean 

 Determine if UDP packets are sent only to the client or are broadcast to the broadcast IP of the network. 
Broadcasting is supported only when the transport type is UDP. 

changeUDPBroadcastEnabled 

Method name: acq.changeUDPBroadcastEnabled 
Parameters: Boolean 
Return value: 0 if successful, fault code on error 

 Modify whether UDP packets are sent only to the client or are broadcast to the broadcast IP of the network. 
Broadcasting is supported only when the transport type is UDP. 

getSingleConnectionModePort 

Method name: acq.getSingleConnectionModePort 
Parameters: None 
Return value: integer 

 Returns the port number on which the server will connect to the client to deliver data. This port is used only 
when the connection mode is set to “single” which interleaves all data over a single connection. 
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changeSingleConnectionModePort 

Method name: acq.changeSingleConnectionModePort 
Parameters: integer 
Return value: 0 on success, else fault code 

 Modifies the port on which the server connects to the client to deliver data. This port is used only when the 
connection mode is set to “single” which interleaves all data over a single connection. 

getDataDeliveryEnabled 

Method name: acq.getDataDeliveryEnabled 
Parameters: channel index parameter structure 
Return value: boolean 

 Query whether a channel is enabled for data delivery. Channels must be enabled for data delivery in order for 
their data to be delivered to the client. Not all channels that are being acquired are required to be delivered to data 
delivery. 

changeDataDeliveryEnabled 

Method name: acq.changeDataDeliveryEnabled 
Parameters: channel index parameter structure, Boolean 
Return value: 0 for success, else fault code 

 Change whether or not data delivery is enabled for a particular channel. Data delivery can only be changed 
prior to the start of an acquisition. Changes to data delivery enabling are only applied on the next start of acquisition. 

getMostRecentSampleValueDeliveryEnabled 

Method name: acq.getMostRecentSampleDeliveryValueEnabled 
Parameters: channel index parameter structure 
Return value: Boolean 

 Query whether a channel is enabled for most recent data sample requests. If a client wishes to use the XML-
RPC calls to fetch the most recent value of data acquired of a channel, the channel must be enabled for this 
functionality prior to the start of acquisition. 

changeMostRecentSampleValueDeliveryEnabled 

Method name: acq.changeMostRecentSampleDeliveryValueEnabled 
Parameters: channel index parameter structure, Boolean 
Return value: 0 for success, else falut code 

 Change whether or not a channel is enabled for most recent data sample requests. When a channel is enabled, 
XML-RPC calls can be used during an acquisition to return the most recent sample of data acquired (or computed) for 
the channel. Any changes to the enabled state of a channel is applied on the start of the next acquisition. If a client 
wishes to use XML-RPC calls to read the value of a channel, that channel must be enabled prior to the start of the 
acquisition. 

getDataConnectionPort 

Method name: acq.getDataConnectionPort 
Parameters: channel index parameter structure 
Return value: int 

 Retrieves the port on which the server will deliver the data for the channel specified in the parameters to the 
client. Per-channel data connections are only used if the data connection method is set to “Multiple.” 

changeDataConnectionPort 

Method name: acq.changeDataConnectionPort 
Parameters: channel index parameter structure, integer 
Return value: 0 for success, else fault code 
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 Changes the port on which the individual connection is made by the server to the client to deliver the data for 
the channel specified in the parameters. This style of connection is used only if the data connection method is set to 
“Multiple.” 

getDataType 

Method name: acq.getDataType 
Parameters: channel index parameter structure 
Return value: structure 

 Returns the data type that is being used in the binary data streams for the channel's data. The return value is a 
structure with a type and endian member. The type member, named “type”, is a string and contains one of the 
following values: short, double, float. These strings correspond to their matching C-style data types. The endian 
member, named “endian”, is a string and contains one of the following values: little, big. “little” corresponds to little 
endian byte order, big endian bit order. “big” corresponds to big endian byte order, big endian bit order. 

changeDataType 

Method name: acq.changeDataType 
Parameters: channel index parameter structure, type structure 
Return value: 0 on success, or fault code 

 Changes the data type that is used for binary data streams of the channel's data. The type structure is a struct 
containing two members. The “type” member is one of the following strings: double, float, short. Each string 
corresponds to the matching C-style data type. The “endian” member is one of the following strings: little, big. Each 
corresponds to the matching byte endian. Bit order within a byte will always be big-endian. 

 Not all channels may be able to support all data types. If the channel cannot be transmitted in the requested 
data type, a fault code is returned. 

setDataConnectionTimeoutSec 

Method Name: acq.setDataConnectionTimeoutSec 
Parameters: integer of new timeout in seconds 
Return value: 0 on success, or fault code 

 Changes the timeout in seconds after which the data connections is closed when acquisitions complete. 
Clients may need to set this keep-alive timeout in order to receive the trailing data at the end of acquisitions. The 
default value is “0” seconds which terminates all data delivery connections immediately when the final sample of data 
is acquired. 

Reading Data During Acquisition 

Normally data is delivered to clients during acquisitions using data connections. Data connections are either TCP or 
UDP connections established from the server to the client over which the server streams the incoming data. In some 
languages and environments however, it may not be possible to handle continuous data streams. The following XML-
RPC commands are offered to assist these types of clients. Due to the large overhead of processing connections and 
XML-RPC requests, this data transfer type is not recommended and TCP/UDP should be used wherever possible. 

getMostRecentSampleValue 

Method name: acq.getMostRecentSampleValue 
Parameters: channel index structure 
Return value: double, or fault code 

 This procedure allows clients to read the most recent data value of a specific channel during acquisitions. In 
order for this call to be successful, a data acquisition must be in progress and the channel must be enabled for most 
recent sample value data delivery. Issue a changeMostRecentSampleValueDeliveryEnabled call prior to acquisition to 
allow this procedure to be used. 

getMostRecentSampleValueArray 

Method name: acq.getMostRecentSampleValueArray 
Parameters: none 
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Return value: array of structures with channel info and values, or fault code 

 This procedure allows clients to retrieve the most recent data values of all channels during acquisitions in a 
single call. If clients are interested in the values of multiple channels, using this method is more efficient than 
performing consecutive getMostRecentSampleValue calls (which require an individual POST request per call). 

 Only channels that are enabled for most recent sample value data delivery is returned. Issue a 
changeMostRecentSampleValueDeliveryEnabled call for each desired channel prior to acquisition in order for this to 
return the value for a channel. 

 The return value is an array of structures, one per channel. Each structure contains two members. The 
“channel” member will contain a channel index structure with members set to appropriate type and index information 
for the channel. The “value” member is a double that contains the most recent sample value of the channel specified in 
the “channel” member. 

 This procedure cannot be called unless there is an acquisition in progress and there is at least one channel 
enabled for most recent sample value delivery. 

 

Other Control Connection Commands 

Control connections will also allow for the following additional commands to be used by clients: 

loadTemplate 

Method name: acq.loadTemplate 
Parameters: base64 encoded binary AcqKnoweldge graph template 
Return value: 0 on success, or fault code 

 Attempts to open the passed template within the AcqKnowledge environment. The parameter is a base 64 
encoded AcqKnowledge “gtl” graph template file. Only templates in PC AcqKnowledge 3.7.1 or Mac AcqKnowledge 
graph templates are allowed to be used with this command. The parameter must include the entire contents of the 
template file. 

 The parameter in the XML-RPC call should be a base64 parameter with the raw binary contents of a graph 
template file. When this parameter is decoded, it should correctly provide the contents of a template file on disk. 

 This function will return 0 on success, otherwise a fault code if the template could not be loaded. Once a 
template is loaded, the hardware settings contained within that template is used for subsequent data acquisitions. 
Templates for ACQ 3.9.2 and higher will retain any data connection settings that have been specified by clients. After 
loading a template, clients should re-send any configuration information for ports and data connection methods if they 
do not match the new settings from the template. 

 If the template data is corrupted or is incompatible with AcqKnowledge, user interaction may be required on 
the server computer to dismiss any error messages when attempting to load the template. If user interaction is required 
on errors, this call may not return until the user interaction has completed. Clients who are using XML-RPC bindings 
that offer timeout services may wish to use them with this function. 

getAcquisitionInProgress 

Method name: acq.getAcquisitionInProgress 
Parameters: none 
Return value: Boolean 

 Query whether data acquisition is currently in progress or not. A value of true is returned if data acquisition is 
occurring in any open AcqKnowledge graph window. 

toggleAcquisition 

Method name: acq.toggleAcquisition 
Parameters: none 
Return value: 0 on success, else fault code 
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 Toggles data acquisition in the frontmost graph. If data acquisition is in progress, it is halted. If none is in 
progress, data acquisition is started in the graph. 

 Note that this function invocation may block if physical user interaction is required to start the acquisition in 
the graph, such as dismissing an overwrite warning, warnings on incompatibilities between different MP unit types, 
specifying a save location for acquisition to disk, etc. If the implementation of the XML-RPC binding used by the 
client supports timeout capabilities, it is highly recommended to enable timeouts for this function. 

setOutputChannel 

Method name: acq.setOutputChannel 
Parameters: channel index structure, float output value 
Return value: 0 on success, else fault code 

 Changes the voltage on the specified output channel of the MP device. For analog outputs, the value should 
be in the range (-10, 10) for the voltage level. For digital outputs, a value of 0 will turn the specified line off, a non-
zero value will turn it on. The latency of when the output line is changed is variable and non-guaranteed. Additionally, 
the output channel may be modified by other areas of the software including control channels, manual user 
intervention, configured stimulators, etc. 

The valid output channels are dependent on the type of MP device that is connected.  

 MP150 units allow analog 0, 1 and all digital output channels 

 MP36R units allow no analogs and digital 0-8. 
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Chapter 22 Licensed Functionality: Vibromyography 
VMG functionality is available through an optional license available with AcqKnowledge 4.1.1  
or above. The VMG license must be authorized to access VMG functionality. To add a VMG 
license to an existing MP System, please contact BIOPAC.  

The vibromyography transducer (TSD250) uses an accelerometer to measure surface vibration 
during activity which is directly correlated to muscle activity; this allows for muscle force and 
balance to be assessed without using surface electrodes or needle probes. The VMG license allows access to software 
processing algorithms that are incorporated into AcqKnowledge to perform data reduction for analysis of data 
collected from a VMG system.  

The VMG license: 

 adds “Vibromyography” Calculation channel Preset with required scaling and calibration  

 adds “Vibromyography Filter” option under the Analysis menu 

 includes QuickStart Q45 Vibromyography (.gtl format)—the journal of the file introduces VMG and the 
hardware settings use Module Setup to add a “VMG Transducer” to analog channel 1 and analog channel 2 of 
an HLT100C module. Two calculation channels are set to the “Vibromyography” preset using analog channel 
1 and analog channel 2 as the respective source channels. 

The VMG analysis reduces the channel sampling rate by a factor of 32. In the AcqKnowledge software, all data in an 
individual waveform share the same acquisition sample rate and each channel may have a lower sample within certain 
parameters, see (link for variable rate sampling ). It is not possible to mix sampling rates within a channel. This 
analysis is preformed for the entire channel or appended segment (see VMG and append on page 46x). Traditionally, 
if there is only a single point selected, then the entire data channel is transformed. If only a portion of the wave is 
selected, then the following warning will be displayed: 

 
When OK is clicked, analysis will be performed on the entire waveform. The selected area will be maintained but the 
waveform regions outside the selected area will still be transformed. This matches the “Transform entire wave” 
checkbox operation of other transformations. Cancel exits without modifying the data. 

Sampling Rate Restrictions 

The Vibromyography Filter is designed to process data acquired at 2 kHz sampling rate only. If the correct 
sampling rate is not used (via Hardware menu > Set Up Data Acquisition > Length/Rate), results may be 
unpredictable. 

Transducer Setup  

The TSD250 VMG transducer is a MEMS accelerometer transducer used for recording vibromyography signals 
from major muscle groups. 

 MP150: Activating the VMG license adds the “VMG Transducer” option to the MP150 module setup; it 
is an HLT100C high level transducer. 

 MP36R Support—the MP36R system may be useful for VMG analysis as four channels allows for 
comparison of muscle balance between two muscle groups. No analog channel preset exists for the VMG 
transducers, but a Vibromyography preset exists for the calculation channel. See page 482. 
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Post-Analysis Selection Adjustment 

After the analysis completes, the waveform sampling rate of the selected waveform will be reduced by a factor of 
32. As this reduction occurs, the selected area or cursor will adjust to the nearest sample point in the processed 
VMG channel. 

Data Modification History Name 

This operation will be displayed in data modification logs (Display > Channel Info) as “VMG Analysis.” 
It will not have any parameters. 

VMG Calculation Channel Preset 
The Vibromyography calculation channel preset uses the VMG channel as its source channel. The calculation 
channel preset automatically applies a downsampling divider of 32 based on the acquisition sampling rate.  
 The Vibromyography preset automatically adjusts the channel sampling rate by a factor of 32. After 

setting up the Vibromyography calculation channel, adjusting the channel sampling rate for the VMG 
source channel will not change the sampling rate of the Vibromyography calculation channel. The 
channel sampling rate can be manually adjusted. 

At the end of an acquisition, the Vibromyography preset automatically performs the following steps: 
1. Checks for the Vibromyography license. If the license is not found, then the appropriate prompt is 

displayed. 
2. Checks if acquisition is running in append mode. If this is the case then additional parameters are checked 

and the user will be prompted as needed. 
3. Perform Vibromyography Analysis filtering. 
4. Adjust selection to highlight only the most recently acquired data segment. If not in append mode, all data 

will be selected. 
5. Copy the processed data to the clipboard. 
6. Select the destination calculation channel. 
7. Paste processed data from clipboard over the zero valued data for the appended segment (or entire 

channel if not in append mode). 
8. Remove the duplicated channel created earlier. 
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VMG Sample Data Files 
Two sample data files illustrating basic VMG data and analysis results are included: 
 VMG right leg VL dynamic isometric.acq 

 
 

 VMG Squat Data.acq 

 
 Watch the AcqKnowledge Vibromyography video tutorial for a detailed demonstration of this feature. 

http://www.biopac.com/video/?video_category=hardware-tutorials&v=vibromyography-solutions-from-biopac-english�
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Chapter 23 Licensed Functionality: Scripting 
Scripting functionality is available through an optional license available with 
AcqKnowledge 4.1.1 or above. The Scripting license must be authorized to access Script 
functionality for executing, authoring, and debugging BIOPAC Basic scripts. To add a 
Scripting license to an existing MP System, please contact BIOPAC. 

Scripting is available for Windows Vista and Mac OS X 10.5 or above and also requires 
Qt SDK 4.5.0 or higher for rich dialog development. 

BIOPAC Basic Scripting is a scripting language development option for AcqKnowledge that allows for viewing 
of runtime variables, creating new script files and editing existing script files, triggering of individual script functions 
for testing and single step functionalities. Only users that have licensed the BIOPAC Basic feature may run user-
generated scripts; if the feature is not available only digitally signed BIOPAC scripts may be executed. Scripting is 
available in any hardware supported in AcqKnowledge but configuration commands may not be available for non-MP 
hardware. 

 
 
The Scripting license  
 enables the Script menu 
 adds the Calculation channel Preset “Run Macro” 

 links the BIOPAC Basic Reference under Help 
 adds Preferences for Scripting
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Scripting Menu  

 
Script Editor 
The Script Editor is the window used for creating and editing scripts. The window appears blank by default 
unless an existing script file (*.bbs) is selected or a new script is created.  
To create a new script in the Editor, select New Script File from the “Script file:” menu. 
To open any of the existing AcqKnowledge Specialized Analysis scripts, choose Open Analysis Script from 
the “Script file:” menu and select the desired script file. 
Script Editor formatting is controlled in the Script Editor Preferences (Display > Preferences > Script Editor). 
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Variables Explorer 

 
Variables Explorer Window 

The Variables Explorer window (Script > Variables Explorer) shows the contents of the scripting language 
variables. 
Single Step Execution mode (Script > Single Step execution) halts execution after each individual line of a 
macro, which allows for stepping through macros line by line for debugging and development purposes.  
Example Scripts 
Several BIOPAC example scripts and macros are available in this menu. When a script file is selected, the 
scripting language for the selected script is displayed in the Script Editor. 

Run Macro Calculation Channel 

 
Run Macro Calculation Channel Setup Dialog 

The “Run Macro” Calculation Channel Preset enables automatic post-processing at the end of acquisition. 
Note 

 Inserting an extra End in the middle of the macro creates a second macro upon saving. The second 
macro starts immediately after the inserted End. 

 Run Macro calculation channels created with a licensed version will run if opened in a copy of 
AcqKnowledge without a Scripting license, but the macro cannot be edited. 
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To view the full online BIOPAC Basic Reference Scripting Manual, see the AcqKnowledge Help menu. 

 
 

 
 

More Scripting References 
For more information about creating user-defined scripts for automated analysis routines, see the Tutorial 
Video. 

Preconfigured scripts for automated routines may also be downloaded from BIOPAC here. 

 
 

 

http://www.biopac.com/script/adding-scripts-to-acqknowledge-analysis-menus/�
http://www.biopac.com/script/adding-scripts-to-acqknowledge-analysis-menus/�
http://www.biopac.com/scripts/�
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Chapter 24 Licensed Functionality: Remote Monitoring 
Remote Monitoring functionality is available through an optional license available with 
AcqKnowledge 4.2 or above. The license must be authorized to access Remote Monitoring 
functionality. To add a license to an existing MP System, please contact BIOPAC. 

 

  
AcqKnowledge MP devices are generally tethered to specific computers where data acquisition is performed. 
In some laboratories, this computer may not be in the same location as the researcher performing the 
experiment. In MRI situations, for example, the data acquisition computer may be in the MRI control room 
but the researcher may be in a separate area. AcqKnowledge Remote Monitoring offers researchers the 
capability of checking on critical parameters from an alternate location. 

Remote Monitoring is a client/server application capable of locating and connecting to computers running 
AcqKnowledge on the same network. It consists of a simple browser interface, from which acquisitions can be 
started, stopped and remote data viewed during and post-acquisition. Remote Monitoring is supported in 
MP150 hardware only. 
About Remote Monitoring 
 Remote Monitoring is licensed functionality and must be activated by BIOPAC. 

 Remote Monitoring is for viewing of data only. Transformation and specialized analysis of graph data 
is not supported within the Remote Monitoring interface. 

The Remote Monitoring web interface consists of three primary pages:  

 A list of open graph windows 
 Configuration settings for an individual graph 
 The data monitoring page. 

Remote Monitoring in AcqKnowledge Networking Preferences 
Remote Monitoring is enabled by default in 
AcqKnowledge Networking Preferences (Display > 
Preferences > Networking > Remote Monitoring). The 
Enable remote monitoring checkbox option activates 
the local machine on the network, making it visible to 
other local network machines also running 
AcqKnowledge Remote Monitoring.  

The Webserver TCP port is the numerical port on which AcqKnowledge listens for remote requests. (This 
port is set to 8080 by default.) The Remote monitor URL is a clickable link that opens Remote Monitoring 
in the local machine’s default web browser. This view will display acquisitions running on the local 
machine only. (This is actually an easy way to become familiar with Remote Monitoring). To view 
acquisitions running on machines in other network locations, the stand-alone Remote Monitoring Client 
application must be used. For further details, see the Remote Monitoring Client section on the following page. 

NOTE If a Remote Monitoring preference or port setting is changed, the new preference will not be applied 
until the subsequent AcqKnowledge application launch. 

New! Remote Monitor 
Track the welfare of the subject with alarms to 
warn when signals fall out of range. The system 
will work on any device that has access to the 
same IP based network as the MP150. 
Simplified user interface to view subject data on 
another computer or mobile device – ‘bedside 
monitor’ display.  
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Remote Monitoring Client 
The Remote Monitoring Client is a stand-alone application residing in the AcqKnowledge program folder. 
This application facilitates the remote connection to other computers running AcqKnowledge acquisitions on 
the local network. AcqKnowledge does not need to be running on the local machine in order to use the 
Remote Monitoring Client to observe remote acquisitions in progress. To launch the Client, browse to the 
following directory: 

Main Drive:\Program Files\BIOPAC Systems, Inc\AcqKnowledge 4.2\RemoteMonitorClient.exe 

 
Double-click on the RemoteMonitorClient.exe to launch the application. After launching, the first presented 
item is the Remote Monitoring Server list. This is a list of other AcqKnowledge computers on the network 
that have Remote Monitoring enabled. 

  
Quit  Exits Remote Monitoring Client 
Refresh List Updates list of available AcqKnowledge Remote Monitor computers on network 
Connect Connects to the computer selected in list 

The above-right figure shows a right-click contextual menu available within the Remote Monitoring Server 
List, which allows an alternate means of connecting to a selected computer. The Properties option displays the 
AcqKnowledge application status, along with network and hardware information about the selected computer. 

Remote Monitoring Client Browser 
Selecting a computer from the list launches the Remote Monitor Client browser interface. The navigation 
buttons operate in the same manner as most Internet browser controls. See the following page for details on 
the Remote Client browser buttons. 
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Icon Button Function Explanation 

 Back Moves browser back one page 

 Forward Advances browser ahead one page 

 Refresh Reloads the current page 

 Stop Stops loading of current page 

 

Address bar Displays I.P. address of currently-connected computer 

 Zoom in Master control for enlarging size of browser content 

 Zoom out Master control for decreasing size of browser content 

 

File, Edit, Help 
menus 

File contains Page Setup and Print controls for 
Remote Monitoring chart displays. Quit exits the 
Remote Monitor. 

Edit contains a Copy option. (Copy function not 
supported in Windows version) 

Help displays “About” information for the current 
version of Remote Monitoring Client* 

NOTE for Windows only: 

In order for the Remote Monitor Client to properly display the server list of additional AcqKnowledge 
computers on the network, Bonjour Service for AcqKnowledge must be installed. (The option of 
installing Bonjour Service is presented during the licensed AcqKnowledge 4.2 application 
installation). If Bonjour is not installed, the following dialog will be presented upon launch of the 
Remote Monitoring Client: 
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The I.P. address of the desired computer can be entered into the http-address field. If the address is 
valid, clicking OK will connect the Remote Monitoring Client to this computer. An acceptable entry 
should include the server IP address and UDP port number. (Example; http://192.168.1.76:8080) 

Open Graphs Page 
When the Remote Monitoring Client browser is launched, a scrollable list of all graph windows currently 
open on the selected remote machine is presented. Only one graph may be selected at a time. 

 
Refresh this page Reloads the page and refreshes the list of available graphs. 

Show Monitor  Advances the browser view to the selected file’s setup page. 

Configuration Settings Page 
After selecting a graph and clicking Show Monitor, the following Monitor Setup page is displayed. This page 
contains configurable options for data display and other viewable parameters in the Remote Monitor graph. 
Note that all available options are set individually per channel. 
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Control Description 

Return to Graph List Returns browser to list of currently-open graphs. Serves the same function as the 
browser’s ‘back’ button. 

Show Monitor Saves the selected setup and advances the view to the data monitoring page. 
(‘Show Monitor’ button at bottom of screen duplicates this link’s function) 

Auto-refresh interval Chooses the interval at which the monitored data is being refreshed over the 
network. The increments range from 1-sec. to 5 minutes. 

Use audible alarms When enabled, an alarm will sound if the Remote Monitoring graph data display 
exceeds its maximum or minimum visible ranges. The audio sound is a one-
second beep followed by one second of silence. This audio playback is supported 
only on HTML5 compliant browsers.  

Label Displays assigned label of the AcqKnowledge data channel 
Show Trend Displays a graphical plot of the currently monitored data. 

Show Most Recent Value If checked, the most recent value of the channel data is displayed in a large font. 
If unchecked, textual display of this value is omitted. 

Show Min/Max Displays minimum and maximum value of currently monitored data. 
Alarm Enabled If the channel value exceeds the current trend display range, the alarm changes 

the color of the textual display to red and optionally plays audio. 
Precision Sets number of decimal places following channel display values. 

Data Monitoring Page 
After the desired channel setup parameters are selected, choosing ‘Show Monitor’ will advance the view to 
the data monitoring page. 

 
If an AcqKnowledge acquisition is already in progress and data being plotted, the screen will appear similarly 
to above, with the graph plot tracing at intervals determined by the Monitor setup auto-refresh rate. If the 
acquisition has not been started prior to launching Remote Monitoring; the Start button will be displayed in 
this screen. (Remote acquisitions can be easily started or stopped from within this data monitoring page). 
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Control Description 
Return to Graph List Displays scrollable list of all currently-open graphs. 

“-“ and “+” Controls for decreasing and increasing size of the input values display font. 
Reset Resets size of input values font display to default setting. 

Show Monitor 
Settings 

Returns to the “Monitor Setup” page for adjusting refresh rate, display options, and 
other monitoring parameters. 

Start/Stop  Toggles between starting/stopping acquisition in Remote Monitoring graph. 
Refresh Now Updates data and controls on Monitoring page. 
Stop Alarms Halts any audio alarms that may be playing. Active only if Audio Alarm option is 

enabled. 
Plot Controls visual display of Min, Max and Mean values display of current graph 

Change Range Allows adjustment of visible ranges of the chart, similar to the vertical and horizontal 
scale dialogs found in the AcqKnowledge application. This is useful for viewing data 
that may otherwise appear out of range of the default scaling. Change Range only 
affects the data display in the Remote Monitoring window, not in the actual 
AcqKnowledge graph data. (See below for Change Range example and further details). 

 

  
Default Visible range. (Note BPM data from this graph is ‘out of range’ in the above chart) 

  
Visible range is modified via ‘Change Range’ to include entire data set. Horizontal time scale and vertical divisions 

were also modified. 
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Controls in Visible Range (Change Range) dialog 

Control Description 
Return to Monitor page Clickable link for paging back to the Monitoring screen. 
Show seconds of data Determines visible horizontal time scale in chart display. 

Number of horizontal divisions Sets the number of horizontal divisions in chart. 
Horizontal axis precision Sets number of decimal places following horizontal time values. 
Vertical lower endpoint Determines low end of vertical graph scale. 
Vertical upper endpoint Determines high end of vertical graph scale. 
Number of divisions  Sets the number of vertical divisions in chart. 

NOTE: Remote Monitoring plots are only updated in the data monitoring window while an acquisition is 
in progress. Once a Remote Monitoring acquisition is stopped, the graph will remain visible only as 
long as the browser page is displayed. After navigating away from the page, the plot will not be 
retained or reconstructed. To save a Remote Monitoring plot for future reference, printing a hard 
copy or printing to a PDF file is recommended. 

*For Remote Monitoring technical support, contact BIOPAC Systems, Inc at (805) 685-0066 or 
support@biopac.com 

 

mailto:support@biopac.com�
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Chapter 25 Licensed Functionality: B-Alert 
B-Alert functionality is available through optional licenses* available with AcqKnowledge 4.2 
or above (B-Alert wireless headset hardware is also necessary).  
 * B-Alert Headset integration: must be authorized to access basic B-Alert functionality. 

 * Cognitive States Analysis: must be authorized to access this enhanced functionality. 

To add licenses please contact BIOPAC. 

The B-Alert Hardware Data Acquisition license adds: 

 Basic wireless recording of up to nine channels of raw or decontaminated EEG data 

The Cognitive States Analysis Software license adds: 

 Functionality described above, plus the ability to create individual baseline recordings for each 
subject 

 Additional analysis software and specialized calculation channels 

 
Data Acquisition and Analysis with B-Alert™ 

 
B-Alert™ X10 is a Bluetooth wireless system and sensor headset integrated with AcqKnowledge software to 
record up to 9 channels of monopolar EEG, plus one optional channel of ECG data. B-Alert data can be 
acquired simultaneously with BIOPAC MP150 Hardware, if additional graphs are used.  

IMPORTANT NOTE: In AcqKnowledge for B-Alert: 
 B-Alert is licensed functionality and must be activated by BIOPAC 
 Analog channels can be toggled on/off but not modified 
 Digital channels are not supported 
 B-Alert-specific calculation channels are available when the optional Cognitive 

States Analysis software license is applied (AcqKnowledge calculation channels C8 
and higher can be used if configured manually) 

 Data acquired with B-Alert is outputted in standard BIOPAC *.acq format 
 

B-Alert™ users should refer to the B-Alert X10 User Manual for complete hardware setup instructions. This 
guide, and other B-Alert material can be found on the BIOPAC Manuals Support page. 

http://www.biopac.com/LabManuals.asp�
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AcqKnowledge software is used to view, record and analyze data acquired with the B-Alert unit. 
To launch software with B-Alert hardware: 

1. Connect the B-Alert dongle to a USB port and turn the X10 headset unit’s power switch ON. 
2. Choose B-Alert device from the AcqKnowledge Startup Wizard Hardware menu or from the 

‘Connect to > Add New Device’ menu in the application window. (See figures below.) 
3. Use the B-Alert menu options for acquisition and channel settings.  

 

 
OR: 

 
 
When AcqKnowledge launches in B-Alert mode, the MP menu will be replaced by the B-Alert menu and the 
B-Alert device ID will appear in the AcqKnowledge graph “Connect to” menu. 

 
If the B-Alert device cannot be located or is disconnected, the following dialog will appear: 

 
Click ‘Retry’ in the B-Alert Headset Warning dialog to initiate a refresh of the hardware connection.  

 
With B-Alert installed, an additional 

“B-Alert Live” shortcut icon will 
appear on the Desktop. To use B-

Alert with AcqKnowledge, initiate all 
B-Alert actions from within the 

AcqKnowledge software interface as 
shown in this chapter. For further 

information about B-Alert, see the B-
Alert Software Manual. 
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Click ‘Cancel’ in the B-Alert Headset Warning dialog to launch the AcqKnowledge software in analysis 
mode. This operates similarly to MP150/36R “no hardware” mode, for which data can be analyzed and 
transformed but not recorded. 

Acquisition Setup 
Standard recording modes found in MP150/MP36R hardware (with the exception of Averaging) are 
supported in B-Alert but the acquisition sample rate is limited to a maximum of 256 samples per second. 
Dependent upon licensing level, there are two additional checkbox options in the B-Alert Set Up Data 
Acquisition > Length Rate dialog: 

• Record EEG artifacts as events: When checked, recorded EEG artifacts are translated into 
visible events (eye blinks, EMG interference, etc.). When unchecked, artifacts are discarded and 
only data is acquired. 

• Use B-Alert Definition File: When checked, enables use of a subject’s baseline Definition File. 
This option is only available if the Cognitive States Analysis license is applied. See page 501 for 
a detailed explanation of Definition File setup in AcqKnowledge. 

Channel Setup 
Nine analog input channels of monopolar EEG data are enabled by default in B-Alert, along with one optional 
ECG (EKG) channel. Channels are configurable as desired. In the standard B-Alert setup, calculation 
channels C8 – C15 remain available for additional online transformation/filtering of data (for C0-C7, see page 
504). (Digital channels, stimulation or triggering are not supported in B-Alert hardware.) 

 
 
Under the standard B-Alert license, the Input channel setup contains options for recording raw or 
decontaminated EEG data. These parameters are set individually per channel. It is possible to record raw data 
on one channel and decontaminated data on another. 

• Record raw data: records unfiltered data. Any further filtering must be applied through 
calculation channels or transformations. (Default setting) 

• Record decontaminated data: filtered data will be recorded for the channel. This setting applies 
algorithms to minimize artifact resulting from eye blinking or other small involuntary 
movements. 

The optional B-Alert Cognitive States Analysis license offers additional functionality, such as creation of a 
baseline “Definition” file (based upon a subject’s responses to some simple cognitive tests), and access to pre-
configured calculation channel setups. 
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B-Alert-specific Hardware Menu Options   

 
B-Alert Headset Check Impedance  

This item is found in the B-Alert menu, (which 
replaces the MP menu in B-Alert hardware 
configuration) and is used to initiate an 
impedance check to verify the headset’s 
electrode contact quality. Results and 
resistance values are displayed in the dialog 
when the check is complete. If any of the 
channels fail the impedance check (as shown 
on Channel Fz on the right), verify that 
electrodes are firmly attached and making good 
contact, and then rerun the check.  
B-Alert Headset Benchmark Session 
Requires Cognitive States Analysis license 

Use to set up an “Alertness Memory Profile” 
(AMP) Baseline recording of a subject’s EEG 
definition file. The baseline (Benchmark) 
recording consists of a three-choice 
psychomotor vigilance task (3CVT) and eyes 
open/eyes closed. 
Subject: Field for 4-digit identifier unique to 
subject being recorded. 
Group: Field for single-digit identifier used to 
distinguish the subject’s group number. 
Iteration: Field for single digit identifier 
identifying the session, if additional Baseline 
sessions are recorded for a subject. 
ABM Benchmark scenario: Choose the type 
and length of the baseline recording. The 
following recording lengths are supported:  

• Short Benchmark – 3CVT (three-choice 
Psychomotor Vigilance Task, 3 minutes 
per task) 

• Medium Benchmark – VPVT (Visual 
Psychomotor Visual Task, 5 minutes per 
task) 

• Long Benchmark – APVT (Auditory 
Psychomotor Vigilance Task, 20 minutes 
per task)  

After setting up the required fields, click OK to 
launch the baseline recording user interface, 
which will resemble the example to the right. A 
series of onscreen step-by-step instructions will 
follow. 

 

 

 

 
For more details about the Benchmark recording user 
interface and additional software controls, refer to the 
Benchmark section of the B-Alert Software Manual. 
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B-Alert Generate Definition File 
Requires Cognitive States Analysis license 
Use this option to generate or recreate a 
definition file from a previous Headset 
Benchmark session. 

After completing a Benchmark session (see 
previous page), a definition (.def) file is 
automatically generated and saved to the 
subject folder. This *.def file is used to generate 
the Benchmark Report file. If the *.def file needs 
to be recreated, the "B-Alert Generate 
Definition File" option can be used. Note: The 
previous Benchmark Signal *.edf and all 
baseline Events *.edf files must be located 
within the same folder, and have the same 9-
digit number for a definition file to generate 
properly. Follow the steps below to create a 
definition file: 

1. Choose “B-Alert > B-Alert Generate 
Definition File.” 

2. Click “Select Source Files…”. 

3. Navigate to the desired folder 
containing the Benchmark session 
*.ebs “Signal” file. 

4. Select the *.ebs “Signal” file and click 
“Open.” 

5. Select the “Event” (*.edf) files (a 
minimum of three must be selected) 
and click “Open.” 

6. Click “Generate” to create the new 
definition file and report and save them 
to the Benchmark destination folder. 
Once created, the individualized .def 
file can be reused across sessions (for 
Cognitive State and/or Workload Metric 
classifications) for a given individual.  

7. See page 501 for further details about 
using and assigning a definition file.  
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B-Alert ESU Configuration 
The B-Alert ESU unit is a multi-channel external 
synchronization unit that serves as a 
communication interface between the B-Alert 
unit and the computer. It allows for 
synchronization of data between the B-Alert 
hardware and other third-party data acqusitition 
devices.  
For more information about the B-Alert ESU 
unit, see the B-Alert with AcqKnowledge Quick 
Guide or the B-Alert Software Manual. 

NOTE: Before configuring the ESU settings, the ESU 
must be paired with the B-Alert unit via a Bluetooth 
connection. 

• B-Alert headsets are shipped paired to either a 
B-Alert Dongle or an ESU. If the pairing is lost, 
the devices must be re-synced using the “Sync” 
option in the B-Alert Live software’s “Operations” 
menu. For more information, see the “Sync 
Device” troubleshooting section in the B-Alert 
with AcqKnowledge Quick Guide or the B-Alert 
Live Software Manual. 

To Configure the ESU in AcqKnowledge: 

1. Plug the ESU unit into a computer USB port. 

2. In AcqKnowledge: choose B-Alert > B-Alert ESU 
Configuration. 

3. In the ESU Control Panel, use the pop-up menus 
to configure ESU third-party data (three serial 
COM ports and one parallel port) as desired (see 
below). 

 
4. Click “Save config to ESU unit” to save the 

settings. 

5. Wait until the “saved configuration” confirmation 
dialog appears. Restart the ESU by unplugging it 
and then re-plugging into the computer’s USB port. 

B-Alert Show Brain State Gauges  
Requires Cognitive States Analysis license 
activation 
Displays real-time views of B-Alert headset data 
as it is being acquired. Information includes 
Meter Gauges (Top Left) with Engagement, 
Workload and Drowsiness (along with Heart 
Rate) Time Series (Bottom) Movement Meter 
Gauge (Bottom right) Heat maps (Top Right) 
display EEG power spectral densities (PSD) in 
both spatial and temporal maps for the 
traditional Hz bands (Beta, Alpha, Theta, 
Sigma). 
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Assign Definition File  
Requires Cognitive States Analysis license activation 

 
The Definition File is created when the subject undergoes an initial baseline EEG recording while responding 
to some simple onscreen tests, or can be recreated from an existing Benchmark session via the “B-Alert 
Generate Definition File” menu item. (The Definition File setup is configured in the B-Alert Headset Amp 
Baseline dialog, referred to on the previous pages). The file is saved to the directory containing the subject’s 
B-Alert profile folder. Once created, a subject’s Definition File will always be referenced for subsequent 
recordings and analysis. 
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Output to ABM File Format  
Acquisition setup options are available for controlling data output to a separate B-Alert ABM file format, 
which contains an “*.ebs” extension. Outputting to *.ebs format can be useful for preventing raw EEG data 
from being overwritten while recording in decontamination mode. (AcqKnowledge does not save the original 
raw EEG data within the default *.acq file format if the decontamination option is applied.)  To access these 
output options, open B-Alert > Set Up Acquisition, and choose “Choose ABM data file location.” 

  
The following options will be presented: 

• No output into ABM format: 
 Data files will be outputted in AcqKnowledge *.acq format only. No external B-Alert *.ebs output 
 created. 

• Output data into ABM data file at: 
 The ABM raw data file is outputted to the default file path, or a user defined path can be selected.  

 
When the above “Output data into ABM data file at” option is selected, the full ABM *.ebs data file path 
and file name will appear in the Acquisition Setup dialog after clicking OK. (See example figure below.) 

 
Other B-Alert Setup Options are: 

• Record B-Alert EEG artifacts as events: 
When this option is selected, artifacts appearing in the B-Alert data (i.e., eye blinks) will be assigned 
event markers as these artifacts are detected during the recording. B-Alert events can also be 
manually assigned to recorded data while in progress or in post-acquisition analysis by using the 
Event tool . For more details on the AcqKnowledge event marking system, see page 215. 
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Event types supported for B-Alert recordings 

• Use B-Alert Definition File: 
When this option is selected, the Benchmark definition file will be used for the recording (requires 
Cognitive States licensing level).  

• Assign Definition File: 
Use this option to navigate to and select a different definition file for the recording. 

Opening the ABM Data File 
The outputted ABM *.ebs format data file can be opened in AcqKnowledge by choosing File > Open, 
browsing to the file location and selecting “EDF” format from the file type list. For a complete list of 
outputted ABM data see the Data Output table on page 505. 

NOTE: Even though the file extension in the output dialog appears as “*.ebs”, the file will open in 
AcqKnowledge by choosing “EDF” format. 
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Linked Acquisitions in B-Alert 
Linked acquisitions are supported in B-Alert. In a Linked Acquisition session, different hardware device types 
can acquire data simultaneously into individual graphs. B-Alert acquisitions can be synchronized with and 
triggered by an MP150 unit and the multiple data recordings merged into one graph at the end of the session.  
NOTE: In order to use “master synch device” mode to link signals between B-Alert and MP150 hardware, a 
CBLX10 cable is necessary. See the MP Hardware Guide for more CBLX10 details.  
To connect the CBLX10 for an MP150/B-Alert linked acquistion: 

1. Plug the black connector into an Analog Output on the UIM100C module connected to the MP150. 

2. Plug the blue connector into the 2-pin (ECG) input on the top of the B-Alert unit. 

3. In AcqKnowledge, choose “MP150 > Set Up Data Acquisition > Set Up Linked Acquisitions” and 
select “Use the master synchronization” as the synchronization method to pair and synchronize data 
obtained during linked MP150 and B-Alert X10 acquisitions. This is the only configuration where the 
“Master Sync Device” radio button is active. 

IMPORTANT: About 10-12 seconds after starting a linked MP150/B-Alert X10 acquisition, and verifying 
that both independent signals are being plotted correctly in AcqKnowledge, disconnect the CBLX10 from the 
B-Alert headset to avoid introducing extraneous noise into the B-Alert signal. 

For further details on setting up Linked Acquisitions, see page 235 or watch the Tutorial video. 
Cognitive Analysis Calculation Channels 
Pre-configured calculation channels C0 – C11 become available when a subject’s B-Alert Definition File is 
active. These signals are mapped from the Definition File and extract cognitive workload, high/low 
engagement, distraction, drowsiness, movement and tilt angle data. The channel setups and presets are not 
editable but can be enabled or disabled as desired. 

 
For specific information on additional B-Alert GUI software controls, see the B-Alert Software Manual. 

http://www.biopac.com/video/?video_category=acqknowledge-new-features&v=linked-acquisitions-in-acqknowledge�
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Data Output 
The following data is collected during a B-Alert experiment and merged into a standard AcqKnowledge *.acq 
file: 

Real-Time Output file name Description 

Data file 
.edf European data format containing nine raw and nine decontaminated 

EEG channels, raw ECG channel, plus derived heart rate, head 
movement value and head movement level  

_Impedance.csv Lists the values obtained for each channel each time impedance was 
measured  

Automatically Generated during Acquisition – for all EEG Channels 

_Ref_Raw.csv Absolute PSD from 1 to 40 Hz, relative PSD from 1 to 40 Hz, and EEG 
bands labeled by channel (no edge-effect window) 

_Ref_Class.csv Absolute PSD from 1 to 40 Hz, relative PSD from 1 to 40 Hz, and EEG 
bands labeled by channel (with Kaiser window) 

Automatically Generated during Acquisition – Derived Signals 

_HR_beat.csv Presentation of heart rate based on beat-to-beat interval 
_HR_epoch.csv Beat-to-beat heart rate interpolated to sec-by sec value 

Optionally Generated with B-alert Cognitive State Classifications 

_Classification.csv Probabilities for sleep, distraction, low and high engagement, cognitive 
state from DFA with greatest probability, probability of high workload 
based on forward and backward digit span (FBDS), backward digit span 
(BDS), and average of FBDS and BDS 

_Diff_Raw.csv Absolute PSD from 1 to 40 Hz, relative PSD from 1 to 40 Hz, and EEG 
bands for differential channels: FzPO,CzPO,FzC3,C3C4, and F3Cz (no 
edge-effect window) 

_Diff_Class.csv Absolute PSD from 1 to 40 Hz, relative PSD from 1 to 40 Hz, and EEG 
bands for 5 differential channels FzPOz, CzPO, FzC3, C3C4, F3Cz (with 
Kaiser window) 

_Zscore_class.csv Updates and applies mean and standard deviation with each new 
second to provide z-scores for B-Alert cognitive states (sleep onset, 
distraction, low and high engagement, three workload measures) 

_Zscore_psd.csv Updates and applies mean and standard deviation with each new 
second to provide z-scores for PSD for all channels requested in 
initialization process 
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Chapter 26 Licensed Functionality: PV Loop Analysis 
PV (Pressure-Volume) Loop Analysis is available through an optional license available 
with AcqKnowledge 4.3 or above. The license must be authorized to access this 
Analysis tool. To add a license to an existing MP System, please contact BIOPAC. 

 
Pressure-volume loops (a.k.a. PV Loops) measure blood pressure and flow from a 
catheterized system. This analysis tool extracts various measures of heart function, including contractility, 
elasticity and ventricular characteristics. Sophisticated algorithms in this advanced analysis feature help 
circumvent the laborious visual process of identifying loop ranges while allowing the inclusion or exclusion 
of individual loops in the analysis output. Extracted measurements can be saved to an Excel spreadsheet, and 
selectable XY data views clearly show a wide range of outputted data. A pressure-volume loop graph 
template containing the necessary analog/calculation channels, data views and custom toolbars is included 
with the feature. (Q46-Pressure Volume Loop.gtl) PV Loop Analysis is supported in MP150 hardware only. 
Loop Location 
The two primary time locations for an individual PV loop range from the end systole (ES) point where the 
aortic valve closes, and the end diastole (ED) point where the mitral valve closes. On a PV loop XY plot, the 
end systole point is located at the top left corner of the loop and the end diastole is at the bottom right corner 
of the loop. An individual loop is defined as the extent from one end diastole to next end diastole, the 
equivalent of one heart beat. 
PV Loop Analysis Preferences 
PV Loop Analysis Preferences are accessed via the Analysis > PV Loop menu and offer two methods for 
locating cardiac cycles.  

 
PV Loop Analysis Preferences dialog 

PV Loop Analysis Preference Controls Description 
P/V ratio When selected, ES and ED are located by analyzing 

the ratio of pressure over volume. 
ED relaxation percentage Percentage that P/V ratio must fall from ES in order 

to locate ED. 
% threshold of dP/dt max and min When selected, ES and ED are located using the 

pressure signal derivative only. 
% of max Defines percentage of the positive pressure 

derivative local maximum for ED. 
% of min Defines percentage of the negative pressure 

derivative local minimum for ES. 
Customize Baseline Results 

 
Displays a checkbox dialog for selecting measures to 
be included or excluded from baseline analysis. (See 
next page for complete list of available measures) 
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Baseline Analysis 
Baseline analysis extracts basic single-loop measures over selected data ranges. These measures are used to 
assess proper positioning of the catheter for calibration and for assessing various changes during the 
experiment. Baseline analysis is accessed via Analysis > Pressure-Volume Loop > Baseline Analysis, or via 
the “Analyze Baseline” button on the PV Loop graph template. Measures to be extracted or excluded are 
accessed in the Preferences > Customize Baseline Results menu. 

 
Available Baseline Analysis measures 

The figure below shows a partial view of single-loop Baseline Analysis measures. The Save icon on the top 
left is used to save the measures to an external Excel file. 

 
Locate ES and ED Boundaries 
This option is accessed via “Analysis > Pressure-Volume Loop > Locate ES and ED Boundaries.” It locates 
the ending systole and ending diastole boundaries in a selected area and inserts events into the graph marking 
their location. 
Realtime Display 
Realtime display during PV Loop acquisitions involves setting up multiple views, toolbars and calculation 
channels specifically tailored for PV Loop analysis. For convenience, a Pressure Volume Loop Quickstart 
graph template is included with AcqKnowledge software. This template is configured for MP150 hardware 
and contains all above-mentioned setups, as well as two additional toolbars for realtime and post-processing 
data display. 
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PV Loop Quickstart showing graph data and Pressure vs. Magnitude XY data view 

 
The above figure shows the additional toolbars present in the PV Loop Quickstart template, with toolbar 
functions explained below. 

• Recent Values toolbar (outlined in blue) 

The Recent values toolbar extracts the following measurements in real time from the cardiac calculation 
channels 42-46. (Values are displayed during acquisition.) 

Heart Rate (BPM) 

Maximum Pressure (mmHg) 

Minimum Pressure (mmHg) 

Maximum Volume (mL) 

Minimum Volume (mL) 

• Custom Button toolbar (outlined in red) 

This toolbar provides quick access to the following functions during recording and in post-processing 

Show PV Loop Displays the Pressure Volume Loop in XY view. Plot 
shows most recent 6 seconds of pressure (X) vs. 
volume (Y). Useful for viewing experimental effects or 
determining catheter positioning. 

Analyze Baseline Performs baseline analysis on selected graph data. 
(A shortcut to choosing Analysis > Pressure Volume 
Loop > Baseline Analysis.) 

Show P vs. Magnitude Displays the Pressure vs. Magnitude data in XY view. 
Plot shows most recent 6 seconds of pressure (X) vs. 
Magnitude (Y). Useful when positioning the catheter. 

Show V vs. Phase Displays the Volume vs. Phase data in XY view. Plot 
shows most recent 6 seconds of pressure (X) vs. 
phase (Y). Useful for viewing oscillating muscle 
contributions in the signal. 

Reset Display Sets the display back to the default view. 

 



Part D — Licensed Functionality 509 

AcqKnowledge 4 Software Guide 
 

Full PV Loop Analysis 
After all pressure volume data has been acquired, it may be analyzed in detail using the full static analysis 
tool. This is accessed via Analysis > Pressure-Volume Loop > PV Loop Analysis. This tool enables the 
examination of all loops within the selected area of the graph. PV Loop Analysis is a manual process where 
outliers are defined both visually and through determining how different sets of loops affect defined 
parameters. When activated, if End Diastolic and End Systolic events are already present in the selected data, 
they will be used to define the loop boundaries. If none are present, new events will be defined using the 
desired location method and preferences. 

The full PV Loop dialog appears as follows: 

 
The PV Loop Analysis dialog is divided into three basic panes.  

• Loop display (right pane) 

• Multiple loop measures (left pane) 

• Per loop measures (bottom pane) 

The loop display shows an XY plot of volume vs. pressure. Individual loops are drawn using the waveform 
plot color of the pressure channel. Overlaid in black on top of the loops are two best fit curves for end systolic 
pressure volume relationship (ESDVR) and end diastolis pressure volume relationship (ESPVR). Use the 
checkboxes under ‘Cycle’ to include or exclude individual loops in the plot analysis. Excluded loops will 
appear as dotted lines and the actively selected loop will be outlined in blue. Excluded loops will also be 
grayed out in the per loop measure display (bottom pane). 

The loop display can be rescaled by clicking on the XY graph’s vertical and horizontal axis in the same 
manner as in any graph, and then modifying the scaling parameters.  
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Use the controls  in the upper left of the loop display region to autoscale vertically, 
horizontally, and zoom data. 

Multiple loop measures 
Once a set of loops has been identified, various models are constructed showing ideal boundaries of pressure 
and volume extents for varying cardiac cycles. Additional relationships between per-loop measures are also 
extracted to help assess overall cardiac condition. Multiple loop measures include the following relationships 
and controls: 

ESPVR (End Systolic Pressure Volume 
Relationship) 

Theoretical maximum pressure for any given volume. 

Type Use to select the equation upon which to base the PV 
loop curve fit: Linear or quadratic. 

Ees Index of overall myocardial contractility. 

V0 Theoretical volume of loop at zero pressure. 

EDPVR (End Diastolic Pressure Volume 
Relationship) 

Passive filling properties of ventricle, reciprocal of 
ventricular stiffness. 

PRSW (Preloadable recruitable stroke work) 
Pressing  displays a plot showing linear 
regression between stroke work and diastolic volume 
between loops. 

dpMax vs. EDV 
Pressing  displays a plot showing maximum 
change in pressure vs. end diastolic volume. 

PVA vs. EDV  
Pressing  displays a plot showing pressure 
volume area vs. end diastolic volume. 

PVA vs. ESP 
Pressing  displays a plot showing pressure 
volume area vs. end systolic pressure. 

Other controls 
Pressing  copies the loop-specific measures to 
the clipboard. 

Pressing  saves the loop-specific measures to an 
Excel file. 

Per loop measures 

 
The bottom pane of the analysis window contains a table display of individual loop analysis results. Each loop 
occupies one row. Comparative measures are automatically updated upon any changes to included loops. 
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Each per loop measure is recorded in its own table column. The following hemodynamic measures are 
reported: 

Measure Abbrev. Formula Units Description 

Heart rate HR 

 

BPM Provides the heart 
rate. 

End systolic 
pressure 

ESP  mmHg Blood pressure at 
end of systole. 

End diastolic 
pressure 

EDP  mmHg Blood pressure at 
end of diastole. 

Maximum 
pressure 

Pmax  mmHg Maximum pressure 
within the loop, left 
endpoint exclusive 
right endpoint 
inclusive. 

Minimum 
pressure 

Pmin  mmHg Minimum pressure 
within the loop, left 
endpoint exclusive 
right endpoint 
inclusive. 

Maximum 
dP/dt 

dPmax  mmHg / sec Maximum change in 
pressure within the 
loop, left endpoint 
exclusive right 
endpoint inclusive. 

Minimum 
dP/dt 

dPmin  mmHg/sec Minimum change in 
pressure within the 
loop, left endpoint 
exclusive right 
endpoint inclusive. 

Maximum 
volume 

Vmax  ml Maximum volume 
within the loop, left 
endpoint exclusive 
right endpoint 
inclusive. 

Minimum 
volume 

Vmin  ml Minimum volume 
within the loop, left 
endpoint exclusive 
right endpoint 
inclusive. 

End systolic 
volume 

ESV  ml Volume at ES. 

End diastolic 
volume 

EDV  ml Volume at ED. 

Stroke 
volume 

SV  ml Volume of blood 
ejected. 
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Measure Abbrev. Formula Units Description 

Cardiac 
output 

CO 

 

ml / minute Amount of blood 
pumped per unit time. 

Ejection 
fraction 

EF 
 

(none) Percent of the end 
diastolic volume 
ejected during each 
contraction. 

Maximum 
power 

MaxPwr  
 

Maximum cardiac 
power within the loop, 
left endpoint 
exclusive right 
endpoint inclusive.  
With appropriate 
factors may be 
converted into Watts. 

Parallel 
power 

PlPwr 

  
 

Stroke work SW 

 
 

where  

mmHg * ml Work performed by 
the ventricle to eject 
the stroke volume.  
Equivalent to the 
area of the PV loop. 

Arterial 
elastance 

Ea 
 

mmHg / ml Measure of arterial 
load for measuring 
coupling between 
heart and arterial 
system. 
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Relaxation Constant 

The relaxation constant, or tau, is a measure of the shape of pressure decay during ventricular relaxation.  The 
relaxation period is defined as the time of minimum change in pressure until the time when the pressure signal 
has dropped under the EDP of the previous loop (or to ED if no previous loop is located).  Multiple methods 
are used to extract tau: 

Method Description Units 

Tau Weiss Tau parameter in best fit of pressure data to: 

 

 
 
where is the value of the LVP signal at the time of dP/dt 
minimum and t is the time coordinate shifted such that t is 0 at the 
time of dP/dt minimum. 

(unitless) 

Tau Logistic Tau parameter in best fit of pressure data to the zero asymtote 
logistic: 

 

 
 
where t is the time coordinate shifted such that t is 0 at the time of 
dP/dt minimum. Let us fix the initial endpoint such that  . 
 
The logistic fit is computed by the best linear fit to the equation 

 where  and , such that . 

(unitless) 

Tau Glanz The Raff-Glanz relaxation constant method is described in 
http://circres.ahajournals.org/content/48/6/813.full.pdf. This 
extends the Weiss method by allowing a non-zero asymptote to be 
incorporated into the relaxation model such that the formula is: 

 

 
 

To solve for the constant, the slope a of the best fit linear 
regression of the series of points 

 resulting in . 

(unitless) 

Tau Mirsky Time interval between dP/dt minimum and when P drops below a 
threshold of . 

ms 

 

http://circres.ahajournals.org/content/48/6/813.full.pdf�
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Comparative Measures 

After multiple loop measures are extracted, the following additional measures may be extracted for each loop 
to examine its relationship to the volume-relationship analyses of a set of loops and expected theoretical 
baselines. These measures are based upon various multiple loop measures and should be recomputed any time 
they are changed due to modifications to the set of loops included in the analysis: (See following page.) 

Measure Abbrev. Description Units 

Pressure volume 
area 

PVA Provides a measure of the total mechanical energy 
produced by a ventricular contraction.  From the set of 
loops the ESPVR model provides the theoretical baseline 
volume at zero pressure .  The PVA for a loop is then 
determined from the following formula: 

 
where SW is the stroke work for the loop. 

mmHg * ml 

Potential energy PE Provides a measure of the elastic potential energy built 
during the systole and stored in the ventricular wall at the 
onset of relaxation.  From the set of loops the ESPVR 
model provides the theoretical baseline volume at zero 
pressure V0.  The PE for a loop is then determined from 
the following formula: 

 
That is the total mechanical energy minus the actual work 
used to eject the stroke volume. 

mmHg * ml 

Efficiency Eff Provides the fraction of the total mechanical energy used to 
eject the stroke volume: 

 

(unitless) 

Maximum time 
varying elastance 

Emax The normalized time varying elastance for an individual 
loop is adjusted from the theoretical baseline volume at 
zero pressure V0 and is given by the Suga and Sagawa 
formula: 

 
For a given loop, the maximum value of E(t) will occur 
when pressure is highest and volume is lowest, or at the 
time of ES: 

 
This is also the slope of the line connecting V0 with ESP 
within the XY loop plot1. 

mmHg / ml 

 
 See the AcqKnowledge PV Loop Analysis video tutorial for a detailed demonstration of this feature. 

                                                      
 

http://www.biopac.com/video/?video_category=acqknowledge-new-features&v=pressure-volume-loop-analysis-with-acqknowledge�
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Chapter 27 Licensed Functionality: Baroreflex Analysis 
Baroreflex Sensitivity Analysis (BRS) functionality is available through an optional license 
available with AcqKnowledge 4.4 or above. The license must be authorized to access BRS 
functionality. To add a BRS license to an existing MP System, please contact BIOPAC. 

Baroreflex analysis measures the relationship between blood pressure and heart rate and is derived 
from measures of blood pressure and ECG. The body regulates blood pressure to ensure proper 
blood flow to organs underneath different conditions, e.g. supine to standing. Baroreflex sensitivity is a 
measure of how quickly the blood pressure system compensates for changes in conditions, such as would be 
observed in increasing or decreasing exercise. Variations in baroreflex sensitivity are useful as a comparative 
measure between subjects and for assessing various external impacts. 
The Baroreflex licensed functionality adds two additional measures to the Specialized Analysis > 
Hemodynamics menu. 

 
Baroreflex Sequence Analysis 
Baroreflex Sequence analysis method produces measures of Baroreflex sensitivity (BRS) by automatically 
locating time periods to analyze. Analysis results can be outputted to a graph channel and/or spreadsheet. The 
output format is selected in the Hemodynamics global preferences. 
The Graph channel output consists of two channels: 

• “Local BRS – Ascending” with values set to the BRS estimate slope during the time periods of all 
ascending Heart Rate and Systolic Blood Pressure sequences.   

• “Local BRS – Descending” will have its values set to the BRS estimate slope during all time periods 
of descending Heart Rate and Systolic Blood Pressure sequences.   

Sequence Analysis Setup Dialog 
Choosing the Baroreflex Sequence Analysis option produces a 
dialog with the following controls:  

Source channels: 
• ECG Lead II – Selects the ECG channel for detecting heart 

rate 
• Blood Pressure – Selects pressure channel for extracting 

systolic pressure 
Sequential method parameters: 

• Min required cardiac cycles – Minimum number of 
increasing or decreasing cardiac cycles required to initiate a 
sequence analysis operation 

• Heart rate threshold – Minimum heart rate change required 
to initiate a cardiac analysis operation 

• Systolic BP threshold – Minimum systolic blood pressure 
change required to initiate a BP analysis operation 

Analyze: 
• entire graph – The entire graph is analyzed for Baroreflex 

measures 
• focus areas only – Only defined focus areas are analyzed 

for Baroreflex measures 
• Show RR data in the graph – Outputs the RR interval as a 

graph channel 
• Show SBP data in the graph – Outputs the systolic blood 

pressure data as a graph channel 
Note When “focus areas only” is selected, the entire graph is still scored for QRS events and systolic BP events, but 

only defined focus area data is included in the analysis output. 
Baroreflex Sequence Analysis description references can be found on page 518. 
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Baroreflex Slope Analysis   
The Baroreflex Slope analysis method uses linear regression to determine a measure of Baroreflex sensitivity 
(BRS). The analysis output area displays the current BRS estimate and the slope of the best linear regression 
fit to all of the cardiac cycles included in the analysis. 
First, a source time interval is defined in the cardiac recording, generally located around regions of induced 
change in blood pressure. The pairs of heart rate and systolic pressure within this time interval are extracted.  
A linear regression of these coordinates is computed, with pressure as the x coordinate and heart rate interval 
as the y interval. BRS is defined as the slope of the best fit linear regression, in units of ms/mmHg. 
The slope method is useful when correlating with studies using this method, performing validations, or when 
areas to be measured are very well known. This method can only be used on an area of selected data. If 
attempted on unselected data, a dialog will appear prompting for data selection with the I-beam tool or a 
defined focus area. 
Baroreflex Slope Analysis description references can be found on page 518. 

Slope Analysis Setup Dialog 

Choosing the Baroreflex Slope Analysis option produces the following dialogs: 

 
In the initial dialog, the ECG and blood pressure channels are selected (above). 

  
The subsequent dialogs prompt for the highlighting and selection of a systole in the BP data (above). 

 
Following systole selection, the arterial blood pressure events are scored. This can take some time, depending 
on the width of the selected area (above). 
An interactive plot (see next page) will appear, and displays the best present linear curve fit and the cardiac 
cycles as points on an XY plot of systolic blood pressure versus heart rate.  
Include or exclude points from analysis by checking or unchecking the numbered cardiac cycle boxes, or by 
clicking on individual ponts while holding down the ALT key. When individual points are excluded or 
included, the best linear fit will be automatically recalculated. The cardiac cycle table at the bottom of the 
analysis window provides a tabular spreadsheet view, and includes:  

• Active (checked) or hidden (unchecked) 
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• Time on horizontal scale that cardiac cycle occurred 
• Heart Rate (HR) in milliseconds 
• Systolic Blood Pressure (SBP) in mmHg 

 
 
Control Description 

 

The analysis output area in the upper left corner displays the current BRS estimate, 
the slope of the best linear regression fit to all cardiac cycles included in the analysis. 
Underneath it the present r value, goodness of fit, is displayed. These values are 
updated dynamically if plot data is modified. The “Copy” button in this area copies the 
text to the clipboard. 

 Copies the plot to a *.jpeg file. 

 Copies the plot data to the clipboard. 

 
Autoscales the plot vertically. 

 Autoscales the plot horizontally. 

 Toggles between selection and zoom mode in the plot. 

 

The “Pair” checkboxes allow for dynamic interaction with the individual heart rate 
(HR) and systolic blood pressure (SBP) points (also referred to as pairs). This is 
useful for visual indentification and the exclusion of outliers. 

• Check/uncheck a box to show or hide a point, or click a point while holding 
down the ALT key. Active points appear like this:   

• Hidden points appear like this:  
• Click on a point to highlight it. The highlighted point will also be selected in 

the cardiac cycle table in the lower part of the screen. Highlighted points 
appear like this:  

 Click the left icon above the cardiac cycle table data to save table data to an Excel 
spreadsheet; click the right icon to save it to the clipboard. 
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Baroreflex Sequence Method Description 
The Baroreflex Sequence method is described in the following papers: 
Kuusela, Tom; “On the Analysis of Baroreflex Sensitivity,” 2010. 
Reyes del Paso, Gustavo A; “A program to assess baroreceptor cardiac reflex function,” “Behaviour Research 
Methods, Instruments & Computers,” 1994, 26 (1), 62-64. 
The sequence method first applies criteria to the heart rate and systolic pressure signals to locate time ranges 
for analysis.  Given a minimum number of samples n, a minimum rate of change in heart rate , and a 
minimum rate of change in systolic blood pressure , the sequence of RR and pressure intervals is 
examined for time ranges of rising and falling signals.   
As indicated in section 2.5 of the Reyes del Paso paper, the pressure value at index u will actually be paired 
with the heart rate value at index u+1. This one index delay is estimated to provide a better estimation of 
BRS. 
A rising time interval is defined as a time range where at least n consecutive data points exhibit 

and , that is the heart rate and pressure 
signals are increasing by at least their thresholds inbetween consecutive data points.  These intervals must be 
at least n samples but will be extended until the first sample where the signals either decrease or the increase 
is underneath the appropriate thresholds. 
A falling time interval is defined as a time range where at least n consecutive data points exhibit 

and , that is the heart rate and 
pressure signals are decreasing by at least their thresholds inbetween consecutive data points.  These intervals 
must be at least n samples but will be extended until the first sample where the signals either increase or the 
decrease is less than the appropriate thresholds. 
For each of these defined periods, the baroreflex sensitivity is computed using the slope method. That is, the 
best linear fit for each individual sequence with pressure as the x coordinate and heart rate as the y coordinate 
will be computed.  As with the range identification, the source data used for this regression analysis will be 
the pressure at index u paired with the heart rate at index u+1. The slope of this best fit line is the local BRS, 
expressed in units of ms/mmHg. 
The default values of the thresholds and count are defined in section 4 of the Kuusela paper as follows:  

, , . 
Because of the delay applied to the heart rate signal from the systolic pressure, the slope method may not be 
directly used to validate local BRS measures from the sequential method. 

Baroreflex Slope Method Description 
The Baroreflex Slope method is described in the following papers:   

Kuusela, Tom; “On the Analysis of Baroreflex Sensitivity”, 2010. 

Patakas, D., Louridas, G. et. Al; “Reduced baroreceptor sensitivity in patients with chronic obstructive 
pulmonary disease”, Thorax 1982; 37:292-295. 
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Chapter 28 Licensed Functionality: Actigraphy 
Actigraphy Analysis functionality is available through an optional license available with 
AcqKnowledge 4.4 or above. The license must be authorized to access Actigraphy tools. To 
add an Actigraphy license to an existing MP System, please contact BIOPAC. 

Actigraphy is the long term study of accelerometer data correlated to subject activity. One of the 
primary uses of actigraphy is to conduct sleep studies in which subjects are relatively motionless 
for extended periods. With this AcqKnowledge licensed feature, long term data recordings acquired with 
accelerometers and BIOPAC’s wireless BioNomadix, Mobita or BioHarness systems can be employed to 
empirically detect periods of waking and sleep. Using Actigraphy, researchers have the ability to 
noninvasively measure a subject’s activity level, and analyze the resulting data to assess sleep disorders and 
other sleep related criteria. These types of studies usually span at least one day and often encompass several 
weeks of data. 

The purpose of the AcqKnowledge Actigraphy analysis tool is to import and process accelerometer data from 
graph data files and perform further data reduction into meaningful sleep metrics. A new file format 
(actigraphy analysis file or *.act) allows multiple recordings to be stored and analyzed for individual subjects 
across multiple time periods. 

Actigraphy User Interface 
A separate user interface and file format is employed for saved actigraphy analysis files within 
AcqKnowledge. The actigraphy analysis (*.act) file retains the following information and settings: 

• Subject name and description 
• One or more activity records. Each activity record contains the calendar date starting time and activity 

count data (1 minute epochs) 
• Time used to separate days (default is 12:00 PM) 
• Sleep onset interval detection setting 
• Low activity level threshold 
• High activity level threshold 
• Previous analysis results for each day containing activity records (primary sleep onset, end, sleep 

deprived measures, and activity level analysis) 
• Number of visible activity level count plots 
• Index of last visible tab of analysis results in the window (sleep vs. activity) 

Creating Actigraphy Files 
To create a new actigraphy analysis file, select “Create new actigraphy analysis” in the Startup Wizard, or 
choose “File > New > Actigraphy analysis file.” 
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This creates a blank actigraphy analysis window similar to the example above. 

Importing Raw Accelerometer Data 
AcqKnowledge records raw accelerometer data which must be imported and processed into activity counts for 
use in actigraphy analysis.   

To import data from an external accelerometer sleep study file, click the  toolbar button in the Actigraphy 
Analysis window, navigate to the raw data file’s location and choose “Open.” Once the data is imported, it 
(along with the extracted sleep and activity level measures) can be saved as an actigraphy analysis (*.act) file. 
After accelerometer data is imported into the main Actigraphy window, (or after an existing acitgraphy 
analysis file opened) the raw data appears in graph format in the upper “activity count plot” area of the 
window, with all data correlating to a navigable and scalable horizontal time scale. The default scaling is for a 
24 hour period, but data can be zoomed by clicking and dragging over any portion of the activity plot data.  
During zoom, the rescaled clock time is displayed in red at the right border of the 
zoomed area. (Right) 
The activity count plot area displays activity data for the subject. Its overall vertical 
area is split up into a variable number of plots, controllable within the Analysis Settings (see page 522). Each 
plot represents 24 hours of activity data. The leftmost plotted position is the starting time where time periods 
are to be split. The vertical label for the plot is set to the calendar date at that starting time position and the 
horizontal axis shows time of day in a 24 hour time format.  Every time the window is first opened, data is 
horizontally scaled to show all 24 hours. Data plotting is vertically autoscaled so the bottom of each 
individual plot is zero and the top of each plot area is the maximum activity count within the entire data set.  

 
Following data import, multiple measures are extracted and displayed in column format in the lower pane of 
the Actigraphy window. This pane is divided into two tabbed categories, Sleep Analysis and Activity Levels, 
with each category displaying its own set of measurements.  

 
All extracted measures can be exported to a text (*.txt) or Excel spreadsheet format. 

Opening an Existing Actigraphy File 
To open an existing actigraphy analysis file, choose File > Open in the analysis window, navigate to the *.act 
file location and click “Open.” 
Below: Actigraphy Analysis window populated with accelerometer sleep data (Max OS X version). 
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The following table explains the various menus, options and controls in the Actigraphy Analysis window: 

Item Description 

 

File > Open – displays File Open dialog for navigating to existing 
*.act (actigraphy) files. 
Open Recent – displays most recently opened *.act files. 
Export Activity Count Data – saves all raw accelerometer data to a 
text format. 
Export Sleep Analysis Spreadsheet – saves all sleep derived 
measures to a spreadsheet format. 
Export Activity Level Analysis Spreadsheet – saves all Activity Level 
Analysis measures to spreadsheet format. 

 

Edit > Copy Sleep Analysis to Clipboard – Exports sleep derived 
measures to clipboard. 
Copy Activity Level Analysis Spreadsheet – Exports activity level 
analysis information to clipboard. 
Analysis settings – opens the Actigraphy Analysis Settings setup 
dialog. See details on page 522. 

  
Add/Import – use to navigate to and import external accelerometer 
data file into the Actigraphy Analysis “activity plot” window. 

  
Save – saves any changes to the imported data file and Actigraphy 
window settings. 

 
Reanalyze – manually reanalyzes data to locate primary sleep 
periods and repopulates the derived measure table.  

 
Settings – opens the Actigraphy Analysis Settings setup dialog. See 
details on page 522. 

 
Field for entering text identifying Subject. 

 Field for entering text describing pertienent study information. 

 
Autoscale – horizontally utoscales the activity plot data back to the 
original 24 hour period. 

  
Scaling – time scaling button. Opens setup dialog for adjusting the 
time range of the Actigraphy window’s plotting area.  

 
Tab for displaying sleep derived measures extracted from the data 
file under analysis. For a list of specific sleep derived measures, see 
page 524. 

 
Tab for displaying activity level measures extracted from data file 
under analysis. For a list of specific activity level measures, see 
page 524. 

 
Copy text – copies sleep derived measures to clipboard. (Performs 
same function as Edit > Copy Sleep Analysis to Clipboard). 

 
Export spreadsheet – exports sleep derived measures to a 
spreadsheet. (Performs same function as File > Export Sleep 
Analysis Spreadsheet). 
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Actigraphy Analysis Settings 

As stated in the previous section, choosing “Edit > Analysis settings” (or clicking the  toolbar button) 
generates the Analysis settings setup dialog. This is where important parameters are selected and applied to 
the Actigraphy Analysis file. 

 
The following table describes the various parameters available in this dialog. 

Actigraphy Analysis Settings Controls 
Item Description 

Time Zone 
(current file only): 

Indicates the time zone in which the time data is being analyzed. This varies on a file-by-
file basis and is set to the computer's time zone when the file is first created.  

Separate 24h 
periods at: 

Provides the cutoff where data is split into new 24 hour blocks for analysis. Only one 
primary sleep period is allowed per block, so this should be set to a time when the 
subject is expected to be awake.  Default setting is 12:00 PM. 

Sleep onset 
interval: 

Selects the time interval for detecting onset of sleep. 10, 15, or 20 minute intervals are 
available. Default value is 20 minutes. 

Sleep end 
interval: 

Selects the time interval for detecting end of sleep. 10, 15, or 20 minute intervals are 
available. Default value is 20 minutes. 

Visible activity 
count plot: 

Selects the number of 24 hour activity plots to display in the actigraphy analysis window. 
Default value is 3. 

Low/Med activity 
threshold level: 

Threshold level used for separating the low and medium activity bands. Default value is 
50. 

Med/High activity 
threshold level: 

Threshold level used for separating the medium and high activity bands. Default value is 
300. 

Sadeh scoring 
algorithm: 

See below for separate explanation of this algorithm and associated settings.  

Plot colors: Clicking either option generates a colorwell for modifying the background or sleep period 
plot colors. 

Save as defaults: Saves any modified settings as a new default for subsequent Actigraphy analyses. 
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Sadeh Scoring Algorithm for Wake/Sleep Classification 
After the activity count has been extracted from the accelerometer data, each data epoch is classified as either 
a sleep or a wake interval based upon a formula cited in a widely-acclaimed sleep study publication, 
“Activity-Based Sleep-Wake Identification: An Empirical Test of Methodological Issues (1994)” by Avi 
Sadeh, Katherine A. Sharkey and Mary A. Carskadon. 
 Sadeh (1994) proposed one of the classic formulas referenced in multiple papers. Given the activity count 
sequence A, this heuristic defines the “probability of sleep”. 
The following table contains derived measures with formulas as described in Table 1 of Sadeh (P. 202): 

Measure Description Abbreviation Formula(s) 

Mean-
W-5-min 

Windowed mean of overall activity count in 
the present interval and the 5 minutes prior 
to and after the present interval. 

M 

 

SD-last 
6 min 

Standard deviation of a 6 minute activity 
window including the present interval. 

S 

 
 

 

NAT Number of intervals within an 11 minute 
window centered on the current interval 
having activity counts within this example 
range [50, 100). 

N 
 

 

 

LOG-Act Natural logarithm of the current activity 
count plus 1. 

L  

Given these source parameters, the probability of sleep PS is defined on page 202 of Sadeh (1994) as: 

 
If PS is negative, the minute at interval i is classified as a waking interval. If PS is zero or positive the 
interval is classified as a sleep interval. 
The default scoring algorithm can be modified if desired in the Sadeh scoring algorithm portion of the 
Actigraphy Analysis setup window. All fields for described measures are editable. 

 

http://sleepforscience.org/stuff/contentmgr/files/2855b4abbf7298a588d84c4c434ee48d/pdf/sadeh_etal.sleep.1994.pdf�
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Sleep Derived Measures (Sleep Analysis) 
After the primary sleep period has been located, it will be further subdivided into “bouts.”  A “bout” is a 
contiguous section of data that has been classified as either wake or sleep.   
Once the primary sleep period has been located in the data file, the following measures are extracted: 

Measure Description 

Date This is the calendar date for the start of the primary sleep period.  For most normal 
sleep periods the ending time will be assumed to be the next day; the date is for the 
start of the sleep cycle. 

Sleep Onset Starting time of the primary sleep period. 

Sleep End Ending time of the primary sleep period. 

Total Sleep Total duration of primary sleep interval. 

Sleep Time Number of minutes in the primary sleep interval classified as sleep. 

% Sleep Total percentage of the sleep period that was spent in the sleeping state. 

Wake Time Number of minutes within the primary sleep interval classified as waking. 

% Wake Total percentage of the sleep period that was spent in the waking state. 

WASO (Wake 
After Sleep Onset) 

Number of minutes after the initial sleep onset period to the first epoch classified as 
waking. 

Sleep Bouts Total number of sleep bouts within the primary sleep period. 

Mean Sleep Bout 
Len 

Average length of a sleep bout in minutes. 

Wake Bouts Total number of wake bouts within the primary sleep period. 

Mean Wake Bout 
Len 

Average length of each wake bout within the primary sleep period. 

Activity Level Measures  
The following measures are extracted from Activity Level Analysis. 

Measure Description 

Date Calendar date and starting time of the period being analyzed. 

Total Low Total low activity time for the entire period in minutes. 

% Total Low Percentage of the entire period spent in the low activity state. 

Total Med Total medium activity time for the entire period in minutes. 

% Total Med Percentage of the entire period spent in the medium activity state. 

Total High Total high activity time for the entire period in minutes. 

% Total High Percentage of the entire period spent in the high activity state. 

awakeLow Time spent in a low activity state when subject was not sleeping. 

awakeLowPercent Percentage of time subject was in a low activity state when not sleeping.  

awakeMedium Minutes in the medium activity state while subject was not sleeping. 

awakeMedPercent Percentage of time subject was in a medium activity state when not sleeping. 

awakeHigh Minutes in the high activity state while subject was not sleeping. 

awakeHighPercent Percentage of time subject was in a high activity state when not sleeping. 
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Actigraphy Specialized Analysis 

  
 
 
The Specialized Analysis menu contains options for performing Actigraphy import and analysis on any 
currently-open AcqKnowledge data files. These options are defined as follows: 

• Add to Existing Analysis – allows a channel of data in the graph to be added to a pre-existing actigraphy 
analysis. This operation may be used often after importing or recording the next set of data from a subject. 
To add to an existing analysis: 
1. Open the graph containing the accelerometer data to be added to the existing Actigraphy analysis file. 
2. Choose Specialized Analysis > Add to Existing Analysis. 
3. If the graph contains multiple channels, select the channel containing the accelerometer data to be 

added and click OK. 

 
4. Choose the existing Actigraphy (*.act) analysis file to add the new data to and click “Open.” 

. 
Note  If multiple Actigraphy analysis files are open, you will be prompted to select the desired file: 
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• Create New Analysis – Imports and performs Actigraphy analysis on the currently-open AcqKnowledge 

graph. 
To create a new Actigraphy analysis from the currently open file: 

1. Choose Specialized Analysis > Create New Analysis. 

2. If the graph contains multiple channels, you will be prompted to select the desired channel for import. 

 
3. In the Actigraphy analysis window, choose File > Save as to save the new Actigraphy (*.act) 

analysis. 

 Watch Actigraphy Tutorial Screencast for a detailed demonstration of Actigraphy. 
 

 
 
 

http://www.biopac.com/Videos.asp?Cat=NewACQ�
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Chapter 29 BioHarness Bluetooth 
A specially licensed version of AcqKnowledge is included and required when used with 
BioHarness. 

Data Acquisition and Analysis with BIOPAC BioHarness™ 
 

  
IMPORTANT NOTE: In AcqKnowledge for BioHarness 
 BioHarness menu replaces the MP menu 
 Analog channels can be turned on/off but not changed 
 Other functionality remains the same 

 
 

BioHarness™ users should see the BioHarness User 
Guide available under the Help menu and installed to the 
User Support folder in the program folder. 
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Chapter 30 Stellar Telemetry  
Stellar Telemetry Control interface for existing Stellar Small Animal Telelemtry System & 
Implants is available through optional licensing available with AcqKnowledge 4.4 or above. 
The license(s) must be authorized to access functionality for the specified number of implants. 
Please contact BIOPAC to discuss licensing options. 

 

 
Stellar Telemetry System 
The Stellar Telemetry System wirelessly acquires and logs physiological data from single or multiple animal 
subjects. The system consists of a small implantable recording device with an antenna and USB base station 
for communicating with the implanted units. AcqKnowledge software is used to configure Stellar experiments 
and analyze blood pressure, ECG, temperature, and accelerometer data imported from the logging sessions. 
Specific data recording parameters, such as the desired signal type, recording schedule, duration/repetition 
interval, and selection of animal subjects are set up beforehand in AcqKnowledge, whereas the import, display 
and analysis of resulting data are performed following the logging session. Stellar Telemetry is a licensed 
feature of AcqKnowledge, and activated with a BIOPAC-provided iLok USB License Key. The number of 
animal units (allowable animal subjects controlled per experiment) is determined by the specific quantity of 
animal units purchased in the software license. 
This chapter describes how AcqKnowledge software is used with the Stellar Telemetry System. For 
information on the Stellar System hardware (setup of implantable devices, antenna and base station), see the 
Stellar Telemetry User Guide. For Access Point hardware driver installation and troubleshooting, see the 
Access Point Configuration Guide. 
Before you begin: It is important to note that the Stellar Telemetry System may lose communication with the 
Access Point if the computer is allowed to go to sleep, resulting in a loss of data. To prevent this from 
occurring, disable the computer’s sleep mode prior to conducting a Stellar experiment. To disable, go to 
“Control Panel” > “Power Options” and set the “Change when the computer sleeps” option to “Never.” 

Stellar Experiment Interface in AcqKnowledge 
Stellar experiments are configured in AcqKnowledge in a dedicated experiment setup window. Launch the 
experiment setup by selecting “New Stellar Experiment” or by choosing File > New > and selecting “Stellar 
Experiment” in the “Choose type” option dialog. 
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Stellar Experiment Setup Window 

Description of the Stellar Calendar Controls 
CONTROL DESCRIPTION 

Visual Calendar view 

 

This is the calendar view in the left pane. Interactive 
calendar indicating date/time of scheduled logging 
sessions. Scheduled sessions are highlighted with 
orange squares. Double-clicking a date defines a new 
session. If a session has already occurred, double-
clicking the date launches and displays AcqKnowledge 
graph files containing data acquired during that date’s 
session. The month display can be advanced or 
regressed by using the arrows to the right and left of the 
current month display or by clicking on the month and 
selecting from the list (right). 

 

Graphical Day view Scrollable 24 hour representation of the selected calendar day. Vertical bars 
represent scheduled session intervals, with one “session bar” per scheduled 
session. Double-clicking an empty time slot creates a new 60 minute session. 
Single-click an existing session bar to select and highlight it. While a session is 
running, the active session bar becomes shaded in black, indicating elapsed 
time of the session in progress. The session start/end time can be adjusted to 
the nearest 15-minute interval by dragging the edge of a selected bar upward or 
downward. For more precise scheduling, adjust the start/end time using the 
navigation arrows in the Start and Stop fields, to the right of the Day View.  
Graphical Day View Buttons: 
Use the “Add Session” button to quickly add a session to the schedule. (This 
performs the same function as double clicking on a date in the Visual Calendar 
as described above.) 
Graphical Day View Contextual Menu: 
Graphical Day View supports the following contextual menu items. To display 
the contextual menu, right-click a session bar in the Day View. 
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• Delete: Removes the selected session 
• Clone: Shortcut to the “Clone Session” setup dialog (see below) 
• Delete cloned sessions: Removes cloned sessions. 

Zoom Controls: 
Use the “+” and “-“ buttons to zoom in or out on the graphical day view grid for 
optimal viewing of scheduled sessions. 

Start Acquisition 

 
Abort Acquisition 

 

Stellar data logging will begin with the next scheduled session. Scheduled 
sessions do not start automatically. They must first be initiated using the “Start 
Acquisition” button. 
During an active logging session, an “Abort Acquisition” button becomes 
available, which enables the session to be ended prematurely if necessary. The 
session can then be aborted (cancelled) or the available data downloaded (see 
below). 
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Download Data button 

 

Allows sessions to be downloaded manually at any time. This button is 
only visible while a session is in progress. 

 
The manual download window consists of the following elements and 
controls: 
Session List: This list displays all available sessions, status, scheduled 
start and stop times and animal units. The “Download” checkbox selects a 
session for manual download. 
Refresh List: Updates status of listed sessions. 
Get Data: Activates downloading process of selected sessions.  

Session Details Controls 

 

Sets specific scheduling parameters for the session. 
Start: Displays and adjusts the start time of the scheduled session. 
Stop: Displays and adjusts the stop time of the scheduled session. 
Start time offset – Start in: Allows the session to be automatically 
scheduled to start two minutes (or more) from the present time. Clicking 
Apply schedules the selected time offset. 
Time align all animal units: Sessions of all animal units will be started at 
the same start time. The start time is calculated based on the “Start” value 
plus 15 seconds for every animal unit in the session. Time aligned 
recording is useful when external stimuli or dosing is occurring at a known 
fixed clock tim 
Record – of data: Sets the duration of the data recording. 
every: Sets the repetition interval of scheduled recordings. 
Sample rate: Sets the data acquisition rate in samples per second (Hz). 
Available sample rates are 100, 200, 500 or 1000 Hz, the default being 
200 Hz. 
Signals: Selects the physiological signals to acquire during the session, 
with option to show or hide the continuous battery voltage level. Available 
signals are Blood Pressure (2), ECG (2), Temperature and Accelerometer 
(X, Y, & Z axes). 
Summary accelerometer axis data monitored: Checking this option 
combines the three axes accelerometer data into a single integrated 
accelerometer signal. 
Set input signals for all checked units: Use this option to apply the 
same input channels to all selected animal units. Signals not supported by 
a particular animal unit will be ignored. Using this option will generate a 
confirmation prompt similar to the following: 
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Clone Session button 

 

 

Configure multiple instances of a given session without manually 
repeating the session setup. This is useful when an experiment extends 
over many weeks or months and the sessions need to be frequently 
repeated.  
Selecting “Clone Session” launches the following setup dialog, allowing 
selection of session repetition intervals and duration. 

 

Animal Units 

 

An “Animal Unit” refers to a specific Stellar transmitter implanted in an 
animal subject. This option controls which available animal units are to be 
included in the session. The displayed information includes unit serial 
number, animal ID, and last known status. 

Test Communications button 

 

 

“Pings” the animal units and provides feedback on the communication 
status. “OK” indicates a successful communication. “Error” indicates a 
failed communication with an animal unit.  
Possible causes of communication failure:  

• Animal unit may be out of radio range of the access point. 
• Animal unit may be in use for a recording by another access point. 
• Animal unit may be frozen and require a magnetic reset. 
• Animal Unit battery may be dead (in which case the unit must be 

 replaced). 

Automatically download data on 
acquisition completion 

After the final session is completed, data is automatically downloaded 
from active animal units into the output directory. (Currently, this option 
cannot be disabled.) 

Set Output Directory button Chooses directory where AcqKnowledge graphs containing downloaded 
data will be stored. If undefined, the default path is the user's Documents 
directory. 

Stellar-specific Setup Window Menus 

File Menu 

> New Experiment Creates a new experiment window. 

> Open Experiment... Displays a “File > Open” dialog for opening a Stellar 
experiment file from disk. 

> Open Experiment for dowloading Opens a Stellar experiment file from disk (*.ase format) 
and activates manual data downloading based on the 
settings stored with experiment file. 

> Save Experiment Saves any changes to the current experiment.  

> Save Experiment As Displays a “Save As” dialog allowing the experiment to be 
saved to a new file on disk. 

> Close Closes the current experiment window, prompting to save 
any changes to the experiment. 

> Quit Exits AcqKnowledge. 
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Session Menu 

> New Session Adds a new session to an experiment on the date selected in 
the Calendar view. 

> Clone... Displays dialog for cloning the selected session. (Performs 
same function as “Clone Session” button.) 

> Delete Deletes a selected session after a confirmation prompt. 
Disabled if no session is selected. 

> Delete cloned sessions Deletes a selected cloned session after a confirmation 
prompt. Disabled if no cloned session is selected. 

> Start Acquisition Reschedules a selected session to start immediately. 
Dimmed if an acquisition in progress or no session is 
selected. 

Animal Units Menu 

> Add New Animal Units... The License CD contains the purchased animal unit 
configuration files. To add an animal unit: 

1. Choose “Add New Animal Units.” 
2. Navigate to the License CD and select the file(s) with 

a *.set extension. 
3. Click “Open.” 

> Test Communications... Performs the same function as the “Test Communications” 
button in the setup window. 

> Manage Animal Units... 

 

Use to select or modify the animal unit configuration. 
Animal Units: Lists available animal units 
Details > S/N: Displays serial number of currently selected 
unit. 
Animal ID: Editable field for displaying additional information 
about animal unit, name, etc. 
Calibration Barometric Pressure: Indicates barometric 
pressure at the time the animal unit was calibrated. 
Firmware: Displays animal unit firmware version. 
Channels count: Displays unit’s available input channels. 
Type: Displays animal unit information. 
On-board memory: Displays installed memory of animal unit. 
Cut-off voltage: Displays lowest battery voltage allowable to 
run data acquisition. 
Channels: Displays list of animal unit input channels. 
Test…: Performs short (2-sec) test acquisition of the selected 
unit 
Status: Displays status information of the selected animal 
unit. This option is only available between recordings. Status 
results are not returned during an active recording. 
HW config: Displays hardware configuration of selected unit. 
This option is only available between recordings. 
Remove: Removes selected animal unit from the list. 
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Add New Unit: Performs same function as “Add New Animal 
Units” in the Animal Units menu. 

Access Point Menu 

> Get Info... Displays current access point information, including serial 
number, communication status, and current barometric 
pressure. 

> Change Access Point... NOTE: This functionality is not currently supported. Only one 
access point may be used with the software at a time 

Tools  Menu 

> Stellar Preferences 

 

Set the following important parameters in the Stellar 
Preferences dialog: 
Path to Stellar Setting Folder – Displays the path location of 
Stellar access point and animal units setup files. 
Browse – Selects the path to location of Stellar access point 
and animal units setup files. 
Access point COM port – Dropdown list of supported COM 
port numbers. The selected COM port must match the USB 
port number assigned to the access point. If the COM port 
preference setting AcqKnowledge does not match the actual 
COM port assigned to the access point, the following prompt 
will be displayed: 

 
Choosing “Yes” will change the preference setting to match 
the correct COM port used by the access point. 
Path to Barometric Pressure Log file – Displays the path 
location of the “Stellar_BaroPressure.log” file. 
Browse – Selects the path to location of the 
“Stellar_BaroPressure.log” file. 
Clear BP file – Used to delete the Barometric pressure log 
file. 
Default path to save data files – Displays the default 
location of Stellar data files. 
Browse – Opens a browse window for setting an alternate 
data file path. 
Set default – Resets the filepath to the original default file 
path. (User’s Documents folder) 
Show Log View – Displays the Journal log view by default for 
new experiments to show real-time experiment information. 
(This may also be controlled via the Options menu in the 
Scheduler window.) 
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> Show/Hide Log (Journal) When “Show” is selected, real-time experiment status 
information is displayed at the bottom of the Scheduler 
window. This field resembles the AcqKnowledge Journal, but 
is not user-editable. (See below example.) 

 

> Print Log Opens a dialog for printing contents (or a selection) of the log 
and for setting the desired print parameters. 

> Copy Settings to Clipboard Copies experiment settings to clipboard in text format. 

> Import data from animal units 

 

Downloads data from selected animal units into an 
AcqKnowledge graph.  

1. Select the animal units for data import via the 
Animal Unit checkboxes. 

2. Select the option to create separate AcqKnowledge 
graphs for each secected animal unit or to merge all 
animal units into the same graph. 

3. Choose the sample rate at which the animal data 
unit was acquired. This information is critical for 
accurate display of the imported data. 

4. Click “Download.” 

> Import data from backup file To protect the animal unit data, AcqKnowledge creates a raw 
data backup file every time data is downloaded from the 
selected animal unit(s). Backup files are located at pre-
defined folder titled “%temp%.” Backup file names appear in 
the following format: 
STELLAR_YYYY_MM_DD_HH_mm_ss.txt. 

Use this menu item to select backup file(s) and import the 
data into AcqKnowledge. 

> Real time data preview This option allows for the previewing of plotted data prior to 
initiating the actual experiment, and is helpful for configuring 
the real time data recording and plotting. Parameters such as 
Animal Unit, input signals, sample rate and duration can be 
modified and the result plotted in real time after clicking the 
“Start” button. 
Data preview graphs can be autoscaled vertically while in 
progress for enhanced data display. See the following page 
for a full explanation of the Real time data preview options. 
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Real time data preview setup options 

Animal 
Units 

Displays the animal units available for preview. Only one animal unit at a time may be selected. 

Channels Displays the channels available for preview. Multiple channels may be selected. 

Duration Sets the length of preview in seconds. 

Unlimited  Choosing this option allows the preview to run until manually stopped.  

Rate Use this option to select the sample rate for the data display. Sample rates of 100, 200, 500 and 
1000 s/s are supported. 

Save data Use this option to choose a path to save the preview data to a *.txt file format. This option is 
available when the duration is set to seconds. It is not supported for unlimited data previews. 

Time 
range 

Use this option to set a horizontal scale range for the data preview display. (Horizontal 
autoscaling is not supported in the preview graph.) 

Start Toggles between Start/Stop of data preview. When clicking Start/Stop it may take a few 
seconds for the application to respond before starting or stopping the preview. When this 
occurs, a “Please wait” dialog will appear. Avoid repeated mouse clicking within the application 
window during this time or AcqKnowledge may become temporarily unresponsive. 
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 Real time data preview in progress after clicking “Start” 

Animal units and Channels selected for Real time data preview are displayed as in a moving graphical format 
while the preview is in progress. The preview signals can be autoscaled vertically but not horizontally, so it is 
important to set the horizontal display in the “Time range” field prior to clicking “Start.” Enhance the preview 
vertical display using the “Zoom In” or “Zoom Out” buttons. (2x zoom is supported.) 

Real time data previews set to duration of seconds can be saved in *.txt file format to a user-defined location. 
These saved files can be reopened in AcqKnowledge using the following steps: 

1. File > Open and choose “*.txt, *.csv” as the files of type. 

2. Navigate to the saved preview *.txt file and open using the following import settings: 
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Running a Stellar Experiment 
The example below is a guide to scheduling and conducting a Stellar experiment. These steps assume that the 
Stellar hardware is set up correctly, and successful hardware connection between the Access Point and the 
Animal Unit has been established. For hardware setup instructions, see the “Access Point Configuration and 
Troubleshooting Guide.” 

1. In AcqKnowledge, launch a new experiment. 
(File > New > Stellar Experiment). This will 
launch the Calendar window. A “Create new 
stellar telemetry experiment” option is also 
available in the AcqKnowledge Startup 
window. 

 

2. Prior to session setup, you must first test the 
Animal Unit communications status.  

3. Click “Test Communications.” 

 

4. Click “Yes” to the resulting dialog to continue. 
 

 

5. Enable the check boxes corresponding to the 
Animal Units to be used during the session and 
click “Start Test.” 
• A successful connection is confirmed by a 

Test Status of “OK.” 

 
 

6. The Calendar will default to the current date. If 
the session is to be scheduled for a future date, 
click on the desired date to highlight. 

 

7. Choose a time for the experiment to start by 
double-clicking in the Graphical Day 
 View region or by clicking the “Add Session” 
button. This highlights a one-hour time period 
with a series of squares called a “session bar.” 
Each black and white square represents a 15-
minute time block.  

• Hold left mouse button down to drag 
the highlighted session bar to a 
different location on the time scale. 
The bar can be dragged up or down in 
15-minute increments or greater.  
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• Position the left mouse button over the 
session bar border and drag the arrow 
cursor up or down to adjust the session 
length. 15 minute increments or greater 
are supported. 

• Conversely, the session length can be 
more precisely modified by using the 
spinners in the “Start/Stop” fields. 

 
 

 

8. Select the recording length, repetition, sample 
rate, and the signal types to be acquired. 

 

9. Select Animal Units to be included in the 
session by checking the corresponding boxes. 

 

10. Once the recording parameters and Animal 
Units are selected for the session, click “Start 
Acquisition.” 

 

11. Choose a file name for the experiment. 
• The session will start at the scheduled 

time and display the imported data in 
an AcqKnowledge graph when 
concluded. 
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Import and Display of Stellar Data in AcqKnowledge 
Following completion of a scheduled experiment, the logged Stellar data is downloaded to an AcqKnowledge 
graph for review and analysis. Stellar-optimized analysis tools enable selective viewing and spreadsheet 
output of recorded data for all selected animal units.  

• Physiological signals extracted from the Stellar experiment are imported into an 
AcqKnowledge graph and displayed as separate channels. 

• Repeated recordings (for example, 15 seconds every 15 minutes for the duration of the 
session), are displayed as appended segments.  

 
Saving Graphs and Settings from Stellar Experiments  
It is important to note that Stellar experiment data files and Stellar experiment settings are stored separately. 
Graphs containing data imported from Stellar experiments are in standard AcqKnowledge *.acq or *.gtl 
format, and like all AcqKnowledge graphs, are opened and saved via the main application window “File” 
menu.  
Conversely, Stellar experiment settings and parameters are saved and opened via a separate File menu in the 
Scheduler window. (See Stellar-specific Scheduler menus on pages 3-5.) Stellar experiments are saved in 
*.ase (AcqKnowledge Stellar Experiment) format and contain the following settings: 

• Access Point ID 
• Output directory 
• List of Animal Units with their last known status 
• List of Animal Unit IDs included into the session 
• Start Date/Time 
• End Date/Time 
• Single Record duration: value and time units 
• Interval between recordings: value and time units 
• Sample rate in Hz 
• Input signals for the recording session: (Blood Pressure, ECG, Temperature, Accelerometer, Battery 

voltage) 
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Stellar Analysis in AcqKnowledge 
After the logged Stellar session is downloaded into an AcqKnowledge graph, data can then be extracted and 
examined using the Stellar specialized analysis tools. Access these tools by using the Analysis > Stellar menu 
option in the main graph window. 

 
 
Analyze Stellar Data 

 
 

 

Creates a spreadsheet output of combined data from 
selected animal units included in the session. All 
measurements are selectable in the Stellar Analysis 
preferences and include the following: 

• Delta T (duration of each recording 
 interval) 

• Mean Systolic Pressure 
• Mean Diastolic Pressure 
• Mean Mean Pressure 
• Standard Deviation Systolic Pressure 
• Standard Deviation Diastolic Pressure 
• Mean Pulse Pressure (systolic pressure 

 minus diastolic pressure) 
• Standard Deviation Pulse Pressure 
• Mean Heart Rate from Pressure 
• Mean Heart Rate from ECG 
• Standard Deviation Heart Rate from ECG 
• Standard Deviation Heart Rate from BP 
• Mean P-P from ECG 
• Standard Deviation P-P from ECG 
• Mean Temperature 
• Battery 
• Barometric Pressure (mmHg) 
• Activity Sum (measures overall activity 

during tht entire recording segment by 
summing all activity count data) 

Note that outputted measurements are dependent 
upon the signal types selected in the setup window.  
If the session includes multiple animal units, the rows 
extend outward to accommodate all subjects and 
displays measurement data for each.  

Show average ECG This option averages the ECG signal and provides 
the average ECG waveform for the entire acquisition 
period. When selected. AcqKnowledge performs an 
ensemble average ECG complex for each recording 
session and then overlaps them to obtain the 
average. 

View Signals for Specific Animals The following parameters can be adjusted using the 
“View Signals” controls: 
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The above option selects the animal units to be 
included in the graph. Unchecking an animal unit 
hides the graph channel containing the deselected 
unit. 

 
Show or hide the various signal type channels 
acquired during the session for a better view of a 
particular signal.  

Preferences > Stellar Analysis: Select measurements to 
extract 

Use this option to select or deselect the 
measurements to be included in the analysis. 
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Preferences > Heart Rate Range Use this preference to enhance the accuracy of heart 

rate ranges extracted during analysis. This option 
(based upon the AcqKnowledge Find Rate 
windowing algorithm,) can help improve results by 
reducing the standard deviation of BPM values falling 
outside of the defined range. These results appear as 
selected measurements in the “Analyze Stellar Data” 
spreadsheet output. 
In general, adjusting the maximum BPM to a lower 
value helps prevent excessive motion artifact from 
adversely affecting the heart rate results. 
This preference is also useful for tuning the heart rate 
“window” for a specific subject type and experimental 
condition, or in cases where the 700 BPM default 
maximum heart rate may not be applicable. 

 
To set the Heart Rate Range preference for an 
experiment: 

1. Analysis > Stellar > Preferences 
2. Dismiss the initial “Select 

measurements” dialog. 
3. Enter the desired minimum BPM 

value into the top field. 
4. Enter the desired maximum BPM 

value into the bottom field. 
5. Click OK to apply the settings. 

The example below shows how mean heart rate and 
standard deviation results can be enhanced by 
lowering the maximum heart rate range from a 
default value of 700 BPM (left) to 300 BPM (right). 

  
For more information about the AcqKnowledge Find 
Rate feature and windowing setup, see page 341.  
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Chapter 31 Mobita 

 
Mobita is a portable wireless system for acquiring ECG, EMG, EEG, EOG, EGG and accelerometer data via a 
dedicated WiFi network. This hardware system is controlled by a specially-licensed version of 
AcqKnowledge (versions 4.4 and greater only). 
The Mobita package consists of: 

• AcqKnowledge software 
• Battery-powered data acqusition unit  
• USB WiFi dongle 
• Detachable docking station (for charging unit, and connecting to computer via USB interface to 

download logged data and change the recording configuration) 
• Detachable “confiCap” (for connecting various electrode leads, allowing wireless acquisition and 

data logging of up to 32 analog data channels, and up to 64 calculation channels) 
The Mobita unit also has a built-in tri-axial accelerometer function, with the “X,” “Y,” and “Z” accelerometer 
channels appearing immediately below the available analog channels in the AcqKnowledge channel setup. 
The purpose of this chapter is to provide an overview of the AcqKnowledge software interface as it relates to 
connected Mobita hardware. For details on Mobita installation, network setup and hardware, see the Mobita 
Installation and Mobita Hardware guides. 

AcqKnowledge Interface in Mobita 
AcqKnowledge with Mobita looks nearly identical to the user interface seen when using MP150 or other 
supported data acquisition hardware types. Standard AcqKnowledge functionality is supported, with the 
following limitations: 

• Acqusition rate is limited to a maximum of 2000 samples per second. (Other available rates are 
1000, 500, 200 s/s.) 

• Recording length is dictated by the maximum amount of available card storage memory in the 
Mobita unit. The default recording length is the standard 1800 seconds (30 minutes). 

• Stimulator controls are not supported. 
• One optional digital channel for use with a trigger signal is supported depending on the 

connections available on the cable. 
Upon launching AcqKnowledge with Mobita, the Set Up Data Acquisition window is presented with the 
Analog Channels tab active. Set up the desired channels and acquisition paremeters here before continuing. 
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Selecting or Adding Mobita Hardware in AcqKnowledge  
If additional hardware types were used prior to Mobita installation, the Mobita hardware can be enabled by 
selecting it from the “Connect to” hardware list (below left), or be added as a recognized hardware type via 
Hardware > “Manage Hardware Connections” and choosing “Connect New Hardware” (below right). 

  
Mobita hardware can also be selected upon application launch in the Startup Wizard following Mobita 
installation and network setup. 

  
Mobita Menu 
The Mobita hardware menu will look familiar to AcqKnowledge users. The “Set Up Data Acquisition” 
window brings up standard AcqKnowledge options for channel and recording setup. (The “Set Up Data 
Acquisition” window is presented by default upon application launch, with Analog Channels display 
enabled.) 

. 
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Mobita Analog Channels Setup 
Up to 32 analog channels are available, with the following available presets and default filtering: 

 
In Mobita, (as in other AcqKnowledge hardware types) channel labels, sample rates and setups are 
customizable, and user-defined channel presets can be created and saved. 

 
Note Mobita accelerometer channels are fixed at absolute levels and have no configurable preset options. 

Analog Channel Digital Filters 
The Analog tab’s “Setup” button displays options for setting IIR filters and modifying scaling parameters for 
the selected channel. Up to four IIR filter types are supported per channel. The bundled presets shown above 
have default filter settings, but these can be modified and saved as unique channel presets if desired. (See 
following page.) 
The below example shows default filters, scaling settings and units for the ECG (0.5 – 35 Hz) analog  
channel preset: 

   

To set a filter manually, select a filter type from the pop-up menu (see below). 
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For details about AcqKnowledge IIR filters, see page 288. See also Appendix B – Filter Characteristics. 

Mobita Calculation Channels 

 
Mobita Calculation channels and associated presets operate in standard AcqKnowledge fashion. Choose the 
Calculation tab, enable a channel and select the desired preset and analog source channel. The “Setup” button 
opens a dialog for modifying default parameters of the selected online transformation. 

Enable Common Average Value Removal 
“Enable common average value removal” is a checkbox is found at the bottom of the acquisition setup 
(Length/Rate) window. This option is helpful for removing common mode interference, noise, and motion 
artifact.  
If disabled, signal and noise artifact will need to be removed manually in post-processing. BIOPAC 
recommends keeping this option enabled for optimal data quality. 

  
Mobita Acquisition (Length/Rate) Settings 

 
The following acquisition modes are supported in Mobita hardware: 
Append and Autosave  
Append and Autosave modes are available for WiFi communication only, with no data stored to the Mobita 
hardware. Memory or disk storage options are supported both acquisition modes. 
Save once (WiFi + Logging) 
“Save once”(memory or disk) mode supports both WiFi communication and data logging. During “Save 
once” acquisition, data is logged on the Mobita hardware and streamed wirelessly into the AcqKnowledge 
graph. When acquiring data in this mode, note the “Start/Stop” button status is replaced by “Log.” 
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Mobita will log data for the selected acquisition length, or until hardware memory is filled to capacity. When 
the acquisition is complete, all logged data will be present in the AcqKnowledge graph. If the “Log” button is 
clicked before the acquisition is complete, (or if the subject wanders out of wireless range), a logging status 
dialog is presented: 

 
 During this state, data plotting in AcqKnowledge stops, but data continues to be logged into Mobita 
hardware. The start/finish times are displayed, along with a countdown of remaining logging time. 
“Abort” option: Data logging to Mobita is cancelled. The “Log” button in AcqKnowledge reverts to “Start.” 
Before acquiring new data or changing the acquisition mode, the Mobita hardware must be reset via the USB 
docking station. For information about resetting the hardware or changing acquisition modes, see page 548. 
 Note: All data logged prior to choosing “Abort” is retained in the graph.   
“Download” option: You will be prompted to confirm the download and connect the Mobita hardware to a 
USB port. (Download of logged data is not supported in WiFi mode.) Upon connection, the logged data is 
downloaded and imported into the graph. During download, a screen similar to the one below will appear: 

 
After the download screen closes, the logged data is imported into the AcqKnowledge graph at an accelerated 
rate. The import duration is dependent on the length of the logged acquisition. 

Changing Acquisition Modes or Resetting Hardware 
To change acquisition modes, or to reset the Mobita hardware after logging data, use the following steps. 

1. Select the desired acquisition mode in Mobita > Set Up Data Acquistion. 
2. Click “Start.” 
3. Follow the onscreen communication prompts as they appear. (Shown below.)  

 
   Communication Prompt 1 

Important: After connecting the docking station, wait for the blue light on the Mobita unit to 
illuminate before clicking “Retry.” 

 
    Communication Prompt 2 
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4. After clicking “Retry” in the confiCap communication prompt, the following connection 
dialog will appear. 

 
5. When Mobita connection is established, this dialog will close automatically and the recording 

will start in the selected acquisition mode.     
 

Mobita Network Connection Utility 
If it becomes necessary to restore the connection to 
the Mobita hardware and/or ASUS USB network 
adapter, you may see this connection message: 
  
To re-establish the connection, use the Mobita Network Connection Utility as follows: 

1. Mobita menu > Manage Network Configuration Utility. 
2. Click “Validate and Adjust Network Configuration.” 

 
3. If the USB adapter connection needs to be re-established, you may see the following  

communication prompt: 
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4. If this prompt appears, highlight the ASUS USB adapter in the “Adapters” list and click “Validate 
and Adjust Network Configuration” again. (Make sure the adapter is connected or it will not 
appear in the list.) 

5. Click “Yes” and “Retry” to the following four prompts as presented. 

 
 

 

 
Important: After connecting the docking station, wait for the blue light on the Mobita unit to illuminate 
before clicking “Retry.” 

 

6. After connecting and clicking “Retry,” wait for the connection to be established (20-30 seconds). 

 

7. After the connection dialog closes, the hardware connection is complete. Close the Mobita 
Network Configuration Utility. 
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NOTES:  
• Mobita functionality is supported in Windows 7 and 8 only. Not supported in Windows XP or 

Vista. 
• Mobita with AcqKnowledge requires an Administrator user account. It is not functional for 

Limited accounts. 
 

 For a detailed look at Mobita configuration, watch the Tutorial video here.
 

http://www.biopac.com/video/?video_category=hardware-tutorials&v=mobita-network-configuration�
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Chapter 32 FaceReader 
FaceReaderTM with AcqKnowledge is available through optional licensing in AcqKnowledge 
4.4.2 and above. Contact BIOPAC for licensing details. 

FaceReader™ is the premier professional software for automatic analysis of facial expressions. Emotion reading 
software locks onto a subject’s face and analyzes facial movements to classify subject’s response. Easily integrate 
with physiological parameters from an MP150 Research System or eye tracking data. Start AcqKnowledge to 
begin recording, and FaceReader data is automatically synchronized and recorded in the same graph file. Monitor 
data in the FaceReader display for real-time feedback. Classifications include: 

• Happy 

• Sad 

• Scared 

• Disgusted 

• Surprised 

• Angry 

• Contempt  

• Neutral 

Seamless Integration – easily integrate and synchronize physiological data or eye tracking through 
AcqKnowledge. 

Complete Facial Expression Analysis – accurate modeling of the face by describing over 500 key points 
delivers objectivity in observations. 

Useful for a Variety of Applications – psychology, educational research, consumer behavior research, 
usability studies, and neuromarketing research. 
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How Does FaceReader Work? 
FaceReader software uses the computer’s (or external) camera, a still photo, or a video image to detect and 
analyze a subject’s emotional state by utilizing the facial action coding system (FACS) first developed in the 
1960s by Swedish anatomist Carl-Herman Hjortsjö and later expanded by Dr. Paul Ekman. The FACS 
algorithm is capable of interpreting the tiniest of facial movements, rendering an accurate and nuanced 
interpretation of a subject’s emotional responses. This automated state scoring has become popular in 
advertising and neuromarketing for assessing subject feedback to videos and other stimuli, and is also often 
used as another measure during self-assessment studies. 

The FaceReader licensed feature allows response classifications to be selectively recorded as channels in an 
AcqKnowledge graph, and includes the following functionalities: 

• Receive emotional state data from FaceReader in real-time 
• Store emotional state data in AcqKnowledge graph files 
• Incorporate emotional state data with other physiological signals and data analysis 

AcqKnowledge FaceReader options become visible when the optional FaceReader license has been activated. 
Additionally, Noldus FaceReader software must be installed on the AcqKnowledge computer, or on a 
networked computer or server. See the Noldus FaceReader Software Reference Manual for installation and 
configuration instructions (i.e., FaceReader software and camera setup.) 

Using FaceReader with AcqKnowledge 
To configure FaceReader for use in AcqKnowledge: 

1. Launch the Noldus FaceReader software and create a new project. 

2. Choose “File >Settings.” 

3. Select “Data Export” and check the “Enable External Control (API)” option. 

4. Note the External Connection Port number. The default setting of 9090 shouldn't need to be 
changed unless there is a conflict with another application: 

 
Enabling data connection in the FaceReader software settings 

5. To record overall valence and activity signals, scroll to the bottom of the Application Settings 
screen and check the “Valence and Arousal” option (see below figure). For more information 
on valence and arousal signals, see page 555. 
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6. Click OK to exit the Application Settings screen. 

Creating a FaceReader Project and Recording in AcqKnowledge 
1. After performing the above configuration steps 1-5, launch the FaceReader software and 

choose “Create New Project.” 

2. Add a participant to the project.  

3. Add a camera analysis (Camera toolbar icon in FaceReader 
software UI) and note the camera preview for positioning 
the subject. 

4. Launch or return to AcqKnowledge. (If necessary, create a new graph.) 

5. Choose MP150 > Set Up Data Acquisition > Channels and click the “FaceReader” tab. 

 
6. Check the “Enable FaceReader” checkbox. 

• If the FaceReader software is installed on the local AcqKnowledge computer, select 
“Local Host” as the “IP” setting and use the default Port number of “9090.” 
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• If the FaceReader software is installed on another networked computer, choose the 
“Manual” option and enter the I.P. address of the FaceReader computer. (The I.P. 
address can be found by choosing Start > Run “cmd” and using the “ipconfig” 
command.) 

7. Select the desired “Emotional States to Record” signals. 

8. Exit the Channels > FaceReader setup screen and click the AcqKnowledge “Start” button. (At 
least one AcqKnowledge Analog channel must be enabled in order for the recording to start.) 

9. The selected Emotional State data will be recorded into a new set of channels alongside other 
AcqKnowledge data. 

10. Click “Stop” to halt AcqKnowledge FaceReader recording. 
TIP: In the AcqKnowledge FaceReader tab, click the “Save as Graph Template” button to permanently save 

the Port setting and selected Emotional States for future sessions. 

Creating AcqKnowledge Graphs from a Saved FaceReader Analysis 
Existing saved FaceReader analyses can be extracted into an AcqKnowledge graph, even if the analysis was 
not originally performed using AcqKnowledge. To do this: 

1. In FaceReader, open an existing project. 
2. Open the Analysis for the project (click the magnifying glass icon to display the saved 

video.) 

 
3. Launch AcqKnowledge and make sure FaceReader is enabled in the application (See Steps 

5-6 above). 
4. Click “Start” in AcqKnowledge. The recorded FaceReader analysis will be displayed in 

AcqKnowledge graph channels. 

FaceReader Signals 
FaceReader records various emotional states and displays the analysis in real-time. As previously explained, 
this analysis extracted as graph channels in AcqKnowledge software. FaceReader implements a neural 
network trained on the following facial expressions: 

• Neutral 
• Angry 
• Happy 

• Sad 
• Scared 
• Surprised 

• Disgusted

These recorded expressions are used to extract the subject’s dominant emotional state during the response 
period, otherwise known as “valence.” 

Valence and Arousal 
Valence and Arousal are two additional high level signals derived by FaceReader. Valence is used as an 
indicator of a subject’s overall emotional state based on sum of positive emotions minus the sum of negative 
emotions, and ranges in value from 1 to -1. (The most positive emotional state being 1, the most negative -1.) 
Arousal is used as an indicator of whether a subject is active or inactive and is based on average activity of the 
various facial action units within the last 60 seconds. A value of 0 corresponds with an inactive subject and a 
value of 1 with an active subject. 
The seven emotional states, plus the derived valence and arousal signals provide useful high-level information 
about a subject. FaceReader also provides tools for extracting other lower level facial information, including 
state of standard FACS action units, general gaze direction, head orientation, eyes open/closed indicators and 
other parameters. These high-level signals are relevant for psychophysiology. 



556 AcqKnowledge 4 Software Guide 

Visit the online support center at www.biopac.com 

If “Valence” and “Arousal” Emotional States are selected in the AcqKnowledge FaceReader tab but have not 
first been configured for output in the FaceReader software, the following dialog will appear. 

 
If this occurs: 

1. Return to the FaceReader software, choose “File >Settings.” 
2. Scoll to the bottom of the Application Settings screen and check the “Valence and Arousal” box.  
3. Click OK to exit the FaceReader Application Settings screen. 
4. Return to AcqKnowledge and rerun the FaceReader recording to verify that valence and arousal data 

are present. 

Connection Issues 
If, after clicking “Start” AcqKnowledge fails to establish a connection with FaceReader, the following dialog 
will appear: 

 

If FaceReader and AcqKnowledge are installed on the same computer: 
Check the IP port setting for both applications as shown on pages 553 and 554. The port settings should 
match. (The default is 9090.) This port number may need to be changed if there is a conflict with another 
application. 

If FaceReader is installed on a different computer on the network: 
Make sure the I.P. address of the FaceReader computer is correctly entered in the AcqKnowledge FaceReader 
tab’s Manual field. Auto-location of the I.P. address is not supported, so this value must be entered manually. 

To determine the I.P. adress of the FaceReader computer: 

1. On the FaceReader computer, choose Start > Run. 

2. Type “cmd” to bring up a command window. 

3. Type “ipconfig” and press the Enter key. 

4. Note the I.P. address. 

5. Return to the AcqKnowledge computer. 

6. Enter the I.P. address in the AcqKnowledge FaceReader tab’s Manual field and click OK. 

 
 



Part D — Licensed Functionality 557 

AcqKnowledge 4 Software Guide 
 

Camera Connection Issues 

For certain types of USB cameras, the camera connection may become lost following a FaceReader analysis 
session. If this occurs, unplug and reconnect the camera before continuing with a subsequent analysis. It is 
recommended that an integrated camera be used if possible and set as the default camera. 

For further instruction and technical details about Noldus FaceReader software, see the FaceReader 
Software Reference Manual. 

 
For more information about the AcqKnowledge FaceReader Licensed Feature, visit www.biopac.com. 
 
 

http://www.biopac.com/�
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Part E — Appendices 
  

Appendix A - Frequently Asked Questions 
Q: I have a large data file and it seems to take a long time to redraw the screen. Is there anything I can do to 

speed it up? 
A:    Yes. You can choose from several remedies for this. 

(1) The simplest solution is to check the Draft mode for compressed waves and Use all available 
memory boxes in the Preferences dialog (shown below). Checking these two boxes will cause 
AcqKnowledge to plot data faster (at the expense of some precision) and use as much available 
memory as possible. 

  
(2) You can reduce the time interval per division, which causes less data to be displayed on the 

screen at one time, and should reduce plot time. 
(3) If you have a high-resolution video card (one capable of displaying millions of colors), you may 

want to reduce the resolution to speed up plotting time. 
(4) Load all data into memory; see page 455 for details. 

Q: Can I use other software with the MP System (MP150 or MP36R)? Can I use AcqKnowledge to control 
other data acquisition hardware? 
A: No. The MP System was designed to work with the AcqKnowledge software. However, the software 

can read in previously acquired text files generated by AcqKnowledge or any other software. 
Q: I have a device that outputs an RS-232/RS-422 signal. Can I connect this to the digital I/O lines? 

A: No. These types of digital output devices have their own communication protocols and are more 
complex than the digital pulses that the MP System (MP150 or MP36R) can accept as inputs. 

Q: I imported a text file and the time scale is wrong. What happened? 
A: When a text file is imported, AcqKnowledge assumes (by default) that the data was sampled at 100 

Hz or 100 samples per second. This is arbitrary, and there are two ways to adjust this. Both methods 
involve Calculating the interval between sample points. To calculate the sampling interval, you need 
to know the rate at which the data was originally sampled. The sampling interval is calculated by 
dividing one by the sampling rate. You can adjust the sampling interval to the appropriate value via 
the File > Open dialog before the data is read in, or if the data is already present, change the time 
scale in the Display > Horizontal scale dialog. 
For instance, if 20 minutes of data was originally collected at 2Hz and is read into AcqKnowledge as 
a text file, the software will interpret this as data collected at 100 samples per second. To set the time 
scale to accurately reflect the data, change the sampling interval from 0.01 to 0.5 seconds per sample. 
To change this setting before data is read in, click the Options button in the File > Open dialog and 
change the value in the Sampling Interval dialog. To change the time scale after data has been read in, 
adjust the units per division in the Display > Horizontal axis dialog. If the data are time-domain data, 
you can adjust the seconds/sample interval at the bottom of the dialog. This value defines the interval 
between sample points, and can be changed to fit the rate at which the data was originally acquired. 
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Q: I just filtered a waveform and now my data file is huge. Why is that? 
A: When AcqKnowledge performs any type of transformation on a waveform (e.g. digital filtering, 

waveform math), it converts the entire waveform from integer format (two bytes per sample) to 
floating-point format (eight bytes per sample). Since each sample point in the waveform now takes up 
four times as much space, the file should be approximately four times as large. AcqKnowledge still 
saves the file as compactly as possible, and since some of the information stored describes the time 
base, the file size will not increase by exactly a factor of four. 

Q: My MP data acquisition unit seems to be connected, but I can’t acquire data. What should I do? 
A: This can be caused by one of several conditions: 

(a) Check to make sure that the MP data acquisition unit is ON and, if so, that all the connections to 
the MP data acquisition unit were made properly. When the MP data acquisition unit is powered 
up, a light on the front panel of the MP data acquisition unit will illuminate. If the power light 
will not illuminate, check to make sure the proper power supply is connected. The power supply 
that comes with the MP data acquisition unit is rated at 12 VDC @ 1 Amp, and using other power 
supplies may result in damage to the MP data acquisition unit. 

(b) If the proper power supply is connected but the power light still does not illuminate, disconnect 
the power supply and check the fuse in the back of the MP data acquisition unit. The fuse is a 
standard 2.0 Amp fast blow fuse, and can be changed by unscrewing the fuse cap and replacing 
the fuse. 

(c) If the power light does illuminate, the next step is to see if the busy light (next to the power light 
on the front panel of the MP data acquisition unit) illuminates when the MP data acquisition unit 
is powered up. When the MP data acquisition unit is powered up, the busy light should illuminate 
for three or four seconds and then extinguish. 

NOTE: The busy light is normally off (except at startup), but it will remain on while 
data is being acquired and will illuminate for the duration of each trial when data is 
being acquired in averaging mode. If the busy light does not illuminate when the 
system is powered up or does not turn off after a few seconds, contact BIOPAC at 
one of the locations listed in Appendix A. 

Q: I set up the channels but I only seem to be acquiring noise. What’s wrong? 
A: A number of phenomena can cause this. Check to make sure that the settings in the Set Up Channels 

dialog correspond to the channel switch settings on the amplifier modules and/or direct analog 
connections to the UIM100C. When a direct analog input is set to the same channel as an amplifier, 
the resulting data will appear quite noisy or erratic. You should also check to see that no two 
amplifiers are set to the same channel. 
Another possible cause is that the gain settings on the amplifiers are too low and should be increased. 
You may also want to select Autoscale waveforms from the Display menu. This will automatically 
adjust the waveforms to provide the “best fit” in terms of scaling the data to fit in the available 
window space. 
It is also possible that the electrodes/transducers themselves are the source of the noise. Proper 
electrode adhesion techniques involve abrading the skin and securing the electrode in place to reduce 
movement artifact. 

Q: What is the storage and operation accuracy of AcqKnowledge? 

AcqKnowledge performs all internal calculations to the accuracy defined by the IEEE format for 
double precision floating point numbers and stores the results of those calculations in double 
precision floating point format. This format assigns 8 bytes to all numbers involved in calculations or 
resulting from calculations. The 8 bytes (64 bits) are assigned as 52 bits to mantissa, 1 bit to sign, and 
11 bits to exponent. The effective decimal accuracy for calculation operation or storage will be 
defined as [2 to the 52] power or approximately 4.5 E15. Accordingly, the effective decimal accuracy 
will be between 15 and 16 digits. 
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Appendix B - Filter characteristics 
Filter types 
AcqKnowledge employs two types of digital filters:  

(a) Finite Impulse Response (FIR) perform filtering calculations online (during an acquisition) or post-
processing (after an acquisition). 

(b) Infinite Impulse Response (IIR) perform filtering calculations online (during an acquisition) or post-
processing (after an acquisition).  

Although the similarities between the two types of filters outweigh the differences, some important 
distinctions remain. 

1. IIR filters tend to be less accurate than FIR filters. Specifically, IIR filters tend to cause phase 
distortion or “ringing.” When the phase of a waveform is distorted, some data points on a waveform 
are shifted (either forward or backward in time) more than others. This can result in the intervals 
between events (such as the Q-R interval or the inter-beat interval in an ECG waveform) being 
slightly lengthened or shortened compared to the original signal. In practice, however, the effect of 
this distortion is usually minimal since the frequencies which are most distorted are also attenuated 
the most. By contrast, FIR filters are phase linear, which means that the interval between any two 
sample points in the filtered waveform will be exactly equal to the distance between the 
corresponding sample points in the original waveform. 

2. IIR filters have a variable Q setting that defines the filter response pattern, but FIR filters do not have 
a Q component. The optimal Q of an IIR filter is 0.707, with lower values resulting in a flatter 
response and higher values resulting in a more peaked response. The default Q for all IIR filters is 
0.707 (except for Band pass filters where Q defaults to 5), which is appropriate for nearly all filter 
applications. 

In the examples on the following page, the filter responses of several different types of filters are compared. 
All of the filters are 50 HZ low pass filters operating on the same data. 
The first graph shows how the number of filter coefficients in FIR filters (Q) affects the filter’s frequency 
response. Note that as the number of coefficients (Q) increases, the filter becomes more accurate. A good rule 
of thumb is to set Q ≥ 2(fs/ fc), where fs = sampling rate and fc = cutoff frequency. 

 
 FIR filter performance as a function of number of coefficients (Q) 
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The next graph shows how the pole or zero locations of the filter, as related to filter “peaking” (specified by 
Q), affect the frequency response of the filter. The “Q” in this case is not to be confused with the Q from the 
FIR filter. Note how increasing “Q” in the IIR filter case affects filter “peaking.” 

 
FIR filter performance as a function of changes in pole or zero locations 

Coincidentally, the FIR (Q = 10) and IIR (Q = 0.707) filters have very similar responses in this case. 
Technically, the coefficient setting for FIR filters determine the number of multiplies performed by the 
filtering algorithm. In practical terms, it determines how “steep” the frequency response of the filter is. Filters 
with a large number of coefficients have a steep roll-off, whereas the frequency response of filters with a 
smaller number of coefficients is not as steep. 
 
Window Functions 
Window functions are used for two purposes in AcqKnowledge. Windows are applied to the impulse response 
in the (FIR) digital filtering functions, and can optionally be applied as part of the FFT function. In either 
case, a window refers to a computation that spans a fixed number of adjacent data points.  
Typically, window functions are used to eliminate discontinuities that may result at the edges of the fixed 
span of points of the digital filter function (FIR filters) or the data points of the FFT. 
Digital filtering. When a window is used in digital filtering, the impulse response of the filter (rather than the 
data itself) is modified. When the impulse response smoothly approaches zero at both the beginning and end 
of the data, this works relatively well. When the impulse response is not so well behaved, edge effect occurs. 
Edge effects can be minimized by windowing, or forcing the edges of the impulse response to smoothly 
approach zero. The exact process depends on the window selected (see below). 
Another way to minimize edge effect with an FIR filter is to increase the number of coefficients used to 
transform the data. 
FFT. The FFT function also windows data, although the nature of the windowing function is somewhat 
different in the sense that the window operates on the data. One of the assumptions of the FFT is that the input 
data is an infinitely repeating signal with the endpoint wrapping around. In practice, the endpoints are almost 
never exactly equal. You can check this by choosing the Delta measurement item from the measurement 
popup menus, which returns the amplitude difference between the first selected point and the last. To the 
extent that the endpoints differ, the FFT output will produce high frequency components as an artifact of the 
transformation. 
 AcqKnowledge displays only the positive coefficients of an FFT. In this FFT presentation, there is an 

implicit negative frequency component for each positive frequency component, so if you are looking 
at amplitude levels in a linear FFT you need to multiply by two (negative frequency can only be 
created with positive frequencies in the real world). 

By windowing the data, the effects of this phenomenon are greatly diminished. When data are windowed, a 
window is moved across the data, much as the smoothing function moves across the data. Whereas the 
smoothing function simply takes the average of a specified number of points, each type of window weights 
the data somewhat differently. 
The Window pull down menu offers the following options: 
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Bartlett implements triangular windowing and Rectangle does not window the data. The “shape” of the other 
windows is defined by the following formula, where n = 

0

N 1n−  and A, B, C and D are constants: 

A Bcos 2 n
N

Ccos 2 n
N

Dcos 2 n
N

− + +
π π π2 3

 

The table below details the different parameter values for each type of window. 

 Parameter Values 

Type of Window A B C D 

Bartlett n/a n/a n/a n/a 

Blackman 0.42000 0.50000 0.08000 0.00000 

Blackman -61 0.44959 0.49364 0.05677 0.00000 

Blackman -67 0.42323 0.49755 0.07922 0.00000 

Blackman -74 0.40217 0.49703 0.09392 0.00183 

Blackman -92 0.35875 0.48809 0.14128 0.01168 

Hanning 0.50000 0.50000 0.00000 0.00000 

Hamming 0.54000 0.46000 0.00000 0.00000 

Kaiser-Bessel 0.40243 0.49804 0.09831 0.00183 

Rectangle 
Windows/PC only 

n/a n/a n/a n/a 
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Appendix C - Hints for Working with Large Files 
It is not uncommon for users to generate large data files (on the order of several megabytes) through some 
combination of (a) high-speed acquisitions, (b) long acquisitions, and (c) multi-channel acquisitions. Users 
frequently encounter system limitations (such as storage space limitations) and find the files are difficult and 
slow in loading to memory. 
The software that comes with your MP System (MP150 or MP36R) stores the data in as compact a format as 
possible. Each sample takes up roughly two bytes of storage space. When a waveform (or a section of a 
waveform) is transformed (i.e., filtered or integrated) each data point takes up roughly eight bytes of storage 
space. As a result, file size can change drastically after transforming one or more waves. 

Note AcqKnowledge data files greater than 2 GB can be opened, but edit, transformation and analysis 
operation cannot be performed. 

The following tips can help you get the most out of your MP System (MP150 or MP36R) when working with 
large data files. 
 Remove waveforms 
 Since each waveform adds to the total size of the file, try removing (or copying to another file) some 

of the waveforms from a multi-channel file. This is especially true if you would like to perform 
transformations of some sort on at least one of the waves. 

 Sample slowly 
 Theoretical and methodological concerns will, to a large extent, dictate sampling rate. However, if 

you can reduce the sampling rate, choose to do so. Or, use Transform > Resample (page 308) to 
resample data after collecting it. 

 Set preferences 
 Check the “Use all available memory” and the “Draft mode for compressed waves” options under the 

Preferences menu item. This should decrease the time it takes to redraw waveforms and allow the 
software to access all available memory for storage. 

 Store to disk 
 Although slightly slower than storing to RAM, much larger data files can typically be stored to disk 

rather than memory. Loss of power to either the computer or the MP unit can result in data loss. To 
avoid potential data loss, connect both the computer and MP power supply to an uninterruptible 
power supply. 

 Use the Append mode 
 The Append mode allows you to pause the acquisition for arbitrary periods. This can be helpful when 

recording only a few key events that will occur randomly over a long period of time, since it will 
reduce unnecessary data.  

 Compress Files 
 Use the File > Save As > Compressed option to store or transfer data 

 
Note  Copy/Paste, Merge Graphs, and Transformations require AcqKnowledge to allocate additional 

memory and then load the data into memory; when these operations are executed on large data files, 
the application may crash. 
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Appendix D - Customizing Menu Functionality 
AcqKnowledge now includes a powerful customization feature lets you choose the program features to display as 
menu options. If you have a specific procedure, you can limit the menu options to list only those functions you 
need, thereby reducing the chance for confusion or error in your lab. For instance, you might choose to remove 
the “Set Up Triggering” and “Set Up Stimulator” options from the MP150 menu, as shown below: 

   
Default MP menu     Customized MP menu 

Follow the simple procedure below to customize menu display for your own needs. 
1. With the AcqKnowledge application closed, navigate to the menu.dsc file: 

DRIVE:\ProgramData\BIOPAC Systems, Inc\AcqKnowledge 4.4\menu.dsc 
2. Open the menu.dsc file in Notepad. 

 
3. Find the menu and item you want to change (scroll through list as necessary) and type “OFF” to disable the 

menu display. For example, you might change the IDM_STIMULATOR option to OFF, as shown below. 
 Note that ON/OFF is case-sensitive and you must type in ALL CAPS. 
 Deleting a file listing instead of typing OFF will not remove the feature; it will default to ON unless you 

type OFF. 

 
4. Save the changes to the menu.dsc file and close it. 
5. Restart AcqKnowledge. 
6. Check your menu listing. 

 To reactivate a menu item set to OFF, just repeat the above procedure and type “ON” for the 
desired menu item. 

 To revert a customized menu.dsc to the factory default, choose Display > Preferences > Other 
and select “Create default menu configuration file.” After choosing “yes’ in the subsequent 
dialog, the application must be closed and relaunched in order for the change to take effect. 

Note: Application menu customization has a corresponding effect on contextual menu display. If a contextual 
menu item does not have a corresponding application menu item, the menu customization file identifier 
will begin with “IDM_CM.” 
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Appendix E—Locking/Unlocking the MP150 

for Network Operations 
The MP150 is primarily designed to work in Local Area Networks (LAN). In a LAN, each MP150 unit may be 
accessed from any workstation (PC or Mac) running an Ethernet version of AcqKnowledge software. 
Theoretically, two or more workstations (WS) could be connected to one MP150 at the same time, but the MP150 
cannot perform independent acquisitions simultaneously, so in such cases one or all connected WS would receive 
corrupted/invalid data and/or crash. 
To prevent this, AcqKnowledge uses new “lock/unlock” technology that establishes communication between an 
MP150 and one —and only one— dedicated WS in the Network. 

 
AcqKnowledge locks an MP150 as soon as it connects to it, which tells the MP150 to only respond to commands 
from that particular computer and the communication method (serial or ethernet). The lock has a timeout which is 
reset every time the MP150 unit receives a command from the computer that locked it. To locate MP150s in the 
local network, AcqKnowledge sends a broadcast packet to the local area network that asks all the MP150s in the 
network to respond. All the MP150s—whether locked or unlocked—will respond to this prompt. This means that 
the “Select MP150” menu may allow a user to select an MP150 that is locked. In such cases, AcqKnowledge will 
fail to connect (to a locked MP150 unit), as expected. To resolve this issue, unlock or power cycle the MP150 
unit. 

 
Locked  An MP150 becomes “locked” in operation to a WS (and unusable to other users) if 
 a) An MP150 unit is selected from “Select 

MP150.” The dialog lists all MP150 units 
that are powered ON and sitting on the 
same local area network. Unfortunately, 
this dialog cannot provide the 
locked/unlocked status of each MP150 in 
the LAN. You may refer to the BUSY and 
ACTIVITY lights on the MP150 to 
determine the status—if you cannot 
connect to an MP150 but its lights 
indicate data traffic or acquisition, the 
MP150 you are trying to connect to is 
connected to another WS. 

 b) When AcqKnowledge is launched. 
AcqKnowledge will “remember” and try to 
connect the last MP150 used by a WS; if the 
last used MP150 is not available, the user 
must pick an available MP150 unit from the 
“Select MP150” dialog. 

 c) With the advent of any new 
communications or the start of any type of 
acquisition to the MP150 unit. When a WS 
communicates with an “unlocked” MP150 
unit, AcqKnowledge sends a “lock” 
command. 

When an MP150 is locked, its serial number is listed in the Select MP150 dialog but any attempt to 
select a locked MP150 will generate a Hardware Not Found prompt (shown above).  
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Unlocked An MP150 automatically “unlocks” and becomes available to other users  

a) When the user exits AcqKnowledge. 
b)  The user selects another MP150 in the Select MP150 dialog. 
c)  The user selects the “No Hardware” option in the Select MP150 dialog. 
Other, less common conditions that may unlock the MP150 include 
d)  The MP150 is powered OFF and then ON. 
e)  The MP150 does not receive commands/data from the WS or AcqKnowledge for about 5 minutes. 

This time-out can occur when 
 An AcqKnowledge dialog (About, Calculation setup, etc.) is open for a long time. 
 AcqKnowledge or the WS crashes for any reason. 
 You turn the connected WS off without exiting AcqKnowledge. 

If the MP150 becomes unlocked due to a time-out, two scenarios are possible: 
1) The MP150 is locked—If another user has locked the MP150 you had been using, you will see 

the No Hardware Prompt. Check the MP150 lights to determine its status. 
2) The MP150 is unlocked—Your WS will “lock” the MP150 as soon as you initiate communication 

or acquisition; until then, the MP150 remains unlocked and available to others. 
 

No 
Hard-
ware 

When a user selects the “No Hardware” option, the menu of available MP150 units is grayed 
out and becomes unselectable. If a user attempts to connect to a locked MP150, an error 
message will be generated to advise that the MP150 unit is locked to a different computer. 
 
 

Cannot 
lock 

 
 If you receive this “cannot lock” prompt, check that no other user on the network is using the 

MP150, power-cycle the MP150, check the current firmware version (About MP150), and, if 
necessary, update the firmware using MP150Tools (see next Appendix). 
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Appendix F—Firmware Upgrade  
MP150 firmware is upgraded automatically. Unless a firmware warning is displayed at application launch, your 
MP150 already has the latest firmware revision and no further action is necessary. If a firmware warning is 
displayed, contact BIOPAC technical support for more information. 
 
Firmware Rollback Switch 

   IMPORTANT! 
Use the Firmware Rollback Switch only if the MP150 fails to operate 
after a Firmware Upgrade. 

 In all other cases, just turn the MP150 power OFF and then ON and check 
the results of the Start up/Self-Test. 

The Firmware Rollback Switch is located on the bottom of the MP150 unit and is recessed to prevent accidental 
activation. 
Activation of the Firmware Rollback Switch will cause the MP150 unit to operate under the factory-installed 
firmware version. If no upgrades have been performed (the MP150 has only the factory-loaded firmware), the 
Firmware Rollback Switch will have no effect. 
Procedure: 

1. Turn the MP150 unit ON. 
2. Use About MP150 in the AcqKnowledge software to determine the factory-installed firmware version: 

 

IMPORTANT! 
Factory-installed Firmware version 1.1.2 or 
previous (purchased approximately November 
2002 or before) may not reset to a level 
compatible with UDP communication. In such 
cases, you will need to install a DLC-compliant 
version of AcqKnowledge and update to UDP in 
stages; contact BIOPAC for additional support if 
necessary 
Mac OS X: Labeled “Manufacturer’s ROM” and 
“Current ROM” 

3. Turn the MP150 unit OFF. 
4. Turn the MP150 unit upside down and use a small-tipped device (an unfolded pawperclip 

will do) to depress and hold the switch down. 
5. Continue to hold the switch down, and turn the MP150 unit ON. 

• One green and one yellow LED light will begin to blink simultaneously 5 times. 

 While the lights are blinking simultaneously, you may cancel the Rollback by 
releasing the Firmware Rollback Switch. If Rollback is cancelled, the MP150 
will try to load the latest firmware upgraded version. 

• Then the MP150 will perform a normal Startup/Self-Test with the factory-loaded firmware. 
6. When the simultaneous blinking stops, release the switch. 

• The MP150 is now restored to the previous version of firmware. 
• You can check the firmware version via the MP150 > About MP150 menu item in AcqKnowledge. 
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Cubic spline interpolation, 308 
Customizing menu display, 452, 564 
Cutoff frequency, 286 
Cycles/Peaks detect, 3D Output, 331 
Cycles/Peaks tab, Cycles/Peaks detect, 326 

D 
Data View, 44 
Delay 

Calculation channel option, 148 
Trigger Set Up, 175 

Delta measurements, 98 
Derivative, 302 
detrending, 317, 392 
Difference 

online calculation, 133 
transformation function, 307 

Digital 
Digital channels, 35, 115–22 
Digital filters, 283–88, 561 
Digital I/O channels, Manual Control, 233 
Digital output, 149 
Digital triggers, 173 

Digital Outputs Control, 191 
Disk 

Space, sampling rate impact, 36 
Space, storage mode impact, 248 
Storage option, 36, 160, 563 

Display 
Menu commands, 427 
Preferences, 563 

DLC, Ethernet protocol, 451 
Draft mode, 449 
Duplicate waveform, 275 
dZ/dt Specialized Analysis 

Classifier, 394 
Derive from raw Z, 394 
Remove motion artifacts, 401 

E 
ECG Analysis 

Automated ECG App Note, 30 
Detect and Classify Heartbeats, 351 
ECG Interval Extraction, 378 
Heart Rate Variability, 388 
Locate Animal ECG Complex Boundaries, 352 
Locate Human ECG Complex Boundaries, 351 

EDA analysis, 355 
edge effects, 561 
Editing 

Cursor tool, 59 
Edit menu, 272 
Features, 73 

EGrid cursor, 59 
Eigenanalysis (PCA), 323 
Electrode Checker, 171 
Embedded archive, 54 
Ensemble Average, 374 
Epoch Analysis, 375 
Ethernet protocol, 451 
European Data Format (EDF) 

Open, 256 
Save, 266 

Event (Marker) 
Graph Selection, defining via, 231 
Hotkey Setup, 218 
Location, 221 
Measurements, 228 
Overview, 215 
Palette, 220 
Preferences, 216 
Printing, 230 
Toolbar, 216 
Tooltips, 216 
Variable Sampling Rate and, 231 
Waveform editing, 231 

Event amplitude measurement, 99 
Event count measurement, 99 
Event definition cursor, 59 
Event location measurement, 99 
Event marker, 28 
Events, 51 
Events, R wave location, 389 
ex power of a data point, 146 
Excel Spreadsheet Export, 267, 350 
Exp Exponential, 294 
Exporting data, 53, 252 
Expression, 140–52, 309 
Expression evaluator, 140–52 
Expression measurement, 99 

F 
FAQ, 558 
Fast Fourier transformations. See FFT 
FFT, 318–22, 561 
File Compatibility for Specialized Analysis, 349 
File format prompts), 268 
File menu commands, 248 
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File size, 559, 563 
Filter 

Calculation, 139 
characteristics, 560 
response, 287 

Find, 341 
Find Cycle/Peak, Mac OS X, 325 

Finite impulse response filters. See FIR filter 
FIR filters, 283, 286, 560 
Firmware Rollback Switch, 567 
Focus areas, 89 
Font, journal, 451 
Formula 

Area, 95 
BPM, 96 
Correlation, 97 
Delta, 98 
Delta T/F/X, 98 
Freq (Frequency), 99 
Integral, 100 
Lin_reg (Linear regression), 101 
Mean, 102 
Slope, 104 
Stddev (Standard deviation), 104 
Threshold, 138 

Fourier 
FFT Fast Fourier transformation, 318 

Fourier Linear Combiners 
Calculation Channels, 153 
Transformations, 292 

Frequency 
frequency spectrum, 322 
Horizontal scale, 434 
measurement (Freq), 99 
rate calculation (Hz), 346 

Frequency Bands, HRV analysis, 390 
Frequently asked questions, 558 
Friendly Grid Scaling, 82 
Function 

Calculation, 141 
Equation (Expression) commands, 146 

G 
Gain setting, 116 
Gastric Wave Analysis, 352 

Gastric Wave Coupling, 352 
Gauge, 240 
Getting Started, 23 
GLP audit 

include timestamp, 449 
mark selection with Events, 449, 450 

GLP guidelines, customizing menus for, 26 
Graph template files (gtl) 

Open, 252 
Quick Start Files, 125, 252 
Save As, 262 

Graph window, 34 
Gray non-selected waves, 449 
Grid 

Adjust spacing, 432 
GridReset, 432 

H 
Hardware. See note on page 10 
Heart Rate Variability, 30, 388 
Help menu, 456 
Hemodynamic Analysis, 376 

ABP Classifier, 377 
Arterial Blood Pressure, 377 
ECG Interval Extraction, 378 
LVP Classifier, 381 
MAP Classifier, 383 
Measurements App Note, 30 
Monophasic Action Potential, 382 

High pass filter, 284 
Histogram, 313 
Hold button, SIV, 232 
Hold relative position 

Horizontal Scale, 74 
Horizontal 

Axis, 27 
scale, 45 
Scale, 45 
Scroll bar, 74 

Human Subjects, Safety, 213 
Hyperbolic 

Cosine, 146 
Sine, 147 
Tangent, 147 

I 
I/O channels, Manual Control, 233 
I-beam tool 

selection cursor, 59 
IBI Inter-beat Interval, 134, 346 
IFFT. See inverse FFT 
Igor Pro Experiment 

Open (import), 255 
Save As (export), 265 

IIR filters, 283, 288, 560 
Impedance Cardiography Analysis, 394 

Body Surface Area, 394 
Derive dZ/dt from raw Z, 394 
dZ/dt Classifier, 394 
dZ/dt remove motion artifacts, 401 
ICG Analysis, 397 
Ideal Body Weight, 400 
Pre-ejection Period, 400 
Preferences, 402 
VEPT, 401 

Independent Component Analysis, 324 
INF (measurement value), 91 
Infinite impulse response filters. See IIR filters 
Information Dimension measurement, 100 
Initial offset, 74 
Input Values Setup (SIV), 232 
Insert 
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Events, 51 
Waveform, 275 

Installation. See note on page 10 
Integral 

measurement, 100 
Transformation function, 301 

Integrate 
formulas, 304 

Integrate Calculation (online), 127 
inter sample interval, 255, 264 
Interpolate pastings, 450 
Interpolation method, resampling, 308 
Intraventricular Pressure Wave analysis, 30 
Inverse mean square error, 298 

J 
Jewett Sequence, ABR testing for, 30 
Journal, 53 

Copy Measurements, 95 
Paste options, 279 
Preferences, 451 
Show Journal, Mac OS X, 281 

Jump-to tool (correlates data views), 60 

K 
K (Constant), Calculate measurement option, 97 
Kurtosis measurement, 101 

L 
Latency, 163 
Left Ventricular Pressure 

LVP Classifier, 381 
Limit data, Calculation channel Function, 138 
Limit math command, 295 
Lin_reg (linear regression measurement), 101 
line plot, 436 
Linear (FFT option), 321 
Linear interpolation, 308 
Ln natural logarithm, 295 
Locate SCRs, 361 
Location Palette, 437 
Locked MP150, 565 
Log, 147, 295 
Low pass filter, 284, 302 
Lung Volume analysis, 30 
LVP Analysis, 30 
Lyapunov measurement, 102 

M 
Macintosh® system requirements, 24 
Magnetic resonance imaging 

Specialized Analysis, 403 
Manual Control (digital I/O), 233 
Manual stimulator controls, 178 
Math 

Calculation, 136–37 
Functions (Transformation), 294 

Waveform Math, 310 
MATLAB 

Open (import), 254 
Save As (export), 264 

Max measurements, 102 
Max T measurement, 102 
Mean 

Mean square error, 298 
Measurement, 102 
Removal, 297, 320 

Mean subtraction, Integrate option, 128 
Measurement, 50, 91 

Cycles/Peaks Output, 330 
Preferences, 448 
Preferences for Journal, 451 
Presets, 94 
Table of Explanations, 95 

Media menu (capture or playback), 458 
Median measurements, 102 
Median T measurement, 102 
Memory 

Load all data into, 455 
Storage option, 36, 160 
Use all available memory, 451 

Menu configuration file, 452 
Menu display, customizing, 452, 564 
Merge Graphs, 276 
Min (minimum) measurement, 102 
Min T measurement, 102 
Modeling 

Linear 
Autoregressive transform, 314 
Lin_reg measurement, 101 

Nonlinear, 315 
NLM measurement, 103 

Modeling, Autoregressive, 314 
Moment measurement, 103 
Monophasic Action Potential, 382 

MAP Classifier, 383 
Moving average, 306 
MP, data storage option, 160 
MP150 

Locked/Unlocked, 565 
MP150 Serial Number, 237 

MP150 Info (menu option), 238 
MP150 System 

Features, 26 
Overview, 23 

MP150 System Requirements, 24 
Mutual information measurement, 103 

N 
Natural logarithm, Ln, 295 
Network Data Transfer (NDT), 467 
Neurophysiology 

Specialized Analysis, 407 
New 

Data View, 248 
No hardware mode, 237 
Noise, 559 
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Calculation channel Function, 138 
Math command, 295 
Rejection (auto threshold detect, 344 

None (measurement option), 103 
Nonlinear modeling, 315 

NLM measurement, 103 
Normalized cross correlation, 299 

O 
Off-line Averaging, Cycle/Peak Detector (MAC), 

330 
Online filtering, 139 
Open (file command), 251 
Open for Playback, 257 
Options button, Open Text file, 252 
Options, Input Values, 232 
Organize Channel Presets, 245 
Organize List, Preferences, 205 
Output continuously. Stim. Setup, 178, 201 
Output Control, 187 

CH# to Output, 189 
Preferences, 188 
Pulses, 192 
Stimulator – OUT3 adapter, 192 
Stimulator—BSLSTM, 192 

Output tab, Cycles/Peaks detect, 330 
Overlap 

Overlap Waveforms, 430 

P 
P300 measurements, 165 
Pad with…, 318 
Padding (resampling interpolation), 308 
Paste, 274 

Acquisition settings, 279 
Measurement, 279 
Wave data, 279 

Pause mode (Append to disk), 159 
PC-compatible files, 262 
Peak 

Detect (Find Rate option), 344 
Find Cycle (Peak Detector), Mac OS X, 325 
Minimum, 346 

Peak-to-Peak (P-P measurement), 103 
PEP Pre-ejection Period, 400 
Phase, 321 

Distortion, 560 
Phasic EDA options, 363 
PhysioNet 

Save As (export), 263 
PICT files, 278 
Playback mode, 43 
Plot 

Plot on Screen, Setup Channels option, 168 
Plotting data, 35, 244 
Poincare plots, 386 
Power Spectral Density, 317 
Power supply, 559 

P-P (peak-to-peak measurement), 103 
Preferences 

Display Preferences, 444 
Journal preferences, 451 
Menu configuration file, 452 
Output Control, 188 
Undo max, 450 

Presets, 112 
Organize Channel Presets, 245 

Pretrigger, 175 
Principal Component Analysis, 323 
Principal Component Denoising, 413 
Print, 28, 55, 270–71 
PSD Options, HRV analysis, 390 
Pulse Sequence Output Control, 194 
pulse stimuli, 182 
Pulses Output Control, 192 

Q 
Q coefficient, filter setting, 139, 288, 560 
QRS Detector, HRV analysis, 389 
Questions, frequently asked, 558 

R 
Ramp waves, 183 
Rate 

calculation, 133–36, 311 
detector algorithm, 30 

Rate mean measurement, 103 
Rate median measurement, 103 
Rate standard deviation measurement, 103 
Raw data 

Open (import), 255 
Save As (export), 264 

Record 
Start acquisition, 169 

Record/Record last, 158 
Recursive formulas, 143 
Remove 

last appended segment, 275 
mean, 297, 320 
trend, 320 
waveform, 275, 563 

Remove Projection, 298 
Remove Projection Template, 298 
Remove Trend, Specialized Analysis, 413 
Repeat mode, 167, 245 
Repositioning Events (Marker), 221 
Resample, 308 
Resampling Interpolation, 308 
Reset 

Append acquisition button, 159 
reset chart boundaries, size window, 454 
Reset Chart Display, 432 
reset thresholds, Integrate setup, 128 
reset trigger, Integrate setup, 128 

Reset Grid, 432 
Resource allocation, 452 
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Respiratory Sinus Arrhythmia, Specialized Analysis, 
387 

RS-232/RS-422 signal, 558 

S 
Safety Notice, 21 
Sample 

measurement, 103 
Rate, 160–61, 563 
Rate, Acquisition rate, 36 
Rate, Channel, 35, 36, 113 
Rate, Stimulation signal output, 176 

Save, 53 
Save (File command), 261 
Save as (File command), 261, 268 
Save once (Acquisition setup), 158 

Save Settings, Preferences, 193, 205 
Scaling, 114–15 
Scaling, Friendly Grid Scaling, 82 
Scope mode, 38 
Scroll, 45, 73 

Menu option, 244 
Segment Labels, 238 
Select 

All, 275 
Area, 49, 272 
Area for measurement, 92 
Channel, 47, 88 
Cursor tool, 59 
Waveform, 47, 88 

Selection Palette, 436 
Selection tab, Cycles/Peaks detect, 329 
Serial number, MP150, 237 
Set template, 296 
Set Up 

Acquisition, 36 
Channels, 109, 114 
Triggering, 173 

Set wave positions, 432 
Shortcuts 

Keyboard, 65 
Toolbars, 57 

Show 
All Data Snapshots, 54 
Display menu options, 435 
Input values, 111 
Input Values, 232 
Input Values Setup options, 232 
Modified input, 319 

Signal averaging. See Averaging mode 
Sine, 147, 295 
Size window, 454 
Skew measurement, 103 
Slope (measurement), 104 
Smoothing 

online calculation, 132 
transformation function, 306 

Smoothing Baseline Removal, 363 
Snapshot data after acquisition, Preference, 54 
Sound Sequence Output Control, 201 

Specialized Analysis Package, 347, 348 
File Compatibility, 349 

Specifications. See MP Hardware Guide 
Spectral analysis. See FFT 
Spectral subtraction, 419 
Spectrum Analyzer Palette, 441 
Square 

Square, 147 
Square Root, 147, 295 
Waves, 182 

Standard deviation measurement, 104 
Start acquisition, 37 
Starting an acquisition, 169 
Statistics (Waveform Statistics dialog), 444 
Status indicator, 37 
Status indicator, software, 169 
Stddev (standard deviation) measurement, 104 
Step plot, 439 
Stimulation. Dual, 181 
Stimulator 

Stimulator Reference Channel, 213 
Stimulator - BSLSTM, 192 
Stimulator Manual Control, 234 
Stimulator setup, 176 
Stimulator, manual controls, 178 
Stimulus signal, 163, 165, 176, 199 
STM100C Manual Control, 234 
Stopping an acquisition, 169 
Sum measurement, 105 

T 
Tab interval, Journal, 451 
Tangent, 147 
Tau (time constant), 315 
Template functions, 296 
Text Annotation, 60 
Text files, 53, 254 
Textual value display, 76 
Threshold 

Math command, 295 
Tile waveforms 

Tile after transformations, 449 
Tile Waveforms, 428 
Time 

Expression source, 142 
measurement, 105 
Set Horizontal Time scale, 434 
Time scale after importing, 558 

Timestamp, journal preference, 449 
Tone stimuli, 182–83 
Toolbars, 57 
Transform, 50 

Math commands, 294 
Menu commands, 282 
Remove Projection, 298 
Specialized Analysis Package, 347, 348 

transition latency, 422 
Triggering, 173 
Troubleshooting, 558 
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U 
UDP, Ethernet protocol, 451 
Undo, 273 
User Support System, 19 

V 
Value (measurement), 105 
Values checkbox, 35, 111 

Show input values, 232 
Variable Sampling Rate, 36, 113, 176 

data processing notes, 144 
Event plotting and, 231 

VEPT, 401 
Vertical axis, 27, 115 
Vertical scale, 47, 75 
Viewing data, 45 
VO2 measurement, 30 

W 
Warning 

Before overwrite data, 245 
Hardware not found, 32 

Waterfall Plot, 423 
WAV files, 256 

Waveform 
Arithmetic dialog, 97 
Color, 433 
Math transformation, 310–11 
Selection, 47, 88 
Statistics dialog, 444 

Wavelet Denoising, 424 
Window 

Find Rate option, 344 
Functions (filter, FFT), 561 
Menu, 456 

Windows® system requirements, 24 
Working in AcqKnowledge, 31 

X 
X/Y mode, 38, 39 

X/Y loop area analysis, 30 
X-axis T/F/X (measurement), 105 

Z 
Zap, event cursor, 60 
Zoom 

Cursor tool, 49, 59 
Zoom previous, 431 
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COPYRIGHT  
Information in this document is subject to change without notice and does not represent a commitment on the part of 
BIOPAC Systems, Inc. This manual and the software described in it are copyrighted with all rights reserved. Under 
the copyright laws, this manual or the software may not be copied, in whole or part, without written consent of 
BIOPAC Systems, Inc., except in the normal use of the software or to make a backup copy. 

The same proprietary and copyright notices must be affixed to any permitted copies as were affixed to the original. 
This exception does not allow copies to be made for others, whether or not sold, but all of the material purchased 
(with all backup copies) may be sold, given, or loaned to another person. Under the law, copying includes translating 
into another language or format. This software is intended for use on only one machine at a time. 

 

Open source software for Specialized Analysis: 

 PCRE 

Regular expression support is provided by the PCRE library package, which is open source software, written by 
Philip Hazel, and copyright by the University of Cambridge, England. 
ftp://ftp.csx.cam.ac.uk/pub/software/programming/pcre/ 

 The Apache Software License, Version 1.1 

Copyright (c) 1999-2001 The Apache Software Foundation. All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

3. The end-user documentation included with the redistribution, if any, must include the following 
acknowledgment: "This product includes software developed by the Apache Software Foundation 
(http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and 
wherever such third-party acknowledgments normally appear. 

4. The names "Xerces" and "Apache Software Foundation" must not be used to endorse or promote 
products derived from this software without prior written permission. For written permission, please 
contact apache@apache.org. 

5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their 
name, without prior written permission of the Apache Software Foundation. 

THIS SOFTWARE IS PROVIDED ''AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE 
FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT 
OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

=================================================== 

This software consists of voluntary contributions made by many individuals on behalf of the Apache Software 
Foundation and was originally based on software copyright (c) 1999, International Business Machines, Inc., 
http://www.ibm.com. For more information on the Apache Software Foundation, please see 
<http://www.apache.org/>. 
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WARRANTY  
BIOPAC Systems, Inc. warrants its hardware products against defects in materials and workmanship for a period of 
12 months from the date of purchase. If BIOPAC Systems, Inc. receives notice of such defects during the warranty 
period, BIOPAC Systems, Inc. will at its option, either repair or replace the hardware products that prove to be 
defective. This warranty applies only if your BIOPAC Systems, Inc. product fails to function properly under normal use 
and within the manufacturer’s specifications. This warranty does not apply if, in the sole opinion of BIOPAC Systems, 
Inc., your BIOPAC Systems, Inc. product has been damaged by accident, misuse, neglect, improper packing, 
shipping, modification or servicing, by other than BIOPAC Systems, Inc. 

Any returns should be supported by a Return Mail Authorization (RMA) number issued by BIOPAC Systems, Inc. 
BIOPAC Systems, Inc. reserves the right to refuse to accept delivery of any shipment containing any shipping carton 
which does not have the RMA number(s) displayed on the outside. The Buyer shall prepay transportation charges to 
the BIOPAC Systems, Inc. designated site. 

BIOPAC Systems, Inc. makes no warranty or representation, either expressed or implied, with respect to this 
software, its quality, performance, merchantability, or fitness for a particular purpose. As a result, this software is sold 
“As is”, and you, the purchaser, are assuming the entire risk as to its quality and performance. 

In no event will BIOPAC Systems, Inc. be liable for direct, indirect, special, incidental, or consequential damages 
resulting from any defect in the software or its documentation, even if advised of the possibility of such damages, or 
for damage of any equipment connected to a BIOPAC Systems, Inc. product. 

 

TRADEMARKS  
AcqKnowledge is a registered trademark of BIOPAC Systems, Inc. 

Windows is a registered trademark of Microsoft Corporation in the United States and other countries. 

Mac and MacBook are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. 

 

ACKNOWLEDGEMENTS  
Technical Writer: Jocelyn Mariah Kremer, Mike Mullins, with input from Alan Macy, Frazer Findlay, Edward Peterlin, 
and Kelly Stephens. 

Cover and frontispiece illustrations: Creative Resource Group, Santa Barbara, CA. 

Created with Microsoft Word for Windows, JASC, Inc. JasCapture, FastStone Capture, Adobe Photoshop and Corel 
Draw 7. 

Manual Revision: AcqKnowledge 4.4.2 and licenses 

PDF 4.27.2016 


	PREFACE TO ACQKNOWLEDGE SOFTWARE GUIDE 15
	Welcome 15
	Supported Platforms 15
	What’s new for AcqKnowledge 4.4.2 16
	User Support System 19
	Where do I find help? 20
	PART A — GETTING STARTED 23
	Chapter 1  MP Systems Overview 23
	MP36R support 24
	MP System Requirements 24
	Automator Integration and Scripting Support 25
	MP System Features 26
	Application Features 29
	Application Notes 30
	Chapter 2  AcqKnowledge Overview 31
	Launching the AcqKnowledge software 32
	Setting up channels using Module Setup (MP150 Hardware) 34
	Setting up channels manually 34
	Basic Analog Channel Information 35
	Basic Digital Channel Information 35
	Basic Calculation Channel Information 35
	Selecting Hardware 35
	Setting Up Acquisitions 36
	Starting an Acquisition 37
	Stopping an Acquisition 37
	Display Modes 38
	Data Views 44
	Analysis 45
	Selecting a waveform 47
	Show/Hide Channel 47
	Collapsing Channels 48
	Zoom 49
	Select an area 49
	Keyboard data selection 49
	Transform data 50
	Measurements 50
	Events (Markers) 51
	Grids 51
	Horizontal Split View 51
	Autoscroll Horizontal Axis Controls 52
	Journals 53
	Saving data 53
	Format change warnings 53
	“Data Snapshot” — Embedded Archive 54
	Print 55
	Chapter 3  User Interface & Context Menu Features 56
	Toolbars 57
	Main, Display and Scaling Toolbars 58
	Hardware Toolbar 58
	Cursor Toolbar 58
	Selection Palette 62
	Start/Stop Toolbar 62
	Channel Button Toolbar 63
	Event Toolbar 63
	Focus Area Toolbar 63
	Measurements Toolbar 63
	Custom Toolbars for Transformations and Analysis 63
	Toolbar Position Retention and Changes 64
	Axis Controls 64
	Enable Cursor Tools During Acquisitions 64
	Button Transparency 65
	Customizable Chart Track Dividers 65
	Plotting Background Colors 65
	Spectrum Analyzer Palette 65
	Keyboard Shortcuts 65
	Tooltips 69
	Mouse Controls 70
	Mouse Scrollwheel Support 70
	Modification History 70
	Cancelling Transformations and Transformation Progress Bar 71
	Typed Event Label Drawing Improvements 71
	Choose MP150 Help Button 71
	Tooltips 71
	Channel Label, Units Length and Tooltips 71
	Graph Window Tooltip Improvements 72
	Menu Item Tooltips 72
	Chapter 4  Editing and Analysis Features 73
	Scroll bars 73
	Scaling 74
	Horizontal axis 74
	Vertical (Amplitude) axis 75
	Adaptive Scaling 76
	Show Textual Value Display 76
	Grid Details 78
	Grid Options 81
	Journal Details 83
	Journal Contextual Menu 83
	Rich Journals 84
	Journal Toolbar Buttons 84
	Journal Numerical Table Tools 85
	Example of Sum, Mean or Standard 86
	Example of Evaluate Expression 87
	Adding a hyperlink to the Journal 87
	Embedding PDFs in Journals 88
	Select a waveform / channel 88
	Channel Labels 88
	Show/Hide Channel 89
	Focus Areas 89
	Creating Focus Areas 89
	Measurements 91
	Measurement Display 92
	Measurement Area 92
	Measurements and Measurement Presets 94
	Measurement Validation 94
	Measurement Info / Parameters 94
	Measurement Interpolation 95
	Exporting measurements 95
	PART B—ACQUISITION FUNCTIONS: THE HARDWARE MENU 106
	Overview 106
	Set Up Data Acquisition > Data Acquisition Settings 107
	Chapter 5  Set Up Channels 109
	Set Up Channels—The Basics 109
	Module-based analog channel setup 109
	View by Channels 111
	Set Up Channels—Advanced 114
	Analog channels 114
	Increased Channel Count Support (AcqKnowledge 4.3 and above) 115
	Analog channels MP36R 116
	Offset 116
	Adjustable, user defined, digital IIR filters for MP36R 117
	High Pass Filters MP36R 117
	Additional controls in MP36R Input Channel Parameters 118
	MP36R Advanced Preset Settings 118
	MP36R Transducer SSID Table 121
	Digital Channels 122
	Calculation Channels 122
	Metachannel 123
	Chapter 6 Calculation Channel Presets 126
	Integrate Calculation 127
	Smoothing Calculation 132
	Rate Calculation 134
	Signal Parameters Tab 135
	Output Tab 136
	Function Calculation 138
	Filter IIR Calculation 139
	Expression 141
	Delay Calculation 148
	Fourier Linear Combiners: FLC, WFLC, CWFLC Calculations 153
	Basic FLC 153
	Weighted-Frequency FLC 153
	Coupled WFLC/FLC 153
	Adaptive Filtering Calculation 154
	Comb Band Stop Filter Calculation 154
	Metachannel 154
	Rescale Calculation 155
	Slew Rate Limiter 156
	Filter - FIR 157
	Chapter 7   Data Acquisition 158
	Data Acquisition—The Basics 158
	Multiple Hardware 161
	Averaging (MP150 Hardware only) 162
	Overview 162
	Averaging Setup 164
	Advanced Averaging—P300 165
	Repeating 167
	Starting an acquisition 169
	Stopping an Acquisition 169
	Rewind 169
	Saving acquisition data 169
	Timers (Stop watches and Elapsed timers) 170
	Timer Types 170
	Electrode Checker 171
	Chapter 8 Set Up Triggering 173
	Digital Triggers (MP150 only) 173
	Analog Triggers 174
	Chapter 9  Set Up Stimulator 176
	Analog Output for MP150 Users 180
	Dual Stimulation 181
	Square waves 182
	Tone Stimuli 183
	Ramp Waves 183
	Arbitrary Waveform 184
	MP150 Stimulator Sample Rates 185
	Analog Output Upper Limits Summary 186
	Chapter 10 Output Control 187
	CH# to Output 189
	MP36R Input > Output Scaling 190
	Digital Outputs Control 191
	Pulses Output Control 192
	Stimulator – BSLSTM Output Control 192
	Stimulator – Low Voltage Output Control 192
	Stimulator Human Stimulator (STMHUM) Output Control 192
	Pulse Sequence Output Control 194
	Visual Stim Controllable LED – OUT4 Output Control 198
	Arbitrary Wave Output 199
	Sound Sequence Output Control 201
	Pulse Defititions 203
	Output Control Panel Descriptions 204
	Usage Guidelines & Setup Summary for BSLSTM Output Control 213
	Chapter 11  Set Up Event Marking 215
	Events (Markers) 215
	Event (Marker) Overview 215
	Event Toolbar 216
	Event Tooltips 216
	Preferences for Events 216
	Event Marking Setup 218
	Create/Toggle Focus Area Action 219
	Event Palette 220
	Audio 225
	Event Type Options 225
	Printing Events 230
	Events and Waveform Editing 231
	Constructing Graph Selections from Events 231
	Event Plotting and Variable Sampling Rate 231
	Chapter 12  Other Hardware Menu Commands 232
	Show Input Values 232
	Manual Control (MP150 only) 233
	Set Up Linked Acquisitions 235
	Limitations on Linked Acquisitions synchronization methods 236
	Manage Hardware Connections 237
	MP150 Info 238
	Segment Labels 238
	Sound Feedback 238
	Gauge 240
	Gauge Preferences 240
	Segment Timer “Stopwatch” option 242
	Autoplotting, Scrolling and Sweep Display Modes 244
	Warn on Overwrite 245
	Organize Channel Presets 245
	PART C—ANALYSIS FUNCTIONS 247
	Toolbars 247
	Shortcuts 247
	Chapter 13 File Menu Commands 248
	New 248
	Graph Window 248
	New > Graph-specific Journal 248
	New > Independent Journal 248
	New > Data View 248
	New > Batch Acquisition 249
	Batch Errors 249
	Open 251
	Open Recent 257
	Open for Playback 257
	SMI BeGaze Import 257
	Importing SMI Begaze Data into AcqKnowledge 258
	Using the Software Timestamps Option to Align Data 258
	Dataquest Import 258
	Close 260
	Save 261
	Save As 261
	Save Selection As 267
	Save Journal Text As 268
	File Format prompts 268
	Send Email Attachment 269
	Copy to Dropbox – Open from Dropbox 269
	Page setup 270
	Print 270
	Quit 271
	Chapter 14 Edit Menu Commands 272
	Undo / Can’t undo 273
	Cut 273
	Copy 274
	Paste 274
	Clear 274
	Clear all 274
	Select All 275
	Insert waveform 275
	Duplicate waveform 275
	Remove waveform 275
	Remove last appended segment 275
	Create Data Snapshot 275
	Merge Graphs 276
	Merging graphs as data segments 277
	Clipboard 277
	Journal 279
	Chapter 15 Transform Menu Commands 282
	Recently Used Transformations 283
	Digital Filters 283
	FIR Filters 286
	Digital filter dialog 286
	IIR Filters 288
	Adaptive Filtering 289
	Comb Band Stop Filter 289
	Fourier Linear Combiners 292
	Basic FLC 292
	Weighted-Frequency FLC 292
	Math Functions 294
	Template Functions 296
	Set Template 296
	Remove mean 297
	Template algorithms 298
	Adaptive Template Matching 300
	Integral 301
	Derivative 302
	Integrate 303
	Output Reset 303
	Smoothing 306
	Difference 307
	Resample 308
	Resample Graph 308
	Resample Waveform 308
	Expression 309
	Delay 309
	Rescale 310
	Waveform Math 310
	Slew Rate Limiter 311
	Chapter 16 Analysis Menu Commands 313
	Histogram 313
	Autoregressive Modeling 314
	Nonlinear Modeling 315
	Power Spectral Density 317
	AR Time-Frequency Analysis 317
	FFT Fast Fourier Transformation 318
	Inverse FFT 321
	DWT/SWT 323
	Inverse DWT 323
	Principal Component Analysis 323
	Inverse PCA 324
	Independent Component Analysis 324
	Inverse ICA 324
	Find Cycle (Peak Detector) 325
	Cycles/Peaks tab 325
	Find Next Cycle 326
	Find All Cycles in Graph 326
	Find in Selected Area 326
	Find All Cycles in Focus Areas 326
	Find First Cycle 326
	Preview (Selection tab) 326
	Find Cycle definitions 326
	Selection tab 329
	Output tab 330
	Output Measurements 330
	Output: Averaging—Offline 330
	Output 3D Surface 331
	Output Events 332
	Event definition 332
	Event Location Table 334
	Output Focus Area 335
	Output: Clustering 335
	Algorithm Overview 335
	Clustering Settings 336
	Number of clusters 336
	Locate Cluster Centers 337
	Manually 337
	By Learning 337
	Training Set Definition 337
	Max. iterations 337
	Tolerance 337
	Remove Outliers 338
	Clustering Criteria 338
	Clustering Output 338
	Find Rate 341
	Modes of Operation 341
	Additional Find Rate Dialog Settings, Output Tab 346
	Specialized Analysis 347
	Chapter 17 Specialized Analysis 348
	Detect and Classify Heartbeats 351
	Locate Human ECG Complex Boundaries 351
	Locate Animal ECG Complex Boundaries 352
	Gastric Wave Analysis 352
	Gastric Wave Coupling 352
	Chaos Analysis 353
	Detrended Fluctuation Analysis 353
	Optimal Embedding Dimension 353
	Optimal Time Delay 353
	Plot Attractor 354
	Correlation Coefficient 354
	Electrodermal Activity 354
	Derive Phasic EDA from Tonic 355
	Event-related EDA Analysis 356
	Sorting Options 358
	Locate SCRs 361
	EDA Measurements 362
	Electroencephalography 364
	Compute Approximate Entropy 364
	Delta Power Analysis 364
	Derive Alpha RMS 365
	Derive EEG Frequency Bands 365
	EEG Frequency Analysis 366
	Seizure Analysis 367
	Seizure Analysis Parameters 368
	Remove EOG Artifacts 369
	Preferences… 370
	Electromyography 371
	Derive Average Rectified EMG 371
	Derive Integrated EMG 371
	Derive Root Mean Square EMG 372
	EMG Frequency and Power Analysis 372
	Locate Muscle Activation 372
	Preferences… 373
	Ensemble Average 374
	Epoch Analysis 375
	Focus Areas between Events and Segments 376
	Hemodynamic Analysis 376
	ABP Classifier 377
	Arterial Blood Pressure 377
	ECG Interval Extraction 378
	Estimate Cardiac Output from ABP 379
	Left Ventricular Blood Pressure 380
	LVP Classifier 381
	Monophasic Action Potential 382
	MAP Classifier 383
	Preferences 383
	HRV and RSA Analysis 384
	Multi-epoch HRV – Statistical 384
	Multi-epoch HRV and RSA – Spectral 385
	R-R Poincare Plot 386
	Respiratory Sinus Arrhythmia (RSA Time-series) 387
	Single-epoch HRV – Spectral 388
	Frequency Bands 390
	PSD Options 390
	Improvements to PSD Options (AcqKnowledge 4.3 and higher) 392
	Impedance Cardiography Analysis 394
	Body Surface Area 394
	dZ/dt Derive from Raw Z 394
	dZ/dt Classifier 394
	ICG Analysis 397
	Ideal Body Weight 400
	PEP Pre-ejection Period 400
	dZ/dt Remove Motion Artifacts 401
	VEPT 401
	Preferences 402
	Magnetic Resonance Imaging 403
	Artifact Frequency Removal 403
	Artifact Projection Removal 405
	Median Filter Artifact Removal 405
	Signal Blanking 406
	Neurophysiology 407
	Amplitude Histograms 407
	Average Action Potentials 407
	Classify Spikes 408
	Dwell Time Histograms 408
	Find Overlapping Spike Episodes 409
	Generate Spike Trains 409
	Locate Spike Episodes 409
	Set Episode Width and Offset 410
	Preferences 410
	Noldus Format 412
	Principal Component Denoising 413
	Remove Mean 413
	Remove Trend 413
	Respiration 414
	Compliance and Resistance 414
	Penh Analysis 416
	Pulmonary Airflow 418
	Preferences 419
	Spectral Subtraction 419
	Stim-Response 420
	Digital Input to Stim Events 421
	Stim-Response Analysis 422
	Waterfall Plot 423
	Wavelet Denoising 423
	ECG Analysis Algorithm References 425
	Chapter 18 Display Menu Commands 427
	Tile Waveforms 428
	Autoscale Waveforms 429
	Autoscale Single Waveform 430
	Overlap Waveforms 430
	Compare Waveforms 431
	Autoscale Horizontal 431
	Show All Data 431
	Show Default Scales 431
	Zoom Back / Forward 431
	Reset Chart Display 432
	Reset Grid 432
	Adjust Grid Spacing 432
	Set Wave Positions... 432
	Set Channel Visibility 433
	Wave Color 433
	Active Slice Color 433
	Horizontal Axis 434
	Show 434
	Annotations 435
	Channel Buttons 435
	Channel Input Values 435
	Chart 435
	Display Mode Toolbar 435
	Dot plot 435
	Dot size 435
	Events 435
	Event Bar 435
	Event Pallete 435
	Focus Areas 435
	Focus Areas Bar 435
	Grid 435
	Grid Options 435
	Hardware 435
	Journal 435
	Last Dot Only 435
	Line Plot 436
	Line Thickness 436
	Main Toolbar 436
	Measurements 436
	Scaling Toolbar 436
	Scope 436
	Selection Palette 436
	Spectrum Analyzer Palette 437
	Timers 437
	Location Palette 437
	Stacked Plot Options 439
	Step plot 439
	Toolbar 439
	X/Y 439
	Customize Toolbars 440
	Spectrum Analyzer Palette Details 441
	Channel Information 444
	Preferences... 444
	Measurements Preferences 448
	Waveforms Preferences 449
	Event Summary Preferences 450
	Graph Preferences 450
	Journal Preferences 451
	Hardware Preferences 451
	Performance Preferences 451
	Networking Preferences 452
	Other Preferences 452
	Window Preferences 453
	Focus Areas Preferences 453
	Location Preferences 453
	Resetting All Preferences to Factory Default 453
	Scroll options 454
	Size window... 454
	Cursor Style 454
	Create Data View 454
	Create Focus Area 455
	Organize Data Snaphots 455
	Show All Data Snaphots 455
	Load All Data Into Memory 455
	Chapter 19 Program & OS Menus 456
	AcqKnowledge menu 456
	Window menu 456
	Bring All to Front 456
	Help menu 456
	Chapter 20 Media Menu 458
	Synchronization Tip 459
	Media > Set Up 460
	Linked Media 461
	Media > Capture 461
	Playback Preview 461
	Media Playback Example 462
	Media Capture Setup with CAM-HFR-A High Speed Camera 464
	PART D — LICENSED FUNCTIONALITIES 466
	Chapter 21 Licensed Functionality: Network Data Transfer 467
	Data Connections 468
	Variable Sampling Rates 468
	Transfer Types 468
	Single Connection 468
	Multiple Connection 469
	XML-RPC 470
	Transport Protocol 470
	TCP/IP 470
	UDP 470
	XML-RPC 471
	Real-time Delivery Guarantees 471
	Data Formats 472
	Default Data Connection Settings 472
	Locating AcqKnowledge Servers 473
	Control Connections 473
	TCP Port 473
	Control Procedure Calls 473
	Channel Index Parameter Structures 473
	Querying Acquisition Parameters 474
	Data Connection Configuration Commands 475
	Reading Data During Acquisition 478
	Other Control Connection Commands 479
	Chapter 22 Licensed Functionality: Vibromyography 481
	Sampling Rate Restrictions 481
	Transducer Setup 481
	Post-Analysis Selection Adjustment 482
	Data Modification History Name 482
	VMG Calculation Channel Preset 482
	VMG Sample Data Files 483
	Chapter 23 Licensed Functionality: Scripting 484
	Scripting Menu 485
	Script Editor 485
	Variables Explorer 486
	Example Scripts 486
	Run Macro Calculation Channel 486
	More Scripting References 487
	Chapter 24 Licensed Functionality: Remote Monitoring 488
	About Remote Monitoring 488
	Remote Monitoring in AcqKnowledge Networking Preferences 488
	Remote Monitoring Client 489
	Remote Monitoring Client Browser 489
	Open Graphs Page 491
	Configuration Settings Page 491
	Data Monitoring Page 492
	Controls in Visible Range (Change Range) dialog 494
	Chapter 25 Licensed Functionality: B-Alert 495
	Data Acquisition and Analysis with B-Alert™ 495
	Acquisition Setup 497
	Channel Setup 497
	B-Alert-specific Hardware Menu Options 498
	Assign Definition File 501
	Output to ABM File Format 502
	Opening the ABM Data File 503
	Linked Acquisitions in B-Alert 504
	Cognitive Analysis Calculation Channels 504
	Data Output 505
	Chapter 26 Licensed Functionality: PV Loop Analysis 506
	Loop Location 506
	PV Loop Analysis Preferences 506
	Baseline Analysis 507
	Locate ES and ED Boundaries 507
	Realtime Display 507
	Full PV Loop Analysis 509
	Multiple loop measures 510
	Chapter 27 Licensed Functionality: Baroreflex Analysis 515
	Baroreflex Sequence Analysis 515
	Sequence Analysis Setup Dialog 515
	Baroreflex Slope Analysis 516
	Slope Analysis Setup Dialog 516
	Baroreflex Sequence Method Description 518
	Baroreflex Slope Method Description 518
	Chapter 28 Licensed Functionality: Actigraphy 519
	Actigraphy User Interface 519
	Creating Actigraphy Files 519
	Importing Raw Accelerometer Data 520
	Opening an Existing Actigraphy File 520
	Actigraphy Analysis Settings 522
	Actigraphy Analysis Settings Controls 522
	Sadeh Scoring Algorithm for Wake/Sleep Classification 523
	Sleep Derived Measures (Sleep Analysis) 524
	Activity Level Measures 524
	Actigraphy Specialized Analysis 525
	Chapter 29 BioHarness Bluetooth 527
	Chapter 30 Stellar Telemetry 528
	Stellar Telemetry System 528
	Stellar Experiment Interface in AcqKnowledge 528
	Description of the Stellar Calendar Controls 529
	Stellar-specific Setup Window Menus 532
	Running a Stellar Experiment 538
	Import and Display of Stellar Data in AcqKnowledge 540
	Saving Graphs and Settings from Stellar Experiments 540
	Stellar Analysis in AcqKnowledge 541
	Chapter 31 Mobita 544
	AcqKnowledge Interface in Mobita 544
	Selecting or Adding Mobita Hardware in AcqKnowledge 545
	Mobita Menu 545
	Mobita Analog Channels Setup 546
	Analog Channel Digital Filters 546
	Mobita Calculation Channels 547
	Enable Common Average Value Removal 547
	Mobita Acquisition (Length/Rate) Settings 547
	Changing Acquisition Modes or Resetting Hardware 548
	Mobita Network Connection Utility 549
	Chapter 32 FaceReader 552
	How Does FaceReader Work? 553
	Using FaceReader with AcqKnowledge 553
	Creating a FaceReader Project and Recording in AcqKnowledge 554
	Creating AcqKnowledge Graphs from a Saved FaceReader Analysis 555
	FaceReader Signals 555
	Valence and Arousal 555
	Connection Issues 556
	PART E — APPENDICES 558
	Appendix A - Frequently Asked Questions 558
	Appendix B - Filter characteristics 560
	Filter types 560
	Window Functions 561
	Appendix C - Hints for Working with Large Files 563
	Appendix D - Customizing Menu Functionality 564
	Appendix E—Locking/Unlocking the MP150 for Network Operations 565
	Appendix F—Firmware Upgrade 567
	Firmware Rollback Switch 567
	INDEX 568
	Preface to AcqKnowledge Software Guide
	Welcome
	Supported Platforms 
	What’s new for AcqKnowledge 4.4.2
	User Support System
	Where do I find help?

	Part A — Getting Started
	Chapter 1  MP Systems Overview
	MP36R support
	MP System Requirements
	Automator Integration and Scripting Support
	 MP System Features
	Application Features
	Application Notes

	Chapter 2  AcqKnowledge Overview
	Launching the AcqKnowledge software
	Setting up channels using Module Setup (MP150 Hardware)
	Setting up channels manually
	Basic Analog Channel Information
	Basic Digital Channel Information
	Basic Calculation Channel Information
	Selecting Hardware
	Setting Up Acquisitions
	Starting an Acquisition
	Stopping an Acquisition
	Display Modes
	Data Views
	Analysis
	Selecting a waveform
	Show/Hide Channel
	Collapsing Channels
	Zoom
	Select an area
	Keyboard data selection
	 Transform data
	Measurements
	Events (Markers)
	Grids
	Horizontal Split View
	Autoscroll Horizontal Axis Controls
	Journals
	Saving data
	Format change warnings

	“Data Snapshot” — Embedded Archive
	Print

	Chapter 3  User Interface & Context Menu Features
	Main, Display and Scaling Toolbars
	Hardware Toolbar
	Cursor Toolbar
	Selection Palette
	Start/Stop Toolbar
	Channel Button Toolbar
	Event Toolbar
	Focus Area Toolbar
	Measurements Toolbar
	Custom Toolbars for Transformations and Analysis
	Toolbar Position Retention and Changes
	Axis Controls
	Button Transparency
	Customizable Chart Track Dividers
	Plotting Background Colors
	Spectrum Analyzer Palette
	Keyboard Shortcuts
	Tooltips
	Mouse Controls
	Mouse Scrollwheel Support
	Modification History
	Cancelling Transformations and Transformation Progress Bar
	Typed Event Label Drawing Improvements
	Choose MP150 Help Button
	Channel Label, Units Length and Tooltips
	Graph Window Tooltip Improvements
	Menu Item Tooltips

	Chapter 4  Editing and Analysis Features
	Edit menu functionality during acquisition
	Scroll bars
	Scaling
	Horizontal axis
	Vertical (Amplitude) axis

	Adaptive Scaling
	Show Textual Value Display
	Grid Details
	Grid Options

	Journal Details
	Journal Contextual Menu
	Rich Journals
	Journal Toolbar Buttons
	Journal Numerical Table Tools
	Example of Sum, Mean or Standard
	Example of Evaluate Expression
	Adding a hyperlink to the Journal
	Embedding PDFs in Journals
	Select a waveform / channel

	Channel Labels
	Show/Hide Channel
	Focus Areas
	Creating Focus Areas
	Measurements
	Measurement Display
	Measurement Area
	 Single-point measurements
	 Selected range measurements

	Measurements and Measurement Presets 
	Measurement Validation
	Measurement Info / Parameters
	Measurement Interpolation
	Exporting measurements
	 Copying measurements to the journal: 
	 Copying measurements to the clipboard: 
	Measurement Definitions




	Part B—Acquisition Functions: The Hardware Menu
	Overview
	Set Up Data Acquisition > Data Acquisition Settings
	Edit menu functionality during acquisition

	Chapter 5  Set Up Channels
	Set Up Channels—The Basics
	Module-based analog channel setup 
	View by Channels

	Set Up Channels—Advanced
	Analog channels
	Increased Channel Count Support (AcqKnowledge 4.3 and above)
	Analog channels MP36R
	Offset
	Adjustable, user defined, digital IIR filters for MP36R
	High Pass Filters MP36R
	Additional controls in MP36R Input Channel Parameters
	MP36R Advanced Preset Settings
	MP36R Transducer SSID Table
	Digital Channels
	Calculation Channels
	Metachannel 

	 Chapter 6 Calculation Channel Presets
	Integrate Calculation
	Smoothing Calculation
	Rate Calculation
	Signal Parameters Tab
	Output Tab
	Function Calculation
	Filter IIR Calculation
	Expression


	Time (in sec) of current evaluation step
	Delay Calculation
	Fourier Linear Combiners: FLC, WFLC, CWFLC Calculations
	Basic FLC 
	Weighted-Frequency FLC
	Coupled WFLC/FLC
	Adaptive Filtering Calculation
	Comb Band Stop Filter Calculation
	Metachannel 
	Rescale Calculation
	Slew Rate Limiter
	Filter - FIR
	Chapter 7   Data Acquisition
	Data Acquisition—The Basics
	Multiple Hardware

	Averaging (MP150 Hardware only)
	Overview
	Averaging Setup
	Advanced Averaging—P300
	Repeating

	Starting an acquisition
	Stopping an Acquisition
	Rewind
	Saving acquisition data
	Timers (Stop watches and Elapsed timers)
	Timer Types
	Electrode Checker

	Chapter 8 Set Up Triggering
	Digital Triggers (MP150 only)
	Analog Triggers

	Chapter 9  Set Up Stimulator
	Analog Output for MP150 Users
	Dual Stimulation
	Square waves
	Tone Stimuli
	Ramp Waves
	Arbitrary Waveform
	MP150 Stimulator Sample Rates
	Analog Output Upper Limits Summary

	Chapter 10 Output Control
	MP36R Input > Output Scaling
	Digital Outputs Control
	Pulses Output Control
	Stimulator – BSLSTM Output Control
	Stimulator – Low Voltage Output Control
	Stimulator Human Stimulator (STMHUM) Output Control
	Pulse Sequence Output Control
	Visual Stim Controllable LED – OUT4 Output Control
	Arbitrary Wave Output
	Sound Sequence Output Control
	Pulse Defititions
	Output Control Panel Descriptions
	Usage Guidelines & Setup Summary for BSLSTM Output Control

	Chapter 11  Set Up Event Marking
	Events (Markers)
	Event (Marker) Overview
	Event Toolbar
	Event Tooltips
	Preferences for Events
	Event Marking Setup
	Create/Toggle Focus Area Action
	Event Palette
	Event List
	Selected Event
	Display
	Actions
	Actions Button
	Description
	Find
	Find Next
	Cut Selected Event
	ClearClear all
	Summarize in Journal
	Mark Selection
	Restore from Snapshot


	Audio
	Event Type Options
	Global
	Event Measurements 
	Event Amplitude Measurement
	Event Count Measurement
	Event Location Measurement

	Printing Events
	Event display setting
	Printed result

	Events and Waveform Editing
	Constructing Graph Selections from Events
	Event Plotting and Variable Sampling Rate


	Chapter 12  Other Hardware Menu Commands
	Show Input Values
	Manual Control (MP150 only)
	Set Up Linked Acquisitions
	Limitations on Linked Acquisitions synchronization methods
	Manage Hardware Connections
	MP150 Info
	Segment Labels
	Sound Feedback
	Gauge
	Gauge Preferences
	Segment Timer “Stopwatch” option 

	Autoplotting, Scrolling and Sweep Display Modes
	Warn on Overwrite
	Organize Channel Presets 


	Part C—Analysis Functions
	Toolbars
	Shortcuts
	 Chapter 13 File Menu Commands
	New
	Graph Window
	New > Graph-specific Journal
	New > Independent Journal
	New > Data View
	New > Batch Acquisition
	Batch Errors

	Open
	Open Recent
	Open for Playback
	SMI BeGaze Import
	Importing SMI Begaze Data into AcqKnowledge
	Using the Software Timestamps Option to Align Data
	Dataquest Import
	Close
	Save
	Save As
	Save Selection As
	Save Journal Text As
	File Format prompts

	Page setup
	Quit 

	Chapter 14 Edit Menu Commands
	Edit menu functionality during acquisition
	Undo / Can’t undo
	Cut
	Copy
	Paste
	Clear
	Clear all
	Select All
	Insert waveform
	Duplicate waveform
	Remove waveform
	Remove last appended segment
	Create Data Snapshot
	Merge Graphs
	Merging graphs as data segments
	Clipboard
	Journal

	Chapter 15 Transform Menu Commands
	Recently Used Transformations
	Digital Filters
	Low pass filtering
	High pass filtering
	Band pass filter
	Band stop filter
	FIR Filters
	Digital filter dialog 
	IIR Filters
	Adaptive Filtering
	Comb Band Stop Filter 

	Fourier Linear Combiners
	Basic FLC 
	Weighted-Frequency FLC

	Math Functions
	Template Functions
	Set Template
	Remove mean
	Template algorithms
	Adaptive Template Matching

	Integral
	Derivative
	Integrate
	Output Reset

	Smoothing
	Difference 
	Resample 
	Resample Graph
	Resample Waveform

	Delay
	Rescale
	Waveform Math
	Slew Rate Limiter

	Chapter 16 Analysis Menu Commands
	Histogram
	Autoregressive Modeling
	Nonlinear Modeling
	Power Spectral Density
	AR Time-Frequency Analysis
	FFT Fast Fourier Transformation
	Inverse FFT

	DWT/SWT 
	Inverse DWT
	Principal Component Analysis
	Inverse PCA

	Independent Component Analysis
	Inverse ICA

	Find Cycle (Peak Detector) 
	Cycles/Peaks tab

	Find Next Cycle
	Find All Cycles in Graph
	Find in Selected Area
	Find All Cycles in Focus Areas
	Find First Cycle
	Preview (Selection tab)
	Find Cycle definitions
	Peaks
	Events
	Start / End
	Match pairs
	Located on
	With Labels optional
	Fixed Interval

	Selection tab
	Output tab
	Output Measurements
	Output: Averaging—Offline
	Output 3D Surface
	Output Events
	Event definition
	Output type
	Output channel
	Output label
	Offset
	Direction of crossing

	Event Location Table
	Output Focus Area
	Output: Clustering
	Algorithm Overview
	Clustering Settings
	Number of clusters
	Locate Cluster Centers
	Manually
	By Learning
	Training Set Definition
	Max. iterations
	Tolerance
	Remove Outliers
	Clustering Criteria
	Clustering Output
	The following example details how to detect the positive spike in the QRS complex—a typical use of the Find Cycle (peak detection) function.


	Find Rate
	Modes of Operation
	Signal type
	Peak detect
	Remove baseline
	Auto threshold detect
	Threshold level
	Noise rejection
	Cycle Interval Window
	Window (Peak Interval)
	Additional Find Rate Dialog Settings, Output Tab
	Function
	Use Averaging Mode
	Output reset events
	Put Result in New Graph
	Find Rate of Entire Wave
	Don’t Find


	Specialized Analysis

	Chapter 17 Specialized Analysis
	Detect and Classify Heartbeats
	Locate Human ECG Complex Boundaries
	Locate Animal ECG Complex Boundaries
	Gastric Wave Analysis
	Gastric Wave Coupling
	Chaos Analysis
	Detrended Fluctuation Analysis 
	Optimal Embedding Dimension 
	Optimal Time Delay 
	Plot Attractor 

	Correlation Coefficient
	Electrodermal Activity
	Derive Phasic EDA from Tonic
	Event-related EDA Analysis
	Sorting Options
	Locate SCRs
	EDA Measurements

	Electroencephalography
	Compute Approximate Entropy
	Delta Power Analysis
	Derive Alpha RMS
	Derive EEG Frequency Bands
	EEG Frequency Analysis
	Seizure Analysis
	Seizure Analysis Parameters
	Remove EOG Artifacts 
	Preferences…

	Electromyography
	Derive Average Rectified EMG
	Derive Integrated EMG
	Derive Root Mean Square EMG
	EMG Frequency and Power Analysis
	Locate Muscle Activation
	Preferences…

	Ensemble Average
	Epoch Analysis 
	Focus Areas between Events and Segments
	Hemodynamic Analysis
	ABP Classifier 
	Arterial Blood Pressure 
	ECG Interval Extraction 
	Estimate Cardiac Output from ABP
	Left Ventricular Blood Pressure
	Computation of Tau

	LVP Classifier 
	Monophasic Action Potential 
	Plateau position

	MAP Classifier 
	Preferences

	HRV and RSA Analysis
	Multi-epoch HRV – Statistical
	Multi-epoch HRV and RSA – Spectral 
	R-R Poincare Plot
	Respiratory Sinus Arrhythmia (RSA Time-series)
	Single-epoch HRV – Spectral

	Impedance Cardiography Analysis
	Body Surface Area 
	Body Surface Area equation

	dZ/dt Derive from Raw Z 
	dZ/dt Classifier 
	ICG Analysis 
	Ideal Body Weight 
	PEP Pre-ejection Period 
	dZ/dt Remove Motion Artifacts 
	VEPT 
	Preferences

	Magnetic Resonance Imaging
	Artifact Frequency Removal
	Artifact Projection Removal
	Median Filter Artifact Removal
	Signal Blanking

	Neurophysiology
	Amplitude Histograms
	Average Action Potentials
	Classify Spikes
	Dwell Time Histograms
	Find Overlapping Spike Episodes
	Generate Spike Trains
	Locate Spike Episodes
	Set Episode Width and Offset
	Preferences

	Noldus Format
	Principal Component Denoising
	Remove Mean
	Remove Trend
	Respiration
	Compliance and Resistance
	Penh Analysis
	Pulmonary Airflow 
	Preferences

	Spectral Subtraction
	Stim-Response
	Digital Input to Stim Events
	Stim-Response Analysis

	Waterfall Plot
	Wavelet Denoising
	ECG Analysis Algorithm References

	Chapter 18 Display Menu Commands
	Tile Waveforms
	Autoscale Waveforms
	Autoscale Single Waveform
	Overlap Waveforms
	Compare Waveforms
	Autoscale Horizontal
	Show All Data
	Show Default Scales
	Zoom Back / Forward
	Reset Chart Display
	Reset Grid
	Adjust Grid Spacing
	Set Wave Positions... 
	Set Channel Visibility
	Wave Color
	Active Slice Color

	Horizontal Axis
	Show
	Annotations
	Channel Buttons
	Channel Input Values
	Chart
	Display Mode Toolbar
	Dot plot
	Dot size
	Events
	Event Bar
	Event Pallete
	Focus Areas
	Focus Areas Bar
	Grid
	Grid Options
	Hardware
	Journal
	Last Dot Only
	Line Plot
	Line Thickness 
	Main Toolbar
	Measurements
	Scaling Toolbar
	Scope

	Selection Palette
	Spectrum Analyzer Palette
	Timers
	Location Palette
	Stacked Plot Options
	Step plot
	Toolbar
	X/Y
	Customize Toolbars
	Spectrum Analyzer Palette Details

	Channel Information
	Preferences...
	Measurements Preferences
	Waveforms Preferences
	Event Summary Preferences
	Graph Preferences
	Journal Preferences
	Hardware Preferences
	Performance Preferences 
	Networking Preferences 
	Other Preferences
	Window Preferences
	Focus Areas Preferences
	Location Preferences
	Resetting All Preferences to Factory Default
	Scroll options
	Size window...

	Cursor Style
	Create Data View
	Create Focus Area
	Organize Data Snaphots
	Show All Data Snaphots
	Load All Data Into Memory

	Chapter 19 Program & OS Menus
	AcqKnowledge menu
	Window menu
	Bring All to Front

	Help menu

	Chapter 20 Media Menu
	Synchronization Tip
	Media > Set Up
	Linked Media 
	Media > Capture
	Playback Preview
	Media Playback Example
	Media Capture Setup with CAM-HFR-A High Speed Camera


	Part D — Licensed Functionalities
	Chapter 21 Licensed Functionality: Network Data Transfer
	Data Connections
	Variable Sampling Rates
	Transfer Types
	Single Connection
	Variable Sample Rate Considerations

	Multiple Connection
	Variable Sampling Rate Considerations

	XML-RPC

	Transport Protocol
	TCP/IP
	UDP
	XML-RPC

	Real-time Delivery Guarantees
	Data Formats
	Default Data Connection Settings
	Locating AcqKnowledge Servers
	Control Connections
	TCP Port
	Control Procedure Calls
	Channel Index Parameter Structures
	Querying Acquisition Parameters
	getMPUnitType
	getEnabledChannels
	getChannelScaling
	getSamplingRate
	getDownsamplingDivider

	Data Connection Configuration Commands
	getDataConnectionMethod
	changeDataConnectionMethod
	getDataConnectionHostname
	changeDataConnectionHostname
	getTransportType
	changeTransportType
	getUDPPacketSize
	setUDPPacketSize
	getUDPBroadcastEnabled
	changeUDPBroadcastEnabled
	getSingleConnectionModePort
	changeSingleConnectionModePort
	getDataDeliveryEnabled
	changeDataDeliveryEnabled
	getMostRecentSampleValueDeliveryEnabled
	changeMostRecentSampleValueDeliveryEnabled
	getDataConnectionPort
	changeDataConnectionPort
	getDataType
	changeDataType
	setDataConnectionTimeoutSec

	Reading Data During Acquisition
	getMostRecentSampleValue
	getMostRecentSampleValueArray

	Other Control Connection Commands
	loadTemplate
	getAcquisitionInProgress
	toggleAcquisition
	setOutputChannel



	Chapter 22 Licensed Functionality: Vibromyography
	Sampling Rate Restrictions
	Transducer Setup 
	Post-Analysis Selection Adjustment
	Data Modification History Name
	VMG Calculation Channel Preset
	VMG Sample Data Files

	Chapter 23 Licensed Functionality: Scripting
	Scripting Menu 
	Script Editor
	Variables Explorer
	Example Scripts
	Run Macro Calculation Channel
	More Scripting References

	Chapter 24 Licensed Functionality: Remote Monitoring
	About Remote Monitoring
	Remote Monitoring in AcqKnowledge Networking Preferences
	Remote Monitoring Client
	Remote Monitoring Client Browser
	Open Graphs Page
	Configuration Settings Page
	Data Monitoring Page
	Controls in Visible Range (Change Range) dialog


	Chapter 25 Licensed Functionality: B-Alert
	Data Acquisition and Analysis with B-Alert™
	Acquisition Setup
	Channel Setup
	B-Alert-specific Hardware Menu Options  
	Assign Definition File 
	Output to ABM File Format 
	Opening the ABM Data File

	Chapter 26 Licensed Functionality: PV Loop Analysis
	Chapter 27 Licensed Functionality: Baroreflex Analysis
	Baroreflex Sequence Analysis
	Sequence Analysis Setup Dialog
	Baroreflex Slope Analysis  
	Slope Analysis Setup Dialog
	Baroreflex Sequence Method Description
	Baroreflex Slope Method Description

	Chapter 28 Licensed Functionality: Actigraphy
	Actigraphy User Interface
	Creating Actigraphy Files
	Importing Raw Accelerometer Data
	Opening an Existing Actigraphy File
	Actigraphy Analysis Settings
	Actigraphy Analysis Settings Controls
	Sadeh Scoring Algorithm for Wake/Sleep Classification
	Sleep Derived Measures (Sleep Analysis)
	Activity Level Measures 
	Actigraphy Specialized Analysis

	Chapter 29 BioHarness Bluetooth
	Chapter 30 Stellar Telemetry 
	Stellar Telemetry System
	Stellar Experiment Interface in AcqKnowledge
	Description of the Stellar Calendar Controls
	Stellar-specific Setup Window Menus
	Running a Stellar Experiment
	Import and Display of Stellar Data in AcqKnowledge
	Saving Graphs and Settings from Stellar Experiments 
	Stellar Analysis in AcqKnowledge

	Chapter 31 Mobita
	AcqKnowledge Interface in Mobita
	Selecting or Adding Mobita Hardware in AcqKnowledge 
	Mobita Analog Channels Setup
	Analog Channel Digital Filters
	Mobita Calculation Channels
	Enable Common Average Value Removal
	Mobita Acquisition (Length/Rate) Settings
	Changing Acquisition Modes or Resetting Hardware
	Mobita Network Connection Utility

	Chapter 32 FaceReader
	How Does FaceReader Work?
	Using FaceReader with AcqKnowledge
	Creating a FaceReader Project and Recording in AcqKnowledge
	Creating AcqKnowledge Graphs from a Saved FaceReader Analysis
	FaceReader Signals
	Valence and Arousal
	Connection Issues


	Part E — Appendices
	Appendix A - Frequently Asked Questions
	Appendix B - Filter characteristics
	Filter types
	Window Functions

	Appendix C - Hints for Working with Large Files
	Appendix D - Customizing Menu Functionality
	Appendix E—Locking/Unlocking the MP150for Network Operations
	Appendix F—Firmware Upgrade 
	Firmware Rollback Switch


	INDEX
	Word Bookmarks
	TOC
	Textstart
	myResource
	New38
	UsingThisManual
	MP36R_Support
	MaconIntel
	AutomatorIntegraion
	AppNoteList
	RangeAck
	ChSetup
	IntroSetupChannel
	SampleRateCh
	SampleRateAcq
	RangeDisplay
	DisplayModes
	OverlapSegment
	StackedPlotShowOptions
	OLE_LINK5
	OLE_LINK6
	Playback
	DataViews
	IntroSelectArea
	RangeMeasure
	IntroMeasurements
	Grid
	HorizSplitView
	AutoscrollButton
	PlottingModes
	Journal
	DataSnapshot
	OLE_LINK9
	OLE_LINK10
	Toolbar
	AckTools
	JumpTool
	TextAnnotation
	Measurements_toolbar
	KeyboardShortcuts
	RightClick
	MouseScrollwheel
	context_menus
	AckOverview
	HorScale
	VertScale
	TextualValueDisplay
	AdaptiveScaling
	GRIDS
	GridDetails
	GridMac
	GridSpacing
	ResetGrid
	GridOptions
	Holdrelative
	JournalDetails
	ChannelSelect
	ShowHideChannel
	FocusAreas
	Measurements
	EditMeasurement
	SamplePoint1at0
	Descriptions
	MeasurementDefinitions
	FreqTimeDomain
	NLMmeasure
	MPmenu
	SetupChannels
	module_setup
	ViewByChannels
	SetupChanPlot
	Presets
	ChSampRateVSR
	RangeAnalog
	AnalogScaling
	RangeScaling
	Calibration
	RangeDigital
	CHSetupMP36R
	SSIDTable
	CalcChannels
	RangeCalculation
	metachannels
	IntegrateCalc
	RangeRate
	OnlineRate
	RangeMath
	Function
	CombBandStopCalc
	FilterCalc
	OnlineFilter
	BandPassLowHigh
	RangeExpression
	EquationGen
	OnlineExpressionEval
	RangeControl
	EquationGen_tables
	FourierLinearCombinersCalc
	AdaptiveFilerCalc
	Rescale_calc
	SlewRateLimiter
	SetUpAcq
	RecordLast
	Autosave
	Append
	OLE_LINK11
	OLE_LINK12
	PauseMode
	Storage
	RangeSample
	SamplingWavesStart
	SamplingWavesEnd
	ECGwaveSamples
	MultipleHW
	ConnectTo
	Averaging
	RangeAveraging
	AveragingUsageNote
	AdvancedAveraging
	AveragingAdvanced
	Repeating
	RewindAppend
	SetupTrigger
	Triggering
	Setupstimulator
	SetupStim
	StimONOFF
	SampleRateStim
	StimAvg
	ManualStimControl
	StimSampleRate
	DualStim
	AnalogOut_MP150
	StimSquare
	RangeSquare
	SquareWave
	RangeSquare
	SquareWave
	SegmentWidthLevel
	RangeTone
	StimTone
	StimRamp
	StimArb
	RangeArb
	RangeArb
	MP150StimSampleRates
	OutputControlOpeningPrefs
	OutputControlCH
	InputOutputMP35
	OutputControlDigital
	PulsesOC
	OCStimulatorBSLSTM
	BSLSTM
	OCLowVoltage
	Output_Control_STMHUM
	OCPulseSequence
	OCSoundSequence
	OCVisual_Controllable_LED
	ArbWaveOutput
	Pulse_Definitions
	OutputPanel
	SaveSettings
	OrganizeListPreferences
	OutputControlTabGen
	OutputControlGen
	OutputControlTabGen
	OutputControlTabAdv
	SaveSettingsPreferences
	GeneralTab
	OutputControlTabLev
	OutputControlVoltage
	StimulatorBSLSTM
	OutputControlStimBSL
	StimulatorSafetyNote
	StimulatorOutputControlPanel
	StimulatorPreferences
	Events_CH7
	EventSetup
	EventDisplay
	EventPreferences
	EventHotkey
	EventMarkingSetup
	EventPalette
	EventList
	SelectedEvent
	DisplayEvent
	Display_Events
	EventDisplayLocation
	EventDisplayLocation
	EventDetail
	ActionsEvent
	EventJournal
	EventType
	EventAmplitudeMeasure
	Evt_ampl
	Evt_count
	EventLocationMeasure
	Evt_loc
	EventPrint
	EventMeasure_Mac
	RangeInputValues
	InputValues
	ShowInputValues
	ManualControl
	SetUpLinkedAcquisitions
	VideoMenu
	UpdateFirmware_MPmenu
	SegmentLabels
	Gauge
	AutoAndScroll
	PresetsOrgCh
	FileMenu
	Batch
	BatchResume
	FileOpen
	GraphTemplate
	GraphTemplateOPEN
	QuickStartTable
	BSLFileOpen
	ColumnDelimiter
	FileOpenText
	Delimiter
	RangeText
	MatLabOpen
	IgorProOpen
	PhysioNetOpen
	raw
	WAVimport
	EDF_import
	Close
	BeGaze_Timestamp_Align
	SaveAs
	FileSaveAs
	Compressed
	GraphTemplateSAVEAS
	MatLabSave
	IgorProSave
	EDF_exports
	PhysioNetSave
	ExcelSpreadsheetExport
	WAVexport
	PrintRange
	RangePrint2
	RangePrint
	FilePrint
	SelectedRangePrint
	RangeEdit
	EditMenu
	Undo
	BackupCreate
	Merge
	Clipboard
	EditClipboard
	RangeClipboard
	CopyAcquisitionSettings
	EditJournal
	PasteJournal
	ManagePDFS
	TransformOverview
	TransformMenu
	RecentlyUsedTransformations
	DigitalFilters
	RangeDigitalFilter
	TransformDigital
	LowPassFilter
	FilterLowPass
	FIRFiltersTransform
	IIR_Filters
	CombBandControls
	AdaptiveFilteringTransform
	CombBandStop
	FourierLinearCombiners
	FLCalgorithm_References
	RemoveProjection
	TemplateNCC
	TemplateATM
	AdaptiveTemplateMatching
	OutputReset
	IntegrateFormulas
	IntegrateNotes
	TransformSmoothing
	DifferenceTransform
	TransformResample
	Expression_Post
	TransformExpression
	RangeExpression2
	Delay_transform
	Rescale_transform
	WaveformMath
	RangeMath2
	RangeFindRate
	Analysis_menu
	SlewRateLImiterTransfrom
	AnalysisChapter
	TransformHistogram
	NonlinearModeling
	ARModel
	PowerSpectal
	ARTimeFreq
	RangeFFT
	FFT
	IFFT
	DWT
	PrincipalComponent
	IndependentComponent
	RangeFindPeak
	FindPeak_PC
	FindCycle_Mac
	Peak_Def
	Event_Def
	Fixed_def
	EdgeAdjustment
	EventLocation
	Clustering_Kmeans
	Clustering
	threedbackgroundcolor
	TransformFindRate
	FindRate
	Signal_type
	TransformRateFunc
	SpecializedAnalysis
	AnalysisGeneral
	HandP
	EDApreferences
	EEGpreferences
	OLE_LINK7
	OLE_LINK8
	FocusAreasAnalysis
	OLE_LINK2
	TauComputation
	LVDEPlocationPref
	MAPplateauposition
	Hemodynamic_Pref
	AnalysisImpedanceCardiography
	Extract_HRV_RSA_Options
	Poincare_Plot
	BodySurfaceEq
	Bpoint
	dZdtCycleLocation
	Cpoint
	Xpoint
	ICGAnalysis
	OLE_LINK1
	StrokeVolumeEq
	OLE_LINK3
	IdealWeight
	motionfilter
	Classify_Spikes
	Locate_Spike_Episodes
	NeuroPhys_Pref
	SpikeLocationMethod
	Respiration_specanalysis
	Resp_Compliance
	Resp_Penh
	Resp_Pulmonary
	Stim_response_dig
	OSEA_QRS
	egpuwave
	OLE_LINK4
	oseaqrs
	OSEA_Library
	License
	DisplayMenu
	ChannelVisibility
	DisplayHorizAxis
	SampleRateA
	SampleRateB
	DisplayShow
	Dotplot
	ConnectedTo
	SelectionPalette
	selectionpal_options
	DisplayXY
	SpectrumAnalyzerPalette
	DisplayStat
	Preferences
	FilePrefGen
	Pref_Focus2
	Pref_Meas
	Pref_Wave
	Pref_Event
	Pref_Graph
	InterpolatePastings
	Pref_Journal
	BackupAuto
	Pref_Hardware
	Pref_Perform
	Pref_Network
	NetworkSettings
	Pref_Other
	Events_MarkEditsPref
	Pref_Window
	Pref_Focus
	Pref_Focus3
	LocationPreferences
	JournalPreferences
	BackupShowOriginal
	LoadintoMemory
	AcqKnowledgeMenu
	WindowMenu
	HelpMenu
	AboutMenu
	Media
	SynchronizeTip
	Delay_media
	CAM_HFR_A
	VibroCalcPreset
	OLE_LINK13
	OLE_LINK14
	Scripting
	DefinitionFile
	Assign_Def_File
	CogStateCalc
	ABM_Output
	Baroreflex_Lic_Chapter_29
	Baroreflex_Sequence_Description
	Baroreflex_Slope_Description
	Actigraphy_cover
	Actigraphy_Analysis_1
	Sleep_Derived_Measures
	Activity_Level_Measures
	Stellar_Telemetry
	Mobita_changemodes
	FR_Port_Settings_1
	FR_Port_Settings_2
	Valence_and_Arousal
	Filter_Characterisitcs_Appendix
	Filter_Windowing_Appendix
	MenuCustom
	LockUnlockMP150
	UpdateFirmware_Win
	FirmwareRollback


